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Overview of AFT xStream
Welcome to AFT xStream™ - a visual platform for modeling compressible fluid transients in pipe net-
works! See what's new in this version.

AFT xStream brings increased productivity to the pipe flow engineer by combining traditional analysis 
with an intuitive graphical user interface. By implementing a drag-and-drop method of pipe flow mod-
eling, AFT xStream simplifies the pipe network modeling process.

AFT xStream can show both input data and analysis results in visual form, allowing rapid analysis of a 
model's validity. Identifying poor assumptions, catching typographical or modeling errors, and rerunning 
models are all accelerated because of AFT xStream's graphical environment.

Whether your pipe system model will be used to evaluate and improve an existing system or to design a 
new one, AFT xStream increases your productivity in the modeling process.

What Can AFT xStream Do?

AFT xStream can be used to model a wide variety of compressible flow systems, including:

 l Open and closed (recirculating) systems
 l Network systems that branch or loop, with no limit on the number of loops
 l Systems with valve transients
 l Systems with compressor transients
 l Systems with pressure or flow control valve transients
 l Multiple design cases in a single model file (Scenario Manager)

AFT xStream's steady-state solution engine is based on standard techniques used for many years in 
industry. A modified Newton-Raphson method is used to solve the fundamental equations of pipe flow 
that govern mass, momentum and energy balance. Solutions are obtained by iteration, and matrix meth-
ods optimized for speed are employed to obtain convergence. Once a steady-state solution is obtained, 
AFT xStream simulates the transient using the Method of Characteristics, the most widely used method 
for solving fluid transient problems.

Where to Start

The best place to start learning about AFT xStream is to work through our example problems and video 
tutorials found in the xStream Learning Resources.

Add-on Module Capabilities

AFT xStream has one add-on module that extends modeling capabilities, the Pulsation Frequency Ana-
lysis module. Pulsation Frequency Analysis (PFA) allows the engineer to predict resonant frequencies in 
the system and graphically show the frequency response of a system.
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Who Can Use AFT xStream             

AFT xStream assumes that the user possesses a good general knowledge of compressible flow theory 
and has at least a basic understanding of fluid transients. Even the most advanced and easy-to-use soft-
ware package cannot make up for a lack of fundamental knowledge on the part of the user.

Related Topics

xStream Learning Resources 33
Primary Window Overview 300
Overview of Fluid Transients 37
Philosophy of Computer Modeling 69
Method of Characteristics 473

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Engineering Assumptions
AFT xStream is based on the following fundamental fluid mechanics assumptions:

 l Compressible flow
 l One-dimensional flow
 l System is fluid-full
 l All gases are superheated (single phase)
 l No chemical reactions
 l No supersonic flow in the system
 l Pipes are rigid (pipe geometry does not change during the transient)
 l The Method of Characteristics (MOC) solution used has several significant assumptions that 

impact accuracy - see the Method of Characteristics topic for more info
 l Additional assumptions exist for particular modeling components and features, discussed where 

relevant

Related Examples

Fluid Library Comparison - Steam Turbine Shutdown Example 639

New in Version 3
View the links below for key updates from past versions:



Overview of AFT xStream

- 19 -

New in Version 2

Workspace Layers

The Workspace Layers feature provides a powerful new tool for customizing and viewing model appear-
ance, input data, and results - all in one place. The Workspace Layers toolset significantly enhances the 
model building process, providing unparalleled customization options. You can easily update pipe/junc-
tion size, color, display text, visibility, and more from a centralized location on the Quick Access Panel. 
Workspace Layers surpass the capabilities of the previous Visual Report feature. With Layer Settings, 
you now have easy control over Color Mapping and the visibility of both Input and Output parameters. 
Any change you make to these settings will have an immediate impact on the model’s display, providing 
real-time feedback. The dynamic combination of unique Layers offers an incredibly flexible framework, 
allowing you to display precisely what you desire on the Workspace. You can easily toggle the visibility of 
individual layers on or off, and the state of all layers can be saved to a Layer Preset for future use.

Figure 1: Workspace Layers can display input and output values superimposed over the model, show Color 
Maps, and control visibility of objects

Reciprocating Compressors

Model single or double-acting multi-cylinder reciprocating compressors, accounting fully for all fun-
damental thermodynamics. Completely new in this version of AFT xStream is a fully transient recip-
rocating compressor model that considers the thermodynamic effects of gas being compressed or 
expanded in a closed chamber. Combined with the fundamental gas dynamics considered by the AFT 
xStream transient solver, this offers an exceptionally powerful simulation tool. The reciprocating com-
pressor model offers the flexibility to specify single or double-acting compressors, with various arrange-
ments including opposed, inline, or V configurations, accommodating up to six cylinders. The model 
incorporates a physical representation of the cylinder geometry and valve opening crank angles. In com-
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bination with the PFA module improvements in this version, this enables engineers to analyze the pulsa-
tion effects of reciprocating compressor systems with greater precision and confidence.

Figure 2: Reciprocating Compressors can be modeled inside the Compressor Properties menu under the Pos-
itive Displacement option

Transient Checkpoints

Extend the length of an existing transient run without the need to re-run the entire simulation, or stop and 
continue a run from other points in the simulation. Transient Checkpoints enable you to save the state of 
a transient simulation at any given point and resume it later from that exact point. This functionality 
proves particularly useful in scenarios where you need to pause a simulation temporarily to provide 
access to another user or when unexpected interruptions, such as system updates, occur during the sim-
ulation. This feature also allows for the extension of a transient run. If you have ever experienced the frus-
tration of waiting for results only to realize that you should have run the simulation for a slightly longer 
duration, this feature provides a solution. Instead of rerunning the entire simulation, you can simply 
extend an existing run by leveraging the automatically created Transient Checkpoints.

Transient-Checkpoints-Panel.html
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Figure 3: The Transient Checkpoint panel within Analysis Setup

Retain Partial Transient Output

If the simulation is stopped - by the user or an error - show the transient results up to that point. Transient 
Output is now saved and viewable regardless of what caused the simulation to stop. This means that you 
can access and analyze the results up to the point where the simulation was interrupted, just like regular 
results. This eliminates a lot of guesswork involved in interpreting system behavior when it deviates from 
expectations, particularly when troubleshooting simulation errors. For instance, if a simulation encoun-
ters difficulties in converging on a compressor solution due to factors like reverse flow or unexpectedly 
low temperatures, the availability of partial output enables you to quickly identify these situations. You 
can then take appropriate corrective measures or provide our Support Team with detailed information to 
expedite problem resolution.

Transient-Checkpoints-Panel.html
Transient-Checkpoints-Panel.html


Overview of AFT xStream

- 22 -

Figure 4: Transient Output can be retained on errors or cancel

Improved Valve Properties Window

The new Valve Properties window greatly enhances clarity and usability when it comes to modeling 
valves. The window now clearly distinguishes between different data sources such as User Specified, 
Characteristic, or Handbook, making it easier to understand the available options. The form has been 
streamlined to focus on the most essential data, providing a clear understanding of what is required to 
define a valve accurately. Valve Characteristics, represented by an Open Percent vs. Flow Coefficient 
table, have been brought front and center. While using a Characteristic is optional, it is highly recom-
mended as it ensures that the valve behavior aligns with real-world scenarios, particularly for valve tran-
sients. The process of selecting a pre-defined Characteristic Source has been simplified, which helps 
obtain more accurate values in case manufacturer data is unavailable.
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Figure 5: Redesigned Valve Properties window

Streamlined Design Alerts

The Design Alert Manager has been reorganized to improve the process of creating and applying user-
defined alerts. Now, you can effortlessly create or edit a Design Alert with just a few clicks. As you modify 
settings, you will immediately see the criteria you are applying, ensuring a transparent experience. We 
have also reduced the amount of text on the form, while ensuring grammatical clarity. These improve-
ments aim to make it easier to understand the limits being placed on the design.
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Figure 6: Steamlined Design Alerts Manager

Other Notable Features

 l Custom Junction Icons - Use your own images for junction icons.
Utilize any image as a junction icon, simply by right-clicking on the Toolbox icon for the junction, 
selecting Add Image, and browsing to the image file. This functionality enables you to use stand-
ard P&ID icons or custom images to visually represent your equipment. By using recognizable 
icons, you can improve the clarity and comprehension of model results, especially for those who 
may not be familiar with the default AFT junction icons.
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Figure 7: The Customize Icon window allows a custom image to be applied to any junction

 l Isometric Freeform Drawing Mode - Draw on the isometric grid without forcing any particular 
pipe routing.
The Isometric drawing tools have been enhanced by adding a new Isometric Freeform drawing 
mode. This new drawing mode allows you to snap junction and pipe anchors to the Isometric grid, 
while having the flexibility to draw pipes that do not necessarily align with the isometric gridlines. 
This allows you to easily draw complex systems where not all piping follows a Cartesian direction.

Figure 8: Isometric Freeform drawing mode does not force pipes to follow gridlines

 l New Annotations - There are new shapes and a line tool, along with a more advanced Annota-
tion editing panel.
New Annotation shapes and a line tool have been introduced to allow more flexible markup such 
as revision numbers or change requests. Editing of Annotations has been revamped with the intro-
duction of a live-edit Quick Access Panel, which provides immediate visual feedback of the 
changes you make, and simple global editing of all selected Annotations. The new edit panel also 
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offers expanded functionality, providing you with more customization than was possible in the 
past.

Figure 9: New Annotation options

 l Set Workspace Print Area - Show printing page borders on the Workspace and customize the 
printing area.
The new Printer Page Layout tool offers a convenient and effortless way to adjust the printing area 
according to your preferences. With a clear and intuitive visual representation, you can easily 
identify where page breaks will occur. Now, you can confidently print a specific section or the 
entire model at your desired scale, eliminating the need for trial and error.
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Figure 10: The Printer Page Layout feature allows the user to set the Workspace print area

 l Customize Parameters Available to Graph from the Workspace - New User Options allow 
custom selection of any graph parameter on the right-click Workspace context menu.
Did you know you can easily graph results from the Workspace by right-clicking on a pipe or junc-
tion? This functionality has existed for a long time, but it was previously limited to a predefined set 
of parameters. Now, you can specify what graph types you would like to see in these menus to 
simplify your analysis process.

Figure 11: The right-click context menu for pipes on the Workspace can have the graphing parameter options 
modified

 l PFA Module Improvements - The PFA module has an improved interface, and can now find a 
Steady State Pulsation solution, allowing better analysis of pulsating systems.

The PFA module interface for xStream has been overhauled to enhance clarity and streamline the 
process, while introducing new tools essential for pulsation analysis. Chief among these is the 
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addition of a Steady State Pulsation mode, which allows the transient simulation to run until standing 
waves are formed by the device causing pulsation. This new mode eliminates artificial transients that 
could affect the accuracy of conclusions drawn from a pulsation study. By focusing on the formation 
of standing waves, the modal analysis becomes more precise and reliable.

Figure 12: The Pulse Setup panel inside Analysis Setup

Miscellaneous Improvements

 l Modeling Additions and Improvements
 l Zero-Length Connectors - Zero-Length Connectors now behave like standard pipes for 

most features, including selection and graphing tools.
 l Fluid Libraries - New category for user-defined fluids, making it easier to find custom 

entries.
 l Simpler Force Definitions - Difference forces spanning more than 2 pipes no longer 

require the definition of a group.
 l Control Valve Fully Open Cannot Regain Control - New special condition that keeps 

the control valve in a locked-open position during transients.
 l API 618 Limitations in PFA Module - API 618 outlines frequency-dependent pulsation 

limits - you can now check for violations graphically, and see locations where the limit is 
exceeded.

 l Importing of PCF, EPANET, GIS, and CEASAR II Models
 l Bend r/D - Import PCF bends with appropriate r/D values.
 l Speed Increase - Importing is up to 10x faster in some cases.
 l Defaults and Display - Better defaults and display options for imported models.
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 l Pipe Materials - Improved ability to link AFT pipe materials to imported pipes.
 l CEASAR II Node Names - Display imported CAESAR II node names as junction names.

 l Behind the Scenes Improvements
 l Graphing Optimization - Significant improvements to backend graphing code which 

provides additional stability now and more capabilities in the future.
 l eLicense Access Improvements - Added a "heartbeat" functionality to eLicenses which 

improves security and the release of license seats not in use.
 l Output - Significant improvements to backend output code which provides additional sta-

bility now and more capabilities in the future.
 l Timed Recovery File - Automatically generate a backup of your unsaved model that can 

be used to recover unsaved work in the event of unexpected application closure. This is 
separate from the *.bak files which are only generated after saving a model.

 l New and Improved Output Parameters and Messages
 l Compressor RPM Output Parameter Report compressor speed in RPM, in addition to 

percent.
 l Dimensionless Heat Transfer Parameters - Grashof, Nusselt, Prandtl, and Rayleigh 

Numbers have been added as Output parameters.
 l Valve xT Output Parameter - Report and graph the xT value used for valves.
 l Estimated xT Output Parameter - Graph saturation temperature and temperature above 

saturation (superheat) along flow paths.
 l Laminar Caution - Alerts the user if flow at junctions is in a laminar range.
 l Profile Graphs for Temperature Saturation and Temperature Superheat - Graph sat-

uration temperature and temperature above saturation (superheat) along flow paths.
 l POR/AOR in Compressor Summary - Show the values for Preferred and Allowed Oper-

ating Ranges in the Compressor Summary.
 l Events Messages in New Format - Events are now shown in a cleaner, collapsible 

format similar to Warnings.

Interface Improvements for xStream 2
There were many improvements made to the interface in xStream 2. These changes primarily involve 
consolidating inputs with the new Analysis Setup window, and updating the functionality of databases, 
which have been renamed as libraries.

Analysis Setup Sources in xStream 1

 l Simulation Mode: The simulation mode settings were moved to the Simulation Mode/Duration 
panel in the Transient Control group.

 l AFT Arrow Steady Solution Control: The Steady Solution Control parameters have primarily 
moved to the AFT Arrow Steady Solution Control group. The Special Controls have moved to 
the Advanced Parameters panel under the Miscellaneous group.
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 l MOC Steady Solution: The MOC Steady Solution panel was renamed to the Transient Solver 
Initialization panel and moved to the Transient Control group.

 l Sectioning: The Sectioning panel has been renamed to the Pipe Sectioning and Output panel 
in the Pipe Sectioning and Output group.

 l MOC Transient: The Start/stop time inputs from this panel were moved to the Simulation 
Mode/Duration panel. The options to save pipe stations were moved to the Pipe Sectioning 
and Output panel.

 l List Undefined Objects: The undefined objects list has been moved to the Pipes and Junc-
tions group. The undefined objects list can also still be viewed next to the Workspace by opening 
it from the View menu.

 l Add-on Modules Activation: The activation window for add-on modules has moved to the Mod-
ules panel

 l Pulsation (PFA module only): Settings have moved to the Pulsation Setup group.

Database Improvements

 l Databases have been renamed as libraries throughout the interface to better reflect their func-
tionality

 l Connecting, creating, and transferring content between libraries can all be done from the Library 
Browser, rather than switching between tabs in the Database Manager to do this

 l Viewing the contents of libraries can also be done directly in the Library Browser, rather than opening 
a separate Browse Database Content window

 l Windows to edit and add components to libraries can all be accessed directly from the Library Man-
ager rather than having to navigate solely through the Library menu



Overview of AFT xStream

- 31 -

New in Version 2

Convective Heat Transfer

Pipe heat transfer calculation options for convective heat transfer are available for use. Radial and axial 
conduction are considered inside the pipe when a convective heat transfer model is used.

Libraries

The database feature interface was completely overhauled to improve workability. The new system is 
called the Library Manager and significantly improves the ease and workability for users to browse and 
connect input information, now called libraries, into their model. For a list of differences between the Data-
base and Libraries interfaces, see Interface Improvements for xStream 2.
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Improved Organization of the Warnings in the Output   

An improved display of the warnings and design alerts makes it easier to review and understand inform-
ation in the following ways:

 l Critical Warnings, Warnings, and Cautions are color-coded and grouped by type  in collapsible sec-
tions

 l Design Alerts are now shown on a separate tab in the General Section
 l Double-clicking messages will take user to the related pipe/junction in the Workspace

More Improvements

 l Pipes/Junctions
 l Several new junctions have been added including the Bend, Screen, and Venturi junctions
 l Valve transients can be defined as open percent vs time

 l Workspace and Interface
 l Pipes and Junctions can be set the Same as Parent directly from the Workspace



Overview of AFT xStream

- 33 -

 l Custom Unit names can be defined in the Unit System section of the User Options window
 l Pipe/Junction notes can be searched in Select Special
 l Special Conditions can be directly changed from the toolbar for junctions that have multiple 

special condition options
 l Output and Reporting

 l Show the number of warnings and design alerts in the batch run window
 l Design alerts are grouped together in the General Output section
 l New output parameters are available for the Relief Valve junction
 l API 618 analysis added for the Pulsation Frequency Analysis add-on module

 l Miscellaneous

 l SRK and Peng-Robinson equations of state are now available for AFT Standard fluids
 l Saturation line data has been added for the AFT Standard fluids
 l List Junctions that have Special Conditions change in Solution Progress window
 l Silent Batch runs can be enabled to prevent notifications from appearing over other active 

windows

xStream Learning Resources

Online Resources

Additional resources can be found in the Learning Center on our website. Resources found there 
include:

 l Training Seminar information
 l Free Webinars
 l Flow Expert Package information
 l Case Studies
 l Video Tutorials
 l Tips & Tricks Blogs
 l Quick Start Guides

Online Quick Start Video Tutorial

The Quick Start video tutorial series provides a short introduction to the interface of AFT xStream using a 
simple example model.

 l Online Quick Start Video Tutorial Series

https://www.aft.com/learning-center
https://www.aft.com/products/xstream/video-tutorial-series
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Beginner: Tank Blowdown Problem

This is a simple example model which is recommended as a starting point for brand new AFT product 
users.

 l Beginner: Tank Blowdown Problem

Walk Through Examples

This links to a variety of example problems for beginning to advanced users which showcase different 
features and applications of AFT xStream.

 l Walk Though Examples

Module Walk Though Examples

A list of examples using the add-on modules of AFT xStream to solve a variety of problems:

 l Module Walk Through Examples

Related Topics

Overview of AFT xStream 17
Primary Window Overview 300
Overview of Fluid Transients 37
Philosophy of Computer Modeling 69

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Startup Window
The Startup Window is displayed when AFT xStream is opened. This window allows the user to quickly 
access files and resources, as well as define a basic starting point for a new model.

 l Open a Model
 l My Files - AFT xStream keeps a list of recently opened model files. The most recent files 

can be opened with a single click here.
 l Other Files - Browse to any other model file, or open the built-in Examples folder.

 l Start a New Model
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 l Activate Modules - Any licensed Module can be activated immediately. Checking these 
boxes will search for an available license.

 l Select Working Fluid
 l I Will Select Fluid Later - No fluid will be defined, one will need to be defined in 

Analysis Setup on the Fluid panel before running the model.
 l Use AFT Standard Air - Selects AFT Standard Air to be used as the working fluid 

of the model.
 l Select A Recently Used Fluid - Allows the selection of a recently used fluid from 

the dropdown menu.
 l Modeling Preferences - Displays various settings for the application, such as specifying 

the units to use or which grid to use. These options can be modified later. Click the Modify 
button to reveal the following settings, as shown in Figure 2. Click the Remember My 
Preferences and Hide button to update the modeling preferences for the model and to 
update the default settings for the application.

 l Units - US, Metric, or both sets of units with one as default can be displayed. Addi-
tionally, the displayed units can further be reduced to only show common units and 
those used by a certain industries.

 l Language - Select a language for the display of the Menus, Workspace Layers, Out-
put, Graph Results, and the Startup Window.

 l 2D or Isometric Workspace - Set up the grid to enable either 2D or isometric draw-
ing modes.

 l Default Pipe Material - Set the pipe material that is initially selected for new pipes.
 l Resources

 l Current Version - Open the AFT website to view the latest AFT xStream release, or sign 
up for notifications of new releases via email.

 l Quick Start Guides - Provides links to various Learning Resources that are designed to 
help get a new user up and running with AFT xStream as quickly as possible. The 
resources include the Quick Start Guide PDF, Examples, and video tutorials.
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Figure 1: Startup Window in AFT xStream

Figure 2: Startup Window showing Modeling Preferences
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Overview of Fluid Transients
A system is steady-state if its properties - pressure, velocity, etc - do not change with time. Any dis-
turbance to a steady-state system will cause these properties to change - this change is a fluid transient. 
All fluid transients cause disturbances which propagate throughout the fluid as  pressure, velocity and 
density waves.

Slow acting system changes - such as a tank pressure that changes over the course of a day - can be 
accurately approximated with a series of steady-state simulations. There are still rapidly-propagating 
transient pressures in the system, but their magnitude is generally small enough to be considered neg-
ligible.

Rapid changes can cause large transient pressures that propagate through the piping network. In 
extreme cases this causes catastrophic failure of piping and associated equipment. AFT xStream is 
focused on analyzing rapid changes to the state of a fluid piping system and the resulting transient beha-
viors via the Method of Characteristics.             

Wave Velocity and Communication Time

Wave Velocity

The wave velocity (sometimes referred to as characteristic speed) for gas transients is the velocity at 
which the pressure waves will propagate through the gas, as is calculated by the Method of Char-
acteristics. For gas flow the wave velocity is equivalent to the sonic velocity of the gas (a) plus the velo-
city of the gas (V). The sonic velocity and velocity will vary with pressure and density.

Communication Time

An important consideration in fluid transient studies is how long it takes a wave to propagate through the 
system.

The time it takes for a wave to travel from one end of a system to the other is the distance (L) divided by 
the wave velocity. Note that the wave velocity is not constant since the sonic velocity and velocity will 
vary with pressure and density. However, a minimum communication time can be estimated using the 
maximum sonic velocity (i.e. sonic velocity at the maximum temperature) and maximum velocity (i.e. 
sonic velocity), as is discussed in Pipe Sectioning - Introduction to Method of Characteristics. 

 

When a transient event occurs at one end of a pipe, the wave travels at the wave velocity to the other end 
of the pipe. However, this is not sufficient time to analyze the problem. While the disturbance has 
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propagated through the entire system, the point of transient initiation has not yet seen the result of the 
reflected wave. For the wave to both travel to the end of the pipe and back requires double the above 
time. This time is known as the Pipe Period or Communication Time.

Related Blogs

A Story About Fluid Communication

Pipe Sectioning - Introduction to Method of Characteristics
To run any transient simulation in AFT xStream, the pipes in the model must first be sectioned. This is 
required to use the Method of Characteristics (MOC) solution approach. A brief overview of the impact 
the Method of Characteristics has on the model is covered below. A detailed discussion on the math-
ematics behind the method is covered on the Method of Characteristics help topic.

What is Sectioning?

The Method of Characteristics requires the entire system to be solved every time step. To accomplish 
this, every section must use a common time step. If the time steps were allowed to vary throughout the 
model, some portions of the system would be solved "ahead" of others, resulting in a time-distorted solu-
tion.

Furthermore, the Method of Characteristics requires that any information propagated from a given cal-
culation point arrives at the neighboring calculation points after one time step. The method cannot allow 
information to be "lost" between time steps or calculation stations - the distance between calculation 
points is locked to the duration of a time step.

The time Δt it takes to travel from one point to another is determined by the linear distance Δx between 
those points and the wave velocity (a + V):

For systems with liquid flow the velocity is relatively small and can be neglected, which results in a con-
stant characteristic line slope:

https://www.aft.com/support/product-tips/a-story-about-fluid-communication
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However, for gas flow the velocity cannot be neglected, which means that the characteristic line slope will 
change throughout the transient. This complicates the choice of a characteristic grid size, since the AFT 
xStream MOC solution requires a fixed grid. For a fixed time step, the distance the wave travels will vary 
based on the wave velocity at that time step. Interpolation must be performed between the known grid 
points to determine the unknown pressure, velocity, and temperature at time step t in order to calculate 
the pressure, velocity, and density at time step t + Δt at the grid intersection.

For example, consider Figure 1 below where the parameters at point 4 are being determined. At time 
step t, points 1, 2, and 3 are known from the previous MOC calculation. However, based on the wave 
velocity at time step t the characteristic lines will be unlikely to fall on the known grid points, so inter-
polation must be performed. Ideally the points R, P, and L will fall between points 1 and 3 on the grid for a 
stable solution.

Figure 1: Characteristic grid in AFT xStream, where point 4 sees effects from points R, P, and L after some 
time dt, which has equal magnitude of dx/a. Points R, P, and L must be interpolated from know points 1, 2, 

and 3.

To ensure that grid points 1 and 3 are not exceeded the minimum time step can be approximated using 
the maximum value of a + V. Recall that the maximum velocity for gas flow in a pipe is limited to the sonic 
velocity, and that the maximum sonic velocity will occur at the maximum temperature (T,max). Therefore, 
the minimum time step can be calculated as follows:



Overview of Fluid Transients

- 40 -

Note: The maximum temperature during the transient will likely be unknown when the model is first 
run. It is best practice to choose a conservatively large temperature when first running the 
model. The maximum temperature can be decreased for subsequent runs to increase the accur-
acy of the results as necessary.

Note that the multiplier of 2 for the maximum sonic velocity, known as the courant factor, was derived 
assuming that the velocity reaches the sonic velocity (Mach number reaches 1). If the Mach number 
does not reach 1 during the transient simulation, then using two times the maximum sonic velocity will be 
an overestimate for the maximum velocity. This large maximum velocity allows for a stable solution, but 
also reduces the accuracy of the solution since points R and L are farther away from the grid points 1 and 
3.

For simulations where the Mach number in the pipes remains significantly below one for the whole dur-
ation the accuracy can be increased by decreasing the courant factor, which should be equivalent to one 
plus the maximum pipe Mach number. Calculating the courant factor using a Mach number less than the 
maximum pipe Mach number will result in an unstable solution and may prevent the MOC from con-
verging.

Note: In xStream the courant factor is adjusted based on the Estimated Maximum Pipe Mach Number 
During Transient defined in the Sectioning panel of Analysis Setup. By default the Estimated 
Maximum Pipe Mach Number is fixed at 1, and can only be changed if advanced options are 
enabled.

Sectioning Effect on  Accuracy

One of the largest sources of error in xStream results from the interpolations performed to determine the 
properties at points R, P, and L. To increase the accuracy of calculations the width between the grid 
points, Δx, can be reduced by increasing the minimum number of sections. For a detailed discussion on 
determining result accuracy, see the Transient Results Accuracy topic.

Sectioning Effect on Run Time

As is discussed above, the accuracy of the results in xStream will be closely tied to the number of cal-
culation sections. However, the more calculation stations there are, the longer the required run time will 
be. xStream simulation times may require hours or days to run, depending on the size of the model and 
the computational speed of the computer. For information on reducing run times see the Minimizing Run 
Time topic.

Related Topics

Method of Characteristics 473

Minimizing Run Time
Models built in AFT xStream can experience long run times, sometimes requiring hours or days to com-
plete. Ultimately, the best method to reduce model run times is to work on a computer with a more 
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powerful processor and with higher read/write speeds.

There are modeling methods which can be used to decrease the run time, though these methods will typ-
ically result in some decrease in result accuracy. When using any of the following methods the engineer 
should always perform a sensitivity analysis to determine what impact these changes have on the accur-
acy of results.

 l Include  losses from static components in the pipe Fittings & Losses tab. This can be done using 
the feature to Join Pipes/Junctions.

 l Artificially increase the length of the shortest pipe in the model. This will decrease the number of 
sections used in longer pipes in the model, therefore decreasing run time.

 l Set the Minimum Number of Sections Per Pipe to 1 in the Sectioning Panel.
 l Use the  AFT Standard fluid library for fluid properties. Results obtained using the AFT Standard 

library should always be compared to results using one of the higher accuracy fluid libraries.

Related Topics

Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60
Reducing Run Time 554
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Transient Forces
This section focuses on imbalanced force calculations in xStream. Topics included discuss how xStream 
calculates forces, what types of force sets can be defined, and how to configure force calculations in 
xStream.

Contents

Defining Forces 42

Force Set Types 45

Exporting Force Data 46

Force Theory 47

Defining Forces
AFT xStream includes the ability to calculate transient pneumatic forces, which occur when a transient 
pressure wave passes through a portion of the system.

Note: As AFT xStream is only a pneumatic solver, only pneumatic forces are accounted for. AFT 
xStream is not a pipe stress analyzer and as such does not have the ability to directly model pip-
ing supports or similar objects. Pneumatic force files can be generated for import into software 
designed for force analysis.

Defining Force Sets from Analysis Setup

In order to process force data, the locations where the forces are to be calculated must be defined. Force 
Sets can be defined from the Force Definitions panel of the Forces group in Analysis Setup.

Note: Force calculation accuracy in AFT xStream is dependent not only on accurately defining the 
Force Sets, but can also be highly dependent on the Sectioning and Fluid panel settings. This is 
discussed further in the Pipe Forces from Turbine Shutdown Example.
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Figure 1: Force set data is defined on the Force Definitions panel in the Analysis Setup window

 l New - Add a new force set to the table.
 l Duplicate - Copy an existing force set.
 l Delete/Delete All - Remove the selected force set / remove all force sets.
 l Swap Nodes - The calculation will be the same, but the sign of the force will be reversed. This 

may be important for proper interpretation of results or for exporting data to other applications.
 l Import from CSV - If force sets are defined in another application or by hand they can easily be 

imported with a comma separated value file. Click the Import from CSV button for an explanation 
on the required format.

 l Generate Force Names - Automatically changes the names for the selected force sets to 
"upstream junction name - downstream junction name" using the names from the connected junc-
tions on the workspace.

 l Point Force Ambient Pressure - If using a Point force set, the ambient pressure is required to 
calculate the force balance. This defaults to the Environmental Properties panel value, but can be 
changed here.

Each individual force set has a number of required parameters:

 l Force Type - There are several force set types available. They are described in detail in Force 
Set Types.

 l Force Set Name - A unique name for the force set.
 l Start Pipe - Where the first node is located.
 l Start Location - Force Sets in xStream must have their endpoints at either the inlet or outlet of a 

pipe.
 l End Pipe - The second  node (for Difference force types). Note that the selection must be valid for 

the specified force type. See Force Set Types.
 l End Location - Force Sets in xStream must have their endpoints at either the inlet or outlet of a 

pipe.
 l Exit Area - For Exit force types, an exit area is required.
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 l Force Unit Vector Coordinates - Define unit vectors for your linear pipe to give the resulting 
forces a three-dimensional direction. xStream is still only a one-dimensional fluid modeling soft-
ware, and specifying a unit vector will not change the force calculations. However, by defining the 
XYZ vector for a given force set, that data can be brought into other software for further analysis 
using the Export Force Data tool. These unit vectors should be defined based on the coordinate 
system in the force stress analyzing software that the force sets will be exported to.

Defining Force Sets from the Workspace

Force Sets for individual pipes can be defined directly from the Workspace by right-clicking on a selected 
pipe. Choose the Create Force Set With Selected Pipe... option to launch the Create Force Set window, 
shown below in Figure 2. If multiple pipes are selected, an individual Difference Force Set will be created 
for each pipe applying the specified settings for each.

Figure 2: Create Force Set window in the Workspace

Each force has several required and optional parameters:

 l Pipe Name - If the pipe has a name entered other than 'Pipe', the user can choose whether to 
include that pipe name or not in the Force Set name.

 l Force Set Name - Users can add a name for the Force Set to better organize and manage Force 
Sets in the model.

 l Force Unit Vectors or Length - Define unit vectors for your linear pipe to give the resulting 
forces a three-dimensional direction. xStream is still only a one-dimensional fluid modeling soft-
ware, and specifying a unit vector will not change the force calculations. However, by defining the 
XYZ vector for a given force set, that data can be brought into other software for further analysis 
using the Export Force Data tool. These unit vectors should be defined based on the coordinate 
system in the force stress analyzing software that the force sets will be exported to.
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 l Show Analysis Setup Force Definitions after Creation - If checked the user will be brought to 
the Force Definitions panel of the Analysis Setup window to view all Force Set information defined 
for that scenario.

Related Topics

Force Definitions Panel 114

Related Examples

Pipe Forces from Turbine Shutdown Example 656

Force Set Types
There are several types of forces that can be defined for analysis with AFT xStream:             

 l Point - Point forces are simply the difference in pressure between the fluid and the ambient envir-
onment multiplied by the pipe area, which can be used for Dead End junctions.

 l Difference - Difference forces are defined as the unbalanced force between two nodes, or com-
putation stations. These nodes should be located at 90 degree direction changes. There may be 
one or several junctions between the elbows so long as the flow does not branch between the 
nodes and all components are axially aligned. An example of this is the pneumatic loading 
between two elbows along the length of a pipe. See Figure 1 below.

 l Difference Exit - Similar to the difference force set in that two nodes are required. However, the 
first node must be a 90 degree elbow, and the second node must be a location where flow exits 
the system. A user defined exit area will be used at the exit node for calculating the force across 
the section. This is useful for modeling forces on exit valves, exit orifices, and relief valves.

Figure 1: Schematic of the Difference force type

Related Topics

Force Definitions Panel 114

Related Examples
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Pipe Forces from Turbine Shutdown Example 656

Exporting Force Data
The transient force data can be exported by selecting the Export Force File from the File menu while view-
ing the Output window.             

CAESAR II, TRIFLEX,  ROHR2, and AutoPIPE Force Files can be selected.             

The time frame of interest, quantity of data points, force balance components, and units can be cus-
tomized. Note that the units for CAESAR II files may only be set to lbf or N as these are the only units 
accepted by CAESAR II.            

Note: Force Set unit vectors can only be exported to CAESAR II (v12 and higher) and AutoPIPE. To 
export any Force Sets to AutoPIPE, users must have defined force unit vectors for each Force 
Set.             

Figure 1: Exporting force results to a Caesar II Force File             

Related Topics

Force Definitions Panel 114

Related Examples

Pipe Forces from Turbine Shutdown Example 656
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Force Theory
The force solution methods in AFT xStream are intended to calculate the unbalanced pneumatic loading 
on a series of axial aligned pipes rather than the total forces on those same pipes. Thus, most systems 
will see steady-state forces calculated as zero. However, systems such as an exit nozzle will see a non-
zero steady state force, since there is a hydraulic force imbalance across that valve even at a steady flow 
rate.             

It is important to keep in mind that AFT xStream is not a tool built for the analysis of pipe stress. In real 
systems, the configuration and location of supports, the deflection of pipes and components, and other 
effects of dynamic loading should be considered. All piping and components in AFT xStream are con-
sidered to be perfectly fixed in time and space, unless directed to change in a specified way, such as a 
valve closure. The forces that can be calculated by a hydraulic solver such as AFT xStream are only 
unbalanced hydraulic forces - not forces or stresses in pipe walls or supports.             

Considering the above, the calculations for forces proceed under the following assumptions:             

 l All piping and components are assumed to be completely rigid. No deflections or deformations are 
considered.                  

 l The force due to fluid and piping weight is neglected.                 
 l The volume of any junctions (bends, valves, etc.) is considered negligible. This is consistent with 

how junctions are modeled throughout AFT xStream.                 
 l All Difference Force sets comprise a pipe or set of pipes that are axially aligned between the begin-

ning or ending nodes.
 l Both beginning and ending nodes for a Difference force set type are assumed to be 90 degree 

elbows.                 
 l The total force acting on the piping is assumed to be equal and opposite to the forces acting on 

the fluid.                 

 Note: Forces calculated in xStream are always referenced as defined by the force set inlet and outlet. 
The reference direction for each pipe does not affect the forces calculated.     

A complementary resource to this discussion is an AFT white paper titled Evaluating Dynamic Loads in 
Piping Systems Caused by Waterhammer, available on our website.             

Difference Force Set Calculations             

A Difference Force Set effectively represents the force between two elbows along a pipe. An example 
case for a difference force set can be considered for a stretch of pipe at constant elevation with a valve in 
the middle, as depicted in Figure 1 below.    

https://www.aft.com/learning-center/white-papers/evaluating-dynamic-loads-in-piping-systems-caused-by-waterhammer
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Figure 1: Simplified force diagram for fluid flow in a pipe

With flow through such a pipe, multiple forces act on the fluid, including friction, pressure, gravity (which 
AFT xStream neglects for force set calculations), normal forces from the pipe to the fluid, and forces due 
to changes in fluid momentum as flow is redirected through the elbows. Only forces which are axially 
aligned with the pipe will be considered.

Newton's second law relates these forces to the acceleration of the fluid, using the equation F=m*a. 
xStream uses this equation to determine the overall reaction force from the change in fluid velocity at 
each time step. Equation 1 below shows how xStream determines the force from the fluid acceleration.

(1)

Using Equation 1 above, xStream takes the change in mass flow rate between the previous time step 
and the current time step to determine the change in velocity (and thus acceleration) of the fluid in each 
section to give the unbalanced force in each section. The total force for each pipe is then given by the 
sum of forces for all sections in a pipe.

In the steady state system, the total unbalanced hydraulic forces sum to zero, as the fluid has no accel-
eration, and thus no net forces acting on it.

Point Force Set Calculations

Point and Exit Force Sets in xStream represent the force caused by the pressure differential between the 
fluid and the ambient conditions. The Point force uses Equation 2 below. Note that this force is assumed 
to be applied over the flow area of the pipe. This assumption may not always be valid. For example, a 
blind flange would see the entire Point force, but a smaller tap on the side wall of a pipe would not.

(2)
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Exit Force Set Calculations

The Exit force captures the same fluid acceleration as the Difference Force Set, but also captures the 
force due to fluid exiting the system at the end of the force set. To do so, xStream accounts for the  
momentum change through the exit, as shown in Equation 3 below. Here, N is the final pipe section of the 
force set, connected to the exit. 

(3)

Note: Users of AFT Impulse may be familiar with the component-based approach Impulse uses to 
determine the total unbalanced hydraulic forces acting on a system. That approach has an 
implied assumption of constant density. Since the assumption of constant density in xStream 
does not hold true, xStream uses the approaches described above instead. If the approach 
implemented in xStream is used on an incompressible fluid in Impulse, the resulting forces are 
the same as those calculated using the component-based approach in Impulse. 

Related Topics

Force Definitions Panel 114

Related Examples

Pipe Forces from Turbine Shutdown Example 656
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Interpreting Transient Results
This section discusses how to begin understanding complex transient results. Topics included discuss 
how to use the output animation features in the Graph Results and Visual Report windows, and how to 
interpret transient results accuracy.

Contents

Animating Graph Results 50

Animation Layers 54

Transient Result Accuracy 58

Transient Sensitivity Analysis Tutorial 60

Animating Graph Results
Animating the results of a transient simulation is a powerful way to understand how a system is behaving. 
Plots of fluid parameters at a given location over time  are valuable and easy to interpret, but they cannot 
directly convey the most important aspect of a fluid transient event: how the pressure and flow waves 
propagate through a system and interact with one another. Animating the results of a transient simulation 
allows these effects to be observed directly. Animations can also be created for Multiple Scenarios.

Creating an Animated Graph

Since animations display information along a flow path, only Profile type graphs may be animated.
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Figure 1: Options for animation under Profile type graphs in the Graph Results window

Profile graphs are animated using the output saved for each computation station in the model. By default, 
output is saved for all stations in an xStream model. Profile graphs cannot be animated if the Inlet/Outlet 
stations for each pipe are the only computation stations where output is saved. To allow animation, the 
user must have the "Pipe Stations To Include In Transient Output File" set to All on the Pipe Sectioning 
and Output panel.

Using an Animated Graph

Once the animated graph is created, it will look much like a normal Profile graph, but a few components 
have been added.
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Figure 2: Components added to the Graph Results window when animating a Profile graph

The animation toolbar has several controls:

 l Play - Start the animation from the current time.
 l Record - Begin playing the animation from the current step, and when the playback is stopped, 

prompt the user to save an .mp4 video recording of the animation to file.
 l Stop - Halt the animation and reset the time to zero.
 l Pause - Pause the animation at the current time.
 l Time - The actual simulation time of the currently displayed data.
 l Step - The simulation step of the currently displayed data.
 l Time/Step slider - Seek for a certain point in the animation. 
 l Speed slider - Change the speed of the playback.
 l Default - Reset the speed to default.

By default, the graph will display the current values for the time step as well as the maximum and min-
imum profiles. These can be hidden or displayed in the graph Parameter selection area, like any other 
Profile graph. The Steady-State solution can be displayed, as well as applicable Design Alerts.

The Current Time box can be moved anywhere within the Graph area.

Using Animations to Interpret Behavior

There are many ways that animations are helpful in interpreting behavior. Below, we consider the case of 
an instantaneous valve opening.
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Like normal Profile graphs, multiple parameters can be displayed and animated as a single Graph List 
Item. The images below show the relationship between pressure and flow (velocity) for this case at the 
beginning and partway through the animation.

Figure 3: Animation showing steady-state (time step zero) results
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Figure 4: The movement of the wave within the pipe can be directly visualized

Animation Layers
Animating the results of a transient run is an extremely powerful way to understand how a complex sys-
tem is behaving. While transient plots of fluid parameters over time at a given location are valuable and 
easy to interpret, they do not directly convey the most important aspect of a fluid transient event - how the 
pressure and flow waves propagate through a system and interact with one another. Animating the res-
ults of a transient simulation allows you to observe these effects directly.

Unlike the Graph Results Animation feature, animated color maps provide the added benefit of being 
able to observe how waves propagate through branching paths and similar situations which are not 
restricted to one continuous flow path.

Saving Output for Animation

The Animation Layers feature works by referencing the output for each computational pipe section in the 
animated pipes. In order to accomplish this, data for each pipe station being animated must be saved to 
the Output File. xStream will save the data for all pipe stations by default. The pipe station output settings 
can be changed on the Pipe Sectioning and Output panel if needed.
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Creating an Animation

To enable animation in the Workspace, a Color Map/Animations layer must first be created using Work-
space Layers. The Layer Type will then need to be set to "Animation" in the Color Map/Animation panel 
in the Layer Settings window.

When Animation is selected in Layer Settings, the following Animation Settings become available.

 l Data Type
 l Absolute Values - This option directly uses the transient values for the pipes being anim-

ated. Impulse will then automatically generate evenly spaced values in between the abso-
lute minimum and maximum which will be displayed on the color scale.

 l Relative Changes - This option displays the changes in the transient results relative to the 
steady state values in order to animate the delta throughout the run. Impulse will determine 
the maximum and minimum changes from the steady state, then automatically generate 
evenly spaced intervals between these values to display on the color scale.

 l Maximum Values - This option does not animate the data, but instead colors the pipes 
based on the maximum values during the transient for each of the pipe stations.

 l Minimum Values - This option does not animate the data, but instead colors the pipes 
based on the minimum values during the transient for each of the pipe stations.

 l Smooth colors between pipe sections - This choice sets the color gradient on the Workspace 
to be displayed as a smooth transition, rather than an abrupt transition in color.

 l Borders between pipe sections - This choice displays lines on the pipes to explicitly delineate 
the sections. This can only be enabled if the smooth colors option is disabled.

 l Pipe Thickness - This option adjusts the thickness of the colored animation pipes. The thickness 
of the original pipes can be adjusted in the Pipe Properties window on the Optional tab.

 l Junction Size - This option allows the size of the junctions on the Workspace window to be adjus-
ted for the animated model. The junctions can also be set to 0% to automatically hide all junctions.

 l Use Lines for Junctions - This option allows the junctions to be represented as bold lines 
instead of symbols as an alternate method of displaying the junction locations.

 l Defaults - This button allows the user to reset the animation settings to the defaults.
 l Parameter - The parameter and units for the animation can be selected
 l Auto Scale - If this box is checked, Impulse will automatically choose the maximum and minimum 

values for the selected parameter to assign the color scale for animation. This box is checked by 
default. 

Note: With Auto Scale active, minimums and maximums will be adjusted as appropriate for the active 
scenario and are not fixed to the maximum and minimum values that were applicable at the time 
of creating the layer.

 l Use Inverted Scale - This option flips the minimum and maximum values on the color scale so 
that lower values are warmer colors and higher values are cooler colors.

 l Maximum - The maximum value for the color scale can be changed here if the Auto Scale box is 
unchecked.
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 l Minimum - The minimum value for the color scale can be changed here if the Auto Scale box is 
unchecked.

 l Reset Label Locations - This resets the location of pipe and junction labels to their default pos-
itions.

Animation settings are specific to each individual animation layer. While only one animation layer can be 
viewed at a time, many can be present in a model and can be toggled with visibility settings or via Layer 
Presets. Animation layers are not scenario-specific, but can be linked by Layer Presets to scenarios to 
automatically display when loading those scenarios in the same fashion as other layer types.

Figure 1: The Layer Settings menu for creating an animated color map

Viewing Animation

Once the Layer Settings have been configured and the animation layer is toggled to visible, several anim-
ation-specific components will appear, including the animation toolbar as shown below.

Figure 2: Components added to the Workspace window when an animation layer is visible
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The animation toolbar has several controls:

 l Play - Start the animation from the current time.
 l Record - Begin playing the animation from the current step, and when the playback is stopped, 

prompt the user to save an .mp4 video recording of the animation to file.
 l Stop - Halt the animation and reset the time to zero.
 l Pause - Pause the animation at the current time.
 l Time - The actual simulation time of the currently displayed data.
 l Step - The simulation step of the currently displayed data.

Note: Input can be typed directly into the Time or Step text boxes to quickly navigate to a desired time 
step or to the one nearest to a desired point in time.

 l Time/Step slider - Seek for a certain point in the animation. 
 l Speed slider - Change the speed of the playback.

The Current Time box and Scale can be moved anywhere within the Graph area.

Using Animations to Interpret Behavior

There are many ways that animations are helpful in interpreting behavior. Below, we consider the simple 
case of a valve closure. Visualizing pressure changes or velocities over time allows an engineer to see 
how pressure waves propagate through a system, including where they originate, their timing and mag-
nitude, and how they reflect within the system. Animation Layers communicate this information more 
clearly than graphs and numbers alone, providing additional insights.

Figure 3: Transient velocities in the pipes can be directly visualized

Related Topics
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Transient Result Accuracy
Modeling transient, compressible flow in a pipe network is an inherently imprecise endeavor. Individually 
modeling transient flow, compressible flow, or transient compressible flow in a single pipe can be done to 
a high degree of precision, but the practical application of all three factors forces limiting assumptions to 
be made. AFT xStream is no exception. The methods it employs start from three fundamental equations: 
conservation of mass, momentum, and energy. However, solving those equations on a practical scale 
requires several limiting assumptions that introduce some amount of error into the results. The derivation 
process and these assumptions are discussed in detail in the Transient Theory section.   

As the user analyzes and interprets their transient results, it is important they keep in mind how the 
assumptions behind the MOC solution introduce error, how to gauge that error, and how to reduce that 
error.   

Sources of Error   

The MOC solution process includes multiple assumptions, with two primary assumptions being made. 
First, flow parameters are assumed to vary linearly between computation stations, allowing linear inter-
polation to be performed. Second, fluid properties are assumed to be constant  while integrating along 
characteristic lines, allowing those integrals to be solved directly. In effect, this means that fluid prop-
erties are only updated once per time step, with their change over time assumed to be linear.   

The nature of the MOC solution forces both assumptions to be made. The MOC solution requires that the 
time step at each location in the system be uniform, meaning the section length must also be held con-
stant. In an incompressible fluid system such as an AFT Impulse model, these assumptions introduce a 
minimal amount of error. However, in a compressible fluid system such as an AFT xStream model, these 
assumptions introduce a potentially significant amount of error as the compressible nature of a gas 
means flow parameters and fluid properties are changing continuously in time and space.   

Users of AFT Arrow may be familiar with how Arrow captures the continuously changing nature of com-
pressible flow. Arrow calculates results at intervals along a pipe which are adjusted based on the change 
in Mach number, thus the compressible flow effects along a whole pipe are accurately captured even 
though properties between computation stations are assumed to change linearly.   

xStream however, does not have the ability to adjust the locations at which properties are calculated to 
be specific for an individual pipe. Section lengths must be held constant across all pipes in a system. 
Adjusting the location of computation stations along a single pipe would require the time step to change 
across the simulation, which in turn could cause time to run faster in some parts of the system than in oth-
ers.   

Gauging Error   

These assumptions have the major implication that mass and energy may not be perfectly conserved 
along the length of a pipe. The error introduced by these assumptions increases as the compressible 
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flow effects become more pronounced. At low Mach numbers, mass and energy can be almost perfectly 
conserved, while near the sonic velocity, potentially significant amounts of mass and energy may escape 
the system.   

Users can gauge this error in their system via two means. The first is more quantitative and is performed 
for the user by xStream. Prior to implementing the MOC transient solver, xStream solves the system 
once using the same computational methods as used by AFT Arrow, and once by running the MOC solu-
tion without any transient events to determine the MOC Steady Solution.   

The mass and energy loss along a pipe in the MOC Steady Solution can then be quantified. The mass 
and energy flow out of each pipe are subtracted from the mass and energy flow into each pipe. In a nom-
inally steady-state system, the difference should be zero. However, the assumptions behind the MOC 
solution mean this difference may not be zero. The steady-state error is reported in the Solution Progress 
window, and the simulation process will be halted if the steady-state error exceeds the allowable set 
points. Figure 1 below, shows what that reported error and halted solution looks like. It is important to 
note that this quantitative approach to gauging error is only valid for a steady-state system. A transient 
system will inherently see differences in inlet and outlet mass and energy flows as waves travel along 
each pipe.   

Figure 1: Solution Progress window showing an example model with high mass and energy conservation 
error   

The second approach users can employ to gauge the error in their systems is more qualitative and must 
be performed by the user. Flow parameters and fluid properties change more rapidly in time and space at 
higher Mach numbers than they do at lower Mach numbers. Thus, in a system which sees high velocity 
or sonic choking either in steady state or during the transient simulation, users can expect to see rel-
atively large mass and energy losses compared to systems with low velocities throughout. While users 
cannot directly quantify those losses, they can expect to be more confident in the results determined by 
xStream at lower velocities.   

Reducing Error   

The best way to minimize the error associated with the assumptions by the MOC solution process is to 
increase the number of sections in each pipe, which also decreases the time step in the simulation. This 
approach is similar to how Arrow captures compressible flow effects in steady-state systems. By cal-
culating system parameters more frequently, the assumptions the MOC solution process makes are viol-
ated to a lesser degree.   

In the Sectioning panel of the Analysis Setup window, users define the minimum number of sections a 
pipe can have. Setting a minimum section number of 5 means the shortest pipe must have at least 5 sec-
tions. Increasing that number forces xStream to use smaller section lengths throughout the entire sys-
tem.   
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Transient Sensitivity Analysis Tutorial
AFT xStream requires a large number of inputs to be defined in order to run a transient simulation. Many 
of those inputs directly affect the transient simulation results, and it is important for users to carefully eval-
uate that effect. This tutorial will focus specifically on three parameters: the Minimum Number of Sections 
per Pipe defined in the Sectioning Panel, the Fluid Property model used, and the estimated Maximum 
Mach Number in Pipe value.

We will use the model shown below in Figure 1 of a system with an abrupt stoppage of flow at a Turbine 
Shutoff Valve (TSV) to indicate how a user might analyze results and refine these inputs over sub-
sequent runs. To help quantify how these parameters impact the transient simulation results, we will look 
at transient forces in the system, using a Difference Force Set applied to each pipe. Please note that this 
tutorial is not meant to be an exact step-by-step procedure to follow, but is instead meant to be a general 
guideline to help the user better understand how to evaluate xStream results.

Figure 1: Layout of Tutorial Example
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Baseline Results

We must start our sensitivity analysis by determining some baseline results for the system. The first run 
of the model uses standard settings for all inputs: AFT Standard Steam using the Three-Parameter 
method, the default Maximum Pipe Mach Number During Transient of 1, and a Minimum Number of Sec-
tions per Pipe of 10. Force results from this run for Pipes 2,3,8, and 9 are shown below in Figure 2.   

Pipes P2 and P9 see the largest transient forces in this model, mostly because P2 and P9 are 120 ft long 
with the other pipes in the system are 40 ft long. Transient forces are caused by the presence of transient 
waves with some pressure differential across them traveling through the system. A longer pipe which is 
long enough to contain the entire wavefront will see a larger pressure differential across it than a shorter 
pipe which only ever sees a portion of the wavefront. Thus, longer pipes tend to see larger transient 
forces, with the maximum transient force seen when the entire wavefront is shorter than the pipe length.

We can also see that P2 experiences a significantly higher maximum transient force than P9 even 
though they have the same length. This difference is due to wave coalescence (or wave steepening). A 
wave moving through a gas raises the local temperature, in turn raising the local sonic velocity. The tem-
perature and sonic velocity behind the wavefront is thus higher than that ahead of the wavefront, mean-
ing the back of the wavefront can have a higher wave velocity (V+a) than the front of the wavefront. As 
the wave travels, the back of the wavefront will catch up to the front of the wavefront, steepening the 
wave until a shock wave is formed.

In this example, P9 is closer to the transient event at J11, and the wavefront is still relatively dispersed. 
However, the wavefront has steepened by the time it reaches P2, meaning more of the wavefront can fit 
in P2 and a larger transient force is seen.

This tutorial will focus on the transient force results from P2, as they are the largest magnitude forces in 
the model.

Figure 2: Force Results for AFT Standard, 10 Minimum Sections, Standard Maximum Mach Number in Pipe
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Minimum Number of Sections Per Pipe

The first parameter for our sensitivity analysis is the Minimum Number of Sections Per Pipe. The 
baseline scenario used a minimum of 10 sections, and we will also run scenarios with a minimum of 50 
and 100 sections. All other inputs are held constant, and results for the P2 Force Set are shown in Figure 
3 below.

Comparing the 10 section and 50 section scenarios, the 50 section scenario gives a force that is 4,504 N 
higher than the 10 section run (or approximately a 5.6% difference). This difference indicates that using a 
minimum of 10 sections was too low, since using a finer grid has a noticeable effect. However,  the 50 sec-
tion and 100 section scenarios have minimal differences in the force results. This similarity indicates that 
the error inherent to applying the Method of Characteristics (MOC) to a compressible fluid may have 
been reduced when using a minimum of 50 sections, and using a finer grid will not reduce that error fur-
ther.

We now know that 50 sections is a good point to balance accuracy with run-time concerns.

Figure 3: Effect of Sectioning on Forces

Fluid Property Model

The next parameter for our sensitivity analysis is the Fluid Property Model. The baseline scenario used 
AFT Standard Steam with the Three-Parameter equation of state, and we will also run scenarios using 
AFT Standard Steam with the Redlich-Kwong equation of state, Chempak Steam, NIST REFPROP 
Steam, and ASME Steam. All other inputs are held constant, and results for the P2 Force Set are shown 
in Figure 4 below.
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The results shown in Figure 4 below show that the Fluid Property Model can have a substantial impact on 
results. The largest difference in results is between the Chempak and Redlich-Kwong results, with an 
absolute difference of  14,804N, or a relative difference of 18%.

The observed difference in transient force magnitude for various Fluid Property models forces us to eval-
uate which model is best suited for this system.The Redlich-Kwong and Three-Parameter equations of 
state were developed for light, non-polar molecules - hydrocarbons in particular.  Water (or steam, in 
xStream) is a relatively light molecule which is highly polar, meaning the accuracy of those Fluid Property 
models may be reduced when evaluating the steam in this system. Chempak has an increased accuracy 
from the AFT Standard Steam models, and gives force results which are substantially higher. It is difficult 
to say how reliable the Chempak results are until we compare them against other models.

Finally, the scenarios using NIST REFPROP Steam and ASME Steam give effectively identical results, 
and the source for each model (NIST and ASME, respectively) is highly reliable.   We can thus say that 
these results are the most reliable results, and they should be used for subsequent runs of our model. 
The only distinguishing factor between these two Fluid Property Models is the model run time, where the 
NIST REFPROP model will run significantly faster than the ASME Steam model. See the Fluid Property 
Model example for more information on this topic.

To learn more about the strengths and weaknesses of each fluid property library, visit the Fluid panel 
topic. Note that while the NIST REFPROP and ASME Steam models may offer improved accuracy, the 
AFT Standard fluid models run significantly faster. Users should always use the AFT Standard fluid mod-
els for initial runs as the xStream model is gradually refined.

Figure 4: Effect of library on Forces (minimum 50 sections used in each pipe, ASME Steam has indis-
tinguishable differences from NIST REFPROP and thus cannot be seen in this figure)
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Effect of Maximum Pipe Mach Number During Transient

The last parameter for our sensitivity analysis is the Maximum Pipe Mach Number During Transient, 
defined in the Pipe Sectioning and Output panel. The MOC grid size is determined by the  wave velocity 
(V+a), using the maximum estimated sonic velocity. This maximum sonic velocity is in turn a function of 
the Estimated Maximum Pipe Mach Number During Transient and the Estimated Maximum Pipe Tem-
perature During Transient input parameters. Refining the estimated maximum sonic velocity can improve 
the accuracy of our results by reducing the amount of interpolation necessary while performing the MOC 
calculations.

The results for our model when using a minimum of 10 sections and ASME Steam show a Maximum 
Mach Number of 0.06, seen in Figure 5 below. Reducing the Estimated Maximum Pipe Mach Number 
During Transient from the default value of 1 to a value closer to 0.06 may improve our results.

Figure 6 below compares transient force results with Estimated Max Mach Numbers of 1, 0.5, and 0.1. A 
scenario with 50 sections is included as a reference for what the expected results are, based on our pre-
vious analysis of how sectioning affects results. We can see that better estimates of the Max Mach Num-
ber for the transient simulation bring the results with 10 sections closer towards the 50 section reference 
results. However, better estimates for the Max Mach Number are unable to make the 10 section results 
match the 50 section results, indicating that the user should use the Estimated Max Mach Number para-
meter to compliment adding additional sections rather than to replace adding additional sections.

Caution: Never define the Estimated Maximum Pipe Mach Number During Transient lower than the 
value observed in the system! An estimate lower than the actual value will force the MOC cal-
culations to extrapolate, which can add significant instability and uncertainty to the results. Out-
put which shows that the specified maximum Mach number was exceeded should be 
disregarded, and a better Estimated maximum Pipe Mach Number During Transient should be 
defined.

Figure 5: Maximum Mach Number obtained from 10 Sections, ASME Steam, Maximum Mach Number of 1
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Figure 6: Effect of Maximum Pipe Mach Number During Transient on Forces

Comparing Initial and Optimized Inputs

Our sensitivity analysis on Minimum Number of Sections Per Pipe, Fluid Property Model, and Estimated 
Maximum Mach Number in Pipe showed what inputs to use for this model. Figure 7 below compares the 
initial results (10 minimum sections, AFT Standard Steam with the Three-Parameter equation of state, 
and a Max Mach Number of 1) against the final results (50 minimum sections, ASME Steam, and a Max 
Mach Number of 0.1). These transient force results show a different timing of the transient waves, a dif-
ferent shape of the wavefront, and a difference in the maximum force magnitude of 11,215N.

These differences help show the importance of gradually refining the model input parameters. Initial runs 
should be performed with default or more simple options which have faster run times as the user starts to 
understand the system. Then, the user should refine the inputs for more advanced parameters to reduce 
the uncertainty in their results.

Note that some systems may be more sensitive or less sensitive to the three parameters considered in 
this tutorial. The user should follow these steps on their own system and use their engineering judgment 
to determine the best model inputs.
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Figure 7: Initial Run vs Modified Run
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Fundamental Modeling Concepts
This section focuses on the critical concepts and theories that comprise the model building process in 
AFT xStream. Topics include discussions on the role of pipe and junction objects, descriptions of how 
boundary conditions and flow direction are specified, and instructions on how to model closed systems.

Contents
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Stagnation vs. Static Pressure Boundaries 77

Pipes and Junctions
AFT xStream employs two fundamental pipe system constructs: pipes and junctions. 

Pipes are conduits for one-dimensional gas flow. Pressure drop due to friction occurs in pipes.

Junctions are connector points for pipes and are elements at which flow balances are made and where 
transients are initiated. Some junction types can only connect to one pipe; others can connect with up to 
twenty-five.

In addition to balancing flow, junctions also influence the flow or pressure behavior of the system. For 
example, an infinite tank junction applies a constant pressure at a location, and the flow there is free to 
adjust in whatever manner is consistent with the governing equations. In contrast, an assigned flow junc-
tion applies a known flow rate at its location, allowing the pressure to adjust to that level dictated by the 
governing equations. The various junction types allow you to specify special kinds of transient behavior, 
irrecoverable pressure losses, or fluid behavior. 

Junctions communicate with each other through the pipes connecting them. Each pipe must be con-
nected to two junctions. There are no exceptions to this rule. 

A pipe differs from a junction in that it has a reference positive flow direction. To say a pipe has a flow rate 
of 1 lbm/sec is meaningless unless the flow direction is specified.
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In general, you do not need to specify the actual flow direction in a pipe, because AFT xStream sorts out 
the true physical flow directions of the system you define. For example, if you specify the reference pos-
itive flow direction from left to right, and the solution is in fact the opposite direction, then that information 
will be presented in the output as a negative flow rate. Inlet and outlet conditions correspond to the ref-
erence positive flow direction, not the actual flow direction. However, for easier analysis of results, it can 
be helpful to ensure all pipes are configured so that they have positive flow in the steady state system. 

It is important to specify the proper flow direction for pipes which connect to junctions such as com-
pressors/fans or control valves. AFT xStream uses the flow direction of the pipes to determine in which 
direction to increase or reduce pressure.

Features for Modeling Irrecoverable Losses
AFT xStream works almost exclusively with the concept of the loss factor, also known as K factor or res-
istance factor. In some Properties windows, other popular methods for specifying loss information are 
provided where they are consistent with the loss factor method. For example, you will find Cv (flow coef-
ficients) for valves. No provision has been made for the equivalent length approach to solving pressure 
drop problems. See the Junction Loss Models section for more information.

Related Topics

Conventions for Specifying Basis Area 213
Pressure Drop in Pipes - Detailed Discussion 205

Reference Positive Flow Direction

Reference Positive Flow Direction

Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for the pipe. 
AFT Fathom assigns a flow direction corresponding to the direction in which the pipe is drawn. You can 
reverse the reference positive flow direction by choosing Reverse Direction from the Arrange menu or 
selecting the reverse direction button on the Toolbar. With exception to some junctions, the reference 
positive flow direction is used for reference purposes only and does not need to correspond with the real 
direction of flow calculated by the Solver (the part of AFT xStream that applies the governing incom-
pressible flow equations to obtain a solution to the pipe system). If the flow direction obtained by the 
Solver is opposite of the reference positive flow direction, then the output will show the flow rate as a neg-
ative number.

Note: The reference positive flow direction is important for compressors because the pipe directions 
will define which side is suction vs discharge. Furthermore, reverse flow through components 
may result in a Caution message which may or may not be valid depending on the intended dir-
ection of flow.
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Convention for Flow Entering and Exiting

Many of the junction types permit gas flow to come into or pass out of the system in a prescribed manner. 
The most obvious of these is the Tank junction. Tanks maintain a constant pressure and temperature at a 
node, and the flow adjusts according to the governing equations. While in principle the gas is stored or 
removed from the tank, AFT xStream considers the gas as coming into or going out of the system. The 
stored tank fluid is not part of the system.

The convention for defining inward or outward flow for the system or any AFT xStream object is that flow 
in is positive (that is, the object/system gains the flow) and flow out is negative (the object/system loses 
the flow).

Philosophy of Computer Modeling
Some might say that a "good" computer model is one that accurately predicts the response of a system; 
but this is only partly true. The practicing engineer generally must weigh the accuracy of the model 
against the risk, schedule, and/or budget involved. Through experience an engineer learns where to 
focus resources and when an answer is good enough to base important decisions on.

Although AFT xStream is designed to speed up the modeling process, it should never be used as a 
"black box". Your model input and output should always be carefully reviewed.

To make the most effective use of AFT xStream, you should follow these guidelines:

 l Be aware of what AFT xStream can and cannot do and the assumptions it makes.
 l Learn and use the tools in AFT xStream that are appropriate for the specific analysis you want to 

perform. Detailed and accurate answers demand detailed and accurate input. Quick and dirty 
answers require less detailed input.

 l Learn and use the tools in AFT xStream that allow you to process information in the formats that 
mean the most to you. Because pipe flow applications vary so much within different industries, 
AFT xStream is customizable for the way you want to do your pipe flow work. Understanding the 
tools will help you gain greater conceptual control over your pipe flow analysis and reduce mod-
eling errors.

 l Check your input data. Use the features available in AFT xStream to review your results for input 
errors. Pay attention to the information in the output report. Don't neglect warnings in the output. 
Perform hand analysis checks of results.

 l Bound your problem. Instead of trying to calculate the exact resistance in a network, or the right 
loss factor for an orifice, use your judgment, guided by data, on how much variation might occur. 
By running your model at the upper and lower limits, you can obtain answers, for example, on the 
maximum and minimum possible pressure drops in the system. If the results at the maximum and 
minimum are acceptable, your analysis is probably finished. If they are not acceptable, you can fur-
ther refine the input model.

 l Recognize whether your problem is one of maximization or minimization. That is, recognize 
whether the design goal is to minimize the flow rate, for example, or maximize the flow rate. Then 
make your assumptions conservative enough to provide high confidence that your design require-
ments are being satisfied.
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Role of Pressure Junctions and How They Work

Role of Pressure Junctions

In modeling a generalized pipe network, it is possible to construct models that do not have a unique solu-
tion. A common occurrence of this is when a model contains one or more sections which are completely 
bounded by known flow rates. The simplest example is the system shown in Figure 1. In AFT xStream 
terms, the system has two assigned flow junctions.

Figure 1: Model with two assigned flows. This model does not have a unique solution.

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It cannot be 
determined because there is no reference pressure. The reference pressure is that pressure from which 
other pressures in the system are derived. There can be more than one reference pressure, but there 
always has to be at least one.

The model in Figure 1 can be built with AFT xStream and if you try and run this model, AFT xStream will 
inform you that it cannot run it because of the lack of a reference pressure (Figure 2). In AFT xStream 
there are several junctions that can act as a reference pressure: the tank, assigned pressure, valve (with 
the exit valve option), and pressure control valves.

When you try and run a model that has one or more sections completely bounded by known flows (or 
Flow Control Valves or Compressors/fans operating in assigned flow mode), the Need Reference Pres-
sure window (shown below) is displayed. This window informs you which junctions bound the sections 
where a reference pressure is needed to obtain a unique solution.

In multi-pipe systems there are a host of other possibilities that present themselves. All other con-
figuration possibilities which lack a reference pressure ultimately boil down to the same problem that 
exists in Figure 1.

See Role of Pressure Junctions - Detailed Discussion (Long) for more information.
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Figure 2: AFT xStream message when you try to run a model without sufficient reference pressures

How Pressure Junctions Work

Pressure junctions (e.g., Tanks or Assigned Pressures) in AFT xStream are an infinite source or sink of 
fluid. This means that they can draw or discharge as much fluid as is necessary to maintain the specified 
pressure. Some engineers have difficulty grasping this concept, and misuse pressure junctions in AFT 
xStream. This section offers a physical example of how pressure junctions work to clarify for those hav-
ing difficulty with the concept.

Consider the physical system shown in Figure 1. This system compresses air from a low pressure supply 
tank to a high pressure discharge tank. 

Figure 1: Physical compressor system to transfer air from low pressure tank (J1) to high pressure discharge 
tank (J2) 

An engineer is tasked with sizing the compressor for this system. The engineer has an idea of the dis-
charge pressure needed for the compressor, and builds an AFT xStream model as shown in Figure 2. 
The Figure 2 model is attempting to represent the physical system in Figure 1, but it in fact represents the 
physical system in Figure 3.
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Figure 2: Model to size compressor attempting to represent system in Figure 1, but actually represents the 
system in Figure 3

Figure 3: Physical system represented by model in Figure 2

Why? Because the tank junction (J4), which is an infinite source of fluid, has been located between the 
compressor (J3) and the discharge tank (J2). The J4 tank isolates the supply tank and compressor (J1 
and J3) from the discharge tank (J2). The J4 tank is very much like placing the atmosphere between the 
supply and discharge piping. 

If the engineer changes the pressure in J4, it is like changing the atmospheric pressure. It will change the 
flow rate in the pipes, but no matter how high the pressure of J4, it does not change the fact that the com-
pression system is isolated from the discharge tank. The flow rate in the piping from J4 to J2 is entirely 
dependent on the difference in pressures between J2 and J4, and is not influenced by the J3 compressor 
in any way.

How then should the physical system in Figure 1 be modeled? It should be modeled as shown in Figure 
4.

Figure 4: Proper model of physical system shown in Figure 1

If the goal is to size the compressor at J3, the model is Figure 4 can be used with the compressor 
modeled as a fixed flow compressor.

Related Topics
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Role of Pressure Junctions - Detailed Discussion (Long) 518
Assigned Pressure 238
Tank 280

Related Blogs

Reference Pressure Needed: Where It Comes from and How to Address it

Open vs. Closed Systems

Model a Closed Loop System

A closed circulating system can easily be modeled with AFT xStream by locating a Tank junction any-
where in the system and setting the pressure to the known pressure at that point. Inflow and outflow 
pipes will then need to be connected. The Tank junction merely acts as a reference pressure against 
which all other pressures in the system are compared. Because there are no other inlets or outlets to the 
system, then whatever is delivered by the Tank junction to the system will also be received from the other 
pipes, thus achieving a net zero outflow rate for the system.

Balancing Mass

In order to model a closed system, only one pressure junction is used in the model. Typically this would 
be a Tank junction. Pressure type junctions are an infinite source of fluid and do not balance flow. How 
then can one be used to flow in a closed system?

To answer this question, it is worth considering how AFT xStream views a closed system model. AFT 
xStream does not directly model closed systems, and in fact does not even realize a closed system is 
being modeled.

Consider the system shown in Figure 1. This is an open system. Fluid is taken from J1 and delivered to 
J4 and J5. Because the AFT Arrow Steady solution engine in xStream solves for a mass balance in the 
system, all flow out of J1 must be delivered to J4 and J5. Because the flow is steady-state, no fluid can be 
stored in the system; what goes in must go out.

https://www.aft.com/support/product-tips/reference-pressure


Fundamental Modeling Concepts

- 74 -

Figure 1: Open system - Flow out of J1 equals the sum of J4 and J5

Now consider the systems in Figure 2. The first system appears to be closed, while the second appears 
to be open. If the same boundary condition (i.e., pressure, temperature and surface elevation) is used for 
J1, J11 and J12 in the second system, to AFT  xStream it will appear as an identical system to the first 
system. The reason is that AFT xStream takes the first system and applies the J1 tank pressure as a 
boundary condition to pipes P4, P9 and P10. The second system uses three tanks to apply boundary con-
ditions to P4, P9 and P10. But if the tanks all have the same pressure, temperature and elevation, the 
boundary conditions are the same as J1 in the first system. Thus the same boundary condition is used for 
P4, P9 and P10 in both models, and they appear identical to AFT xStream.

But how is the flow balanced at J1 in the first system? Looking at the first system, one sees that to obtain 
a system mass balance, whatever flows into P10 must come back through P4 and P9. Because there is 
overall system mass balance by the solver, it will give the appearance of a balanced flow at the pressure 
junction J1. If there is only one boundary (i.e., junction) where flow can enter or leave the pipe system, 
then no flow will enter or leave because there isn’t anywhere for it to go. Thus the net flow rate will be 
zero at J1 (i.e., it will be balanced). But recognize that AFT xStream is not applying a mass balance to J1 
directly. It is merely the result of an overall system mass balance. 

Figure 2: The first system is closed, and the second open. In both systems the flow into P10 is the same as 
sum of P4 and P9. If the second system has the same conditions at J1, J11 and J12, the two system will 

appear identical to AFT xStream
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Balancing Energy

Consider the system shown in Figure 1. We know that the flows are balanced at J1, but how can the 
energy be balanced? For example, assume the user sets an initial temperature of 100° F at J1. This tem-
perature will be the inlet pipe stagnation temperature for all pipes that flow out of J1 in the steady-state. In 
this case, the 100° F will apply only to pipe P10.

The pipes flowing into the tank (P4 and P9) will have their own temperatures that are obtained by bal-
ancing energy along their individual flow paths. This could include heat exchanger input and heat trans-
fer to or from pipes, as well as any heat of compression effects from compressors.

The only way to obtain an overall system energy balance is for the J1 tank temperature to adjust to the 
mixture temperature (mixture stagnation enthalpy, to be more precise) of all inflowing pipes. This can be 
enforced using the Finite tank option with an Adiabatic Thermodynamic Process. There is a unique “mix-
ture temperature” (or mixture stagnation enthalpy) that will yield an energy balance at J1. This will be the 
temperature/enthalpy from Equation 49.

Figure 1: Example of balancing energy in a closed system

Curve Fitting
There are many places within the interface where the user may be asked to define how a property 
changes in relation to another. Some examples include:

 l Compressor/Fan Curves
 l Junction Resistance Curves
 l Custom Fluids
 l Pipe Physical Properties

These properties are entered in a tabular format, relating a particular property to one or several others. 
For example, see the below definition of a custom fluid:
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Figure 1: Custom Fluid Definition

There are several parameters that control the behavior of the fluid and they are entered as they relate to 
temperature.

However, it is important to recognize that these values in particular are not directly used in the solution. 
Instead, the data is used to create a best-fit curve. This curve is then used in the solution process. This is 
an important step to take because there must be a continuous relationship between the independent vari-
able (e.g. temperature) and the dependent variable (e.g. density). Even if the final solution was close to 
one of the defined points, the Solver needs continuous data to proceed.

There are some options for how the data is curve fit. First, there are two Curve Fit Types:

 l Polynomial - The data is best fit to a polynomial of order 0,1,2,3, or 4. Note that a 0th order poly-
nomial is a constant value, and a 1st order is a linear fit.

 l Interpolated X-Y Data - The data has a linear interpolation drawn between every data point.

One of the critical items to note with any curve fit is that you may not be operating close to one of your 
defined points if the data does not conform well to a polynomial relationship. For example, the below fluid 
(a liquid) has a rapidly decaying viscosity that does not follow a polynomial relationship. Fitting the data to 
the standard 2nd order polynomial results in the following:
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Figure 2: Using a Polynomial Curve Fit on Non-Polynomial Data

The viscosity relationship in the model will use the blue curve, and not the user-defined black points. 
Depending on the operating range of the system, this may significantly impact the results! For this data in 
particular, using the Interpolated X-Y Data option may be a better choice.

After data has been curve fit, the constants for the resulting curve are displayed in the lower-right of the 
associated window.

Related Topics

Compressor Configuration 250
Resistance Curve Loss Model 223
Fluid Library 432
Pipe Material Library 433
General Component 272
Heat Exchanger 273
Reference Density 213

Stagnation vs. Static Pressure Boundaries
With two exceptions (to be discussed), all pressure-type boundary conditions in AFT xStream are stag-
nation. This works very well for things such as large storage tanks or atmospheric boundaries, where the 
volume associated with a pressure is large and will not change (significantly) with time. These bound-
aries have no velocity associated with them, and using stagnation pressure is thus appropriate. These 
boundary conditions are most clearly rendered in AFT xStream by use of a Tank junction.

For simplicity, we will discuss this in terms of an incompressible flow example. Consider the tank and con-
nected pipe in Figure 1. When the fluid in a tank flows into connecting pipes, the static pressure imme-
diately drops due to the increase in velocity.

It is tempting to say that because there is no velocity in the tank, then it does not matter whether the tank 
boundary pressure is considered as a static or stagnation pressure because they are equal. This is a mis-
conception. The pressure boundary condition in an AFT xStream model is applied at the exit of the junc-
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tion, not within the junction itself. Inside the tank, the static and stagnation pressures are the same, but 
they are not the same at the exit - they differ by the amount of the dynamic pressure.

Note: An incompressible liquid flow example is given because it is easier to discuss, but the principles 
apply similarly to compressible flow.

    
Figure 1: Pressure profile along horizontal pipe shown in Figure 1 (incompressible flow)

The appropriateness of either stagnation or static pressure as a boundary condition depends on whether 
there is a velocity associated with the pressure that is specified. Is the pressure in a vessel or large (lower 
velocity) header, or is it in a pipe somewhere in the middle of a system? If the first, stagnation is more 
appropriate; if the second, static.

Pressure boundary conditions with no velocity are more common across all piping industries, and are 
usually appropriate. However, this is not always the case.

When to use Static Pressure 

Now let's consider the application of a true static pressure boundary condition. A static boundary con-
dition has a unique velocity associated with it. The Bernoulli equation, which in this integrated form 
applies only to incompressible flow, is given by:

From this equation it can be seen that application of the static pressure is not sufficient to specify location 
1. The velocity and elevation is also required. Note that though the equation above is only applicable for 
incompressible flow, the general concept is applicable for compressible flow.

In AFT xStream, elevation data is entered for junctions. The pipes adopt the elevation of the junction to 
which they are connected.

But where does the velocity information in the Bernoulli equation come from? One might respond that it 
can be obtained from the flow rate. But this raises another question: what if the flow rate isn’t known? Put 
another way, what if the flow rate is what we are solving for?
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Because the stagnation pressure combines the static pressure with the velocity information (in the form 
of Mach number, see Stagnation Pressure definition), when the user supplies a stagnation pressure 
boundary condition AFT xStream can avoid the need for an associated velocity condition at location 1. A 
stagnation pressure boundary can thus be supplied to multiple pipes that might have different velocities. 
That is why the same Tank junction can connect with multiple pipes.

However, if the user specifies a static pressure as the boundary condition, a unique velocity (or Mach 
number) must be supplied. Thus it is only possible to connect a static pressure to a single pipe with a 
unique velocity.

Important: A static pressure boundary has a unique velocity (and Mach number) associated with it, 
and can thus connect to only one pipe.

Where would one find a static pressure boundary? The best example is when the boundary condition is 
inside a pipe. A pipe system model can start and end anywhere it is convenient for the user. It may be 
convenient to not start the model at the physical boundary (such as a tank) but at a particular location in 
the pipe system. This could be, for example, at the location of a pressure measurement. Or it could be at 
the boundary of the pipe system for which your company is responsible, with another company respons-
ible for what is on the other side of that boundary.

If one needs to model such a situation, the Assigned Pressure junction allows one to model either a static 
or stagnation pressure. The default stagnation pressure allows connection of up to 25 pipes. If static pres-
sure is chosen, only one connecting pipe is allowed.

Static Pressure at Pressure Control Valves

Another example of static pressure is at pressure control valves. For pressure control valves (i.e.,  PRV’s 
and PSV’s) the default control pressure is static pressure. The reason is that the measured pressure that 
provides feedback to the controller will typically be a static pressure measurement. You have the option 
of modeling pressure control valves as either static or stagnation pressure.

Related Topics

Review of Compressible Flow Theory 450
Stagnation Properties 493



- 80 -

Analysis Setup Overview
The Analysis Setup window contains all of the settings which the user must define to run the model, 
including fluid properties, steady state and transient solution controls, pipe sectioning settings, and other 
related options. The Analysis Setup window can be launched from either the toolbar or the Analysis 
menu.

The controls in Analysis Setup are divided into different groups in the navigation pane on the left of the 
window (Figure 1). Each group has one or multiple items. Clicking on an item opens the panel for that 
item. 

A group is not fully defined until each item in that group is defined. Each group will have either a green 
check mark, indicating that all required items have been defined, or a red exclamation point, indicating 
that some or all of the required inputs are missing. Note that some groups will have a green checkmark 
by default, indicating that the required inputs have default settings already applied, or all inputs for that 
group are optional. Groups that are undefined will change to a green check mark when the required 
inputs for that group are entered, and the user navigates to a different panel. Note that none of the 
changes will be applied to the model until OK is selected. Clicking Cancel will discard all changes made 
in the window.

The groups in Analysis Setup are

 l Modules Group
 l Fluid Properties Group
 l Pipes and Junctions Group
 l Pulsation Setup Group
 l Pipe Sectioning and Output Group
 l Transient Control Group
 l Forces Group
 l AFT ArrowTM Steady Solution Group
 l Environmental Properties Group
 l Miscellaneous Group
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Figure 1: Default state of the Analysis Setup window in a new blank model

Modules Group
AFT xStream has one optional add-on module which extends its modeling capabilities into other areas. 
The modules allow pulsation frequency  modeling. The Modules panel in the Modules group in Analysis 
Setup allows you to activate and enable the add-on modules. An additional license to the base AFT 
xStream license is required to use a module. These modules include:

 l PFA (Pulsation Frequency Analysis) - Helps identify and avoid resonant frequencies in systems, 
especially in those caused by positive displacement compressors.

Modules Panel
The Modules Panel allows users to activate and enable the optional add-on modules and/or cost cal-
culations. 

Activating a module checks out a license seat for the module.

Enabling a module turns on all functionality for the module. By default activating a module will also auto-
matically enable the module for use. Disabling a module keeps the license seat checked out but the mod-
ule calculations are not applied to the model. Disabling a module may be desired for various reasons, as 
is discussed further for each module below.

Note:  A module specific license is required to activate the PFA add-on module.
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Figure 1: The default state of the Modules panel

PFA (Pulsation Frequency Analysis)

Activate the Pulsation Frequency Analysis (PFA)module by checking the box next to Activate PFA. Once 
activated,  enable it by selecting Use or disable it by selecting Ignore.  When the PFA module is activated, 
the Pulsation Setup group appears in the Analysis Setup. The Pulsation Setup group has one item, Pulse 
Setup.

The PFA module can be enabled before or after a model is built. Pre-existing models built with the base 
AFT xStream application  can have the PFA module activated.

Setting the PFA module to Ignore causes the PFA module to function like the base AFT xStream applic-
ation. One difference is that users are still able to enter pulsation data and it be retained in the model. If a 
model with PFA input is opened in the base AFT xStream application that cannot access a license to 
PFA, this data will be lost. Table 1 relates the differences  between using AFT xStream without the PFA 
module activated, using it with the PFA module activated but disabled (Ignore mode), and using it with 
the PFA module activated and enabled. 

The PFA module  can also be toggled between Use and Ignore from the Analysis menu in the Pulsation 
Frequency Analysis option as shown in Figure 2. Use this feature to quickly toggle the PFA module 
between Use and Ignore without opening the Modules panel in Analysis Setup. 
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Table 1: AFT xStream feature accessibility based on PFA activation and enablement

Feature PFA Not 
Activated

PFA Activated

PFA Dis-
abled PFA Enabled

Pulsation 
Setup group 
in Analysis 

Setup

Not Visible Visible Visible

Pulsation Fre-
quency Ana-

lysis in 
Analysis 

menu

Not Visible Visible Visible

Pulsation 
Setup 

in Analysis 
menu

Not Visible Visible Visible

Steady-State 
Pulsation Tol-
erance on Tol-
erance panel

Not Visible Not Visible Visible

Frequency 
tab in Graph 

Control, 
Graph Res-
ults window

Not Visible Not Visible Visible

Figure 2: Select Use from the Pulsation Frequency Analysis in the Analysis menu to perform pulsation ana-
lysis
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Fluid Properties Group
The Fluid Properties group in Analysis Setup gives you control over the fluid properties that influence 
your pipe system analysis.              There is one item in the Fluid Properties Group, the Fluid panel.

Related Topics

References 499

Related Blogs

Get More Flexible With Your Fluids

Fluid Panel
The Fluid panel controls the properties of the fluid in the model. A default fluid is not selected - one must 
be defined to run any simulation unless one was previous defined on the Startup Window.

The first selection that must be made is what Fluids library to use. The available Fluid Libraries are:

 l AFT Standard - Common fluids from various industry standard sources have been curve fit to 
optimize calculation speed. This fluid library offers the best balance between accuracy and com-
putation time. Saturation line data was added for AFT Standard fluids in xStream 2.

 l ASME Steam Tables - Properties are calculated via the Equations of State which were used to 
generate the classic steam/water tables in the IAPWS Industrial Formulation (1997). Saturation 
line data is included.

 l NIST REFPROP - The Reference Fluid Thermodynamic and Transport Properties (REFPROP) 
Database is licensed from the National Institute of Standards and Technology (NIST) where prop-
erties for approximately 150 fluids are calculated via Equations of State. REFPROP supports 
user-specified fluid mixtures. For more info see the following sources: Program Summary, 
REFPROP FAQ, NIST Chemistry WebBook, NIST Chemical Name Search.

 l Chempak Fluid - Optional add-on for purchase which contains data for several hundred fluids 
and supports user-specified fluid mixtures. Chempak is licensed from Madison Technical Soft-
ware.

 l User Library Fluid - If the desired working fluid is not available via the other sources, custom fluid 
properties can be entered and saved to the User Library for repeated use in the future. Fluids can 
be created using the Fluid Libraries menu.

Select a library by clicking the radio button next to the name of the library. After selecting a library, the Flu-
ids Available in Library list is populated. One of the fluids can be selected and used with the Add To 
Model button.

Note: All fluids in xStream are treated as compressible and superheated as stated in the Engineering 
Assumptions.

https://www.aft.com/support/product-tips/get-more-flexible-with-your-fluids
https://www.nist.gov/programs-projects/reference-fluid-thermodynamic-and-transport-properties-database-refprop
https://pages.nist.gov/REFPROP-docs/
https://webbook.nist.gov/chemistry/
https://webbook.nist.gov/chemistry/name-ser/
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When determining which fluid library is most appropriate, it is recommended that you consult the table 
below to ensure your selection suits your needs.

Table 1: Compatibility Chart for Fluid library Selection

Fluid Library
Model Requirements

Mixtures Condensation 
Data

System 
Troubleshooting Final Runs Complex 

Systems*

AFT Standard   P P**   P

NIST 
REFPROP P P   P P

Chempak P P   P P

ASME Steam   P   P  

* Evaluating the complexity of a system is most easily done in early runs of the model. It is suggested that 
all early runs use an AFT Standard fluid (even if the real system fluid is a mixture), and the run time recor-
ded. This run time should inform your decision on which fluid library is needed to run the more polished 
runs when high accuracy results are needed. Run times can vary significantly between the 4 libraries, so 
make sure you evaluate your time constraints and accuracy needs when weighing this decision. Factors 
that can impact the run time include the ratio in the length of the smallest pipe to the largest pipe, pres-
ence of mixtures, usage of junctions containing resistance curve loss models, and the presence of sonic 
choking.

** It is strongly recommended that all runs used to troubleshoot the design of the system are run using 
AFT Standard.

AFT Standard Fluid Library    

The AFT Standard Library offers several equation of state models and enthalpy models. These models 
account for both temperature and pressure dependence on density and enthalpy.

Transport properties (specific heat, dynamic viscosity, and thermal conductivity) and Saturation Pressure 
are based on polynomial curve fits which are functions of temperature only. The assumption that these 
properties are only functions of temperatures is generally a good assumption at low pressure. However, 
at high pressures (especially above the Critical Pressure), this assumption starts to break down.

To add a fluid into your model, select it from the list at the top and choose the Add to Model button. The 
fluid will appear in the lower list of Fluids in Current Model. You can have only one AFT Standard fluid in 
your model, as there is no mixing support for Standard fluids.
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Figure 1: Fluid panel in Analysis Setup with the AFT Standard fluid library selected

ASME Steam Tables

Properties are calculated via the Equations of State which were used to generate the classic steam/water 
tables in the IAPWS Industrial Formulation 1997 for the Thermodynamic Properties of Water and Steam (ISPWS-
IF97), see ASME Press in References.

This library is selected by choosing the option ASME Steam Tables at the top of the Fluid panel. After this 
selection has been made, "ASME ’97 Steam" is displayed in the Fluids in Current Model area at the bot-
tom of the Fluid panel.

Detailed fluid properties information from SteamCalc can be calculated using the AFT SteamCalc 
Viewer, which can be accessed from Tools > Fluid Property Viewers > SteamCalc. The SteamCalc 
Viewer will be launched as a separate application, which can then be used to calculate fluid properties at 
various conditions.

For more information on AFT SteamCalc Viewer see the SteamCalc Help File.

https://docs.aft.com/steamcalc/Content/What_Does.html
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Figure 2: Fluid panel in Analysis Setup with the ASME Steam fluid library selected

NIST REFPROP Library

The Reference Fluid Thermodynamic and Transport Properties (REFPROP) Database is licensed from 
the National Institute of Standards and Technology (NIST) where properties for approximately 150 fluids 
are calculated via Equations of State (generally the Helmhotz Free Energy Equation of State). The data 
comes from Version 10 of the library. For more info see the following sources: Program Summary, 
REFPROP FAQ, NIST Chemistry WebBook, NIST Chemical Name Search.

A NIST REFPROP fluid can be added to the model in the Fluid panel by selecting the NIST REFPROP 
radio button. Add a fluid from the list by selecting it and clicking Add to Model, as shown in Figure 3.

The NIST REFPROP library allows for the calculation of gas mixtures, as well as dynamic mixing in the 
model, but note that no chemical reactions are modeled as listed in the Engineering Assumptions. Sat-
uration line data is also available.

https://www.nist.gov/programs-projects/reference-fluid-thermodynamic-and-transport-properties-database-refprop
https://pages.nist.gov/REFPROP-docs/
https://webbook.nist.gov/chemistry/
https://webbook.nist.gov/chemistry/name-ser/
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Figure 3: Fluid panel in Analysis Setup with the NIST REFPROP fluid library selected

Chempak Library

Optional add-on for purchase which contains data for several hundred fluids. Chempak is licensed from 
Madison Technical Software.

Fluids from the Chempak library  support gas mixtures and dynamic mixing, but no chemical reactions are 
modeled as listed in the Engineering Assumptions.

To add a Chempak fluid, select Chempak Fluid at the top of the Fluid panel. From here, select the appro-
priate fluid from the fluid list and click the Add to Model button. After a fluid is added to the model, it will 
appear in the lower list under Fluids in Current Model.

The equation of state is that of Wu & Stiel which is an extension of Lee Kesler to cover polars as well as 
non-polars. Properties are derived by interpolation between a Simple Fluid (mainly Argon), a Reference 
Fluid (mainly Octane) and a Polar Fluid (Water) using Acentric Factor and Stiel Y Factor as interpolating 
variables. These compound parameters (OM, the Acentric Factor, and YFACT the Stiel Y Factor) are 
derived from the compound vapor pressure curve. For more information see the Chempak Technical 
Information topic.

Detailed fluid properties information from Chempak can be calculated using the AFT Chempak Viewer, 
which can be accessed from Tools > Fluid Property Viewers > Chempak. The Chempak Viewer will be 
launched as a separate application, which can then be used to calculate fluid properties at various con-
ditions. A Chempak Data license is required to use the Chempak viewer.

For more information on AFT Chempak Viewer see the Chempak Viewer Help File.

https://docs.aft.com/chempakviewer3/Default.htm
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Figure 3: Fluid panel in Analysis Setup with the Chempak fluid library selected

Fluid Accuracy Settings

Several advanced settings are available to fine-tune the accuracy of the fluid property calculations and 
depend on which fluid library is selected. These settings are discussed in the Fluid Accuracy Settings 
topic.

Related Examples

Fluid Library Comparison - Steam Turbine Shutdown Example 639

Related Topics

References 499
Use an AFT Standard Fluid 568

Creating Mixtures
You have the option of creating a mixture of fluids with the NIST REFPROP or Chempak fluid libraries.

To create a mixture, first select NIST REFPROP or Chempak Fluid on the Fluid panel in Analysis Setup. 
Once this has been selected, the option to Create New Mixture and Add button becomes available. Click 
this button, then locate and select the first fluid in the mixture you wish to specify (the Search button can 
be used to search for a name or synonym). Enter the mass or mole fraction of the fluid in the mixture, and 
click Add Fluid to Mixture. Repeat this process for all fluids in the mixture as shown in Figure 1.
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Note: The fraction basis of all mixtures is either mass or mole, and it is specified on the Fluid panel 
itself. If you would like to change the fraction basis for the mixture (from mass to mole or from 
mole to mass), click on the desired fraction basis located at the bottom of the Fluid panel below 
Fraction Basis for Mixture. Note that this option is only available after you specify the model fluid 
as a mixture.

The mixtures you create here are referred to as static mixtures because you are specifying the com-
position before the model is run. Any of these gases or mixtures shown as Fluids in Current Model can be 
assigned to boundary junctions such as Tanks or Assigned Flows.

Assigning different fluids or mixtures to different junctions will (usually) result in mixing flow streams 
where the composition will change. The relative percentage of gases in the mixed composition depends 
on the flow solution. Hence, these mixture compositions change as the simulation converges on a flow 
balance. For this reason these mixtures are called dynamic mixtures.

Note: The NIST REFPROP fluid library is not able to calculate the mixing parameters for most mix-
tures containing steam.

Figure 1: The Create Mixture window (opened from the Fluid panel) allows you to create predefined mixtures 
for the model
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Equation of State Models
AFT xStream uses the Ideal Gas model with a corrected compressibility factor, Z, to model AFT Standard 
fluids. The Z-factor can be calculated by numerous correlations. xStream offers 6 options: Constant Z, 
Ideal Gas, Peng-Robinson, Redlich-Kwong, Soave Redlich-Kwong,  and Three-Parameter. 

The Ideal Gas option leaves the Z-factor defined at 1, meaning the fluid is modeled as an Ideal Gas. The 
Constant Z option allows the user to specify a value for Z which xStream then uses for all property cal-
culations. The other Equation of State options are discussed in turn below. 

Equations of State Nomenclature

There are a few characterizing fluid properties that are common to all of the Equations of state below.

The reduced temperature (Tr) and reduced pressure (Pr) are the ratios of the thermodynamic prop-
erties to the critical properties. For example,             

is the definition of the reduced pressure. The reduced temperature could be written similarly.

ω is the acentric factor, for which values can be found in chemical engineering data books. It is a cor-
rection factor that can be set to zero if you cannot find data for the fluid. However, accuracy will be 
reduced.

Redlich-Kwong

The Redlich-Kwong Equation of State is given by the following cubic equation. 

where
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And Pc and Tc are the critical pressure and temperature, respectively. V is the molar volume.

An alternative form of the Redlich-Kwong equation can be obtained by multiplying the Redlich-Kwong 
equation by V/RT.             

where

Elimination of the "a" and "b" terms gives

 

where Tr and Pr are the reduced temperature and reduced pressure.

Soave-Redlich-Kwong (SRK)

Soave proposed a modified version of the Redlich-Kwong method as follows
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where

where Tr is the reduced temperature, and ω is the acentric factor.

The SRK equation can also be written as in terms of Z as

where

The largest root of Z for the cubic equation is the compressibility factor for the vapor form of the fluid.

Peng-Robinson

The Peng-Robinson Equation of State uses a similar form to the Redlich-Kwong equation of state cubic 
equation. The Peng-Robinson cubic equation is given as follows



Analysis Setup Overview

- 94 -

where

And Pc and Tc are the critical pressure and temperature, respectively, V is the molar volume, Tr is the 
reduced temperature and ω is the acentric factor.

The above equation for pressure can be rewritten as

where

 

The largest root of Z for the above equation is the compressibility factor of the vapor form of the fluid.
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Three-parameter

xStream implements a Three-Parameter Equation of State derived by Pitzer for the second coefficient in 
the Virial Equation of State. The Three-Parameter model as used by xStream is taken from page 102 of  
Smith, van Ness, and Abbott and shown below.

where Z is the compressibility factor, and Pr and Tr are the reduced pressure and temperature, respect-
ively.

The constants B0 and B1 are given by the following

whereω is the acentric factor.

Related Topics

Nomenclature 448
References 499

Enthalpy Models
For superheated gases, enthalpy is a function of both temperature and pressure: 

However, enthalpy is more strongly a function of temperature, and thus you will frequently see the 
approximation as follows:
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where the specific heat at constant pressure is used as a proportionality constant. For processes that are 
not at constant pressure, the above approximation starts to lose accuracy.

AFT xStream offers three ways to calculate the enthalpy for the AFT Standard Fluid Library. Below is a 
description of each.

Reference Enthalpy

The Reference Enthalpy Method uses the following equation to calculate enthalpy

The reference enthalpy and temperature is entered in the fluid library, and should be for a state that is as 
near as possible to the operating conditions of your model. As seen from the equation, the pressure 
dependence of enthalpy is ignored. In many cases, this assumption is acceptable.

Generalized Enthalpy

The Generalized Enthalpy Method is an extension of the Reference Enthalpy Method. The Generalized 
Enthalpy, similar to the Three-Parameter Method, uses critical property data to calculate a Residual 
Enthalpy. The method is shown below.

where:

B0 and B1 are as given previously, and:
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Table Lookup Enthalpy

The third method of obtaining enthalpy data is by using AFT xStream’s two-dimensional table. In this 
method, a sequence of polynomial curve fits as a function of temperature are used. Each step in the 
sequence is for a different pressure.

With this method, enthalpies would be obtained by interpolating the polynomials between 25 and 50 psia 
at a given temperature. Up to 10 pressure table entries can be used. If the pressure is outside the table 
range, the enthalpy is extrapolated.

Related Topics

Nomenclature 448

Fluid Accuracy Settings
Several advanced settings are available to fine-tune the accuracy of the fluid properties for the xStream 
simulation. These options are enabled on the Fluid panel by selecting the Accuracy Settings check box. 
Once enabled the different Accuracy Setting options will be selectable using the available radio buttons. 
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Figure 1: Fluid panel in Analysis Setup with the Fluid Accuracy Settings enabled

State Properties              

This option is applicable only to Chempak fluids.

The State Properties option influences the number of elements used in curve fits for calculating property 
data. You will usually want to start with standard accuracy, and use high accuracy for final runs, depend-
ing on the importance and run time for the model. The high accuracy option will increase run time by 
about a factor of two.             

When performing interpolations for properties, a 4 point (bilinear) or 16 point (bicubic) interpolation 
scheme can be used. The 4 point scheme implemented in AFT xStream is the Standard Accuracy option. 
The 16 point scheme is the high accuracy option. Use of the High accuracy option will roughly double the 
run times for models.             

Sonic Velocity

This option is applicable only to Chempak fluids.

The standard accuracy sonic velocity option will usually be acceptable. The standard option uses Equa-
tion 87 for all sonic velocity calculations. The high accuracy option uses Equation 84, calculating the 
derivative using a numerical difference (also called perturbation derivative) along the isentropes. This is 
time consuming, and can cause models to run ten times as long. You should not use this option unless 
you have reason to believe Equation 87 has unacceptable accuracy as evidenced from the output values 
of sonic velocity.
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Specific Heat Ratio

This option is applicable to all of the fluid libraries.

There is a choice of standard or high accuracy for the specific heat ratio. The standard accuracy uses 
Equation 80 for gamma (γ). The high accuracy uses Equation 81. The standard accuracy will usually be 
suitable, but for completeness you may want to use the high accuracy in your final runs and see if the res-
ults change.

The high accuracy option should not have a significant affect on run time (at most 10%). However, it can 
result in convergence problems.

Pipes and Junctions Group
The Pipes and Junctions Group in Analysis Setup has one item: the Pipes and Junctions panel. When 
the Pipes and Junctions group has a green checkmark next to its name, all pipes and junctions are fully 
defined. When a red exclamation point is next to its name, there is at least one pipe or junction that is 
undefined. The model cannot run until all pipes and junctions are defined.

Pipes and Junctions Panel
The Pipes and Junctions panel within Analysis Setup displays the status of pipes and junctions within the 
model. 

Figure 1: Default state of the Pipes and Junctions panel

This panel is made up of three sections:
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 l Undefined Pipes
 l Undefined Junctions
 l Undefined Properties

The Undefined Pipes and Undefined Junctions sections displays the number and name of all pipes and 
junctions, respectively, that are not fully defined. If all pipes and junctions in the model are fully defined, 
the messages "All Pipes Are Defined" and "All Junctions Are Defined" will be displayed. Clicking on the 
undefined pipe or junction will display the undefined properties in the list below, as shown in Figure 2. All 
undefined data for all objects can be saved to the file or copied to the clipboard. Any undefined object's 
Properties window can be launched by double-clicking the object's name in the list to finish defining the 
object.

Figure 2: Pipes and Junctions panel with one pipe undefined and undefined properties displayed

Pulsation Setup Group
(PFA module only) The Pulsation Setup group in Analysis Setup allows you to define the pulsation ana-
lysis parameters.

The Pulsation Setup group has one panel, the Pulse Setup panel. The Pulse Setup panel allows the user 
to define properties of the pulse including the source, cutoff frequency, low-pass filtering, and magnitude.

Pulse Setup Panel
The Pulse Setup panel (Figure 1) allows you to specify required input for the PFA module, including the 
junction at which the pulse will be applied, as well as the pulse properties. This panel will not be visible 
unless the PFA module has been activated from the Modules panel.
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Figure 1: Pulse Setup panel in the Analysis Setup window with Natural Frequency Evaluation selected
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Figure 2: Pulse Setup panel in the Analysis Setup window with Steady State Pulsation selected

Frequency Analysis Mode

At the top of the window the Frequency Analysis Mode can be specified. The options include: Natural Fre-
quency Evaluation, Steady State Pulsation, and None. The Natural Frequency Evaluation will produce a 
single transient pulse at a specified assigned flow or fixed flow rate positive displacement compressor 
junction so as to determine the frequencies that would excite the system. The Steady State Pulsation 
option will determine how a pulsation source, such as a reciprocating compressor, would interface with a 
system in steady operation. 

Natural Frequency Evaluation

When Natural Frequency Evaluation is selected, the Pulse Properties can be specified, including the 
junction that will act as the source of the pulse and the magnitude of the pulse. By default, the magnitude 
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of the pulse is twice the steady-state flow, but you have the option to define this magnitude as “User Spe-
cified”. This pulse will be assumed to last for two time steps and then return to steady-state flow. The 
pulse can only be applied to an assigned flow junction or fixed flow rate positive displacement com-
pressor.

Steady State Pulsation

The Steady State Pulsation analysis mode allows for the evaluation of pressure amplitude for each fre-
quency at each pipe station in the model when these frequencies are excited by a reciprocating com-
pressor. The reciprocating compressor can be modeled explicitly using the reciprocating positive 
displacement compressor junction, or approximated by applying a sinusoidal flow transient to an 
assigned flow junction. In practice, the natural frequencies of the system may be used along with har-
monic multiples to identify compressor RPMs of particular concern.

The Steady State Pulsation analysis mode also offers acoustical evaluation of the reciprocating com-
pressor and system interaction based on the API 618 standard.

Artificial Pulsation Resolution

It is highly recommended that the option to delay transient simulation until artificial transients are 
resolved be left enabled. This resolution method is based on comparison of average pressures between 
blocks of compressor rotations, and operating without this method will result in less accurate frequency 
evaluation. Pressure is averaged over the course of each block, and this value is compared to the pre-
vious block until it meets a specified tolerance. This method is distinct from the one used in the Transient 
Solver Initialization Panel, which is not used and will not appear when using Steady State Pulsation ana-
lysis.

The parameters for pulsation resolution can be modified in the Advanced Settings section at the bottom 
of the Pulse Setup panel.

 l Average Pressure Tolerance - Similar to solver tolerance settings, this defines the pressure tol-
erance from block to block that must be achieved for a block to pass tolerance requirements. This 
can be defined using absolute tolerance, relative tolerance, or any combination thereof.

 l Iteration Limits
 l Maximum number of blocks - The maximum number of blocks that may be evaluated 

without success before the artificial transients are considered to be unresolved.
 l Revolutions per block - This determines the number of time steps per block based on 

number of crankshaft rotations, the time step size, and compressor RPM.

Note: If the default value of 10 is not sufficient, try increasing this value to 20.

 l Time steps per block (Other Pulsation Source) - When using Other as the pulsation 
source, this parameter replaces revolutions per block.
Successive blocks required - This defines the number of consecutive blocks that must 
meet tolerance requirements before artificial transients are considered resolved.
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Pulsation Source

The pulsation source can be set to Reciprocating Compressor or Other. The Other option allows a user 
to excite the system with any arbitrary pulsation source. In practice this takes the form of cyclical user-
defined Junction Transient Data applied to one or multiple junctions in the system. The Reciprocating 
Compressor option allows a reciprocating positive displacement compressor junction or assigned flow 
junction to be selected, and has the following parameters.

 l Compressor
 l Reciprocating Compressor - Select an existing reciprocating compressor from the model 

listed by junction number.

Note: If there are multiple reciprocating compressors with the same speed and number 
of heads, any may be selected. If these parameters differ between compressors, 
use the Other option for Pulsation Source.

 l User Defined - This option is selected when using one or more assigned flow junctions  to 
represent reciprocating compressors. The appropriate transient must be defined in the 
Transient tab of the assigned flow junction, typically using the periodic flow feature. The 
Speed and Number of Heads parameters do not define this transient flow, but are used for 
Artificial Pulsation Resolution and API 618 and should match the assumptions that were 
used to define the transient flow.

 l Speed - The current operating speed of the compressor in RPM. If a reciprocating compressor 
junction is selected, this will display the value defined in the Compressor Properties window.

 l Number of Heads - This is the number of compression chambers in the compressor, which is the 
number of cylinders in a single-acting compressor and twice the number of cylinders in a double-
acting compressor. If a reciprocating compressor junction is selected, this parameter will be 
determined from the compressor properties.

 l Evaluate with API 618 - When this option is checked, an API 618 acoustical analysis will be per-
formed. More detail about this analysis is provided in the section below.

Cutoff Frequency

The cutoff frequency in xStream is the maximum frequency for displayed output. The defined cutoff fre-
quency must be less than or equal to the detectable frequency for the analysis, which is calculated using 
the equation for maximum frequency as follows:

where dt is the time step. The time step for the model is not known until run time; however, the time step 
can be estimated based on the inputs on the Pipe Sectioning panel. The Pulsation Summary at the bot-
tom of the Pulse Setup panel shows the Detectable Frequency based on the current settings on the Pipe 
Sectioning panel, as well as the minimum number of sections required to capture the specified cutoff 
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frequency. If the current Cutoff Frequency and sectioning are not valid for the analysis, then either the 
Cutoff Frequency should be decreased, or the minimum number of sections should be increased.

When the Analysis is run it is possible to account for all frequencies up to the Detectable Frequency cal-
culated based on the time step. However, the results in the output will only display frequencies up to the 
user defined Cutoff Frequency. Therefore it is important to define a large enough Cutoff Frequency to be 
able to analyze all relevant frequency responses.

Note: In Steady State Pulsation, the cutoff frequency should be at least six times the base pulsation 
frequency.

Minimum Number of Frequency Samples

The minimum number of frequency samples used to generate the forcing function is specified in the Fre-
quency Analysis section of the Pulse Setup panel. The default of 1000 should be sufficient for most 
cases. The Minimum Number of Frequency Samples will impact the required simulation duration - a lar-
ger number of samples will require a longer simulation duration. The required simulation duration can be 
calculated by dividing the minimum number of frequency samples by the detectable frequency. If the cur-
rent simulation duration is not long enough to accommodate the minimum number of frequency samples, 
then the  simulation duration should be lengthened on the Simulation Mode/Duration panel, or the min-
imum number of frequency samples should be decreased.

Evaluate with API 618

The Evaluate with API 618 feature, under the Steady State Pulsation selection, can be used to determine 
if the pressure response at any of the acoustic natural frequencies of the system exceeds the limits 
defined in API 618 for reciprocating compressors. To evaluate API 618 the model should first be run with 
PFA enabled and the API 618 feature disabled to determine the acoustic frequencies. Once the excit-
ation frequencies are known, child scenarios can be created by the user to evaluate the pressure results 
when the compressor operates at the excitation frequencies, as is demonstrated in the last step of the 
Frequency Analysis Example. The API 618 evaluation should be enabled in the excitation frequency 
child scenarios to check if the pressure results exceed the limits in API 618.

The required inputs to check API 618 are as follows:

 l Speed - The speed the reciprocating compressor is operating at.
 l Number of Heads - The number of pistons in the reciprocating compressor.
 l Time Until Steady State Pulsation - The time required for the dissipation of artificial transients 

caused by the introduction of a flow rate wave to the system. This time should be determined by 
running the scenario with the "Time Until Steady State Pulsation" set to 0, then plotting the pres-
sure results at the outlet of the compressor. The Time Until Steady State Pulsation should be set 
as the time at which the pressure waves have consistent amplitudes. For example, in Figure 2 
below the waves begin to reach constant amplitude at about 0.25 seconds. It is best to choose a 
slightly longer time interval than the estimated time interval for increased accuracy when checking 
API 618.
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Note the Time Until Steady State Pulsation input only changes which pressure results are 
included in the API 618 evaluation, the transient results are not impacted by this time.

Figure 3: Example pressure results at the outlet of the reciprocating compressor with an oscillating flow tran-
sient specified

With output an Acoustical Frequency Analysis can be graphed. When API 618 is being evaluated, the 
limit and the frequency will be graphed together as shown in Figure 4.

Figure 4: Example Acoustical Frequency Analysis Plot including the API-618 Limit

The equations for the API 618 peak to peak pressure level limits are as follows (American Petroleum Insti-
tute 2007, Clause 7.9):
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where P1(%) is the maximum allowable peak to peak pressure level of individual pulsation components 
at fundamental and harmonic frequencies, as a percentage of absolute line pressure, PL is the average 
absolute line pressure in psi (bar for SI), ID is the inside diameter of the pipe in inches (mm), f is the pulsa-
tion frequency in hertz, anda is the speed of sound inside the pipe in feet per second (meters per 
second).

Pulsation Summary

The Pulsation Summary section at the bottom of the Pulse Setup panel provides information on the cur-
rent transient settings in the model to check that the sectioning and simulation duration are sufficient 
based on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples. Therefore 
the Pulsation Summary will only be able to display results if the Pipe Sectioning panel and Simulation 
Mode/Duration panel have already been fully defined.

The Update For Me button under the Pulsation Summary can be used to update the Minimum Number of 
Sections and/or the Stop Time for the simulation if they are not sufficient based on the user-specified 
Cutoff Frequency and Minimum Number of Frequency Samples.

A short description of each of the Pulsation Summary items is given here.

 l Minimum Sections
 l Current Count - Displays the Minimum Number of Sections Per Pipe defined on the Pipe 

Sectioning panel
 l Detectable Frequency - Displays the Max Frequency calculated as discussed above in 

the Cutoff Frequency section
 l Required for Cutoff - Displays the required Minimum Number of Sections Per Pipe which 

allow the Detectable Frequency to be greater than or equal to the Cutoff Frequency
 l Minimum Simulation Duration

 l Current Duration - Displays the current simulation duration defined on the Simulation 
Mode/Duration panel (Stop Time minus Start Time)

 l Actual Samples - Displays the Actual Samples used for the frequency analysis, calculated 
by multiplying the Current Duration by the Detectable Frequency

 l Required For Min. Samples - Displays the minimum required simulation duration based 
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on the user-specified Minimum Number of Frequency Samples and the calculated Detect-
able Frequency

Related Examples

Frequency Analysis - PFA Example             671

Related Topics

Reciprocating Compressor 262
Positive Displacement Compressor 260
Defining Pulsation Settings 419
The maximum peak-to-peak pressure limit defined in the API 618 standard has been 
exceeded at X locations 543
Pulsation peak-to-peak pressures are within allowable API 618 levels 552

Pipe Sectioning and Output Group
The Pipe Sectioning and Output Group in Analysis Setup has one item: the Pipe Sectioning and Output 
panel. The Sectioning panel contains settings related to setting up the Method of Characteristics grid 
used for the transient solution method.

Related Topics

Method of Characteristics 473

Pipe Sectioning and Output Panel
Before running a transient simulation, there are several pipe sectioning options that must be defined to 
section the pipes as described in Pipe Sectioning - Introduction to Method of Characteristics.

The user is required to specify the Sectioning item  when the Transient Simulation Mode is selected. How 
the pipes are sectioned is controlled in the Pipe Sectioning and Output panel of Analysis Setup.

When the system has been defined, the Pipe Sectioning and Output panel will also show a Sectioning 
Summary which contains details of the sectioning including the estimated maximum sonic velocity, the 
estimated time step, and the estimated total steps. These numbers are only estimated values, as the 
actual values are determined after xStream gets results from the AFT Arrow Steady Solution. However, 
these estimates can help the user understand how many sections the system will have, and thus how 
long a run might take.
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Figure 1: The Sectioning panel in the Analysis Setup window

Sectioning Options

 l Minimum Number of Sections Per Pipe - Defines the minimum number of calculation sections 
that will be used in each pipe in the model. Some pipes may use more than the minimum number 
of sections depending on the time step and maximum sonic velocity in the pipe. The ideal number 
of sections will vary based on the relative length of the shortest pipe compared to other pipes in 
the model, and the speed of transients in the model.

 l Estimated Maximum Pipe Fluid Temperature During Transient - Temperature used to 
determine the maximum sonic velocity for sectioning calculations. If the actual maximum tem-
perature is not known, a higher temperature than expected should be used.

Transient Output Options

The Pipe Stations To Include In Transient Output File option controls how much data is saved to the 
file. By default all time steps for all pipe stations will be saved to file. The user may also set only the pipe 
inlet/outlet station data to be saved to file. Saving only the inlet and outlet stations to file will decrease the 
run time for the model, but also means that the user will not be able to plot the results at interior cal-
culation stations for the pipes.
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Numbering Convention for Pipe Sectioning

Once a pipe is broken into sections, computation takes place where the sections join together. These are 
called pipe stations. The total number of stations in a pipe is equal to the number of sections plus 1. The 
station at the beginning of the pipe is numbered zero.             

Figure 2: Computing Stations (blue) exist at the boundary of every section (green)

To observe parameters at the inlet or outlet of a junction, view the station adjoining the junction. In the 
above example, the inlet to the valve is P1, Station 3 and the outlet is P2, Station 0.

Advanced Sectioning Controls

 l Estimated Maximum Pipe Mach Number During Transient - Adjusts the MOC grid time step. 
An input value of 1 will ensure stability. For simulations with lower maximum Mach Numbers, redu-
cing this input value can improve accuracy and runtime. If Mach Numbers higher than the Estim-
ated Maximum Pipe Mach Number are encountered during simulation, the results will not be valid, 
and the simulation can become unstable or fail to converge. This can only be edited if advanced 
options are enabled.

 l Number of Radial Thermal Nodes per Wall or Insulation Layer - Defines the number of cal-
culation nodes that will be used in the pipe wall and in each of the insulation layers when cal-
culating radial conduction. The default setting of 3 calculation nodes per layer should be sufficient 
for most applications; However, changing the number of radial nodes may improve calculation sta-
bility if the heat rate changes rapidly across the pipe wall and insulation. See the topic on Tran-
sient Heat Transfer for more information on how the transient heat transfer calculations are 
performed.

Related Examples

Gas Turbine Fuel System Example 623
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Transient Control Group
The Transient Control Group in Analysis Setup allows the user to specify transient parameters such as 
the simulation duration, transient solver initialization, and transient checkpoints. Only the Simulation 
Mode/Duration panel is required to run the model. 

 l Simulation Mode/Duration panel - Required panel. Contains the controls for simulation type, sim-
ulation duration, and options to save less output to file.

 l Transient Solver Initialization panel - Optional panel. Allows Specification of how the solver will 
resolve artificial transients. 

 l Transient Checkpoints panel - Optional panel. Allows specification of when to create checkpoint 
files used to continue transient simulation.

Simulation Mode/Duration Panel
The Simulation Mode/Duration panel allows the user to define settings that will affect the transient res-
ults.

The Time Simulation options control what calculations will be performed by xStream. There are two time 
simulation options:

 l AFT Arrow Steady - This simulation mode runs the network solution methodology found in AFT 
Arrow to give steady-state results for the model.     

 l Transient - This simulation mode runs the MOC solution methodology for the transient simulation 
as defined by the user. This option is the default selection.      

The Start Time and Stop Time refer to the beginning and end times for the simulation. The units can be 
specified using the drop-down box.

Transient Solver Initialization Panel

Artificial Transient Resolution

AFT xStream employs two separate solvers in its solution method: the AFT Arrow Steady Solver is used 
to calculate the steady state solution to initialize the transient solution,  and the Transient Solver is used to 
run the Method of Characteristics (MOC) transient solution. The AFT Arrow Steady solver and the Tran-
sient solver use different sectioning methods, which causes small discrepancies between the converged 
Arrow solution and the first time step of the transient solution. If xStream were to proceed directly from 
the AFT Arrow Steady solution to the Transient simulation, artificial transient waves would be introduced 
into the system as is shown in Figure 1.  Checking the option to Delay start of transient simulation 
until artificial transients are resolved ensures that the artificial transient waves are allowed to die out 
before the transient simulation begins, as is depicted in Figure 2. It is strongly recommended to allow the 
artificial transients to resolve before the transient simulation begins for higher result accuracy.

Once xStream determines the artificial transients have been resolved, xStream checks the resolved solu-
tion against the AFT Arrow Steady solution. If the velocity results have a larger relative velocity change 

Transient-Checkpoints-Panel.html
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than the specified Allowed Mismatch Between AFT Arrow Steady and Resolved Solutions in the 
Transient Solver Initialization panel, a warning is given. By default "Do not proceed to the transient sim-
ulation..." is enabled to stop the transient run if the mismatch exceeds the allowed mismatch. The user 
can disable the option that prevents the transient solution from proceeding; however, note that large 
changes between the AFT Arrow Steady solution and Resolved Solution can  introduce error into the tran-
sient results. 

Figure 1: Illustration of the Transient Solver Initialization process without artificial transient resolution

Figure 2: Illustration of the Transient Solver Initialization process with artificial transient resolution

The artificial transients are resolved by running the Method of Characteristics in a series of Blocks. Each 
Block consists of 100 time steps. After each Block is run xStream compares the velocity results at the 
beginning and end of the block for every calculation station. If the velocity change from the beginning to 
the end of the block at any point is larger than the allowable tolerance defined in the Transient Solver Ini-
tialization panel, then the process is repeated until the Maximum Number of Blocks is reached, or the 
velocity tolerance is met for two consecutive blocks. 
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Figure 3: Example of blocks used during artificial transient resolution period

Advanced Settings

The advanced settings should generally be used for troubleshooting purposes only. There are a number 
of settings that can be customized.

 l Disable transient junction behavior for the entire simulation - This option sets all junction 
transient events to be ignored, and fixes the pressure/temperature at all finite tanks for the dur-
ation of the transient. By disabling the junction transient behavior in this way the user can directly 
view the artificial transients in the model for troubleshooting purposes.

 l Bypass AFT Arrow Steady and start the transient with fixed values for all stations - This 
option uses arbitrary guesses to initialize the period of resolving artificial transients instead of 
using the AFT Arrow Steady solution. The resolved solution should still be the same regardless of 
the whether the AFT Arrow Steady solution is used or just initial guesses; however, the artificial 
transient resolution will likely take more time when fixed guesses are used.

 l Allowed mismatch between AFT Arrow Steady and resolved solution - The allowed velocity 
mismatch criteria can be modified here. Additional pressure and temperature criteria can also be 
applied by checking the corresponding boxes.

 l A series of time steps (a block) is considered resolved when every station meets these 
tolerances from beginning to end of the block - The tolerances in this section are used to 
determine if the artificial transients are resolved by comparing the tolerance values to the velocity 
change at the beginning and end of each block as described in the Artificial Transient Resolution 
section above. Additional pressure and temperature criteria can also be applied by checking the 
corresponding boxes.

 l Iteration Limits
 l Maximum number of blocks - The maximum number of blocks that xStream will run to 

attempt to resolve the artificial transients.
 l Time steps per block - The number of time steps that will be run in each block. If there are 

too few time steps the blocks may falsely converge.
 l Successive blocks required - The number of successive blocks that must meet the tol-

erances for the artificial transients to be considered resolved.
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Related Topics

Transient Result Accuracy 58
Method of Characteristics 473

Forces Group
The Forces group in Analysis Setup has one item: the Forces panel. By default, the Forces group is fully 
defined and will have a green checkmark next to its name.

Related Topics

Transient Forces 42

Related Examples

Pipe Forces from Turbine Shutdown Example 656

Force Definitions Panel
AFT xStream includes the ability to calculate transient pneumatic forces, which occur when a transient 
pressure wave passes through a portion of the system.

Note: As AFT xStream is only a pneumatic solver, only pneumatic forces are accounted for. AFT 
xStream is not a pipe stress analyzer and as such does not have the ability to directly model pip-
ing supports or similar objects. Pneumatic force files can be generated for import into software 
designed for force analysis.

Defining Force Sets from Analysis Setup

In order to process force data, the locations where the forces are to be calculated must be defined. Force 
Sets can be defined from the Force Definitions panel of the Forces group in Analysis Setup.

Note: Force calculation accuracy in AFT xStream is dependent not only on accurately defining the 
Force Sets, but can also be highly dependent on the Sectioning and Fluid panel settings. This is 
discussed further in the Pipe Forces from Turbine Shutdown Example.
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Figure 1: Force set data is defined on the Force Definitions panel in the Analysis Setup window

 l New - Add a new force set to the table.
 l Duplicate - Copy an existing force set.
 l Delete/Delete All - Remove the selected force set / remove all force sets.
 l Swap Nodes - The calculation will be the same, but the sign of the force will be reversed. This 

may be important for proper interpretation of results or for exporting data to other applications.
 l Import from CSV - If force sets are defined in another application or by hand they can easily be 

imported with a comma separated value file. Click the Import from CSV button for an explanation 
on the required format.

 l Generate Force Names - Automatically changes the names for the selected force sets to 
"upstream junction name - downstream junction name" using the names from the connected junc-
tions on the workspace.

 l Point Force Ambient Pressure - If using a Point force set, the ambient pressure is required to 
calculate the force balance. This defaults to the Environmental Properties panel value, but can be 
changed here.

Each individual force set has a number of required parameters:

 l Force Type - There are several force set types available. They are described in detail in Force 
Set Types.

 l Force Set Name - A unique name for the force set.
 l Start Pipe - Where the first node is located.
 l Start Location - Force Sets in xStream must have their endpoints at either the inlet or outlet of a 

pipe.
 l End Pipe - The second  node (for Difference force types). Note that the selection must be valid for 

the specified force type. See Force Set Types.
 l End Location - Force Sets in xStream must have their endpoints at either the inlet or outlet of a 

pipe.
 l Exit Area - For Exit force types, an exit area is required.
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 l Force Unit Vector Coordinates - Define unit vectors for your linear pipe to give the resulting 
forces a three-dimensional direction. xStream is still only a one-dimensional fluid modeling soft-
ware, and specifying a unit vector will not change the force calculations. However, by defining the 
XYZ vector for a given force set, that data can be brought into other software for further analysis 
using the Export Force Data tool. These unit vectors should be defined based on the coordinate 
system in the force stress analyzing software that the force sets will be exported to.

Defining Force Sets from the Workspace

Force Sets for individual pipes can be defined directly from the Workspace by right-clicking on a selected 
pipe. Choose the Create Force Set With Selected Pipe... option to launch the Create Force Set window, 
shown below in Figure 2. If multiple pipes are selected, an individual Difference Force Set will be created 
for each pipe applying the specified settings for each.

Figure 2: Create Force Set window in the Workspace

Each force has several required and optional parameters:

 l Pipe Name - If the pipe has a name entered other than 'Pipe', the user can choose whether to 
include that pipe name or not in the Force Set name.

 l Force Set Name - Users can add a name for the Force Set to better organize and manage Force 
Sets in the model.

 l Force Unit Vectors or Length - Define unit vectors for your linear pipe to give the resulting 
forces a three-dimensional direction. xStream is still only a one-dimensional fluid modeling soft-
ware, and specifying a unit vector will not change the force calculations. However, by defining the 
XYZ vector for a given force set, that data can be brought into other software for further analysis 
using the Export Force Data tool. These unit vectors should be defined based on the coordinate 
system in the force stress analyzing software that the force sets will be exported to.
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 l Show Analysis Setup Force Definitions after Creation - If checked the user will be brought to 
the Force Definitions panel of the Analysis Setup window to view all Force Set information defined 
for that scenario.

Related Topics

Transient Forces 42

Related Examples

Pipe Forces from Turbine Shutdown Example 656

AFT Arrow Steady Solution Group
The user has control over a number of parameters that influence global convergence for the AFT 
ArrowTM Steady Solution.

Note: These values should only be changed by experienced users or under advisement by AFT Sup-
port. Poorly defined Solution Control settings can cause the model to converge on an 
incorrect solution without warning messages.

 l Solution Method panel - The calculation method can be defined on this panel.
 l Tolerance panel - The iterative tolerances that define convergence can be defined on this panel.
 l Iterations panel - Additional iteration controls that can affect whether or not a model converges, or 

how quickly it will converge, can be defined here. Most settings on this panel will not affect the final 
result.

 l Pressure and Temperature Limits panel - Options to limit the pressure and/or temperature results 
in the solver.

Related Topics

References 499

Solution Method Panel
The Solution Method panel defines the calculation method and relevant parameters for the AFT ArrowTM 
Steady Solution (Figure 1). This panel is defined by default and typically should not be changed unless 
problems are encountered when running the model.

The Method Type can be set as Recommended or User Specified. The Recommended option (Length 
March With March Number Limits) is sufficient for most models. If desired the User Specified option can 
be selected to choose a different Method Type as are described below in the Solution Method Overview 
section below. Choosing User Specified also allows the march method increments to be changed.

A few other settings are defined by default for the user including the Length March Increment and 
Mach Number Increment settings. See the Marching Methods discussion below for more information 
on these parameters.
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Lastly the "First Use Lumped Adiabatic..." option is available for all method types except the Lumped 
methods. This option solves the entire system with the Lumped Adiabatic method, and applies the results 
of that solution as a starting point to the marching method selected. This can help with convergence for 
some models. The results will be the same as using only the marching method. See the Lumped Meth-
ods section below for more information on Lumped Adiabatic.

Figure 1: Default settings on the Solution Method panel

Solution Method Overview

xStream has six solution methods it can employ to find the AFT Arrow Steady Solution. Each method has 
certain advantages, and applicability to certain types of systems. While each option should theoretically 
come to a similar solution, there will be differences in the results between the methods. The magnitude of 
this difference depends heavily on the particular system being analyzed. All of the methods apply the 
same fundamental equations in differing ways.

 l Length March - All of the fundamental equations are applied at fixed length increments - axial 
points - down a pipe. This method provides good accuracy if changes in Mach Number are small. 
It is the least sensitive to initial conditions.

 l Length March with Mach Number Limits - This hybrid method starts with the Length March 
method, and dynamically switches to the Mach Number March method if the change in Mach Num-
ber between steps is large. This ensures excessive changes in Mach Number across computing 
sections are avoided.

 l Mach Number March - The fundamental equations are still applied at axial points down the pipe, 
but in this case the distance between the points is fixed by a Mach Number increment. This 
method is more accurate when there are large changes in Mach Number, often occurring when 
the Mach Number is high and when the flow is sonically choked.

 l Mach Number March with Length Limits - This hybrid method begins with the Mach Number 
March method, switching to Length March if the distance between axial points is too large. This 
helps ensure accuracy when the changes in Mach Number are small.
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 l Lumped Adiabatic - This method ignores all heat transfer and elevation changes. These effects 
are minimal in xStream as the pipes will be treated as adiabatic regardless, and simplifying the cal-
culations this way greatly reduces the required solution time and likelihood of convergence.

 l Lumped Isothermal - This method further simplifies the fundamental equations by assuming 
pipes are a fixed temperature throughout and again ignoring elevation.

Marching Methods

The marching methods provide the most accurate solutions. AFT Arrow "marches" down a pipe in the 
model, solving the fundamental equations along the way.

Dividing the pipe into smaller segments is important for compressible flow because the fluid properties 
change throughout the pipe. Each segment considers the flow properties constant and applies the fun-
damental equations. This represents a discretization of the continuously changing flow parameters - 
necessary for an iterative Solver such as AFT Arrow. This discretization introduces a certain amount of 
error into the solution, which is closely related to how many segments are present, as well as how much 
the flow properties change over a single segment.

When dividing the pipes into segments, axial points are created along the pipe, at the ends of every seg-
ment. The results at each axial point can be viewed in the output.

 l Length March - This method divides pipes into segments based on length. The segment length 
can be defined in two ways - either by dividing every pipe into a certain number of segments (Ini-
tial Number of Segments per Pipe setting), or dividing all pipes into equal-length segments 
(Segment Length setting). This method has the advantages that it is conceptually easier to under-
stand and ensures some minimum number of segments in every pipe. Axial points are also often 
located at convenient locations. However, at high Mach Numbers, the large change in flow prop-
erties over a segment makes this method less accurate. For a detailed mathematical description 
of this method see Length March Method - Detailed Discussion.

 l Mach Number March - Unlike the Length March, Mach Number March determines the locations 
of the axial points dynamically based on the flow solution. There is no easy way to tell where the 
axial points will be without completing the solution. This method is superior when analyzing high 
Mach Number flows, as the flow properties tend to change dramatically over short distances. 
Effectively, this method adds axial points as necessary where the flow properties are changing 
rapidly. The disadvantage of this method is that the minimum number of sections cannot be 
enforced - if the Mach Number in a single pipe changes less than the increment specified, the 
entire pipe will be represented with a single segment. This is not necessarily inaccurate, but it is 
generally preferable to have more than one segment per pipe. For a detailed mathematical 
description of this method see Mach Number March Method - Detailed Discussion.

Hybrid Marching Methods

AFT Arrow offers hybrid marching methods to get the best of both marching methods in one solution. 
These methods dynamically switch from Length to Mach Number March or vice-versa during the solu-
tion.

This dynamic switch allows the user to ensure that a certain minimum number of segments is present in 
each pipe, and that the flow properties do not change significantly over the segment.
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 l Length March With Mach Number Limits (AFT Arrow default) - The default solution method 
begins the march down the pipe with equal length segments. If the Mach Number over any certain 
segment is detected to increase more than the specified limit, the march continues over the rest of 
the pipe at equal Mach Number increments. It is often the case that flow velocity in a pipe is rel-
atively low and constant in the first few segments of the pipe, but increases dramatically towards 
the exit. This method captures this behavior.

 l Mach Number March With Length Limits - Very similar to the default method, this hybrid 
method begins with a Mach Number march, but if it is detected that the length to the next axial 
point is too far due to relatively constant velocity, additional axial points are forced into the pipe via 
the length limit. This helps ensure all pipes have some minimum number of sections.

The figure below shows an example of a pipe solved with Length March With Mach Number Limits. Dur-
ing the solution, the solver determined that taking an additional 10 foot step from point 6 (60 feet) to point 
7 (70 feet) would violate the Mach Number limit of 0.01. Therefore, the march was adjusted (starting at 
point 6) to increment in Mach Number steps of 0.01.

Figure 1: Length March dynamically switching to Mach Number March

Lumped Methods

For faster - but less accurate - computation, AFT Arrow offers two of the traditional lumped methods. 
These methods divide all pipes into 10 segments, but the method solves the entire pipe in a single com-
putation. Certain assumptions simplify the fundamental equations allowing a much faster solution at the 
cost of accuracy.

 l Lumped Adiabatic - This method treats every pipe as adiabatic, disallowing heat transfer into or 
out of the pipe. If heat transfer is defined in the model, the definition is retained for convenience 
but is not applied during the solution. In addition, this model cannot accurately model body forces 
so therefore does not account for elevation changes or rotating systems. In many gas systems 
these assumptions are reasonable and the results from Lumped Adiabatic acceptable. For a 
detailed mathematical description of this method see Lumped Adiabatic Method - Detailed Dis-
cussion.
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 l Lumped Isothermal - Similarly, this method treats all pipes as a constant temperature. Again, 
elevations are ignored. Note that heat transfer is applied to pipes (heat in or out) to meet the iso-
thermal conditions. For a detailed mathematical description of this method see Lumped Iso-
thermal Method - Detailed Discussion.

 l Use Pipe Isothermal Temperatures When Available Instead of This Value - If Iso-
thermal models have been defined for individual pipes, that temperature will be applied to 
that pipe instead of the global temperature defined in the Solution Method panel.

Comparing Marching Methods to Traditional Methods

There exist in industry practice a number of traditional methods and equations for calculating com-
pressible flow in pipes.

A common equation is the Crane isothermal equation (see Crane 1988, pp. 1-8). AFT Arrow and equa-
tions such as the Crane isothermal equation differ in several respects. First is that the Crane equation 
assumes isothermal flow, while AFT Arrow can model isothermal flow or other, more general, boundary 
conditions. Second is that the Crane equation solves the entire pipe as one segment. This can be called 
a lumped method. It is thus roughly analogous to using AFT Arrow with a single computing section per 
pipe. Third, the Crane equation assumes a constant diameter run, whereas AFT Arrow allows you to 
change diameters. Fourth, it is not apparent how to apply the Crane equation to multi-pipe systems, 
including pipe networks.

The Crane equation solves the governing mass and momentum equations by making some assump-
tions. AFT Arrow is solving the same equations, but is not making any assumptions. It marches down 
each pipe, taking into account physical property changes and non-linear acceleration effects as it pro-
gresses. Thus, AFT Arrow is in general much broader and more accurate than the Crane equation. When 
the pipe flow conditions are within the assumptions of the Crane equation, then the Crane equation and 
AFT Arrow should agree closely.

Other equations on page 1-8 of Crane 1988, compare similarly to AFT Arrow. They are all lumped meth-
ods with certain assumptions about thermal conditions in the pipe and properties of the gas.

These traditional equations can be used successfully in many engineering applications. They all rep-
resent a subset of AFT Arrow’s marching methods, which solve the fundamental equations without lim-
iting assumptions.

 

Related Topics
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Length March Method - Detailed Discussion
The Length March solution method for the AFT Arrow Steady Solution Method is described in detail 
below.

The stagnation pressure is given by the following:
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(22)

By differentiating Equation 22 the following is obtained:

(23)

Now take Equation 23 and use it to replace the pressure term in Equation 10 to obtain:

(24)

The first two terms on the right hand side of Equation 24 relate to the stagnation temperature (Equation 
15) as follows:

Making this substitution, and also using Equation 14

(25)

Integrating Equation 25 yields:
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(26)

And with algebra the Length March equation (Equation 27) is obtained:

(27)

Example

Some examples are given here to clarify how the Mach Number March and Length March methods solve 
the governing equations.

Figure 1: Marching equations are applied at successive computing sections along the pipe. Conditions at loc-
ation 1 are known, and at location 2 are being solved using one of the marching equations. 

Both of these methods are referred to as marching methods. What does this mean? Figure 1 shows a rep-
resentation of a computing section in a pipe. In this example, all parameters at Location 1 are known, and 
it is desired to calculate conditions at location 2 which is always downstream of location 1.

Whether we are applying the Length March or the Mach Number March (Equation 21, 37 or 41), at loc-
ation 1 we know these primary parameters:

Because we know the parameters above, we also know:
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Let's consider the Length March method first because it is easier to grasp. Using the Length March equa-
tion, we know three things about location 2. First, we know the length step, as this is specified by the 
user. We also know that the mass flow rate is constant. Lastly, we know the heat transfer relationship spe-
cified by the user and can use this to determine a thermodynamic parameter.

For instance, if the pipe is modeled as adiabatic (q = 0), we can determine the stagnation enthalpy at loc-
ation 2 using the following assumptions. 

If there is no elevation change, then:

and according to the Energy equation:

Even if there is elevation change, we know what it is and can just add that into the energy equation and 
calculate ho,2 explicitly.

If the pipe is isothermal, then:

If there is convective heat transfer or known heat flux, we can solve Equation 36 or 40 for To,2 which 
allows us to calculate ho,2 and we are at the same point as with adiabatic.

Thus, if any boundary condition other than isothermal is specified, the following is known at location 2:

or, if isothermal, the following is known at location 2:

With one thermodynamic parameter known at location 2, we guess at the stagnation pressure solution to 
the Length March equation. This in effect gives us two known thermodynamic parameters, from which all 
the other parameters can be determined through state relationships. This requires significant iteration for 
each computing step.

For each pipe in the system, the marching is initiated at the pipe inlet where conditions are known. The 
known inlet conditions reflect the current solution state at the junction upstream of the pipe. This is loc-
ation 1. Based on the user specified length step, the distance to location 2 is specified. The method just 
described is used to converge on the conditions at location 2. Once this convergence occurs, the 
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previous location 2 becomes location 1 and a new location 2 is determined based on the step size. The 
marching continues to the end of the pipe.

If the user specifies an absolute length size (say 10 foot sections), a step may go past the end of the pipe. 
This will occur for any pipe that is shorter than 10 feet. For a longer pipe of say 12 feet, the first computing 
length will be 10 feet, while the second will be 2 feet.

It should be understood that in the Length March method, computing sections are equidistant along a 
pipe, aside from possible roundoff at the end.

Note: The process of converging on location 2 while marching down a pipe is referred to as a local iter-
ation. It is local in that it does relate to what is happening in any other part of the model. AFT 
xStream also has global iterations, which relates to iterations made on the entire system in try-
ing to obtain complete system convergence. You can specify iteration limits for each type of con-
vergence in the Iterations panel.

Example Application

Consider the model in Figure 2. This model is of an air system modeled as a real gas using Redlich-
Kwong and Generalized enthalpy. The Solution Method panel specifies Length March method with 10 
segments per pipe. Results using the Length March method are shown in Figure 3.

There are several items worth noting in Figure 3. First, note that the second column shows the x location 
for each computation step. Point 1 will be identical to the pipe's inlet values. For this model, there were 10 
steps along a 100 foot pipe, thus each step is equally  10 feet long. 

Second, notice how the velocity and Mach number increase along the pipe length.

Third, notice how the static temperature drops. This is due to cooling of the gas as it expands with pres-
sure drop.

Fourth, notice that the stagnation enthalpy is constant in accordance with adiabatic flow.

Fifth, notice how the static enthalpy drops along the pipe length. This shows that the flow is not 
isenthalpic.

Finally, notice how the stagnation temperature drops slightly. This is a result of real gas effects. A perfect 
gas will have constant stagnation temperature and enthalpy in adiabatic flow with constant elevation.

These results can be viewed graphically by changing to the Graph Results window and selecting to 
graph a profile along a flow path.
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Figure 2: Model of an air system dropping from 40 to 30 psia.

Figure 3: Axial Points (available in the Output window) for model in Figure 2 using Length March method

Length March Method Verification

The axial points shown Figure 3 can be used to verify that the fundamental equations are being solved 
accurately. Figure 4 shows the relevant verification parameters for a pipe carrying air from a tank at 40 
psia and 100 deg. F to another tank at 30 psia. The pipe is vertical, 100 feet long, and 4 inches in dia-
meter with a roughness of 0.001 inches, and is adiabatic. The high pressure tank is the top tank.

 
Figure 4: Axial Points for AFT xStream model Verify_Governing_Equations.xtr using the Length March 

method.

The model, Verify_Governing_Equations.xtr, is shown in Figure 5 can be obtained from AFT upon 
request (support@aft.com). Also included is an Output Control data configuration file called Verify_
Governing_Equations_1.dat that can be used to configure any model to that shown in Figure 1.

The Figure 4 results were obtained using the Length March method with 10 pipe segments. The results 
can be copied to the clipboard and pasted into a spreadsheet as shown in Table 1. Once in the spread-
sheet, additional calculations can be performed. Table 1 shows these calculations and a balance 



Analysis Setup Overview

- 127 -

verification using all terms in the momentum equation (Equation 2), continuity equation (Equation 1), and 
energy equation (Equation 30). Along with the previous files, this spreadsheet is included upon request 
and is named Verify_Governing_Equations_Length.xls.

There are several terms in Table 1 that require clarification. Using coordinates as shown previously in Fig-
ures 1 of Fundamental Equations and Figure 1, density and velocity can be represented as follows:

 
Figure 5: AFT xStream model solved in Figure 1 and verified in Table 1. Fluid is air. File is Verify_Governing_

Equations.xtr.

And using these terms, the four momentum equation terms from Table 1 are defined as:

dP Total:                           
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dP Fric. (Friction):                           

dP Accel (Acceleration):                           

dP Grav. (Gravity): (53)

Table 1: Verification showing how AFT xStream Length March method predictions satisfy momentum, mass 
and energy balance equations. Taken from spreadsheet Verify_Governing_Equations_Length.xls. 

There is another term that is not relevant in this model and is thus not shown in Table 1. This term 
accounts for additional minor losses in the form of K factors, and is a modified form of the dP Acceleration 
term:

The momentum equation terms in Table 1 are added together for each computing section. If the 
momentum equation is being satisfied, the four terms should sum to zero (or a very small number). They 
do, as shown in Table 1 in the column titled Balance (psi).
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Note that AFT xStream does not solve Equation 49. Rather, when using the Length March method, AFT 
xStream solves Equation 27, which contains (more accurate) logarithmic terms. Equation 27 is a more 
complex form of the momentum equation. The arithmetically averaged terms in Equations 49 and Table 
1 are approximations which show that the momentum equation is being satisfied.

Table 1 has another column titled Balance (lbm/sec) which shows that the continuity equation (Equation 
1) is also satisfied. This is calculated in Table 1 as follows:

While not shown here, it was shown earlier in Figure 3 how AFT xStream maintains constant stagnation 
enthalpy for adiabatic flow with zero elevation change. According to the energy equation (Equation 30), 
when the elevation changes, the stagnation enthalpy is not constant in adiabatic flow. The energy bal-
ance is calculated as follows:

In the Energy Balance column, Table 1 shows how this equation is satisfied. If heat transfer is applied, it 
is a simple matter to extend the spreadsheet behind Table 1 to verify that energy is balanced.

The individual terms in Equations 49 are also available for output in AFT xStream. The contributions to 
pressure drop can be reviewed individually, and can also be used for further verification. Figure 6 shows 
the axial points again for Verify_Governing_Equations.xtr, but now these pressure drop contributions are 
shown. The Output Control data configuration file used to obtain the Figure 6 format is Verify_Govern-
ing_Equations_2.dat.

Figure 6: Axial Points for Verify_Governing_Equations.xtr showing the individual pressure drop con-
tributions.

The Pipe Results table shows the total pressure drop contributions for each pipe when appropriate para-
meters are selected for display. See Figure 7.
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Figure 7: Pipe Results table shows total pressure drop contributions as defined in Equation 49.

Related Topics

Nomenclature 448

Mach Number March Method - Detailed Discussion
The Mach Number March Solution Method for the AFT Arrow Steady Solution Method is described in 
detail below.

Modify Equation 2 by substituting Equations 3 and 5 and eliminating density,

(6)

By definition of Mach number for a real gas

(7)

and from basic calculus the following relationship holds:

(8)

Differentiating Equation 7 (and using Equation 8) results in,
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(9)

Now, substitute Equation 7 and 9 into Equation 6 and eliminate the velocity

(10)

Differentiating the equation of state, Equation 5 yields

(11)

Replace velocity by Mach number by substituting Equation 9 into Equation 11 to obtain

(12)

Eliminate pressure from Equation 10 using Equation 12 to obtain:

(13)

From the definition of stagnation temperature

(14)

Differentiating the preceding yields
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(15)

Replace static temperature in Equation 13 with stagnation by using Equation 14 and Equation 15 to 
obtain:

Collecting terms and simplifying yields:

(16)

Rearrange Equation 16 to obtain

(17)

Four useful parameters that simplify notation are:
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(18)

Using the four new parameters in Equation 18 simplifies to

(19)

Integrating Equation 19 yields

(20)

Equation 20 can be solved for x2:
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(21)

where the bars over certain parameters indicate that the average value over the computing section is 
used.

Equation 21 is the Mach Number March equation. The Mach Number March is a variable step size 
method. As shown in Equation 21, the distance is the parameter being calculated. 

Modifications for Heat Transfer 

In order to model heat transfer effects it is convenient in some cases to modify the previous equations.

The energy equation has the form:

(28)

The definition of stagnation enthalpy is

(29)

which, when substituted into Equation 28, yields:

(30)

In most applications, the elevation term, gz, is very small and is neglected. This term will only become sig-
nificant over pipes that have large elevation changes such as pipelines that go over mountains or down 
mineshafts, or in rapidly rotating systems.

With elevation neglected, it is not uncommon for engineers to conclude that adiabatic flow is isenthalpic 
(constant static enthalpy). It’s not. Rather, the stagnation enthalpy is constant in adiabatic flow. 
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Convective Heat Transfer

In pipe convective heat transfer, it is convenient to use the change in stagnation temperature rather than 
stagnation enthalpy by introducing the following approximation

(31)

When heat transfer occurs, the effect of elevation change on the energy balance is small and is neg-
lected. Substituting Equation 31 into Equation 30 yields

(32)

The heat transfer due to convection is given by the following:

(33)

where: 

        U        = Overall heat transfer coefficient 

        Ph        = Heated perimeter

The heated perimeter will frequently equal the wetted perimeter, which is the internal pipe circumference. 
It can change if part of the pipe is insulated (it will be less than the wetted perimeter) or there are fins on 
the pipe (it will be greater than the wetted perimeter).

Equating Equation 32 and 33 yields

(34)

Rearranging Equation 34 yields:

(35)

Integrating Equation 35 yields
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(36)

This relationship for stagnation temperature can be substituted into Equation 20 to obtain:

(37)

In convective applications which use the Mach Number March method, the advantage of Equation 37 
over Equation 21 is that the stagnation temperature change is proportional to the distance step dx (as 
shown in Equation 35), for which we are solving. Equation 37 couples the effects of friction and heat 
transfer, and provides more reliable convergence, especially in convection heating.

Constant Heat Flux 

The constant heat flux boundary condition on a pipe results in a modified form of Equation 32

(38)

The stagnation temperature change is thus:

(39)

Integrating Equation 39 yields:

(40)
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Substituting this into Equation 20 yields:

(41)

Example

Some examples are given here to clarify how the Mach Number March and Length March methods solve 
the governing equations.

 
Figure 1: Marching equations are applied at successive computing sections along the pipe. Conditions at loc-

ation 1 are known, and at location 2 are being solved using one of the marching equations 

Both of these methods are referred to as marching methods. What does this mean? Figure 1 shows a rep-
resentation of a computing section in a pipe. In this example, all parameters at Location 1 are known, and 
it is desired to calculate conditions at location 2 which is always downstream of location 1.

Whether we are applying the Length March or the Mach Number March (Equation 21, 37 or 41), at loc-
ation 1 we know these primary parameters:

Because we know the parameters above, we also know:

Let’s turn our attention to the Mach Number March method. Depending on the heat transfer model, AFT 
xStream will solve either Equation 21, 37 or 41. The most general of these is Equation 21, so in the fol-
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lowing discussion it will be referred to as the Mach Number March equation, with the understanding that 
Equation 21 encompasses Equations 37 and 41.

Similar to the Length March method, it is desired to solve for conditions at location 2 based on known con-
ditions at location 1 (see Figure 2). However, here the length step itself is not known. In fact, as shown in 
Equation 21 it is the computing length (i.e., Δx) for which we are solving. What is the reason for trying to 
solve for Dx rather just specifying it? This question will be answered shortly. Before that, let’s understand 
better what is happening when Equation 21 is applied.

The knowns at location 1 are the same as before, namely:

with the other derived knowns easily obtainable:

In the Mach Number March method, our step size is dictated by increments of Mach number. We thus 
take the Mach number at location 1 (M1) and add to it an increment. Since the maximum Mach number in 
the pipe systems modeled in AFT xStream is 1, the step size should be far smaller. The default step size 
is 0.01. Using the default, we know the Mach number at location 2:

where ΔM is the Mach number increment. As before, we know the mass flow rate at location 2 (it's the 
same the same as location 1), and we also have similar heat transfer relationships as discussed in the 
Length March method example previously. 

Specifically, if the pipe is adiabatic, we know the following at location 2:

or, if isothermal, the following is known at location 2:
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and if the pipe has a convective or heat flux boundary condition, 

However, in the convective and heat flux cases, we cannot definitely say what ho,2, is because the 
amount of stagnation enthalpy change depends on the length step, for which we are solving. This 
requires additional iteration.

Similar to the Length March method, the Mach Number March method requires significant iteration for 
each computing step. Again, known inlet conditions become the first location 1, and once location 2 is 
solved, it becomes location 1 and the marching continues to the end of the pipe.

Since we are solving for Δx, it is entirely possible that the distance step will extend beyond the pipe 
length. This will occur for any pipe that has an end-to-end Mach number change of less than ΔM. It will 
always occur for the final computing section of each pipe that does not reach choking. In such a case, the 
method reverts to the Length March method to compute conditions at the pipe exit.

It should be clearly understood that in the Mach Number March method, computing sections are not 
equidistant along a pipe. In fact, as the gas accelerates along the pipe, the Mach number increases more 
and more rapidly. This results in shorter and shorter computing section lengths as shown in the following 
application.

Example Application

Consider once again the model in Figure 2. All conditions are the same as in the previous Length March 
method application, except for the solution method. If we solve this model using the Mach Number March 
method, with a Mach number increment of 0.01, the results in Figure 3 are obtained.

There are several items to note about Figure 3. First, note how the Mach number increases down the 
length of the pipe. At the inlet, the Mach number is 0.2604 (this is not specified, but determined as part of 
the solution for flow rate). Each computing point increases the Mach number by DM , which is 0.01. This 
is what the Mach Number March method is, a method which marches in Mach number increments. With 
the step size dependent on the Mach number change, the number of calculation points in a pipe cannot 
be controlled. The  10 points shown in Figure 3 were chosen by AFT xStream, not the user.

Second, note the x locations of computing points. These numbers are not whole numbers, and as the 
end of the pipe is approached the distance between each computing section and the previous one 
becomes smaller and smaller. This is a result of the gas acceleration. At higher Mach numbers this 
becomes even more pronounced. 

Figure 4 shows how the Mach number increases along the pipe length. The curve's upward curvature 
shows the acceleration effect. Figure 5 shows the relative computing section distances.

Third, notice this adiabatic flow case has constant stagnation enthalpy, but not constant static enthalpy. 
This is similar to the Length March method.

Last, notice how the mass flow rate is (in this case) the same as the Length March method results shown 
in Figure 3 of Length March Method Example (4.884 lbm/sec). Since both methods solve the same gov-
erning equations, one would expect the results to be comparable. However, the two methods will not 
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always agree. Each method has strengths and weaknesses, and results can differ somewhat when the 
flow conditions favor one of the methods.

Is there any way to check that the results offer valid solutions of mass balance (Equation 1), momentum 
balance (Equation 2) and energy balance (Equation 30)? There is. An example is given in the Mach Num-
ber March Verification section below.

Figure 2: Model of an air system dropping from 40 to 30 psia.

Figure 3: Axial Points (available in the Output window) for model in Figure 2 using Mach Number March 
method.
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Figure 4: The Mach number increases with length in this plot of the Figure 3 results

Figure 5: Relative pipe section locations for Figure 3 results. Notice how computing sections get closer as a 
result of gas acceleration as the end of the pipe is approached

Mach Number March Method Verification

By changing the solution method for Verify_Governing_Equations.xtr in Figure 5 of the Length March 
Verification to the Mach Number March method, the verification process described in the previous sec-
tion for the Length March method can be repeated. This is shown in Figure 6 and Table 1.
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Figure 6: Axial Points for AFT xStream model Verify_Governing_Equations.xtr using the Mach Number March 
method.

Table 1: Verification showing how AFT xStream Mach Number March method predictions satisfy momentum, 
mass and energy balance equations. Taken from spreadsheet Verify_Governing_Equations_Mach.xls

 

Related Topics

Nomenclature 448

Lumped Adiabatic Method - Detailed Discussion
When this AFT Arrow Steady Solution Method is used, all heat transfer data entered for individual pipes 
is neglected. The other pipe data is left as entered by the user in case the user switches back to one of 
the marching methods.
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Elevation data is also ignored by the Solver. The output will still show the elevation as entered by the 
user. Since elevation effects are usually not very important in gas systems, neglecting elevation changes 
is frequently an acceptable approximation.

An analytical solution to Equations 1, 2, and 5 for adiabatic flow neglecting elevation changes is given by 
the following (e.g., see Saad, 1993, page 209):

(42)

This equation is valid for real gases as long as the following approximation is accepted:

using a suitably averaged value of cp. Integrating from 0 to L obtains:

(43)

Equation 43 is then solved for each pipe, using an average value of friction factor and g for each pipe. 
The solution of Equation 43 typically is iterative where the unknown is M2.

Note: In Saad 1993 on page 209 equation 5.27 (Equation 43 above) the square brackets are not 
included. They have been added above to clarify that the natural log applies to all of the encap-
sulated terms. Furthermore, the left-hand side in Saad contains a multiplier of 4 since the Fan-
ning friction factor was used, whereas Equation 43 above used in AFT software uses the Darcy 
friction factor.

Related Topics

References 499

Lumped Isothermal Method - Detailed Discussion
When this AFT Arrow Steady Solution Method is used elevation data is ignored by the AFT Arrow Steady 
solver. The output will still show the elevation as entered by the user. Since elevation effects are usually 
not very important in gas systems, neglecting elevation changes is frequently an acceptable approx-
imation.



Analysis Setup Overview

- 144 -

Another special case of flow in pipes is that of isothermal flow. In isothermal flow, the gas static tem-
perature remains constant. The tendency is for gas to cool as it flows along a pipe. For the temperature to 
remain constant, an inflow of heat is required.

When the temperature remains constant, it removes one of the unknowns from Equations 1, 2 and 5. 
From Equation 5, the density becomes directly proportional to pressure, and an analytical solution can be 
obtained if elevation changes are neglected (e.g., see Saad, 1993, pp. 264-269):

(44)

where the T subscript on L emphasizes isothermal. Integrating from point 0 to L,

(45)

Isothermal flow behavior results in a different relationship for sonic choking as compared to adiabatic 
flow. In fact, to truly maintain isothermal flow up to the sonic point requires an infinite amount of heat 
transfer. This results in the strange but mathematically correct conclusion that sonic choking occurs at a 
Mach number less than 1 for isothermal flow. Sonic choking will occur at 1/sqrt(gamma) for isothermal 
flow, where gamma is the isentropic expansion coefficient (Saad, 1993, pp. 267). Practically speaking, 
isothermal flow will not remain isothermal at high velocities.

Similar to the Lumped Adiabatic method, Equation 45 is solved for each pipe, using an average value of 
friction factor and g for each pipe. The solution of Equation 45 typically is iterative where the unknown is 
M2.

When the user chooses the Lumped Isothermal method, an isothermal temperature is required in the 
AFT Arrow Steady Solution panel. This temperature is used for all pipes.

Related Topics

References 499

Tolerance Panel
The iterative tolerances that define convergence are defined on the Tolerance panel in Analysis Setup, 
shown in Figure 1. These values can be modified for Pressure Tolerance, Flow Rate Tolerance, and 
Enthalpy Tolerance.
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Figure 1: Tolerance panel in Analysis Setup

An iterative approach is used to obtain pipe flow solutions. When approaching any analysis iteratively, a 
stopping point must be defined. The simplest approach is to stop after a certain number of iterations. 
However, this either results in uncertain results because the result is still changing, or wasted processing 
time because there are too many iterations.

A solution is to use iterative tolerance. This tolerance is related to the change between iterations. When 
this change is smaller than the iterative tolerance, the solution is said to be converged. These settings 
are specified in the Solution Method panel.

Tolerance and Solution Accuracy

Iterative tolerance does not have any relationship to an engineering tolerance.

An engineering tolerance is a familiar term to most engineers - it is a permissible limit in variation of a 
parameter. A simple example is the length of a steel bar - an engineer might specify that this length must 
be 3 ± 0.01 meters. A steel bar manufactured by this specification is known to be within the engineering 
tolerance of the "true" or desired length. In other words, engineering tolerance describes an accuracy.

Iterative tolerances do not directly describe an accuracy. Convergence only means that the change 
between iterations was within the specified limit.

With sound iterative methods, and an appropriately specified iterative tolerance, the iterative solution will 
be close to the true solution. However, even with good settings, the iterative tolerance does not define 
how close the results are to the true solution.

If there is concern that the results may not be close enough to the true answer, the tolerances could be 
lowered and the results compared. If the results do not change appreciably, an appropriate tolerance 
was likely selected.
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Avoiding False Convergence

It is important to keep the tolerance at least one order of magnitude smaller (two orders or more is recom-
mended) than the relaxation. A false convergence can occur when the change from the old value to the 
new value is small enough to be within the tolerance because it is restricted by the relaxation.

Absolute Tolerance

Absolute tolerance looks at the absolute change in quantity of a given parameter. If the change is smaller 
than the directly specified value, the parameter is considered converged.

This approach works equally well for both small and very large values, making iterative solvers more 
likely to find convergence. However, specifying an appropriate absolute tolerance requires some know-
ledge of the true solution. The tolerance should be set 3 or 4 orders of magnitude below the solution, if 
there are near zero flows in the system this will require a very low tolerance.

Relative Tolerance

Relative tolerance checks the relative change of a given parameter. Each change is divided by the num-
ber itself, giving a change proportional to the magnitude.

This approach does not require any knowledge about the true solution, and for that reason is the default 
method.

Table 1 shows the difference between relative and absolute change while iterating. Notice that the abso-
lute change has units, while relative change does not.

Convergence criteria can also be based on either (or both) absolute or relative change. Table 1 shows 
how this is applied.
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Table 1: Example of four tolerance methods for a mass flow rate example. Absolute tolerance = 0.0005 lbm/s, 
Relative tolerance = 0.0001

Iteration 
#

Mass 
Flow 
Rate 

(lbm/sec)

Relative 
Change

Absolute 
Change 
(lbm/sec)

Meets Abs. 
Tolerance?

Meets Rel. 
Tolerance?

Meets Abs. 
OR Rel. 

Tolerance?

Meets Abs. 
AND Rel. 

Tolerance?

1 20.0000 - - - - - -

2 12.0000 0.666667 8.000000 NO NO NO NO

3 14.0000 0.142857 2.000000 NO NO NO NO

4 13.5000 0.037037 0.500000 NO NO NO NO

5 13.6000 0.007353 0.100000 NO NO NO NO

6 13.5900 0.000736 0.010000 NO NO NO NO

7 13.5913 0.000096 0.000130 NO YES YES NO

8 13.5907 0.000044 0.000600 NO YES YES NO

9 13.5909 0.000015 0.000200 YES YES YES YES

Exhaustive Tolerance

AFT xStream finds a solution for all junction pressures when Exhaustive Tolerance is enabled.

Disabling this option will only check junction pressures that are in the solution matrix. Only junctions that 
contain a split in flow are included in the matrix. Both options should come to a reasonably similar con-
verged result, but the more rigorous approach of checking all junctions is selected by default.

Related Blogs

Having model convergence problems? Start here!

Iterations Panel
Relaxation, iteration limits, and matrix method settings are defined on the Iterations panel in Analysis 
Setup. Most settings on this panel will not affect the final result. The default state of the Iterations panel is 
shown in Figure 1.

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
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Figure 1: Iterations panel in Analysis Setup

Relaxation

Relaxation slows iterative progress toward a solution reducing the destabilizing effect of non-linear sys-
tems.

 l Automatic - Implements an adaptive relaxation scheme that reduces the relaxation dynamically 
in response to highly non-linear features of the problem.

 l Fixed - Allows for user specified Flow Rate and Pressure Relaxation

When applied to the flow solution, relaxation r is used as follows:

A relaxation of 1 is the same as no relaxation. Each iteration's prediction is used directly in the next iter-
ation.

A relaxation of 0 is not allowed, as this would prevent the parameter from changing.

 l Flow Rate Relaxation - For highly non-linear systems, a flow rate relaxation of 0.1 is advised. 
Experience shows that using flow rate relaxation factors between 0.5 and 1 has limited use-
fulness. If a flow rate relaxation of 1 does not work, you should generally try flow rate relaxation 
parameters between 0.1 and 0.5. In more extreme cases, a flow rate relaxation factor smaller than 
0.1 may be required.

 l Pressure Relaxation - Because of the nature of the matrix solver, experience indicates that if 
pressure relaxation is used, it should always be set to 0.5 or 1 to maintain stability.



Analysis Setup Overview

- 149 -

 l Resistance Relaxation - Typically should be left at 1. In some cases with very long pipelines, 
reducing the value as low as 0.1 can improve convergence.

Iteration Limit

 l Maximum Iterations - 50000 by default, sufficient for the vast majority of models. Most models 
converge in a relatively small number of iterations. This limit does not directly affect the solution.

 l Iteration Span for AutoDetect - If the AFT Arrow Steady Solver detects that no meaningful pro-
gress has been made to convergence within this many iterations, relaxation is automatically 
lowered. This also automatically adjusts tolerance.

 l Local Iterations - The maximum number of local iterations allowed before allowing the Solver to 
continue without local convergence. See Local Iteration Control below for details.

Iteration History

Iteration History shows a history of which pipe or junction is most out of tolerance, which is helpful for 
troubleshooting. After enabling Iteration History on the Iterations panel in Analysis Setup, the Iteration 
History can be viewed from the Solution Progress window by pausing the calculation and selecting the 
Other Actions button.

Matrix Method

Network analysis requires solving complex matrices potentially thousands of times. Different methods 
may solve faster or slower, but have no bearing on results. The default method of Gaussian Elimination is 
very robust and usually provides the fastest convergence. The available Matrix Methods are:

 l Gaussian Elimination
 l Gaussian Elimination With Pivoting
 l LU Decomposition

Local Iteration Control

In the AFT Arrow Steady  Solver, properties such as density, specific heat, and viscosity will vary over an 
interval. Calculations done on such an interval should use average values for the interval. However, the 
average values cannot be directly calculated without knowing the values at both the beginning and end-
ing of the interval. Because the parameters at the end of the interval are not known initially, the local prop-
erties must be solved for iteratively.

In certain models, these local iterations may not converge. The Local Iterations limit provides a means 
to allow the Solver to continue if this occurs.

If the Local Iteration limit is reached, the Solver will continue with the global solution using the non-con-
verged local solution. This does not affect the final results unless it occurs on the final global pass 
through the Solver. If a local iteration problem does occur on the final pass, the solution is retried. A Max 
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Number of Retires After Incomplete Local Convergence will be carried out to attempt to solve the 
problem. If the retries are not successful, the results will be presented as converged along with a warning 
including information on the amount out of tolerance.

A default Factor on Allowable Tolerance Violation of 50 is specified here. Local iterations within this 
factor of the built-in tolerance values are deemed adequately acceptable. Setting this value to 1 will show 
a warning for any tolerance violation.

Related Blogs

Having model convergence problems? Start here!

Pressure and Temperature Limits Panel
The Pressure and Temperature Solver Limits panel allows users to set boundaries, temperature and 
pressure, within the solver. These limits are intended to help with convergence and prevent the solver 
from providing unrealistic results. These limits are intended to keep the solver within physical restraints, 
such as temperatures that can't be produced on Earth. This is most useful when operating near the edge 
of available physical property data. During iteration, the Solver may attempt to extrapolate past the avail-
able data, returning an error. Limiting the allowable range can keep the search within the proper bounds. 

For design requirements and limitations, use Design Alerts to signify when the solvers values are beyond 
a desired range yet is still physically possible to occur.

Figure 1: Pressure and Temperature Solver Limits panel within Analysis Setup

Note: This setting can affect results. It is critical that the limits are appropriately selected to not arti-
ficially constrict the solution.

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
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Environmental Properties Group
The Environmental Properties Group in Analysis Setup has one item: Environmental Properties panel. 
By default, the Environmental Properties Group is fully defined and will have a green checkmark next to 
its name.

Environmental Properties Panel
The Environmental Properties panel, shown in Figure 1, controls the atmospheric pressure, acceleration 
properties, standard conditions, and transition Reynolds number used to model the system.

Figure 1: Environmental Properties panel in the Analysis Setup window

Atmospheric Pressure    

AFT xStream uses a default atmospheric pressure of 1 standard earth atmosphere, or 14.696 psia. This 
pressure is also used to convert absolute pressures to gauge pressures. Keep in mind that atmospheric 
pressure varies with altitude. A project at Sea Level should not have the same atmospheric pressure as a 
project at 8500 feet. 

Standard Conditions (STP)    

The standard temperature and pressure (STP) are used for defining common usage flow rate units includ-
ing standard cubic feet per minute (scfm).    
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AFT xStream uses a default standard pressure of 14.696 psia. This value is used consistently across 
industry, and the user likely will not need to change it. AFT xStream uses a default standard temperature 
of 60° F. This value changes across industries, and the user may wish to change it.    

Another common usage flow rate is normal flow rate units. The definition of normal uses the same stand-
ard pressure as above, but 32° F (0° C) for temperature. The normal pressure and temperature cannot 
be changed by the user.    

Transition Reynolds Numbers    

AFT xStream allows you to modify the transition Reynolds numbers. The default values are Reynolds 
number less than 2300 is laminar and greater than 4000 is turbulent. In the transition zone a linear inter-
polation is assumed. This applies for friction factors as well. 

Miscellaneous Group
The Miscellaneous Group in Analysis Setup has two items: the Advanced Parameters panel and 
Advanced Transient Parameters panel. Both panels contain advanced parameters intended for 
troubleshooting only and should be used with caution.

Advanced Parameters
The Advanced Parameters panel offers various advanced options to adjust the AFT Arrow Steady 
Solver.

These parameters should not be changed under normal circumstances and will seriously impact results. 
They can be useful for troubleshooting certain models. Contact AFT for more information.

Transient Solver Advanced Parameters
The Transient Solver Advanced Parameters panel is located in the Miscellaneous group of Analysis 
Setup.

The options on this panel are intended for troubleshooting use and should only be changed with caution. 
In almost every model, the default values for these parameters is appropriate. There are rare cir-
cumstances where the user may wish to change them.

A description of some of the most commonly used advanced parameter options is provided here. For 
information and guidance on other options please contact AFT.

 l Create Transient Debug File - Disabled by default. When enabled, xStream will write relevant 
diagnostic information to a text file, including information on tolerance and convergence settings, 
records of when/if saturation conditions were reached, etc. The transient debug file will be created 
in the same location as the model file, and follows the naming structure "Model Name_#_
GasTranDebug.txt", where Model Name is the user specified model name, and # represents a 
number assigned to differentiate between the transient debug files generated for different 
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scenarios. It is recommended to send this file to AFT when requesting support on a model file.
 l Limit Properties to Saturation Conditions - Disabled by default. If enabled, xStream will 

attempt to limit the temperature and pressure to saturation conditions to allow the transient solu-
tion to continue. This will not produce accurate results as xStream cannot account for two-phase 
flow. However, this may be useful for troubleshooting purposes to be able to analyze the transient 
results up to the point that saturation conditions were reached.

 l Halt Solver When Saturation Conditions Encountered - Disabled by default. If enabled, 
xStream will halt the solver if the temperature and/or pressure conditions exceed the saturation 
line. This is useful to provide the user the chance to immediately stop the transient and 
troubleshoot the model, as any transient results calculated after the time that saturation conditions 
were reached will be invalid.

Related Examples

Fluid Library Comparison - Steam Turbine Shutdown Example 639
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Working with Pipe and Junction Objects
This section focuses on interactions with the Pipe and Junction objects in the AFT xStream workspace. 
Topics include how to create pipes and junction objects, how to alter junctions already on the workspace, 
and how to ensure the inputs for objects are both correct and complete.    

Contents

Selecting and Finding Objects 154

Pipe Drawing Modes 158

Selecting and Finding Objects
AFT xStream has a number of methods to assist in selecting multiple objects at once as well as finding 
objects for recall later. The contents of this section can be broken down into the two categories shown 
below. Follow the links to learn more.

 l Methods for selecting objects

 l Select Flow Path

 l Select Special

 l Groups

 l Methods for finding objects

 l Workspace Find

 l Workspace Search

 l Find from Model Data or Output

 l Jump Feature

 l Bookmarks

Related Topics

Selecting Objects 154
Moving Objects 173
Editing Objects 173
Defining Objects 174

Selecting Objects
A single left click on any object will select that object. Selecting multiple objects can be accomplished by:
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 l Holding the shift or control key and left clicking on objects
 l Dragging the cursor over the objects, creating a selection area

 l Dragging left-to-right creates a selection area that will only select objects entirely bounded 
by the area

 l Dragging right-to-left creates a selection area that selects any objects completely or par-
tially inside the area

 l Using Select All from the Edit Menu, right-clicking on Workspace to open context menu, or key-
board shortcut (Ctrl+A)

 l Using Select Last Selection from the Edit Menu or with F12 to reselect the previously selected 
objects

 l Using Select Flow Path
 l Using Select Special
 l By selecting a Group

Select Flow Path

A flow path is a sequence of pipes and junctions where there is no branching or flow sources or sinks.

The pipes and/or junctions in a flow path may all be easily selected by selecting a pipe on the Workspace 
then clicking the Select Flow Path item on the Edit menu, Toolbar, or the right-click context menu.

This feature is very useful in duplicating or deleting sequences of pipes and junctions. It can also be used 
to quickly define groups for graphing or for selected Output or Model Data listings.

Select Special

Select Special is a tool for selecting or deselecting objects based on certain criteria. It can be opened 
from all windows/menus that give you the option to choose what pipes and/or junctions are selected. 
These windows/menus include the Output Control window, the Model Data window, the Layer Settings 
window, the Select Graph Data window, the Edit menu, right clicking on the Workspace, or pressing F6 
on the keyboard.

Once Select Special is open, all pipe names and numbers and junction names and numbers are shown 
in numerical order under Pipe Selections and Junction Selections, respectively. At the top of the Select 
Special window is the Selection Type option. This option allows you to choose what criteria you would 
like to use to select certain pipes and junctions. You can choose from the following criteria to select cer-
tain pipes and/or junctions.

 l Selected on Workspace
 l Closed in Model
 l Special Conditions Set
 l Number Range
 l Junction Type
 l Pipe Input Properties
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 l Notes
 l Undefined Objects
 l User-Colored Pipes
 l Transient Data Exists
 l Groups
 l Pipe Output Properties (Only available when output is available)
 l Junction Output Properties (Only available when output is available)

Choosing certain Selection Types will prompt a second or sometimes third option below the Selection 
Type to allow you to further specify the type of pipe or junction you want. For example, selecting Junction 
Type in the Selection Type box will prompt the Junction Type box to appear. The Junction Type box will 
allow you to specify what type of junctions you would like to select. 

By default, the Selection Type is Selected on Workspace and any pipes or junctions selected on the 
Workspace are selected in the Select Special window with a black check mark next to the box cor-
responding to the pipe or junction. 

Once you have fully specified the Selection Type, you must click Select Pipes and/or Select Junctions to 
automatically select the corresponding objects.

The selected pipes and junctions under Pipe Selections and Junction Selections do not automatically 
become unselected when you switch from one Selection Type to another. Therefore, you must first 
choose Deselect Pipes and/or Deselect Junctions located above the Pipe Selections and Junction Selec-
tions boxes, respectively. For example, if you select all of the pipes on the Workspace prior to opening 
the Select Special window, all of the pipes will be selected in the Select Special window when you open 
it. If you then choose Junction Type as the Selection Type and then specify All Junctions as the Junction 
Type, all junctions will be selected under Junction Selections, but all pipes previously selected will also 
remain selected. In this example, if you would like only junctions to be selected with none of the selected 
pipes on the Workspace to be selected in the Select Special window, first click the Deselect Pipes button, 
which is located above the Pipe Selections list. 

Options to select all pipes/junctions, to deselect all pipes/junctions, and to invert the selected pipes/junc-
tions are located below both Pipe Selections and Junction Selections boxes. Inverting the pipes/junc-
tions deselects all currently selected pipes/junctions and selects all currently deselected pipes/junctions. 
This feature is helpful if you want to select all pipes/junctions that do not fit a certain criteria. For 
example, if you want to select all open objects in the model, you could specify Closed in Model in the 
Selection Type box, then click Select Pipes and Select Junctions. All pipes and junctions that are closed 
in the model will be selected. Because you want to select all open pipes and junctions in the model but 
only the closed pipes and junctions are selected, you would simply click Invert below both the Pipe Selec-
tions and Junction Selections lists to deselect all closed pipes and junctions and select all open pipes 
and junctions.

Related Topics

Selecting and Finding Objects 154
Moving Objects 173
Editing Objects 173
Defining Objects 174
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Finding Workspace Objects

Workspace Find

The Find window utility helps you find a particular pipe or junction by its ID number and name. The Find 
utility becomes more useful for models that expand over multiple Workspace pages.

You can access the Find utility by selecting Find on the View menu, by clicking the button on the Toolbar, 
or by using the keyboard shortcut "Ctrl+F". After you double click on the pipe or junction you are search-
ing for in the Find utility or when you click the Find button, the Workspace is moved so that the pipe or 
junction is located near the center of the screen. Additionally, the pipe or junction you are searching for is 
selected in the Selected Items color specified in the User Options window in the Tools menu. By default, 
this color is red.

Workspace Search

The Search window utility helps you search for a particular pipe or junction by its ID number, name, or 
notes you have inputted in the properties window. The Search utility becomes more useful for models 
that expand over multiple Workspace pages.

You can access the Search on the Common Toolbar. The search feature will list all objects related to 
your search term beneath itself in a list of search results. You can hover over each search results to see a 
preview of input and output (if the model has been run). Clicking on or pressing enter while the object is 
highlighted in the search results will select the object in the workspace and center the focus of the work-
space on the object.

Find From Model Data or Output

Objects can be quickly located on the Workspace by right-clicking on a cell in Model Data or row header 
in Output and selecting "Find on Workspace..." the view will change to show the Workspace, with the 
object of interest selected.

Jump Feature

By clicking the Jump button in a Properties window, you can move directly to another Properties Window 
of another a pipe or junction that you specify. 

The Jump button is located in the upper right corner of the Properties Window.

Bookmarks

Use the Bookmark tools on the View menu to set Bookmarks and to display different bookmarked pipes 
or junctions.
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Bookmarks can be added on the Workspace in relation to individual pipes or junctions. You can quickly 
navigate around the Workspace by moving from Bookmark to Bookmark.

Groups
Groups of pipes and junctions can be named for later recall. This is done using the Group tools on the 
Edit menu. The easiest way to create a named Group is as follows:

 1. First select the pipes and junctions you want in the group                                      
 2. Choose Groups -> Create from the Edit menu or Toolbar.                                       
 3. You will be prompted for a name for the group. Enter a meaningful name and click OK.                                      
 4. The Group Manager then opens. The selection of pipes and junctions in the Group will match 

those currently selected on the Workspace. If you want to modify the selections once more, you 
can do it here.                                      

You can include Subgroups inside of your Groups. Subgroups are existing Groups. If a Group contains 
one or more Subgroups and the Group is selected on the Workspace, then all pipes and junctions in the 
Group and Subgroup(s) will be selected. Additionally, if you include a Subgroup in your Group and then 
later change the contents of the Subgroup, the Group that contains the Subgroup will also be changed.

After you have created a Group, you can then quickly reselect that Group of pipes or junctions on the 
Workspace by choosing Group -> Select from the Edit menu or Toolbar and choosing the name of the 
Group.

The Group Manager can be opened by choosing Group -> Manager from the Edit menu or Toolbar. The 
Group Manager allows you to modify, create, delete or rename Groups.

Another place that Groups can be selected from is in the Select Special window.

Related Topics

Graph Results Window 347
Global Pipe Editing 165
Global Junction Editing 166
Force Set Types 45

Pipe Drawing Modes
AFT Impulse has a selection of pipe drawing modes. To select or change a pipe drawing mode, navigate 
to Arrange -> Pipe Drawing Mode. These pipe drawing modes are:

 l 2D Freeform
 l 2D Orthogonal
 l Isometric

A second function called Snap to Grid is highly integrated with Pipe Drawing Modes and will alter how 
each pipe drawing mode works. To select or change a Snap to Grid option, navigate to Arrange -> Snap 
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to Grid. The Snap to Grid options for the 2D modes are on and off. Snap to Grid options for Isometric are 
more extensive. These snap to grid options are:

 l Snap to Isometric Grid Lines
 l Snap to Grid Points
 l Do Not Snap

2D Freeform

This Pipe Drawing Mode allows placing pipes or junctions anywhere on the Workspace, with pipes at any 
angle. Snap to Grid can be turned on with this mode to force the junctions to be at grid intersection points.

Figure 1: 2D Freeform with Snap to Grid off
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Figure 2: 2D Freeform with Snap to Grid on

2D Orthogonal

The 2D Orthogonal Pipe Drawing Mode forces all pipes drawn in the model to be either horizontal or ver-
tical. Segments are automatically inserted into pipes to enforce drawing only along the horizontal and ver-
tical directions.
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Figure 3: Model in 2D Orthogonal mode with Snap to Grid on

Orthogonal drawing can create some confusion for the user because segments from different pipes may 
overlap each other and hence become indistinguishable.

 l Use the Add/Remove Segments button to add new segments
 l Use a fine grid and the Snap to Grid features
 l If you have a junction with several connecting pipes that interfere, enlarge the junction to 150% or 

200% of normal size using the Workspace Layers

Isometric

When modeling, it may be convenient or desirable to demonstrate the three dimensional nature of a sys-
tem. A typical 2D grid has two sets of grid lines representing the x and y axes. An isometric grid has three 
sets of grid lines that are offset by 60°, representing the x, y, and z axes. It is ideal to set the grid type 
desired before building a model to avoid the pipe and junction locations from being rearranged in 
undesired ways. It is also very helpful to show the Grid (Arrange -> Show Grid) when building an iso-
metric model.
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Figure 4: 2D (left) and isometric (right) grids

Drawing Pipes in Isometric Mode

How pipe drawing in isometric mode functions will change depending on the selected snap to grid option. 
When Snap to Isometric Grid Lines is selected, the pipes are automatically segmented to lie on the grid 
lines as shown below. Dragging one of the handles on the pipe shows a preview line of where the pipe 
will be placed if adjustment needs to be made. The placement of the preview line can be cycled through 
all possibilities by pressing the arrow keys or by scrolling the mouse scroll wheel. Holding the alt key 
while dragging a pipe endpoint will automatically add a new segment to the pipe - the placement of the 
line can be controlled with the arrow keys or scroll wheel as before.

    
Figure 5: Automatic layout of isometric pipes
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The Snap to Grid Points option will force the end points of the pipes to snap to the points where the grid 
lines intersect without adding segments to it. This is akin to the 2D Freeform mode while Snap to Grid is 
on.

The Do Not Snap option will allow the end points of the pipes to placed anywhere within the Workspace.

Placing Junctions

Placing junctions onto the Workspace follows the usual rules; however, the visual appearance of the icon 
is more complex than in an orthogonal grid. When icons are added after pipes are placed, AFT Impulse 
will rotate the icon automatically following the Workspace arrangement. When pipes are connected to 
icons already placed on the Workspace, right-click and select Auto-rotate Icon to adjust the icon. For 
manual control of icon appearance, right-click the junction and select Customize Icon to choose the 
desired appearance.

Note: The Rotate button in the Customize Icon window can be used to find the appropriate icon ori-
entation.

  



Working with Pipe and Junction Objects

- 164 -

    

Figure 6: Icon rotations in isometric space

Related Examples

Fluid Library Comparison - Steam Turbine Shutdown Example 639
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Global Edit
AFTxStream has the powerful capability to apply input parameters across a wide range of objects. This 
can be done for pipes by using the Global Pipe Edit or across junctions of the same type by using the 
Global Junction Edit.

Related Blogs

Mass Modify your Model with Global Edit

Global Pipe Editing
The Global Pipe Edit window allows you to edit data for multiple pipes at the same time. A Guide is avail-
able at the top of the Global Edit window to walk you through the global edit process.

Here is how you use it:

 1. Open the Global Pipe Edit window from the Edit menu, or from the right-click menu on the Work-
space.

 2. Select the pipes you want to edit from the Pipe list on the left (if pipes were selected in the Work-
space, they will be automatically selected here)

 3. Click the Select Pipe Data button. This will open a template Pipe Properties Window in which you 
can enter the data you want to change on each of the selected pipes. Alternatively, if you want to 
copy the data from an existing pipe, you can choose "Existing Pipe", then select the desired pipe 
number and skip to step 5.

 4. Enter the pipe data you want to change and click the OK button in the Pipe Properties window.
 5. The Global Pipe Edit window now lists the parameters to change in a list on the right. Select the 

parameters you want to change. 
 6. Click the Apply Selections button.

Note: You cannot change some data, like the pipe ID number, using this global method.

Note: There is no undo for global pipe editing. Therefore, you cannot revert your changes once you 
have exited the Global Edit window. However, hitting Cancel on the Global Edit window will 
undo any changes that were just applied.

Related Examples

Gas Turbine Fuel System Example 623

Related Blogs

Mass Modify your Model with Global Edit

https://www.aft.com/support/product-tips/mass-modify-your-model-with-global-edit
https://www.aft.com/support/product-tips/mass-modify-your-model-with-global-edit
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Global Junction Editing
The Global Junction Edit window allows you to edit data for multiple junctions at the same time. A Guide 
is available at the top of the Global Edit window to walk you through the global edit process, or the instruc-
tions are provided below in this topic.

Junction data falls into the following two broad categories: 

 l Common Data- data that applies to all junctions regardless of junction type; examples include 
elevation and initial pressure data. 

 l Junction Specific Data- data that applies only to certain junctions; examples include compressor 
curves and control valve setpoints.

To open the Global Junction Edit window, browse to the Global Junction Edit option on the Edit menu. 
From there, choose the category of junction you want to edit. The available categories include those junc-
tions selected on the Workspace, any junction type used in the model, and common junction data. Global 
Junction Edit can also be launched by right-clicking on the Workspace.

Note: There is no undo for global junction editing. Therefore, you cannot revert your changes once 
you have exited the Global Edit window. However, hitting Cancel on the Global Edit window will 
undo any changes that were just applied.

Editing Common Junction Data

You can open the Global Junction Edit window for common data editing in two ways. First, you can 
choose Common Data from the Global Junction Edit menu selection on the Edit menu, or you can 
choose one of the other specific junction types on the menu and then choose the Common option for the 
Junction Template in the upper left.

Here is how to globally edit junction common data:

 1. Open the Global Junction Edit window.
 2. Select the Common option for Junction Template in the upper left.
 3. Select the junctions you want to edit from the Junction list on the left. Note that all junctions in the 

model are shown, no matter what the junction type.
 4. Click the Select Common Junction Data button. This will open the Common Junction Data Edit 

window in which you can enter the data you want to change on each of the selected junctions.
 5. Enter the junction data you want to change and click the OK button in the Junction Properties Win-

dow.
 6. The Global Junction Edit window now lists the parameters to change in a list on the right. Select 

the parameters you want to change. 
 7. Click the Apply Selections button.

Note: You cannot change some data, like the junction ID number, using this global method.
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Editing Specific Junction Data

You can open the Global Junction Edit window for specific data editing in two ways. First, you can choose 
the junction type from the Global Junction Edit menu selection on the Edit menu, or you can choose Com-
mon Data on the menu and then choose the desired junction template, or Existing Junction data for the 
desired junction type.

Here is how to globally edit specific types of junctions:

 1. Open the Global Junction Edit window.
 2. Select the Junction Template option in the upper left. Alternatively, if you want to copy the data 

from an existing junction, you can choose "Existing Junction", then select the desired junction 
number and skip to step 6. 

 3. Select the type of junction you want to edit in the dropdown list in the upper left. For example, you 
could choose an Assigned Pressure junction.

 4. Click the Select Assigned Pressure Data button (the button name will change based on the type of 
junction selected). This will open the appropriate junction Properties Window, in this case the 
Assigned Pressure Properties Window. 

 5. Enter the junction data you want to change and click the OK button in the Assigned Pressure Prop-
erties Window (or whatever window type is displayed).

 6. The Global Junction Edit window now lists the parameters to change in a list on the right. Select 
the parameters you want to change. 

 7. Select the junctions you want to edit from the Junction list on the left. Note that only junctions of 
type selected in the upper left are shown (Assigned Pressure junctions in this case).

 8. Click the Apply Selections button.

Related Blogs

Mass Modify your Model with Global Edit

Toolbox
The bundle of tools at the left of the Workspace window that allows you to create pipes and junctions. 
The toolbox can be docked to the left, right, or floated within the workspace by clicking on the arrows on 
the top of the toolbox. 

https://www.aft.com/support/product-tips/mass-modify-your-model-with-global-edit
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Figure 1: Toolbox items

Custom Junction Icons

Right-clicking a junction icon in the Toolbox will open the Customize Icon window. A different icon can be 
selected from the predefined assortment, or a custom image can be uploaded using the  Add Image but-
ton. This functionality enables you to use standard P&ID icons or custom images to visually represent 
your equipment. By using recognizable icons, you can improve the clarity and comprehension of model 
results, especially for those who may not be familiar with the default AFT junction icons.

Note: The Annotation Tool also supports triangle and cloud shapes which can be used in combination 
with the Notes section on the Scenario tab of the Quick Access Panel to designate revisions of 
the model file, similar to a typical P&ID drawing.

Figure 2: The Customize Icon window allows a custom image to be applied to any junction
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Creating Pipes - the Pipe Drawing Tool
The tool in the upper left corner of the Toolbox is the Pipe Drawing tool. With this tool you can draw new 
pipes on the Workspace, starting and ending at any desired location. 

To draw a pipe, click the Pipe Drawing tool. The mouse pointer will change to a crosshair when you move 
it over the Workspace. Position the cursor at the pipe’s starting point, hold down the left mouse button 
while dragging the cursor to the pipe end point, then release the mouse button. 

To draw multiple pipes, double click the Pipe Drawing tool. This will keep the tool engaged until you click 
the Pipe Drawing tool again or press the escape key.

The length of the line on the Workspace has no relationship to the physical length of the pipe. The Work-
space pipe is merely an abstract representation of a pipe, however, each pipe drawn must have a visible 
length on the Workspace. If the pipe drawn does not have a visible length, AFT xStream eliminates the 
line immediately after you release the mouse.

When a single pipe is selected, two black squares (or more if the pipe is segmented), called handles, 
appear. When the cursor is placed over a pipe handle it changes to a crosshair and the pipe handle can 
be moved or stretched by dragging with the left mouse button.

Another way to create new pipes is to duplicate existing pipes with the Duplicate or the Copy and Paste 
features found on the Edit menu. When a new pipe is derived from a previous pipe, the new pipe retains 
the input associated with the original pipe.

Each pipe must be connected to two junctions. There are no exceptions to this rule.

Pipe ID Numbers

When a new pipe is created, it is assigned a default ID number. When the pipe is displayed on the Work-
space, the ID number is preceded by the letter "P" to indicate that it is for a pipe. From the Pipe Prop-
erties Window, you can change the ID number to any desired number greater than zero and up to 
99,999, but the number must be unique to the pipe and cannot be replicated in any other pipes on the  
Workspace. The pipe number remains with the pipe in descendant scenarios in the Scenario Manager. 
An arrow near the ID number indicates the reference flow direction for the pipe. The reference positive 
flow direction can be reversed by choosing Reverse Direction from the Edit menu or by selecting the 
reverse direction button on the Toolbar. 

Tip:  The pipe or junction ID number text can be dragged to a new location to improve visibility. The 
new location is saved with the model. If you want the text of one or more pipes and/or junctions 
returned to the default location, select those pipes/junctions on the Workspace and choose 
Reset Label Locations from the Arrange menu. From this box, click the Reset Labels For Cur-
rently Selected Pipes and Junctions. If you want all pipe and junction text returned to the default 
locations, choose Reset Label Locations from the Reset Label Locations box on the Arrange 
menu.
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Pipe Segments

A pipe can be segmented or "bent" into numerous sections. This only affects the visual representation 
and does not affect the calculated results. It does not add an "elbow" to the model or the resulting pres-
sure drop effects of an elbow. This feature is useful in graphically bending the pipe around another part of 
the model or graphically showing that there are embedded elbows as fittings & losses.

You can add a segment to a pipe in several ways. The easiest way to add a pipe segment is to first select 

the pipe, then click on the Add/Remove Segment icon  from the Toolbar. A segment will auto-
matically be added. One or more segments can be added by clicking on the down-facing arrow on the 
Add/Remove Segment icon from the Toolbar, and then choosing the number of segments to be added. 
Alternatively, you can first select the pipe, then select Pipe Segments in the Arrange menu. A dropdown 
list will appear that allows you to choose Add a Segment or Add Multiple Segments.

The easiest way to remove a segment is to first select the pipe, then click on the down-facing arrow on 
the Add/Remove Segment icon from the Toolbar. A drop down list will appear that will allow you to 
choose Remove Segment. If you wish to remove all segments, click Remove All Segments. Alternatively, 
you can first select the pipe from which you want to delete one or more segments, then select Pipe Seg-
ments in the Arrange menu. A dropdown list will appear that allows you to remove one or all segments by 
clicking on either Remove Segment if you want to remove one segment, or by clicking on Remove All 
Segments if you want to delete all segments.

Keyboard Shortcuts

See the Keyboard Shortcuts for Workspace topic for more information on additional Pipe Drawing Tool 
shortcuts.

Related Topics

Keyboard Shortcuts for Workspace 329

Joining or Splitting Pipes
When pipes are present in the Workspace, users can both combine and split up pipes. This can be done 
either to clean up the model visually or to further manipulate the model.

Joining Pipes

When multiple pipes are placed in the workspace separated by junctions without having other flowpaths 
splitting off, those pipes and intermediate junctions can be combined into a single pipe. The new pipe will 
have a total length equal to the sum of the combined pipe lengths, and any losses associated with the 
intermediate junctions will be summed and entered as additional Fittings & Losses.

The pipes being combined must have the same material, size, type, and friction model to be combined. In 
addition, the pipes must be pointing in the same direction.
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Joining pipes may cause some junction data to be lost such as special conditions, loss factors for reverse 
flow, and ignored transients. 

To join pipes and junctions in the model, select the "Join Pipes/Junctions" option from the Edit menu. The 
Join Pipes window will be shown with more information on pipes that can be combined in the model. The 
behavior of the Join Pipes/Junctions window will vary depending on if junctions are selected on the Work-
space when the Join Pipes/Junctions option is selected.

Note: For maintenance releases prior to August 2022 the Join Pipes/Junctions window did not exist. 
Instead pipes and junctions selected in the Workspace would be joined automatically when the 
"Join Selected Pipes/Junctions" option was selected in the Edit menu.

 l If junctions are selected on the Workspace, the Join Pipes/Junctions window will open with only 
the selected junctions shown in the list.

 l If no junctions are selected on the Workspace, the Join Pipes/Junctions window will open with all 
junctions that can be combined shown in the list. Any junctions that can be combined and won't 
cause a loss in data at that junction will be selected automatically.

Once the Join Pipe/Junctions window is opened the selections can be modified before joining the pipes. 
The options below the table can be enabled/disabled in order to filter the shown junctions based on if 
they are selected on the workspace, if they will loose data when combined, or if they can't be combined.

If any junctions are selected that would loose data when combined, an additional button will appear near 
the bottom of the window that allows junctions that would have data loss to be deselected. It is recom-
mended to select this button before joining the pipes/junctions unless you are certain the lost data is no 
longer required.

To join the pipes at the junctions selected in the Join Pipes/Junctions window, click the Join Selected 
Junction(s) button at the bottom of the window.

Splitting Pipes

An existing pipe in the workspace can be split into multiple pipes by holding the Shift key while placing a 
junction on the pipe. This will split the pipe in two and insert the selected junction at the specified length. 
Any fittings and losses defined in the pipe can be placed in either of the split pipe segments.

Related Topics

Keyboard Shortcuts for Workspace 329

Creating Junctions
Below the pipe drawing and the annotation tools on the Toolbox are junctions, which allow you to model 
a large variety of pipe system components. To add a junction to a model, drag the desired icon from the 
Toolbox and drop it anywhere on the Workspace. 

As you move the mouse pointer over the Toolbox, a tooltip identifies the type of junction under the mouse 
pointer. 
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When you duplicate a junction using the Duplicate, Copy, or Paste features on the Edit menu, the new 
junction retains the input associated with the original junction.

Junction ID Numbers

Junctions are shown on the Workspace with default ID numbers, which you can change in the Junction 
Properties Window. The letter "J" precedes the ID number to signify that it is for a junction. From the junc-
tion’s Properties window, you can change the ID number to any desired number greater than zero and up 
to 99,999, but the number must be unique to the junction and cannot be replicated in any other junctions 
on the Workspace. The junction number remains with the junction in descendant scenarios as long as 
the junction type is not changed.

Identical ID numbers can be assigned to both a pipe and a junction because the "P" or "J" will distinguish 
the two.

Unlike pipes, junctions do not have reference positive flow directions. Junctions for which the flow dir-
ection is important (such as control valves) derive the flow direction from the flow direction of the con-
necting pipes.

Related Topics

Keyboard Shortcuts for Workspace 329

Connecting Objects
During construction of a new model, objects can be placed anywhere on the Workspace. In order to 
assemble a model that is ready for analysis, you must connect the objects properly. 

Remember that connectivity only exists between junctions and pipes. There are no junctions that con-
nect to junctions, and no pipes that connect to pipes. 

AFT xStream will attempt to automatically connect pipes and junctions when they are moved. This elim-
inates unnecessary opening of the pipe and junction Properties windows. If xStream cannot make the 
connection automatically, then the following three steps may be required to establish a connection 
between a junction and a pipe: 

 1. Graphically connect the objects on the Workspace. The pipe endpoint must terminate within the 
boundaries of a junction icon.                                       

 2. After the pipe is graphically connected to two junctions, double-click the pipe to open its Properties 
window, then click OK to accept the connected junctions as determined by AFT xStream. It is 
most efficient to do this when you are entering the pipe's data in its Properties window.                                      

 3. Open the Properties window of the corresponding junction and accept the pipe connectivity 
determination. In most junctions, this pipe connectivity determination will be located in the upper 
right hand corner of the Properties Window. In a few junctions, such as the Assigned Pressure 
Junction and Tank Junction, the pipe connectivity will be shown under the tab containing Loss 
Coefficients. You can do this as you enter the junction's data in its Properties Window.                                      

If the model seems to not be connected properly, you can also use the Extended Model Check feature on 
the View menu. 



Global Edit

- 173 -

When you accept AFT xStream's connectivity interpretation, the connection advances from a graphical 
connection to a model connection. 

The model connectivity you establish on the Workspace is retained only as long as you maintain the 
graphical objects in their current visual relationship to each other. If you move a pipe or a junction and 
break the graphical connection, AFT xStream disconnects the two objects. However, if you move a group 
of connected objects, their model connectivity is maintained.

Moving Objects
Objects on the Workspace can be moved individually or as groups. Clicking a Workspace object selects 
it. Pipe objects change color when selected. Junction objects are outlined in red when selected. These 
colors are configurable in the Workspace section of User Options (Tools menu) .

To move an object, select it, drag it within the Workspace, and drop it in the desired location. When an 
object is dragged beyond the existing Workspace area, the Workspace is expanded accordingly.

A pipe object can be stretched by grabbing the handles (small red squares) at the pipe endpoints and 
moving an endpoint to a new location. To make these handles visible, select the pipe you want to move.

There are numerous ways to select a group of objects for movement or other operations.

To prevent accidental movement on the Workspace, lock the objects. A lock symbol appears next to 
locked pipes or junctions when an attempt is made to move the pipe or junction. The Lock feature is 

accessed from the Arrange Menu or the lock button  on the Toolbar. To lock an object on the Work-
space, select it and then activate the Lock feature either from the Arrange menu or from the lock button 
on the Toolbar. If you would like to lock multiple objects at the same time, ensure that all of the objects 
are selected prior to activating the Lock feature.

Keyboard Modifiers

If you hold down the CTRL key when dragging a junction, the endpoints of any connected pipes are not 
moved with the junction, thus breaking the graphical connection.

Related Topics

Keyboard Shortcuts for Workspace 329
Selecting and Finding Objects 154
Selecting Objects 154
Editing Objects 173
Defining Objects 174

Editing Objects
The pipes and junctions you place on the Workspace can be edited with the editing commands from the 
Edit menu or the Toolbar. Objects can be cut, copied, pasted, duplicated, and deleted. These operations 
can be performed on individual objects or on groups. The Edit menu provides the option to undo each 
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editing operation in the Workspace, but will not undo any changes made in the pipe/junction properties 

windows. Alternately you can use the Undo button  on the Toolbar.

The Copy Graphics feature on the Edit menu will copy the specified Workspace objects to the Windows 
clipboard. This image can then be pasted into other Windows applications.

Related Topics

Keyboard Shortcuts for Workspace 329
Selecting and Finding Objects 154
Selecting Objects 154
Moving Objects 173
Defining Objects 174

Morphing Junctions
Occasionally you may want to change a junction’s type in your model. You can do this by morphing the 
old junction into a new one.

If you hold down CTRL key and select a junction from the Toolbox and drop it onto an existing Work-
space junction, the old junction will morph into the new one. The junction type will change to the new junc-
tion type, and data that can be kept will be copied into the new junction.

Related Topics

Keyboard Shortcuts for Workspace 329

Defining Objects
To specify the required property data for an object, open its Properties window. This can be done in six 
ways: 

 1. Double-click the object on the Workspace                                      
 2. Select the object (by clicking on it once, or using the Selection Box) and press ENTER                                      
 3. Select the object and click the Open Pipe/Jct Window icon on the Toolbar
 4. Double-click the left column of the appropriate table in the Model Data window (where the object 

ID number is shown)                                      
 5. Jump from another Properties window                                      
 6. Double-click the connected pipe or junction number in a Properties window                                      

Parameters that functionally describe the pipe or junction are entered in the Properties window. Some 
parameters in the Properties windows are required and others are optional. The optional parameters 
offer you added control over your model and the ability to obtain specialized information.

The highlight feature shows the required input in pipes and junctions.
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Undefined Objects Window

You can open the Undefined Objects window to view all undefined objects and the undefined properties. 
This is available on the View menu. 

Use Status Feature

Each pipe and junction Properties window has a Status tab. The Status tab shows what required inform-
ation for the pipe or junction is missing.

Satisfying Connectivity Requirements

In addition to entering the required information for each object in the model, you must satisfy these con-
nectivity requirements:

 l You must accept the connectivity information shown in each object's Properties window 
 l Each junction must have the appropriate number of pipes connected to it. For example, an area 

change junction must have exactly two connecting pipes, whereas a tank may have one to twenty-
five connecting pipes. 

 l Pipes must always be connected to two junctions, one at each pipe endpoint.

Should you ever delete any of the required information in the Properties window or move a connected 
object from its connection, the object's status reverts to undefined.

For example, say you place a check valve on the Workspace. A check valve requires inlet and outlet pip-
ing. AFT xStream reflects this by requiring each check valve to be assigned an upstream pipe and a 
downstream pipe. Entering only the Valve model details and setting an elevation is necessary but not suf-
ficient information to define the check valve according to AFT xStream's requirements. Once you have 
entered the check valve data and properly connected it, the check valve is defined.

Show Object Status

The Show Object Status feature helps you identify which objects on the Workspace are defined and 
which are not. This feature can be toggled on and off by selecting it from the View menu or by clicking the 

floodlight button  on the Toolbar. 

Turning Show Object Status on displays the undefined junction and pipe ID numbers in the Undefined 
Color, which is red by default. The color can be changed through the User Options window on the Tools 
menu. Show Object Status helps you rapidly assess where your model requires additional information.

Leaving Show Object Status always toggled on is not recommended for large models, as it will slow the 
Workspace graphics response. When this feature is on, every Workspace graphical operation you per-
form must be accompanied by a check of all pipe and junction connections. This check takes time, and 
could degrade your graphics performance. 
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Highlight Required Input
The highlight feature functions to identify required input data for the Properties Window for each pipe and 
junction. You can toggle the highlight feature on and off in the following ways:

 l From the Properties Window
 l Double-click anywhere in the Properties Window
 l Press the F2 function key

 l From the View Menu
 l Toggle the Highlight in Pipe and Jct Windows to Off

The highlighting feature may be especially useful when you are first learning to use AFT xStream or 
when you are having difficulty obtaining a defined object status.

Inspecting Objects
The Inspection feature displays data associated with a Workspace object in read-only fashion via a pop-
up overlay (see Figure 1). Inspecting is faster than opening the Properties window if you only want to 
review the data and no edits need to be made. Inspecting can be done directly from the Workspace and 
provides a quick summary of the parameters that appear on the Model Data Primary Window.

To inspect an object, position the mouse pointer on the object and hold down the right mouse button.

The Inspection feature is also available inside each pipe/junction's Properties window. This is useful if 
you want to check the input data of objects connected to the one you are viewing. The upstream/-
downstream pipes or junctions are listed, and holding the right mouse button on the listed ID number will 
open the associated inspection overlay.  For example, when working in an Orifice Properties window, you 
may wish to quickly check the upstream and downstream pipe diameters previously defined. Holding 
down the right mouse button on each connected pipe ID number will show you that pipe's primary input 
parameters.

Judicious inspecting can save you time when assembling or debugging a model.

Note: Output data will be shown on the inspection overlay only if a valid Output File is present for the 
current scenario.
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Figure 1: Holding the right mouse button on a Workspace object displays the associated data

Notes
Each object can have notes associated with it. This is useful for listing assumptions, reference doc-
uments, drawings, measurements, etc.

Related Topics

Pipe Properties Window 180
General Junction Information 207

Status
The status tab lists all undefined parameters that are required to define the pipe or junction.

Related Topics

Pipe Properties Window 180
General Junction Information 207

Workspace Pan
The user can use Workspace Pan mode to move around, or pan, the model. If the Workspace has been 
enlarged beyond the default one screen size (Workspace scrollbars will be visible), then the Workspace 
can be panned by activating Workspace Pan mode. There are several ways to activate Workspace Pan 
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Mode:

 l Click the Workspace Pan button   on the toolbar
 l Select the Workspace Pan option in the View menu
 l If your mouse has a center button (a scroll wheel), hold the scroll wheel button down
 l Hold CTRL and use the arrow keys

Once in pan mode, the cursor will change to an open hand that can be used to grab and move a point in 
the Workspace. The Workspace can be panned by holding down the left mouse button (if the Workspace 
Pan mode has been activated using the Workspace Pan button on the toolbar or the Workspace Pan 
option has been selected in the View menu) and moving the mouse in the desired direction, or by holding 
down the mouse scroll wheel (if using the scroll wheel to keep Workspace Pan mode activated) and mov-
ing the mouse in the desired direction. 

To switch off the pan mode, click the mouse scroll wheel or the Workspace Pan button on the toolbar a 
second time. If Workspace Pan mode is maintained using the mouse scroll wheel, it will automatically 
turn off once you release the mouse scroll bar.

Related Topics

Keyboard Shortcuts for Workspace 329

Moving Pipe and Junction Labels
Each pipe and junction on the Workspace also displays a label.  A label refers to any text associated with 
an object - pipe numbers, names, flow rates, and so forth. The label will display a unique combination of 
defined display text items from each visible Workspace Layer.  This label can be dragged to improve 
model aesthetics. The relative location of the label to the object is linked so that if the object is moved, the 
label moves with it.

Returning Label to Default Location

To return the label to its default location, you can:

 l Right-click the label for an individual object and choose Reset Label Location
 l Use Arrange -> Reset Label Locations and respond to the dialog
 l Click Reset Label Locations in the Label Control group of the Layer Settings window to reset all 

label locations

Special Conditions
Some junctions have Special Conditions which alter the normal state of the junction. For example, a 
valve can be closed, a compressor turned off, or a relief valve opened.

The special conditions are set in one of three ways:
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 l By selecting the junction(s) on the Workspace and choosing Special Conditions from the Edit 
menu

 l By selecting the junction(s) on the Workspace and clicking the Special Condition icon  on the 
Toolbar

 l By opening the junction's Properties window and clicking the appropriate condition on the 
Optional tab

The junctions which have special conditions set are shown using a special symbol before the ID number 
(an "X" by default). This symbol can be customized in the User Options.

When the special condition results in a section of the model being closed or "turned off", the pipes which 
will have zero flow are display as dotted lines. This indicates visually that they are cut off from flow; the 
junctions are outlined with a dotted line. The default dotted line can be changed in the User Options.

The user can specify Special Conditions for Control Valves to be either closed or fully open. Similarly, 
compressors/fans can be turned off and either allow flow through or stop the flow.

Special Condition: Ignore

The Relief Valve junction has a unique kind of Special Condition called Ignore. This makes the steady-
state and transient solvers ignore the presence of the junction. Thus not only is the data ignored, the junc-
tion itself is ignored. This is convenient when locating a relief valve by trial and error. Rather than having 
to delete the junction, it can be ignored.

As an example, assume that one is trying to find the best location for a relief valve. If one does this with a 
single relief valve junction, it will be required to run a case, view the results, then relocate the junction by 
changing the pipe lengths and rerunning. If one uses the Special Condition Ignore, one can place mul-
tiple relief valve junctions in the model and then set all of them except one to Ignore so that only one of 
the junctions is used at a time.
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Pipes
This section focuses on specifying and modifying the Pipe object in the Workspace. Topics include an 
overview of the Pipe Properties window, how to input pipe specification data, a description of the meth-
odology used for heat exchange within pipes, and how to insert fittings and losses within the pipes.   
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Pressure Drop in Pipes - Detailed Discussion 205

Pipe Properties Window
Each pipe on the Workspace has engineering information associated with it. Each pipe must have an ID 
number, a length, a diameter, a roughness specification, and two connecting junctions. If the pipe is not 
purely cylindrical, additional geometry information is also required. 

The Pipe Properties Window allows the user to define all data for a pipe on the Workspace. An example 
on a fully defined Pipe Properties Window is shown below in Figure 1. The various Pipe inputs are dis-
cussed in the respective pipe pages listed in the Related Topics section below. 
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Figure 1: Fully Defined Pipe Properties Window

Related Topics

Notes 177
Status 177

Common Pipe Input Parameters
The common input parameters are located above the tabs in the Pipe Properties Window.

Number

Every pipe must have a unique ID number. When new pipes are created, a pipe number is automatically 
allocated.

The pipe number can be changed by the user to any unique value greater than zero and less than 
100,000. Pipe numbers are only identifiers and have no affect on the model behavior.

Name

A name can be assigned to each pipe for reference purposes. The default name is simply “Pipe.” Names 
do not need to be unique. The name can be shown on the Workspace and in the Output window.
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Copy Data From Pipe...

The Copy Data From Pipe drop-down list allows you to copy all or some of an existing pipe’s properties to 
the current pipe. Selecting an existing pipe will prompt the user on what parameters should be changed. 
The Copy Previous button functions similarly, copying parameters from the previously edited pipe.

In a child scenario, Copy Data From Pipe lists "Parent Pipe Data," allowing the user to copy all or some 
parameters from the parent pipe.

Connected Junctions 

All pipe objects have a reference positive direction, as indicated on the Workspace by an arrow in the cen-
ter of the pipe. The upstream and downstream junctions are identified with this direction. The connected 
junctions area displays these junctions. Every pipe must be connected to two junctions in order to be 
completely defined.

Pipe Model

Size

The size section of the Pipe Model tab specifies the pipe geometry.

 l Pipe Material
 l User Specified - If selected, the geometry of the pipe must be directly specified.
 l Library Material - Many common pipe materials are included in the standard Pipe Material 

library. These and any other accessible library materials can be selected. When a library 
material is selected, the parameters defining the geometry cannot be modified.

 l Size - Select from a list of defined nominal sizes for the selected Pipe Material. Only available for 
library materials.

 l Type - Select from a list of defined types (classes/schedules) for the selected Pipe Material. Only 
available for library materials.

 l ID Reduction (Scaling) - Reduction in hydraulic diameter due to scaling can be accounted for by 
entering a percent reduction in this field. Zero represents no reduction.

Length

The Length is defined as the distance between the two connecting junctions. This length has no rela-
tionship to the visual length of the pipe drawn on the Workspace.
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Note: In contrast with other AFT products, xStream does not contain the Zero-Length Connector 
(ZLC) option at this time.

Friction Model

Multiple friction data sets can be compiled for each library pipe material. These different data sets are 
then made available in the Data Set drop down list. For AFT standard materials, the friction data set is 
generally "Standard."

The Friction Model can be modified for any individual pipe, and the default friction model can be set in 
Parameter Options. The Friction Model for a library material can be modified by selecting the User Spe-
cified radio button in Data Set, and must be directly specified for User Specified materials.

 l Absolute roughness (default) - Absolute average roughness height. Values of pipe roughness 
can be found in many pipe handbooks or from manufacturer's data.

 l Relative roughness - Relative roughness is the absolute roughness divided by the pipe dia-
meter.

 l Hydraulically smooth - Hydraulically smooth implies that roughness is negligible. This is not the 
same as frictionless.

 l Explicit Friction Factor - Friction factor for the pipe, you can enter the value explicitly.
 l Frictionless - For troubleshooting purposes, it is occasionally useful to model a pipe as having no 

friction. There are limitations to where such a pipe can be located in your model.

For detailed information on how these Friction Models are defined, see Pressure Drop in Pipes - Detailed 
Discussion.

Fittings & Losses
Fittings & Losses allows the user to define additional losses directly in a pipe. This is useful to account for 
pressure losses without modeling large numbers of elbows or similar fittings. To specify losses, open the 
Pipe Properties window, click the Fittings & Losses tab, then click Specify Fittings & Losses to open the 
Pipe Fittings & Losses window. An Additional K Factor loss can also be user specified.

Pipe Fittings & Losses

The Fittings & Losses library contains many standard loss values. Because many of these values are 
dependent on pipe diameter, a pipe diameter must be specified to open the Pipe Fittings & Losses win-
dow.

Losses are divided into several categories represented by tabs. To add fittings to the pipe, select the 
type, and adjust the quantity column next to the desired fitting.

After accepting the changes by clicking OK, a summary of the pipe's Fittings & Losses will be displayed 
in the Pipe Properties window.
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Note: Area Change fittings do not change the size of the pipe, they only represent the loss factor 
based on the pipe diameter and the area ratio of the loss. When including area changes, notice 
the illustration of how the loss is defined, where Apipe is the area of the pipe and As is the area of 
the loss. These area changes are useful to model fittings between a pipe and another junction 
like a compressor.

Figure 1: Pipe Fittings & Losses window

Fittings & Losses Workspace Symbol

When a pipe has any loss value assigned through the Fittings & Losses tab, a symbol (default of &) is 
added before the pipe number.

Favorite Fittings & Losses

In the Pipe Fittings & Loses window, there is a column labeled Favorite for each of the loss types. Check 
the box for favorite to add it to the list of favorite fittings and losses. On the left side of the window there 
are several options to filter the list. For example, one may only want to see Crane fittings. In which case, 
Crane should be checked, and all others unchecked on the left hand side of the window. If a list of only 
favorite fittings is desired, check the box to "Show Favorites Only".

Related Topics
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Fittings & Losses Library 436
Specifying Losses 212
References 499

Heat Transfer in Pipes Overview
Each pipe responds thermally to the environment outside of the pipe. AFT xStream offers several models 
that allow you to model the heat transfer characteristics of a pipe:

 l Adiabatic at Internal Surface - An adiabatic pipe is one that has perfect insulation and thus no heat 
transfer takes place. The temperature into the pipe is taken from the upstream junction. Insulation 
data can be entered but is not used for thermal purposes. This model assumes the fluid in the pipe 
does not thermally interact with the pipe wall.

 l Convective Heat Transfer - This model allows you to specify heat transfer data for the internal 
fluid, pipe wall, three layers of insulation and external convection.

 l Convective Heat Transfer and Heat Flux - This model allows you to model convective heat trans-
fer while also specifying a constant heat flux.

 l Convective Heat Transfer with Heat Tracing - This represents adding some type of heating layer 
onto the pipe's outer surface. The amount of heating may be entered as a constant heat flux or by 
providing information on the power and number of wire turns. Insulation layers can then be added 
on top of the heat tracing (heat flux source).

Note that similar to flow rate definition, heat flow is positive when flowing into the pipe, and negative when 
flowing out.

Viewing Calculated Thermal Results in Output

A table is displayed in the Output window Pipe area showing the temperature distribution in the pipe and 
insulation for the steady-state system.

Figure 1: Thermal Data table in Output window Pipe area shows the steady-state temperature distribution in 
pipe
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Clicking the button next to Show in the Results Diagram column brings up a Results Diagram for that par-
ticular pipe:

Figure 2: Pipe Heat Transfer Results Diagram

Related Topics

References 499

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581
 

Constant Heat Transfer
There are several thermal models for pipes in AFT xStream which fix the thermal behavior of the pipe to 
some constant value:

 l Adiabatic At Internal Surface - The heat transfer between the pipe and the environment is fixed 
to zero, and no heat is stored in the pipe walls. The entire length of the pipe will have a stagnation 
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enthalpy equal to that of the upstream junction. The actual fluid temperature depends on the sys-
tem.

The above models follow a common format on the Pipe's Heat Transfer tab, as shown below. There is 
only one required value input unless insulation is added. One layer of insulation (external or internal) can 
be added, with conductivity values from a library or User Specified in this window.

Figure 1: Heat Transfer tab of the Pipe Properties window

Related Topics

Heat Transfer in Pipes Overview 185
Convective Heat Transfer 187
Heat Tracing Flux Based On Wire Turns and Length 190
Steady State Heat Transfer In Pipes 194

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Convective Heat Transfer
There are 3 convective based models for pipe heat transfer:

 l Convective Heat Transfer - Represents a pipe thermally affected solely by convection.
 l Convective Heat Transfer and Heat Flux - Behaves the same as the Convective Heat Transfer 

model, but also includes the effect of an external heat flux such as radiation.
 l Convective Heat Transfer with Heat Tracing - Similar to the Convective Heat Transfer and 

Heat Flux model, but instead of applying the flux on the outermost surface of the pipe/insulation, 
the flux can be applied directly to the pipe. As the name suggests, this represents a device such 
as a heated wire. If the flux is not known directly, it can be determined  based on Wire Turns and 
Length.
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Defining the Convective Model

When one of the convective heat transfer models is selected, there are a number of items that must be 
defined:

 l Resistance Geometry - Radial or Linear.
 l Number of Insulation Layers - There can be up to three layers of insulation defined, in any com-

bination of internal or external.
 l External Heat Flux - Only available if Convective Heat Transfer and Heat Flux is selected. A con-

stant flux applied to the outermost layer of resistance.
 l Heat Tracing on Pipe (Flux) - Only available if Convective Heat Transfer with Heat Tracing is 

selected. A constant flux is applied at the outer wall of the pipe.
 l Ambient Conditions - The temperature and velocity of the fluid around the pipe. The fluid can be 

either air or water. These values are used for calculating the convection coefficient if correlation is 
selected as the convection Data Source. This correlation can be used for pipes over which bound-
ary layers develop freely, free of constraints imposed by other surfaces. All of the external fluid 
properties are evaluated at the film temperature using data from the NIST REFPROP fluid library.

 l Resistance Table - The table at the bottom of the window defines all of the resistance layers used 
in the thermal model.

 l Rows
 l Units - This special row defines the units of any value in the column below a cell.
 l Fluid Internal - The fluid itself has a convection coefficient that affects the transfer 

of energy to the pipe wall. By default, the Gnielinski Correlation is used to determine 
this value. Alternatively, the Dittus-Boelter Correlation can be used, or a User Spe-
cified value can be entered.

 l Pipe Wall - The wall of the pipe has a thermal conductivity that affects the heat trans-
fer. The built-in pipe materials have thermal conductivity values defined, and this 
value is automatically selected. If a User Specified pipe is used, the conductivity will 
need to be entered.

 l Insulation - There can be several insulation rows, depending on the selection of 
Number of Insulation Layers. The Insulation can be selected from the Insulation 
Library, in which case the conductivity is read from the library. User Specified insu-
lation requires this value to be defined.

 l External - Convection occurring external to the pipe and any insulation layers. By 
default the Convection Coefficient is calculated with the Churchill-Bernstein Cor-
relation. The Correlation can also be set to Free-Horizontal or Free-Vertical which 
requires only an ambient temperature, and no fluid velocity. The Free Horizontal and 
Free Vertical orientations are in reference to the orientation of the pipes. If the con-
vection coefficient is known, a value can be entered by the user.

 l Columns
 l Apply - This can allow enabling/disabling of including certain layers in the cal-

culation. This is useful for comparing states or scenarios without redefining the 
thermal model.
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 l Conductivity/Convection Data Source - Specifies from where relevant inform-
ation is attained. This can be a Library, Correlation, or User Specified.

 l Conductivity - Applies to the Pipe Wall and Insulation. If Data Source is a Library, 
the particular insulation must be selected. If User Specified, the conductivity must be 
entered. Note that obtaining the thermal conductivity from an insulation or pipe 
material library permits temperature dependent thermal conductivity to be 
employed. With this option, AFT xStream dynamically selects the insulation thermal 
conductivity during model solving based on the local temperatures that exist. Con-
versely, user specified values are always constant.

 l Thickness - Applies to Pipe Wall and Insulation. If a Library is used for the Pipe 
Material, this value is automatically populated. All insulation layers require a thick-
ness.

 l HT Area Ratio - Multiplier for the value of surface area used in the heat transfer cal-
culations (default value of 1). In general, this represents any "extra" heat transfer 
area that may exist. For example, cooling fins on the outside of the pipe could be 
modeled by entering a value larger than 1 on the External resistance row.

 l Convection Coefficient - Applies to Fluid Internal and External. Both values can be 
either Correlation or User Specified.

Figure 1: Convective Heat Transfer Layout

Modeling a Constant Wall Temperature

Assign an ambient temperature and disable the External Resistance by unchecking the box in the Apply 
column. This will force the outside wall of the pipe to be equal to the ambient temperature. Note that this 
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differs from isothermal in that the fluid temperature can still change - only the outside wall of the pipe has 
a fixed temperature.

Related Topics

Heat Transfer in Pipes Overview 185
Constant Heat Transfer 186
Heat Tracing Flux Based On Wire Turns and Length 190
Steady State Heat Transfer In Pipes 194

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Heat Tracing Flux Based On Wire Turns and Length
The Convective Heat Transfer with Heat Tracing model requires additional information to represent the 
thermal effect of a heat tracing.

xStream allows users the ability to model Heat Tracing by either entering the heat flux directly, or by 
providing information on the number of turns and power per unit length of wire, which xStream will use to 
determine the heat flux as described below.

Figure 1: Pipe Properties window with the Conv. Heat Transfer with Heat Tracing model enabled
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Power and Turns - Detailed Discussion

When you select the option to model Heat Tracing based off a heated wire, xStream models that heat flux 
based on the theory described below.

Figure 2: Wire tracing geometry

Length of Wire

First, it may be necessary to determine the length of the wire itself, based on a number of turns.

 l N - total number of turns on the pipe                     
 l n - number of turns per unit length                     
 l LPipe - total length of the pipe                     
 l r - external radius of the pipe                     
 l LWire - length of the wire                     
 l LTurn - length of one wire turn                     

The above figure shows a pipe with heat tracing that has been "split open" and laid into a flat rectangle to 
make these equations more intuitive.

The total turns and turns per length are related by the pipe length:



Pipes

- 192 -

Each turn of the wire creates a right triangle on the "flattened" pipe, so we can find the length of each seg-
ment by the Pythagorean theorem.

The total length of the wire is related to the number of turns and the segment length.

Incorporating this relationship and rearranging:

Using the number of turns per unit length:

or:

Flux of Wire

With the length of the wire found, the flux based on power per length can be found.

 l PTotal - total power usage of the wire, along the entire pipe length                     
 l p - power per unit length                     
 l Q'' - heat flux                     
 l A - area heat flux is applied to                     

The heat flux is defined as the heat delivered per area. Here, we assume that the "total power" used by 
the heat trace is equivalent to the total heat delivered. Therefore:
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The total power is equal to the power per length times the length, and area is related to pipe geometry:

Substituting in for LWire:

Simplifying:

Related Topics

Heat Transfer in Pipes Overview 185
Constant Heat Transfer 186
Convective Heat Transfer 187
Steady State Heat Transfer In Pipes 194

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581
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Steady State Heat Transfer In Pipes

Figure 1: Diagram of a pipe with Heat Tracing and Insulation

There are many possible combinations of heat transfer that can be defined in AFT xStream. In any of 
these models there are various heat flows that can be considered.

Figure 1 shows the heat rates for one of the more complex cases – convective heating with a heat trace 
on the outer face of the pipe wall.

This topic will discuss heat transfer in terms of steady state heat transfer calculations. Balancing these 
heat rates and temperatures via iterative methods allows AFT xStream to come to a unique solution. The 
Transient Heat Transfer topic expands on how the convective heat transfer calculations are carried out 
during the transient.

Heat Rates

As a hydraulic solver, the primary heat rate of interest is , the heat added to the fluid itself. Adding 
heat to the fluid has the effect of raising its temperature.

We can derive an expression for  with the first law of thermodynamics. For convenience, we use 
specific quantities (per unit mass)

The energy e is composed of internal energy u and kinetic energy V2/2. Note that the gravity term gz is 
neglected from this equation to simplify the derivation.
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The work done by the fluid is comprised of pressure work pv and shaft work wshaft

Combining and rearranging

Using the definition of enthalpy

In the steady state analysis, we consider that the velocity through the control volume remains constant. 
In reality, changing temperature will cause the density of the fluid to change, and thus the velocity. For 
this reason, pipes in AFT xStream are thermally sectioned. This means that certain properties are con-
sidered constant throughout the section as an approximation – having several sections in a pipe helps 
increase the accuracy of this approximation.

There is also no shaft work being done on the fluid.

We further assume that this can be treated thermodynamically as a constant pressure process. That is, 
cp is constant in the thermal section, like density. With this assumption we can use the relationship

To find that
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Rather than using specific quantities, it is useful to relate heat rate and mass flow. Multiply both sides by 
ṁ

The other heat rates in the system can be related to  and other user defined values like  or  

 by examining various control volumes and surfaces:

We now have a system of equations that allow us to determine all the heat rates in the system given a 
mass flow (determined from a mass balance), a specific heat (defined versus temperature) and a change 
in temperature. However, we do not know what this change in temperature is. To find it, we need to relate 
the surface temperatures to the heat rates.

Surface Temperatures and Resistance

Thermal resistances are useful because they directly relate the heat rate between two points with the 
temperature between those points.

The value of resistance depends on the mechanism of heat transfer
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For conduction, the area and thus resistance changes with increasing r, so an integration must be done

These resistances can all be calculated with user-defined data. AFT xStream helps simplify this by offer-
ing several correlations that can be used to determine the heat transfer coefficients in the above equa-
tions from more readily available parameters.

With resistances and , all the surface temperatures can be determined. By bounding the system 
with a given Tambient we can work outside in to find the required Tfluid to obtain those heat rates.
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If the result for Tfluid matches the values used for ΔTfluid used for determining , the correct solution 
has been found. If they are different, ΔTfluid needs to be adjusted and the process repeated until reaching 
a stable solution.

Overall Heat Transfer

Wherever there are sequential thermal losses, it is convenient to combine these losses. This is straight-
forward:

Additionally, an overall heat transfer coefficient U can be defined which behaves similarly to h or k

Using the heat rate and resistance relationship, as well as the fact the heat transfer is into the fluid

Transforming the equation into a differential form on radius and length

Rearranging and integrating
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We arrive at an expression relating the temperature change along the pipe and temperature change 
through the pipe:

Correlations

Thermal resistances depend on the conduction and convection coefficients k and h which can be directly 
specified or calculated via a correlation.

The convection coefficient for internal fluid convection can be calculated with the Gnielinski Correlation 
or the Dittus-Boelter Correlation which can be seen in Incropera.. These correlations determine the Nus-
selt number of the fluid – a ratio of convective to conductive heat transfer. Conductive properties are 
required input – with a Nusselt number and conductivity defined, the convection coefficient can be cal-
culated.

These correlations also make use of the Prandtl number, a ratio of viscous diffusion to thermal diffusion.

Gnielinski

Dittus-Boelter
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External convection behavior differs from the above. AFT xStream provides the Churchill-Bernstein cor-
relation for determining a convection coefficient from ambient temperature and fluid velocity. This cor-
relation can be used for pipes over which boundary layers develop freely, free of constraints imposed by 
other surfaces. All of the external fluid properties are evaluated at the film temperature.

Related Topics

References 499
Heat Transfer in Pipes Overview 185
Constant Heat Transfer 186
Convective Heat Transfer 187
Heat Tracing Flux Based On Wire Turns and Length 190

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Transient Heat Transfer in Pipes
AFT xStream uses a thermal resistance network to account for convective and conductive heat transfer 
and calculate the steady state heat rates. xStream then uses a discrete solution method to account for 
radial and axial heat transfer through the pipes and fluid during the transient. This topic discusses the 
solution methods used by xStream to determine the heat rate and temperatures during the transient. See 
the Steady State Heat Transfer in Pipes page for information on how the heat rate is derived, and how 
the convection coefficients are calculated.

Transient Heat Rate

Consider a cylindrical control volume as shown below in Figure 1. Note that dz is perpendicular to the 
page and thus is not shown.
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Figure 1: Cylindrical control volume for heat rate calculation through the pipe wall/insulation, with dz extend-
ing out of the page

The heat energy in the control volume due to a change in temperature can be written as:

(1)

The heat energy can also change in response to heat flux and generation:

(2)

By simplifying the heat flux balance and equating it to the heat energy due to temperature change the fol-
lowing is found:

(3)

From Fourier's law for conduction the heat rate is defined as 

(4)

By substituting Fourier's law into equation 3 above and dividing the whole equation through by dr dФ dz, 
the following heat diffusion equation is derived for the radial dimension.

(5)
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Transient Pipe Temperatures

xStream will account for heat transfer in the radial and axial directions. However radial heat transfer is 
dominant, so the below discussion will focus on calculating radial heat transfer.

To calculate the heat rate and temperature profile across the pipe walls and insulation the heat diffusion 
equation (Equation 5) must be solved. There is not a simple analytical solution for the heat diffusion equa-
tion derived above, so a discrete solution method will be used. 

The pipes and insulation layers will each be sectioned radially similar to the example in Figure 2 below, 
with points 1, 2, and 3 representing calculation nodes at which the temperature and heat rate will be expli-
citly calculated. Each node represents the temperature, density, and thermal conductivity of the control 
volume they are within.

Figure 2: Partial pipe cross-sectional area representing the radially sectioning for heat transfer calculations

There are a few assumptions that are made to calculate the heat rate and temperature.

First, for the purpose of calculating a heat rate xStream assumes a linear temperature profile between 
each set of consecutive temperature nodes.  In reality the temperature would vary logarithmically through 
a single material. However, using a logarithmic temperature function would be computationally difficult, 
and provide a negligible increase in accuracy.

Second, the temperature is assumed to be constant at the boundary of different materials, such as where 
the insulation touches the pipe wall. In reality there would be some contact resistance creating a dif-
ference in temperatures between the pipe and insulation, but this is typically a negligible effect.

Lastly, for calculation nodes that exist at a boundary between pipe materials, the thermal conductivity 
and density are assumed to be an average (by volume) of the staggered control volume (Figure 3). This 
assumption is made to simplify the solution by creating a continuous temperature profile. From testing 
this assumption provides reasonable results.

Note: The discrete solution method used for calculating radial conduction can potentially become 
unstable and give physically unrealistic results if the number of radial calculation nodes is insuf-
ficient. The default number of nodes should be sufficient for most cases. The number of thermal 
nodes can be changed on the Sectioning Panel.
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Figure 3: Partial pipe cross-sectional area with the staggered control volume outlined in red

Insulation for Pipes
Insulation data can be entered on the Heat Transfer tab of a pipe. The insulation data is only included in 
the heat transfer calculations if a convective heat transfer model is entered. It may be entered for other 
heat transfer models, but will only be used for cost calculations. Internal insulation will reduce the flow 
area which AFT xStream will account for in such cases. Insulation data is from the Nayyar Piping Hand-
book 2000 pages B.325-B.344.

See Heat Transfer in Pipes for more details.

Related Blogs

Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Optional Input for Pipes

Initial Flow Guess

The Initial Flow Guess for a pipe can be specified. An appropriate initial guess can decrease the number 
of iterations required to arrive at a converged solution. This initial guess will only affect the steady-state 
solution process.

The Solver generates initial guesses on its own, which is usually sufficient to get the Solver going in the 
right direction so a converged solution results. If this is not the case, user defined guesses can help 
obtain a solution.

Design Factors

A design factor can be used to add safety margins into the  analysis. For pipes, two design factors exist:

https://www.aft.com/support/product-tips/let-the-heat-flow-modeling-heat-transfer-in-pipes-in-aft-fathom-and-aft-arrow
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 l Pipe Friction: friction factor is multiplied by the design factor assigned to the pipe.
 l Pipe Fittings & Losses: total loss factor (K factor or Equivalent Lengths) is multiplied by the design 

factor assigned to the pipe.

Parallel Pipes

A single pipe object can be specified as a number of parallel pipes. When multiple pipes are defined, the 
parameters in the Pipe Properties window represent only one of the parallel pipes.

Use Temperature Override for Zero Flow

Enabling the Temperature Override option will force the fluid temperature in the pipe to the specified 
value for the initial steady-state solution, but only if the flow is initially zero.

If the temperature override option is not used, then the temperature in the pipe will be set to the ambient 
temperature if the heat transfer model is set as Convective Heat Transfer, or to the temperature of the 
connected boundary junction if any other heat transfer model is used. See Heat Transfer in Pipes for 
more information.

Related Topics

Optional Input for Junctions 212
Make Initial Flow Rate Guesses for Pipes 567

Add/Remove Pipe Segment
Visual segments can be added to pipes.

To add or remove segments, use the Arrange -> Add/Remove Segments submenu. These options are 

also available by clicking the Add/Remove Segments button  on the Workspace Toolbar.

Note: These segments are useful for creating a clear layout of the system, but have no impact on the 
solution - a visual "bend" is not the same as adding a Branch junction.

Related Topics

Keyboard Shortcuts for Workspace 329

Reverse Direction
Every pipe has a reference positive flow direction as indicated by its arrow. This direction can be easily 
reversed by selecting Reverse Direction from the Arrange menu or clicking the Reverse Direction button

 on the Workspace Toolbar.
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Pressure Drop in Pipes - Detailed Discussion
Depending on the pipe friction model selected, the calculation of pressure drop in a pipe differs.

Darcy-Weisbach Loss Model

Note: The pressure drop for compressible flow depends on several equations, as discussed in Review 
of Compressible Flow Theory. The effect of pipe friction is taken into account as part of the full 
compressible method. The Darcy-Weisbach pressure loss equation for incompressible flow is 
shown below for simplicity.

AFT xStream utilizes the Darcy-Weisbach loss model to relate the Darcy Friction Factor, the pipe geo-
metry, fluid density, and fluid velocity to pressure drop in the pipe. The Darcy Friction Factor differs from 
the Fanning Friction Factor by a factor of 4.

This model requires the calculation of a friction factor, as described below.

 l Roughness-Based Methods - This method calculates the friction factor based on the roughness 
of the pipe wall. Different equations are used based on flow regime - laminar flow uses the stand-
ard laminar relationship, while turbulent flow uses the implicit Colebrook-White equation. In the 
transition range between laminar and turbulent flow, a linearly interpolated value is used. The 
default transition Reynold's Numbers can be modified in the Environmental Properties panel of 
Analysis Setup.

 l Absolute Roughness (default) - The absolute average roughness height εis specified dir-
ectly.

 l Relative Roughness - The roughness is specified as a ratio ε/D.
 l Hydraulically Smooth - The ratio ε/D is set equal to zero.

 l Explicit Friction Factor - The friction factor to be used in the Darcy-Weisbach equation is spe-
cified directly



Pipes

- 206 -

Frictionless

The pipe will not have any pressure drop across it. This is inherently unrealistic behavior, but can be use-
ful for troubleshooting purposes.

Design Factors

In each pipe you can specify a Design Factor for the pipe friction. This is a multiplier that is applied to the 
friction factor calculated with the preceding methods.

Related Topics

Features for Modeling Irrecoverable Losses 68
Conventions for Specifying Basis Area 213
Nomenclature 448
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Junctions
This section focuses on the Junctions in the workspace as well as the theories that govern the junctions. 
Topics included discuss the types of junctions that xStream provides, the required inputs for each junc-
tion, and theory topics that indicate how the inputs to the junction are used.

Contents

General Junction Information 207

Junction Loss Models 216

General Junction Information
The different types of junctions on the Toolbox offer a great degree of freedom in assembling a pipe net-
work model. While there is some redundancy in capabilities between the junctions, each of the types of 
junctions offers specialized features to allow you to prepare a good conceptual model of the physical sys-
tem of interest. Table 1 compares the features of the junction types.

There is a junction properties window for each junction type. Each junction Properties window falls into 
one of two basic window formats, depending on the number of connecting pipes allowed for that junction 
type.

Note: AFT xStream does not prevent negative flow through junctions. Should this occur, AFT xStream 
will use the same loss factor or pressure drop data referenced to the defined upstream pipe, just 
as in forward flow. Because it is possible that the loss factor or pressure drop data would not be 
the same for both flow directions, the flow solution could be misleading. For this reason it is 
important that you either properly define the pipe flow directions for junctions or pay close atten-
tion to the flow directions that result. AFT xStream will not always give a warning for this, though 
it will for certain junctions.
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Table 1: Junction Property Windows and Features

Junction Type Connecting 
Pipes

Special Condi-
tions

CdA Custom Library Window 
Format

Area Change 2  Yes Yes 1

Assigned Flow 1 Yes  Yes 1

Assigned Pres-
sure*

1/1-25  Yes Yes 1

Bend/Elbow 2  Yes Yes 1

Branch 2-25   Yes 2

Check Valve 2 Yes Yes Yes 1

Compressor/Fan 2 Yes  Yes 1

Control Valve 2 Yes  Yes 1

Dead End 1    1

General Com-
ponent

2 Yes Yes Yes 1

Heat Exchanger 2 Yes  Yes 1

Orifice 1-2  Yes Yes 1

Relief Valve 1-2 Yes Yes Yes 1

Screen 2  Yes Yes 1

Tank 1-25   Yes 2

Tee/Wye** 3    2**

Valve 1-2 Yes Yes Yes 1

Venturi 2  Yes Yes 1

*Assigned Pressure Junction connects to only one pipe for static pressure, and up to 25 for stagnation
**Tee/Wye junction has a unique format closer to Format #2

Related Topics

Notes 177
Status 177
Common Junction Input Parameters 211
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Two Window Formats

Format #1: Junctions With One or Two Connecting Pipes

The first basic window format is for junction types that allow only one or two connecting pipes (see Figure 
1). While junctions do not have an explicitly defined flow direction like pipes do, typically those with two 
pipes or less adopt a direction from the connecting pipes. For these junction types, upstream and down-
stream pipes are recognized by AFT xStream based on the reference positive flow direction of the con-
necting pipes. The upstream and downstream pipes are displayed separately near the top of the window.

In this first basic window type, it is generally important to have the pipes' reference positive flow dir-
ections specified in the physically correct directions. A good example of this is a Compressor junction. A 
compressor will add pressure to the system, but it does so only in the direction of positive flow through 
the connecting pipes. The compressor junction interprets where to add the pressure based on the dir-
ections of the connecting pipes.

To inspect in this window format, position the mouse pointer over the connected pipe ID and hold down 
the right mouse button.

Figure 1: Properties window format #1 (fixed connecting pipe display). 
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Format #2: Junctions With More Than Two Connecting Pipes

The second basic window format for junction Properties windows is for junctions that allow more than two 
connecting pipes (see Figure 2). These junctions typically allow up to 25 connecting pipes; the exception 
is the Tee/Wye junction, which allows only three.

An example of this second window format is the Branch Properties window, shown in Figure 2, which has 
three connecting pipes.  

Figure 2: Properties window format #2 
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Common Junction Input Parameters

Number 

Every junction must have a unique ID number. When new junctions are created, a junction number is 
automatically allocated.

The junction number can be changed by the user to any unique integer value greater than zero and less 
than 100,000. Junction numbers are only identifiers and have no effect on the model behavior.

Name 

A name can be assigned to each pipe for reference purposes. Names do not need to be unique. The 
name can be shown on the Workspace and in the Output window.

Library List 

A list of all available custom components. It displays components from any connected library.

Selecting a component from this list automatically retrieves the junction settings and populates the prop-
erties window. Changing the input manually will deselect the component in the list.

Copy Data From Jct 

The Copy Data From Junction dropdown list allows you to copy all or some of an existing junctions’s prop-
erties to the current junction. Selecting an existing junction will prompt the user on what parameters 
should be changed.

In child scenarios, Copy Data From Junction lists "Parent Junction Data," allowing the user to copy all or 
some parameters from the parent junction.

Pipe Connectivity 

The connected pipes are displayed. This is helpful to determine potential connection issues and easily 
identify which pipes are upstream and downstream of the junction.

Elevation 

Every junction must have an elevation reference. This value is the centerline elevation of the connected 
pipe(s).
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Junction elevations are used to account for pressure changes due to gravity, allowing calculation of abso-
lute pressures in pipes.

A default elevation can be specified in Parameter Options, automatically setting new junctions to the spe-
cified elevation.

Jumping to Another Junction 

Quickly move to the next junction. See Jump Feature.

Related Topics

Notes 177
Status 177

Optional Input for Junctions

Special Conditions

The Special Condition can be changed for some junctions. For example, a valve can be set to closed, pre-
venting all flow. A symbol (default of "X") will be placed before the junction label indicating that a special 
condition is applied.

Workspace Icon

The junction icon can be changed to better represent a specific junction type. This is accomplished by 
clicking the Change Icon button. Custom images can be added by clicking the Add Image button. The 
size of the junction can be changed via Workspace Layers.

Related Topics

Optional Input for Pipes 203

Specifying Losses
Local losses can be specified in two ways. The most flexible way of including a loss factor in an AFT 
xStream model is to associate it with a junction specifically defined for that type of loss. This allows you to 
define a loss as a function of a flow parameter such as Reynolds number or volumetric flow rate, or as a 
function of the area change ratio between the upstream and downstream pipes. This method results in 
the greatest clarity.

Secondly, you can include loss factors with pipes. When you specify Fittings & Losses in the Pipe Prop-
erties window, the loss is assumed to be distributed evenly along the pipe length, much like friction 
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losses. For this reason a pipe-associated loss factor is referred to as a distributed loss. The losses at 
junctions, on the other hand, are point losses.

It should be noted that for compressible flow, the location of a fitting/loss along a pipe will change the 
pressure drop due to that fitting/loss. This is because the velocity along a pipe changes for compressible 
flow. For this reason, the recommended method for representing losses is to define them in a junction.

Related Topics

Fittings & Losses Library 436
Fittings & Losses 183
Discharge Coefficient Loss Model 216
K Factor Loss Model 217
Cv/Kv and XT Loss Model 220
Resistance Curve Loss Model 223

Conventions for Specifying Basis Area
Loss factors are area dependent. When specifying a loss factor at a junction, the base area is of critical 
importance. By default, AFT xStream adheres to the following convention: whenever it makes sense 
physically, the basis area is always the upstream pipe flow area. However, this can be modified by the 
user. In most junction Properties windows (on the Loss Model tab), the basis area can be specified as the 
upstream pipe, downstream pipe, user specified area, or user specified diameter.

However, some junction types, especially those that allow three or more connecting pipes, specify loss 
factors based on each connecting pipe flow area, whether upstream or downstream. An example of this 
is a Wye in which each of the connecting pipes has a different diameter. The idea of specifying a loss 
factor based on upstream flow area loses meaning because there may be more than one upstream pipe. 
In these cases the loss factor is referenced to the base area of the actual downstream pipe(s) where it 
connects to the junction. The types of junctions that do not always follow the upstream pipe area con-
vention are the Tee/Wye, Branch, Tank, Assigned Pressure, and Assigned Flow. Other exceptions are 
Valves and Relief Valves specified as exit valves, and Orifices specified as an exit.

Related Topics

Features for Modeling Irrecoverable Losses 68
Pressure Drop in Pipes - Detailed Discussion 205

Reference Density
A relationship can be drawn for many components between flow energy and flow rate. This can be a 
decrease (e.g., a loss across a valve) or increase in energy (e.g. energy added by a compressor). The 
specific parameter used to represent flow energy can vary depending on application. It can be given in 
terms of pressure change or head change, and there is a critical difference between the two.

Consider a centifugal turbomachine (a pump or radial compressor): Kinetic energy is imparted to the fluid 
by accelerating it along the radius of the impeller. If the rate of rotation is held constant, a denser fluid will 
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have more energy imparted to it than a lighter weight fluid. This would give rise to higher pressures. In 
other words, the pressure change depends on the density of the fluid.

Sometimes curves are provided in terms of head. This is convenient because head is a unit of specific 
energy - or energy per weight. Therefore, it does not vary with fluid density like pressure does. The head 
added to a fluid by a pump or compressor at a fixed speed, for example, will be the same for fluids of dif-
ferent densities. 

However, head relationships are not always available or meaningful. If a pressure vs flow relationship is 
used, a reference density must be specified. This is the fluid density used during testing and creation of 
the curve.

Figure 1: Visual comparison of Pressure Loss Curves for differing densities. Head curves would be identical 
for this component

Note: Incompressible liquids are used in the example in Figure 1, but the principles apply similarly to 
compressible flow.

Affected Parameters

There are several parameters that are affected by the density of the fluid:

 l Pressure - As discussed above
 l Mass Flow - The mass term contains information about the density of the fluid
 l Power - More power is demanded by a compressor to meet the head curve for a denser fluid. While 

head is independent of density and therefore often reported by manufacturers, power is not inde-
pendent of density. Therefore, a proper specification sheet that includes power must also include the 
reference fluid density.
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Accounting for Reference Density

Compressors and any Resistance Curve allow for the specification of a reference density if one of the 
above parameters is selected. The selection appears below the curve fit area as shown in Figure 2.

Figure 2: Reference Density Selection

There are two options:

 l No Correction (default) - This selection assumes that the component was tested with the fluid 
defined in the Fluid Panel and is operating at the reference conditions.

 l User Specified - This directly specifies the reference density. If the  fluid or operating conditions dif-
fer from the testing conditions, the entered curve will be corrected.

Related Topics

Curve Fitting 75

Equal Percentage Valves
Equal Percentage valves have a valve plug shaped so that each increment in valve percent open (lift) 
increases the flowrate by a certain percentage of the previous flow.

The relationship between valve lift and orifice size is not linear but logarithmic.

It is expressed mathematically as follows:

where:

 l τ = valve rangeability (ratio of the maximum to minimum controllable flowrate)
 l H = valve percent open or lift (0 = closed; 1= fully open)
 l Cv,max = full open valve loss value
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Related Topics

Control Valve 268
Valve 284

Junction Loss Models
There are a number of loss models available in xStream to account for frictional losses at the junctions in 
the model. See the below topics for more information on how losses are calculated for each of the avail-
able models.

Discharge Coefficient Loss Model
Orifice subsonic losses for the Orifice, Relief Valve and Venturi junctions can be defined with a discharge 
coefficient, Cd.

Subsonic Loss  

When solving the system, AFT xStream creates a subsonic CdA for the orifice using the Cd specified for 
the subsonic loss model, and the specified orifice area. xStream then solves the pressure drop by iter-
ating the following equation for pressure drop for a given mass flow rate. The equation below for mass 
flow rate can be derived from isentropic relationships, replacing the static pressure at the restriction with 
the downstream stagnation pressure, Po,out.             

The assumption that the static pressure at the restriction can be replaced with the downstream stag-
nation pressure, Po,out, is necessary to find a solution, as the velocity must be known to find the static 
pressure, and the mass flow must be found before the velocity can be a known quantity. It is important to 
note that this assumption neglects static pressure recovery, which could be a significant factor.

Sonic Loss    

The above equation for the mass flowrate can be simplified when the orifice is sonically choked. When 
the Mach number at the restriction is 1, the equation can be simplified as shown below. The value of CdA 
used here will be the CdA for sonic choking, which is entered as a separate value from the discharge coef-
ficient,  Cd, as is discussed in the  Subsonic vs. Sonic Pressure Losses topic.
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Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in 
xStream. The discharge coefficient can vary at different pressure ratios due to the vena con-
tracta moving closer to or farther from the orifice restriction.  For the highest accuracy the CdA 
used for subsonic and sonic losses should be tested and entered separately. See the "Modeling 
Choked Flow Through an Orifice" white paper on AFT's website for more information.

Transient Theory    

The above equations for the mass flow rate through an orifice are applied in the transient simulation sim-
ilar to the approach used for other loss models. Inlet conditions are guessed at, a mass and energy bal-
ance is applied to find the outlet conditions, and then those conditions are used to determine the mass 
flow through the orifice for that guess. Iteration proceeds until the guesses for inlet conditions are con-
sistent with the solved mass flow equation. 

Related Topics

Orifice 274
Relief Valve 277
Subsonic vs. Sonic Pressure Losses 493

K Factor Loss Model
AFT xStream models component losses according to the following equation:

(1)

where K is commonly referred to as the loss factor. Note that for calculation purposes this pressure loss 
is a stagnation pressure loss.

Table 1 lists the sources for the k factor loss models used in AFT xStream. The losses implemented dir-
ectly in the code were chosen on the basis of ease of use. Many loss factor types are functions of the 
flow, and thus too general to be easily incorporated.             

https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
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Table 1: Loss model references                 

Crane (1988) offers good general purpose correlations for modeling irrecoverable losses in pipe sys-
tems. A well prepared pipe flow analyst would be advised to have copies of either or both of these ref-
erences.             

Another lesser known source of loss factor information is Idelchik's Handbook of Hydraulic Resistance 
(Idelchik 2007). This reference is indispensable for the engineer who must make detailed assessments 
of pipe systems in which so-called minor losses play a significant roll. The reference is voluminous in 
scope and full of tables, charts and equations for calculating loss factors for almost any pipe arrange-
ment.             

Miller's Internal Flow Systems (1990) is another reference offering good general purpose hydraulic data.             

K Factor Losses in Compressible Flow    

Most handbook K factor data is based on incompressible flow tests or theory. Applying standard K 
factors to compressible flow components carries some uncertainty. There are not any universally accep-
ted methods available to determine K factors for truly compressible flow except in very specific situations.
    

xStream offers common handbook values for K factors, and you should use caution in how you apply the 
data. Also recognize that when you use the “Fittings & Losses" in pipes, computationally these K factors 
are spread out along the whole pipe as distributed losses. In compressible flow, the location of a fitting 
along a pipe will affect the actual pressure loss since velocity is not constant along a pipe. The Fittings & 
Losses do not account for this.             

Transient Theory

When a junction is defined using a K factor, the junction inlet will be treated as a static pressure bound-
ary. A guess for the inlet static pressure is made, which can be used to solve for the inflow conditions 
using the compatibility equations as shown for the Assigned Pressure junction at the downstream end of 
a pipe. With the known inlet conditions, the inlet stagnation pressure and stagnation enthalpy can be cal-
culated and used to solve for outlet stagnation pressure using the K factor loss equation above.

With the outlet stagnation pressure and enthalpy the outlet conditions can be solved using the method for 
an assigned pressure boundary.

With both the inlet and outlet conditions known the inlet and outlet mass flow rates can be calculated and 
compared. If the mass flow rate difference is too large, then iterations on the inlet static pressure will be 
completed until the mass flow rate tolerance is met.
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Exit Junction Transient Theory

If a K factor loss is defined for a junction that is specified as an exit type junction, such as a relief valve, 
then a different solution method must be applied as there is no downstream pipe.

The user specified exit conditions are assumed to be stagnation properties. The K factor loss model can 
be rearranged and the compatibility equations substituted as follows.

The combined equations can then be rearranged to solve for velocity and density at the junction inlet.

If flow reverses at the exit junction then the solution will be similar to the solution with two pipes con-
nected, except that the effective pipe area at the exit side of the junction will be assumed to be equivalent 
to the area of the pipe connected to the entrance of the junction.

Sonic Choking Transient Theory

Either restriction choking or expansion choking can occur at junctions modeled with K factor loss, 
depending on the geometry of the junction.

When the flow is choked iterations on the inlet pressure will be performed similar to the non-choked tran-
sient solution. However, the sonic area will be used as the dependent variable for the iterations. Once the 
inlet conditions are determined, the mass flow rate and stagnation enthalpy can be used to solve for the 
outlet conditions.

Related Topics

Area Change Loss Model 235
General Component 272
Heat Exchanger 273
Control Valve 268
Relief Valve 277
Valve 284
Orifice Loss Model 275
Transient Sonic Choking 481
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Sonic Choking Detailed Description 488
References 499

Cv/Kv and XT Loss Model
AFT xStream allows the user to enter valve loss coefficient data in terms of Kv or Cv. Conversions are 
handled seamlessly in the background. Kv is the metric equivalent to Cv. 

The valve Cv loss model type is unique in that this loss model can be used as part of both the subsonic 
and sonic loss calculations across the valve.

Subsonic Loss

The relationship between valve Cv, XT, and flow is provided by ANSI/ISA-75.01.01-2012 standard as fol-
lows:

Where C is the flow coefficient (Cv or Kv) and N is a numerical constant found in Table 1 of the ANSI 
standard referenced above. The units for the flow, pressure and density will be based off of the numerical 
constant chosen.

FP is a correction factor for piping geometry. This correction will be treated as 1 unless the Valve ID has 
been entered by the user.

Xsizing is the ratio of the pressure drop across the valve to the inlet pressure of the valve for subsonic 
flow:

Y is the expansion factor, which accounts for the change in density as the gas passes through the vena 
contracta, and is calculated as follows:

Where XT is the pressure ratio, X, when the valve has just begun to choke.

 

XT can be a complicated topic. If more information on it is needed, a helpful blog post on the topic can be 
found here.

https://www.aft.com/support/product-tips/entry/2019/10/29/making-sense-of-xt-valve-loss-in-compressible-flow
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Sonic Loss

If choked flow occurs across the valve, then the mass flow equation above is still used. However, the 
Xsizing is now equivalent to XT, which is the pressure ratio when the valve first begins to choke.

Estimated Cv/Kv in Output

In the Output window the estimated Cv /Kv can be displayed if the Cv /Kv was not defined by the user. 
The estimated Cv /Kv value is calculated using the mass flow rate equation shown above, with Xsizing  
estimated as follows

Transient Theory

A valve junction has a pressure loss across the valve. When the valve closes this loss becomes infinite. 
With two connecting pipes, the upstream and downstream pipe parameters must be determined through 
iteration. The valve will be treated as a mass flow boundary. A guess for the velocity is made, which can 
be used to solve for the inflow conditions using the compatibility equations as shown for the Assigned 
Flow junction at the pipe inlet. This will provide values for the conditions at the valve outlet, including the 
mass flow at the valve.

The outlet static pressure can now be used to calculate the pressure ratio X and the expansion coef-
ficient Y as are shown above. The calculated X and Y can then be used in the to determine the ANSI/ISA 
predicted mass flow as shown above.

The mass flow calculated from the assigned flow boundary solution and the mass flow calculated from 
the ANSI/ISA equation can now be compared. The difference between these two values will be driven to 
zero using iterations on velocity.

Exit Valves Transient Theory             

If the valve is an exit valve, then the downstream pressure is known. The user specified exit properties 
are assumed to be static. The compatibility equations can be substituted into the ANSI/ISA mass flow 
equation shown above, which is then rearranged to solve for the inlet pressure at the valve.
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If the flow reverses then a similar substitution can be done with the appropriate compatibility equation

Iterations are then performed by varying Pout (the pressure at the inlet of the connected pipe).

Sonic Choking Transient Theory

Restriction choking can occur at any time at the valve junction for either a regular or exit type valve. If the 
valve becomes choked, the valve Cv/Kv equation for choked flow must be used.

The mass flow term can be eliminated to find the equation in terms of pressure, density, and velocity only

The wave and particle path compatibility equations can then be substituted to eliminate density and velo-
city. 

Though not shown here, this equation can be rearranged into a polynomial and solved for static pres-
sure. Once the static pressure is known the choked valve can be solved using the typical transient sonic 
choking calculation.    

At the end of the calculation X will be recalculated. If X is greater than Xchoked then the solution is valid. 
Otherwise, the valve is not choked, and the non-choked valve calculation are repeated using the choked 
valve solution to bracket the velocity solution. 

Related Topics
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Nomenclature 448
Valve 284
Control Valve 268
Check Valve 245
Method of Characteristics 473
Sonic Choking 487
Sonic Choking Detailed Description 488
References 499

Related Blogs

Making Sense of xT – Valve Loss in Compressible Flow

Resistance Curve Loss Model
The resistance curve loss model is available in many different junctions. It is useful when measured flow 
vs pressure loss data is available for a component.

Clicking Enter Curve Data will open a new window where the input can be entered into a table. Several 
options for the Flow Parameter are available using the dropdown in the column header, and the appro-
priate units can be selected.

Fill As Quadratic (Using a Single Known Data Point)

It is not uncommon to obtain only a single data point from an equipment manufacturer. For example, the 
data might be 3 psid pressure drop at 1 lbm/sec. In this case, the known data point can be entered into 
the first row of the data table. Then, selecting Fill As Quadratic will automatically insert another two data 
points to be used with a quadratic curve fit. The first data point will be zero pressure loss at zero flow 
which is physically realistic for a static component. Note that elevation differences within a junction are 
accounted for externally by the Solver. The last data point will be a quadratic extrapolation using the zero 
point and the originally provided data point. Clicking Generate Curve Fit Now will create the curve fit con-
stants and complete the resistance curve definition.

This method is often a reasonable approach to define a static component because the pressure drop 
characteristics of most equipment follows the square law. As the flow rate increases, the pressure drop 
increases with the square of the flow rate. Defining the component with a curve fit provides a robust solu-
tion where the junction can still provide a reasonable pressure loss even if the flow rate in the model is 
changed. This also aids in numerical convergence when running a transient simulation.

In our example, an increase in the flow rate to 2 lbm/sec would result in a pressure drop of 12 psid. 
Although this may not be exactly correct depending on the component, it is much better than assuming a 
flat 3 psid drop for all flow rates, which we know for certain is not correct.

https://www.aft.com/support/product-tips/making-sense-of-xt-valve-loss-in-compressible-flow
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Table 1: Example data points for pressure drop modeling using manufacturer data

Data Point Flow Rate
(lbm/sec)

Pressure 
Drop
(psid)

Comment

1 0 0
Always valid 
for passive 
equipment

2 1 3 Given by man-
ufacturer

3 2 12
Extrapolated 

assuming 
square law

Curve Fitting

Curve fitting can be performed via a polynomial or interpolated data. The Curve Fit Order can also be 
changed to achieve a better fit to the data, and the curve fit constants are displayed in a table.

Note: Unrealistic behavior could occur if the curve fit does not pass through the origin of the graph. 
This may negatively impact convergence when running transient simulations that have zero 
flow through the component at a point in time. See the Troubleshooting Resistance Curves topic 
for more information.

Reference Density

Options to correct for a reference density are available when using mass or pressure parameters. This is 
useful for when the pressure loss data was measured with a different working fluid than what is used in 
the model. See the Reference Density topic for more information.

Related Topics

Curve Fitting 75
Troubleshooting Resistance Curves 565
General Component 272
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Defining Junction Transients
This section contains information related to defining transient behavior for junctions. Topics include dis-
cussions on standard junction transient information and transient initiation options. For information on 
overall transient simulation controls see the Pipe Sectioning and Output group and Transient Control 
group.

Contents

Junction Transient Data
Many junction types have an area where active transient data can be specified. Active transient in this 
context means that the behavior of a component over time is being directly defined by the user. It is also 
possible for components to react passively during the simulation as well - for example, a relief valve 
opening under excess pressure or a finite tank changing pressure as mass flows into or out of it.    

Table 1: Junctions that support transient data    

The active transient data is entered on the junction's Transient tab.
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Figure 1: Transient tab for a Valve    

In most cases, transient data can be entered as absolute values or as a percentage of steady-state, as 
defined by the first options in Transient Data.    

The first data point always needs to match the steady-state value which is usually entered on the Loss 
Model tab. xStream fills in that initial data point for the user, but it should always be checked.     

Lastly, take note that several junctions require multiple inputs for transient data to be used. This is dif-
ferent from many liquid based transient solvers, and should be kept in mind when establishing transients 
in xStream.    

Note: If a junction does not have any active transient behavior, there is no need to enter any data on 
the Transient Data tab.    

Repeat Transient    

If the transient data is periodic, you can enter the data for one cycle of the period and then tick the check 
box for Repeat Transient. This will cause the one cycle of transient data to be repeated once it has 
reached the end. The repetition will continue until the end of the simulation.    

Transient Special Condition    

There are instances where you will only wish to use the defined transient data in certain cases or scen-
arios. Instead of deleting the transient data, specify the Transient Special Condition as Ignore Transient 
Data. The data will be left in the window for future use, but will not activate during the run.    
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Initiation of Transient    

There are multiple ways that the data entered in Transient Data can be applied during the simulation. The 
default selection is Time for most junctions, meaning that the behavior vs simulation time is directly 
defined by the user.    

It is also possible to initiate a transient based on a system event. This will execute the Transient Data 
when a user defined parameter reaches a certain setting. For example, a valve can be set to close only 
when a specific flow rate becomes too low.    

See Initiation of Transients for detailed information.    

Related Topics

Assigned Flow 236
Assigned Pressure 238
Valve 284
Heat Exchanger 273
Compressor/Fan 247
Control Valve 268
Check Valve 245

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Initiation of Transients
In general, transients can be initiated according to a certain time or according to certain events that hap-
pen in the system. These two categories are referred to as time based and event based transients. This 
is defined in the Initiation of Transient area of a junction's transient tab.             

Figure 1: Type of transient initiation

It is helpful to consider the different time scales that are used when referring to the initiation of a transient, 
as shown in Figure 2.

Absolute and Simulation Time are often identical. The simulation Start Time is set in the Simulation Dur-
ation panel to an Absolute Time of zero seconds by default, but it could be non-zero. In Figure 2, the Sim-
ulation Start Time is set to a value of 2 seconds – the entire Simulation Time timeline is shifted forward 2 
seconds.

https://www.aft.com/support/product-tips/and-not-or-starting-transient-events-with-complex-logic
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Event Time refers to the time data defined in Transient Data this could be equal to Simulation Time (and 
Absolute Time) depending on how the event is defined. For example, all three time bases will match for a 
valve closure event starting at the beginning of a simulation with Start Time equal to zero. However, the 
event may not start until a certain system condition is met and zero Event Time could be well into the sim-
ulation.

Figure 2: Time basis

Time

Time based transients modify a parameter directly according to Simulation Time.

For example, consider a valve closure transient. The valve starts to close at two seconds into the sim-
ulation, and the time it takes for the valve to close is one second. After that, the valve stays closed. To 
define this event with the Time option, the Start Time must be set to zero, and the Transient Data must 
look something like the data shown in Figure 3.

Figure 3: Defining a valve closure at a specific time

Single Event

Single Event initiated transients do not begin until a certain condition is met.

To completely define an Event, four parameters are required:
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 l Event Type - What parameter is being considered to initiate the transient. See Table 1 below for a 
list of the possible Event Types.

 l Condition - The logical relationship between Event Type and Value (e.g. greater than, less than, 
etc)

 l Value - The specific magnitude of the Event Type parameter at Location
 l Location - Where in the model the Value should be observed

Given the same valve closure profile described in Figure 3, we can set the valve to remain open until (and 
if) the flow at the inlet of P1 exceeds 20 lbm/sec. Note that the Transient Data is identical - but the ini-
tiation of the event may happen at a very different time.

Figure 4: Event definition

Table 1: Event types

Dual Event Cyclic

The Dual Event options, as the names imply, require the definition of two events. The definition for each 
event follows the same structure as a Single Event.

Dual Event Cyclic will continue monitoring both triggering events throughout the simulation and will apply 
the corresponding transient data when the conditions are met.

To continue with the valve example, we can define our valve not only to close when a flowrate is 
exceeded, we can tell it to open when the flow drops below a certain setting.



Defining Junction Transients

- 230 -

Figure 5: Dual Event set up. Note that a Second Event requires additional data for the Second Transient

Dual Event Sequential

Dual Event Sequential is nearly identical to Dual Event Cyclic. In fact, all of the required user input is the 
same.

The difference is that the two defined events are only applied once. That is – after the second event is 
complete, no more transients will be applied even if the conditions are met.

Junctions With Inherent Event Logic

There are two junction types in AFT xStream which have built-in, or inherent, event logic. These are the 
check valve and relief valve. The user does not need to specify the nature of the events, and in fact is not 
allowed to. 

The inherent event logic is very similar to the Dual Event Cyclic logic described previously.

 l Check valve - The check valve has two built-in events. The first is that it closes when backflow 
starts to occur. The second is that it reopens when sufficient pressure differential occurs. These 
transients are assumed to be instantaneous.

 l Relief valve - The relief valve has one built-in event. It opens when the set pressure is reached.  
This transient is assumed to be instantaneous.
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Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Multi-Condition Events
One of the Event Types available is Multi-Condition. This feature allows starting a transient based on 
more than one parameter in the model.

For example, it may be desirable to open a valve when either of two pressures is exceeded.

To define a Multi-Condition Event, first select Multi-Condition as the Event Type from the junction's Tran-
sient tab.

Figure 1: Selecting Multi-Condition Event Type

Event Manager

Clicking Multi-Condition Event opens the Event Manager, where Simple Events and Multi-Condition 
Events can be defined.

The Event Manager defines events model-wide. That is, if the active scenario is changed, the same 
events will be accessible.

https://www.aft.com/support/product-tips/and-not-or-starting-transient-events-with-complex-logic
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Figure 2: The Event Manager

Simple Events

The Event Manager allows for the definition of Simple Events and Multi-Condition Events.

Simple Events are nearly identical to normal (non Multi-Condition) events defined in a Transient tab. 
They require a Parameter, Condition, Value, and Object as well as a unique Name.

Clicking "Create Simple Event..." adds a new Simple Event to the list with default values. These values 
should be updated with the desired values and applied with the Update button. Simple Events can be 
duplicated to help reduce repeated data entry.

Multi-Condition Events

Multi-Condition Events are a collection of other Events with a logical condition applied to them. When cre-
ating a new Multi-Condition Event, a prompt for a Name appears. After entering a name, an empty Multi-
Condition is created with a default logical condition of AND. This logical condition can be:

 l AND - All of the Simple Event conditions must be met for the Multi-Condition Event to trigger.
 l NOT - The Multi-Condition Event triggers when none of the conditions evaluate to true.
 l OR - One or more of the Simple Event conditions must be met for the Multi-Condition Event to trig-

ger.
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Figure 3: Conditional logic for Multi-Condition Events

Any number of Simple Events can be added to a Multi-Condition Event as Sub-Events:

Figure 4: Multiple Events

Complex Multi-Condition Events

More complex events can be defined by adding one or several Multi-Condition Events as Sub-Events to 
another Multi-Condition Event.

Figure 5: A Multi-Condition Event containing another Multi-Condition Event (trigger if Limit 3 AND (Limit 1 OR 
Limit 2))

Using Multi-Condition Events

All Multi-Condition Events are listed in the junction's Initiation of Transient section. Only one Multi-Condi-
tion Event can be selected as the Initiating Event for any particular Transient Data.
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Figure 6: The selected Multi-Condition Event controls the trigger of the Transient Data. Hovering over the 
Multi-Condition events here shows an expanded definition of the event

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Area Change
The Area Change junction type must always have two connecting pipes. This junction type allows you to 
model the irrecoverable loss that occurs at the area transition between two pipes, whether expansion or 
contraction.

The Area Change Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. A flow direction through the junction is adopted from the 
defined directions of the two connecting pipes.

The Area Change Properties window offers two standard types of area change losses: the Conical Trans-
ition and the Abrupt Transition.

The critical parameter that influences the magnitude of the area change loss is the area ratio between 
upstream and downstream pipes. Until you have input the information for the upstream and downstream 
pipes that allow for flow area determination, the standard Area Change junction loss factor is not cal-
culated. For conical transition geometries, you also need to specify the conical angle. This angle has a 
range of 0-180 degrees, with a 0 degree angle representing a transition taking place over an infinitely 
long length, and a 180 degree angle representing an abrupt transition. 

https://www.aft.com/support/product-tips/and-not-or-starting-transient-events-with-complex-logic
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If the standard loss factors provided are inadequate for your application, you may specify your own cus-
tom loss factor referenced to the base area you specify.

Note:It is possible to have a vena contracta through a physical area change. If high velocities are pos-
sible, the Mach number may reach sonic conditions and the flow will choke. The optional CdA 
input parameter is intended to represent this vena contracta. The minimum possible sonic flow 
area is entered as the CdA and if sonic conditions are reached, AFT Arrow will solve the system 
on achoked flow basis.

Related Topics

Common Junction Input Parameters 211

Area Change Loss Model
Two standard area change loss geometries are available: the conical transition and the abrupt transition.

The conical expansion correlation (Crane 1988, A26) is

The conical contraction correlation (Crane 1988, A26) is

The abrupt expansion correlation (Idelchik 2007, 246) is
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The abrupt contraction correlation (Idelchik 2007, 254) is

Note: While a 180 degree conical transition is the same as an abrupt transition, Crane's conical con-
traction equation gives a different result at 180 degrees compared to Idelchik's abrupt con-
traction equation. Therefore, it is up to the user to determine which one to use. 

All K factor equations are provided here in terms of the upstream pipe. The K factor in terms of the down-
stream pipe can be found as follows:

Related Topics

Nomenclature 448
K Factor Loss Model 217
References 499

Assigned Flow
The Assigned Flow junction type allows you to connect one pipe and to input a known steady-state 
and/or transient flowrate entering or leaving at a particular location.

The Assigned Flow Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipe information in a fixed format.

The Assigned Flow junction type allows you to specify positive mass flow rates. Negative flow rates are 
not accepted for steady flow, although they are for transient flow. If, for example, you have an outflow 
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type junction and your system is physically flowing in, you cannot assign a negative flow rate to the junc-
tion. You must reverse the connecting pipe reference flow direction to be consistent with the actual dir-
ection and change from an outflow type to an inflow type.

Transient Data

On the transient data tab a flowrate transient can be entered. A special feature is the ability to model a 
sinusoidal flowrate transient. Input for the amplitude and frequency is required. If data is present in the 
transient data table, the sinusoidal transient is summed with the data in the transient data table. 

A chopped sine wave takes the absolute value of the sine function. The end effect looks like doubling the 
frequency in the positive domain only, and having nothing in the negative domain.

For more information on transient data, including event transients, see Junction Transient Data.

Special Conditions

You can set a Special Condition for an Assigned Flow junction, which will turn the flow off and make it act 
like a Dead End during steady-state.

Related Topics

Common Junction Input Parameters 211
Junction Transient Data 225

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Impulse which allows users to sim-
ulate settling slurries.

Assigned Flow Transient Theory
With an assigned flow, the flow rate is known at the pipe inlet or outlet. The unknowns are then the velo-
city, the pressure, and the density.

If the flow rate is known at the upstream end of the pipe, the negative wave compatibility equation is used 
to determine the pressure based on an initial guess for velocity. 

The density can then be determined directly from the equation of state as a function of pressure and tem-
perature. Once the pressure and density are calculated, the mass flowrate can be recalculated using the 
continuity equation. If the difference between the defined and calculated mass flow rate is too large the 
velocity is adjusted and the process is repeated until the specified flow is met within a reasonable tol-
erance.
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Conversely, if the flow is known at the downstream end, the positive wave compatibility equation is used 
to calculate the velocity based on an initial guess for pressure.

The density can then be found using the particle path compatibility equation.

Similar to the process above with a known inflow the mass flow can be recalculated using the continuity 
equation, and the pressure will be iterated on until the calculated mass flow is within a reasonable tol-
erance of the specified mass flow.

Sonic Choking Transient Theory

An outlet assigned flow junction can experience endpoint choking during the steady state, or can 
become choked during the transient due to transient events in the system. An inlet assigned flow junction 
cannot be choked in the steady state, but may experience choking during the transient as a result of 
rapid transients in the system. If sonic choking occurs at the assigned flow junction  a different solution 
method must be enacted. See Transient Sonic Choking for more information.

Related Topics

Nomenclature 448
Method of Characteristics 473
Sonic Choking Detailed Description 488

Assigned Pressure
The Assigned Pressure junction allows for the specification of a fixed boundary pressure. The Assigned 
Pressure window follows the second of the two basic Properties window formats. A table on the Loss 
Coefficients tab displays the connecting pipe information, and allows loss factors to be entered to 
account for losses due to fittings or components at the entry/exit to each of the connected pipes.

This junction is very similar to the Infinite Tank in that it fixes a pressure at a boundary. However, the 
Assigned Pressure allows the definition of either a static or stagnation pressure boundary, whereas tanks 
are always stagnation pressure. Typically, any pressure gauge on a pipe will be reporting static pressure 
- it is important to select static pressure if this is the actual boundary in the real system. A Tank would be 
inappropriate to represent such a piping connection with non-zero flow.

If stagnation is selected, the Assigned Pressure accepts the connection of up to twenty-five pipes. Static 
selection limits the connection to one pipe.
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Transient Data

On the transient data tab a flowrate transient can be entered. A special feature is the ability to model a 
sinusoidal flowrate transient. Input for the amplitude and frequency is required. If data is present in the 
transient data table, the sinusoidal transient is summed with the data in the transient data table. 

A chopped sine wave takes the absolute value of the sine function. The end effect looks like doubling the 
frequency in the positive domain only, and having nothing in the negative domain.

For more information on transient data, including event transients, see Junction Transient Data.

Related Topics

Role of Pressure Junctions - Detailed Discussion (Long) 518
Role of Pressure Junctions and How They Work 70
Tank 280
Common Junction Input Parameters 211
Junction Transient Data 225

Related Online Content

 l Static vs. Stagnation Pressure Video

Assigned Pressure Transient Theory
With an assigned pressure, the pressure is known at the pipe endpoint. The unknowns are therefore the 
velocity, which can be obtained by solving the appropriate compatibility equation, and the density.

If the static pressure is known at the upstream end of the pipe, the negative compatibility equation is 
used. 

The density can then be determined directly from the equation of state as a function of pressure and tem-
perature.

Conversely, if the static pressure is known at the downstream end, the positive compatibility equation is 
used.

https://www.aft.com/static-vs-stagnation-pressure?utm_source=i8&utm_medium=full&utm_campaign=hlp_apphlp
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The density can then be found using the particle path compatibility equation.

If the known pressure changes with time, then a current pressure is obtained for the current time step and 
used in the equations.

If the known pressure is a stagnation pressure instead of the static pressure, additional complexities are 
introduced as the velocity must be known to convert the given stagnation pressure to a static pressure. 
Therefore, iterations must be performed using the corresponding compatibility equations as shown 
above combined with the stagnation property relationships.

Sonic Choking Transient Theory

An outlet assigned pressure junction can experience endpoint choking during the steady state, or can 
become choked during the transient due to transient events in the system. An inlet assigned pressure 
junction cannot be choked in the steady state, but may experience choking during the transient as a res-
ult of rapid transients in the system. If sonic choking occurs at the assigned pressure junction  a different 
solution method must be enacted. See Transient Sonic Choking for more information.

Related Topics

Nomenclature 448
Method of Characteristics 473
Sonic Choking Detailed Description 488

Bend
The Bend junction type must always have two connecting pipes. This junction type allows you to model 
the irrecoverable loss that occurs when the flow direction changes through a bend or elbow.    

The Bend Properties window follows the first of the two basic Properties Window formats, displaying the 
connecting pipes in a fixed format. A flow direction through the junction is adopted from the defined dir-
ections of the two connecting pipes.    

The Bend Properties Window offers three standard types of bend losses: the Smooth Bend, the Standard 
Elbow (the standard short radius threaded elbow), and the Mitre Bend. The window shows a schematic 
of the selected geometry. Until you have input the information for the upstream pipe that allows flow area 
determination, the standard Bend junction loss factor is not calculated. For smooth radius bends, you 
also need to specify r/D, which is the radius of curvature over the pipe diameter. At r/D less than one the 
Reynolds number must be known to calculate the loss factor, and therefore cannot be displayed until out-
put is available.    

For bends that are not at a 90-degree angle, you can enter the angle and the standard loss factor will be 
calculated.    

If the standard loss factors provided are inadequate for your application, you may specify a custom loss 
factor referenced to the upstream pipe flow area.    
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Note: In principle, the upstream and downstream pipe diameters should be the same. However, the 
Bend junction only uses the reference area specified under Basis Area for Loss Model, even if 
the physical flow is in the opposite direction. If you are working with a user-specified loss, your 
geometry may have different diameter pipes connecting to the elbow. In this case, you would 
purposely define different upstream and downstream pipe areas. However, you would still want 
to be careful that the custom loss factor you assign is referenced to the correct area that is spe-
cified in Basis Area for Loss Model.    

CdA for Sonic Choking 

As the fluid goes around the bend, it can separate from the wall. This results in a reduced physical flow 
area. When assessing sonic choking, it is this reduced area that is important. The optional CdA input 
parameter is intended to represent this reduced flow area. The minimum possible flow area is entered as 
the CdA and if sonic conditions are reached AFT xStream will solve the system on a choked flow basis.

Bend Loss Model

90 degree bends 

The three Bend loss correlations are all for turbulent Reynolds numbers (Crane 1988, A-29).

The K-factors for a smooth flanged bend with r/D ≥ 1 are provided in Table 1.

Table 1: K-factors for 90 degree smooth flanged bends

 
The standard threaded elbow is given by:             
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where fT is the turbulent friction factor given in Table 2.             

Table 2: Pipe friction factors used for Crane formulas

 
The Mitre bend is given by:             

Non-90 degree bends

The two non-90 degree bend loss correlations are for turbulent Reynolds numbers (Crane 1988, A-29).

A smooth flanged bend with r/D ≥ 1 is given by:             

where n is the number of 90 degree bends, K is the loss factor for one 90 degree bend (Table 1), and fT is 
given by Table 2.             

The Mitre bend is given by Table 3.             
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Table 3: K values for Mitre bends

 

Smooth Flanged Bends, r/D < 1             

The smooth, flanged bend with r/D < 1 loss factor uses a correlation applicable for turbulent Reynolds 
numbers (Miller 1990, 209)

The loss coefficient is calculated based on Miller's class 2 bend model, which is sufficient for general 
design purposes, and is given by

C0 and Cf are assumed to be 1 for class 2 bends. Kb* is given by the nomograph on page 207 of Miller.             

For r/D > 0.7 or Kb* < 0.4, CRe is given by Miller Figure 9.3. Otherwise, CRe is given by the equation 
below.             

where the CRe for r/D = 1 is also found from Miller Figure 9.3.             

Related Topics

References 499

Branch
The Branch junction allows up to twenty-five connecting pipes. The Branch junction is the most flexible 
junction type for building network models that have flow splits. The Branch junction must have at least 
two connecting pipes.
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The Branch Properties window follows the second of the two basic Properties window formats.

This junction will always be treated as lossless.

Related Topics

Common Junction Input Parameters 211

Branch Transient Theory
At a branch, there can be multiple pipes. Two additional relationships are needed, the conservation of 
mass and conservation of energy. The total mass flow in and out of the junction must sum to zero. The 
branch junction is treated as adiabatic, so the energy must sum to zero as well.

A constant stagnation pressure Po is asserted at the branch since the branch is treated as lossless, 
meaning there is no stagnation pressure loss. By asserting a constant stagnation pressure the branch 
can essentially be treated as an assigned pressure boundary, though the "known" stagnation pressure 
must be iterated on.

Using the stagnation pressure solution the flow rate and density can be solved for with the appropriate 
compatibility equations as is done for the Assigned Pressure Junction.

The total mass flow in can then be calculated

and the total energy flow is found using

Using the above equations and enforcing energy conservation, the stagnation enthalpy can be found as 
follows
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While the conservation of energy is inherently enforced in the solution using the above equation, con-
servation of mass is not inherently included. Mass conservation is instead achieved using iteration.

The total mass outflow can be written similar to the mass inflow summation above. The total mass out-
flow can then be calculated similar to the mass inflow using the compatibility equations, known stag-
nation pressure solution and known stagnation enthalpy.

An  iterative method for stagnation pressure is used to drive the mass inflow and outflow difference to 
zero.

Sonic Choking Transient Theory

Expansion choking can occur at a branch if the total cross-sectional area of the inflow pipes is less than 
the total cross-sectional area of the outflow pipes. If sonic choking occurs at the branch junction a dif-
ferent solution method must be enacted. See Transient Sonic Choking for more information.

Related Topics

Nomenclature 448
Method of Characteristics 473
Sonic Choking Detailed Description 488

Check Valve
The Check Valve junction type requires two connecting pipes. This junction type allows you to model the 
effect of a check valve which closes to prevent back flow.
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The Check Valve Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. The Check Valve junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes for calculating loss. The user can define 
the base area for the loss model, though the default is set to use the upstream flow area.

A check valve is a device that allows flow in only one direction. AFT xStream assumes that the Check 
Valve is initially open (unless modeled as Closed on the Optional tab). If the flow solution indicates that 
the velocity at the check valve is insufficient to keep the check valve open based upon the check valve 
input, AFT xStream closes the valve. The valve can close during the steady-state or transient portion of 
the simulation.

AFT xStream allows you to model the check valve by entering a User Specified closing velocity.

The Loss Model for the open valve can be specified as a Cv, Kv or K factor by choosing an option on the 
Valve Model tab and entering the Full Open value.

An optional input in the Check Valve Properties window is the CdA. This parameter describes the effect-
ive area restriction in the valve for the purpose of calculating sonic choking. In most cases, information on 
the CdA must be obtained from  the manufacturer or from test data. Note that the CdA input field is dis-
abled if Cv or Kv loss is used, as the Xt value is used for sonic choking calculations in that case.

User Specified

The User Specified option opens and closes based on user-defined values for velocity to close and a 
delta pressure to reopen. For steady-state analysis the valve is either fully open, or fully closed. In a tran-
sient analysis, the valve opens and closes instantaneously.

The inputs are as follow:

 l Forward Velocity to Close Valve - By default this value is zero. Some valves are designed to start 
closing at some reverse velocity - you can specify that here as a negative value. Entering a positive 
value in this field would imply that the check valve closes while the flow is still continuing forward.

 l Delta Pressure to Reopen - Frequently after a check valve closes, there is pressure across the 
valve at which it will open again. You can specify that delta pressure here.

Special Conditions

A check valve can have a Special Condition of None, Closed (stays closed or allowed to reopen in tran-
sient), or Open (stays open).

Related Topics

 l Parameters Common to All Junction Properties Windows
 l Junction Transient Data
 l K Factor Loss Model
 l Kv, Cv, and XT Loss Model  
 l Inherent Event Logic
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Compressor/Fan
The Compressor/Fan junction modeling of the pressure added to a system by a compressor, and mod-
eling many transient events involving compressors/fans. Because all compressors/fans are different, 
AFT xStream does not provide preset configurations for centrifugal compressors/fans. For these junc-
tions, pressure and flow data that describes the device must be obtained from the manufacturer or from 
test data. To reduce repeated data entry, frequently-used compressors/fans can be added to the Junc-
tion Library.

Common Input Information

Like all junctions, Compressor/Fan junctions require a junction number, junction name, and inlet and out-
let elevations. Similar to other junctions, compressors can have Design Alerts and Notes applied to them. 
They require two connecting pipes. Note that the direction of the connected pipes define which side of 
the compressor/fan is suction and which is discharge.

Compressor Model

This tab requires the selection and definition of what type of compressor/fan the junction represents. 
There are several compressor models available:

 l Centrifugal (Rotodynamic) - Represents a typical centrifugal compressor or fan where the head 
added to the fluid is related to the flow through the compressor via a compressor curve.

 l Positive Displacement (Fixed Flow Rate) - Represents a steady state approximation of a positive 
displacement compressor. The flow is fixed to a constant value, and whatever head is necessary 
to obtain that flow will be supplied.

 l Positive Displacement (Reciprocating) - Represents a compressor in which pistons connected to        
one or more crankshafts are used to pressurize a volume of gas. Cylinders can be arranged by       
single cylinder, opposed cylinders, inline, and vee cylinder options. Single and double-acting       con-
figurations are available.

Figure 1: Compressor/Fan Models                 
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Variable Speed

This allows the speed of the centrifugal compressor to vary.

 l Fixed Speed (%) - Directly modify the compressor curve according to the Affinity Laws. The Com-
pressor/Fan Curve entered in Compressor/Fan Configuration is always assumed to be the 100% 
speed curve.

Transient

Centrifugal compressors/fans and fixed flow rate positive displacement compressors allow for transients. 
This allows the user to directly specify how the speed of the centrifugal compressor/fan or the flow rate of 
the fixed flow rate positive displacement compressor changes over time. This can be used to model star-
tups, trips, or control transients.

For more information on transient data, including event transients, see Junction Transient Data.

All of the transient options need to know when to start with Initiation of Transient and allow the definition 
of a Transient Special Condition.

Reciprocating compressors operate at constant speed and do not allow Speed vs     Time transients.

Optional

There are several optional parameters that can be defined for a compressor/fan. The Workspace Icon 
can be adjusted, as is the case for most junctions.

Also present are several compressor junction specific options:

 l Special Condition
 l None - The compressor/fan operates normally.
 l Compressor Off No Flow - The compressor/fan is shut off and blocked. This is identical to a 

closed valve.
 l Compressor Off With Flow Through - The compressor/fan is shut off but allows flow to con-

tinue through. This is identical to a lossless connection.

Related Topics

Common Junction Input Parameters 211
Junction Transient Data 225
Initiation of Transients 227
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Related Blogs

Modeling Fans, Blowers and Compressors - Oh My!

Centrifugal Compressor

Centrifugal Compressor Curve

A  Compressor Curve is required to model a centrifugal compressor. This is the typical Head or Pressure 
vs. Flow information that will be available from any compressor manufacturer.

To enter these curves, click Enter Curve Data. Once this data has been defined, previews of the applied 
curves can be seen here.

Note: AFT xStream does not have a means to account for stall or surge lines for the compressor. 
Therefore, it is possible that xStream will allow the compressor to operate at unrealistic con-
ditions. It is advised that the user check the results to ensure that the compressor did not reach 
the surge or stall lines during the run, design alerts can be useful to assist with this check.

Figure 1: Standard Compressor Curve

Added Pressure

If the compressor curve is entered using pressure rise information as opposed to a head rise, the pres-
sure rise will need to be specified as either a stagnation or static pressure. This specification is performed 
on the Compressor Model tab under the Centrifugal Compressor specification. Note that mechanical 
energy rises are typically entered in xStream as pressure rises instead of head rises because the use-
fulness of the head term in variable-density systems is diminished.

https://www.aft.com/support/product-tips/modeling-fans-blowers-and-compressors-oh-my
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Compression Process Thermodynamics

In xStream the compressor will always be modeled  as isentropic and 100% efficient. If the compression 
process is isentropic, the temperature rise is given by the following isentropic relationship:

Note that these pressures and temperatures are static and not stagnation. Gamma is the isentropic 
expansion coefficient or specific heat ratio, depending on the Fluid Accuracy Options.

Note: The Compressor Configuration window provides the option to enter efficiency option for the sole 
purpose of maintaining input when models are imported from other AFT products. The com-
pressor efficiency data will not be used for calculation purposes.

Related Topics

Affinity Laws 255
Multiple Configurations 256
Transient - Speed vs. Time 259
Compressor/Fan Efficiency Data 267
Compressor Configuration 250

Related Blogs

The Truth About Air Compressors

Modeling Fans, Blowers, and Compressors - Oh My!

Compressor Configuration
The compressor configuration window is used to define the specific operation of a centrifugal com-
pressor. It is opened with the Enter Curve Data button from the Compressor/Fan Properties Compressor 
Model tab when Centrifugal Compressor is selected.

https://www.aft.com/support/product-tips/truth-about-air-compressors
https://www.aft.com/support/product-tips/modeling-fans-blowers-and-compressors-oh-my
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Figure 1: Enter Curve Data

Configuration Method

By default, a compressor curve is defined using the Simple configuration. This means that the user inputs 
only one compressor curve for the junction.

If the Configuration Method is changed to Multiple, additional input becomes available on the right of the 
configuration window. This allows defining different curves to represent the behavior of the compressor 
at different speeds. See a detailed description in Compressor/Fan Multiple Configuration. This feature is 
especially useful when multiple curves for a given compressor junction must be evaluated as it prevents 
the user from having to delete and enter curve data.

Compressor Data

The first tab of the compressor configuration controls the compressor's most basic behavior - the com-
pressor curves. 
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Figure 2: Compressor Data

A compressor/fan can have two curves defined:

 l Flow vs. Head/Pressure/Compression Ratio - Required. This is what is commonly referred to 
as the "compressor/fan curve" and defines how much pressure the turbomachine can add to a 
fluid at any given flowrate.

 l Flow vs. Efficiency/Power - (Optional) Data entered in this column allows for quick assessment 
of power used at the operating point and the proximity to Best Efficiency Point (BEP).

After entering the raw values into the table, the data needs to be curve fit.

If Mass Flow, Pressure, or Power are used in the curve definitions, Reference Density becomes an addi-
tional required input.

Configuration Data

This tab controls some additional behavior or input for a compressor junction. Entering or changing val-
ues on this tab is optional. 
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Figure 3: Configuration Data

 l Best Efficiency Point (BEP) - The Best Efficiency Point (BEP) by default is calculated from the 
entered efficiency or power curve. This is generally the preferred option as it best relates to the 
true meaning of BEP. A User Specified value can be entered if no efficiency or power curve is 
available, or if it is desired to force the BEP to a certain flow.

 l End Of Curve Flow Rate (optional) - This value is used to create a warning in the output if it is 
exceeded. It does not affect the solution - the model will behave identically however this value is 
defined.

 l Preferred Operating Region (POR) - % of BEP values falling outside of the defined range will 
generate a warning in the model output. This range can be defined by the user.

 l Allowable Operating Region (AOR) - Similarly, this flow range creates a warning in the output 
when the user specified flow range is not adhered to.

Graphs

The following tabs display the curves that have been fit to the given data. If multiple curves are defined, 
the Composite Graph tab becomes available. The other graph tabs show the individual curves, along 
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with points representing the raw data. It is a good idea to check that these graphs to confirm the curve fit 
is reasonable for any potential operating region.

Figure 4: Composite Graph

Related Topics

Curve Fitting 75
Reference Density 213
Centrifugal Compressor 249
Affinity Laws 255
Multiple Configurations 256
Transient - Speed vs. Time 259
Compressor/Fan Efficiency Data 267

Related Blogs

Modeling Fans, Blowers and Compressors - Oh My!

https://www.aft.com/support/product-tips/modeling-fans-blowers-and-compressors-oh-my
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Affinity Laws
Compared to compressors, it is more common for fans or blowers to operate with variable speeds 
(adjustable in the Variable Speed tab in the Compressor/Fan Properties window). Affinity laws (also 
called homologous laws) allow an estimation of the compressor/fan performance at speeds other than 
the design speed.

Before discussing the affinity laws, it should be noted that the affinity laws are an approximation. In many 
cases, compressor/fan manufacturers will have performance data for a number of speeds. These data 
should be used if available. When not available, the affinity laws can be used with an understanding that 
an approximation is being made. The affinity laws are known to have much lower accuracy for com-
pressors and blowers than for fans.

Compressor/fan curves can generally be curve fit to a polynomial:

The speed ratio is defined in terms of the design impeller speed, N1 and the desired operating speed N2  
as:

Affinity Laws

For the following ratios, subscript 1 represents the parameter from the defined curve (assumed to be at 
100% speed). Subscript 2 represents the given parameter at the desired operating speed N2 .

 l Flow rate -

 l Compressor/fan head -

 l Power consumption -
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 l Efficiency - 

Application to Transients

During a transient event, the speed of the compressor/fan may change. In such cases, the affinity laws 
are used to adjust the head/pressure curves appropriately for the new speed. This is a process that often 
requires additional iteration.

Related Topics

Centrifugal Compressor 249
Multiple Configurations 256
Transient - Speed vs. Time 259
Compressor/Fan Efficiency Data 267
Compressor Configuration 250

Related Blogs

To Affinity and Beyond!

Multiple Configurations
A single compressor junction can contain information for multiple compressor configurations - impeller 
trims and operating speeds. This is useful to compare different variations of a compressor without need-
ing to redefine a new compressor junction for every case. The configuration of the compressor can easily 
be changed without losing any information.

Defining Multiple Configurations

When opening the compressor configuration, change the Configuration Method from Simple to Multiple. 
When doing so, an additional user input panel appears on the right hand side of the window.

https://www.aft.com/support/product-tips/to-affinity-and-beyond
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Figure 1: Multiple Configuration Method Selected

In order to make use of the multiple configuration feature, an RPM and Impeller Diameter under Con-
figuration Information should be filled in. A Description can optionally be added. After modifying any 
information that affects the definition of this configuration the Update Configuration box turns yellow:

Figure 2: Update Configuration
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Clicking Update Configuration Now adds the Configuration to the Compressor Configurations listed in 
the top-right.

Figure 3: Current Compressor Configurations

To create an additional configuration, click Create.

Figure 4: Creating a new Configuration
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The compressor curves must be created and curve fit, as with a single configuration compressor. After 
completing this and clicking Update Configuration Now, the new configuration will be created and shown 
in the Compressor Configurations area. Configurations can be edited by selecting them in this area

Figure 5: Editing a Configuration

Now that multiple configurations are available, they can be selected on the Compressor Model tab:

Figure 6: Selection of a Configuration

Related Topics

Centrifugal Compressor 249
Affinity Laws 255
Transient - Speed vs. Time 259
Compressor/Fan Efficiency Data 267
Compressor Configuration 250

Transient - Speed vs. Time
Certain configurations of a compressor allow the direct specification of Speed vs. Time. 
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Transient Data

For Speed vs. Time, the variation of speed must be directly defined in Transient Data. The speed of the 
compressor will be forced to meet this data at each time step of the transient simulation, with the com-
pressor curves being adjusted every time step according to the affinity laws.

Figure 1: A Speed vs. Time transient

Related Topics

Initiation of Transients 227
Centrifugal Compressor 249
Affinity Laws 255
Multiple Configurations 256
Compressor/Fan Efficiency Data 267
Compressor Configuration 250

Positive Displacement Compressor
To model a positive displacement compressor, select the Positive Displacement option on the Com-
pressor Model tab of the Compressor/Fan Properties window. There are two subtypes of positive dis-
placement compressors. Generally, the Fixed Flow Rate model is used for positive displacement 
compressors that do not function with a piston mechanism, or when configuration information for a recip-
rocating compressor is unknown.
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 l Fixed Flow Rate Compressor - Represents a steady state approximation of a positive dis-
placement compressor. The flow is fixed to a constant value, and whatever head is necessary to 
obtain that flow will be supplied.

 l Reciprocating Compressor - Represents a compressor in which pistons connected to        one or more 
crankshafts are used to pressurize a volume of gas. Cylinders can be arranged by       single cylinder, 
opposed cylinders, inline, and V cylinder options. Single and double-acting       configurations are 
available.

Related Topics

Reciprocating Compressor 262
Pulse Setup Panel 100
Fixed Flow Rate Compressor 261
Transient - Setpoint vs. Time 266

Fixed Flow Rate Compressor
Fixed Flow Rate Compressors are a subtype of Positive Displacement Compressors that provide a fixed 
flow for steady-state analysis. This allows for a fixed flow to be defined in a straightforward manner. With 
a Fixed Flow Rate Compressor, a transient can be defined in terms of flow setpoint varied over time.

Parameter

 l Volumetric Flow Rate - Fix the volumetric flow rate at the inlet of the compressor. Due to com-
pressibility effects, the outlet volumetric flow rate may differ.

 l Mass Flow Rate - Fix the mass flow rate through the compressor.

Fixed Condition

 l Fixed Flow Rate - The value and unit of the fixed flow amount.
 l Nominal Efficiency - A fixed efficiency, useful to calculate power requirements. The positive dis-

placement compressor thermodynamics will be treated as adiabatic regardless of the defined effi-
ciency value.
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Figure 1: Fixed Flow Rate Positive Displacement Compressor model

Related Topics

Positive Displacement Compressor 260
Reciprocating Compressor 262
Transient - Setpoint vs. Time 266

Related Blogs

Modeling Fans, Blowers and Compressors - Oh My!

Reciprocating Compressor
The reciprocating compressor is a subtype of Positive Displacement Compressor used to represent a 
compressor with flow driven by a crankshaft and pistons. This can be used to model both single and 
double-acting compressors with one or multiple cylinders in single, inline, V, or opposed configurations. 
The model incorporates the effects of cylinder geometry, crankshaft angles, and valve opening and clos-
ing angles into a thermodynamic model for gas expansion and compression. Gas compression and 
expansion within each cylinder is assumed to be isentropic and the valves are assumed to be lossless 
and open or close instantaneously. The options for configuring a reciprocating compressor are shown in 
Figure 1 below.

https://www.aft.com/support/product-tips/modeling-fans-blowers-and-compressors-oh-my
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Figure 1: The Compressor Model tab of the Compressor/Fan Properties window for a reciprocating com-
pressor

Compressor Configuration

The Compressor Configuration section of the Compressor Model tab has the following parameters:

 l Action
 l Single-Acting - This is used for compressors with a single compression chamber per pis-

ton where the connecting rod is outside the compression chamber.
 l Double-Acting - This is used for compressors with two compression chambers per piston 

where the piston rod passes through the chamber that is on the side of the crankshaft. The 
connecting rod connects the piston rod to the crank arm. The volume of the piston rod is 
subtracted from its associated chamber volume. See the Rod Diameter parameter below.

 l Cylinder Arrangement
 l Single Cylinder - The single cylinder option is used for single piston compressors or used 

when modeling each cylinder of a compressor separately, such as in multiple stage com-
pressors or when building a model to capture manifold effects.

 l Opposed - An opposed cylinder arrangement has two banks of cylinders with a shared 
crankshaft separated from each other by 180 degrees. The cylinders in each bank operate 
in phase with their counterpart, and do not share crank arm angles between cylinder banks.

 l Inline - Inline cylinders share a crankshaft and move in parallel to one another.
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 l V - A vee cylinder arrangement has two banks of cylinders with a shared crankshaft sep-
arated by an angle of 90 degrees.  Crank arm angles are the same for each cylinder pair, 
resulting in a 90 degree phase offset between the first  bank and the second  bank.

 l Operating Speed - The operating speed is the crankshaft speed in RPM for the compressor in 
the current scenario.

 l Bore - The bore is the diameter of each cylinder.
 l Stroke - The stroke is the distance traveled by a piston between TDC and BDC.
 l Rod Length - The rod length is the length of the connecting rod between the rotational axes of the 

connections at the piston and the crank arm.
 l Rod Diameter (Double-Acting Only) - The rod diameter is the diameter of the piston rod, which 

connects the connecting rod to the piston in a double-acting compressor. This term is used is used 
to calculate the volume of the piston rod, which is subtracted from the gas volume for the chamber 
nearest the crankshaft.

 l Cylinder Clearance - The cylinder clearance is the volume of the compression chamber at TDC. 
In a double-acting compressor, this is for the compression chamber facing away from the crank-
shaft.

 l Crank End Clearance (Double-Acting Only) - In a double-acting compressor, this is the volume 
of the crank end compression chamber when the piston is at BDC.

The Crank Angle Data button lists the crank angle for each cylinder relative to the compressor's ref-
erence angle. For opposed and V cylinder arrangements, cylinder numbers alternate between banks so 
that even-numbered cylinders and odd numbered cylinders are in separate banks. The cylinder offsets 
for single-acting compressors are shown in Table 1.

Table 1: List of crank angle offsets for each single-acting cylinder in order of cylinder number based on the 
cylinder arrangement and number of cylinders

Cylinder 
Arrangement 2 4 6

Opposed 0,0 0,0,90,90 0,0,120,120,240,240

Inline 0,0 0,180,180,0 0,120,240,240,120,0

V 0,90 0,90,180,270 0,90,120,210,240,330

Note: The head ends of double-acting compressors have the same offsets, except each cylinder also 
has a crank end that is offset from its head end by 180 degrees.

Initial Conditions

 l Pressure Ratio - The pressure ratio is the ratio of the discharge stagnation pressure to the suc-
tion stagnation pressure for the reciprocating compressor. This is only used directly for steady-
state calculations, and must be greater than one.
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 l Crankshaft Phase Shift - This essentially offsets the phase of the crankshaft by shifting the ref-
erence crank angle. This can be used for offsetting the timing of multiple compressors from each 
other, which is useful when dealing with cylinder timings other than the defaults, for modeling 
reciprocating compressors with multiple compression stages, or modeling cylinders individually 
when modeling manifolds for a reciprocating compressor. This must be a positive number.

While the pressure ratio is not directly used in the transient solution, the steady-state solution is used to 
initialize the Transient Solver. The transient pressure ratio  is dependent on the mass and energy entering 
the reciprocating compressor, the compressor configuration, and the stagnation pressures upstream and 
downstream of the compressor.

Disagreement between the transient and steady-state pressure ratios can contribute to artificial tran-
sients at the initial time steps of a model with reciprocating compressors.

Note: This can be reduced by observing the stabilized transient stagnation pressures and adjusting 
the steady-state pressure ratio accordingly. However, this may result in a lower pressure ratio 
than the real system due to reduced valve losses and will impact the accuracy of steady-state 
results.

Cylinder Gas Volume vs Crank Angle

The Cylinder Gas Volume vs Crank Angle graph shows one period of each compression chamber in the 
model, which is one period per cylinder in a single-acting compressor. This graph provides quick visual 
confirmation that the compressor is set up properly. The volume at each crank angle is determined from 
the cylinder and crankshaft geometry that are defined in the Compressor Configuration section, while the 
shift between the start of each compression chamber's cycle is determined by the Crank Angle Data val-
ues.  Valve opening and closing events are displayed on each plot with X marks. The Crankshaft Phase 
Shift, if applicable, is shown as a vertical line at the crank angle defined by the shift.

The X-Y Data of the plot can be copied and will contain a series for each compression chamber and one 
series for valve timing events. An image of the plot can also be copied.

Crank Angles

Crank angles for valve events are defined relative to a crank angle of 0 degrees at TDC so that the suc-
tion stroke occurs before the discharge stroke, as shown in Figure 2.
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Figure 2: Illustration of suction and discharge strokes with crank angles

All cylinders within a compressor are assumed to obey the same valve timing relative to their individual 
TDC point (or BDC for the crank end of double-acting cylinders), and the valve angle set points must 
therefore be between 0 and 360 degrees.

Related Topics

Pulse Setup Panel 100
Positive Displacement Compressor 260
Fixed Flow Rate Compressor 261
Transient - Setpoint vs. Time 266

Transient - Setpoint vs. Time
When modeling a Fixed Flow Rate Positive Displacement Compressor with a steady setpoint, it is pos-
sible to vary the setpoint over time. This replaces the Speed vs. Time transient as defining both the 
speed and the setpoint would over constrain the system. 

Transient Data

For Setpoint vs. Time, the variation of the setpoint must be directly defined in Transient Data. The selec-
ted parameter will be forced to meet this data at each time step of the transient simulation. The resulting 
speed variation over time will be visible in the output.
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Figure 1: A Setpoint vs. Time transient

Related Topics

Initiation of Transients 227
Positive Displacement Compressor 260
Fixed Flow Rate Compressor 261
Reciprocating Compressor 262

Compressor/Fan Efficiency Data

Note: All efficiency data in the Compressor junction is treated as an isentropic efficiency.

Best Efficiency Point (BEP)

By defining a power or efficiency curve, the Best Efficiency Point of the compressor/fan can be found. 
Optionally, the calculated value can be overridden with a user-defined value on the Configuration Data 
tab on the Compressor/Fan Configuration window. It is generally desirable to operate compressors/fans 
as close to the BEP as possible. The Compressor/Fan Summary tab in the Output can display what the 
BEP is, as well as how far off (in % of BEP) of BEP the compressor/fan is operating in the model.

Nominal Efficiency

When modeling a fixed flow or fixed rise compressor/fan, you can optionally input a nominal efficiency as 
an approximation. This can be useful for sizing or design purposes, although more precise efficiency 
data should be entered when modeling a compressor/fan curve.
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Related Topics

Centrifugal Compressor 249
Affinity Laws 255
Multiple Configurations 256
Transient - Speed vs. Time 259
Compressor Configuration 250

Control Valve
Control Valve junctions are always internal to the system, with two connecting pipes. This junction type 
allows modeling of valves that offer special pressure or flow control characteristics at a location in the 
pipe system.

The Control Valve Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. The Control Valve junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes.

Control Valve Types

xStream offers four types of Control Valves: Pressure Reducing Valves (PRVs), Pressure Sustaining 
Valves (PSVs), Flow Control Valves (FCVs), and Pressure Drop Control Valves (PDCVs). Loss inform-
ation for a Control Valve is not required, because Control Valves are dynamic devices that change their 
geometry in response to the pipe system behavior. The loss that results is that required to maintain the 
control parameter. A Loss When Fully Open can be specified, and is the loss that will occur should the 
valve fail to a full open state.

 l A PRV is a device that controls the pressure in a pipe system. The PRV maintains a constant con-
trol pressure downstream of the junction as long as the upstream pressure exceeds the control 
pressure. If the upstream pressure is lower than the control pressure, the ability to control pres-
sure is lost.

 l A PSV is similar to a PRV in that it controls pressure in a pipe system. While the PRV maintains a 
constant downstream pressure, the PSV maintains a constant upstream pressure. If the down-
stream pressure rises higher than the control pressure, the ability to control pressure is lost.

 l An FCV is a device that maintains a constant flow rate in a pipe system. By setting the junction to 
an FCV type and entering a flow rate, the junction will limit the flow through the connecting pipes to 
be equal to the control flow rate. The FCV can lose its ability to control flow when the pressure 
drop across it becomes zero or backward flow begins.

 l A PDCV is a device that maintains a constant (stagnation) pressure drop. For this option, the 
valve is forced to always meet its setpoint. An indicator that an unrealistic pressure drop has been 
demanded is a failure to obtain a converged solution.
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PRV/PSV Static vs Stagnation Pressure

The control pressure for a PRV or PSV can be either static or stagnation . The default selection is static, 
as this is the most frequent application in industry.

Loss When Fully Open

By default, the valve will be set to model the valve with no loss if it fails open. This can be changed by 
choosing a loss model on the Control Valve Model tab to use Cv, Kv, or a K factor (not applicable for 
PDCV valve types). When Cv, or Kv, is selected, the option becomes available to pull the value from an 
open percentage table on the Optional tab.

Action if Setpoint Not Achievable    

It is possible to build a system where the control valve cannot control the system to the specified setpoint, 
either in the steady-state or during the transient analysis.     

When the control valve cannot meet the specified setpoint in the steady-state system, its behavior will 
depend on why it could not control the system. If the valve was fully open and would need to open further 
to meet the setpoint, the valve will open fully and lose control. An example of this situation is a FCV with 
a setpoint of 100 scfm. If the valve sees 90 scfm at 99.9% open, it cannot control to 100 scfm, will lose 
control, and open fully. In the opposite direction, if the valve was fully closed and would need to close fur-
ther to meet the setpoint, the valve will close fully and lose control. An example of this situation is a PSV 
with a setpoint of 3 atm. If the valve sees 2.5 atm at 0.1% open, it cannot control to 3 atm, will lose con-
trol, and close fully.     

In a transient simulation, a control valve can regain control if system conditions change such that the con-
trol valve can again control to its setpoint.     

Open Percentage Table

The Optional tab allows data to be entered for special control valve characteristics. Specifically, the valve 
Cv and Flow Area can be Specified vs. the Open Percentage of the valve. This data does not affect AFT 
xStream’s flow solution. However, engineers frequently desire to know the valve’s open percentage dur-
ing operation to ensure it meets design requirements. The Valve Summary (in the Output window) 
always displays the valve Cv, and if data is specified for open percentage and flow area it will also display 
open percentage and flow area at the operating point.

AFT xStream can assist in creating this Cv vs Open percent curve. This is accessible in the optional tab 
by selecting "Edit Table" and then "Create Cv vs. Open Percent...". This then opens a window in which a 
user defined, linear, equal percentage, or Pre-defined curve can be defined and transferred to the Cv vs. 
Open Percentage table.
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Special Conditions             

Control Valves have the following Special Conditions: Fully Open - No Control, or Closed.

 l Closed - No flow is allowed through the Control Valve.
 l Fully Open - No Control (can regain control) - Starts in the Fully Open position and uses the 

Loss When Fully Open value from the Control Valve Model tab of the Properties window (or Con-
trol Setpoint for the PDCV valve type). Throughout the simulation, the Control Valve can regain 
control if applicable.

 l Fully Open - Never Control - Remains in the Fully Open position for the entire simulation and 
uses the Loss When Fully Open value from the Control Valve Model tab of the Properties window 
(or Control Setpoint for the PDCV valve type).

Related Topics

Common Junction Input Parameters 211
K Factor Loss Model 217
Cv/Kv and XT Loss Model 220
Junction Transient Data 225

Control Valve Transient Theory
We can use the methods for known flow or pressure to calculate the conditions at a control valve. AFT 
xStream flow and pressure control valves allow the control setting to be changed with time. Whether con-
stant or changing, the flow or pressure is known and can be used to solve the equations.             

Flow Control Valves             

With the known flowrate, one can substitute into the Compatibility Equations and solve for the upstream 
and downstream pressures, respectively, at the valve. The valve loss solution can then be compared 
against the user-specified loss range to determine if the valve can control to the setpoint for that time 
step.    

Once the valve loses control, it acts like a regular valve. However, it is possible for the control valve to 
later regain control if the upstream pressure raises sufficiently.             

Pressure Control Valves             

Pressure control can be specified on the upstream or downstream side of the valve, or as a differential 
pressure across the valve. All three control types use identical approaches to find a solution at each time 
step which satisfies the control setpoint.             

An iterative approach is required to find a solution that meets the controlled parameter. A flowrate 
through the valve is guessed at, the positive characteristic is used to determine the upstream pressure, 



Defining Junction Transients

- 271 -

and the negative characteristic used to determine the downstream pressure. The upstream or down-
stream pressure is compared against the valve setpoint, and further iterations are used to find a flow solu-
tion which meets the setpoint.     

If the valve is fully open or fully closed yet cannot meet the control setpoint, the valve will lose control and 
behave as a regular valve. It is possible for the control valve to later regain control if the upstream pres-
sure raises sufficiently. Note that the Pressure Drop Control Valve will never lose control and open fully, 
as there must be a control pressure loss by definition. 

Related Topics

Nomenclature 448
Method of Characteristics 473

Dead End
The Dead End junction must always have one connecting pipe. This junction type is one way to define 
flow in a pipe as truly zero.

In steady flow, dead ends have no flow and thus play no role in the solution to the system. However, in 
transient flow pipes that terminate in dead ends can have flow. Thus dead ended lines can and do influ-
ence the transient response of the system. Unless you know otherwise for a specific system, dead ends 
should always be included in the model.

The Dead End Properties window follows the first of the two basic Properties window formats, displaying 
the connecting pipes in a fixed format. The only required information is the connecting pipe and the elev-
ation.

Related Topics

Common Junction Input Parameters 211

Dead End Transient Theory
A dead end is similar to an assigned flow, except the flow rate is zero (Wylie, et al., 1993, pp. 44). The 
unknown is then the pressure, which can be solved by calling the appropriate compatibility equation. If 
the dead end is at the upstream end of the pipe, the negative wave compatibility equation is used with 
zero flow.

Conversely, if the dead end is at the downstream end, the positive wave compatibility equation is used 
with zero flow.
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The path characteristic becomes completely vertical, but is still represented by the particle path com-
patibility equation, using the pressure from the appropriate wave compatibility equation.

Related Topics

Nomenclature 448
Method of Characteristics 473
References 499

General Component
The General Component junction type is internal to the system and requires two connecting pipes. This 
junction type allows you to model the irrecoverable loss that occurs through equipment that may not be 
explicitly represented on the Toolbox and to specify loss factors as a function of a flow parameter.

The General Component Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. The flow direction through the junction is determined by 
the defined directions of the connecting pipes.

When you select Resistance Curve, the General Component Properties Window makes additional fea-
tures available. You can specify polynomial constants, fit a curve to available data, or use interpolated x-
y data.

When a variable loss is specified, AFT xStream modifies the loss factor in the Solver to agree with the 
solution. You can choose any of the optional flow and pressure parameters provided, and you can spe-
cify the most convenient units.

No transient data can be entered for a General Component. From a transient point of view, the junction is 
a static element.

An optional input in the General Component Properties window is the CdA. This parameter describes an 
effective area restriction for the purpose of calculating sonic choking. In most cases, information on the 
CdA must be obtained from  the manufacturer or from test data.

Related Topics

Curve Fitting 75
Common Junction Input Parameters 211
K Factor Loss Model 217
Resistance Curve Loss Model 223
Troubleshooting Resistance Curves 565
Reference Density 213



Defining Junction Transients

- 273 -

Heat Exchanger
The Heat Exchanger junction type is internal to the system and requires two connecting pipes. This junc-
tion models the irrecoverable loss that occurs through heat exchanger equipment along with a known 
heat rate added to or removed from the fluid.

The Heat Exchanger Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. The flow direction through the junction is determined by 
the defined directions of the connecting pipes.

Heat Transfer

On the Thermal Data tab you can define a fixed heat rate into the system.

Note that similar to flow rate definition, heat flow is positive when flowing into the system, and negative 
when flowing out.

Transient Data

On the Transient Data tab, a heat rate transient can be entered. Note that if there is a heat rate and flow 
through the junction reaches zero (either because flow is halted or because flow reverses), the solution 
will fail as heat can no longer flow out of the junction, causing heat to accumulate infinitely. For more 
information on transient data, including event transients, see Junction Transient Data.

Special Conditions

The Special Condition for a Heat Exchanger junction functions differently than other junctions. Here you 
can turn off the heat transfer for the heat exchanger. 

Related Examples

Gas Turbine Fuel System Example 623

Related Topics

Curve Fitting 75
Common Junction Input Parameters 211
K Factor Loss Model 217
Junction Transient Data 225
Reference Density 213
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Orifice
The Orifice junction type requires two connecting pipes, unless it is defined as an exit orifice, in which 
case only one connecting pipe is allowed. This junction type models the irrecoverable loss that occurs 
through a plate-type flow restriction. It also allows the specification of loss factors as a function of a flow 
parameter and an orifice loss for pipes with an area change.

The Orifice Properties window follows the first of the two basic Properties window formats, displaying the 
connecting pipes in a fixed format. The Orifice junction does not have an explicit flow direction, but 
adopts a flow direction from the connecting pipes.

Orifices that are located at exit points are specified as exit orifices. These orifices require an associated 
back pressure definition. Exit orifices can only be connected to a single upstream pipe. To specify an exit 
orifice, select the Exit Orifice checkbox on the Loss Model tab. Then specify the exit pressure and tem-
perature.

Orifice Types

AFT xStream provides two standard orifice types: Sharp-Edged and Round-Edged. These loss factors 
are calculated based on correlations. In addition to the standard orifices that AFT xStream provides, 
users can enter  custom orifice loss factors.

The constant loss characteristics of an orifice can be specified as a discharge coefficient (Cd) or as a loss 
factor (K). The standard orifice geometries include a functional dependence on the upstream and down-
stream pipe areas, which may be different. 

An optional input in the Orifice Properties window is the CdA for Sonic Choking. This parameter 
describes the effective area restriction in the orifice for the purpose of calculating sonic choking. In most 
cases, information on the CdA must be obtained from handbook or test data.

Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in 
xStream. The discharge coefficient can vary at different pressure ratios due to the vena con-
tracta moving closer to or farther from the orifice restriction.  For the highest accuracy the CdA 
used for subsonic and sonic losses should be tested and entered separately. See the "Modeling 
Choked Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics

Common Junction Input Parameters 211
Discharge Coefficient Loss Model 216
Subsonic vs. Sonic Pressure Losses 493

https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice


Defining Junction Transients

- 275 -

Orifice Loss Model

Sharp-Edged Orifice             

The orifice loss factors are all for turbulent Reynolds numbers. The sharp-edged orifice shown in Figure 
1, is given by the following equation(Idelchik 2007, 259):    

Figure 1: Sharp-edged orifice (in this case Aup = Adown)

Round-Edged Orifice with Different Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are different for a round-edged orifice as shown in 
Figure 2, the round-edged orifice equation for different pipe areas is used and is given by the following 
(Idelchik 2007, 258)

where
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Figure 2: Round-edged orifice with different upstream and downstream pipe areas

Round-Edged Orifice with Identical Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are the same for a round-edged orifice as shown in 
Figure 3, the round-edged orifice equation for the same pipe areas is used and is given by the fol-
lowing (Idelchik 2007,262)

where

Figure 3: Round-edged orifice with the same upstream and downstream pipe areas

For other orifice configurations, see Chapter 4 of Idelchik's Handbook of Hydraulic Resistance (2007).

Other Loss Models

For information on the discharge coefficient loss model see the Discharge Coefficient Loss Model topic. 
For information on the orifice loss when the flow is choked see the Sonic Choking description.

Related Topics

K Factor Loss Model 217
References 499
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Relief Valve
The Relief Valve junction allows users to model a device that opens at a specified pressure in the sys-
tem.             

The Relief Valve Properties window follows the first of the two basic Properties Window formats, dis-
playing the connected pipes in a fixed format. The Relief Valve junction adopts a flow direction from the 
connecting pipes.

A Relief Valve junction in AFT xStream will always behave as an Exit Rupture Disk, with the relief valve 
located at the end of a pipe leg. Below the Set Pressure, the valve is closed and behaves as a Dead End. 
When the Set Pressure is reached, the valve will instantly open and remain open for the rest of the MOC 
Transient simulation. If the valve is open during the AFT Arrow Steady Solution, it will remain open for the 
entire MOC Transient simulation.    

Valve Setpoints

The valve setpoints determine when the relief valve will open. These setpoints are defined using pres-
sure. 

There are two setpoints the user needs to define:

 l Exit Pressure - the ambient pressure downstream of the relief valve when open.
 l Set Pressure - the upstream pressure at which the valve opens.

Note: The Relief Valve junction operates exclusively using stagnation pressure. The Set Pressure 
and Exit Pressure are defined as stagnation pressures and all calculations are based on stag-
nation pressure.             

Loss Model             

The Relief Valve loss information is entered on the Loss Model tab. The Basis Area for each Loss Model 
is by default the upstream pipe.    

The following loss model options are available:             

 l CdA (Constant) - the relief valve instantly changes from closed to a fixed CdA. This CdA is 
defined as the product of an Orifice Effective Area (A) and a Discharge Coefficient (Cd).                 

 l The Orifice Effective Area can come from an API 526 letter designation or it can be User 
Specified.                     

 l The Discharge Coefficient must always be specified by the user. The value is typically spe-
cified by the manufacturer.                     

 l K Factor - the relief valve instantly changes from closed to a fixed K Factor. 
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Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in 
xStream. The discharge coefficient can vary at different pressure ratios due to the vena con-
tracta moving closer to or farther from the orifice restriction.  For the highest accuracy the CdA 
used for subsonic and sonic losses should be tested and entered separately. See the "Modeling 
Choked Flow Through an Orifice" white paper on AFT's website for more information.                

Special Conditions

The relief valve has two Special Conditions:

 l Failed Open - the valve is forced to remain open regardless of pressure conditions.
 l Ignore Relief Valve - the valve is forced to remain closed regardless of pressure conditions.

For more information see Special Conditions.

Related Topics

Common Junction Input Parameters 211
Discharge Coefficient Loss Model 216
Subsonic vs. Sonic Pressure Losses 493
K Factor Loss Model 217
Junction Transient Data 225
Initiation of Transients 227
References 499

Relief Valve Transient Theory
The Relief Valve junction in AFT xStream allows users to model a rupture disk in the system, and 
behaves similarly to a regular exit valve. When closed, the relief valve behaves identically to a closed exit 
valve or a dead end. When open, the relief valve relieves to the user-specified Exit Pressure.             

When the Relief Valve junction is defined using the CdA Subsonic Loss Model, the losses across the 
junction are determined as described in the Discharge Coefficient Loss Model topic.     

When the Relief Valve junction is defined using the K Factor Subsonic Loss Model, the losses across the 
junction are determined as described on the K Factor Loss Model topic. 

Related Topics

Method of Characteristics 473

Screen
The Screen junction type requires two connecting pipes. This junction type allows you to model the irre-
coverable loss that occurs through a screen, mesh, or filter flow restriction. It also allows you to specify 
loss factors as a function of a flow parameter.

https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
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The Screen Properties window follows the first of the two basic Properties window formats, displaying the 
connecting pipes in a fixed format. The Screen junction does not have an explicit flow direction; it adopts 
a flow direction from the connecting pipes.

AFT xStream provides four standard screen types for your use: sharp-edged perforated plate, round-
edged perforated plate, circular wire screen, and silk thread screen. The loss factors for these screens 
are taken from handbook values. In addition to the standard screens that AFT xStream provides, you 
may enter your own custom screen loss factor that is consistent with the application.

When you select Resistance Curve, the Screen Properties window makes additional features available. 
Using these new features you can input Screen loss factors or pressure drops that vary with flow. To 
enter these factors, you can fit a curve to available data, or use interpolated x-y data. You can choose 
any of the optional flow and pressure parameters provided; you can also specify the most convenient 
units.

When a variable loss is specified, AFT xStream modifies the loss factor in the Solver to agree with the 
solution. You can choose any of the optional flow and pressure parameters provided, and you can spe-
cify the most convenient units.

CdA for Sonic Choking

An optional input in the Screen Properties window is the CdA. This parameter describes the effective 
area restriction in the screen for the purpose of calculating sonic choking. In most cases, information on 
the CdA must be obtained from the vendor or test data.

Related Topics

Common Junction Input Parameters 211
Subsonic vs. Sonic Pressure Losses 493

Screen Loss Model
The screen loss factors have much in common with orifice loss factors. In fact, the sharp-edged per-
forated plate and round-edged perforated plate screen losses are the same as for orifices with similar 
area ratios and equal upstream and downstream areas. Refer to the orifice loss factor equations for 
these relationships. The relationships are good for screen area Reynolds numbers above 100,000.

The circular metal wire screen, shown in Figure 1, is given by the following equation for screen area 
Reynolds numbers above 1000 (Idelchik 2007, 598):
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Figure 1: Circular metal wire screen

The silk thread screen, shown in Figure 2, is given by the following equation for screen area Reynolds 
numbers above 500 (Idelchik 2007, 598):

For other screen configurations, see Chapter 8 of Idelchik's Handbook of Hydraulic Resistance (2007).

 
Figure 2: Silk thread screen

Related Topics

References 499

Tank
The Tank junction type allows you to connect up to twenty-five pipes. A minimum of one connecting pipe 
is required.

The Tank Properties window follows the second of the two basic Properties window formats.

Tank Model

There are two possible Tank Models available in the Tank junction, Infinite Tank and Finite Tank.
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 l Infinite Tank - Infinite tanks refer to a massive volume of gas whose pressure and temperature do 
not change appreciably as a result of gas inflow or outflow during the time frame of the simulation. 
An example is a large room or the atmosphere. The Infinite Tank model is convenient for spe-
cifying a fixed pressure in your system. This tank model applies a defined pressure at the junction 
location in the model. When solving a pipe flow system, an Infinite Tank causes the rest of the sys-
tem to distribute the flow in a manner consistent with the defined pressure.

 l Finite Tank - Finite tanks refer to a body of fluid which is small enough that its pressure and tem-
perature change significantly during the time frame of the simulation as a result of gas inflow or 
outflow. An example is a tank which is pressurized by a compressor as the simulation progresses. 
Finite tanks require specification of tank geometry. Typically, the pressure and temperature are 
defined initially, and then calculated over time based on the tank geometry.

Both tank models will require the initial stagnation pressure and stagnation temperature/enthalpy to be 
defined.

If the Finite Tank option is chosen, then the volume and thermodynamic behavior of the tank become 
required inputs as discussed below.

Known Parameters Initially

For the Finite Open Tank option, the options become active to specify whether the pressure and tem-
perature are defined by the user for the steady state.

 l Initial Conditions Known - This option should always be chosen for tanks at the inlet or outlet of 
the system which are acting as boundaries, Or for tanks with a known operating temperature and 
pressure in the steady state.

 l Initial Conditions Calculated From Steady State - This option should be used for tanks that are 
inline or at intermediate points in the system at which the pressure and temperature are not 
known.

Thermodynamic Process

The tank thermodynamics can be specified using one of three options:

 l Adiabatic - The static enthalpy and volume in the tank will be fixed based on the user specified ini-
tial conditions in the tank. The variation in all other parameters will be calculated throughout the 
transient.

 l Isothermal - The temperature and volume in the tank will be fixed based on the user specified ini-
tial conditions in the tank. The variation in all other parameters will be calculated throughout the 
transient.

 l Known Heat and Volume vs. Time - The heat rate and volume are explicitly defined by the user 
throughout the transient. The variation in all other parameters will be calculated throughout the 
transient.

Related Topics
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Role of Pressure Junctions - Detailed Discussion (Long) 518
Role of Pressure Junctions and How They Work 70
Assigned Pressure 238
Common Junction Input Parameters 211

Tank Transient Theory
An infinite tank is equivalent to an Assigned Pressure junction defined with a stagnation pressure. The 
solution for a finite tank is more complex, and is discussed below.

Adiabatic Finite Tank 

For a finite tank a fixed volume is known, along with an initial stagnation pressure and tem-
perature/enthalpy. The known values can be used to calculate initial values for the density, enthalpy, and 
energy.

(1)

(2)

(3)

The total mass and energy in the tank is calculated at the current time step, and the mass flow rate and 
energy flow rate out of the tank is assumed to be constant between the old and current time step. This 
assumption is reasonable when the time step is reasonably small, and the parameters in the tank are 
changing relatively slowly. With the known tank mass and the constant tank volume the density can be 
calculated for the current time step using Equation 2. The pressure and temperature are related to the 
total energy using Equations 1 and 3 as shown above. We can iterate on the pressure and temperature 
to solve these equations.. After each iteration the new pressure and temperature are used to recalculate 
the density, which is checked against the density calculated previously from Equation 2 to confirm when 
the iteration is complete.

Once the pressure and temperature have been calculated for the current time step, the new pressure 
and temperature can be used to calculate how the mass flow rate and energy flow rate will change for the 
future time step t + 1.

Isothermal Finite Tank

The isothermal tank solution will proceed similar to the adiabatic finite tank solution outlined above. 
However, in this case the temperature is fixed as well as the volume.
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The mass at the current time step can be calculated assuming the mass flow rate from the previous time 
step remained constant. The mass and volume can then be used to calculate the density at the current 
time step, which can be used to iterate on the enthalpy state equation which is represented by Equation 1 
above.

Once the pressure has been calculated for the current time step, the new pressure and temperature can 
be used to calculate how the mass flow rate and energy flow rate will change for the future time step t + 1.

Known Heat and Volume vs Time

The Known Heat and Volume vs. Time option allows the user to specify the tank volume over time plus 
an external rate of heat added to (or removed from) the tank. A similar process to the Adiabatic Finite 
Tank solution is used, where the external heat rate is used along with the mass flow into and out of the 
tank to determine the new pressure, temperature, and enthalpy inside the tank. The known tank volume 
is also coupled into the solution to iterate on tank mass and gas density as the tank volume changes.

Sonic Choking Transient Theory

An outlet tank junction can experience endpoint choking during the steady state, or can become choked 
during the transient due to transient events in the system. If sonic choking occurs at the tank junction  a dif-
ferent solution method must be enacted. See Transient Sonic Choking for more information.

Related Topics

Nomenclature 448
Method of Characteristics 473
Sonic Choking Detailed Description 488

Tee/Wye
The Tee/Wye junction type requires three connecting pipes.              

Loss Factor             

The Tee/Wye is modeled as a Branch with no loss factors entered for the connecting pipes. 

Related Topics

Common Junction Input Parameters 211

Tee/Wye Transient Theory
The Tee/Wye junction is a static element, and its solution method is  the same as the Branch junction.             
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Related Topics

Method of Characteristics 473

Valve
The Valve junction type requires two connecting pipes, unless you specify it as an exit valve, in which 
case only one connecting pipe is allowed. This junction type allows you to model the irrecoverable loss 
that occurs through a flow control component. The Valve Properties window follows the first of the two 
basic Properties window formats, displaying the connecting pipes in a fixed format. A flow direction 
through the junction is adopted from the defined directions of the connecting pipes. You also have the 
ability to change the loss with time to open or close the valve in full or in part.

Loss Source

In order to completely define a valve junction, you must specify the valve loss source by clicking on the 
appropriate radio button under Loss Source:

 l User Specified -  This is the best option if manufacturer data is known. Manually input the loss 
information using one of the Loss Models listed in the next section.

 l From Characteristic - This option is useful if no information about the valve is known aside from 
the type, and an estimate needs to be made. Automatically calculate Cv based on the selection of 
a common valve geometry type and a Full Open Cv value. With the exception of the User Defined 
characteristic from the dropdown, the window will automatically populate an Open Percent vs Cv 
data table by scaling the shape of the characteristic curve to fit the provided Full Open Cv. Then, 
choose an Open Percentage under the Loss Parameters area to automatically calculate a Cv. The 
data for the characteristic shapes comes from Val-Matic 2009.

 l Handbook - Uses standard valve loss models from Idelchik, Miller, and Crane.

Loss Model

Depending on the selection of the Loss Source, various loss models will be displayed:

 l Flow Coefficient - Cv for English units or Kv for Metric units, and XT (the terminal pressure drop 
ratio) will be required to check for sonic choking

 l K Factor
 l Resistance Curve

A special Reduced Port configuration is available when using the Handbook loss source, and requires 
the selection of a valve type and several geometric inputs. Once specified, a K Factor from the Handbook 
source will be calculated.
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Exit Valves

Valves that are used as exit flow control mechanisms are specified as Exit Valves. These valves require 
an associated ambient pressure definition (also called a back pressure). Exit valves can only be con-
nected to a single upstream pipe. To specify an Exit Valve, select the Exit Valve checkbox, and input the 
required Exit Pressure and Exit Temperature.

Sonic CdA & Optional Losses

The optional inputs in this expandable section depend on which loss model is selected:

 l Sonic CdA - Optional input that is only available for the K Factor, Resistance Curve, and 
Reduced Port loss models. This parameter describes the effective area restriction in the valve for 
the purpose of calculating sonic choking. In most cases, information on the CdA must be obtained 
from the manufacturer or test data.

 l Basis Area - See the topic on Specifying Basis Area.

Open Percentage Data

Optional data may be entered for special valve characteristics. Specifically, the Open Percentage vs Cv , 
XT, and Flow Area can be specified. This data does not affect the Solver’s flow solution; however, engin-
eers frequently desire to know the valve’s open percentage during operation to ensure it meets design 
requirements. The Valve Summary in the Output window always displays the valve Cv, and if data is spe-
cified for open percentage and flow area it will also display open percentage and flow area at the oper-
ating point. A graph of the open percentage, Cv, and flow area data can be displayed by selecting the 
Characteristic Graph tab below the table.

The Characteristic Source parameters can be used to create an Open Percent vs Cv curve that follows 
the shape of several common valve types including Ball, Butterfly, Equal Percentage, Globe, Linear, 
Plug, and Quick Opening.

Transient Data

On the Transient tab, a transient Cv and XT vs time or K Factor and CdA vs time table can be entered to 
simulate the opening or closing of the valve. If the optional open percentage table is entered, it can also 
be used to specify an open percent vs time transient. For a closed valve, the K Factor is infinite. To 
account for this, a K Factor of -1 (negative one) can be used in the transient data table. For more inform-
ation on transient data, including event transients, see the Junction Transient Data topic.

Special Conditions

The Special Condition on the Optional tab allows the valve to be specified as Closed, which is useful to 
turn off a valve while retaining the input data for future use.
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Related Topics

Common Junction Input Parameters 211
K Factor Loss Model 217
Cv/Kv and XT Loss Model 220
Junction Transient Data 225
References 499

Related Examples

Gas Turbine Fuel System Example 623

Venturi
The Venturi junction type requires two connecting pipes. This junction type allows you to model the irre-
coverable loss that occurs through a venturi area change, which is frequently used in conjunction with 
pressure taps in flow measurement devices. It also allows you to specify loss factors as a function of a 
flow parameter.

The Venturi Properties window follows the first of the two basic Properties window formats, displaying the 
connecting pipes in a fixed format. The Venturi junction does not have an explicit flow direction, but 
adopts a flow direction from the connecting pipes.

Loss Models

AFT xStream does not provide any standard venturi loss models. Venturi flow characteristics vary from 
vendor to vendor, so it is difficult to find generally applicable models. You must enter your own custom 
venturi loss factor that is consistent with the application. This information should be obtained from the 
manufacturer or from test data.

For convenience, you can specify constant loss characteristics of a venturi as a discharge coefficient 
(Cd) or as a loss factor (K). 

If you would like to model the pressure loss through the Venturi as varying with the flow rate, select the 
radio button next to Resistance Curve under the Loss Model tab of the Venturi Properties window. Once 
Resistance Curve is selected, additional features appear that allow you to input pressure drops versus 
flow data. To enter this data, you can specify polynomial constants, fit a curve to available data, or use 
interpolated x-y data. 

When a variable loss is specified, AFT xStream modifies the loss factor in the Solver to agree with the 
solution. You can choose any of the optional flow and pressure parameters provided, along with the most 
convenient units.
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CdA for Sonic Choking

An optional input in the Venturi Properties window is the CdA for sonic choking. This parameter describes 
the effective area restriction in the venturi for the purpose of calculating sonic choking. In most cases, 
information on the CdA must be obtained from test or manufacturer data.

Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in 
xStream. The discharge coefficient can vary at different pressure ratios due to the vena con-
tracta moving closer to or farther from the orifice restriction.  For the highest accuracy the CdA 
used for subsonic and sonic losses should be tested and entered separately. See the "Modeling 
Choked Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics

Common Junction Input Parameters 211
Subsonic vs. Sonic Pressure Losses 493

 

https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
https://www.aft.com/white-papers/modeling-choked-flow-through-an-orifice
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Interface and User Options
This section focuses on the how the items within the various menus and tabs that comprise AFT xStream 
can be used to customize the user's experience within the software. Topics discussed include the 
options present in each of the drop-down menus, the tools available in the Primary Window tabs, and 
descriptions of the customizable parameters in the User Options menu. 

Contents

Menus and Toolbars 288

Printing 298

Primary Window Overview 300

Status Bar 301

Quick Access Panel 302

Model Status Light 312

Solution Progress Window 312

Workspace Window 312

Model Data Window 332

Output Window 336

Graph Results Window 347

User Options Overview 367

Menus and Toolbars
Many of the actions required to set up an AFT Impulse model can be completed from the various menus 
located at the top of the window. Additionally, these menus can provide helpful features such as saving, 
importing and exporting files, and accessing various help documents such as the product help files and 
examples. These menus include

 l The File menu
 l The Edit menu
 l The View Menu
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 l The Analysis menu
 l The Tools menu
 l The Library menu
 l The Arrange menu
 l The Window menu
 l The Help menu

This topic also gives a high level overview of Toolbars, including the Main Toolbar as well as each 
Primary Windows toolbar.

File Menu
 l New - Opens new model.
 l Open - Calls Open file common dialog window so pre-existing model can be selected for opening.
 l Save - Saves input model to disk using current model file name.
 l Save As - Opens Save As common dialog so you can specify a file name to save model to disk.
 l Save Graph As - (Graph Results Only) - Opens Save Graph As common dialog so user can spe-

cify a file name to save graph as a graphics image file to disk.
 l Save Graph Data As - (Graph Results Only) - Opens Save Graph Data As common dialog so 

user can specify a file name to save graph x-y data to text file on disk.
 l Import Graph Data - (Graph Results Only) - Allows for data as .txt and .dat to be imported for cre-

ating graphs
 l Export Model Data - (Model Data Only) - Opens formatting window and Save As dialog where 

you can specify data from the Model Data window to be saved to a delimited file appropriate for 
spreadsheet use. Available in Model Data window.

 l Export Output - (Output Only) - Opens formatting window and Save As dialog where you can spe-
cify data from the Output window to be saved to a delimited file appropriate for spreadsheet use.

 l Export Force File - (Output Only) - Opens Export Force File window for the selected file type 
from those shown below.

 l CAESAR II Force File
 l TRIFLEX Force File
 l ROHR2 Force File
 l AutoPIPE Force File

 l Import Excel Change Data - (Workspace and Model Data Only) - Imports data from Excel file 
which modifies certain input data. See Importing Excel Data for more info.

 l Excel Export Manager - Opens the Excel Export Manager.
 l Merge - (Workspace Only) - Opens a Merge dialog where you can specify another model file to 

merge into the current model.
 l Print Preview - Opens Print Preview which allows you to specify special formatting for printed 

graphics and text, as well as preview printed content before sending it to the printer.
 l Start Batch Run - The Start Batch Run button on the File Menu opens a Batch Run dialog where 

you can select a different scenarios or models and initiates a process whereby xStream runs the 
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multiple scenarios/models automatically. This tool can also be used to export output to Excel 
using the settings already configured in the Excel Export Manager.

 l Load Background Picture - (Workspace Only) - Loads a background picture into the Work-
space. Formats supported include bitmap, windows metafile, enhanced metafile, JPEG, GIF and 
RLE. Available in Workspace window.

 l Import Piping Layout From
 l Piping Component File (PCF) - Import a Piping Component File
 l Caesar Neutral File (CII) - Import a Caesar Neutral File
 l GIS Shapefile (SHP) - Allows for Importing GIS Shapefile (geospatial maps) as .shp file.
 l EPA Net File (INP) - Import an EPA Net File

 l Export Piping Layout To
 l EPA Net File (INP) - Export an EPA Net File

 l Exit - Exits AFT xStream.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Edit Menu
 l Undo - (Workspace Only) - Undoes the previous workspace manipulation action. xStream will 

keep track of a historical list of changes, and users can revert the workspace back to any of those 
previous states.

 l Redo - (Workspace Only) - Reverts the workspace following Undo actions. xStream will keep 
track of undo actions, and users can redo any changes that have been undone.

 l Cut - (Workspace Only) - Cuts the selected pipes and junctions on the Workspace and places 
them on the clipboard.

 l Copy - (Workspace, Model Data, and Graph Results Only) - Copies the selected window contents 
to the clipboard.

 l Copy Graphics - (Workspace Only) - Copies selected Workspace content to the Windows clip-
board. Formats supported include bitmap, windows metafile, and enhanced metafile.

 l Copy X-Y Data - (Graph Results Only) - Copies numerical data from graph to the Windows clip-
board. Available in the Graph Results window.

 l Paste - (Workspace Only) - Pastes clipboard pipes and junction contents (from previous cut or 
copy operation) into the Workspace model. Paste preview mode allows the pasted pipes and junc-
tions to be moved and specifically placed where desired and will indicate interference with other 
junction by changing color. A green box indicates that there is no interference and a red box indic-
ates that the junctions will be overlapping and are not in a proper location. Available in the Work-
space window.

 l Delete - (Workspace Only) - Deletes the selected pipes and junctions on the Workspace.
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 l Duplicate - (Workspace Only) - Duplicates the selected pipes and junctions on the Workspace.
 l Duplicate Special - (Workspace Only) - Opens Duplicate Special dialog window where you can 

specify the increment by which all pipes and junction numbers will be increased when the model is 
duplicated, the creation of a new group from the duplicated objects, and whether to hide the duplic-
ated objects in the output.

 l Select All - (Workspace Only) - Selects all pipes and junctions on the Workspace.
 l Select Last Selection - (Workspace Only) - The most recent pipes and/or junctions selected may 

be reselected by selecting Select Last Selection from the Edit menu.
 l Select Special - (Workspace Only) - Opens Select Special window where group of pipes and junc-

tions can be built up.
 l Select Flow Path - (Workspace Only) - Selects the sequence of pipes and/or junctions in the flow 

path connected to the selected pipe(s) on the Workspace.
 l Select Shortest Path - (Workspace Only) - The shortest flow path between two junctions can be 

found and selected by xStream. To enable this option, two junctions must be selected in the Work-
space which xStream will find a path between.

 l Customize Icon - (Workspace Only) - Allows user to change junction icon color, orientation, and 
icon image.

 l Special Conditions - (Workspace Only) - Sets or clears Special Conditions for selected pipes 
and junctions on the Workspace.

 l Groups - (Workspace Only) - Allows you to create and manage groups of pipes and junctions.
 l Renumber - (Workspace Only) - Allows renumbering pipes and junctions on the Workspace using 

one of the Renumbering methods.
 l Join Selected Pipes/Jcts - (Workspace Only) - A continuous series of connected pipes and junc-

tions can be combined into a single pipe object to simplify the Workspace. See Joining and Split-
ting Pipes.

 l Global Pipe Edit - (Workspace and Model Data Only) - Opens Global Pipe Edit window where 
editing of multiple pipes can be performed.

 l Global Junction Edit - (Workspace and Model Data Only) - Opens Global Junction Edit window 
where editing of multiple junctions can be performed.

 l Transfer Results to Initial Guesses - (Output Only) - Copies solution results into initial guesses 
for pipes and junctions.

 l Make Selection Same As Parent - (Workspace Only) - Replaces all input data for the selected 
pipes/junctions with data from the pipes/junctions in the current scenario's parent.

 l Clear Initial Guesses - Clears all initial guesses in pipes and junctions.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347
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View Menu
 l Last View - (Workspace Only) - Switches to the most recent Workspace view. The view is 

changed by scrolling, zooming or using the Workspace Find. The Last View in the View Menu will 
take you back to the previous view of the Workspace. You can toggle between two views by con-
tinuously clicking Last View.

 l Select Objects - (Workspace Only) - Changes cursor to selection tool to select junctions, pipes, 
etc.

 l Overview Map - (Workspace Only) - Opens overview map in the Quick Access Panel.
 l Workspace Pan - (Workspace Only) - Changes cursor to pan tool to move around workspace.
 l Show Magnifier - (Workspace Only) - Turns on the Magnifier Tool in the Workspace.
 l Show Object Status - (Workspace Only) - Toggles Show Object Status, which checks status of 

all pipes and junctions in model.
 l List Undefined Objects - (Workspace Only) - Opens Undefined Objects window which displays 

undefined pipes and junctions and their properties.
 l Extended Model Check - Performs and exhaustive check of model consistency and com-

pleteness.
 l Highlight in Pipe and Jct Windows - (Workspace Only) - Toggles Highlight feature for pipe and 

junction Properties windows.
 l Bookmarks - (Workspace Only) - Allows creation and management of bookmarks.
 l Find - (Workspace Only) - Opens window to find specific pipes and junctions.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Analysis Menu
 l Analysis Setup- Opens theAnalysis Setup window.
 l Time Simulation- Allows selection of theSimulation Mode used to run the model.
 l Pulsation Frequency Analysis - (PFA Module Only) - Allows pulsation analysis settings to be 

ignored or used in the model.
 l Run Model- When the model is complete, the Run Model selection sends the model to the Solver 

for solution.

Related Topics

Workspace Window 312
Model Data Window 332
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Output Window 336
Graph Results Window 347

Tools Menu
 l Scenario Manager - Opens the Scenario Manager window.
 l Last Scenario - Switches back to the previously loaded scenario.
 l Compare Scenarios - Quickly sets up a comparison between the current scenario and a related 

scenario.
 l Scenario Comparison Tool - Opens the Scenario Comparison Tool window, allowing users to 

compare differences between any two or more scenarios in a model.
 l Integration Query - Opens the Integration Query window, allowing users to have xStream per-

form a numerical integration of results over specified time frames.
 l Output Control - Opens the Output Control window.
 l Output Print Content - (Output Only) - Configures what content can be printed from the Output 

window.
 l Output Language - Selects the display language for certain phrases in the Output window, 

Graph Results window, and the labels in Workspace Layers.
 l Model Data Control - (Model Data Only) - Opens the Model Data Control window.
 l Model Data Print Content - (Model Data Only) - Configures what content can be printed from the 

Model Data window.
 l Select Graph Parameters - (Graph Results Only) - Opens window to allow user to select which 

parameters to graph.
 l Quick Graph Formatting - (Graph Results Only) - Opens window to allow user to change quick 

graph title and axis names, fonts, and scale values.
 l Design Alerts - Opens the Design Alerts window.
 l Multi-Condition Events - Opens the Event Manager window which allows users to make tran-

sients that are triggered by more than one parameter condition in the model.
 l Fluid Property Viewers - Gives options to open either the SteamCalc Viewer or Chempak 

Viewer. These are separate executables bundled with the software. Chempak Viewer requires a 
license.

 l Activate Modules - Opens the Modules panel in Analysis Setup where optional add-on modules 
can be activated or deactivated.

 l eLicense Information - Visible if AFT xStream was opened using an eLicense - shows general 
information about the eLicense.

 l Keep Network eLicense Checked Out - If a network eLicense is used, it can be kept Checked 
Out to this machine. This will prevent it from being lost when going offline, and prevent it from 
being accessible by other users. The license will be good for the Checkout Period - generally one 
week  but depends on the specific company license.

 l Model Diagnostics - Opens the Model Diagnostics window which provides troubleshooting 
information.

 l Custom Units - Allows custom unit names to be enabled or disabled. Custom unit names can be 
defined in the User Options under the Unit System section.

 l User Options - Opens the User Options window.

https://docs.aft.com/steamcalc/Content/What_Does.html
https://docs.aft.com/chempakviewer3/Content/What_Chempak_Viewer_Does.html
https://docs.aft.com/chempakviewer3/Content/What_Chempak_Viewer_Does.html
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Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Library Menu
 l Add Junction to Library - (Workspace Only) - Prompts you to enter the name to be used in the 

Junction Library for the currently selected junction. After naming, adds junction to the library.
 l Edit Junctions - Opens Edit Junctions window where you can delete or rename entries in the 

Junction Library.
 l Edit Fluids - Opens Edit Fluids window where you can add, delete, modify or review custom flu-

ids.
 l Edit Pipe Materials - Opens Edit Pipe Materials window where you can add, delete, modify or 

review custom pipe materials.
 l Edit Insulations - Opens Edit Insulations window where you can add, delete, modify or review 

custom insulation materials.
 l Edit Fittings & Losses - Opens Edit Fittings & Losses window where you can add, delete, modify 

or review custom pipe fittings and losses.
 l Library Manager - Opens the Library Manager window.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Arrange Menu
 l Primary Windows - Allows you to configure the Primary windows in two panes in a horizontal or 

vertical orientation. The primary windows can be further rearranged by dragging the tabs into the 
center of the screen and adjusted by moving the tab into the desired position in the docking guide 
(see Figure 1).
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Figure 1: The Docking Guide can be used to view multiple primary window tabs at the same time

 l Sort Table By - (Output Only) - Allows user to order tables in order of any variable and in ascend-
ing or descending order. Available in the Output window. 

 l Rotate Icon Right or Left - (Workspace Only) - Rotates icons for all selected junctions on the 
Workspace. Available in the Workspace window.

 l Rotate Selection Right or Left - (Workspace Only) - Rotates selected pipes and junctions as a 
group. Available in the Workspace window.

 l Align - (Workspace Only) - Aligns selected pipes and/or junctions on the Workspace. You can 
choose to align pipes and junctions, just pipes, or just junctions horizontally or vertically on the 
workspace. Available in Workspace window.

 l Pipe Drawing Mode - (Workspace Only) - Select the type of grid layout that the model will use.
 l 2D Freeform - Junctions can be placed anywhere on the Workspace.
 l 2D Orthogonal - Toggles orthogonal drawing capability on the Workspace. This toggle is 

a shortcut to enabling the feature in User Options window. See Orthogonal Drawing Over-
view for more information.

 l Isometric - Uses an isometric grid.
 l Snap to Grid - (Workspace Only) - Toggles Snap to Grid feature on the Workspace. When ON, 

all Workspace pipes, junctions and annotations snap to an grid specified in User Options window. 
Available in the Workspace window.

 l Show Grid - (Workspace Only) - Toggles Show Grid feature on the Workspace. Shows or hides 
grid that is specified in User Options window. Available in the Workspace window.

 l Make Selected Pipes and Jcts Orthogonal - (Workspace Only) - Makes all selected pipes and 
pipes connected to selected junctions on the Workspace orthogonal. Available in the Workspace 
window.

 l Flip Vertex - (Workspace Only) - Available when orthogonal drawing is enabled. This will flip the 
vertex of all selected pipes on the Workspace. Available in the Workspace window.

 l Scale/Flip Workspace - (Workspace Only) - Scales (shrinks or expands) or flips either selected 
or all pipes and junctions on the Workspace. Available in the Workspace window.
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 l Set Pipe and Junction Locations to Parent - (Workspace Only) - Sets locations of pipe and 
junction labels to the same position as the parent scenario. Available in the Workspace window.

 l Reset Label Locations - (Workspace Only) - Sets locations of pipe and junction labels to their 
default locations. Available in the Workspace window.

 l Disable Pipes Snapping to Isometric Grid - (Workspace Only) - Toggles Snap to Grid feature 
on the Workspace for the selected pipe. When Snap to Grid is disabled for that pipe, the pipe end 
point no longer snaps to grid points and pipe segments do not follow the Isometric lines. Available 
in the Workspace window.

 l Pipe Segments - (Workspace Only) - Allows user to Add Segment (split single into two pipes), 
Add Segment at Right Angle, Add Multiple Segments, Remove Segment, or Remove all Seg-
ments. Available in the Workspace window.

 l Lock Object - (Workspace Only) - Locks selected pipes and junctions on the Workspace so they 
cannot be moved. A lock symbol appears next to locked pipes or junctions when an attempt is 
made to move the pipe or junction. Available in the Workspace window.

 l Reverse Direction - (Workspace Only) - Reverses the reference positive flow direction of all 
selected pipes on the Workspace. Available in the Workspace window.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Related Blogs

AFT Responds to 2020 Customer Survey Feedback

Window Menu
 l Workspace - Makes the Workspace window active. 
 l Model Data - Makes the Model Data window active. 
 l Output - Makes the Output window active. 
 l Graph Results - Makes the Graph Results window active.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

https://www.aft.com/support/product-tips/aft-responds-to-2020-customer-survey-responses
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Help Menu
 l Open Help -  Opens help site home page
 l Use Offline Help - Indicates that the PDF help file will be used instead of the Online AFT Help 

File when the help buttons in topics are clicked. Note that the PDF help file must be downloaded 
from the PDF Downloads page on the online help site prior to using this option.

 l Quick Start Guide - Opens quick start guide pdf in English or metric units 
 l Quick Start Video - Opens ~15 minute quick start video on aft.com in English or metric units
 l Keyboard Shortcuts - Opens keyboard shortcut help page in local help system
 l Show Examples - Opens  to example section of help file
 l Video Tutorials - Opens video tutorials on aft.com in English or metric units and English or Span-

ish language
 l Technical Seminars - Opens information on training courses on aft.com
 l Flow Expert Package - Opens information on aft.com for individualized help from AFT engineers 

for training, modeling, consulting, and more
 l Online Learning Center - Opens learning center on AFT website with links to resources such as 

blogs, video tutorials, webinars, etc.
 l AFT Home Page - Opens home page on aft.com
 l AFT Blog - Opens blog home page on aft.com
 l Send Email to Support  - Links to AFT support in your default email program
 l Latest Release - Opens page on aft.com to download the newest AFT xStream release
 l AFT Notifications - Opens page on aft.com where you can sign up for email notifications for new 

software updates and releases
 l About AFT xStream - Opens window in AFT xStream with information on current AFT xStream 

version, license number, etc.

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Toolbars
The Toolbars offer quick access to the features used most frequently in AFT xStream. There are actually 
several Toolbars in all. One is the Common Toolbar, and it is always shown. Its features are common to 
all Primary windows. In addition, there is one Toolbar for each Primary Window, offering features appro-
priate for work in that window. You only see two Toolbars at a time in AFT xStream. The function of each 
icon in a given Toolbar appears when you pass the mouse over the icon button without clicking on the but-
ton.  Each of the functions on the Toolbar is also available through the menu system.



Interface and User Options

- 298 -

Figure 1: Common Toolbar

Figure 2: Workspace Toolbar

Figure 3: Model Data Toolbar

Figure 4: Output Toolbar

Figure 5: Graph Results Toolbar

Related Topics

Workspace Window 312
Model Data Window 332
Output Window 336
Graph Results Window 347

Printing

Printer Page Layout

The Printer Page Layout tool enables users to control how a model on the Workspace will be split across 
pages in the Print Preview window. To access this tool click the printer icon in the bottom-right of the 
Workspace. The Printer Page Layout options should appear.
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Figure 1: The Printer Page Layout options control how the model is split between pages on the Print Preview

 l Show Page Boarders - When checked, a dotted yellow outline will appear around sections of the 
model. If the dotted yellow lines form a single box around the model, this means the entire model 
will fit on a single page. If the dotted yellow lines form multiple boxes, regardless of the size of the 
boxes, the model will be divided such that everything in a box will appear on its own page once the 
Print Preview is used.

 l User Defined Print Area - When checked, a purple box will be drawn around the entire model. 
Clicking on this box will cause sizing handles to appear. Using these sizing handles along with the 
"Show Page Boarders" enables users to customize more precisely what appears on each page. 
Additionally, a user can shift the model on the Workspace in order to place specific sections of the 
model on specific pages.

 l Paper Size - The paper size is a drop down with a selection of page dimensions based on the 
page sizes. The list of page sizes is determined by  whatever printer page sizes are supported by 
your printer. Selecting one of these sizes will affect the size of the paper the model will be printed 
on. As such, the size of the boxes formed by the dotted yellow lines from the "Show Page 
Boarders" will adjust in size.

 l Orientation - The portrait setting will flip the page such that the longest side from the paper size 
will align vertically on the page. The Landscape setting will flip the page such that the longest side 
from the paper size will align horizontally. As such the boxes created from the "Show Page 
Borders" option will follow suit.

 l Contents Scaling - This feature determines how large the model will appear on each page. As 
the slider moves, it will appear as though the boxes from the "Show Page Borders" are shrinking 
or growing. This does not affect the dimensions of the pages. Instead, when the Print Preview is 
used the page size will remain the same, but the objects in each box will fit to the pages as dis-
played on the Workspace.
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Print Preview

The Print Preview window allows you to access special print features such as Print Preview and Fit to 
One Page. It is accessed from the File menu or using the shortcut CTRL + P.

The Print Preview window also offers you a preview of the print content and format for all Primary Win-
dows. By clicking the Print Preview button you can review your printed material at several zoom states. 
Individual pages can be printed.

The "Fit To Page(s)" feature causes the graphic image generated from the Workspace window to be com-
pressed onto the specified number of pages. This is a convenient feature for creating reports of your 
model. The Print Preview supports whatever printer page sizes are supported by your printer, so the use 
of legal paper or larger may allow you to get more visible details. The graphics can also be centered ver-
tically and/or horizontally. You also can fit your content onto multiple pages.

The Page Setup option in the Print Preview window allows you to set the page orientation, paper size/-
type, and margins.

Additional special printing features affect the Workspace. The "Selected on Workspace" option works 
with Workspace printing by selectively printing the pipes and junctions currently selected on the Work-
space.

By default, the junction icons on the Workspace will be printed with the same colors as displayed on the 
screen. It also prints the background color as specified in the User Options > Workspace > Colors and 
Fonts. You can also specify that the junction icons be printed in black and white (still with the color back-
ground) or that the entire printout be black and white.

If you added a background picture from the File menu, this picture will be included in the printout.

Finally, if you have a grid displayed on the Workspace, the grid will be included in the printout.

Page options allow the use of a company logo, user comments, titles, and different options for borders.

Primary Window Overview
AFT xStream has several Primary Windows that work in an integrated fashion. Each is located on a sep-
arate, moveable tab. You work exclusively from one of these windows at all times. For this reason, they 
are referred to as Primary Windows.

You can change between the Primary Windows by selecting them from the Window menu or by clicking 
the appropriate tab within the AFT xStream window.

 l Workspace
The Workspace Primary Window is where the user creates the graphical representation of the sys-
tem. Engineering data is input on pipe and junction property windows which are opened by 
double-clicking the objects.
The Workspace Layers are also located on this Primary Window and allow the user to display both 
input and output data superimposed on the pipe system schematic.

 l Model Data
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The Model Data Primary Window summarizes the engineering input data from the Workspace into 
categorized tables. This allows for easy review of the system inputs, and double clicking cells will 
open the pipe or junction properties for quick editing.

 l Output
The Output Primary Window offers a powerful and diverse range of features for reviewing analysis 
results which are organized into categorized tables and lists. The Output allows the user to easily 
compare multiple design scenarios with color coded rows, details errors or design requirement 
violations, and prepare the results for documentation.

 l Graph Results
The Graph Results Primary Window allows the user to create a wide array of graphs with various 
parameters which are integral to gaining a deeper understanding of the pipe system’s behavior. 
The user can adjust various formatting settings such as axis ranges, labels, colors, and create 
dual y-axis or stacked graphs. The settings can be saved into templates called Graph List Items 
so that the graphs can be easily reproduced.

Primary Win-
dow

Can Dis-
play Input

Can Dis-
play Out-

put

Workspace ✓ ✓

Model Data ✓  

Output  ✓

Graph Res-
ults  ✓

Related Topics

Overview of AFT xStream 17
xStream Learning Resources 33
Overview of Fluid Transients 37
Philosophy of Computer Modeling 69

Related Examples

Beginner - Tank Blowdown Example (Metric Units) 581

Status Bar
AFT xStream's Status Bar displays contextual information about the current scenario or operation.
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Figure 1: Current scenario displayed in the Status Bar

The Status Bar indicates the status of certain operations - for example, when opening a model the pro-
gress of loading the pipes, junctions, and scenarios is displayed.

Figure 2: Status Bar displaying progress when opening a model

Quick Access Panel
The Quick Access Panel, as shown in Figure 1, contains several useful features:

 l Scenario Manager - Configure the scenarios and variations of the model
 l Properties tab - Review pipe/junction inputs or output, and edit annotations
 l Workspace Layers - Superimpose input and output parameters on top of the Workspace model
 l Overview Map - Easily navigate large models
 l Activate Add-on Modules - Shortcut to the Add-on Modules group in the Analysis Setup
 l Model Status Light - Green/red light indicating if all required input is present and if the Solver is 

ready to run
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Figure 1: The Quick Access Panel

Scenario Manager

By clicking on the Scenario tab in Figure 2 below, you have the full scenario customization ability as you 
would with the Scenario Manager. You can create child scenarios, expand or collapse various families of 
scenarios, and use the many other Scenario Manager features here as well.
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Figure 2: The Scenario Manager

Properties Tab

As seen in Figure 1 or 2, there is a "Properties" tab in the Quick Access Panel.  When pipes and junctions 
are drawn on the Workspace, you can quickly view the Pipe or Junction Properties by first selecting a 
pipe or junction on the Workspace, then clicking on the "Properties" tab. The tab's name will dynamically 
update depending on which pipe/junction is selected. This will display the Object Property data as well as 
any Output data if the model has been run.  Figure 3 below shows an example of what the Properties tab 
would look like when clicking on a pipe on the Workspace after it has been defined and output was cre-
ated.
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Figure 3: Viewing the Pipe/Junction Properties and Output Data from the Quick Access Panel

Annotations can be edited by selecting an annotation on the Workspace which will bring up their prop-
erties in this tab where they can then be edited.
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Figure 4: Annotation view for the Properties in the Quick Access Panel

Workspace Layers Tab

The Workspace Layers tab contains settings relating to object visibility, labels, superimposing input/out-
put data, and color maps.

Figure 5: View of the Workspace Layers panel structure
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Overview Map

When a model is very large in size, it can be troublesome to have to constantly drag the model around on 
the Workspace to get to a specific area of the model you want to view.  By clicking on the Workspace 
Overview Map button in the red box in Figure 6, you will bring up a map that is a bird's eye view of the 
model.  Drag the small square in the Workspace Overview Map over various parts of the model, then 
zoom in and out of the model.  You can also click the "Fit" button to see the full model zoomed out on the 
Workspace. You can also zoom in and out using the mouse wheel.

Figure 6: Workspace Overview Map
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Activate Add-on Modules

Clicking the Modules button in the bottom right of the Quick Access Panel in Figure 7 launches Analysis 
Setup to the Modules panel to activate or deactivate add-on modules.

Figure 7: Activating the Modules from the Quick Access Panel

Model Status Light

The Model Status Light is located in the bottom-right of the Quick Access Panel (Figure 8). Clicking the 
Status Light will open Analysis Setup. When each item in Analysis Setup is fully defined, it will have a 
green check mark.  When all necessary items in Analysis Setup are completed, the Status Light will turn 
from red to green, indicating that the model can be run.
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Figure 8: The Model Status Light is located at the bottom-right of the Quick Access Panel

Minimizing the Quick Access Panel

By default, AFT xStream opens with the Quick Access Panel automatically expanded.  The Quick Access 
Panel can be easily collapsed and pinned to the side of the Workspace to allow for a larger usage area of 
the Workspace.  Figure 9 shows the AFT xStream window with the Quick Access Panel initially 
expanded.  By clicking on the thumbtack pin button (highlighted below with the red box), the Quick 
Access Panel will then become collapsed as shown in Figure 10.  After the Quick Access Panel is col-
lapsed, it can be temporarily expanded again simply by hovering over the "Scenario" sidebar with the 
mouse.
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Figure 9: The Workspace with the Quick Access Panel expanded

Figure 10: The Workspace with the Quick Access Panel collapsed
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Model Status Light
The light at the right of the Status Bar located at the bottom of the AFT xStream window, which indicates 
whether or not the model can be sent to the Solver.

Clicking on the Model Status Light will show the Analysis Setup window where the completion status of 
different panels can be seen.

Solution Progress Window
The Solution Progress window indicates the current state of the solution iterations. During each of the 
three stages of the solution process, the Solution Progress window shows the following information.

 l Arrow Steady Solution - The tolerance for the most out of tolerance junction or pipe is listed. 
General information about the solution method and solution control settings for the AFT Arrow 
Steady Solution are also shown. Note that both absolute and relative criteria are always dis-
played. These tolerances can be helpful for selecting the appropriate criteria on difficult to con-
verge models.

 l MOC Steady Solution - The absolute and relative velocity change across each block iteration is 
shown for the pipe with the largest velocity change. Information is also reported about if the MOC 
Steady Solution criteria are met and about any potential loss of mass or energy in the MOC 
Steady Solution.

 l MOC Transient Solution - A progress bar of the transient simulation is shown.

The area in the bottom of the window will give important feedback on the model solution. It is important 
not to dismiss messages in this area, as they could have an impact on results. This information will also 
be printed to the General and Warnings sections of the Output window as is applicable.

When the model solution is complete, options to view the Output, Graph Results, and Workspace 
become available.

Other Actions - Pausing the simulation allows the modification of certain AFT Arrow Steady Solution 
parameters during the run, as well as viewing the iteration history  if it was enabled via the Keep Track of 
Iteration History setting on the Iterations panel.

Retain Partial Transient Output - Canceling the run allows for output data to be kept up to the point at 
which the run was canceled. The Output File will be finalized and the partial output can be viewed. A cau-
tion will be shown in the Output stating the last valid time step. This can be used in combination with Tran-
sient Checkpoint Files to continue the run later.

Workspace Window
The Workspace window is the sole area where you specify the model layout and connectivity. The Work-
space window has two separate functional areas: the Toolbox on the far left and the Workspace itself 
encompassing the rest of the screen (see Figure 1). 

Transient-Checkpoints-Panel.html
Transient-Checkpoints-Panel.html
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Figure 1: The Workspace window

Display and Printing Features

The Workspace image can be:

 l Copied to the clipboard
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The Print Preview window allows the above outputs to be applied to all or certain selected Workspace 
objects.

Related Topics

Workspace Layers 314
Creating Pipes - the Pipe Drawing Tool 169
Annotations 324
Optional Input for Junctions 212
Workspace 370
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Workspace Layers
Fundamentally, Workspace Layers are used to control the visibility of Workspace objects and labels.  Lay-
ers allow custom views to be created in which results can be displayed without needing to leave the Work-
space window.  A group of layers functions like a stack of transparencies, with each layer displaying 
specific, customizable information.  The view on the Workspace is a composite of the information presen-
ted by all visible layers, but all objects exist regardless of visibility for the purposes of calculations and 
object connections.

Figure 1: Information from all currently visible layers combines to form the view displayed on the Workspace

Layers can be shown or hidden to create different views of the Workspace.  The visibility of objects on the 
Workspace depends on the layers that are shown, as objects on hidden layers are not shown on the 
Workspace unless present on another layer. If an object exists on multiple layers, only the top-most rep-
resentation is visible. The order of the layers is controlled by the order in which they are listed in the Work-
space Layers panel.

Workspace Layers Panel

The Workspace Layers panel is accessed via the Workspace Layers tab in the Quick Access Panel. 
There are two areas within the Workspace Layers panel to control Layer Presets and Layers.

In the Layers area, new layers can be created, and any selected layers can be renamed, duplicated, and 
toggled in visibility. The Global Layers Settings menu is accessed here, and the column of visibility icons 
on the right shows the current visibility of each layer and can be clicked to toggle visibility. Hovering over 
a layer, a gear icon appears that links to the layer’s Layer Settings options for customization.
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Figure 2: View of the Workspace Layers panel structure

Standard layers control pipe and junction styles, labels, and visibility, along with the visibility of any 
annotations in the model. Among the standard layers is the All Objects Layer. The All Objects Layer 
exists in all models and contains all pipes, junctions, and annotations in the model. This serves as the 
primary layer, provides a central location for users to quickly see all objects in the model, and is always 
the bottommost layer.  When creating a view where some objects are hidden, the All Objects Layer can 
be toggled in visibility so that only objects visible in other layers are shown on the Workspace.

Other standard layers can be reordered up or down the layer stack using the areas at the top of the Lay-
ers area. For pipe and junction labels, the order of displayed text items is affected by the order of the lay-
ers containing label text.

Standard layers can be created from the New Layer drop-down as a Blank Layer or From Workspace 
Selections. Layers created from Workspace selections have the selected objects and their labels visible 
in the new layer.
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By default, new objects are visible only on the All Objects Layer.  However, if layers are set as Active Lay-
ers, then any new objects that are created and their labels will be visible within all Active Layers. Active 
Layers are set by hovering over a layer and clicking the pencil icon and any currently Active Layers are 
denoted by the pencil icon.

Layer Presets

Layer Presets allow customized Workspace views to be retained by saving the status (visibility) of each 
layer. There are four columns in the Layer Preset area. One shows the name of the preset, the Load Pre-
set option allows the previously saved layer states to be loaded onto the Workspace, the Update Preset 
option saves the current layer states to that Layer Preset, and the Link Preset option links that preset to 
the currently active scenario.

By linking a preset to a scenario, it will automatically load whenever that scenario is loaded in the future. 
Individual layers, by contrast, are not tied to a specific scenario and are defined globally and immediately 
available in all scenarios. A layer can only show objects that exist in the active scenario, and changes to 
the style of an object in a layer will affect all scenarios.

Global Layer Settings

Figure 3: Global Layer Settings window

The Global Layer Settings are accessed from the double gear icon on the Layers Toolbar in the Quick 
Access Panel. The properties that are controlled by Global Layer Settings are not defined for individual 
layers – changes to these settings affect all layers globally.

Text and Graphics Options allow the analysis title, input filename, scenario name, and units in the legend 
to be toggled.

Note: The analysis title is set in the general tab of Output Control.
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The Fonts setting controls the fonts for Data/Text (e.g. labels), the Title text (the analysis title, input file-
name, and scenario title if visible) and the text in the legend.

The Numerical Formats option determines the minimum number of digits shown for input and output data 
displayed within label text.

Layer Settings - Pipes & Junctions

The Layer Settings window can be accessed by double-clicking the layer, from the single gear icon on 
the right of each layer, or by selecting the layer and clicking the single gear icon on the Layers Toolbar.

The layout of the Layer Settings window is similar to Analysis Setup, with a number of groups listed on 
the left side of the window. Each group contains items that when selected change the content of the main 
panel area on the right.

Figure 4: The Show/Hide & Style panel allows the appearance and visibility of pipes and junctions to be man-
aged

The Pipes & Junctions group of the Layer Settings window allows the pipe and junction color and 
size/thickness to be defined for a given layer, along with which pipes and junctions are visible. Note that 
changes to this panel are made live in real time, and no Apply button is needed to apply the changes that 
you make. Pipes and junctions are shown in two separate lists, which can be filtered.

Multiple pipes or junctions can be edited at a time using the Color, Size, and Thickness modifiers at the 
top of each table, or set to default options with the Defaults buttons towards the bottom. The usual tools 
for selecting pipes and junctions, including Workspace select and Select Special, are available here. 
Pipes and junctions may also be edited individually with the visibility, color, and size options in each row.

The appearance of new pipes and junctions is layer specific, and can be set to default options with the 
top Defaults button or modified with the New Pipe Color, New Pipe Thickness, and New Junction Size 
options. Note that color and icon style for new junctions are set via the Toolbox as they are specific to 
each type of junction.

List Pipes & Junctions from All Scenarios is toggled off by default to reduce unintended changes to items 
in other scenarios, but this can be toggled on to include objects from all scenarios in the lists.
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Layer Settings - Label Control

A label is text that is associated with a pipe or junction on the Workspace. Labels include both input and 
output parameters along with object names, numbers, and workspace symbols. While there is no sep-
arate output mode, output parameters are only displayed when the current scenario has output data avail-
able. If no output is present, the parameter in the list to the right will appear grayed out. Input parameters 
will always be shown when added to the list on the right. The label shown for an object on the Workspace 
is a combination of defined label items from each visible layer, and the order of the items is determined 
by both the layer order and the order that parameters are listed within each layer.

Figure 5: The Junction Parameters panel within the Label Control group of Layer Settings

Within the Label Control group, the Pipe Parameters and Junction Parameters items allow for the para-
meters associated with a layer to be customized. When there is no output available, output parameters 
will be grayed out within the list, but their list position and units may still be edited.

Label locations are defined globally, so the Reset Label Locations option will apply to all labels in all lay-
ers and all scenarios.
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Figure 6: The Show/Hide Labels panel determines which objects will have visible labels for a given layer

The Show/Hide Labels panel can be used to toggle the visibility of labels for each pipe and junction within 
a layer. This allows a user to create a layer that shows only the relevant parameters for the relevant 
objects in the model. Visibility can be modified for one or several objects at a time via the same methods 
as pipe and junction visibility.

The Force Shown Labels to Match Shown Objects option forces the visibility of each label to match its 
object visibility as defined in the Pipes & Junctions group of the Layer Settings. The Defaults options at 
the bottom of the tables simply toggle this option on if it had been previously unselected.

Layer Settings - Annotations
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Figure 7: The Show/Hide Annotations panel shows all annotations that exist in the model file and allows their 
visibility to be controlled on a per-layer basis

The Show/Hide Annotations panel allows the visibility of annotations to be defined for the current layer 
and displays the visibility of each annotation in the current layer. While annotations exist globally, in con-
cert with Layer Presets this menu allows annotations to be controlled so that they are only visible in the 
relevant scenarios. Annotations can be edited from this list view by double-clicking them in the list to 
open the annotation in the Annotation Editor.

Color Maps and Animations

A Color Map layer allows you to visualize magnitudes of various parameters by coloring the pipes. Color 
Maps are a special layer type, and are shown in a separate group on the Layers panel. There can be only 
one special layer visible at a time, and they override the behavior of standard layers in the model - in this 
case superseding any colors assigned to pipes by other layers.

Example use cases for Color Maps includes visualizing hot/cold loops, locations of high velocity/reverse 
flows, or pipe diameters/lengths.

To create a Color Map layer, click the new layer icon on the Layers Toolbar, select a Color Map layer 
type, and name the new layer. To edit the layer, go to its Layer Settings menu, accessed in the same 
manner as a standard layer.

Figure 8: Layer Settings window for a Color Map

In the Color Map Layer Settings window, choose a parameter and units for which all pipes will be cat-
egorized. Then choose the Number of Conditions (number of colors) and click Generate. The operators 
(i.e. >, >=, =, <=, <) and values can be modified. Values may be categorized on an absolute value basis 
by selecting the Use Absolute Value checkbox. The Show Value on Workspace Label option shows the 
evaluated parameter next to each visible pipe in the model, and combines with any other label text items 
from other layers.

The order of entry is not important. Arrow will sort the entries first by value and then by the operator, with 
the greater than (>) operator being above the less than (<) operator. The pipes will be colored using the 
first match found in the map, starting from the top of the map. If no match is found, the pipe will be the 
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Workspace pipe color. Be careful to avoid overlapping operators and values. If, for example, the map 
defined four colors using the following inequalities,

 l >=60
 l <60
 l >=20
 l <20

then there is no way colors 3 and 4 will be used because any pipe less than 20 is also less than 60. Since 
<60 is before <20 in the map, the pipe will be colored using color 2. 

To avoid overlapping colors, only use less than (<) as the last entry. A better map would be the following:

 l >=60
 l >=20
 l <20

To delete a map value, select the row from the Color Map Grid and  click the Remove Row button. Instead 
of coloring the pipes, it is possible to color just the pipe numbers. This is done by choosing the Color Pipe 
Labels radio button in the Color Options area. Alternatively, the Color Pipes and Labels radio button 
allows both to be colored.

Color choices from the Color Map Grid will appear in a legend without units shown by default. The legend 
may be repositioned by dragging it to any location on the Workspace. Units may be displayed in the 
legend using the Show Units in Legend setting within Global Layer Settings.

If there is no output for the current scenario, any Color Map layer that displays an output parameter will 
have a red exclamation mark next to it on the Layers panel to warn the user that there is no output. The 
model must run before such Color Map layers can be displayed.

Color Maps can be animated for transient data using Animation Layers. The interface for animating a 
color map layer is shown in Figure 9.

Figure 9: Layer Settings window for an animated color map layer
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Workspace Layers Import Assistant

The Workspace Layers Import Assistant can be used when importing a model from Arrow 9 or earlier. By 
default, when opening a model from these previous versions, layers are created as applicable for object 
numbers, workspace symbols, and object names. This is done regardless of whether or not the  Work-
space Layers Import Assistant is run.

The purpose of the Workspace Layers Import Assistant is to import visual styles of pipes and junctions 
and to import labels from the deprecated Visual Report Window as Workspace Layers so that previous 
Visual Reports can be recreated. This is a step by step guided procedure that will attempt to bring these 
elements into Workspace Layers while creating as few new layers as possible. These layers are created 
on a per-scenario basis.

If a model has a high number of scenarios with similar Visual Reports, it may be preferable to recreate 
the Visual Report manually as a new layer that can be used with any scenario. If the chosen scenarios for 
the Import Assistant share many of the same visual settings, the Import Assistant will create all relevant 
layers for each, even if those layers are identical to each other.

The  Workspace Layers Import Assistant will allow you to select which scenarios to use to create the new 
layers. Once these are selected, the next page of the Import Assistant will allow you to see how many lay-
ers and Layer Presets will be generated. Once satisfied with the proposed Workspace Layers and Layer 
Presets, click Import Layers to complete the import process.

Related Topics

Animation Layers 54

Merging Models
Two models can be merged together using the command on the File menu. Here’s how:

 l Open the first model
 l Choose Merge on the File menu
 l From the file list, select the model to be merged

If there are duplicate numbers, the objects in the second model will be changed. The second model will 
be selected (highlighted) so that you can move it into position (be careful not to click off the selected por-
tions or the second model may be deselected).

Note that annotations, layers, and layer presets are not imported from the second model.

Tip: To move a selected group of objects, use a junction icon, instead of a pipe, to drag the group. 
This will avoid missing the pipe and clicking on an empty area of the Workspace which will 
deselect your group.
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Merging Models with Multiple Scenarios

If the model you are merging from has multiple scenarios, only the base scenario can be merged. If you 
want to merge one of the children of that model, do the following:

 1. Open the model which you want to merge.                                      
 2. Open the Scenario Manager.                                      
 3. Select the child scenario you want to merge.                                      
 4. On the Other Actions button (or from the right-click menu), choose the Save Scenario to File 

Without Children.                                      
 5. Enter a name and click OK. This process creates a new xStream model with the desired scenario 

as the base scenario.                                      
 6. Open the original model and merge in the new model file created in Step 5. 

Renumbering Workspace Objects
Objects on the Workspace can be renumbered by choosing Renumber from the Edit menu. There are 
several ways that Renumbering can proceed.

Renumber Wizard

The Renumber Wizard allows you to renumber pipes and/or junctions by simply clicking on them on the 
Workspace. Normal Workspace functions are suspended when the Renumber Wizard is active. The 
Renumber Wizard is activated on the Edit menu.

When the Renumber Wizard is active the settings can be modified in the Quick Access Panel. Click Done 
Renumbering in the Quick Access Panel to finish renumbering and exit the wizard.

Renumber Automatic

Selected pipes and/or junctions can be renumbered starting at the lowest selected number or at a spe-
cified number. If a pipe or junction which is not selected to be renumbered already has the next number in 
sequence, it will only be changed if the Force Sequential checkbox is checked.

xStream will start at the beginning of the flow path containing the lowest numbered selected pipe and will 
attempt to march down the pipes in the direction of flow. It is recommended that renumbering be per-
formed after the model has been completed so that the junctions and pipes are completely connected.

Tip: If you want certain sections of the model to be numbered in sequence, then use the Renumber 
feature on the selected sections only. It is also preferable in the case of large or complicated 
models to renumber small sections at a time.
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Renumber Increment

Renumber Increment is on the Edit menu and allows you to increment or decrement all selected pipes 
and junctions by a specified value.

Scale/Flip Workspace
The Workspace can be scaled horizontally and/or vertically by choosing Scale/Flip Workspace on the 
Arrange menu. Scaling will move the junctions and will stretch or shrink the pipes so that the area the 
model covers is changed by the percentage specified.

Flipping the Workspace horizontally and/or vertically will move the pipes and junctions to their mirror 
image locations. This is useful when you are building a system which has symmetrical or mirrored sec-
tions. For example, you could select the section, duplicate it, and then flip it horizontally, vertically, or 
both with Scale/Flip Selected Objects Only checked.

Magnifier Tool
The Magnifier tool can be used to provide a magnified view of any area on the Workspace. This is useful 
for navigating and viewing details of a large model without needing to zoom in on that area. The Magnifier 
tool can be accessed from the Workspace Toolbar, as can be seen in Figure 1 below. The magnifier tool 
can be enabled/disabled by clicking the button on the Toolbar.

There are several options available to adjust the Magnifier view:

 l Zoom Level - Adjusts the level of magnification used
 l Magnifier Size - Adjusts the size of the magnifier circle

Figure 1: Magnifier tool on the Toolbar

Related Topics

Toolbars 297

Annotations
Annotations are objects that can be placed on the Workspace to display customized text, express ideas 
via shapes or lines, or even to insert pictures into the Workspace. These are purely visual and do not 
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affect results; their purpose is to communicate conceptual information about a system. They appear both 
in the Workspace and when printing from the Workspace.

New annotations are created using the Annotation Tool in the Toolbox. The Annotation Tool is located to 
the right of the Pipe Drawing Tool. With this tool, the user can draw a line or a shape on the Workspace. 
Shapes can display an image or text on the Workspace or can be used without text to display boundaries 
around various regions of the model.

Figure 1: After clicking the Annotation Tool, select the shape for the new annotation
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Properties
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Figure 2: Annotation view for the Properties in the Quick Access Panel

After an annotation is placed on the Workspace, the properties of the annotation will be displayed in the 
Properties tab of the Quick Access Panel where they can be edited. For existing annotations, it can be 
accessed quickly by double-clicking on the annotation in the Workspace. Annotation styles can be set as 
default or restored to default settings using the Defaults drop-down menu in the upper right of the Annota-
tion properties area.

 l Annotations - The name of the annotation, its text content, text style, and text visibility can be 
edited within the Annotations section. The name of the annotation is not displayed on the Work-
space but is shown within the Layers Settings where it can be used to communicate the purpose 
of an annotation.

 l Behavior - The Behavior section allows the behavior of the annotation to be customized. Annota-
tions can be attached to the Workspace, a pipe, or a junction. When attached to the Workspace, 
the annotation always remains in the same location until you move it. When attached to a pipe or 
junction, the annotation will move when the pipe or junction is moved.

Note: Whether an annotation appears behind or in front of another object is usually determined by the 
order of the Workspace Layers in which they are visible, but the toggle Workspace Keep in Back 
forces the annotation to appear below pipes and junctions regardless of layer order.

 l Format - The Format section controls the shape as well as the shape's style and visibility.
 l Image - The Image section allows an image to be displayed within the annotation and controls its 

appearance.
 l Line - The Line section controls the appearance of lines and only applies when the shape is set to 

be a line in the Format section. Similarly, the shape color and border properties from the Format 
section are not used for lines.

Interaction with Scenarios and Layers

Annotations are not scenario-specific and exist globally within a model. Their visibility is associated with 
layers and can be controlled for each layer in the Layer Settings. While annotations exist globally, their 
visibility for a given scenario can be controlled using Layer Presets.

Extended Model Check
The connections and settings of each pipe and junction are exhaustively checked using the Extended 
Model Check item on the View menu. This is also helpful if the model seems to not be connected cor-
rectly.
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Keyboard Shortcuts for Workspace

Selection Box

 l Select all objects completely inside box by dragging cursor from left to right
 l Select all object completely or partially inside box by dragging cursor from right to left

Pipe Drawing Tool 

 l If you double-click the pipe drawing tool, it will allow you to draw multiple pipes at a time. Clicking 
Esc or clicking the pipe drawing tool again will deactivate the tool.

 l When orthogonal drawing is off and you hold down the SHIFT key while drawing pipes on the 
Workspace, you can draw pipes that are perfectly horizontal or vertical. When the orthogonal 
drawing is on and you hold down the SHIFT key down while drawing new pipes on the Workspace 
the pipe vertex will flip. If you move an existing pipe and hold the shift key while selecting a handle 
at one of the pipe endpoints a new vertex will be inserted at that point endpoint.

 l If you hold down the CTRL key when completing the pipe drawing (just before releasing the 
mouse button), the Pipe Drawing Tool remains active, and you can draw a series of pipes without 
returning to the Toolbox each time.

 l To add pipe segments, use CTRL+SHIFT+Y 
 l To remove all pipe segments, use CTRL+SHIFT+N

Junctions

 l If you double-click any junction in the Toolbox, you will be able to place multiple of that junction on 
the Workspace by clicking the Workspace where you would like to place each junction. Clicking 
Esc or clicking the junction icon in the Toolbox again will deactivate the tool.

 l If you hold down CTRL key and select a junction from the Toolbox and drop it onto an existing 
Workspace junction, the old junction will "morph" into the new one. The junction type will change 
to the new junction type, and data that can be kept will be copied into the new junction.

 l If you hold down the CTRL key then drag a junction on the Workspace which has pipes connected 
to it, the junction will move but the pipes will not move with it

 l If you hold down the SHIFT key while selecting a junction from the Toolbox and then drop the junc-
tion onto an existing pipe, the pipe will split into two pipes. You will specify the length of the first 
pipe and the second pipe will be automatically set to the remaining length from the original pipe. 
Thus the sum of the two pipe lengths will equal the length of the original pipe. You can also choose 
which pipe contains any Fittings & Losses that were specified within the original pipe.
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Figure 1: Split pipe keyboard shortcut

Pipe and junction Properties window

 l When in a pipe or junction Properties Window you can toggle the highlight feature by pressing the 
F2 function key. You can also toggle this from the View menu.

 l When in a Pipe Properties Window, if you press the F5 function key, you will jump to the next 
highest numbered pipe. If you press the CTRL key while pressing the F5 function key, you will 
jump to the next lowest numbered pipe. The F5 function key also behaves this way for junction 
Properties Windows.

Pan and Zoom

 l The Workspace position can be moved with CTRL + arrow keys.
 l The Zoom level can be adjusted with CTRL + (+/-)
 l The Zoom level can be reset to default with CTRL + 0
 l Mouses with scroll wheels can be used to zoom by scrolling, or to pan by clicking and holding the 

scroll wheel

Switching Primary Windows

 l Go to the Workspace window using CTRL + W
 l Go to the Model Data window using CTRL + M
 l Go to the Output window using CTRL + U
 l Go to the Graph Results window using CTRL + G
 l Go to the Visual Report window using CTRL + I
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Other

 l Open the Keyboard Shortcuts Help Page (this page!): CTRL + Q
 l Run the model: CTRL + R
 l Save the model: CTRL + S
 l Open a file: CTRL + O
 l Undo the last action: CTRL + Z
 l Cut: CTRL + X
 l Copy: CTRL + C
 l Paste: CTRL + V
 l Duplicate: CTRL + D
 l Delete selected pipes and junctions: DEL
 l Reverse pipe direction: F3
 l Lock Object: CTRL + L
 l Toggle special condition of pipes/junctions between open and closed: F4
 l Show object status: CTRL + H
 l Other available shortcuts can be seen listed by their command on the menus

Related Topics

Add/Remove Pipe Segment 204
Joining or Splitting Pipes 170
Creating Junctions 171
Defining Objects 174
Editing Objects 173
Morphing Junctions 174
Moving Objects 173
Creating Pipes - the Pipe Drawing Tool 169
Workspace Pan 177

Undefined Objects Window
This window is launched from the Workspace toolbar or the View menu.

This window displays all undefined pipes or junctions in the model. Clicking on the undefined object will 
display the undefined properties in the list below. All undefined data for all objects can be saved to the file 
or copied to the clipboard.

Any undefined object's Properties window can be launched by double-clicking the object's name in the 
list to finish defining the object.

Related Topics
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Defining Objects 174

Raw Data Changes
When other objects in the model use the same base raw data as the current object and the data is 
changed, you can decide whether to use the new data on the other model objects.

This frequently happens when you have multiple junctions based on the same x-y data for com-
pressor/fan curves or junctions resistance curves, and later change that x-y data. The question is 
whether you want to have the current junction you are working on updated, or all junctions that use that 
same base data.

Figure 1: Raw Data Change Options

Duplicate Special
Duplicate Special allows the model to be copy & pasted, while simultaneously applying other helpful set-
tings as explained below.

 l Increment All Pipe and Junction Numbers By - Adds the specified number to all pipe/junction 
numbers for the created object duplicates. Useful for maintaining consistent numbering

 l Create Group - Adds the duplicates to a group.
 l Hide in Output - Automatically hides the pipe and junction duplicates in the Output window so 

only the original pipes and junctions will be seen.
 l Copy Layer Style Settings From Original Objects - Duplicates Workspace Layers style set-

tings (visibility, thickness, color, label parameters, etc.) for selected objects.

 

Model Data Window
The Model Data window offers a text-based perspective on all engineering information in the pipe flow 
model. This window is immensely useful for obtaining a global view of the model and rapidly checking the 
input. 
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The Model Data window does not offer any tools to build or add to a model; all model assembly must hap-
pen in the Workspace. 

The Model Data window allows you to manipulate existing elements from the Workspace. Therefore, a 
complete model can be assembled in the Workspace window without ever opening the Model Data win-
dow. In fact, for small models this may be the preferred approach.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and dragging 
the bars between each section to re-size them. Each section can also be hidden by clicking the arrow in 
the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Model Data window to re-size the text 
displayed on screen.

Figure 1: The Model Data window displays input in text form

Editing Features

The Pipe table allows display of all input data for all pipes in the model. Details of Fittings & Losses are 
displayed in the Pipe Fittings & Losses table, accessed with an adjacent tab. The Pipe Fittings & Losses 
table displays all fittings with K factors grouped into columns.

The other display tab in the pipe area is the Pipe Detail Summary, which assembles a list of details about 
each pipe in another format useful to some engineers.
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The junction data area is below the pipe data area. Here the junction data is separated into tables for 
each junction type. Click the tabs to see the data for any type of junction. All transient data entered for the 
junctions can be seen in the Transient Data tab on the far right. 

To edit information in the Model Data window, you can open the Properties Window for the pipe or junc-
tion. This can be done by double-clicking anywhere in the row for the pipe or junction to be edited. Altern-
atively, you can use the Global Edit windows opened from the Edit menu. 

Display and Printing Features

Model Data Control lets you specify the combination of pipe, junction, and general information you want 
to see in the Model Data Window.

The Model Data Print Content window lets you specify the content to include in the printed Model Data 
report and select the font to be used for printing. This window is opened from the Tools menu (or Tool-
bar).

The Model Data window contents can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to Excel
 l Saved directly to an Adobe PDF file
 l Sent to the printer

Related Blogs

Having model convergence problems? Start here!

Model Data Control Window
The Model Data Control allows you to customize what data to show for the pipes and for each junction 
type and also which pipes and junctions to show (see Figure 1). It can be opened from the Tools menu 
(or Toolbar).

Pipe Data Display

The data to be shown for the pipes is selected on the left side of the Model Data Control window. Only the 
items with check marks will be shown in the Model Data window. All pipes shown will report the selected 
items.

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
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Junction Data Display

The data to be shown for the junctions is selected on the right side of the Model Data Control window. 
The data is grouped by junction type. However, some data is general and applied to each of the junction 
types. Select the junction type from the list and then select the data for that junction type. Each type also 
includes the general data which may be selected/deselected.  

You can select/deselect the general data for all junction types simultaneously by clicking Set Common.

Figure 1: The Model Data Control window allows selection of the parameters to show in the Model Data win-
dow

Model Data Format

The Model Data Control format can be saved to a file so that the format can be quickly applied to other 
model files. There are multiple ways to do this. The Model Data Control format can be saved to the 
internal User library by clicking the Set As Default button, then choosing User Default in a new model file 
to apply the settings.

The Model Data format can also be saved to an external file, which can then be shared with different 
users. The external file can be generated by clicking the Save Control Format button at the bottom of the 
window. The format can then be applied to other model files by clicking the Load Control Format button.
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Show Selected Pipes and Junctions

Specific pipes and junctions can be shown in Model Data. Click the Show Selected Pipes/Jct tab, then 
click the items in the lists to select the pipe(s) and junction(s) to be shown.

Other Data

Here you can specify whether pipe elevation data, junction curve data, Design Alerts, and/or Force Sets 
will be displayed in the Model Data window.

Scenario Format

A powerful Model Data feature when using scenarios is to show all direct ancestor data in the Model Data 
along with data from the current scenario. The Scenario Format features allow you to do this, and to high-
light where data changes occur. Note that the scenario name is appended to the pipe and junction num-
ber in the left columns. This tab only appears when multiple scenarios exist.

Library Connections

In the lower left of the Model Data Control window there is a Library checkbox. If this box is checked, your 
Model Data Control parameters are setup as determined by the library to which you are connected. This 
is referred to as an active library. To make it inactive, uncheck the box or change one of the Model Data 
Control settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are not being 
passed to the Model Data Control window. The library is thus inactive. To make it active, check the box 
then click the OK button.

If the check box is disabled, there is no connected library.

Output Window
The Output window is the primary vehicle for communicating the results of an analysis in text form (see 
Figure 1). The Output window follows the same general window organization as the Model Data window. 

When a model is submitted to the Solver, the Solution Progress window appears. After the solution is 
obtained, you can view the results in the Output window by clicking the View Output button.

If the information in the Output window is not in the desired format, you can choose Output Control from 
the Tools menu (or Toolbar) to modify the format. The Output Control window lets you specify the para-
meters, their units, and the order of their display in the Output window. 

The Output Print Content window available on the Tools menu (or Toolbar) lets you specify the content to 
include in the printed Output report and select the font to be used. 
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The Sort window opened from the Arrange menu (or toolbar) offers the ability to sort the Pipe Results or 
Junction Results tables according to the values in any of the columns. 

The Transfer Results to Initial Guess feature on the Edit menu (and Toolbar) sets all pipe and junction ini-
tial steady-state flows and pressures equal to the converged results, which causes future runs to con-
verge much faster.

You can view the input data for individual pipes or junctions directly from the Output window in one of two 
ways. First, if you press down the right mouse button on the pipe or junction number in the far left column 
of the table you will see the Inspection window. Second, if you double-click the pipe or junction number 
you will open the Properties window in read-only form where you can review input in detail.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and dragging 
the bars between each section to re-size them. Each section can also be hidden by clicking the arrow in 
the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Output window to re-size the text dis-
played on screen

Figure 1: The Output window displays output in text form

Right-click Context Menu Actions

There are several options available when right-clicking on a cell, row header, column header, or entire 
table in the Output window:

 l Column Header
 l Change Units -  Quickly redisplay the selected column in a different unit.
 l Sort - Sort the table in Ascending or Descending order on the selected column.
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 l Add "Parameter" for all Table Objects to Excel Export Manager - Add this column to 
the Excel Export Manager.

 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the column to the clipboard.

 l Row Header
 l Add all Object Parameters to Excel Export Manager - Add this row to the Excel Export 

Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Find on Workspace -Quickly locate an object on the Workspace.
 l Copy Selected Cell Data - Copies all of the values in the row to the clipboard.
 l Open Properties Window - Opens the properties window for the associated pipe or junc-

tion.
 l Table (upper left cell)

 l Add Object Table to Excel Export Manager - Add the entire table to the Excel Export 
Manager.

 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the table to the clipboard.

 l Cell
 l Add Object "Parameter" to Excel Export Manager - Add this cell to the Excel Export 

Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Create Design Alert -Create a Design Alert related to the selected object and value.
 l Copy Selected Cell Data - Copies the value of the cell to the clipboard.

Output Window Updates

Whenever you change the input model, all output windows are erased. This prevents you from changing 
your input model, forgetting to rerun it, and mistaking the previous Output window for the current model's 
results.

Steady Flow Results

Figure 2 shows the steady flow results in tables for pipes and junctions as specified in the Output Control 
window. Details of the steady state results at each pipe calculation station can be viewed on the Axial 
Points tab of the Pipes section.
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Figure 2: The Output window shows steady flow results in the Pipes and Axial Points tables and the various 
junction tables. Transient data is shown on the transient tabs.

Transient Flow Results for Pipes

You can review the transient results for any pipe station for any time which was saved to file as specified 
in the Simulation Duration panel. These results are shown in the Output window Transient Output table 
(Figure 3)

Figure 3 shows the transient flow results at the initial time step (which is equal to zero here). The columns 
of data shown in Figure 3 are specified in the Output Control window. Using the Time Slider will change 
what time step results are displayed.

Note that the pipe stations shown are those saved to the output file.

Figure 3: The Transient Output table in the Output window shows output results for pipe stations and at spe-
cified times
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Transient Max/Min Results for Pipes

You can review the maximum and minimum transient results for all pipes for all times. The data shown is 
not dependent on which pipe stations or time steps were saved to file. Figure 4 shows the Transient 
Max/Min table in the Output window. The parameters that are shown are the same as those specified in 
Output Control. However, there are four columns for each parameter. The four columns show the max-
imum and minimum values for the parameter, and the times at which each maximum and minimum 
occurs in the pipe.

Figure 4: The Transient Max/Min table details the maximum and minimum values for the entire simulation

Summary Max/Min Results

There is a summary version of the Transient Max/Min table, which is the default view. The version shown 
in Figure 4 is what is called the Detailed version. You can switch between detailed and summary views 
by selecting the option on the Output Control, Format & Action tab.

The summary version shows only maximum and minimum values for the entire pipe, as opposed to each 
pipe station. The summary also shows the pipe station that is the overall maximum or minimum for the 
pipe. Therefore, for each Output Control transient parameter there are six columns in the summary ver-
sion of the Transient Max/Min table. See Figure 5 for an example.

Figure 5: Summary version of the Transient Max/Min table

Transient Event Messages

When events occur at junctions during the transient simulation, a log of all events is displayed in the two 
Event Message lists. In the first list events are sorted by junction number. In the second list they are sor-
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ted by time. The list includes when check valves close (and re-open), relief valves open, control valves 
lose control (and regain it), as well as all standard event transients.

Results Diagrams

Results diagrams are available for steady state compressor/fan results (see Figure 6). These diagrams 
allow you display the information in a more intuitive manner, copy the image of the diagram to your clip-
board, or print the diagram. The option to show the results diagram can be found in the compressor/fan 
summary tab.

Figure 6: Compressor/Fan Results Diagram

Printing and Exporting

Data in the Output window can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to a delimited file suitable for direct importing into spreadsheet software
 l Exported directly to Excel
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 l Saved directly to an Adobe PDF file
 l Sent to the printer

The printed and Adobe PDF output follows the same flexible, organized, and accessible format as the 
Output window itself. 

Related Topics

Exporting Force Data 46
Output Messages & Warnings 530
Applied Standards 347

Output Control
Output Control  (see Figure 1) allows you to customize the parameters shown on the Output Window. 

Figure 1: The Output Control window selects parameters for the Output window. Here the Pipe Output para-
meters are shown. The other output parameters function the same way



Interface and User Options

- 343 -

Display Parameters

The Display Parameters tab controls the parameters to be shown for the pipes, junctions and summary 
reports. The output type is selected from the group of buttons at the top. For each output type, the list on 
the left side shows all available parameters for the selected report. For the pipe and junction output, this 
list can be viewed in alphabetized or categorized mode, which makes it easier to find a parameter.

Choose a parameter to be shown by selecting it on the left-hand list and clicking the Add button, or 
double-clicking the parameter name. The selected item will appear in the list on the right either at the bot-
tom or at the previously selected location. The list on the right shows the order of the parameters to be 
displayed in the output and the units (if any) in which to display the results.

You can change the order of the output by selecting a parameter on the right-hand list, then clicking the 
Reorder scroll bar on the far right or by clicking and dragging the row using the handle on the left. The list 
will be reordered accordingly. The output is presented from left to right in the order defined in this list.

The units used for a parameter can be changed by selecting the parameter then choosing the desired 
units from the adjacent drop-down list. By selecting the units of interest, you can obtain your results in 
whatever units you find most convenient and meaningful. This means that you can enter all your input 
parameters in one set of units (or a variety of units, for that matter), and have all your output parameters 
in a completely different set of units. 

To set selected units for both pipes, junctions and summary reports to the preferred units (set in the User 
Options window), click the Use Preferred Units button. If you change the units of a parameter and you 
would like that unit to be used for all similar parameters in the list or entire output, select the Same Units 
button.

You will note that some output parameters do not offer the ability to specify output units. These para-
meters either do not have units associated with them (such as Reynolds Number or friction factor), or are 
in fact echoes of input parameters (such as Pipe Nominal Size). 

Several Special Summary Reports can be displayed in the Output window. These include the following:

 l Compressor/Fan Summary
 l Valve Summary
 l Heat Exchanger Summary
 l Tank Summary
 l Pipe Transient Summary
 l Forces Summary

General

The General Section is the text area located at the top of the Output window. The project title, reference 
information and solution balance display are controlled here. 

You can enter a descriptive Analysis Title which will be used in the Model Data, Output and Workspace 
windows. A title is required and can have up to 100 characters.
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You can keep a lengthy explanation or any other documentation about your model in the Reference 
Information section. Names of projects, individuals, and assumptions can all be kept with the model. This 
information can then be included in your reports to improve tracking.

There is an option "Show Solution Balance Summary" that is defaulted to off. This option toggles the dis-
play of a general output tab showing the total flow entering and exiting each junction, as well as the sum 
of those flows. This can be helpful in verifying the results as well as in some troubleshooting cases.

Format & Action

The results can be automatically sent to the printer or saved to a file when the model has reached con-
vergence. Additionally, the results can be automatically saved as initial conditions when the model is run. 
By saving the results as initial guesses, the iteration time for AFT xStream to arrive at a converged solu-
tion is reduced. The initial guess can also be transferred manually by selecting Transfer Results to Initial 
Guesses on the Edit menu or Toolbar. The model can also be automatically saved after the initial con-
ditions are transferred. The valve state (open, closed or failed) can also be saved along with the initial 
conditions.

When enabled, the Wrap Table Column headers option makes the output tables wrap the column head-
ers as an extra line if the header is wider than usual.

There are four formatting methods for the pipe and junction output data:

 l Always Align Decimal Point on Output - allows magnitude of the data to be easily compared 
as the data is read down the column. However, a number whose magnitude is small may force lar-
ger numbers to show many digits. For example, assume that the minimum number of digits is set 
to four, and there are two output values: 1234.5 and .09876. These two values will be displayed in 
the output as:

 l 1234.50000
 l      0.09876

 l Show Only Number of Digits (not aligned) - forces the data to use exactly the number of digits 
specified, which may result in the decimal point location changing from value to value. Using this 
method with the above example and four digits, the output will be displayed as:

 l     1235.
 l 0.09876

 l Align Only When Max/Min < Limit- aligns the data on the decimal point only if the maximum 
value in the column divided by the minimum value is less than a limiting order of magnitude that 
you set. If this ratio is greater than the limit, then each value in the column will be exactly the num-
ber of digits specified. Using the above example with a limit set to 4 then 1234.5/.09876 = 12500 
or an order of magnitude of 5. This is greater than the limit. The entire column will not be aligned 
and will be displayed as:

 l     1235.
 l 0.09876

 l Use Exponential When Max/Min>Limit -  similar to the above method except that if the ratio is 
greater than the limit then the entire column will be shown in exponential format. Using the above 
example, the column would be shown as
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 l 1.235E+03
 l 9.876E-02

These formatting options are for the entire Output window; however, the last two are calculated and 
applied on a column basis. In other words, if you choose the third option one column may be aligned but 
another may not be. 

The output can be forced to always display in exponential notation by choosing the checkbox.

The Limit Event Options box can be checked to set maximum number of events which will be displayed in 
the Event Messages tabs that appear for cases such as valve transients. This can be useful in cases 
such as valve chatter.

For transient results, the maximum and minimum values for all selected parameters are shown in the Out-
put window. The results can show the max/min values for all pipe stations, or only the max/min values for 
anywhere in the pipe. You can choose which type of report you want by selecting Detailed or Summary in 
the Max/Min Transient Table Contents area. For models with a large number of pipe sections, the Sum-
mary report is generally preferable because of the time required to display the Detailed table.

The Grid Headers and Design Alert highlight colors can be configured to create a visually appealing out-
put for ease of reading.

The box next to Show Results Diagram Column can be unchecked to hide the column which allows easy 
access to the Compressor Diagram for Steady State compressor output.

Show Pipes/Jcts

You can choose which pipes and junctions are to be displayed in the Output window. Clicking a selected 
item in the list on the Show Pipes/Jcts  tab will deselect it. Clicking a deselected item will select it. This fea-
ture is especially useful when you are interested only in a certain area of the model.

You can quickly define the output you want by doing the following:

 1. Select the pipes and junctions on the Workspace
 2. Open the Output Control window and select the Show Pipes/Jcts tab
 3. Click the Workspace button for both the pipes and junctions
 4. Click the Show button

Library Connections

In the lower left of the Output Control window there is a Library checkbox. If this box is checked, your Out-
put Control parameters are setup as determined by the library to which you are connected. This is 
referred to as an active library. To make it inactive, un-check the box or change one of the Output Control 
settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are not being 
passed to the Output Control window. The library is thus inactive. To make it active, check the box then 
click the OK button.

If the check box is disabled, there is no connected library.
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Command Buttons

There are eight buttons at the bottom of the Output Control window. xStream has built-in default para-
meters, units and settings which you can choose by clicking the xStream Default button. You can also 
develop your own settings, tailored to your project or industry, and have these used by default (instead of 
xStream’s defaults). To make your own default, first select the output parameters, units and settings you 
would like to use then click the Set As Default button. Your settings will be saved and will be used each 
time any new project is initiated. If you make changes to the settings, and want to get back to your 
defaults, click the User Default button. The saved settings are updated only when you click Set As 
Default.

You can save the output settings (except for the selected pipes/junctions) to a file by pressing the Save 
Control Format button and entering a file name. These settings are loaded again by pressing the Load 
Control Format button and choosing the file name. For example, you may have a final report format that 
is always desired. You can load this format before generating final results. If you have another format you 
use for reviewing model accuracy, you may want a larger number of parameters in the output.

The format files you create can be placed on a network for sharing among a group or company.

If you have made changes you don’t want to keep, click the Cancel button. Click OK to use the setting 
you have specified

Related Blogs

Quick Guide to Custom Output

AFT Responds to 2020 Customer Survey Feedback

Output Parameters
A variety of parameters are available to display in the Output window depending on the junctions and 
loss models used in the model.

A description of each parameter may be seen by double-clicking the header in the Output Window table, 
and is also displayed below the Output Parameters table when that parameter is selected in the Output 
Control window (Figure 1).

Additional information can be found below for some of the output parameters.

Figure 1: A description is provided at the bottom of Output Control for the selected parameter

https://www.aft.com/support/product-tips/quick-guide-to-custom-output
https://www.aft.com/support/product-tips/aft-responds-to-2020-customer-survey-responses
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Cv Est./Kv Est.

The estimated Cv is only displayed when the valve does not have a defined Cv loss value. The estimated 
Cv/Kv loss coefficient is estimated using the sizing equations from the ANSI/ISA-75.01.01-2012 stand-
ard, as are discussed in the Valve Kv and Cv Loss Model topic.

Mass Flow Rate Net At Junction

Displays the total mass flow rate exiting the system through the junction, which is useful to display the 
flow exiting through junctions such as a relief valve. In other words, the Mass Flow Rate Net At Junction 
is equal to the flow rate into the junction from the pipes minus the flow rate out of the junction into the 
pipes.

Mass Flow Rate Through Junction

Displays the total mass flow rate through the junction for junctions connected to only two pipes. If the junc-
tion is connected to more than two pipes this parameter will be displayed as N/A. When more than two 
pipes are connected the user should refer to the output for the pipes connected to the junction in order to 
view the flow rate through the pipes. The user can add the "Mass Flow Rate Net At Junction" to view flow 
exiting the system rather than flowing out of the junction into a pipe.

Related Topics

References 499

Applied Standards
When an applicable standard is used in a calculation, an additional tab appears in the general area of the 
Output Window. This tab indicates what standard(s) were used for what calculations in the model.

Figure 1: Applied Standards when applied for Cv/Xt loss at a valve

Graph Results Window
The Graph Results window, shown in Figure 1, allows users to generate high quality printed graphs.
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The Graphing Panel offers several types of standard graphs for transient pipe or junction, profile, and 
force information. Users can also control graph content, plotting information for multiple parameters, junc-
tions, pipes, paths, or scenarios simultaneously. 

Results can be graphed as linear or log versus linear. 

Figure 1: The Graph Results window offers full-featured plot generation

Graph List Manager

Allows the user to create, update, and even replace unique graphs that can be regenerated with new 
data. Multiple graphs can be displayed at the same time and organized into separate Folders. The 
default folder is named “My Graphs” and more folders can be created using the “New Folder…” icon on 
the Graph List Manager Toolbar or by right clicking on “My Graphs” and selecting “New Folder…”

Once a folder is created and selected, a Graph can be added to its list by selecting the “Add Graph to 
List” icon found on the Graph Results Toolbar. This can also be done by right-clicking anywhere on the 
graph. Once Graphs are in Folder individual Graphs can be generated in unique tabs or each Graph in a 
Folder can be displayed in a single tab by right clicking on the Folder and selecting “Load Current Folder 
Graphs in New Tabs” or “Load Current Folder Graphs in Same Tabs”. These options are available in the 
Graph List Manager toolbar as well. Other options that can be found by right clicking on a Folder or 
Graph in the Graph List Manager or on the toolbar are:

 l Load Graph in Current Tab – Regenerates the graph in the currently active tab.
 l Load Graph in New Tab – Creates a new tab and regenerates the graph there.
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 l Load Current Folder Graphs in New Tabs – Regenerates all the Graphs in a Folder in separate 
tabs.

 l Load Current Folder Graphs in Same Tab – Regenerates all the Graphs in a Folder in a single 
tab.

 l Keep Folder Display Layout – Saves the current layout in the Graph Results window if multiple 
graphs have been loaded into one tab from a folder.

 l Reset Folder Display Layout – Resets the layout in the Graph Results window if multiple graphs 
have been loaded into one tab from a folder.

 l Print Preview Selected Item - Opens graph item directly in the Print Preview window.
 l Move Graph Up – Moves the selected Graph up one level. 
 l Move Graph Down – Moves the selected Graph down one level. 
 l Rename Graph… – Changes the name of the Graph.
 l Duplicate Graph – Creates a copy of the selected Graph with a new name.
 l New Folder – Creates a new Folder where more Graphs can be saved to.
 l Delete Graph – Removes Graph from the Graph List Manager.
 l Move To Folder – Moves the selected Graph to a previously existing Folder or a new Folder.

Graph Results Toolbar

The Graph Results Toolbar also has many options that are available by right clicking on the Graph Res-
ults space at any point. These options are:

 l Select Graph Parameters – Select the type of Graph to create and its parameters.
 l Add Graph To List – Saves the Graph to the currently active list allowing it to be regenerated in 

the future.
 l Update Current Graph In List – Saves any changes to the current graph that have been made. 

(e.g. Changing the Graph Title or Line Style). Note that it is preferred to use the Replace Graph in 
List option if changes to the parameters or objects/paths being shown have been made. 

 l Replace Graph In List – Replaces the graph highlighted in the Graph List with the current graph 
that is shown. 

 l Copy Graph Image – Copies a .jpeg of the Graph to the clipboard
 l Copy X-Y Data – Copies the X-Y used by the Graph to the clipboard
 l Show Data – Displays the X-Y data used to generate the graph in a column to the right of the 

graph
 l Create Annotation – Add an annotation to the graph that can be formatted and saved to be 

reloaded with the Graph in the future.
 l Show Legend – Toggles the legend off and on.
 l Show Check Boxes in Legend – Adds a check box in the legend that allows the user to select-

ively turn off and on certain curves in a Graph without having to recreate a new Graph.
 l Show Cross Hair – Displays and cross hair that shows the cursors X-Y values along the X and Y 

axis. This also displays the nearest data point X-Y values in a tooltip. If this feature is used at the 
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same time as "Show Data" the Cross Hair will focus on that highlighted data point and display its 
values in a tooltip. The user can also change what data point is highlighted with the arrow keys 
and the Cross Hair and tooltip will move to that data point.

 l Show Range Finder – Adds a toolbar at the bottom of the graph that displays the entire X axis, 
but allows the user to zoom in to a specific range by clicking and dragging the handles on either 
side of the range finder.

 l Show Junction Locations – Add a vertical line with the number of the junction labeled at the loc-
ation of the junction along the flow length.

 l Manage Junction Locations – Allows junction labels on the graph to be shown/hidden indi-
vidually.

 l Zoom to 100% – Resets the focus of the graph to 100%
 l Format – Allows the user to change the Graph’s format. Including

 l Header, Axis, and Legend names and fonts.
 l X and Y scaling
 l Line color and thickness

Graph Outline Colors

The active graph will always have an outline which indicates what state it is in.

 l Orange – Graph not added to list
 l Dark Green – Graph added to list
 l Light Green – Graph added to list, but changes have occurred. These can be saved and make 

they graph dark green by selecting “Update Current Graph in List”.

Graph Tab Icons

Each Graph Type has a specific color associated with it. This color will display in the box on the tab for 
the Graph. The colors are below:

 l Transient Pipe – Dark Red
 l Transient Junction – Dark Gray
 l Profile – Purple
 l Forces – Yellow
 l Frequency – Light Brown
 l Blank Graph – Light Gray

These tabs also display if the Graph in the tab is not saved or has been changed from the original Graph 
List item by showing a small yellow square over the tab's icon. If the current graph has been saved, there 
will be no yellow square.
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Graph Tab Actions

 l New Tab – Creates a blank tab in which a new type of Graph can be generate and added to the 
Graph List Manager

 l Tab Actions
 l Close Active Tab
 l Close All Tabs
 l Close All But The Active Tab
 l Two Vertical Tab Groups
 l Two Horizontal Tab Groups
 l Reset to Single Tab Group
 l Tabs on…. – Selects the location of tabs (defaults to the bottom of the Graph)

 l Graph Tab Selection – Selects a Graph for the Graphs currently in the tabs based on name. 

Printing and Exporting

The Graph Results image can be:

 l Copied to the clipboard
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The x-y data in the Graph Results graph can be:

 l Copied to the clipboard
 l Exported to a delimited file suitable for direct importing into spreadsheet software

Animations of graphs can be saved as .wmv or .mp4 files.

Data Point Limitations

By default, the maximum number of data points xStream will plot for an individual graph is 500,000, 
though users can change this limit under the General -> Other section of the User Options window. This 
limit is in place to help ensure users do not encounter memory issues related to plotting large numbers of 
data points. The allowed range of data points plotted is 10,000 - 1,000,000. The data point limit is applied 
to an individual graph. Two parameters plotted as stacked graphs count as two separate graphs. Two 
parameters plotted with one as a secondary y-axis graph count as one graph. One parameter plotted for 
two scenarios on the same graph counts as two graphs (i.e. the data point limit is essentially doubled 
from a single-scenario graph to a two-scenario plot graph). 
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When a user attempts to generate a graph that exceeds the maximum number of data points, xStream 
will skip data points in order to remain under that limit. The frequency of skipped data points is pro-
portional to the amount by which the generated graph exceeds the maximum number of data points. 
When data points are skipped, there is the potential for important data points to be excluded from the 
graph such as maximum or minimum values. 

Users can take the following steps to avoid running into this issue, and to double-check that the graph 
gives an accurate representation of the results and does not skip any maximum or minimum data points:

 l Increase the limit in the User Options window (the time required to load a graph will increase)
 l Plot fewer curves in the graph
 l Graph data for limited amounts of time rather than the entire simulation time
 l Save fewer output data points from the Simulation Duration panel in the Analysis Setup window
 l Double check results shown in the graph with transient output shown in the Output window. Users 

can either reference the Transient Output, showing output values for every time step and pipe sec-
tion data is saved for, or examine the Transient Min/Max values shown for the parameters selec-
ted in the Output Control window.

Related Topics

Animating Graph Results 50

Related Blogs

Quick Guide to Custom Output
SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Impulse which allows users to sim-
ulate settling slurries.
PFA Module 
Pulsation Frequency Analysis 
Module
An optional add-on module to AFT 
Impulse which allows users to 
determine resonant frequencies in 
their system.

Quick Graph Formatting Window
The Quick Graph Formatting window allows you to customize the plot by giving you control over the 
many aspects including:

https://www.aft.com/support/product-tips/quick-guide-to-custom-output
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 l Axis titles and font sizes
 l Legend text and font size
 l Line thicknesses and basic color sets
 l Axis min and max values

You can save the settings you set up by clicking the Save button. If you make changes to the settings, 
and want to get back to previous settings, click the Load button.

Graph Types
AFT xStream offers several types of graphs to help users better understand and interpret their data. 
Each type of graph is given a brief description below.

Transient Pipe

Transient pipe results can be plotted against time for any pipe station that is saved to the output file. By 
default, all stations for each pipe will be saved to the output file. The amount of pipe data saved can be 
changed in the Simulation Duration panel.             

The user can plot the data for the entire simulation, or for a user specified time frame. 

One or more parameters can be graphed by using the Add button with the green plus sign. The Remove 
button can be used to eliminate extra parameters.  Parameters can either be plotted in stacked graphs, 
or two parameters can be plotted on the same graph using the secondary axis. To move a parameter to 
the secondary access, add it below the parameter that will be on the primary access, then click the right 
blue arrow button, or double-click on the gray square to the left of the parameter. This will cause the para-
meter to be indented, as shown in Figure 2.

Further, if Design Alerts are specified for the pipe (e.g., max/min operating pressures), these can be 
cross-plotted against the transient data by selecting the check box under "DA".

Figure 1: Creating a graph with a parameter on the secondary axis

Transient Junction

Similar to transient pipe results, transient junction results can be plotted vs. time for any junction that is 
saved to the output file. Junction data includes items such as compressor speed and valve Cv.
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Profile

This graph category allows users to plot the selected parameter(s) along a flow path. In order to generate 
this graph, the specified pipes in the Select Graph Parameters window that comprise the path must form 
a single, continuous path. If they do not, an error message will appear listing the pipes which are pre-
venting the path from being continuous. The independent variable in these graphs is the length along the 
flowpath.

A path of pipes can be specified in one of two ways. First, the user can select the pipes in the displayed 
list. Additionally, you can select the path on the workspace, and then use the Workspace button on the 
Select Graph Parameters window to automatically select all pipes currently selected on the Workspace. 
These methods permit only a single path to be specified. 

One or more flow paths can be specified using groups. Only those groups that consist of a continuous 
pipe sequence will be displayed as an option in the Select Graph Parameters window. 

The results can be the values at a particular point in time, or the overall maximum and/or minimum val-
ues. You can also cross-plot Design Alerts, the max/min values, and the steady-state results. This is 
done clicking the check boxes underneath "Mx" for maximum, Mn" for minimum, "SS" for steady-state, 
and "DA" for design alerts. 

All profile graph types support animation. Animating graphs is discussed further in Animating Transient 
Results.

Forces

If transient force sets have been defined in the Forces panel, the resulting force data can be plotted vs. 
time. Force sets selected from the list of defined force sets will be plotted. The unbalanced transient force 
data can be plotted for the entire transient simulation, or the user has the option of selecting a specific 
time frame to display. 

This force data can also be exported for analysis in pipe stress analysis software. 

Frequency

(PFA module only) As part of the pulsation frequency analysis, the tab will appear to plot the frequencies 
identified for the system. 

Multi-Scenario Graphing Features

Users can plot information from multiple scenarios in the same plot. In the Select Graph Parameters win-
dow, the button for 'Multiple Scenarios' allows users to select the scenarios in the model they wish to plot 
for a particular graph. The scenarios being plotted in the graph must have the same pipe layout for all 
scenarios, but can have different sectioning.
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When creating multi-scenario profile graphs, the current scenario will determine start/stop time, time 
step, junction label locations, and design alerts that are shown on the graph. For multi-scenario graphs 
with different time steps/sectioning groups for multiple paths will not be allowed.

The active scenario must be included in a multi-scenario graph. When creating a new graph, users are 
not able to deselect the current scenario. When a user loads a saved Graph List Item that does not 
include the active scenario, xStream will add the active scenario into the Graph List Item, but will not save 
the active scenario into it. 

Scenarios can be selected using the Multi-scenario... button as shown in Figure 2 below.

Figure 2: Graph Parameters window showing Multi-scenario selection options

PFA Module 
Pulsation Frequency Analysis 
Module
An optional add-on module to AFT 
Impulse which allows users to 
determine resonant frequencies in 
their system.
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Basic Graph Tutorial
Generating graphs is a powerful tool for analysis. Below are step by step instructions about how to make 
and manage graphs from one of the example models. Many of the graphs created in this example will be 
multi-scenario graphs. However, the information discussed within is the same regardless of which scen-
arios are selected.

For this example, the US - Gas Turbine Fuel System model file was used. A copy of the completed model 
can be downloaded from the Gas Turbine Fuel System example, or can be found in the AFT xStream 
installation folder.

Open the model and create three children of the 2 Sections Minimum Per Pipe scenario. The three chil-
dren scenarios evaluate three different closure times of the Premix Gas FCV #2 valve (J11): 0.01 
seconds, 0.1 seconds, and 0.5 seconds. Run the three scenarios and return to the 0.01 Second Valve 
Closure scenario.

To skip to different sections of this tutorial, use the links below:

 l Transient Junctions and Saving Graphs
 l Transient Profiles and Animations
 l Displaying multiple graphs simultaneously
 l Creating graphs from the Workspace

Transient Junctions and Saving Graphs (return to top)

Figure 1: High Pressure Steam Example

Go to the Graph Results Primary Window and determine what type of graph you want to generate. The 
first graph created in this example will be a Transient Junction Graph. The Transient Junction is one of 
several different types of Graphs that can be made. This graph is created by first selecting the Transient 
Jct tab and selecting the desired parameters. The only junction with saved transient data will be the valve 
J11. Add this junction to the “Graph These Junctions:” column by double-clicking the junction ID number, 
or selecting the “>” symbol. Select “Cv” as the parameter. Select all three valve opening children 
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scenarios using the Multi-scenario... button, and then select “Generate”. This creates a plot of “Cv vs. 
Time” for all three scenarios on the left.

Note that the Graph Guide, accessed by clicking on the "What Would You Like to Do?" icon on the upper 
right of the graph, will guide you through the process of creating a graph

Note: The model file used in this tutorial does not have force sets applied, so the Forces graph tab is 
not available in the Graph Parameters area. The Forces tab will be available if force sets are 
defined and applied in the Analysis Setup window.

Figure 2: Valve Cv vs. Time

The Graph has been created, but has not yet been added to the list under "My Graphs". To add this 
Graph to the list, first select the “Add Graph to List” icon on the Graph Results toolbar (this option and 
many others can be accessed by right-clicking on the Graph at any time). Name the Graph “Transient 
Junction - J11 Cv”. The Graph has now been saved and will be easily regenerated with the same format if 
the output changes. The name of the saved Graph can be seen in the Graph List Manager, with two small 
squares in the icon associated with it indicating it is a multi-scenario graph. The border of the Graph has 
also changed to dark green along with borders of the parameters and the name of the Graph in the 
Graph List Manager, indicating that the Graph is current, saved, and that the displayed parameters are 
the ones used to generate the Graph.
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Figure 3: Adding a Graph to My Graphs

Formatting options are available by selecting “Formatting” above the different graph types. When format-
ting changes occur the border of a Graph will change from dark green to light green, indicating a change 
has been made to a graph in the Graph List. Another indicator that the Graph is not saved is the small yel-
low square over the icon on the tab. Here, the title has been changed from “Cv vs. Time” to “Valve J11 Cv 
vs. Time”. Once the formatting settings have been changed, this change and other formatting changes 
are not retained to the Graph unless “Update Current Graph in List” is selected.

Figure 4: Update Formatting Changes to Graphs

After selecting “Update Current Graph in List” the border has changed back to dark green and the yellow 
square has disappeared. This indicates that this is the current formatting of this graph, and that regen-
erating this graph will generate the same graph (according to the current model output).
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Figure 5: Valve Cv graph with updated formatting changes

Transient Profiles and Animations (return to top)

The next step in the example is to make a new Graph in a separate tab. This is done by selecting the 
“New Tab” icon in the lower right. This Graph will be a “Profile” Graph that displays Static Pressure along 
the length of the flow path from the compressor through J11 and to Combustion Basket #3. Select pipes 
1, 2, 3, 6, 9, 10, and 11 in the system and change the parameter to “Pressure Static” with units of length 
in feet and units of pressure in psig. Make sure that the Mx and Mn boxes are checked to display the max-
imum and minimum static pressures. Make sure "Animate Using" is set to none.

Note: An easy way to select the pipes in a longer path would be to select them in the Workspace, then 
click the Workspace button under Pipes to automatically select the desired path.
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Figure 6: Generating a Profile plot with Min and Max Pressure Static

The graph shows the minimum and maximum static pressures during the transient simulation for each 
pipe station along the flowpath. Save this new graph as a new Graph List item. The two graphs we have 
made can be switched quickly between by either selecting the graph from the list, by clicking on the cor-
responding tab, or using Graph Tab Selection.

Figure 7: Pressure Static vs. Flow Length Profile added to Graph List

This is a useful graph, but animating the pressure profile over time can provide even more information. 
Animating from the Output file requires that all data for the pipe stations being animated to be saved to 
the Transient Output File in the Pipe Sectioning and Output panel, which is done by default.

Select the Animate Using Output option, then click generate.
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After selecting generate the Graph will now allow for animation with options to Play, Record, Stop, and 
manipulate the animation in other ways. The recorded animation can be exported to a video file for con-
venience.

Figure 8: Max/Min Profile Graph with Animation

Displaying Multiple Graphs Simultaneously (return to top)

Another option that is available is to add another parameter to the graph. This is called generating 
stacked graphs. To do this select “Add” next to “Select Parameter”. This will graph an additional para-
meter that shares the same X-Axis as the original parameter. For this example, select “Pressure Static” 
as the parameter, but with units in barG rather than psig.
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Figure 9: Stacked Pressure Profile with different units

We now have the same plot twice, which is not the most efficient way to view this data. A better way 
would be to have the secondary parameter (which could be any of the available options for a profile plot) 
on a secondary y-axis. This can be done by double clicking on the arrow to the left of “Pressure Static: 
barG” or by selecting the blue right arrow on the “Select Parameter Row”. This will visibly indent the sec-
ondary parameter. When the Graph is regenerated it will now only be one plot of Pressure Static vs. 
Length, but it will have units displayed in psig on the primary y-axis and units of barG on the secondary y-
axis.

Figure 10: A Single Graph with Alternate Units on a Secondary Y-Axis
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Update the Current Graph in List using the toolbar button. The Graph is now complete and can be easily 
regenerated if input data is changed on the Workspace and the model reran. It can also be used to gen-
erate the same graph for data from other scenarios. 

Figure 11: The Resulting Graph when it is Updated

It is now possible to close the Graphs and regenerate them either in their own tabs or all graphs in a 
folder in the same tab. To test this out, close both Graph tabs and then create a new "Graph on same tab" 
folder from the right click menu. Right click each of the graphs made in this tutorial, and choose to move 
the graph list items to the "Graph on same tab" folder.

Right-click on the "Graph on same tab" folder and then choose “Load Folder Items” and then “Same 
Tab”. After the Graphs have been loaded in the same tab, the tab icon changes to an orange square, 
indicating that multiple Graphs are being displayed on one tab. All graphs will now be animated, with a 
vertical red line appearing on the graphs with a time axis. This red line will move over the animation time 
to compare values more readily.

Depending on the monitor display being used, or the number of graphs being displayed, this view may be 
easy to view or difficult to see data. For the sake of this example, we've kept the display size relatively 
small, meaning it is more difficult to view the data on all the graphs. However, with larger monitors avail-
able, it is likely easier to view this data.
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Figure 12: All graphs loaded into the same tab

Other ways to view multiple graphs simultaneously are to plot them as stacked graphs, as we did pre-
viously for our pressure profile in psig and barG, or to plot saved graph items in two tabs either stacked or 
side-by-side. Right-clicking on a Graph-Tab at the bottom of the window shows the options for displaying 
two separate tabs.

If we have two Time graphs with the same x-axis, we can display them in a single, stacked graph. This 
approach to viewing graphs can be especially helpful in examining how a junction transient is affecting 
output parameters nearby. To create a stacked graph of multiple Graph List Items, first make sure both 
items have the same time scale. Then, move them into their own folder. Here, we've moved the Com-
bustion Basket #3 Profile graph back to the My Graphs folder and moved the example's Combustion Bas-
ket #1 Temperature vs Time graph to the "Graph on same tab" folder. Finally, right-click the "Graph on 
same tab" folder, select "Load Folder Items", and then the "Stack Common X-Axis in Same Tab" option.

Figure 13: Load Current Folder Graphs in Same Tab - Stack Same x-Axis
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As we just saw with the Profile Graph Folder, it is possible to create more Graph Folders other than “My 
Graphs”. Saved Graph List Items can then be organized into different folders and can independently be 
generated into their own tabs or a whole folder of Graphs can be generated into one tab. Using multiple 
folders will allow the user to create many unique variations of animations or other Graphs that can be 
used to convey transient output in a meaningful and intuitive manner.

Creating Graphs from the Workspace (return to top)

Some graphs can also be generated directly from the Workspace after running the model. To create a 
graph for the valve inlet and outlet static pressures from the Workspace right click on the valve J11, 
choose “Create Transient Graph for Pipes”, and select “Pressure Static”.

Figure 14: Creating Transient Graphs of the Inlet/Outlet Pipes Connected to a Junction

This will automatically generate the requested Graph with default units. This is a quick and easy way to 
see the pressure difference across the valve. Notice that this graph will be a Transient Pipe graph, since 
the pipe inlet/outlet stations are being used to graph the equivalent valve inlet/outlet values.
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Figure 15: The Pressure Static vs. Time of the Two Pipes Connected to Valve J11

Make one more Graph from the Workspace by right-clicking pipe 10, selecting “Create Transient Graph 
for Pipes”, “Mass Flowrate”, and then “Outlet Only”.

Figure 16: Graph the Changes to Mass Flowrate vs. Time from the Workspace

This will add a Graph of the Mass Flowrate at the Outlet Station of Pipe 10 as is shown below in Figure 
17.
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Figure 17: Mass Flowrate vs. Time at the Outlet of Pipe P10

User Options Overview
An array of User Options are provided in a single window that can be found in the Tools menu.

The General section of the User Options window provides the following options:

 l Choose to show the Startup Options window at startup
 l Choose to show the New Version Welcome window at startup
 l Enabling orthogonal drawing tips
 l Whether to confirm before clearing output results
 l Enabling Highlighting Required Data on Property windows
 l Options for opening models with scenarios
 l Visual Themes and Styles
 l The default location of the Quick Access Panel
 l Number of data points to show in input tables
 l Maximum Number of Data Points per Graph 
 l Setting parameters for "button flashing" for curve fit buttons on Junction Property windows

User Option Defaults

There are several buttons at the bottom of the User Options window. There are built-in AFT Default para-
meters, units, and settings which you can choose by clicking the Reset to xStream Defaults button. You 
can also develop your own settings, tailored to your project or industry, and have these used by default. 
To make your own default, first select the parameters, units, and settings you would like to use, then click 
the Save All As New User Defaults button. Your settings will be saved and will be used each time any 
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new project is initiated. If you make changes to the settings, and want to get back to your defaults, click 
the Load All User Defaults button. The default settings are updated only when you click Set All As New 
User Defaults.

If you have made changes which you don’t want to keep, click the Cancel button. Click Save and Close to 
use the settings you have defined.

Unit System
You can set the units you prefer to use in AFT xStream in the Unit System section. Once selected as the 
preferred units, these units appear as the default units in all instances in which empty fields exist in the 
model input. Any model input existing prior to changing the Preferred Units will maintain the units used 
when the data was input, regardless of changes made to unit preferences. After saving your preferred 
units, a window appears asking if you would like the output parameters to be displayed in your preferred 
units. Choose Yes if you do want the output parameters to be displayed in the preferred units, or No if you 
want the output parameters to be displayed in the units previously used.

Preferred Units

To customize the units used by AFT xStream, first select Preferred Units under the Unit System section 
in the User Options window under the Tools menu.

AFT xStream allows you to specify certain units from a large selection to be displayed in the main inter-
face.

The primary selection is the Unit System: 

 l US - Only US units will be available
 l Metric - Only Metric units will be available
 l Both with US Defaults - All Units will be available, but US units will be chosen by default
 l Both with Metric Defaults - All Units will be available, but Metric units will be chosen by default

Additionally, a filter can be applied to limit the selection:

 l All Units - all units for the Unit System will be displayed
 l Common Only - only "common" units will be displayed
 l Common Plus Selected Industries - Units particular to certain industries can be included with 

the common units

If the selection has been limited to Common Only, there may units common for certain industries no 
longer present. The Additional Units for Industry section allows the user to append additional sets of units 
to the Common unit set. For example, barrels/day is a common unit in the petroleum industry but not 
many others. Checking the Petroleum box adds these units to the main interface.

Preferred Units allows fine grain control over what unit in the above selection is displayed as the default 
when defining model input. For example, it may be desired to have a particular parameter such as pipe 
diameter default to inches, while keeping other parameters metric. This area allows the user to define 
such defaults.
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Show/Hide Unit Items

For additional control of the available units, select Show/Hide Unit Items under the Unit System section. 
From here, you can select which units for each Unit Family Type you would like to be available for the 
model input and output by checking the box next to each unit you would like to be used. Removing units 
that you do not wish to use as input or view as output can simplify your modeling and reduce errors asso-
ciated with incorrect units.

Edit Custom Unit Names

A custom unit name can be assigned to display different names in the interface for units. For example 
"feet/min2" could be changed to display as "ft/min2".

To assign a custom unit name choose the appropriate Unit Type from the drop-down and enter the Cus-
tom Unit Name in the table.

To speed up the process of entering custom unit names the units can be exported to *.csv and re-impor-
ted as follows:

 1. Click "Save Units to CSV" and save the file where it will be easy to locate
 2. Open the *.csv file in a spreadsheet editing software like Excel, and fill in the desired custom unit 

names in the Custom Name column
 3. Save the *.csv file
 4. In the User Options window click "Load Units from CSV" and select the edited *.csv file

Note: To use units with superscripts, make sure the *.csv file is saved with UTF-8 encoding. This can 
be done in Excel by choosing save as and selecting "CSV UTF-8" as the file type.

Note: Regions outside the United States that use commas as the decimal separator may have *.csv 
files that are delimited with semicolons (this was a change made by Microsoft). AFT software 
requires true comma delimited files. A workaround for such regional users in Excel is listed 
below.

Workaround for regional users with alternate decimal separators (e.g. Europe):

 1. In Excel go to File > Options > Advanced
 2. Under the Editing Options heading, uncheck the box for "Use system separators"
 3. Change the "Decimal separator" to a period symbol (.)
 4. Change the "Thousands separator" to a comma (,)
 5. Save the *.csv file
 6. Re-check the "Use system separators" option to revert to the default Excel settings
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Workspace
In the Workspace group of the User Options window, you can change the symbols used, default text con-
tent, and location of the text on the Workspace. Note that all display changes are made only for the user's 
convenience/preference and do not affect the model calculations. Additionally, many display options 
available in the User Options window are also available in individual pipes and junctions.

Grid

A traditional 2-D grid or an Isometric grid can be displayed on the workspace for modeling convenience 
based on the Pipe Drawing Mode that is selected. The number of lines in the grid can be adjusted to cre-
ate a grid that is fine, medium, or coarse. The grid can be hidden or shown by checking or unchecking the 
Show Grid box accordingly. If the grid is shown, the grid line pattern can be solid or dashed. The pipes 
and junctions can also be snapped to the grid, which moves junctions and pipe end points to the closest 
intersection of grid lines.

The Pipe Drawing Mode and the toggle to Show Grid can also be found on the Arrange menu.

Pipes

The display of pipe lines, closed pipes, pipe endpoints, and pipe direction arrows can be adjusted accord-
ing to your preferences here.

The default pipe line thickness for new layers can be adjusted by selecting the desired pixel value in the 
box next to New Layer Default Pipe Line Thickness (pixels).

You can close a pipe using the Special Conditions feature which closes the pipe to flow at both ends. 
From the User Options window, you can select how you would like a closed pipe to be displayed on the 
Workspace. The options include a solid line, dashed line, a dotted line, and dashed-dotted combinations. 
The color of the line is still determined by the visible Workspace Layers.

When building a model, xStream automatically adjusts pipe endpoints to the centers of junctions for user 
convenience. If you would like to disable this feature, uncheck the box next to Automatically Adjust Pipe 
Endpoints to Junction Centers.

Under the Pipe Direction Arrows section you can select the size of arrow you would like to be displayed 
as a percentage of the pipe thickness. Additionally, you can opt to not show a pipe direction arrow by 
checking the option Do Not Show Arrow.

Note: The pipe direction arrow is used as a reference positive flow direction and does not change dir-
ection on the Workspace if the calculated flow is in the opposite direction indicated by the arrow. 
Instead, the flow is reported as a negative flow in the Output.

Junctions

The junction icon style displayed on the Workspace can be chosen in Junctions underneath the Work-
space section in the User Options window. The two available icon styles include classic icons and trans-
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parent icon. Classic icons are the icons used in earlier versions of AFT products in which each junction is 
surrounded by a box, and transparent icons are updated icons not surrounded by boxes.

You can also select the icon size and label location for junctions. To adjust the size, click on the box 
below Icon Size in the Junctions window and choose the percentage of the default size that you would 
like the junction icons to be sized. For the junction label location, you can select from any of the eight loc-
ations shown in the window by clicking on the selection circle that corresponds to the desired location.

Using the default transparent icon style, the appearance and color of icons for new junctions can be set in 
the Toolbox, and icon size and color for existing junctions can be set in Layer Settings. Junction icon and 
rotation can be edited for existing junctions by right clicking the junction on the Workspace and selecting 
Customize Icon.

Note: Junction and pipe labels can be moved individually on the Workspace by using the mouse to 
drag and drop the label according to your preferences.

The final option  is to enable or disable a dotted outline around a closed junction. If this option is enabled, 
a dotted box will appear around the junction when it is closed with Special Conditions. If this option is dis-
abled, no dotted box will appear.

Labels

When a pipe or junction is inserted onto the Workspace, the next whole number available at the incre-
ment specified in this panel is automatically assigned to the new pipe and/or junction. xStream's default 
is to increment pipe and junction numbers by one. Therefore, the first pipe you place on the Workspace 
will automatically be labeled as Pipe 1 (P1 for brevity), the second will automatically be labeled P2, etc. 
Junctions are labeled in a similar fashion with a "J" in front of the number to indicate it is a junction. 
However, if you choose a different increment in the User Options window for pipes and/or junctions, the 
automatic numbering will increment pipes and/or junctions according to the specified number. You can 
renumber any pipe or junction individually as long as the number is not already used in any scenario of 
the model. If a number at the increment is already in use, xStream will skip to the next available whole 
number. Pipe and Junction label numbers are limited to integers between 0 and 99,999.

Note: A unique label must exist for each pipe and junction on the Workspace. Therefore, there cannot 
be more than one P1 in the model, but a P1 and J1 can exist simultaneously because the lead-
ing letter is different.

Whether pipe/junction names and/or numbers are displayed is controlled ultimately by Workspace Lay-
ers, but the Pipe/Junction Default Display setting allows the user to set their preferred default behavior.

Users can also choose whether the pipe and junction labels should be moveable at all times, or if they 
should only be moveable when the user is holding down the shift key with the Allowable Workspace 
Label Movements setting. Restricting the movement of labels can be especially helpful to users with com-
plicated or dense models, as it is possible to inadvertently grab a label when attempting to reposition or 
select an icon on the Workspace.
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Colors and Fonts

The Colors and Fonts item located under the Workspace section in the User Options window allows you 
to change the colors of the following parameters seen on the Workspace:

 l Pipe and Junction Symbols 
 l Junction Labels
 l Pipe Labels
 l New Layer Default Pipe Color
 l Selected Items 
 l Undefined Numbers 
 l Workspace Background Base Scenario 
 l Workspace Background Children  
 l Workspace Background of Grandchildren
 l Workspace Background 3rd Generation
 l Workspace Background 4th Generation +
 l Grid 

The currently selected color for each parameter is shown to the right of the parameter. To change the 
color for any parameter, either select the box containing the parameter's color and then click on the Set 
Color box under the list, double click on the box containing the color you would like to change, or click the 
"..." button next to the color of the parameter you would like to change. A color window pops up that 
allows you to choose from 48 basic colors, or to create a custom color by clicking anywhere in the color 
box and adjusting the slider at the right of the box to create the color of your choice. If you would like to 
save the custom color for use in other areas of the model, click on any empty box underneath Custom col-
ors: and then click on the Add to Custom Colors box below the color box. When finished with selecting a 
color, click OK on the bottom left of the Color window.

To have the background color of the children and grandchildren scenarios maintain the same color as the 
base scenario, click on the Set All Background Colors to Base Color button under the Parameter/Color 
list.

Other

Workspace Symbols representing pipe or junction special conditions and inflow or outflow are listed in 
the Other item within the Workspace group in the User Options window. These symbols can be disabled 
by unchecking the box on the left of the list. Users can also change what symbol will be used by clicking 
in the Symbol box on the right and typing the new desired symbol.

If there is a background image in a model, the image size can be controlled from this panel. To scale a 
background picture, enter a Scale Multiplier in the box underneath Background Picture Scaling.
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Parameters
The Parameters section of the User Options window allows you to specify some default parameters and 
model input when a new pipe or junction is added to the Workspace. Changing any of the parameters in 
this window adjusts the specified default pipe and/or junction input parameters and/or values to simplify 
the modeling process and to prevent the user from having to enter repetitive data.

Pipes and Junctions

Pipe and Junctions, located within the Parameters section of the User Options window, allows you to spe-
cify default pipe and junction input information.

Under the Default Pipe Data box in this window, you can enable or disable the option Use Most Recent 
Pipe Size Data. If you enable Use Most Recent Pipe Size Data, the pipe property windows of new pipes 
added to the Workspace will automatically contain pipe diameter, material, and friction information from 
the most recently entered pipe. This prevents you from having to re-enter the pipe diameter, material, 
and friction model information in the case that several pipes require this same input. Disabling this fea-
ture leaves the pipe diameter, material, and friction model for each new pipe added to the Workspace as 
the default specified in the User Options window.

The Default Junction Elevation box allows you to select the default junction elevation you would like for 
all new junctions added to the Workspace. If you select Unspecified in this box, the junction elevation 
field in the Junction Properties window remains empty until you specify each junction elevation indi-
vidually. If you select Use Most Recent, the junction elevation of a new junction added to the Workspace 
is shown as the elevation of the most recently specified junction. If you select Specified, you are able to 
input an elevation of your choice that will automatically be input into each new junction that is added to 
the Workspace.

The Default Design Factors box allows you to add a default Design Factor to each pipe shown in the list 
on the Pipes and Junctions window. Setting a default design factor for pipes can be especially useful 
when applying safety factors on given equipment.

Graphs from Workspace

Various parameters can be graphed quickly by right-clicking on a continuous selection of pipes from the 
Workspace and choosing the Generate Profile Graph for Pipes option. The graph parameters that are 
available from the right-click menu can be customized.

Parameter Type

Parameter Types, located within the Parameters section of the User Options window, allows you to spe-
cify the flow rate type, head/pressure type and Efficiency/Power types you would like as the default 
option wherever one of those parameter types is defined in the model. The default flow rate type can be 
set to either mass flow or volumetric flow, the default head/pressure type can be set to either head or 
pressure, and either efficiency or power can be selected as the default for efficiency/power. For example, 
when defining a resistance curve to describe the hydraulic pressure loss behavior through a general com-
ponent, you are required to enter data that describes pressure loss at given flow rates. When defining the 
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pressure loss behavior here, you can either define the flow rate as a mass or volumetric flow rate, and 
you can define the head/pressure loss as either a head or pressure loss. Adjusting the default option of 
these parameter types to fit your available data not only helps to make data input more efficient by pre-
venting you from having to constantly change parameter type, but it also helps to minimize input errors by 
adjusting the required input to the form of your available data.

Files
The Files section of the User Options window allows you to specify file locations for saving models, lib-
rary folders, user settings, and model backup files. You can also customize the model backup file set-
tings here.

File Locations

Under File Locations in the Files section of the User Options window, you have the option to select the 
default folder in which to save your model. If a default model folder is specified, this location will be the 
default location to save the model. To specify the default location, click Add below the Default Model 
Folder box and browse to the location you want to set as the default folder. Once you have selected the 
folder, click OK. The location of the default model folder will then show in the Default Model Folder box. 
You can add more than one default folder, but only the folder selected in blue will be the active default 
folder.

To specify locations for xStream to search for library files, click Add under the Library Search Locations 
box. Browse to the file location that contains the library, select the location, and click OK. You can add 
multiple folders to be searched. To add additional folders, repeat the process for each folder.

The User File consists of all saved settings and preferences. In order to backup these user settings in a 
*.ini file, click Add under User File Backup Locations. Browse to the file location in which you would like to 
save these settings. Once you have selected the desired file location, click OK. Note that the User File 
can be saved in multiple locations. To add additional locations, repeat the process for each folder that 
you would like to save the settings.

Backup Files & Auto Save

A Backup File is a copy of a previously saved version of your model file (*.xtr) that can function as a com-
plete, standalone model. These files are used as a safety measure to provide you with one or more pre-
vious versions of the model in the case that the current model is deleted or damaged.

The Number of Backup Files (i.e. the number of previously saved versions of the model) and the fre-
quency that the model is saved can be adjusted. You can opt to save no Backup Files by choosing "0" in 
the Number of Backup Files Created dropdown.

After the model has been saved initially, subsequent instances of saving the model will create a new 
Backup File until the specified maximum has been reached. The most recent Backup File will always con-
tain the file extension *.bakX-001. Larger numbers appended to the file name indicate older backups:
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 l Model File.xtr - Current and most recent version of the model file
 l Model File.bakX-001 - Latest backup (the second most recent version of the model file)
 l Model File.bakX-002 - Older backup
 l Model File.bakX-003 - Oldest backup

If you need to revert to a Backup File and convert it back into a standalone model, add the extension .xtr 
to the Backup File (the file name should now appear as Model File.bakX-001.xtr), and open the file in 
xStream. From there you can re-save the file or overwrite your existing model file.

The model file can be saved periodically by enabling the checkbox for Automatically Save Model and spe-
cifying a frequency in the dropdown box.

Create Recovery File

A Recovery File (*.Recv-XTR) is similar to a Backup File but is saved periodically at the specified interval. 
It allows the user to recover unsaved changes in the model file prior to the application crashing or closing 
abnormally. The Recovery File is written to the same location as the model file, and each time the spe-
cified interval passes it will be overwritten to contain the most recent state of the model. If the application 
is closed normally the Recovery File will be deleted. A Recovery File can only be generated for existing 
model files that are opened.

If a Recovery File exists, the next time the model file is opened a prompt will be shown asking if you want 
to use the Recovery File:

"A recovery file for this model was found which may indicate that the application closed unexpectedly. 
Would you like to open this recovery file?"

 l Yes - This will copy the previously saved model file to a new file with "(Original)" appended to the 
front, and the Recovery File containing the latest unsaved changes will be opened.

 l No - The Recovery File will be deleted, and the previously saved model file will be opened. This 
will open the model file in its last saved state, which may not include the latest unsaved changes if 
any are stored in the Recovery File.

Encoding

The File Encoding option can be set to "Unicode" in order to use characters outside of the standard Eng-
lish keyboard such as diacritics, cyrillic, etc for text fields such as the pipe/junction name, notes, etc.
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File Import and Export
This section focuses on the various file types that can be imported and exported from AFT xStream. Top-
ics included discuss importing piping layouts from various sources, importing and exporting between 
AFT products, and importing and exporting data with Excel.

Contents

Importing Piping Component Files 376

Importing GIS Shapefiles 380

Importing Caesar II Netral Files 382

Importing and Exporting Epanet Files 384

Importing and Exporting from Other AFT Products 388

Exporting to Excel 388

Importing Excel Data 393

Related Blogs

Meet the Import Piping Layout Wizard

Now it’s Super Easy! Changing Input Data in AFT Models using Excel Change Data

That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel Change 
Data

Importing Piping Component Files
AFT xStream includes the ability to import Piping Component Files (.pcf), which can be generated by a 
wide range of software, and provide a quick way to get started with the transient modeling portion of a pro-
ject. Files can be imported into existing models.

Selecting File > Import Piping Layout From > Piping Component File (.pcf) brings up the Import Piping 
Layout Wizard in the Quick Access Panel, as shown below in Figure 1.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .pcf files within the folder will be listed here. Sim-
ply clicking a file in the list will show a preview of the import in the Workspace. The location of the 
preview can be moved by dragging the icon in the upper-left of the selection area. 

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard
https://www.aft.com/support/product-tips/now-it-s-super-easy-changing-input-data-into-aft-models-using-excel-change-data
https://www.aft.com/support/product-tips/that-was-easy-quickly-change-pipe-and-junction-input-data-into-aft-models-using-excel-change-data
https://www.aft.com/support/product-tips/that-was-easy-quickly-change-pipe-and-junction-input-data-into-aft-models-using-excel-change-data
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 l Object List - When a file is selected, the objects to be created will be listed here. Each individual 
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For 
example, the originating software may have only had a "valve" while this could be a Relief Valve or 
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Right-
clicking on an object shows a menu for converting object types.

 l Property Window - This button opens an additional panel that shows the raw properties 
for the currently selected object.

 l Link Materials - Opens the File Object Link window, where groups of pipes from the .pcf 
file can be associated with a pipe material, size, and type in the AFT Pipe Material library. 
Pipes can be grouped by file schedules (i.e. item codes) or diameters, and are sorted by 
length within each group. The selection from the AFT Pipe Material library will overwrite 
any diameter information from the .pcf file. Selections made for a .pcf material will be 
applied to all pipes that reference that .pcf material. Pipes associated with each material 
can be seen by clicking the arrow on the left expand the group (Figure 2) and can be edited 
individually or as a group.

 l Show Ignored Objects - Certain types of objects are ignored on import - these can be 
objects such as flanges, or additional file components such as materials or bolt spe-
cifications.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe 

in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring 

pipes can be helpful in keeping a model clean and free of unnecessary components. For 
example, a pipe stress software may require many short pipe segments in between welds 
or flanges. However, these types of connections are almost always ignored for gas tran-
sient analysis. By ignoring short pipes, the amount of "import clean up" required can be 
reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is 
desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Combine Pipes When Possible - It is required that all pipes in the Workspace be con-

nected by two junctions. However, this is not a requirement in all software. Therefore, some 
.pcf files may be generated with several pipes "end to end." If the pipes were imported this 
way, either junctions would need to be added, or the pipes would need to be manually com-
bined, before the model could be solved.

 l Import Bends as Pipes - Pipe bends can be imported as junctions, or as a visual change 
in direction of the pipe. Importing bends as pipes is identical to using segments with 
assigned fittings and losses to show piping layout. To account for losses, bends will be 
matched to smooth flanged bends in the AFT Internal Fittings & Losses Library if an exact 
match for angle and r/D ratio is available and assigned to the pipe automatically. Losses 
that are not assigned automatically can be set up manually using junctions or fittings & 
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losses. This option is helpful to reduce unnecessary model clutter and input if bend losses 
are negligible.

Note: In most cases, it is recommended to import bends as bends rather than pipes. Bends imported 
as bends will always use smooth bends with r/D and/or angle imported from the .pcf file and 
basis area inherited from the upstream pipe.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts for the 
equivalent length of fittings and losses, and is not actually part of the physical pipe length.

 l Import Data to Pipe or Junction Notes Field - Add the raw data from the originating file 
to the Notes tab of the corresponding object.

Figure 1: Piping Component File Import
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Figure 2: File Object Link window for Piping Component File Import

General Recommendations

Importing piping layouts from external file types such as Piping Component Files is intended to save time 
by allowing a means to quickly achieve a foundational layout. A .pcf file does not provide all information 
needed to create a working compressible flow model of a system and the import process will not produce 
a completed model or a perfectly accurate representation of the .pcf model. There will be missing data 
that must be assigned prior to analysis, such as fluid properties and boundary conditions. However, there 
are import practices and preparations that can be made to the .pcf file that will make creating model from 
an imported piping layout go more smoothly.

 l Workspace - Piping Component Files are a three-dimensional file format, whereas model layouts 
in the AFT Workspace are a two-dimensional representation of a system. Because the Work-
space is a purely visual tool  independent of actual system dimensions, the Scale/Flip Workspace 
feature can be useful for achieving a readable model when working with imported piping layouts.

 l Object Positioning - It is recommended to have some distance between most objects (this is not 
relevant to welds, branch/tap connections, gaskets, and supports). This aids in pipe connections, 
as objects that are very close together may have trouble connecting automatically. This is espe-
cially true of non-isometric models. Spacing between objects also streamlines the process of scal-
ing objects on the Workspace after import.

 l Bends - By default, Import Bends as Pipes is unchecked, and importing bends as bends is recom-
mended for the sake of model readability and a more flexible approach to incorporating bend 
losses. Bends that have common angles and r/D ratios present in the internal AFT library can be 
imported as Fittings & Losses automatically when importing bends as pipes, but other bends will 
need to be added manually as junctions, or have their losses specified using the Additional K 
Factor option in the Pipe Fittings & Losses window or as user-specified fittings & losses using the 
Fittings & Losses Library. When bends are imported as bends, they will be treated as smooth 
bends, the upstream pipe determines the cross-sectional flow area, and the r/D ratio and/or angle 
is imported from the Piping Component File. If only the r/D ratio or angle is specified, the other 
parameter will be calculated using the endpoint coordinates.
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Note: Bends modeled explicitly can be joined with adjacent pipes as using Join Pipes/Junctions later if 
desired. Modeling bends as explicit junctions is advised for models containing bends that are 
not smooth flanged or have an uncommon angle or r/D ratio. Modeling bends as explicit junc-
tions is recommended in xStream for more accurate modeling of compressible flow except 
when doing so would lead to unacceptable solver run times. When calculating forces between 
elbow pairs, modeling bends explicitly is always recommended.

 l Pipes - While the AFT Pipe Material Library contains many piping materials specified by ASME 
and ANSI, the Piping Component File format does not always contain these materials and  mater-
ial attributes can be defined within .pcf files in a number of drastically different ways. Because of 
this, materials, nominal sizes and schedules are not assigned automatically and can be assigned 
using Link Materials (shown above in Figure 2). Pipes can be grouped by file schedules (i.e. item 
codes) if they exist or by diameter so that pipe size and material can be applied to a group of pipes 
quickly. Pipe inner diameter is assigned from the nominal diameter defined in the pipe's coordin-
ates within the .pcf file as a starting point, but any sizes assigned in Link Materials will override 
these inner diameters within the AFT model. Alternatively, pipes can be defined after import using 
Global Pipe Edit.

Related Blogs

Meet the Import Piping Layout Wizard

Importing GIS Shapefiles

Import GIS Shapefile

GIS Shapefiles that adhere to the ESRI standard can be imported into xStream for ease of model cre-
ation. These files have the extension .shp, but there are two other supporting file types that need to be in 
the same folder as the .shp in order for the import to work correctly. These are .shx and .dbf file types. 
The option is located under File > Import Piping Layout From > GIS Shapefile (.shp). This opens the 
"Import Piping Layout Wizard" in the Quick Access Panel that allows the importing of one line .shp that is 
of pipes and multiple point .shp files for branches, valves, compressors/fans, and tanks. Once the .shp 
files have been added to this window the object type, scaling, and mapping can be selected. 

Type

Any .shp files that are of lines are automatically set to the object type of "Pipes". Only one .shp file con-
taining lines can be imported at a time. Any .shp file that is of points can be set to Branches, Valves, Com-
pressors/Fans, or Tanks.

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard
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Scaling

The default scaling is 1 grid point to 1 foot. This can be adjusted by selecting the "..." button in the Scaling 
column. This button opens a new window in which a new scale can be committed to the shapefile. This 
window also allows the viewing the coordinates of specific points and parts of different shapes within the 
shapefile.

Mapping

The Data Mapping window allows the user to select what data fields have relevant data for xStream to 
import. 

 l Pipes can map:
 l Labels - Names                         
 l Length - If no length is imported, the pipe lengths will be calculated based upon the 

shapefiles scaling.                         
 l Friction - Absolute Roughness, Relative Roughness, and Explicit Friction Factor friction 

models are available.                         
 l Inner Diameter

 l Branches can map:
 l Labels - Names                         
 l Elevation

 l Compressors/Fans can map:
 l Assigned Flow - Imports as a Fixed Flowrate compressor                        
 l Labels - Names                         
 l Elevation

 l Tanks can map:
 l Labels - Names                         
 l Elevation

 l Valves can map:        
 l Labels - Names                         
 l Elevation

Related Blogs

Meet the Import Piping Layout Wizard

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard
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Importing Caesar II Netral Files
AFT xStream includes the ability to import CAESAR II Neutral Files (.cii), providing a quick way to get 
started with the transient modeling portion of a project. Files can be imported into existing models.

Selecting File > Import Piping Layout From > CAESAR II Neutral File (.cii) brings up the Import Piping 
Layout Wizard in the Quick Access Panel, as shown below in Figure 1.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .cii files within the folder will be listed here. Simply 
clicking a file in the list will show a preview of the import in the Workspace. The location of the pre-
view can be moved by dragging the icon in the upper-left of the selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each individual 
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For 
example, the originating software may have only had a "valve" while this could be a Relief Valve or 
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Right-
clicking on an object shows a menu for converting object types.

 l Property Window - This button opens an additional panel that shows the raw properties 
for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be associated 
with a pipe material, size, and type in the AFT Pipe Material library. The selection from the 
AFT Pipe Material library will overwrite any diameter information from the CII file, and will 
be applied to all of the pipes. Pipes are grouped by diameter by default and can also be 
grouped by schedule.

 l Show Ignored Objects - Certain types of objects are ignored on import - these can be 
objects such as flanges, or additional file components such as materials or bolt spe-
cifications.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe 

in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring 

pipes can be helpful in keeping a model clean and free of unnecessary components. For 
example, a pipe stress software may require many short pipe segments in between welds 
or flanges. However, these types of connections are almost always ignored for gas tran-
sient analysis. By ignoring short pipes, the amount of "import clean up" required can be 
reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is 
desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Show Labels In Preview - Show the corresponding label from the .cii file in the Work-

space preview. This is only shown in the preview and will not be imported into the model 
itself.
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 l Combine Pipes When Possible - It is required that all pipes in the Workspace be con-
nected by two junctions. However, this is not a requirement in all software. Therefore, some 
.cii files may be generated with several pipes "end to end." If the pipes were imported this 
way, either junctions would need to be added, or the pipes would need to be manually com-
bined, before the model could be solved.

 l Import Bends as Pipes - Pipe bends can be considered as junctions or simply a visual 
change in direction of the pipe. This is identical to using segments to show piping layout. 
Note that these bends are visual only and have no losses associated with them - to account 
for losses, either junctions or fittings & losses must be used. This option is helpful to reduce 
unnecessary model clutter.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts for the 
equivalent length of fittings and losses, and is not actually part of the physical pipe length.

 l Import Data to Pipe or Junction Notes Field - Add the raw data from the originating file 
to the Notes tab of the corresponding object.

Figure 1: CAESAR II Neutral File Import
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Related Blogs

Meet the Import Piping Layout Wizard

Importing and Exporting Epanet Files
AFT xStream includes the ability to import and export EPANET Files (*.INP). EPANET is public domain 
modeling software developed by the US Environmental Protection Agency. Many different applications 
support the file format, so it can therefore provide a quick way to get started with the transient modeling 
portion of a project.

Import Piping Layout Wizard

Selecting File > Import Piping Layout From > EPANET File (.inp) brings up the Import Piping Layout Wiz-
ard in the Quick Access Panel, as shown below in Figure 1. Note that importing from EPANET requires 
that the Workspace be empty.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .inp files within the folder will be listed here. Sim-
ply clicking a file in the list will show a preview of the import in the Workspace. The location of the 
preview can be moved by dragging the icon in the upper-left of the selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each individual 
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For 
example, the originating software may have only had a "valve" while this could be a Relief Valve or 
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Click-
ing on an object in the workspace highlights it in the wizard.

 l Property Window - This button opens an additional panel that shows the raw properties 
for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be associated 
with a pipe material, size, and type in the AFT Pipe Material library. The selection from the 
AFT Pipe Material library will overwrite any diameter information from the EPANET file, and 
will be applied to all of the pipes.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe 

in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring 

pipes can be helpful in keeping a model clean and free of unnecessary components. For 
example, a pipe stress software may require many short pipe segments in between welds 
or flanges. However, these types of connections are almost always ignored for gas tran-
sient analysis. By ignoring short pipes, the amount of "import clean up" required can be 
reduced.

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard
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 l Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is 
desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Import Data to Notes Field - Add the raw data from the originating file to the Notes tab of 

the corresponding object.
 l Auto-Zoom Preview - This option can be enabled to automatically zoom out so that the 

whole model can be seen in the workspace, which can be convenient for large systems.
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Pipes and Junctions

All pipes and junctions get imported with user-specified names from EPANET. All junctions below that 
have flow, elevation, length or other parameters will be imported with the same units if possible.

 l Pumps - Pumps are imported as compressors  with adiabatic compression thermodynamics. The 
available points on the pump curve are imported into the compressor data and used with the curve 
fit type set to interpolated X-Y data. If desired, polynomial curve fits can be set up within com-
pressor configuration using this data after the import process is complete.

Note: If only one or two data points exist for the pump curve, the compressor curve will still need to be 
user-specified.

 l Tanks - Finite-volume tanks will imported as finite tanks.
 l Reservoirs - EPANET reservoirs are imported as infinite tanks in xStream.
 l Pipes - These will use roughness, length, and inner diameter from EPANET model.
 l Junctions - (Just called Junctions in EPANET) 
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 l If one connecting pipe - If it has a demand, it becomes an Assigned Flow with relevant 
inflow/outflow. Otherwise, it becomes a dead end.

 l If multiple connecting pipes - If it has a demand, it becomes a branch using the Flow 
Source or Sink optional property with the relevant inflow/outflow imported from the 
EPANET junction demand. Otherwise, it is imported as a normal branch.

 l Valves - The K factor of a valve is assigned with the value specified in the EPANET model. Valves 
can be imported as normal valves, control valves, relief valves, or check valves depending on how 
they are defined within EPANET:

 l Normal valves come from GPV and TCV in EPANET.
 l Control valves come from FCV, PBV, and PSV in EPANET.
 l Relief valves come from PRV in EPANET.
 l Check valves come from CV in EPANET.

 l Heat Exchangers - While Heat Exchangers are not an explicitly defined object type in EPANET, 
EPANET junctions with "Heat Exchanger" in their user-defined name are imported as Heat 
Exchangers in AFT software.

 l Emitters - Emitters in EPANET are defined as a junction with a base demand and an emitter coef-
ficient. These are imported as Spray Discharge junctions with no loss model information in AFT 
xStream. This is because the loss coefficient used by EPANET for emitters, K Fire Sprinkler, is 
only for incompressible flow. Loss model values and CdA should therefore be defined manually by 
the user.

Exporting EPANET Files

AFT models can be exported to an EPANET file by using the File -> Export Piping Layout To -> EPANET 
File (.inp)... option from the Workspace window. The EPANET Export window shown in Figure 2 below 
allows the user to specify the desired destination to export the file to.

Figure 2: EPANET Import/Export Dialog

Related Blogs

Meet the Import Piping Layout Wizard

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard
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Importing and Exporting from Other AFT Products
Models made in other AFT products such as AFT Arrow can be opened directly in AFT xStream  and vice 
versa. This can be a useful starting point when it is desired to perform additional analysis on a model that 
has already been built in another AFT product, such as if it is desired to perform transient analysis on a 
system previously built in AFT Arrow.

To convert a model from one AFT product to another just browse to the model you would like to convert 
and open it in the software you are converting the model to. This can be done by changing the file exten-
sion selected, as is shown below in Figure 1. Note that though AFT Fathom and AFT Impulse are not 
explicitly listed, models from Fathom and Impulse can also be converted by selecting "All" and browsing 
to the model file.

When the model is opened in AFT xStream a backup copy of the original model will be created from 
which the original model can be restored if needed. See the Backup Settings explanation for more inform-
ation on backup files.

The conversion process will automatically change junction types not included in AFT xStream, such as 
the Spray Discharge junction, to either a General Component or Branch junction. Be aware that some 
features available for use in other AFT products are not available for use in AFT xStream. If a junction is 
defined using a feature not available in AFT xStream, the non-applicable information will be removed, 
and the user may be required to input additional information to fully define the model. It is advised to fully 
review the model after import.

Figure 1: File extensions options for Open File window

Exporting to Excel
AFT xStream includes a powerful ability to export any Output data to any specific cell(s) in an Excel 
spreadsheet. Specific values from the model can be exported, as well as columns, rows, or entire output 
tables as defined in Output Control. These items are controlled with the Excel Export Manager, available 
from the File menu.
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Figure 1: The Excel Export Manager

Adding Items to the Excel Export Manager

Data from the Output can be added to the Excel Export by clicking New, or by selecting an existing item 
and clicking Duplicate. Items can also be created directly from the Output Window by right-clicking on a 
cell or header.

Figure 2: Adding items directly from the Output

Each row in the Excel Export Manager corresponds to a cell, column, row, or table of data to be added to 
the spreadsheet. Each column helps define what data will be transferred where. The grid below the 
entries shows a preview of where the data will be added to help prevent intersecting data by showing 
where there are overlapping regions. Note that graph items can vary in size and do not show a complete 
region here.

 l Apply to Export - Items can be optionally included or excluded from the export.
 l Export Type - What type of data is being exported. This affects other settings, and will affect how 

much room is required on the target Excel sheet.
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 l Single Value - The value of a single parameter for a single pipe or junction object.
 l Column - Values of a single parameter for all of the displayed objects.
 l Row - Values of all displayed parameters for a single object.
 l Table - Values of all displayed parameters for all displayed objects.
 l Graph - The graph points from a specified Graph List Item.
 l Other - Additional information not available in a standard Output table, such as Fluid defin-

ition, Model Title, or Scenario Names.
 l Source - Where the data is coming from.

 l Pipe - From the steady-state Pipe section of the output.
 l Axial Points - From the Axial Points tab in the pipe output section
 l Junction - From the Junction section of the output.
 l General Output Summary - From one of the available output Summary sections. For 

example, if there is a compressor junction in the model, Compressor/Fan Summary is avail-
able.

 l Transient Max/Min - From the Transient Max/Min tab in the Pipes section of the output.
 l Forces - From the Forces tab in the pipe output section
 l Graph - From a specified Graph List Item.

 l Object - The object in particular that is desired. If Column or Table are selected for Export Type, 
this selection will be fixed to ALL.

 l Parameter - The parameter in particular that is desired. If Row, Table or Graph are selected for 
Export Type, this selection will be fixed to ALL.

 l Units - The units of the exported value. This is available only for Single Value and Column Export 
Types. Some parameters do not have units and this will display N/A.

 l Excel Sheet - Which Excel Sheet to export to. This value can be edited by the user - if it is desired 
to export to a named sheet this can be entered here.

 l Excel Starting Cell - The upper-left cell to export the data to.
 l Excel Ending Cell - The automatically calculated lower-right cell of the data, which depends on 

the Export Type, export options, and the number of parameters or objects in the model. It is import-
ant to recognize that the Excel Starting Cells can be defined in a way that data gets overwritten. 
The Ending Cell column is a handy reference to help avoid this.

 l Header - Optionally export the name of the Parameter(s) related to the item.
 l Units - Optionally export the name of the Unit(s) related to the item.
 l Add Excel Comments - Optionally adds an Excel comment to the value cell that contains the 

Parameter name and unit.
 l Show Example - Displays an example of how the exported cells will appear.
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Figure 3: Example Export

Figure 4: Result of the above example. Color added for emphasis.

Excel Export Location

After all of the desired data has been added to the Excel Export Manager, the next step is to actually 
export the data. There are three options available for the export:

 l Create New Workbook - A new Excel Workbook will be opened with the exported data.
 l Previously Saved Workbook - Browse to a Workbook saved to file. The Workbook will be 

opened and the modifications made to the sheets as specified.
 l Currently Opened Workbook - Select a Workbook that is currently open in Excel. The already 

open Workbook will be modified.

Note: The Excel Export Manager does not save Excel files for non-batch run exports. Any changes 
made need to be manually saved by the user in Excel.

There are two options available for exporting:

 l Clear Sheet Data - All of the existing data on the sheets specified in the Excel Sheet column will 
be cleared. This is especially useful for setting up a new export when many changes are being 
made.

 l Automatically Export After Running Model - After the model is run, the Export will be carried 
out automatically, per the settings defined by the user in the Excel Export Manager.
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Advanced Options

Items can be added directly from the Output instead of adding custom items with the New button. There 
are two behavioral options that can be modified for this action:

 l Open Excel Export Manager - If enabled, the Excel Export Manager will be opened every time 
an item is added from the Output. This is useful for double checking the setup.

 l For Existing Items -
 l Add New Item - The item selected will be added to the Excel Export Manager even if it 

already exists.
 l Select Existing - If the item already exists, do not add a duplicate item and instead select 

the existing item.
 l Ask - If the item already exists, prompt the user on the action to take.

 l Create an Export Guide - When exporting, an Export Guide can optionally be included in the 
export. The Export Guide contains information about the model and the generation of the export, 
to help keep the connection between the data and the model clear for future reference.

Exporting Data From Multiple Scenarios

The Excel Export Manager can be employed with Batch Runs with a couple of important distinctions.

First, if multiple sheets are specified in the Excel Export Manager, the only way to export multiple scen-
arios is to export every scenario to its own Workbook. To keep data from multiple scenarios in one 
Workbook, there can only be one sheet specified in the Excel Export Manager.

Second, the Excel File will be saved after each scenario. In normal single-scenario exports the file is 
never saved, but in batch mode it is required.

In the Batch Run tool, users are also able to use Excel Export without having to run the scenarios again. 
Note that if any of the scenarios in the Batch Run do not have output, the batch Export Only will not 
export any data for that scenario, as it will not run those scenarios to get output. 
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Figure 5: Saving Results From Multiple Scenarios

Related Blogs

Quick Guide to Custom Output

Paint a Clear Picture Faster Than Ever with AFT's New Excel Export Manager

Importing Excel Data
A Microsoft Excel spreadsheet can be used to make changes to objects in an AFT xStream model. The 
values in the Excel file are located in specific locations as described in the Setting Up Excel section. 

Setting Up Excel

When reading an Excel file, AFT xStream will search for a worksheet named AFT Transfer. There can 
be other worksheets in the workbook but xStream will only look for a sheet with this name. The file 

https://www.aft.com/support/product-tips/quick-guide-to-custom-output
https://www.aft.com/support/product-tips/excel-export
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structure looks like the following:

Figure 1: Sample AFT Transfer Excel Sheet

Row 1 and column A are not read by AFT xStream - these cells can have any value in them, though it is 
recommended to enter the values above for the header row.

Each column has certain accepted values, which can depend on the values in neighboring columns.

Note: A template spreadsheet containing validation rules for the required layout is included in the AFT 
xStream installation. By default the file path is: C:\AFT Products\AFT xStream\AFT xStream 
Excel Import Workbook.xlsx

Apply Column

This column accepts Yes or No. Only changes marked as Yes will be imported into the model.

Object Type

This column must be a junction name or Pipe. Valid choices can be seen below in Table 1.

Object Number

This corresponds to the junction or pipe number.

Parameter

The specific parameter to be changed. These parameters vary based on the Object Name selected. 
Each parameter has a type (C/S/I) associated with it, as is explained in the next section.
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Table 1: Object Types, Associated Parameters, and Change Codes

Change Code

Each Parameter has restrictions on how it can be changed. All of the Parameters are decimal numbers, 
integers, or strings.

Table 2: Valid Change Codes for each type of Parameter
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Value

The actual value to change the Parameter to or by.

For special conditions there are specific values assigned to each special condition option, as are listed in 
the table below.

Table 3: Values used to import special conditions

Scenario Path Name

The Scenario that the changes are intended to apply to. If no scenario is present, the changes will be 
applied to the current scenario.

It is important that the Scenario name is uniquely qualified - if there are multiple scenarios with the same 
name, the full Scenario Path Name can be used. Scenario Path Names can easily be copied from AFT 
xStream by right-clicking the scenario name and selecting "Copy Scenario Path Name."

Importing the File

When the sheet has been completely filled out, it can be imported from File -> Import Excel Change Data. 
When importing the data, the Object Change Log will appear, listing the changes that were made and 
any errors that occurred during the import. 
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Table 4: Excel Importing Error Messages

Note: In order for the junction to accept the changes, some fields must already contain data. For 
example, if the control setpoint for a control valve is being changed, there must already be a set-
point and units entered into the control valve junction object. This is to ensure that the correct 
set of units are being used. These values can be set using Global Edit to an arbitrary value 
before the changes are made from Excel.

Related Blogs

Now it’s Super Easy! Changing Input Data in AFT Models using Excel Change Data

That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel Change 
Data

https://www.aft.com/support/product-tips/now-it-s-super-easy-changing-input-data-into-aft-models-using-excel-change-data
https://www.aft.com/support/product-tips/that-was-easy-quickly-change-pipe-and-junction-input-data-into-aft-models-using-excel-change-data
https://www.aft.com/support/product-tips/that-was-easy-quickly-change-pipe-and-junction-input-data-into-aft-models-using-excel-change-data
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Design Alerts
Design Alerts are a powerful feature that can help speed up the modeling process and help verify that the 
model is behaving as expected. The creation of a Design Alert does not constrain or affect the operation 
of the model in any way. However, it automatically creates an output alert any time the design limit is viol-
ated. One common use case might be defining a maximum allowable pressure for the pipes in the model. 
While the output can be reviewed manually for these violations, this quickly becomes tedious as the 
model grows in size. Creating a Design Alert instead allows the engineer to spend less time reviewing 
output tables as any violation will be immediately identified. 

The Design Alert Manager allows the user to create or modify Design Alerts. It can be accessed from the 
Tools Menu or in the Design Alerts tab in pipe and junction properties windows.

Design Alerts can also be created directly from the output, or can be imported/exported for use in other 
models. 

Figure 1: Design Alert Manager

Creating and Applying Design Alerts

Click the green plus sign (New Design Alert) to add a new Design Alert to the model.

A Name, Object Type, and Parameter Type and Value can be specified. Depending on the Object Type, 
a different selection of Parameters are available, as shown below. To add a Parameter:
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 1. Give the Design Alert a distinct and descriptive name.
 2. Select the Object Type the alert will be applied to.
 3. Select the Parameter Type the alter will monitor.
 4. Specify a value, unit if applicable, and companion.

 1. Use >= when the value shouldn't rise above the specified value (i.e. temperature shouldn't 
exceed a maximum value)

 2. Use <= when the value shouldn't fall below the specified value (i.e. pressure shouldn't drop 
below a minimum value)

 5. Select which Objects from the Workspace the Design Alert will be applied to.
 6. Click "OK" to save changes.

Several Parameter limits can be added to one Design Alert. For example, an alert can be created that 
requires a pressure within a range by adding both the maximum and minimum pressure limits.

To update a Parameter, simply create it again and click Add to List - the old value will be replaced with 
the new one.

Figure 2: Creating a Design Alert
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Figure 3: Available Design Alerts

When running the model, the selected object's output values will be checked against the conditions that 
have been defined. If any of the Design Alert conditions are met, the user will receive a Design Alert warn-
ing and the violating parameters will be highlighted in the output tables. Design Alert warnings can be 
double-clicked to take you to that object in the Workspace.

Figure 4: Design Alert Violations in Output

Design Alerts can be cross-plotted in the Graph Results window vs. the actual results. One good 
example where this is useful is for cross-plots of maximum and minimum allowed operating pressures.

Design alerts are visible in every scenario in a model, but can be turned off or on for specific scenarios. 
When creating a design alert for the first time it will be active in that scenario and all its child scenarios. 
For more information about scenarios, please read the Scenario Manager topic.
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Design Alerts From Output
Right-clicking on a cell in the Output Window brings up a context menu. One of these options is Create 
Design Alert...

Figure 1: Output Context Menu

Create Design Alert automatically defines a Design Alert based on the selected value and quantity:

Figure 2: Automatically defined Design Alert

The Design Alert needs to have a name defined to be added. The specific value of the alert can be mod-
ified, and whether it is a maximum or minimum can be selected. The associated object is automatically 
selected as part of the Design Alert, but this is not required and additional objects can be selected now.

After the Design Alert has been created it can be further modified in the Design Alert Manager.
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Design Alert Importing & Exporting
Design Alerts can be saved to a text file to be imported into other model files. This allows the user to 
quickly load commonly used design alerts into multiple model files.

Export a Design Alert

To export a Design Alert:

 1. Fully define a Design Alert for any parameter in the Design Alert Manager. For this example, we 
are using a velocity design alert.

Figure 1: A design alert for velocity to be exported

 2. Select "Save All Alerts To File..." and give the file a descriptive name.

Import a Design Alert

 1. Open the Design Alert Manager from the Tools menu.
 2. Select "Load Alerts From File...", then browse to and select the saved design alert file.
 3. The Design Alert should now be added to the Existing Design Alerts list, and can be applied to 

objects in the model.
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Scenario Manager
The Scenario Manager (in the Quick Access Panel) is a powerful tool for managing variations of a model, 
referred to as scenarios. It lets you to quickly test the same model with selected differences (such as com-
pressor size, pipe diameter, system location, units, etc.) to find the system which works best. The Scen-
ario Manager allows you to:

 l Create, name, and organize scenarios
 l Select the scenario to appear in the Workspace (the ‘current’ scenario)
 l Delete, copy, and rename scenarios
 l Duplicate scenarios and save them as separate models
 l Review the source of a scenario’s properties
 l Pass changes from a scenario to its variants
 l See what scenarios have output by automatically changing the text color to blue if they have out-

put

All scenarios are saved within the model file.

Scenario

A variant case of a model that is created in the Scenario Manager.

Base Scenario

The Base Scenario is the root scenario at the top of the scenario tree. As the highest level ancestor, It 
does not inherit from any other scenario. A new scenario can be inserted above the base scenario, at 
which point the new scenario would behave as the base scenario, and the original base scenario would 
behave as a child scenario. "Base Scenario" is the default name given in a new, single scenario model.

The Scenario Manager

Illustrated in Figure 1, the top of the Scenario Manager displays the scenario tree, showing the names of 
the currently defined scenarios, their relationship to other scenarios, and which is the current Workspace 
scenario (the current scenario is identified both as the scenario with a green check mark next to it and in 
AFT xStream’s Status Bar). At the bottom, there is a place where you can record notes related to that 
scenario (propagates to children).

Those attributes whose value comes from a different scenario are linked, while those values coming from 
the selected scenario are not linked. Linked attributes will inherit changes made in the same object and 
attribute of the linked ancestor. This inheritance will occur over as many generations as the link exists.             
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Figure 1: Scenario Manager on Quick Access Panel

Related Examples

Gas Turbine Fuel System Example 623

Creating, Organizing, and Editing Scenarios
Scenarios are referred to as either a parent or child, plus the Base Scenario, which may be thought of as 
the root scenario. Upon opening a new model file, only a Base Scenario will be present.  To create a new 
scenario below the Base Scenario, right-click the Base Scenario and select Create Child.

Any scenario can be made current by double-clicking on it.

Figure 1 illustrates a model with a Base Scenario with three children: "Compressor A Running", "Com-
pressor B Running", and "Both Compressors Running". Each of these have two children: "One Process 
Tank" and "Two Process Tanks", representing the different operating cases where the process fluid 
could be fed to either one or two storage tanks.
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Figure 1: Scenario Manager Window

The "Compressor A Running", "Compressor B Running", and "Both Compressors Running" scenarios 
were created by first selecting the Base Scenario and clicking 'Create Child'. Each of the "One Process 
Tank" and "Two Process Tanks" scenarios were created by choosing 'Create Child' for each of the three 
different compressor configuration scenarios.

Note: Alternatively, one could have made the "Compressor A Running" scenario current and created 
the "One Process Tank" and "Two Process Tanks" scenarios below it. Then, with "Compressor 
A Running" still selected, select 'Clone With Children' twice, then rename the new clones "Com-
pressor B Running" and "Both Compressors Running".

The "One Process Tank" and "Two Process Tanks" scenarios may be thought of as grand children of the 
Base Scenario. This concept of scenario ancestry is helpful in keeping track of the differences and sim-
ilarities between scenarios discussed later.

A box with a plus sign next to a scenario indicates it may be expanded to reveal children scenarios while 
a box with a minus sign indicates the level is fully expanded with all children scenarios shown, if any.  No 
box indicates there are no children.  Levels may be expanded by clicking on the plus sign and condensed 
by clicking on the minus sign.

Right-clicking a scenario provides the following choices:

 l Create Child with No Output - create child scenarios without results saving duplication and load 
time

 l Rename - renames the selected scenario
 l Delete Scenario - deletes the selected scenario
 l Delete All Children - deletes all children of the selected scenario
 l Clone Without Children - creates a copy of the selected scenario at the same level (a sibling). 

Cloning a scenario prompts the user for a name for the new scenario.
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 l Clone With Children - creates a copy of the selected along with its children. Cloning a scenario 
prompts the user for a name for the new scenario.

 l Insert Scenario Above Selected... - creates a new scenario where the selected scenario is and 
shifts the selected scenario and its children down a level. This can be used to create a new base 
scenario. If this is done the user will be prompted to rename the previous base scenario.

 l Promote - raises a scenario one level, i.e. from a child to a sibling, active only for scenarios more 
than one level below the base scenario

 l Copy/Save Scenario Names
 l Copy Scenario Path Name - copy the fully-qualified name of the scenario to the Windows 

clipboard ("Base Scenario/Case 1/Child 3")
 l Copy Scenario Path Name With File Name - copy the fully-qualified scenario name 

along with the model name ("Model.xtr :: Base Scenario/Case 1/Child 3")
 l Save Scenario Names Only to File... - copy all scenario names on separate lines, with 

indents to show child/parent relations
 l Save Full Scenario Paths to File... - copy all scenario names on separate lines, with the 

full path name used for each scenario
 l Save Scenario to File Without Children - saves the selected to scenario to a separate file 

without its children
 l Save Scenario to File With Children - saves the selected scenario and its children to a separate 

file
 l Compare to Active Scenario - compares all parameters for all objects between the selected 

scenario and active scenario and displays the Comparison Grid showing the results
 l Scenario Comparison Tool - opens the Scenario Comparison tool to create a custom scenario 

comparison

Note: It is important to remember that AFT xStream’s Edit menu Undo does not apply to Scenario 
Manager operations. To undo a Rename scenario operation, you can rename the scenario 
again to the old name. To undo a Clone or Save Scenario operation, you can delete the clone or 
file created. Once a scenario is deleted or promoted, there is no way to un-delete or un-promote 
the scenario.

Viewing Scenario Differences

A scenario’s data and that for all of its direct ancestors can be viewed in the Model Data window. This 
functionality can be enabled in the Model Data Control window.

Fast Scenario Changes

AFT xStream remembers the most recent scenario you had open, and allows you to quickly change back 
to that scenario by using the Last Scenario feature. The Last Scenario feature is found on the View menu 

and Common Toolbar .
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Modifying Individual Scenarios
When first created, a scenario is identical to its parent. To modify or run a scenario, it must first be made 
in the current Workspace scenario by selecting it in the Scenario Tree on the Quick Access Panel, then 
double clicking it or choosing the Load Scenario option on the Right Click menu.  (The name of the cur-
rent scenario is displayed in AFT xStream’s Status Bar and is indicated in the Quick Access Panel with a 
green check mark.)  Once a scenario is the current scenario, changes may be made to differentiate it 
from its parent using any of AFT xStream’s editing tools and functions. When an attribute is changed 
within a scenario it breaks the link for this attribute. Subsequent changes in the scenario’s ancestors will 
no longer affect this attribute.

Properties of a scenario that may differ from its ancestors include:

 l Presence and location of objects - one may add or delete pipes and junctions within a scenario 
and the workspace locations may vary from scenario to scenario                 

 l Pipe and junction properties - all values set in the Properties windows     
 l Fluid - fluid selected                 
 l AFT Arrow Steady Solution - solution method, tolerances, relaxation                 
 l Output Control - Output window content and formatting                 
 l MOC Transient - The transient settings can be varied between scenarios                 
 l Library Manager - The connected database content can be varied between scenarios                 

Model Data Control and User Options apply to all scenarios.              

Scenario Inheritance
Scenario Manager will pass changes made in a scenario to linked attributes of its descendants, allowing 
multiple scenarios to be modified in one operation and maintain similarity between scenarios where 
desired.

Any attribute whose value is the same as that of the scenario’s parent is linked to the parent. In turn, if the 
parent’s attribute value is the same as that of its parent, then the child’s attribute is linked to its grand-
parent. This ancestral linking of attributes can exist across any number of generations. A change made to 
a scenario will be passed downward to its children, grandchildren, etc., as far as the link exists. Changes 
are NOT passed upward from child to parent.

Once an attribute is changed within a scenario, the link is broken to that individual attribute. Subsequent 
changes in the scenario’s ancestors, parent, grandparent, etc., will no longer affect that attribute, but all 
other attributes within the scenario will remain linked. The Model Data window with Ancestral Data 
enabled shows how the data changes between scenarios.

Scenario Logic Examples

For many users, it is easiest to grasp Scenario Manager when it is explained how the coding logic is actu-
ally implemented. Blank fields for children, grandchildren, etc., mean to look to the parent for the data. 
The Base Scenario never has blank fields (Table 1). Data only passes downwards, never upwards.
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Table 1: Blank fields for Child #1 and Grandchild #1 mean that the data is to come from the parent. If the Base 
scenario data is changed, all descendants are changed.

If a child scenario does not have a blank field, then data for that property is initiated at that scenario level 
(see Table 2).

Table 2: Child #1 does not have a blank field, so its Diameter would be 2, not 3, as would Grandchild #1.

If a scenario is changed, and its child has different data, then the change will not pass downwards (see 
Table 3). 

Table 3: Changing the Base Scenario Diameter from 3 to 6 would not impact Child #1 or any descendants in 
that line. Changing the Length from 25 to 40 would also change the length in Child #1, Grandchild #1, and 

any descendants of Grandchild #1.

If a child scenario has data that is different than the parent, its children cannot relink to the parent (see 
Table 4).
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Table 4: Even if the Grandchild #1 has the same Diameter as the Base, it is not linked to the Base because it 
and its parent are not blank.

If a child scenario’s data, which was previously changed and is thus different from the parent, is changed 
back to the same vale as the parent, the inheritance link is re-established (see Table 5). Its descendant’s 
link is also re-established.

Table 5: If the Diameter in Child #1 is changed to be the same as the Base, it will be "blanked out" the next 
time the scenario is loaded and the link re-established. And so will Grandchild #1, if its Diameter is also the 

same.

Table 6 shows data for two pipe properties across three scenarios. The data that would be used when 
each scenario is loaded is as follows:

 l Base scenario
 l Diameter = 3
 l Length = 25
 l Changes to Diameter will not pass downwards
 l Changes to Length will affect only Child #1.

 l Child #1 scenario
 l Diameter = 2
 l Length = 25
 l Changes to Base Diameter will not affect Diameter
 l Changes to Base Length will affect Length

 l Grandchild #1 scenario
 l Diameter = 2
 l Length = 15
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 l Changes to Base Diameter will not affect Diameter
 l Changes to Child #1 Diameter will affect Diameter
 l Changes to Base Length or Child #1 Length will not affect Length

 

Table 6: Input data for these properties explained in the text.

Re-Establishing Broken Scenario Links

A link may be re-established by returning the attribute to the same value as that of its parent. This can be 
done manually by entering the value or selecting the Copy Data From Pipe list and selecting the Parent 
Pipe Data option. Within other data windows, it is done by selecting the Same As Parent option in Output 
Control, Analysis Setup, Cost Settings, or Library Manager.

Since links are identified by comparing attribute values of pipes or junctions with the same Workspace ID 
number, renumbering a scenario will break the links of all pipes and junctions renumbered. Since num-
bers must be unique, once a link has been broken by renumbering, it may not be re-established.

Running Models in Batch Mode
AFT xStream scenarios or models can be run in batch mode, a feature that is especially useful for run-
ning a group of scenarios or models during lunch or overnight.

To run models in batch mode, follow these steps:

 1. Click "Start Batch Run" on the File menu.
 2. Select the Batch Run Type. This is where you select if you want to run scenarios from the current 

model or different model files. If the current model does not have any scenarios, then only the 
second option will be available.

 3. If the Batch Run Type is "Scenarios in Current Model", then choose the Add Scenarios button and 
select the scenarios you wish to run.

 4. If the Batch Run Type is "Models from Different Files", then the models can be selected indi-
vidually using the "Add Model Files" button, or loaded from a Batch File (by Choosing the "Load 
Existing Batch File" button). A Batch File is a text file listing all models you would like to run. At any 
time, a selected model file can be removed by clicking the "Remove Selections". The current list of 
models can be saved to a Batch File for use in the future by clicking the "Save List to File" button.

 5. Use the Output Options in the lower left to save the output data to a file and/or send it to a printer 
or Adobe PDF file. All reports will use the specified font. 
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 6. Alternatively, the option can be chosen to Save Using Excel Export Manager by either saving to 
separate sheets, or saving the scenarios to separate workbooks. The Excel Export option can 
only be chosen if the batch run type is for Scenarios in Current Model. Additionally, the desired out-
put must first be configured in the Excel Export Manager under the File menu for any data to be 
exported.

 7. Check the box to Run Batch in Background if you wish for all selected scenarios to run without 
showing the Solution Progress window. AFT xStream will run the simulations in the background 
and will not interrupt any work being done in other programs.      

 8. Click the Start Run button to begin the batch run.

AFT xStream then opens each scenario or model file in sequence, automatically runs each scen-
ario/model that has a completed Analysis Setup Window, and sends results to the specified destination. 
All pertinent information that is generated during the batch run (such as error messages) are auto-
matically displayed when the final scenario/model is finished. Output files generated from each scenario 
or model run is automatically saved before moving to the next run. 

The entire batch run can be canceled at any time by clicking the Cancel button in the Solution Progress 
window. Output from scenarios that have already been run is still retained when the Batch Run is can-
celed.

Note: You can plot output from multiple scenarios using Multi-Scenario Graphs.    

Open Model Using Last Scenario
When the model is saved, the current scenario is remembered, and by default, reloaded when the model 
is opened again. Your preference of whether to always open the model to the most recent scenario or to 
the base scenario can be specified in the User Options window.

Scenario Comparison Tool Overview
Scenario Comparison Tool (accessed via the Tools menu) is a powerful tool that allows users to compare 
model parameters between scenarios in a given model. It lets users quickly identify differences between 
two or more scenarios without needing to search through the model data for each scenario or inspect 
each element of the model. This tool can be especially powerful for users reviewing others' models, or for 
users returning to models after a period of time. It can also be powerful for troubleshooting purposes. The 
Scenario Comparison Tool lets you: 

 l Compare any two or more scenarios
 l Compare selected Pipes and Junctions between selected scenarios
 l Compare selected Pipe and Junction parameters between selected scenarios
 l Compare selected General Properties between selected scenarios

Related Examples
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Pipe Forces from Turbine Shutdown Example 656

Related Blogs

New Feature Highlight - Scenario Comparison Tool

Accessing Scenario Comparison Tool
The Scenario Comparison tool can be accessed from the Scenario Manager, the Workspace, and the 
Tools menu.              

From the Scenario Manager             

To set up a comparison from the Scenario Manager, first select the pipes and junctions to compare in the 
workspace. Then, select the desired scenario to compare the current scenario to in the Scenario Man-
ager. Note the current scenario is indicated  by the green check-mark symbol. Right-click the desired 
scenario, and select Compare Selected Scenarios.... This will bring users to the Scenario Comparison 
window and display a grid of the differences between the selected objects in the two scenarios.             

To modify the comparison use the Modify Comparison button at the bottom of the window.             

From the Workspace             

From the workspace, users can quickly select desired pipes and junctions in the scenario and compare 
them to those found in any other scenario.              

First, select the desired pipe(s) and/or junction(s) in the workspace. Then, right-click the Workspace, 
choose Compare Scenarios, and select the desired comparison. This will bring users to the Scenario 
Comparison window and display a grid of the differences between the selected objects in the two scen-
arios.             

To modify the comparison use the Modify Comparison button at the bottom of the window.             

From the Tools Menu             

From the Tools menu, there are multiple options to generate the Scenario Comparison Report.             

A comparison grid can be directly generated by selecting the desired objects to compare in the Work-
space, then selecting the scenarios to be compared from the Compare Scenarios menu option.             

Alternatively, the Scenario Comparison Tool menu option can be selected to build a custom scenario 
comparison by directly selecting the scenarios, objects, and parameters to be included in the com-
parison. See Modify Comparison for more information on the available options.             

Click the Show Comparison button at the bottom of the window to view the comparison. To make addi-
tional changes, use the Modify Comparison button at the bottom of the window.             

https://www.aft.com/support/product-tips/new-feature-highlight-scenario-comparison-tool
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Related Blogs

New Feature Highlight - Scenario Comparison Tool

Modify Comparison
Several Options are available to customize the Scenario Comparison Grid. These options are available 
from the Modify Comparison button at the bottom of the scenario comparison report, or by selecting Scen-
ario Comparison Tool from the Tools menu. The Modify Comparison window is shown in Figure 1 below.

Figure 1: Scenario Comparison window options to Modify Comparison

Select Scenarios to Compare

The Scenario Comparison Tool has four pre-set templates for comparing scenarios, plus the ability to set 
up a custom comparison. These are:

 l Parent: This template compares the current scenario with that scenario's parent.
 l Ancestors: This template compares the current scenario with all of that scenario's direct ancest-

ors. This setting would be similar to the comparison available in the Model Data window, though it 
does provide a more comprehensive comparison. 

 l Siblings: This template compares the current scenario with all of that scenario's siblings. 
 l Exhaustive: This template compares all of the scenarios in the model with each other. 
 l Custom: This option allows users to compare any two or more scenarios throughout the model. 

https://www.aft.com/support/product-tips/new-feature-highlight-scenario-comparison-tool
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Select Pipe and Junction Properties

This section sets what parameters will be compared such as length, diameter, roughness, etc.

Users can choose to compare a set of specified properties, or all pipe and junction properties by select-
ing the desired properties under Select Pipe and Junction Properties. Only properties selected in this sec-
tion will be considered when the comparison is run.

A helpful option to filter the parameters to be displayed in the comparison is to display the parameters 
shown in the Model Data window. This can simplify the comparison, but might hide some differences 
between scenarios. Use the Model Data Control window to further define what parameters are shown 
with this option.

Select General Properties

This section sets what General Properties will be compared such as fluid properties, tolerances, etc.

Users can choose to compare all or a select set of general properties for the scenarios including options 
that are located in the Analysis Setup window such as the AFT Arrow™ Steady Solution, Fluid, Sec-
tioning, and MOC Transient panels.

Select Pipes and Junctions

This section sets which pipes and junctions will be compared for the model.

Users can choose to compare all objects in the model, or a selected set of pipes and junctions. Users can 
manually select the desired objects, select those highlighted in the workspace, or use the Select Special 
tool to select desired groups or other sets of objects. 

Related Blogs

New Feature Highlight - Scenario Comparison Tool

Scenario Comparison Grid
Choosing the Compare Selected Scenarios menu item from the right-click or Tools menu will bring the 
user directly to the Scenario Comparison Grid based on any selected Workspace objects and scenarios. 
The settings for the scenario comparison can be seen/modified by clicking Modify Comparison at the bot-
tom of the window.

The tabular data from the report can be copied to and pasted to a separate file or worksheet using the 
Copy button at the bottom of the window.

https://www.aft.com/support/product-tips/new-feature-highlight-scenario-comparison-tool
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Figure 1: Default Scenario Comparison Report view

Filtering Options

When a large comparison is run, typically many of the objects/parameters in the model will be unchanged 
across scenarios, which may result in a large number of items with no differences. To help condense the 
Scenario Comparison Grid, several toggles are available at the top of the Item and Parameter columns 
which allow the user to show/hide rows in the report. Switching the toggle to All will show all items or para-
meters being compared. If the toggle is set to differences, then only Items/Parameters that have a dif-
ferent value in at least one scenario will be shown. Thus, if both toggles are set to All, then all parameters 
will be displayed for all items. If both toggles are set to Differences, then only items that have parameters 
with different values will be shown, and only the parameters that differ will be displayed.

Color Coding

The cells in the Item and Parameter columns will be colored either yellow or green to indicate whether 
that item/parameter has differences between the scenarios being compared. Yellow indicates dif-
ferences, while green indicates that no differences exist. Parameters will be colored yellow if the value of 
that parameter is different in at least one scenario that is being compared. Items will be colored yellow if 
at least one parameter that is being compared for that item has a different value in one or more scen-
arios.

The Highlight Unique Values toggle is used to color the values to visually link identical values. All values 
under the currently active scenario will remain grey, while values that have differences will be colored. 
This is powerful to quickly see differences when more than two scenarios are being compared. If two 
scenarios have the same value for a parameter, the values will have the same shading. See Figure 2 
below for an example.
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Figure 2: Scenario comparison showing differences only. Each unique value is highlighted with a different 
color to indicate which scenarios have differences from the currently active scenario, which is the "3.5 inch" 

scenario for this example.

Related Blogs

New Feature Highlight - Scenario Comparison Tool

https://www.aft.com/support/product-tips/new-feature-highlight-scenario-comparison-tool
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Add-on Modules
AFT xStream has one optional add-on module which extends its modeling capabilities into other areas. 
The module allows pulsation frequency analysis.

 l Introduction to the PFA Module (Pulsation Frequency Analysis)

Introduction to the PFA Module

What is the PFA Module?

Steady-state pressure and flow dynamics, henceforth referred to simply as “pulsation”, is a common prob-
lem, which can cause high vibration, fatigue failures, frequent maintenance outages, and flow uniformity 
or product quality problems.

The PFA Module helps engineers identify and avoid resonant frequencies in systems. Problems can 
arise when the frequencies that are excited by pulsation are at or near the acoustic resonant frequencies 
of a fluid system. The module is used to calculate the acoustic resonance frequencies that could damage 
system equipment.

The PFA Module can also be used to check compliance with the peak-to-peak pressure limits defined in 
the API 618 standard for reciprocating compressors.

How Does the PFA Module Work?

The Pulsation Frequency Analysis (PFA) module is used to determine resonant frequencies that could 
damage system equipment by calculating the acoustic resonance.

The general steps of pulsation analysis involve the following:

 1. The piping and process equipment system is first modeled.
 2. At run-time a pulse is generated to determine excitation frequencies, and generate the forcing 

function. This forcing function is then placed in the transient data of the junction at which the pulse 
is applied.

 3. The model is run with the forcing function to generate the Acoustical Frequency Analysis graph, 
providing information on the resonant frequencies in the system.

 4. Replace the pulse transient with a transient at the frequencies of interest in the reciprocating com-
pressor and turn on the API 618 evaluation option.

 5. When the model is run xStream will show warnings if API 618 is violated.

Using the PFA Module

The user has the option of activating or not activating the PFA module when AFT xStream first loads. 
After AFT xStream is loaded, the PFA module can be activated or deactivated for use from the Tools 
menu. Whether or not PFA is activated impacts the Analysis menu and Graph Results window.
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If the PFA module is active, the user can still run models without pulsation. This is selected under Pulsa-
tion Frequency Analysis on the Analysis menu. Hence there are three possibilities for the PFA module. 

 l PFA is not active
 l PFA is active and pulsation is disabled
 l PFA is active and pulsation frequency analysis is performed

Related Examples

Frequency Analysis - PFA Example             671

Defining Pulsation Settings
The Pulse Setup panel (Figure 1) allows you to specify required input for the PFA module, including the 
junction at which the pulse will be applied, as well as the pulse properties. This panel will not be visible 
unless the PFA module has been activated from the Modules panel.

Figure 1: Pulse Setup panel in the Analysis Setup window with Natural Frequency Evaluation selected
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Figure 2: Pulse Setup panel in the Analysis Setup window with Steady State Pulsation selected

Frequency Analysis Mode

At the top of the window the Frequency Analysis Mode can be specified. The options include: Natural Fre-
quency Evaluation, Steady State Pulsation, and None. The Natural Frequency Evaluation will produce a 
single transient pulse at a specified assigned flow or fixed flow rate positive displacement compressor 
junction so as to determine the frequencies that would excite the system. The Steady State Pulsation 
option will determine how a pulsation source, such as a reciprocating compressor, would interface with a 
system in steady operation. 

Natural Frequency Evaluation

When Natural Frequency Evaluation is selected, the Pulse Properties can be specified, including the 
junction that will act as the source of the pulse and the magnitude of the pulse. By default, the magnitude 
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of the pulse is twice the steady-state flow, but you have the option to define this magnitude as “User Spe-
cified”. This pulse will be assumed to last for two time steps and then return to steady-state flow. The 
pulse can only be applied to an assigned flow junction or fixed flow rate positive displacement com-
pressor.

Steady State Pulsation

The Steady State Pulsation analysis mode allows for the evaluation of pressure amplitude for each fre-
quency at each pipe station in the model when these frequencies are excited by a reciprocating com-
pressor. The reciprocating compressor can be modeled explicitly using the reciprocating positive 
displacement compressor junction, or approximated by applying a sinusoidal flow transient to an 
assigned flow junction. In practice, the natural frequencies of the system may be used along with har-
monic multiples to identify compressor RPMs of particular concern.

The Steady State Pulsation analysis mode also offers acoustical evaluation of the reciprocating com-
pressor and system interaction based on the API 618 standard.

Artificial Pulsation Resolution

It is highly recommended that the option to delay transient simulation until artificial transients are 
resolved be left enabled. This resolution method is based on comparison of average pressures between 
blocks of compressor rotations, and operating without this method will result in less accurate frequency 
evaluation. Pressure is averaged over the course of each block, and this value is compared to the pre-
vious block until it meets a specified tolerance. This method is distinct from the one used in the Transient 
Solver Initialization Panel, which is not used and will not appear when using Steady State Pulsation ana-
lysis.

The parameters for pulsation resolution can be modified in the Advanced Settings section at the bottom 
of the Pulse Setup panel.

 l Average Pressure Tolerance - Similar to solver tolerance settings, this defines the pressure tol-
erance from block to block that must be achieved for a block to pass tolerance requirements. This 
can be defined using absolute tolerance, relative tolerance, or any combination thereof.

 l Iteration Limits
 l Maximum number of blocks - The maximum number of blocks that may be evaluated 

without success before the artificial transients are considered to be unresolved.
 l Revolutions per block - This determines the number of time steps per block based on 

number of crankshaft rotations, the time step size, and compressor RPM.

Note: If the default value of 10 is not sufficient, try increasing this value to 20.

 l Time steps per block (Other Pulsation Source) - When using Other as the pulsation 
source, this parameter replaces revolutions per block.
Successive blocks required - This defines the number of consecutive blocks that must 
meet tolerance requirements before artificial transients are considered resolved.
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Pulsation Source

The pulsation source can be set to Reciprocating Compressor or Other. The Other option allows a user 
to excite the system with any arbitrary pulsation source. In practice this takes the form of cyclical user-
defined Junction Transient Data applied to one or multiple junctions in the system. The Reciprocating 
Compressor option allows a reciprocating positive displacement compressor junction or assigned flow 
junction to be selected, and has the following parameters.

 l Compressor
 l Reciprocating Compressor - Select an existing reciprocating compressor from the model 

listed by junction number.

Note: If there are multiple reciprocating compressors with the same speed and number 
of heads, any may be selected. If these parameters differ between compressors, 
use the Other option for Pulsation Source.

 l User Defined - This option is selected when using one or more assigned flow junctions  to 
represent reciprocating compressors. The appropriate transient must be defined in the 
Transient tab of the assigned flow junction, typically using the periodic flow feature. The 
Speed and Number of Heads parameters do not define this transient flow, but are used for 
Artificial Pulsation Resolution and API 618 and should match the assumptions that were 
used to define the transient flow.

 l Speed - The current operating speed of the compressor in RPM. If a reciprocating compressor 
junction is selected, this will display the value defined in the Compressor Properties window.

 l Number of Heads - This is the number of compression chambers in the compressor, which is the 
number of cylinders in a single-acting compressor and twice the number of cylinders in a double-
acting compressor. If a reciprocating compressor junction is selected, this parameter will be 
determined from the compressor properties.

 l Evaluate with API 618 - When this option is checked, an API 618 acoustical analysis will be per-
formed. More detail about this analysis is provided in the section below.

Cutoff Frequency

The cutoff frequency in xStream is the maximum frequency for displayed output. The defined cutoff fre-
quency must be less than or equal to the detectable frequency for the analysis, which is calculated using 
the equation for maximum frequency as follows:

where dt is the time step. The time step for the model is not known until run time; however, the time step 
can be estimated based on the inputs on the Pipe Sectioning panel. The Pulsation Summary at the bot-
tom of the Pulse Setup panel shows the Detectable Frequency based on the current settings on the Pipe 
Sectioning panel, as well as the minimum number of sections required to capture the specified cutoff 
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frequency. If the current Cutoff Frequency and sectioning are not valid for the analysis, then either the 
Cutoff Frequency should be decreased, or the minimum number of sections should be increased.

When the Analysis is run it is possible to account for all frequencies up to the Detectable Frequency cal-
culated based on the time step. However, the results in the output will only display frequencies up to the 
user defined Cutoff Frequency. Therefore it is important to define a large enough Cutoff Frequency to be 
able to analyze all relevant frequency responses.

Note: In Steady State Pulsation, the cutoff frequency should be at least six times the base pulsation 
frequency.

Minimum Number of Frequency Samples

The minimum number of frequency samples used to generate the forcing function is specified in the Fre-
quency Analysis section of the Pulse Setup panel. The default of 1000 should be sufficient for most 
cases. The Minimum Number of Frequency Samples will impact the required simulation duration - a lar-
ger number of samples will require a longer simulation duration. The required simulation duration can be 
calculated by dividing the minimum number of frequency samples by the detectable frequency. If the cur-
rent simulation duration is not long enough to accommodate the minimum number of frequency samples, 
then the  simulation duration should be lengthened on the Simulation Mode/Duration panel, or the min-
imum number of frequency samples should be decreased.

Evaluate with API 618

The Evaluate with API 618 feature, under the Steady State Pulsation selection, can be used to determine 
if the pressure response at any of the acoustic natural frequencies of the system exceeds the limits 
defined in API 618 for reciprocating compressors. To evaluate API 618 the model should first be run with 
PFA enabled and the API 618 feature disabled to determine the acoustic frequencies. Once the excit-
ation frequencies are known, child scenarios can be created by the user to evaluate the pressure results 
when the compressor operates at the excitation frequencies, as is demonstrated in the last step of the 
Frequency Analysis Example. The API 618 evaluation should be enabled in the excitation frequency 
child scenarios to check if the pressure results exceed the limits in API 618.

The required inputs to check API 618 are as follows:

 l Speed - The speed the reciprocating compressor is operating at.
 l Number of Heads - The number of pistons in the reciprocating compressor.
 l Time Until Steady State Pulsation - The time required for the dissipation of artificial transients 

caused by the introduction of a flow rate wave to the system. This time should be determined by 
running the scenario with the "Time Until Steady State Pulsation" set to 0, then plotting the pres-
sure results at the outlet of the compressor. The Time Until Steady State Pulsation should be set 
as the time at which the pressure waves have consistent amplitudes. For example, in Figure 2 
below the waves begin to reach constant amplitude at about 0.25 seconds. It is best to choose a 
slightly longer time interval than the estimated time interval for increased accuracy when checking 
API 618.
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Note the Time Until Steady State Pulsation input only changes which pressure results are 
included in the API 618 evaluation, the transient results are not impacted by this time.

Figure 3: Example pressure results at the outlet of the reciprocating compressor with an oscillating flow tran-
sient specified

With output an Acoustical Frequency Analysis can be graphed. When API 618 is being evaluated, the 
limit and the frequency will be graphed together as shown in Figure 4.

Figure 4: Example Acoustical Frequency Analysis Plot including the API-618 Limit

The equations for the API 618 peak to peak pressure level limits are as follows (American Petroleum Insti-
tute 2007, Clause 7.9):
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where P1(%) is the maximum allowable peak to peak pressure level of individual pulsation components 
at fundamental and harmonic frequencies, as a percentage of absolute line pressure, PL is the average 
absolute line pressure in psi (bar for SI), ID is the inside diameter of the pipe in inches (mm), f is the pulsa-
tion frequency in hertz, anda is the speed of sound inside the pipe in feet per second (meters per 
second).

Pulsation Summary

The Pulsation Summary section at the bottom of the Pulse Setup panel provides information on the cur-
rent transient settings in the model to check that the sectioning and simulation duration are sufficient 
based on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples. Therefore 
the Pulsation Summary will only be able to display results if the Pipe Sectioning panel and Simulation 
Mode/Duration panel have already been fully defined.

The Update For Me button under the Pulsation Summary can be used to update the Minimum Number of 
Sections and/or the Stop Time for the simulation if they are not sufficient based on the user-specified 
Cutoff Frequency and Minimum Number of Frequency Samples.

A short description of each of the Pulsation Summary items is given here.

 l Minimum Sections
 l Current Count - Displays the Minimum Number of Sections Per Pipe defined on the Pipe 

Sectioning panel
 l Detectable Frequency - Displays the Max Frequency calculated as discussed above in 

the Cutoff Frequency section
 l Required for Cutoff - Displays the required Minimum Number of Sections Per Pipe which 

allow the Detectable Frequency to be greater than or equal to the Cutoff Frequency
 l Minimum Simulation Duration

 l Current Duration - Displays the current simulation duration defined on the Simulation 
Mode/Duration panel (Stop Time minus Start Time)

 l Actual Samples - Displays the Actual Samples used for the frequency analysis, calculated 
by multiplying the Current Duration by the Detectable Frequency

 l Required For Min. Samples - Displays the minimum required simulation duration based 
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on the user-specified Minimum Number of Frequency Samples and the calculated Detect-
able Frequency

Related Examples

Frequency Analysis - PFA Example             671

Related Topics

Pulse Setup Panel 100
The maximum peak-to-peak pressure limit defined in the API 618 standard has been 
exceeded at X locations 543
Pulsation peak-to-peak pressures are within allowable API 618 levels 552

Interpreting Pulsation Results
The accuracy of results when using the PFA module in xStream will be affected by the sources of error 
described in the Transient Result Accuracy topic, but there are a few additional considerations specific to 
the PFA module.

The methodology the PFA module uses assumes that the fluid parameters change linearly in the sys-
tem, similar to the assumptions made for the Method of Characteristics in the transient solver. The 
assumption of linear behavior primarily affects the magnitude of the frequency response results, rather 
than affecting the locations of the largest amplitude responses. However, if the error for the analysis is 
large it is possible that the predicted resonant frequencies may be shifted. To minimize error the con-
siderations in the Transient Result Accuracy topic should be taken into account, in particular running the 
model with higher sectioning counts. It may also be prudent to analyze the system response not only at 
the predicted resonant frequencies, but also at frequencies near to the predicted frequencies to ensure 
that all frequencies of concern have been accounted for in the system.

Related Topics

Method of Characteristics 473

Related Examples

Frequency Analysis - PFA Example             671

PFA Module Glossary
Much of the terminology associated with pulsation analysis is specific to time-frequency analysis and/or 
to vibrational analysis. The following words have been defined for ease of comprehension when working 
with the PFA module. Note that most of the defined words include page numbers and, occasionally, equa-
tion numbers. All of these references can be found in the document referenced at the end of this page.
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 l Sample Rate - The inverse of the time step (Page 14)
 l Harmonic Frequencies - Multiples of the base frequencies that excite the system
 l Forcing Function - The function that will be used to “ring” the system. This function can be the 

pulse in a non-low-pass-filtered system, or can be determined by the cutoff frequency that is 
determined by using Fast Fourier Transform (Page 7)

 l Pulse - The near-instantaneous increase, then normalization, of flow
 l Fast Fourier Transform (FFT) - A method used to transpose the time-domain (flow vs. time) into 

the frequency-domain (magnitude vs. frequency)
 l Cutoff frequency (fc) - This is  the maximum frequency that will be shown in the frequency ana-

lysis results.
 l Detectable Frequency - This is the maximum frequency which will be recognized by xStream dur-

ing the transient solution. If frequencies exist above this frequency they will be aliased to lower fre-
quencies in the final solution.

References 

Blanding, James M., Ph.D., and Trey Walters, PE. Pulsation Analysis in Positive Displacement Pump 
Systems Using Waterhammer, Modal, and Animation Software. Houston, TX: 45th Turbomachinery & 
32nd Pump Symposia, Sept. 2016. http://www.aft.com/documents/TechnicalPapers/2016/TPS2016-
PulsationAnalysis.pdf
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Libraries
Powerful customization capabilities are provided through the ability to create libraries which can store 
custom fluid properties, pipe materials, and all junction types. There are several categories of libraries 
which are discussed below.

AFT Internal Library

 l Purpose - Stores AFT-provided library data that is always available with the default installation.
 l Filename - xStream#.dat (where # is the corresponding version number).
 l Location - xStream installation folder, default is C:\AFT Products\AFT xStream #.
 l Limitations - Cannot be transferred to other users, local use only.

Local User Library

 l Purpose - Stores user-specified data for most component types.
 l Filename - xtr_User#.DAT (where # is the corresponding version number).
 l Location - C:\Users\username\AppData\Roaming\Applied Flow Technology\AFT xStream\#.
 l Limitations - Cannot be transferred to other users, local use only.

External Library

 l Purpose - Stores user-specified data of any type: fluids, pipe materials, junctions, and fittings & 
losses. Multiple network or local custom libraries can be created via the Library Manager on the 
Library menu. External libraries can be shared to multiple users from a network location as is dis-
cussed in Creating an Enterprise-wide Network Library System.

 l Filename - User-specified filename.
 l Location - User-specified location.
 l Limitations - Must be connected via the Library Manager prior to use, and consideration should 

be given to version control or user permissions to edit.

Library Manager 429

Network Library Overview 441

Library Verification 445

Library Locations in General Preferences 446
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Library Manager
Accessed from the Library Menu, the Library Manager allows you to:

 l Connect to and disconnect from libraries
 l Create and delete libraries
 l Add content to libraries
 l Review the content of libraries
 l Move contents between libraries

Library Browser
The first panel of the Library Manager is the Library Browser. Use the Library Browser to create a new lib-
rary, add an existing library, view contents of an added library, and connect or disconnect libraries to the 
model.

Adding and Removing Existing Libraries

To work with a library you must first make it available to AFT Impulse. Referring to Figure 1, clicking on 
the Add Existing Library button will open a standard file dialog box with which you may browse to and 
select a library. A library may be removed from the list of available libraries by right-clicking on the library 
and selecting Remove Library from List.  A summary of the library contents can be seen in the section on 
the right when a library, library section, or component is selected in the list of available libraries.

The AFT DEFAULT INTERNAL LIBRARY and the AFT XSTREAM LOCAL USER LIBRARY may not be 
removed and will always appear in the list of available libraries. External shared libraries will also always 
appear in the available library list.
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Figure 1: Library Browser in the Library Manager

Connecting and Disconnecting Libraries

In order to use the components from a library in the model the library must be connected. A library is con-
nected to the model when it is shown with a check mark in the Library Browser. All libraries are auto-
matically connected when they are first added to the Library Manager.

Sections or components in a library can also be connected/disconnected on an individual basis if the lib-
rary as a whole is connected.

It may be desired to disconnect a library if you do not want the components from that library to be avail-
able for use in the current model, but you do want the library to be available for use in other models.

Clicking on Set As Default will establish the list of connected libraries as the default list, while clicking on 
User Default will set the connections to the default list.

AFT Internal Pipe Material libraries can be connected or disconnected as a group from the Other Actions 
button under the available libraries list.

Editing Library Contents

Existing content can be moved to/from, copied to/from, or deleted from available libraries in the Library 
Browser.

To edit an item right-click on the item in the Library Browser, then click the desired action from the right-
click menu. Note that moving, copying, and deleting can be done to a library as a whole, or can be done 
for just a section or single component in a library. Individuals components can also be edited by choosing 
Edit Component, which will take you directly to the Edit section for the component type.
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Figure 2: Library contents can be transferred or deleted from the right-click menu

Creating External Libraries

By default library items are stored in the AFT Default Internal Library or Local User Library, both of which 
cannot be shared with other users. Library items can be moved or copied to an external library which can 
be shared with multiple users.

To create an external library click the Create New Library button underneath the available libraries list. 
You will be prompted to provide a name for the file, and a library description (Figure 3). The provided 
description will be displayed as the library's name in the Library Manager.

To add content to an external library copy or move content from an existing library as described in the 
Editing Library Contents section. Junction components can also be directly added to external libraries as 
is described in the Junction Libraries topic.

For more details on creating and sharing external libraries see Creating an Enterprise-wide Network 
Library.

Figure 3: After specifying a library file name, you will be prompted for a description which will then appear in 
the Library Manager when this library is selected



Libraries

- 432 -

Junction Library

Adding Custom Junction Data to the Component Library

To simplify modeling and eliminate repetitive data entry, AFT xStream allows you to save frequently-
used junction data to a custom library. Once saved, the custom equipment can be selected from the 
Library List in the Properties window at any later time for immediate recall of the data. Using this tool, you 
can easily build your own library of compressors, valves, or other components supplied by specific man-
ufacturers.

To save a custom junction to the library - open the junction Properties Window and enter all required 
data. Close the window and choose Add Component to Library from the Library menu. You will be promp-
ted to enter a name for the custom component. Enter a descriptive name and close the window. If you 
open the junction again, the custom name will be selected in the Library Jct dropdown.

AFT xStream accepts custom for all junction types.

Editing the Component Library

You can delete or rename any existing library component in the Edit Junctions panel of the Library Man-
ager, accessed from the Library menu. To edit an existing library entry, select the item in the list and click 
the Edit Data button. This opens the data into a Properties Window where the data can be modified.

Fluid Library
AFT Arrow provides an AFT Standard fluid library for numerous common fluids. If the working fluid you 
wish to model is not in this library, you may elect to enter the fluid properties in a custom library for later 
reuse using the Edit Fluids panel in the Library Manager.

You can open the Edit Fluids panel from the Library menu or from the Edit Fluid list button in the Fluid 
panel in Analysis Setup. The Edit Fluids panel allows you to review currently defined AFT Standard and 
custom fluids, to change the data for custom fluids, and to enter new fluids. All AFT Standard fluid prop-
erties are assumed to be a function of temperature. Custom fluids can be a function of temperature or 
solids concentration.

Once you have entered a custom fluid, it will appear in the Fluids Available in Library list of the Fluid 
panel when User Library Fluid is selected.

Adding a Custom Fluid

You can add new fluids by clicking the Add New Fluid button on the Edit Fluids panel of the Library Man-
ager. A number of fluid properties are required for a compressible flow analysis. There are also several 
optional properties.

Required Data:
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 l Dynamic Viscosity
 l Specific Heat (at constant pressure)
 l Reference Temperature/Enthalpy point
 l Molecular Weight

Optional Data:

 l Thermal Conductivity (required for heat transfer capabilities besides adiabatic/isothermal in pipes)
 l Vapor Pressure (required if checks and warnings for saturation are desired)
 l Compressibility Factor
 l Critical property data points are used for some Equation of State and enthalpy models

Except for the constants and enthalpy, all properties are assumed to be functions of temperature only. 
The assumption can break down in systems with very large temperature changes, and should be 
checked by the user. These properties can be modeled with polynomials or interpolation, and features for 
creating curve fits from raw data are provided.

The enthalpy is a strong function of temperature but a weaker function of pressure. Frequently the pres-
sure dependence of enthalpy can be ignored. The three enthalpy models offered by AFT xStream allow 
you to choose different ways of handling the pressure dependence.

The Add New Fluid/Change Fluid Data windows offer cross-plotting of your custom curves against the 
curve fit data points. You can also import data from text files into these windows.

Related Topics

Curve Fitting 75

Pipe Material Library

Adding Custom Pipe Materials to the Pipe Materials Library

You can open the Edit Pipe Materials panel from the Library menu. Using this panel, you can easily add 
to the user library the geometric information for any pipe material in the length units of your choice. Cus-
tom pipe materials can be selected for use in the Pipe Properties window, minimizing the data entry 
required by the user.

Pipe materials typically have a range of nominal sizes and a specific type, class, or schedule that 
describes the actual dimension. AFT xStream works with the inner diameter of the pipe, since that is the 
parameter that directly affects the fluid mechanics.

To add custom pipe materials to the user library, choose the entry location you desire in the list on 
the left (Pipe Materials, Sizes and Types), then click the New button below. For example, to add an 
entirely new material, click the Pipe Materials item at the top of the list then click the New Material button. 
To add a new size for an existing material (say Steel), click Steel in the list then click the New Size button. 
To add a new type to the Steel 1 inch size, click 1 inch under the Steel material in the list then click the 
New Type button.
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When adding a new material, you also will be asked to specify a geometry, enter a nominal size, type of 
material, diameter, wall thickness, friction data set, and friction value to define the first data. Optionally 
you can add in a wall thickness. From then on you can enter additional nominal sizes and types. The 
name descriptors you choose for the material, size, and type are at your discretion. They can contain text 
mixed with relevant numbers if you desire.

You can also add multiple Friction Data Sets for each pipe material. This allows you to keep, for example, 
different friction values that may apply to the same pipe under different conditions. These conditions 
could be related to the age of the pipe or the type of fluid being carried. See the Friction Data Sets section 
below for more information.

In addition to manual entry of the custom pipe materials, you also can import pipe material data from a 
file. When you click the Import From File button, a dialog box will appear explaining the necessary import 
file format. By choosing to import from a file, you will be able to have a separate copy of the data for later 
access.

Friction Data Sets

Friction Data Sets are pipe friction values for a particular pipe condition.

To create a new Friction Data Set select a Pipe Material, Size, or Schedule to associate the data set with, 
then click New Data Set from the Friction Data Set tab on the right (Figure 1). Modify the Friction Data Set 
description to provide a name, then enter the Friction Model and Value.

A Friction Data Set can be associated with the entire pipe material, or with specific sizes or types. For 
instance, a friction data set associated with Steel (i.e., the top level) might be called "25 year usage" and 
have a roughness value of 0.005 inches. This data set is then available to all sizes and types of steel. 
However, if "25 year usage" is associated only with the 1 inch of Steel, it will apply only to the pipe sched-
ules that are 1 inch.

You can also associate friction data sets with a specific type (i.e., schedule). For instance, you can make 
a "25 year usage" and associate it only with 1 inch schedule 40 Steel pipe and assign its roughness value 
as 0.006 inches. Then all Steel pipe would use 0.005 inches for "25 year usage" friction while the dif-
ferent value for 1 inch schedule 40 of 0.006 inches would supersede the value of 0.005 inches asso-
ciated with all Steel pipe.

Finally, among multiple friction data sets you can specify a default data set.

Multiple friction data sets can be created for each type of pipe material. For example, there may be sep-
arate friction data sets for Steel pipe such as: New Pipe, 10 Year Use, 20 Year Use and 30 Year Use. 
Typically, the older pipes will have higher friction.
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Figure 1: Friction Data Set tab on the Edit Pipe Materials panel

Pipe Physical Properties

The Pipe Material Library window allows you to assign physical properties of the pipe. The density and 
Poisson ratio of the pipe can be entered as constants, and the modulus of elasticity as a function of tem-
perature.

Related Topics

Curve Fitting 75
Pipe Material Library References 494

Insulation Library
The Edit Insulations panel is accessed from the Library menu. This panel allows you to view the insu-
lation data provided with AFT xStream, or to add, edit or delete user defined insulation materials. Insu-
lation library items are used for heat transfer calculations in pipes. 

To add a new insulation material click Add New Insulation, then enter the data in the Insulation Physical 
Properties window. The insulation thermal conductivity is entered as a function of temperature, and dens-
ity as a constant.

Insulation data can be applied directly to pipes, and can also be associated with the Pipe Material Library 
as insulation data sets.
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Related Blogs

Databases 101 - Get to Know Them

Databases 201 - Name That Fluids

Databases 301 - Those Are Some Nice Pipes!

Databases 401 - Managing Databases

Fittings & Losses Library
The Edit Fittings & Losses panel can be accessed from the Library Menu and allows the user to review 
the Fittings & Losses data provided by default in xStream, and to add, edit or delete user defined Fitting & 
Losses in the AFT Default Internal Library.

Fittings & Losses can either be added by using the entry form in the window, or by importing a text file as 
described below. To enter a new Fitting/Loss item in the Edit Fittings & Losses panel click Create New 
Loss Item. Define the applicable category, type, geometry and loss model information then click Accept. 
The user-defined item will appear in the Fittings & Losses on the left under the relevant category/type 
with the source shown in parentheses as "U".

Custom fittings & losses are saved to the local user library. From there the user can move them to other 
libraries (see Library Manager).

Import From File

Fittings & Losses can be imported from a *.CSV type file, which can be created from any spreadsheet-
type software, such as Excel.

The entries in the file should be in the order as shown in Figure 1, but with no headers in the workbook. If 
a header row or a blank row is used, xStream will present a warning, but give the user the option to still 
import the valid rows.

Figure 1: Example of import file setup for a custom elbow/bend (headers should not be present in the file to 
import)

Valid options for each of the columns are listed below, with detailed options given in Table 1. 

 l Category - Must match one of the values from Table 1. "Other" may be used if none of the specific fit-
ting/loss categories fit.

 l Type - This field is required, any name/value may be entered. Types already existing in the library 
are shown in Table 1, and may be used if desired.

 l Sub Type - This field is optional. A sub-type may be chosen from Table 1, or any other name/value 
may be entered.

https://www.aft.com/support/product-tips/entry/2016/01/04/databases-101-get-to-know-them
https://www.aft.com/support/product-tips/name-that-fluid-databases-201
https://www.aft.com/support/product-tips/databases-301-those-are-some-nice-pipes
https://www.aft.com/support/product-tips/databases-401-managing-databases
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 l Geometry - This field is optional. A geometry type from Table 1 must be used if a geometry is 
entered. If the Geometry field is left blank, the Geometry Value will be ignored.

 l Geometry Value - This field is only required if a Geometry type has been entered. Any positive 
numerical value may be entered.

 l Loss Model - This field is required. The Loss Model must be either "K (constant)" or "K / fT (Crane)".
 l Loss Value - This field is required. Any positive numerical value may be entered for the loss value.
 l Reference/Notes - This field is optional. Any information may be entered here as needed.
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Table 1: Valid Entries for each field. The Geometry Value and Loss Value fields will accept any numerical 
entry. The Reference/Notes field will accept any entry.

Category Type Sub Type Geometry Loss Model

Elbow/Bend

Standard 
Threaded

Mitre

Smooth Flanged

 

 

 

 

 

 

 

 

 

 

 

3-K (Darby)

 

 

General

General

r/D=1

r/D=1.5

r/D=2

r/D=3

r/D=4

r/D=6

r/D=8

r/D=10

r/D=12

r/D=14

r/D=16

r/D=20

90 deg

45 deg

180 deg

Angle (degrees)

Pipe Size (nom-
inal)

None

K (constant)

k / fT (Crane)

Valve

Angle

 

 

 

Ball

Butterfly

 

 

Type 1

Type 2

Direct flow

General

None

Plane disk - 
AR=0.92

Plane disk

t/D=0.1

Angle (degrees)

Open Percentage

L/D

Pipe Size (nom-
inal)

None

K (constant)

k / fT (Crane)
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Cylindrical

 

Gate

 

 

 

 

 

 

 

 

Globe

 

 

 

 

 

Plug

Poppet

 

 

t/D=0.15

t/D=0.2

t/D=0.25

t/D=0.3

t/D=0.35

Type A

Type B

Type C

General

Rect. Tube

Wedge/Plug

Wedge

Disk w/o recess

Disk with recess

Disk

Wedge - Full Open 
10 deg.

Wedge - Full Open 
20 deg.

Sluice

Disk with recess

90 degree wall

45 degree wall

Standard 45 deg. 
wall

Standard 90 deg. 
wall

Standard

Y Type

Straight-way

W/D=.035
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Three-way

 

3-K (Darby)

 

 

 

 

 

W/D=.07

No Seat Width

Through flow

Branch flow

Angle

Globe

Plug

Gate

Ball

Diaphragm

Check Valve

Swing

 

Lift

 

Tilting disc

Stop-check

 

 

3-K (Darby)

 

90 deg. seat

45 deg. seat

90 deg. wall

45 deg. wall

General

Globe 90 deg.

Globe 45 deg.

Globe thru flow

Swing Check

Lift Check

Angle (degrees)

None

K (constant)

k / fT (Crane)

Orifice
Sharp

Long

None

None

Area Ratio

None

K (constant)

k / fT (Crane)

Entrance/Exit

Entrance

 

 

Exit

Sharp

Reentrant

Rounded Flush

None

R/D

None
 

Other

Diff Flowmtr

 

 

Orifice Plate

Nozzle

Venturi 7 deg.

Area Ratio

None

K (constant)

k / fT (Crane)
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Honeycomb cell

 

 

 

 

 

Screen

 

 

 

Tee

 

Venturi 3 deg.

Dall Tube

L/D=2

L/D=4

L/D=6

L/D=8

L/D=10

L/D=12

Perforated Plate

Circular wire

Silk thread

Round wire or net-
ting

Through flow (dead 
branch)

Branch flow (dead 
run)

Flange Steel
150 lb.

300 lb.
None N/A

Related Topics

Fittings & Losses 183
Specifying Losses 212

Network Library Overview
Custom libraries contain custom data generated by the user, including fluid properties, pipe materials, 
and data for junctions types such as pumps and valves.

All custom data created by the user is kept on the local computer in a file called xtr_User#.DAT (where # 
is the corresponding version number) in the local user directory. This data is not shared and is always 
available to the local user for access or for editing. See the Libraries topic for more information.

In addition to the local user library, you can create multiple network or local custom libraries. The Library 
Manager window on the Library menu simplifies this process. See Creating an Enterprise-wide Network 
Library System for details on how to do this.
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Benefits of Shared Libraries
When the xStream libraries are placed on a network, powerful data management procedures can be 
implemented. Specific, quality-checked data can be entered into libraries located on a local or wide area 
network of PC's. This data is not accessible to the end users through AFT xStream itself, so it is guarded 
data.

Once the data is placed on a network, users can connect to any library listed in the Library Manager. 
Users can connect to as many libraries as they want.

If the user connects to a library with these files and selects to be connected to any of these control files, 
the model will inherit the control formatting specified in the control files. This means that special report lay-
outs, special graphical representations and colors, and other special controls can be decided upon by 
the library constructor, and those control features can be loaded into local models by end users. This is 
highly useful for creating customized reports for certain customers or project requirements.

By way of example, assume the Output Control content was specified as coming from the "Woodland 
Park Office Library" library.

If you uncheck the Library checkbox or change certain data in the Output Control window, the library will 
remain connected but change to an inactive state. When the library is inactive, none of its data flows 
through to the model. To bring the Output Control data back into sync with the connected library, recheck 
the Library check box in Output Control.

This entire custom library concept lends itself naturally to the idea of specific project libraries. Each pro-
ject has differing requirements that depend on the nature of the project and the end customer. Data for 
each project can be assembled into separate libraries, allowing faster and more accurate transmission of 
the controlled data and desired reporting formats to engineers.

Maintaining a network library allows commonly-used data to be controlled, which may be helpful in 
instances where quality control is strict.

Creating an enterprise-wide, network library system

Overview

Users of AFT xStream on a network can access common libraries to simplify model verification, improve 
analysis and reporting consistency, and eliminate redundant work.

To accomplish this there is some initial setup that must be done. First, the data for components, mater-
ials, formats, etc., needs to be created and saved to various data files. Secondly, these files must be 
made available to the users of AFT xStream by creating a file named DATABASE.LIB in the xStream 
folder. Thirdly, the users need to connect to the new libraries listed and select the sections to use. Each 
of these broad steps is discussed below. To maintain control and integrity of the data, it would be advised 
that one person is given the responsibility to create and maintain the network libraries. The discussion 
below will be given from the viewpoint of this person.

Table 1 shows the relationship between Internal Libraries and External Libraries as well as the library file 
listing that AFT xStream uses to find these libraries. An External Library is any library file that is created 
by the user and listed in the XTR_DBUSER.LIB residing in the user’s local user directory. The user can 
make these available and unavailable, and connect and disconnect from these libraries using Library 
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Manager. The library files themselves may be located on any local or mapped drive. These library files 
are also distinguished by being under the local user’s complete control. External Shared Libraries, on the 
other hand, are common to all AFT xStream users on the network, therefore the local user cannot 
remove them from the list of available libraries. However, the user can choose to connect or disconnect 
from these libraries using Library Manager. Finally, to complete the discussion, there are two special lib-
raries, the Default Internal Library and the Local User Library. These files are AFT xStream Internal 
Libraries which cannot be disconnected or made unavailable.

Table 1: Summary of the types of libraries used for the example below, note the difference between External 
and External Shared libraries is just which *.LIB file their file path is listed in

Library Groups & 
Filenames Library Titles Library Locations

xStream Internal 
Libraries   

XSTREAM3.DAT

XTR_USER3.DAT

AFT Default Internal Library

AFT xStream Local User Library

AFT xStream 3 
folder

AppData folder

External Shared 
Libraries 
(DATABASE.LIB)

  

VailMaterials.dat Vail Resort Materials
Network Location, 
with path listed in 
DATABASE.LIB

External Libraries 
(XTR_DBUSER.LIB)   

VailMaterials.dat Vail Resort Materials
Network Location, 
with path listed in 
XTR_DBUSER.LIB

Creating Library Files

The first thing to do is create the files that contain the information to be shared. These files will be referred 
to as library files and can contain information about pipe materials, components (e.g. pumps, valves, 
etc.), fluids, etc. The following are several ways to create library files:

 l Use the Create New Library button in the Library Manager, as described previously. Data can be 
taken from the current model or other libraries.

 l Copy and paste sections from one file into another file using a text editor.

This discussion will focus on the first and second methods. Let’s assume that the person responsible for 
the network library has already created a new pipe material. Also, assume that the goal is to create a net-
work-wide library to contain this material.
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The information for the material is copied from the Local User Library (XTR_USER3.DAT) to a new file 
using the Library Broswer in the Library Manager. For the source library choose Local User Library and 
then select Pipe Materials. Then click Create New Library and enter a file name, VailMaterials.dat, for 
this example. Enter a description of the library - this description is how AFT xStream users will refer to the 
library and should concisely describe what is in the library (for this example we’ll use "Vail Resort Mater-
ials"). Right-click the pipe materials section from the Local User Library and choose Copy Content to 
copy the pipe materials to this new library file. The pipe material library file has now been created and is 
ready to be used.

Sharing Library Files Using DATABASE.LIB

Now that the library file for the Pipe Materials has been created, it needs to be made available to the 
users of AFT xStream. Depending on the scope of use, library files can be placed into one of two groups. 
If the library is to be used locally by one user, it is put in the External Library group. On the other hand, if 
the library is to be common among many users and shared over a network it is put into the External 
Shared Library group.

Continuing the above example, the goal is to share the library file, so it will need to be an External Shared 
Library listed in the DATABASE.LIB file in the xStream directory on the network. However, since xStream 
does not write directly to the network files for security reasons, it is easiest to temporarily treat these files 
as local External Library files which will be listed in the XTR_DBUSER.LIB file located in the local user dir-
ectory of the local machine.

It is recommended that External Shared Library files be copied to the network server and placed in a sub-
folder of the AFT xStream folder (e.g. AFT Products\AFT xStream 3\Libraries). The files may, however, 
be located anywhere on the network that is accessible to the users. For our example, we are going to put 
the pipe material library on the network in a subfolder called Libraries. It is easier to copy the file to the 
Libraries folder before they are made available in AFT xStream. This will help establish the correct paths 
to the files as the files are made available using the Library Manager.

Once the library file is in the network location, open the Library Manager in AFT xStream to the Library 
Browser. Each of the new library files we have created needs to be added to the Available Libraries list by 
clicking Add Existing Library and browsing to the file. Once you click OK, the description of the library you 
just added appears in the Available Libraries list. Once you have added the new library, click Close and 
the External Library listing file (XTR_DBUSER.LIB) in your local user directory is automatically updated.

Now we need to discuss how the paths should be setup. When you add a library, AFT xStream will write 
the full path of the library to the External Library listing  (XTR_DBUSER.LIB). That means that if you 
browsed to the library file using a mapped drive letter then the path will include that drive letter. However, 
if other users try to access the libraries but have the AFT xStream folder mapped to a different drive letter 
they will not be able to locate the library files. Other options include using either relative paths or the com-
puter name in the path (e.g. \\Network Server\Eng Apps\AFT Products\AFT xStream 3\Librar-
ies\filename.dat). You can automatically have AFT xStream use the computer name when you add the 
file by choosing Network Neighborhood, then the computer and then browse to the library file. If you 
would rather use relative paths, you can manually edit them in the library listing file. All library files must 
be relative to the AFT xStream folder where the executable is located.

When the pipe materials library was added it became an External Library listed in XTR_DBUSER.LIB. 
Now we need to move this listing from the local machine to the AFT xStream folder on the network so that 
all users can access the library files. Once the listing file is moved to the network, it must be renamed 
DATABASE.LIB. Once this is done, all users can now access the library file we have created.
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Connecting to the External Shared Libraries

Now that the libraries have been placed on the network and made available to all AFT xStream users, 
each user must now connect to the libraries and make the sections active as needed. When a user opens 
the Library Manager, the External Shared Libraries are listed in the Library Browser. Make sure the 
checkbox is checked to make those libraries connected for use. Also ensure that the sections within the 
library are checked for use. A library can be connected without having any sections selected and active. 
Finally, to have these connections in place every time you start AFT xStream, click Set As Default. To 
apply these settings to a model made previously, open the model, go to Library Manager, click User 
Default and, if you have set the default, the connections and setting will now be applied to the model.

Sharing Model Formats/Preferences

Note that the Library Manager used to provide the option to include formats/preference settings such as 
the Output Control or layouts into shared libraries. These type of files can still be shared, but are no 
longer shared through the Library Manager. Instead these type of format files must be loaded directly 
through their control windows, such as loading the Output Control format being loaded in the Output Con-
trol window.

Library Verification
The Library Verification window is displayed when you open a model or new scenario which contains con-
nected library items that have some inconsistency.

1. Library Item Not Found

You may have a library item that is not found in any currently connected library. For example, a com-
pressor may be connected to a library, and derive its data from that library. However, when the model is 
loaded, the source library is not available. This could be for several reasons that will be discussed 
shortly.

The compressor in the model does in fact have all of the required data needed to run the model. But 
when it is not found in the library, you will be offered several options:

 l Disconnect it from the source library - This means that the model will forget the library the com-
pressor came from and make it a standalone compressor not connected to any library.

 l Add it to a library - This means that the compressor can be added to a custom library.
 l Leave the library connection - This means that the compressor will remember what library to 

which it was originally connected and connect to that library again when it is made available to 
AFT xStream. If, however, you try to open the Compressor Properties window, AFT xStream will 
disconnect the compressor from the library and warn you.

The compressor might have lost its library connection for one of these reasons:
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 l The library is no longer available because it was removed either through the Library Manager or 
because your libraries have been changed on the network.

 l The model is being run on a different PC than where it was created, and the original libraries are 
no longer available. This could be, for example, because you have moved the model onto a laptop 
computer to take it on travel. Or it could happen because the model was developed by another 
company which had developed libraries of its own but which are not available to you.

Whatever choice you make, the model will retain all its engineering data and yield the same results as it 
did originally.

2. Item in Model is Different from Library

You may have a library item in the model that is connected to a external library, but for some reason the 
data is not the same. For example, you may have a compressor curve for the Rocky Mountain Com-
pressor Company's Model 100A in your model, but it does not match the compressor curve for this model 
in your library. Here you have three choices:

 l Update the items in the model to match the library - This will actually change the model's 
input data, and it might yield different results than originally.

 l Update the library (if it is local) to match the model's items - This will change the library, but 
will leave the model's input data as it was. It will yield the same results as it did previously.

 l Disconnect it from the source library - This will leave the model as it was, and it will yield the 
same results.

The compressor in the model might have a different compressor curve than the one in the library for one 
of these reasons:

 l When the model was built, the compressor was connected to the Rocky Mountain Compressor 
Company (i.e., RMCC) Model 100A. But since that time, the RMCC library has changed. Perhaps 
there was an input error in the original data, or better data has since become available and the lib-
rary was updated. If this were the case, it would be best to update all your compressors to the lib-
rary values.

 l The library may have been changed by an unauthorized individual, and while it was accurate ori-
ginally, now the data is no longer valid. In this case, it would be best to not update the com-
pressor in your model, and to inquire into the cause of the inaccurate data within your 
organization.

Library Locations in General Preferences
When performing an engineering analysis with or even without cost estimating, there may be many engin-
eering libraries that underlie the model. These libraries need to be connected in the Library Browser in 
order to be accessible by the model. However, to know what libraries are actually needed, one needs to 
first load the model. This creates a dilemma.

To help alleviate the dilemma, users can create "Library Search Locations" in the User Options window. 
Figure 1 shows an example. Once specified, you can set these as your default locations by clicking the 
Set As Default button. When AFT xStream tries to open a model that requires certain libraries, and those 
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libraries have not been connected already, AFT xStream looks for them in the locations specified in the 
User Options. In addition, AFT xStream looks in the model's folder. If AFT xStream finds the libraries in 
one of these locations, it automatically adds it to the list of connected libraries in the Library Manager. If it 
cannot find a library, it informs you once the model is loaded.

Figure 1: Library Search Locations can be defined in the User Options window
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Theory and References
This section focuses on the fundamental theories that are used in AFT xStream's solution method. Addi-
tionally, this chapter gives information on the source material for the theories used. Topics include dis-
cussions on the theories that comprise the network solution, compressible flow theory, sonic choking, 
transient flow theory, and information on references used in the development of AFT xStream.

Content

Nomenclature 448

Review of Compressible Flow Theory 450

Nomenclature

a sonic speed

A cross-sectional flow area of a pipe

B compatibility equations parameter for method of characteristics 

C compatibility equations parameter for method of characteristics

Cd discharge coefficient

cp specific heat, constant pressure

cv specific heat, constant volume

CV valve coefficient

D diameter of a pipe

e specific energy

F Force

f friction factor

fT turbulent friction factor (used by Crane, 1988)

fL laminar friction factor

fTr transition friction factor

F error value in mass balance

g gravitational constant

h internal convection coefficient

h enthalpy, static
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ho enthalpy, stagnation

H  head

J  Jacobian matrix

k thermal conductivity

K loss factor

L length of a pipe

mass flow rate

M Mach number

n general constant

N compressor synchronous speed (rpm)

P pressure, static

Po  pressure, stagnation

Pw  wetted perimeter

P power

q heat rate to a pipe

Q  volumetric flow rate

r  radius

r  relaxation

R, R’  resistance or gas constant

Rc   coefficient of rigidity

Re  Reynolds Number

s fan speed

s entropy

t  time

T  temperature, static

To  temperature, stagnation

u internal energy

v specific volume

V  volume

V  velocity
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w  work

x  distance along pipe centerline

z elevation

Z  compressibility factor

α, μ, θ angle

β diameter ratio

β coefficient of volume expansion

λ method of characteristics multiplier

η  efficiency

ν  kinematic viscosity

ε roughness

γ  specific heat ratio

ρ density

τ  shear stress

ω  rotational velocity

μ dynamic viscosity

Subscripts             

i junction or pipe station at which solution is sought

j junctions with pipes connecting to junction i

R rated conditions for a compressor, usually BEP

o stagnation

 infinity, far away, ambient

new current time for computation

old  most recent time for computation

Review of Compressible Flow Theory
This topic gives an overview of internal compressible flow theory. For a more complete development of 
compressible flow theory, please consult one of the many textbooks available (Anderson, 1982, Saad, 
1993, and Shapiro, 1953).             
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What is Compressible Flow?             

Compressible flow is a specialized branch of fluid mechanics that describes the flow of gases. This field 
of study is sometimes called gas dynamics, which is a synonymous term.

Compressible flow theory draws heavily from the fields of fluid mechanics and thermodynamics. This 
important branch of fluid mechanics has been developed almost completely since the year 1900. Its 
development has been largely driven by the extraordinary progress in the applied fields of aerodynamics 
and aircraft technology.

The field of compressible flow breaks down naturally into the two related areas of internal and external 
flow. Among the important applications of external compressible flow are the design of aircraft and airfoil 
design. Among the important applications of internal compressible flow are pipe flow, nozzles and gas tur-
bines. In AFT xStream, the interest is entirely in internal compressible flow.

The basic feature that distinguishes compressible from incompressible flow is the changing density of the 
gas. The density of the gas is related to the temperature and pressure of the gas through an equation of 
state. The variable density makes traditional incompressible analysis techniques of limited usefulness, 
and in general makes pipe flow analysis much more complicated.

The variable gas density has several important ramifications. First, the velocity of the gas is related to 
density through the continuity equation, and thus velocity also becomes a variable even in constant area 
pipes. Second, the density dependence on temperature means that the energy equation is coupled to 
the equation of state and must be solved simultaneously with the other governing equations. And last, 
the velocity of the gas is constrained by the sonic gas speed. Thus unusual effects like sonic choking can 
occur which further complicates analysis.

It should be noted that not all gas flows are compressible. In some applications the gas velocities are low 
enough or the pressure drops are small enough that compressible effects are insignificant. In such situ-
ations, systems can be modeled with traditional incompressible techniques. AFT xStream is capable of 
modeling gas flows that are either compressible or incompressible.

Equation of State

The equation of state relates the density, pressure and temperature of a gas. In principle, knowledge of 
any two of these parameters makes it possible to determine the third. 

The ideal gas equation of state is given by the following

where  is the universal gas constant and  is the molecular weight of the gas. These two terms are fre-
quently combined into a constant Rg

(63)
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where Rg is the gas constant for the particular gas. The above equation is known as the ideal gas equa-
tion, because it offers an idealized model to relate the pressure, density and temperature of a gas. For 
simplicity, the “g” subscript will be dropped and it is to be understood that R is not the universal constant, 
but that for a particular gas.

Experiments have shown that Equation 63 can be applied to a more general selection of gases by intro-
ducing the compressibility factor, Z, which compensates for departure from ideal gas behavior.

(64)

There are many methods of determining Z. These methods are found in textbooks and handbooks, each 
having strengths and weaknesses.

First Law and Isentropic Relationships

From the First Law of Thermodynamics we know that

(65)

For a reversible process, the work term can be represented by the following

(66)

where v is the gas specific volume (inverse of density). In addition, the incremental addition of heat is 
given by 

(67)

where s is the entropy. Substituting Equations 66 and 67 into 65 and rearranging yields

(68)

The enthalpy is related to the internal energy by the following identity
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(69)

Differentiating yields

so that Equation 68 becomes

(70)

By using a suitably average specific heat constant, the enthalpy can be related to temperature

(71)

and can be substituted into Equation 70 to obtain

The specific volume is the inverse of density, thus

(72)

To simplify the following concepts, a perfect gas will be assumed and extensions to real gases will be 
made without proof. Later applications will describe the effects of real gas behavior in more detail.

For a perfect gas, the third term in Equation 72 can be modified to obtain

(73)

Integrating Equation 73 results in
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(74)

In many applications the local gas flow is isentropic, which causes the left side of Equation 74 to go to 
zero yielding

(75)

For an ideal gas it can be shown that

(76)

or rearranging

(77)

where γ is the ratio of specific heats.

For a real gas, Equations 76 and 77 become

(78)

(79)

The ratio of specific heats can also be calculated by

(80)
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The parameter γ is very important in determining the thermodynamics in isentropic processes. When con-
sidering a real gas, as the pressure increases Equation 80 takes on a modified form (Bejan, 1988, pp. 
178)

(81)

By algebra Equation 75 becomes

(82)

By similar methods it can be shown that

(83)

To summarize, Equations 82 and 83 are isentropic relationships that are valid for real gases if the appro-
priate value for γ is used.

Sonic Speed and Mach Number

The sonic speed of a gas is the velocity at which disturbances propagate within a gas. Unless a system is 
specially designed to produce supersonic flow, the sonic flow speed is the maximum speed at which the 
gas can travel.

It can be shown that a sound wave is an isentropic phenomenon involving virtually no energy loss, and 
that the speed of sound is given by the following equation (based on mass and momentum conservation)

(84)

where a is the speed of sound and the subscript “s” refers to isentropic conditions. Another more useful 
form of Equation 84 is obtained by combining Equations 82 and 83 to relate pressure and density
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(85)

Using Equation 85 in Equation 84 and carrying through the differentiation

or using the ideal gas equation (Equation 63)

(86)

Equation 86 is the classic equation for speed of sound, and since the specific heat ratio varies only 
slightly, the speed of sound effectively depends only on temperature.

For real gases, Equation 86 requires using the real gas equation (Equation 64) to obtain

(87)

As an example of sonic velocity, consider air at 70º F (530º R). The specific heat ratio for air is about 1.4, 
and assuming ideal gas (Z = 1) then

The relationship between the gas velocity and sonic speed is known as the Mach number. 

(88)

The Mach number is a dimensionless quantity that is the most important parameter in compressible fluid 
flow. Relating all parameters to the Mach number greatly simplifies compressible flow calculations.

In general, the sonic gas velocity is the maximum that can be attained in a system, thus the largest Mach 
number in a pipe system is 1. This is known as sonic flow. Flows less than Mach 1 are referred to as 
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subsonic flows. It is in fact possible to attain Mach numbers greater than 1 by using a specially designed 
convergent-divergent nozzle. Flows greater than Mach 1 are referred to as supersonic flows. There are 
special applications for supersonic flows in internal flow systems, however these applications are not gen-
erally of interest to the piping engineer and thus no attempt is made to address supersonic flows in AFT 
xStream. AFT xStream strictly assumes that Mach 1 is the maximum in the system.

Stagnation Properties in Compressible Flow

In application of Equation 65 to compressible pipe flow, use of the fluid enthalpy simplifies energy bal-
ance calculations. The enthalpy is a convenient parameter that combines the internal energy changes 
with the work performed by volume changes in the flow. The energy equation is:

(89)

A new parameter called the stagnation enthalpy is introduced which is defined as:

(90)

Introducing Equation 71 into Equation 90 results in

(91)

where To is the stagnation temperature. The stagnation properties are sometimes referred to as “total” 
properties, which is a synonymous term. In contrast, the temperature, T, is the thermodynamic tem-
perature that we are accustomed to, and takes on the more descriptive name of static temperature.

Using Equation 79 to replace cp results in

(92)

and using the Mach number, Equation 88, this becomes
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(93)

Equation 93 relates the stagnation and static temperatures through the single flow parameter Mach num-
ber and γ, which is frequently constant.

Following from Equation 82 and 83

(94)

(95)

Between pressure, temperature, enthalpy and density, it is easiest to grasp the physical difference 
between static and stagnation properties when considering pressure. The classic example is a pitot tube 
that is normal to the flow or pointed directly into the flow. Figure 1 depicts the distinction.

The ratio of stagnation to static conditions for pressure and temperature are shown in Figure 2. 
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Figure 1: Comparison of static and stagnation pressure measurement at a pitot tube. 

Figure 2: Variation of stagnation to static temperature ratio and stagnation to static pressure ratio with Mach 
number. Gamma = 1.4.
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The stagnation temperature, stagnation enthalpy and stagnation pressure (and to a lesser extent, stag-
nation density) are of great importance in compressible flow systems. The stagnation property is made 
up of the “static” portion (which is the thermodynamic portion) and the “dynamic” portion (due to the fluid 
motion). The stagnation property is that property that would exist if the flow was brought to rest. In a fluid 
at rest (such as a large gas tank) the stagnation and static properties are equal.

The stagnation properties take on significance because they combine the effect of fluid velocity. Thus, a 
frictionless pipe will have constant stagnation pressures even if the area (and hence velocity) changes. 
The stagnation enthalpy will remain constant as long as no heat transfer and no elevation change occurs 
(see Equation 89). If the stagnation enthalpy is constant, the stagnation temperature remains constant 
insofar as Equation 71 remains valid. Departures from Equation 71 mean that the stagnation tem-
perature can change in an adiabatic pipe, but this change is usually small. For a perfect gas, Equation 71 
is always valid and thus stagnation temperature is always constant in adiabatic flow.

The convenience of stagnation properties is that frictional pressure loss and heat transfer calculations 
can be performed by using the stagnation property, thus avoiding the need to separately calculate 
dynamic (velocity) effects.

Also of importance is the issue of pipe networks. When a branch exists in a compressible flow network, a 
change in flow area is almost certain. The change in flow area means a change in velocity, and hence a 
change in the static pressure and static temperature. However, the stagnation pressure and temperature 
must always match at branching boundaries. The result is that the stagnation pressure and temperature 
are the key variables to solve for in a network pipe system.

The Continuity Equation

The continuity equation is the equation that applies the Law of Mass Conservation. For steady flow, the 
vector integral form of the continuity equation is given by

(96)

Carrying out the integration of Equation 96 and assuming one-dimensional flow in a pipe results in

(97)

If the pipe is of constant area, Equation 97 can be differentiated to obtain the following

(98)

Equation 98 states that any increase in gas density must be accompanied by a decrease in velocity.
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The Momentum Equation

The momentum equation is an expression of Newton’s Second Law of Motion, which states that the 
change in momentum is proportional to the sum of the acting forces, or

(99)

For gas flow in a pipe, the acting forces are the pressure forces and friction forces. Assuming one-dimen-
sional flow in a constant area pipe, the differential form of Equation 99 is

(100)

where τw is the wall shear stress. The wall shear stress can be expressed in terms of a Moody friction 
factor, f (one-fourth of the sometimes used Fanning friction factor), and defined as

(101)

Substituting Equation 101 into Equation 100 results in

(102)

Equation 102 relates the change in fluid momentum (the third term) to the pressure forces (first term), fric-
tion forces (second term) and body forces (fourth term). The four terms balance to zero.

The Energy Equation

The First Law of Thermodynamics was introduced earlier in Equation 89,
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(89)

or, using the stagnation enthalpy (Equation 90), the energy equation becomes

(103)

In the case of constant elevation, dz is zero and Equation 103 states that any heat transfer in a pipe is 
accompanied by a proportional change in stagnation enthalpy. If no heat transfer occurs (adiabatic flow), 
the stagnation enthalpy is constant.

For a perfect gas, the enthalpy is related to temperature by Equation 71. In general, enthalpy is a function 
of static temperature and pressure

While it is tempting to relate stagnation conditions on a similar basis because of the simplifications that 
result, in general only static conditions should be used. Thus

Frictional Effects in Pipes

To clearly understand the effect of friction in a pipe, it is convenient to look at the case of isothermal flow. 
The momentum equation, Equation 102, will be used as the starting point. Neglecting gravity effects,

From the continuity equation (98)

Substituting this into the momentum equation
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For ideal gas, isothermal flow,

(104)

Therefore 

or using the Mach number

or 

(105)

For subsonic flow, the quantity on the right hand side will always be negative. Therefore, dP will always 
be negative when there is isothermal flow with friction, which is what one would expect. If dP is negative

then from the equation of state (104)

Therefore, from the continuity equation (98)
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The conclusion therefore is that in isothermal frictional pipe flow, the velocity will always increase along 
the pipe. Simply put, the gas will accelerate. It can also be shown that the gas will accelerate if the flow is 
adiabatic. This further means that the Mach number will increase along the pipe length, eventually reach-
ing Mach 1 sonic conditions if the pipe is long enough. 

Once sonic conditions are reached, no additional acceleration is possible. Thus the flow will experience 
sonic choking. When a flow experiences sonic choking, lowering the downstream pressure to increase 
the differential pressure will not increase the flow. This phenomenon is frequently encountered in long 
gas transfer lines, and is addressed by placing compressors in the pipeline at regular intervals. 

It should be noted for completeness that the previous development assumed isothermal flow.

If pipe conditions are such that a gas is cooled along its length, then it is possible to decelerate a com-
pressible flow.  The reason decelerating flow can occur when the gas is cooled is seen from the equation 
of state. The ideal gas equation, in differential form, is

and eliminating density using the continuity equation

If cooling occurs, then the temperature change is negative, and because the pressure change is also neg-
ative, the velocity change can be either negative or positive. Thus, accelerating or decelerating flow is 
possible. In most applications, the pressure changes more rapidly than the temperature, making the velo-
city change positive resulting in accelerating flow.

Isothermal and Adiabatic Flow

Since the majority of gas flow applications operate somewhere between isothermal and adiabatic flow, 
these two idealized cases are frequently taken as the extremes to consider. As discussed in the previous 
section, this is not strictly true.

The case of adiabatic flow is frequently encountered in short pipelines or in cases where the pipes are 
well insulated. When the flow is adiabatic, the static temperature will decrease along the pipe. This can 
be seen from Equation 93. For perfect gases, the stagnation temperature is constant in adiabatic flow. As 
the Mach number, M, increases, the static temperature must decrease.
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But what happens when the pipe is cooled? When cooled, the stagnation temperature will decrease and 
the static temperature will actually decrease more than it would naturally. Thus, we can see that adiabatic 
flow cannot always be relied upon to be an extreme case.

The case of isothermal flow is frequently encountered in long gas transfer pipelines. When the flow is iso-
thermal, then by definition the temperature remains constant. This can only occur if the gas is heated 
from its tendency to cool down. In a long transfer line exposed to ambient conditions, the tendency is for 
the gas pipe material to come to equilibrium with the surroundings, and the gas will tend toward equi-
librium with the ambient conditions as well. The gas is heated by the ambient conditions outside the pipe.

In a more general case of gas heating, the heating may be strong enough to actually increase the static 
temperature. This means that the isothermal condition is not the extreme limit either. There is, in fact, no 
limit to gas heating effects until conditions reach ionization or dissociation. 

Figure 3 shows an example of air flow in a pipe where the adiabatic and isothermal flow do not bracket 
the range of possible flow conditions.

This discussion points out a frequent misconception among engineers that isothermal and adiabatic flow 
are the extreme cases to consider in gas flows. A more accurate statement is that the conditions under 
which the majority of gas pipelines operate have heat transfer boundary conditions that maintain the gas 
between adiabatic and isothermal behavior. For most practical applications, adiabatic and isothermal 
flow can be considered as the extreme cases. But it has been shown that this is not a completely general 
rule, and may be incorrect in some applications.

One last comment of practical importance. Whether a pipe operates adiabatically or isothermally or 
somewhere in between or outside, the primary impact of these assumptions is on the gas temperature.

Frequently, for analysis simplification purposes, a gas is assumed to operate either adiabatically or iso-
thermally, and the result is that the flow rates and gas pressures in the system do not change significantly 
between these two idealized cases. Thus, if the purpose of the analysis is to determine the system flow 
rate or flow distribution in a network, the heat transfer assumption used for the pipe will frequently have 
only a second order effect on the results.
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Figure 3: Comparison of temperature profiles and flow rate predictions for adiabatic, isothermal, heated and 
cooled air flow in a 20 ft. long 1 inch steel pipe. Inlet conditions are 100 psia, 111 °F and outlet pressure is 60 
psia. Cooled flow has ambient temperature of 30 °F. Heated flow has ambient temperature of 220 °F. Both 

heated and cooled cases have pipe wall and insulation heat transfer coefficients which total to 100 Btu/hr-ft2-
F. Note how adiabatic and isothermal cases do not bracket conditions. See Walters, 2000.                 
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Transient Theory
AFT xStream simulates transient systems using fundamental equations based on conservation of mass, 
momentum, and energy. These fundamental equations are solved using the Method of Characteristics.   

The math and calculations needed to support AFT xStream's transient simulations can be complex at 
times. The topics in this section attempt to clearly detail the theory behind AFT xStream. Please reach 
out to AFT Support if you have further questions.    

Transient Flow Equations
Any rigorous fluid dynamics solution must start with the most fundamental laws of physics. For fluid flow 
there are three core equations - conservation of mass, Newton's second law of motion, and conservation 
of energy. We will consider the below control volume in a pipe. The control surfaces 1 and 2 are per-
mitted to move relative to one another, and the unlabeled control surface on the pipe wall must remain 
fixed to the wall. For the purposes of analyzing a fluid transient, it is safe to consider the system one-
dimensional in the x direction. Note that there is one radial effect that is important to consider - the 
change in cross-sectional area of the pipe.             

The resulting equations are nonlinear hyperbolic partial differential equations, requiring a numeric solu-
tion such as the Method of Characteristics.             

For a complete development of the equations please see one of the many excellent references (Moody 
1990, Wylie 1993, Chaudry 1987, and Swaffield 1993).             

Figure 1: Control volume



Transient Theory

- 468 -

Continuity Equation

First we apply conservation of mass to the control volume via Reynold's Transport Theorem:

Simplifying to one dimension:

According to the Leibniz integral rule:

Applying this relationship and canceling terms:

Considering a mean value of the integral:

Divide by δx

Expand and group terms to find the continuity equation:
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Momentum Equation

The application of Newton's second law follows from the same control volume above. Again applying 
Reynold's Transport Theorem we begin with the following relationship:

Very similar to the continuity equation, we can apply a one dimensional simplification, the Leibniz integral 
rule, and consider the resulting integral as a mean over the interval. These steps are extremely similar to 
the above and are not shown for brevity.

Summing the forces on the body:

To find the shear term, we consider a steady force balance with only two terms - the pressure across a 
section, and the shear term. We can find the pressure across the section with the Darcy-Weisbach rela-
tionship. Note that this step assumes that the transient shear term can be calculated with an equivalent 
steady state velocity.             
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Incorporating this, dividing through by δx, and assuming that the areas on the pressure terms can be con-
sidered constant, we arrive at the following combined equation:             

Expanding the partial derivatives, and dividing through by ρA, we find the continuity equation and can 
drop those terms.             

Gathering the remaining terms, we arrive at the momentum equation:

Energy Equation

First apply Reynolds Transport Theorem to Newton's first law:

From the First Law of Thermodynamics:

Assuming that the shaft work and viscous work are zero, only the pressure work will contribute as fol-
lows:
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Combining the three equations above, the surface integrals can be simplified as follows

Simplifying the surface integrals into one dimension, the equation becomes

Dividing through by ∂x, expanding the derivatives and grouping the derivatives results in the following.    

To further simplify the above, the continuity equation indicated above can be eliminated. To eliminate the 
internal energy term use the definition of internal energy and take the partial derivative as follows.

Assuming that gravity and elevation are constant with time, the partial derivative of gz can be dropped. 
The internal energy derivative can then be substituted into the overall equation.

After expanding the partial derivatives and grouping the common terms results in the following energy 
equation.
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Modified Conservation Equations

The continuity, momentum and energy equations derived above contain a large number of variables 
which make them unwieldy.

The stagnation and static enthalpy terms in the energy equation can be eliminated using the definition of 
stagnation enthalpy, the first law of thermodynamics, and various thermodynamic relations and iden-
tities. The rearranged energy equation is as follows.

In this form, part of the momentum equation can be inserted into the energy equation. Rearrange the 
momentum equation as follows. Note that the sin(α) term in the momentum equation shown previously is 
equivalent to dz/dx.    

The rearranged momentum equation can now be inserted into the energy equation to get the Modified 
Energy Equation:

The continuity equation can be rearranged to insert into the Modified Energy Equation as follows



Transient Theory

- 473 -

After inserting the above continuity equation into the Modified Energy equation, multiply through by a2 to 
find the Modified Continuity Equation as follows

The Modified Continuity and Energy equations can be further simplified by defining the variable F. The 
final modified equations for F, continuity, energy, and momentum can be seen below in order:

Related Topics

Transient Result Accuracy 58
Nomenclature 448
Method of Characteristics 473

Method of Characteristics
The Method of Characteristics is a general approach for solving a partial differential equation by reducing 
it to a system of ordinary differential equations.             
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We see here how it is applied to the transient flow equations. The three partial differential equations have 
three unknowns P,V, and ρ, and two independent variables x and t. Application of the Method of Char-
acteristics will generate six ordinary differential equations.    

Characteristic Equations             

First linearly combine the equations with the introduction of constant factors represented by λ:    

Note that for the above equation, the area was assumed to be constant, so all partial derivatives with 
respect to A were dropped to simplify the equation.    

Rearranging terms from the linear combination above             

We define relationships for λ1, λ2, and λ3:    

By asserting that λ3 = 1, it is found that
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and

Substituting into the above equation:             

We have three solutions for λ, each valid along a certain characteristic line, as will be described further 
below. The solutions are as follows

This represents the six characteristic equations that we are searching for, paired as the right running (R), 
left running (L), and particle path (P) sets of equations:             

where
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The relationship between the time step, length step, sonic velocity and velocity from the characteristic 
equations shown here is crucial for effectively sectioning the pipes, which is discussed further in Pipe 
Sectioning - Introduction to Method of Characteristics.    

Note: This set of ordinary differential equations represent an exact solution to the governing equa-
tions, given the minor assumptions that flow is one dimensional, gravity does not change in time 
and space, and the pipe is rigid and constant area.             

Numerical Method             

We can simplify the equations further into a form that is convenient for simulation.             

For each of the equations multiply by dt as is shown below for the right running characteristic

This equation can be integrated along the right running characteristic.             

It is useful at this stage to consider a graphical representation of the characteristic grid.    

On the characteristic grid point 4 will be affected by the right running characteristic from point R, the left 
running characteristic from point L, and the particle path characteristic from point P.     
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Figure 1: Characteristic grid. The point 4 sees effects from points R, L, and P after some time dt, which has 
equal magnitude of dx/a                 

Setting up the integral along the right running characteristic line:             

This integrand represents the exact solution. However, in order to evaluate the integral, several major 
assumptions will be made:    

 1. The values are only known at the grid points (points 1, 2, and 3 in Figure 1). Therefore, inter-
polation is required to find the values at points R, L, and P. In literature this is often cited as the 
largest source of error. Linear interpolation is used to determine the position, z, and the properties 
at each of the starting points R, L, and P. Though compressible flow properties do not vary linearly 
along a pipe, it has been found that more sophisticated interpolation is less stable and requires a 
much larger calculation time, which is why linear interpolation is used for xStream.     

 2. The variables in each integrand cannot all be related, so an analytical solution cannot be found for 
each of the integrals. Instead, the integrands are assumed to be constant, using the values from 
the starting point. In some cases this may be a good approximation, as the properties are rel-
atively constant. However, in other cases, such as at high Mach numbers, the properties would 
change rapidly in reality. Adding additional sections helps reduce error caused by this assump-
tion.                 

 3. Related to the constant integrand and interpolation assumptions, the characteristic lines are 
assumed to be straight. In reality the slope would constantly change as both the velocity and sonic 
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velocity are changing over time. Assuming the characteristic lines are straight allows the starting 
points R, L, and P to be interpolated as discussed above.                 

 

Using the 3 assumptions above, the integral is trivial, and the below solution can be found for the right 
running characteristic:    

where

We can repeat the above process for the left running characteristic and particle path characteristic to 
arrive at:             

where



Transient Theory

- 479 -

We have finally arrived a system of three equations with only three unknowns - pressure, density and 
velocity at point 4. These equations can be further arranged into a convenient form known as the com-
patibility equations.             

Related Topics

Transient Result Accuracy 58
Nomenclature 448
Cv/Kv and XT Loss Model 220

Compatibility Equations
From the characteristic equations (repeated below), we can construct three convenient equations known 
as the compatibility equations.

(Positive Wave 
Characteristic)

(Negative Wave 
Characteristic)

(Particle Path 
Characteristic)
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The only unknown terms in these equations are the pressure, velocity and density at point 4. The other 
terms are found from a previous time step, or from the initial conditions as determined from the steady 
state MOC simulation.

Rearranging terms:

and defining six new constants (constant for this time step):

We have our simplest equations yet:
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Which can be solved directly for pressure and velocity, then used to directly calculate density.

Note:The compatibility equations allow a solution of all interior points in a pipe. However, the pipe end-
points are solved by applying specific boundary conditions. The boundary condition rela-
tionships build on the previous methods, and offer the final needed information to generate a 
complete solution.

Related Topics

Method of Characteristics 473

Transient Sonic Choking
During the transient solution sonic choking may begin at any of the geometries described in the Sonic 
Choking Detailed Description topic, including all junctions except for the  dead end junctions. In addition 
to the geometries previously discussed, sonic choking may occur at a junction at the inlet of a pipe in 
response to rapid system changes. Choking at the inlet of a pipe is not sustainable, and may result in 
shock waves moving through the system, as is discussed further below.    

AFT xStream evaluates every boundary calculation (i.e. junction inlet/outlets) at every time step to 
determine if sonic choking would occur. If sonic choking is detected at a junction, xStream will adjust the 
solution method at that junction accordingly.    

Under sonic conditions, the defined boundary condition at the choke point is no longer meaningful, as it 
cannot be reached. However, because the flow is sonic the velocity must be equal to the sonic velocity, 
a. Sonic velocity depends on the local state, which is unknown. Therefore, iteration is required to determ-
ine the velocity.    

Iterations will be performed on the velocity using the appropriate wave compatibility equation to calculate 
pressure. To calculate the density for an inflow the pressure and the specified temperature/enthalpy will 
be used. For an outflow boundary the density is calculated using the particle path compatibility equation.    
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Shock Waves    

A shock wave is a compression wave across which velocity transitions from supersonic to subsonic, and 
also causes discontinuities in other properties such as pressure, temperature, and density. (Saad, 1993) 
It is simplest to discuss shock waves by discussing how compression waves are formed. Compression 
waves may or may not become shock waves, depending on the conditions.    

A compression wave is generated in a pipe or duct due to a series of incremental, instantaneous velocity 
changes in the flow. Each velocity change generates a sound wave that begins traveling through the gas. 
As the gas compresses each subsequent wave will have a higher sonic velocity caused by the increasing 
temperature. Eventually the faster waves will catch up to the initial wave, causing the compression wave 
to steepen and the pressure drop across the wave to increase. If an abrupt enough velocity change 
occurs, then the compression wave will become a shock wave.    

AFT xStream does not employ any  shock wave solution methods in the solver. However, the method of 
characteristics, which is frequently used to model wave movement, can approximate the movement of 
shock waves through gas systems.    

Related Topics

K Factor Loss Model 217
Method of Characteristics 473
Sonic Choking Detailed Description 488
Sonic Choking 487

Related Blogs

Making Sense of xT – Valve Loss in Compressible Flow

Compressible Flow Theory in Single Pipes
In order to provide a robust method to solve compressible flow in pipe networks, numerous fundamental 
equations must be solved simultaneously. The AFT Arrow steady state solver which AFT xStream uses, 
solves the continuity (i.e., mass balance) equation, the one-dimensional momentum equation, the 
energy equation, the equation of state, and the Mach number equation which ties together temperature 
and velocity.

If you are unfamiliar with the field of compressible flow, it is suggested that you first read the com-
pressible flow review topic and/or consult a textbook for a thorough description of the subject.

Extension of Single-Pipe Methods to Networks
Methods to solve the single pipe equations are available in the literature (Anderson, 1982, Saad, 1993, 
and Shapiro, 1953), but their extension to pipe networks involves significant difficulties. In a network sys-
tem, the flow and energy must balance at each branch point. Traditional solution methods in incom-
pressible flow systems break down because the relationships between pressure and flow cannot be 

https://www.aft.com/support/product-tips/making-sense-of-xt-valve-loss-in-compressible-flow
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expressed in a single convenient equation. Thus the calculation speed and reliable convergence benefits 
of incompressible flow matrix methods are much more difficult to obtain in compressible flow cal-
culations. Heat transfer and the resulting temperature effects further complicate the analysis.    

To address these issues, AFT xStream's primary steady solver incorporates unique methods of relating 
the various thermodynamic and fluid dynamic parameters to each other resulting in a solution meth-
odology that is fast and offers good convergence characteristics. AFT xStream’s primary steady methods 
maintain the integrity of single pipe methods while preserving the required mass and energy balances at 
all branch points.    

The specific techniques used by AFT xStream's primary steady solver to obtain solutions to the equa-
tions of compressible flow are proprietary and probably of little interest to the user. What the user will be 
most interested in is what equations are solved (so that results can be cross-checked) and what bal-
ances are calculated at branch points. Therefore, sufficient information is provided to enable users to 
verify results, while the proprietary aspects of AFT xStream’s solution methods are not described.    

Fundamental Equations
The continuity equation applied to a constant area pipe yields:

(1)

The one-dimensional momentum equation applied to a constant area pipe yields:

(2)

Assuming the pipe is straight over the computing section, Figure 1 shows the relationship between dx 
and dz:

(3)
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Figure 1: Relationship between distance along pipe (dx) and vertical elevation change (dz).

The fourth term on the left of Equation 2 accounts for pressure changes due to body forces. AFT xStream 
models body forces due to gravity. The default value of g in Equation 2 is the standard earth acceleration 
(i.e., 32.174 ft/sec2 or 9.81 m/sec2). 

From the equation of state for a real gas:

(4)

Related Topics

Nomenclature 448

Continuity Equation at a Branch
By applying the continuity equation at branch i, we loop over all connecting pipes and get

(1)

where  is the flow rate in the pipe connecting junctions i and j.

Related Topics

Nomenclature 448

Energy Equation at a Branch
By applying the energy equation at a branch i, we loop over all connecting pipes and get    
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or, in terms of stagnation enthalpy,

(47)

where  is the stagnation enthalpy at the connection point of pipe and junction.

The elevation term shown in Equation 30 drops out because all pipes at the junction connect at the same 
elevation.

Related Topics

Nomenclature 448

Network Implementation
To provide converged solutions in the shortest time possible, matrix solution techniques are used. Matrix 
techniques allow all pipes to be solved simultaneously, which is faster and offers the best convergence 
characteristics.

To obtain a valid solution in a network, the stagnation pressure at each branch point will be equal and the 
mass flow and energy flow will sum to zero at the branch. Although the stagnation pressures at the pipe 
endpoints will equal that at the connecting junction, this is not true for stagnation enthalpy (and tem-
perature). The stagnation enthalpy at the end of a pipe will be that enthalpy that results from the heat 
transfer in the pipe. Once the fluid flows into the junction, the stagnation enthalpy will change to the mix-
ture stagnation enthalpy, or the average stagnation enthalpy of all inflowing pipes.

If only one pipe flows into the branch, the branch stagnation enthalpy will equal the stagnation enthalpy 
coming out of the pipe. But if more than one pipe flows into the branch, the stagnation enthalpy will reach 
an averaged condition. It is this averaged stagnation enthalpy that results from mixing two or more 
streams at different stagnation enthalpies. This stagnation enthalpy is supplied to all outflowing pipes. 
This is depicted in Figure 1 and follows Equation 49.

(49)
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where the + superscript indicates the summation applies only to positive inflows into the junction.

The concentration balance at a junction is similar to stagnation enthalpy. The junction concentration itself 
will not match the concentrations for the inflowing pipes, but will be a mixture of the incoming flow 
streams.

Figure 1: Flow weighted mixing and energy balance

Related Topics

Nomenclature 448

Verifying Network Solutions
AFT xStream's primary steady solver uses a modified Newton-Raphson matrix method to obtain a sys-
tem level balance of mass and energy. When the Solver is finished, the continuity and energy equations 
are satisfied at all branching sections. Once solved, it is a simple matter to go back and sum up all mass 
flows and energy at each branch to verify that these equations are satisfied. In fact, AFT xStream does 
just that.

After the primary steady solver converges, AFT xStream loops over each junction and adds up the inflow 
and outflow of mass and energy and compares the sum to the solution tolerances. If it appears that any 
junction is out of tolerance, a warning is given in the output.

In the Solution Balance Summary table AFT xStream provides additional information on the balance at 
each junction. This table can be displayed by selecting the option in the Output Control window General 
Output folder. Figure 1 shows an example of the Solution Balance Summary table.
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Figure 1: Solution Balance Summary table shown in the Output window offers a balance report of all junc-
tions in the window.             

Sonic Choking
Sonic choking occurs in a pipe system when the gas attempts to accelerate to a velocity faster than the 
local sonic velocity at some point in a system. Being unable to accelerate any further, the gas reaches its 
maximum velocity at sonic velocity. Changes to the downstream conditions, such as lowering the pres-
sure, produce no additional flow. In many pipe applications sonic choking dominates the system beha-
vior.

Predicting the flow rates under such sonic choking conditions can be very difficult depending on where 
the choking occurs. AFT xStream is designed to identify sonic choking and predict the system behavior 
under such conditions. In addition, xStream can approximate moving shock waves in the system.

Related Topics

Cv/Kv and XT Loss Model 220
Sonic Choking Detailed Description 488
Transient Sonic Choking 481
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Sonic Choking Detailed Description
Sonic choking occurs when some location in the pipeline experiences a local velocity equal to the sonic 
velocity of the gas. AFT xStream can account for sonic choking, and approximate moving shock waves in 
gas systems.

Sonic Choking Types

Sonic choking can occur in three geometric configurations in a pipe system. Figure 1 depicts the three 
possibilities.

The first case can be called endpoint choking because it occurs at the end of a pipe as it exits into a large 
vessel or the atmosphere. In this situation, the gas cannot drop its pressure to match that at the dis-
charge without accelerating to sonic velocity. A  choke point forms at the end of the pipe, which results in 
a pressure discontinuity across which the discharge pressure condition is met.

The second case can be called expansion choking, and is similar to the first case. Expansion choking 
can happen when the flow area of the pipe is increased rapidly. For example, this occurs when the pipe is 
expanded from a two inch pipe to a three inch pipe. Another example is when a pipe enters a flow splitter 
where the sum of the pipe areas on the splitting side exceeds the pipe area of the supply pipe. A choke 
point forms at the end of the supply pipe, and a pressure discontinuity is established.

The third case can be called restriction choking. This can occur when the gas flows through a restriction 
in the pipe such as an orifice or valve. In such a case the flow area of the gas is reduced, causing a local 
increase in velocity which may reach the sonic velocity. A choke point forms at the restriction, with a pres-
sure discontinuity similar to the first two cases.

Figure 1: Three configurations which can result in sonic choking. From top to bottom, endpoint choking, 
expansion choking, and restriction choking

Figures 2-4 show example stagnation pressure and Mach number profiles for the three cases. The data 
for the cases are: Supply air at 100 psia and 1000° R discharging to 30 psia, with Figure 2) 2 inch pipe 
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with no restrictions or expansions, Figure 3) 2 inch pipe expanding to 3 inches at the midpoint, Figure 4) 
all pipe is 2 inch with orifice at midpoint with 0.6 area ratio. Mach number spikes to 1 at the orifice then 
reduces to 0.29 immediately after. For clarity this spike is not shown.

Figure 2: Example stagnation pressure and Mach number profiles for endpoint choking.

Figure 3: Example stagnation pressure and Mach number profiles for expansion choking.
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Figure 4: Example stagnation pressure and Mach number profiles for restriction choking. Note that the Mach 
Number reaches 1 within the restriction at 0.5.

Steady-State Sonic Choking

During the steady-state the choked flow rate can be determined from Equation 50 by inserting a Mach 
number of 1 in Equation 51. These equations can be derived from the continuity equation (Saad, 1993):    

(50)

where:

(51)

In practice it is difficult to apply Equation 50 to choked conditions because the local stagnation con-
ditions, P0, and T0, are not known at the point of choking. For instance, to apply these equations to end-
point choking (Figure 1, top), one must calculate the stagnation pressure and temperature at the end of 
the pipe before the choke point. The problem is that the stagnation pressure and temperature before the 
choke point depend on the flow rate, which is what we are trying to calculate.

The only way to accurately calculate such a problem is to do the following:

 1. Assume a flow rate
 2. March down the pipe
 3. If the Mach number reaches unity before the end of the pipe, lower the assumed flow rate and 

repeat steps 1-3 until the Mach number reaches sonic right at the pipe endpoint
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Obviously this is not practical without a computer.

The area, A, in Equation 50 can also be CdA, where the Cd is less than one and accounts for area reduc-
tions due to flow separation. This occurs in orifices, valves and other internal restrictions. Note that the 
Cd used here is not equivalent to the discharge coefficient used for subsonic flow calculations. See Sub-
sonic vs. Sonic Pressure Losses for more information.

A helpful output parameter in AFT xStream is the sonic area, which can be compared against actual area 
to determine what CdA would cause choking at a restriction:

(52)

A CdA smaller than the sonic area indicates that the flow would be choked. The sonic area is one of the 
output parameters.

Transient Sonic Choking

During the transient, the above choking mechanisms will still be applicable, though additional scenarios, 
such as choking at the inlet of a pipe, may occur. In addition the calculation method must be adjusted as 
the Method of Characteristics is used for transient pipe calculations, rather than the marching methods 
used for the steady state. See Transient Sonic Choking for further details.

Sonic Choking Effects

The effect of sonic choking in pipe design or operation is that the maximum physically possible pipe flow 
rate has been reached for the supply conditions. Lowering the discharge pressure will not produce more 
flow rate. Figure 5 illustrates this by showing the flow rate as a function of discharge pressure in a two 
inch pipe carrying air. This pipe does not have any restrictions, and experiences endpoint choking at any 
discharge pressure below 63.6 psia.
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Figure 5: Example of dimensionless flow rate vs. dimensionless pressure drop. Sonic choking occurs just 
past the dimensionless pressure drop of ~0.5, after which the flow can no longer increase.

Some engineers misapply the concept of sonic choking and conclude that the sonic flow rate is the max-
imum possible through the pipe for all conditions. This is not the case. If the supply conditions can be 
increased, the flow rate through the pipe can be increased. In fact, the increased choked flow rate 
appears to increase linearly with increased supply pressure. See Figure 6.

Figure 6: Example of increasing choked flow rate with supply pressure.

The pressure drop across the choke point in choked flow cannot be calculated directly. Methods such as 
"normal shock tables" do not apply. The only way to calculate the pressure drop is to use the choked flow 
rate as a new boundary condition on the pipe downstream of the choke point. This boundary condition is 
facilitated by knowing the stagnation enthalpy change across the choke point is constant. For the steady 
state solution governing equations can then be applied to the remaining pipes to solve for the static con-
ditions. During the transient solution the static conditions can be found from the static conditions at the 
downstream station at the previous time step.

Finally, a pipe can choke in more than one location. This occurs when the choked flow rate determined 
by the first choke point is applied to the pipes downstream of the shock wave and the gas at this flow rate 
cannot reach the end of the pipe without experiencing another shock wave. There is no limit to the num-
ber of choke points in a pipe other than the number of possible geometric configurations it contains which 
may cause sonic choking.
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The three mechanisms that cause choking can all occur in the same pipeline in any combination and any 
order.

See Walters, 2000 and Walters and Olsen, 1997 for more information.    

Related Topics

Nomenclature 448
Method of Characteristics 473
Transient Sonic Choking 481
Sonic Choking 487

Subsonic vs. Sonic Pressure Losses
There are two separate pressure loss mechanisms when gas flows through a restriction, expansion, or 
end point.

 l Subsonic losses are standard "form" losses and are dependent on the geometry of the restric-
tion, expansion, or end point. This is the common K factor, or discharge coefficient for subsonic 
flow.

 l Sonic losses result when sonic choking occurs. Sonic losses are dependent on the minimum 
effective flow area (CdA) and are unrelated to the K factor.

The two loss mechanisms cannot occur simultaneously in nature or in AFT xStream. During a time step if 
one mechanism is in use, the input data for the other mechanism is ignored by AFT xStream. The loss 
mechanism in use can switch during the transient as system operation changes.

It is also important to note that sonic choking at a restriction cannot be calculated if the CdA for Sonic 
Choking is not entered. In this case, AFT xStream will always use subsonic loss calculations if no CdA for 
Sonic Choking has been entered, even if the actual system would experience choked flow at that restric-
tion. The only exception to this is if the restriction occurs at a valve which is defined in terms of Cv/Kv and 
XT, which can account for both subsonic and sonic loss at the valve.    

Related Topics

Orifice 274
Relief Valve 277
Discharge Coefficient Loss Model 216
Screen 278
Venturi 286

Stagnation Properties
Solving compressible flow equations requires equations to relate static and stagnation properties. The fol-
lowing equations are used by AFT xStream to relate stagnation temperature, pressure, enthalpy, and 
density (T0, P0, h0, and ρ0, respectively), velocity (or Mach number, M), and static temperature, pres-
sure, enthalpy, and density (T, P, h, and ρ, respectively).    
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Stagnation temperature:             

Stagnation pressure:

Stagnation enthalpy:

Stagnation density:

Related Topics

Stagnation vs. Static Pressure Boundaries 77
Review of Compressible Flow Theory 450
Nomenclature 448

Pipe Material Library References
The pipe material properties in AFT applications were origianlly compiled from a variety of unofficial 
sources. Many of those sources are now obsolete. Beginning in 2016, pipe material properties are taken 
directly from national/international standards such as: ASTM, ANSI, AWWA, and ASME. Several new 
material standards are also added. For example: DIN and JIS. With the addition of a significant number 
of new pipe material standards, the increased volume and scope necessitate splitting the pipe material 
library into several smaller independent libraries. All of the pipe material found in older AFT applications 
are still available, but are now called "AFT Customary".             

Maintaining several independent pipe libraries facilitates including or excluding specific standards. For 
example: a pipe engineer in Germany may prefer to use only ISO and DIN standards. The Library 
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manager can be used to "Connect" or Disconnect" each of the pipe material libraries. A list of available 
pipe libraries can be found below. 

Note that while AFT attempts to provide this standard information to make defining pipe information 
easier for the user, the prudent engineer will always verify this information against manufacturer spe-
cifications. ASTM and ANSI standards exist for the thickness and diameter specifications for some of 
these materials. Furthermore, AFT attempts to source reference information from reputable and author-
itative sources. However, data for pipe roughness and thermophysical properties including density, 
thermal conductivity, modulus of elasticity, and Poisson's ratio have no single standard to follow. Thus, 
the user should always check that the pipe material inputs match the actual pipe material data for their 
system.

 l Copper Pipe - ASTM - 
 l Source = ASTM B42-10
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-33
 l Copper Tubing - ASTM - 

 l Source = ASTM B88-09
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-31; www.cranecop-
per.com.au/sizes/astmb88.asp

 l Ductile Iron - ANSI - 
 l Source = ANSI-AWWA C150-A21.50-08
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2
 l Fiberglass - Green Thread -

 l Source = Fiber Glass Systems product data, http://www.nov.com/Segments/Completion_
and_Production_Solutions/Fiber_Glass_Systems/Chemical_Industrial/Green_
Thread.aspx 

 l Roughness References = Fiber Glass Systems product data
 l Density References = Average value calculated based on ID, OD and Weight in Fiber 

Glass Systems product data
 l Thermal Conductivity References = Fiber Glass Systems product data
 l Modulus of Elasticity References = Fiber Glass Systems product data
 l Poisson's Ratio References = Fiber Glass Systems product data
 l Additional References = ASTM D2996 - 17

 l HDPE - AFT Customary - 
 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2
 l PVC - ASTM - 
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 l Source = ASTM D1785-06
 l Additional References = Thermal data from: Materials Science and Engineering, Callister, 

Table C.4
 l PVDF - AFT Customary - 

 l Source = George Fischer Engineering handbook page 425
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2
 l Rectangular Duct - AFT Customary - 

 l Source = Applied Flow Technology
 l Stainless Steel - ANSI - 

 l Source = ASME-B36_19M_2004
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conduct References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for Type 304
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ration Referenecs = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for Type 304 @ 20oC
 l Stainless Tubing - AFT Customary - 

 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed, 

Table A3.2
 l Steel - AFT Customary - 

 l Source = Applied Flow Technology
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

 l Steel - ANSI - 
 l Source = ASME B36.10-2004
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2391-1 - 
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 l Source = DIN 2391-1-1994
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2458 -
 l Source = DIN 2458-1981
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10216-1 (s1) - 
 l Source = BS EN 10216-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10216-2 (s1) - 
 l Source = BS EN 10216-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
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 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-
45 Table 28-18 for SA-35P12 @ 20oC

 l Additional References = ANSI 36.10, CRANE Technical Paper 410
 l Steel - EN 10217-1 (s1) - 

 l Source = BS EN 10217-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-2 (s1) - 
 l Source = BS EN 10217-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-4 (s1) - 
 l Source = BS EN 10217-4-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-5 (s1) - 
 l Source = BS EN 10217-5-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
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 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-6 (s1) - 
 l Source = BS EN 10217-6-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical 

Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.28-

45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410
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Chempak Technical Information - Detailed Discussion
© Copyright 1998 Madison Technical Software Inc. Used with permission.

Note: The information in this Appendix was taken from Section 8 of the Chempak Operating & Refer-
ence Manual, Version 4, Windows Edition, Issue: January 1998. Section numbering was left 
unchanged, and some sections that were judged not relevant were not included so the num-
bering is not sequential.

Note: Notation and references in this Appendix apply only to this Appendix, and are referenced at the 
end.

8.1 General 

This section sets out the data sources, correlations and estimation methods used in the CHEMPAK data-
base. In putting together the database, the methods and sources were selected in the following order of 
preference. 

·        Published experimental data 

·        Published correlations based on experimental data 

·        Specific category correlations 

·        General estimation methods 

Madison Technical Software has followed the general recommendations in Reid and in Danner and 
Daubert as far as selection of specific category correlations and general estimation methods are con-
cerned. In selecting specific compound data, a combination of sources has been used wherever pos-
sible. Important sources of specific compound data used by CHEMPAK are: 

·        Reid et al 

·        Perry et al 

·        J Chem Eng Data 

·        Daubert & Danner 
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·        ESDU publications 

·        API Technical Data Book - Petroleum Refining 

·        International Critical Tables 

·        CRC Handbook 

·        Vargaftik 

In many cases, the compound property values are a combination of published data, published cor-
relations and general estimation methods. Several properties in certain compound categories have been 
estimated or adjusted by Madison Technical Software. It has been our policy to adopt and maintain a crit-
ical approach to available data sources and correlation methods.

The following sections set out details of the correlations and estimation methods used. In certain cases, 
the user is directed to the original references, particularly where the method is complex.

Data sources for Aqueous Solutions/Heat Transfer Liquids are published experimental data and cor-
relations based on experimental data.

8.2 Physical Constants 

8.2.1 Critical Temperature 

The great majority of values are believed to be experimental. Where values had to be estimated, the 
Joback method was used. 

8.2.2 Critical Pressure 

Most of the values are experimental. In cases where experimental data were not available, the critical 
pressure was derived from the Joback method.

8.2.3 Critical Volume 

A majority of the values are experimental. A great majority of the remaining compounds for which exper-
imental values were not available had accurate boiling-point volumes available from which critical 
volume estimates were derived using the Tyn and Calus correlation. For a few substances, estimates of 
the critical volume were derived from the Joback method. 

8.2.4 Normal Boiling Points 

All values are believed to be experimental. In some cases, the values were slightly adjusted for vapor 
pressure.

8.2.6 Acentric Factors

The acentric factor is defined as 

 w = -log10(Pvr at Tr = 0.7) - 1 

In all cases the acentric factor was derived from the vapor pressure correlation ( see section 8.8) 

8.2.7 Joback Group Contribution Method 

The Joback method is used to derive values of Tc, Pc, Vc and Tf where no experimental data or other pre-
dictive method was available. 

Tc = Tb/(0.584 + 0.965 Sum(Dt) - Sum(Dt)2)

Pc = 1/(0.113 + 0.0032 na - Sum(Dp))2

Vc = 17.5 + Sum(Dv)
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Tf = 122 + Sum(Df)

where na is the number of atoms in the molecule and the D contributions are given by Joback and by 
Reid et al (1987). Error magnitudes for the Joback method are as follows: 

·        Critical Temperature: average error about 1%

·        Critical Pressure: average error about 5%

·        Critical Volume: average error about 2%

·        Freezing Point: average error about 11% 

8.2.8 Tyn & Calus Relation 

Tyn & Calus showed a close (< 3% error) relation between molar volume at normal boiling point and the 
critical molar volume of the form, 

Vb = a Vcn 

a = 0.285 

n = 1.048 

8.8 Vapor Pressure 

The vapor pressure is expressed in its reduced form 

Pvr = Pv/Pc

Reduced vapor pressure varies from very low values at freezing point to unity at the critical point. 

8.8.1 Published Correlations 

The experimental correlations are commonly given in the following formats: 

Wagner Equation 

ln(Pvr) = (aX + bX1.5 + cX3 + dX6)/Tr

with 

X = 1 - Tr

FKT Equation 

ln(Pv) = a + b/T + cln(T) + dPv /T2 

Antoine Equation 

ln(Pv) = a + b/(T + c) 

8.8.2 Gomez-Thodos Vapor Pressure Equation 

Gomez-Nieto and Thodos give the following equation: 

ln(Pvr) = B(1/Trm - 1) + G(Tr7 - 1) 

G = aH + bB 

a = (1 - 1/Tbr)/(Tbr7 - 1) 

b = (1 - 1/Tbrm)/(Tbr7 - 1) 

H = Tbrln(Pc/Pb)/(1 - Tbr) 

For non-polar compounds, 

B = -4.267 - 221.79/(H2.5exp(0.038 H2.5)) + 3.8126/exp(2272.33/H3) + D 
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m = 0.78425 exp(0.089315 H) - 8.5217/exp(0.74826 H) 

D = 0

except D = 0.41815 for He, 0.19904 for H2, 0.02319 for Ne 

For polar non-hydrogen-bonding compounds (e.g. ammonia and acetic acid), 

m = 0.466 Tc0.1667 

G = 0.08594 exp(0.0007462 Tc) 

B = (G - aH)/b

8.8.2 Gomez-Thodos Vapor Pressure Equations 

For polar hydrogen-bonding compounds (water, alcohols), 

m = 0.0052 M0.29Tc0.72 

G = (2.464.M) exp(0.0000098 MTc) 

B = (G - aH)/b 

The advantages of this method are, 

·        fit guaranteed at T = Tb and T = Tc 

·        good performance with polar compounds 

·        good performance over Tr = 0.5 to 1 

In addition, tests carried out by Madison Technical Software show the clear superiority of this method 
especially at low temperatures over the Lee-Kesler method. 

8.8.3 Lee-Kesler Vapor Pressure Equation 

Lee and Kesler give the following vapor pressure equation: 

ln(Pvr) = f(0) + wf(1) 

w = acentric factor 

f(0) = 5.92714 - 6.09648/Tr - 1.28862 ln(Tr) + 0.169347 Tr6 

f(1) = 15.2518 - 15.6875/Tr - 13.4721 ln(Tr) +0.43577 Tr6 

The characteristics of this equation are, 

·        guaranteed fit at Tr = 1 and 0.7 

·        accurate for non-polar compounds 

This equation is used in the Lee-Kesler and Wu & Stiel equations of state. 

8.8.4 Interpolation and Extrapolation 

In many cases an accurate empirical equation is known which does not extend to the critical point or to 
the freezing point. The approach taken here is to fit the Wagner equation by least squares to the empir-
ical equation and use the Wagner equation to extrapolate to the freezing point and to the critical point. 

Extrapolation by this method to the critical method is a very accurate procedure. Extrapolation to the 
freezing point is less accurate but it does provide reasonable values. 

In CHEMPAK, the vapor pressure correlations set out in this section are used to provide the basic data. 
Empirical relations are used wherever possible. 
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8.9 Vapor Viscosity 

The methods of Lucas are employed here. The equations take two forms: 

·        Low Pressure (< 2 atm) 

·        High Pressure (> 2 atm) 

8.9.1 Low-Pressure Equation 

v0 = a0k0{a1 + a2Trn + a3exp(a4Tr)+ +a5exp(a6Tr)}Fp0,Fq0 

v0 = low pressure viscosity in kg/ms 

k0 = M0.5Pc0.667Tc0.1667 

with Pc in Pa and Tc in K 

a0 = 0.0026373 

a1 = 0.018 

a2 = 0.807 

a3 = -0.357 

a4 = -0.449 

a5 = 0.340 

a6 = -4.058 

n = 0.618  

The low pressure polar correlation is given by, 

Fp0 = 1 0 < mr < 0.022 

Fp0 = 1 + f(Zc) 0.022 < mr < 0.075 

Fp0 = 1 + f(Zc).g(Tr) 0.075 < mr 

f(Zc) = 30.55(0.292 - Zc)1.72 

g(Tr) = 0.96 + 0.1(Tr - 0.70) 

mr = 52.46 m2Pc/Tc2 

m = dipole moment, debye 

Pc = critical pressure, bar 

Tc = critical temperature, K 

8.9.1 Low-Pressure Equation 

In the above equations, if Zc > 0.292 the Fp0 is taken as unity.There are only a few compounds that are 
polar with Zc sufficiently larger than 0.292 to make Fp0 significantly different from unity. The evidence in 
any case is scanty. 

The low-pressure correction for quantum gases (hydrogen, helium and deuterium), Fq0, is given by, 

Fq0 = 1.22 Q0.15{1 - 0.00385(12 - Tr)2/M} 

with 

Tr < 12 
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 Q = 1.38 for helium 

 0.76 for hydrogen 

 0.52 for deuterium 

8.9.2 High-Pressure Equation 

Define, 

Z1 = v0/a0k0 

For Tr <=1, we define, 

Z2 = 0.60 + 0.76 Prm + (1 - Tr)(6.99Prn - 0.60) 

m = 3.262 + 14.98 Pr5.508 

n = 1.39 + 5.746 Pr

For Tr > 1 define, 

Z2 = Z1{1 + aPre/(bPrf + 1/(1 + cPrd))} 

with, 

a = (a1/Tr)exp(a2Trn) 

b = a(b1Tr - b2) 

c = (c1/Tr)exp(c2Trm) 

d = (d1/Tr)exp(d2Trp) 

e = 1.3088 

f = f1exp(f2Trq) 

 

a1 = 0.001245 

a2 = 5.1726 

n = -0.3286 

b1 = 1.6553 

b2 = 1.2723 

c1 = 0.4489 

c2 = 3.0578 

m = -37.7332 

d1 = 1.7368 

d2 = 2.2310 

p = -7.6351 

f1 = 0.9425 

f2 = -0.1853 

q = 0.4489 
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then, 

Y = Z2/Z1 

Fp = (1 + (Fp0 - 1)/Y3)/Fp0 

Fq = (1 + (Fq0 - 1)(1/Y - 0.007(ln(Y))4))/Fq0 

v = v0YFpFq

8.10 Vapor Conductivity 

The method of Ely and Hanley is adopted for both high and low pressure vapor conductivity. The method 
is based on hydrocarbon data but gives reasonable values for non-polar non-hydrocarbons. Errors are 
usually less than 10% except for highly polar compounds. There are few experimental data and no sat-
isfactory correlations for high pressure conductivity for polar compounds. 

The vapor conductivity is given by, 

k = k1 + k2 + k3 

with, 

k1 = 1944 v0H(1 + 0.042332(Cvo - 3R/2)) 

k2 = r0H(b1 + b2(b3 - ln(T0/b4))2)

k3 = k30k31(k32 + k33k34) - 1 

k30 = H/1000 

k31 = exp(a1 + a2/T0) 

k32 = exp(a3 + a4/T01.5)r00.1 

k33 = 6.1843(r0 - 1)r00.5

k34 = a5 + a6/T0 + a7/T02

The parameters in the above equations are given by: 

v0 = low pressure methane viscosity = Sum(cnT0(n-4)/3) 

c1 = 2.90774E-01 

c2 = -3.31287E-01 

c3 = 1.60810E-01 

c4 = -4.33190E-02 

c5 = 7.06248E-03 

c6 = -7.11662E-04 

c7 = 4.32517E-05 

c8 = -1.44591E-06 

c9 = 2.03712E-08 

 

H = 16.04 f0.5/M h0.667 
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Cv0 = low pressure specific heat at constant volume in J/mol.K 

R = gas constant = 8.314 J/mol.K 

M = molecular weight g/mol 

f = TcF1/190.4 

h = VcF2/99.2 

Tc = critical temperature, K 

Vc = critical volume, cc/mol 

F1 = 1 + (w - 0.011)(0.56553 - 0.86276 ln(T*) - 0.69852/T*) 

 

F2 = {1 + (w - 0.011)(0.3949(V* - 1.02355) - 0.93281(V* - 0.75464)ln(T*)}(0.288/Zc) 

 

w = acentric factor 

Zc = critical compressibility 

 

T* = Tr for Tr <= 2 

= 2 otherwise 

 

V* = V/Vc for 0.5 < V/Vc < 2 

= 0.50 for V/Vc <= 0.50 

= 2 otherwise 

 

b1 = -2.5276E-04

b2 = 3.3433E-04 

b3 = 1.1200E+00

b4 = 1.6800E+02 

a1 = -7.1977E+00

a2 = 8.5678E+01 

a3 = 1.2472E+01

a4 = -9.8463E+02 

a5 = 3.5947E-01

a6 = 6.9798E+01 

a7 = -8.7288E+02 

 

r0 = 16.04 h/V 

T0 = T/f 

V = specific volume, cc/mol 
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T = temperature, K 

8.11 Ideal Gas Thermodynamic Properties

Ideal gas thermodynamic properties (i.e. at low pressure) are required for the estimation of the ther-
modynamic properties of liquids and gases. 

8.11.1 Method of Joback 

For those substances not covered by published correlations, the group contribution method of Joback is 
used to estimate Cp0 and the heats of formation. 

Cp0 = a + bT + cT2 + dT3 

with, 

a = Sum(njDa) - 37.93 

b = Sum(njDb) + 0.210 

c = Sum(njDc) - 3.91E-04 

d = Sum(njDd) + 2.06E-07 

where nj is the number of groups of type j and the D contributions are for this type of group. T is in deg K. 
The user is referred to Joback for details. Reid et al (1987) gives values of the group contributions. The 
error associated with this method is usually less than 3%. 

8.11.2 Low-temperature values of Cp0

To our knowledge, no general estimation method exists for Cp0 below about 260 K. In addition, empirical 
datapoints and correlations in this region are not generally available. In order to extend the applicability 
of the estimation methods to temperatures below 260 K, extrapolation of known values and correlations 
was investigated by Madison Technical Software. 

Extrapolation as far as 50 K (-223 C) using monotonic power functions fitted to known values at higher 
temperatures gave estimates whose error did not exceed 10% at 50 K and which averaged about 2% in 
the range 100 K to 273 K. This extrapolation was tested against known values for over 80 hydrocarbons 
and non-hydrocarbons. Thermodynamic properties calculated are limited in CHEMPAK to temperatures 
above minus 100 C. 

8.11.3 Derived Ideal Gas Properties 

Ideal gas enthalpy and entropy are derived by integration of the ideal gas specific heat: 

The ideal gas enthalpy, h0, is given by the integral of Cp0 from T0 to T 

h0(T) = [C0T + C1T2/2 + C2T3/3 + C3T4/4] 

evaluated between T0 and T. 

The ideal gas entropy is given by the integral of Cp0/T from T0 to T

 s0(T) = [C0lnT + C1T + C2T2/2 + C3T3/3] 

evaluated between T0 and T. T0 is a zero-value reference temperature. The specific heat at constant 
volume is simply related to the specific heat at constant pressure: 

Cv0 = Cp0 - R 

8.12 The Equations Of State 



Transient Theory

- 510 -

8.12.1 General 

The two equations of state employed in CHEMPAK are as follows: 

1.        The Lee-Kesler equation of state for non-polar compounds with moderate values of acentric factor 

2.        The Wu & Stiel equation of state for polar compounds or those with extreme values of acentric factor

The equations of state are used to predict the following vapor properties: 

·        Specific Volume 

·        Compressibility 

·        Expansion Coefficient 

·        Specific Heats 

·        Enthalpy/Internal Energy 

·        Entropy 

·        Heat of Vaporization 

8.12.2 The Lee-Kesler Equation of State 

The Lee-Kesler equation of state is a three-parameter (Tc, Pc and w) equation explicit in pressure with 
general applicability to compounds with low polarity and moderate acentric factors. The Lee-Kesler equa-
tion defines two fluids as follows, 

·        a simple fluid with zero acentric factor 

·        a reference fluid with acentric factor = 0.3978 

The specific volume and other properties for any fluid are determined by interpolation between the simple 
fluid properties and the reference fluid properties using acentric factor as the interpolating variable. The 
properties of the simple and reference fluids are determined by a pair of PVT equations with identical 
form but with different parameters. 

We define, 

Pr = P/Pc 

Tr = T/Tc 

Vr = PcV/RTc

where P, Pc, T and Tc are the actual and critical pressures and the actual and critical temperatures of the 
fluid of interest. 

First, Vr(0) is calculated using the constants for the simple fluid. Then Vr(r) is calculated using the con-
stants for the reference fluid. From these quantities, Z(0) and Z(r) are calculated: 

Z(0) = PrVr(0)/Tr Z(r) = PrVr(r)/Tr 

The compressibility of the fluid of interest is calculated using, 

Z = A(0)Z(0) + A(r)Z(r) 

A(0) = 1-w/w(r) 

A(r) = w/w(r) 

w = acentric factor for fluid of interest 

w(r) = acentric factor for reference fluid (0.3978) 
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The expansion coefficient, specific heat departures, enthalpy and, entropy departures are derived from 
the simple and reference PVT equations using the relations detailed in Lee and Kesler and in Reid and 
elsewhere. The component simple fluid and reference fluid values are combined by using relations of the 
same form shown above for compressibility. Danner & Daubert give typical maximum error values 20 
kJ/kg for vapor enthalpy and 70 kJ/kg for liquid enthalpy. Typical errors for specific volume of vapors are 
1 to 2%. 

8.12.3 The Wu & Stiel Equation of State 

The Wu & Stiel equation of state is a four-parameter equation of state developed as an extension to the 
Lee-Kesler equation of state to cover polar compounds and compounds with high values of acentric 
factor. The parameters of this equation of state are,

·        Critical Temperature, Tc

·        Critical Pressure, Pc

·        Acentric Factor, w 

·        Polarity Factor, Y 

The Wu and Stiel equation of state uses three reference fluids as follows: 

·        simple fluid with zero acentric factor 

·        reference fluid with acentric factor = 0.3978 

·        polar fluid (water) with acentric factor = 0.344 and polarity factor = 1.0 

The specific volume and other properties for any fluid of interest are determined by interpolation between 
the properties of the reference fluids using acentric factor and polarity factor as interpolating variables. 

The properties of the simple and reference fluids are determined from the Lee-Kesler equation of state. 
The properties of the polar fluid are determined from the Keenan equation of state for water. With Pr and 
Tr for the fluid of interest, 

Z(0) = PrVr(0)/Tr from simple fluid equation 

Z(r) = PrVr(r)/Tr from reference fluid equation 

Z(p) = PrVr(p)/Tr from polar fluid equation 

Z = A(0)Z(0) + A(r)Z(r) + A(p)Z(p) 

 

A(0) = (1 - Y) - (w/w(r) - Yw(p)/w(r)) 

A(r) = w/w(r) - Yw(p)/w(r) 

A(p) = Y 

A(0) + A(r) + A(p) = 1 

When Y = 0 these equations reduce to the non-polar Lee-Kesler formula. When Y = 1 and w = w(p), they 
reduce to the Keenan equation of state for water. 

The expansion coefficient, specific heat departures, enthalpy, internal energy and entropy departures 
are derived from the simple, reference and polar PVT equations. The component simple fluid, reference 
fluid and polar fluid values are combined using relations of the same form as shown above in the case of 
compressibility. The polarity factor is determined from empirical density data in accordance with the rela-
tions set out by Wu and Stiel. Wu & Stiel report excellent results using this equation of state for polar com-
pounds. Errors in specific volume were less than 1 to 2% for example for the vapor phase.
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8.12.4 Calculation of Saturation Values 

Fluid properties along the saturation line are solved for as follows. For a given value of Tr, 

1.        The simple fluid component properties are solved at Tr , Psr(O) where this latter quantity is the Lee-
Kesler reduced saturation pressure at Tr and w = 0 

2.        The reference fluid component properties are solved at Tr and Psr(r) where this latter quantity is the 
Lee-Kesler reduced saturation pressure at Tr and w = 0.3978 

3.        The polar fluid component properties are solved at Tr and Psr(p) which is the reduced water saturation 
pressure at Tr with Psr(p) = Ps(p)/ Pc(p) 

The compressibility of the fluid of interest is found by, 

Zs = A(0)Zs(0) + A(r)Zs(r) + A(p)Zs(p)

This relation gives the saturation state of the fluid of interest by interpolation between the saturation 
states of the simple, reference and polar fluids at Tr rather than by interpolation between the three fluids 
at Tr and Psr where this latter quantity is the reduced vapor pressure of the fluid of interest. 

The above relations are presented for the case of the Wu & Stiel equation of state. The relations for the 
Lee-Kesler equation of state may be obtained by setting the polar contribution equal to zero.

8.12.5 Enthalpy and Entropy Scales 

All enthalpy and entropy values are quoted relative to a reference zero-value temperature T0. This tem-
perature is taken in all cases to be the higher of 273.15 K and the normal melting point. 

Two cases can be distinguished: 

1.        If the critical temperature is greater than or equal to 273.15 K then the enthalpy and entropy of the sat-
urated liquid are taken to be zero at T0. In this case the enthalpy and entropy functions are, 

h(T,P) - hLs(T0) = [h(T,P) - hv(T,P0)]es + [h0(T0,T)]ig - [hLs(T0) - hv(T0,P0)]es 

s(T,P) - sLs(T0) = [s(T,P) - sv(T,P0)]es + [s0(T0,T)]ig - [sLs(T0) - sv(T0,P0)]es

2.        If the critical temperature is less than 273.15 then the enthalpy and entropy of the low-pressure vapor 
are taken to be zero at T0. In this case the enthalpy and entropy functions are, 

h(T,P) - hv(T0,P0) = [h(T,P) - hv(T,P0)]es + [h0(T0,T)]ig

s(T,P) - sv(T0,P0) = [s(T,P) - sv(T,P0)]es + [s0(T0,T)]ig

The zero point for water is taken to be 273.16 K in accordance with the Keenan equation of state for 
water. Liquid enthalpy and entropy are zero at that temperature and saturation conditions. 

8.13 Properties Of Mixtures 

8.13.1 Scope of Correlations 

CHEMPAK provides the user with the facility of defining mixtures of compounds in the database which 
then may be stored in the database for future use. The properties of mixtures are calculated using the 
techniques set out in this section. The user should note the following: 

A mixture can be formulated using any components in the database except other mixtures, aqueous solu-
tions, heat transfer liquids and User-Defined Liquids. 
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No check is carried out by CHEMPAK on the chemical stability, compatibility or miscibility of the selected 
components or the defined mixture. The user must be satisfied as to the physical reasonableness of the 
formulation of the mixture. 

The accuracy of the calculated properties can be expected to be better when the selected components 
are chemically similar to each other. The accuracy of the calculated properties of very dissimilar com-
ponents is not known but may only be order-of-magnitude in some cases. It is to be expected that the 
errors involved with mixtures of non-polar compounds will be less than with mixtures of polar com-
pounds. 

The range of applicability of the correlations is as follows: 

A low-limit temperature is defined corresponding to the maximum of the reduced melting points of the 
mixture components. Properties cannot be accessed at temperatures lower than this. A high-limit tem-
perature of 1300 K or the pseudocritical temperature (whichever is the greater) is defined for vapor prop-
erties. Vapor properties cannot be accessed at temperatures greater than this. The high limit 
temperature for liquid mixture properties is the pseudocritical temperature of the mixture as defined by 
the Lee-Kesler rules. Liquid properties cannot be accessed at temperatures higher than this.

8.13.2 Mixture Critical Properties 

Critical Temperature 

Tc = Sum(xiVciTci)/Sum(xiVci) 

where xi, Vci and Tci are the mole fraction, critical volume and critical temperature of component i. The 
reference used here is Li. This method is generally recommended by Reid and by Danner and Daubert. 
Deviations for binary hydrocarbon mixtures can be expected to be less than 4 K. Errors for mul-
ticomponent hydrocarbon mixtures average about 11 K. Errors for binary mixtures of non-hydrocarbons 
would be of this order.

Critical Volume 

Vc = Sum(aiVci) + Sum(aiajbij) (all i,j) 

 

ai = xiVci2/3/Sum(xiVci) 

bii = 0 bij = 2cij(Vci + Vcj) 

cij = Aij + Bijdij + Cijdij+2 +Dijdij3 +Eijdij4 

dij = ABS{(Vci2/3 - Vcj2/3)/(Vci2/3 + Vcj2/3)} 

The binary constants Aij thru Eij are given by, 
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The reference for this method is Schick and Prausnitz. An average error of 10% can be expected for bin-
ary mixtures. 

Critical Pressure 

wm = Sum(xiwi) 

Tcm = Sum(ZiTci) 

Zi = xiVci/Sum(xiVci)

Tcm* = Sum(xiTci) 

Pcm* = Sum(xiPci) 

Pc = Pcm*[1 + (5.808 + 4.93 wm)(Tcm/Tcm* - 1)]

This method is based on a simplification of the method of Kreglenski and Kay as amended by Spencer, 
Daubert and Danner. Errors in the application of this method average about one bar - see Reid et al for 
details. This method is not applied when the mixture contains inorganic components. In this case the crit-
ical pressure is taken equal to the Lee-Kesler pseudocritical pressure. 

Acentric Factor 

In accordance with the Lee-Kesler rules, 

w = Sum(xiwi) 

wi = component acentric factor 

xi = component mole fraction

8.13.8 Vapor Pressure 

Accurate determination of the vapor pressures of mixtures normally requires a full vapor-liquid equi-
librium model with knowledge of interaction parameters. Such a VLE model is not a part of CHEMPAK. In 
CHEMPAK, however, an approximation is used in order to be able to determine the mixture phase for 
given input T and P. The Lee-Kesler mixing rules give for the acentric factor, 

wm = Sum(xiwi) 

wi = -log(Pvri at Tr = 0.7) - 1 

wm = -log(Pvrm at Tr = 0.7) - 1 = Sum(-xilog(Pvri at Tr = 0.7) - xi) 

hence, 

log(Pvrm at Tr = 0.7) = Sum(xilog(Pvri at Tri = 0.7))

The vapor pressure is represented for all compounds in the CHEMPAK database by the Wagner equa-
tion: 

ln(Pri) = (aiXi + biXi1.5 + ciXi3 + diXi6)/Tri 

Xi = 1 - Tri 

Hence, for the mixture, the Wagner coefficients are given by,

am = Sum(xiai) bm = Sum(xibi) 

cm = Sum(xici) dm = Sum(xidi) 

where xi is the component mole fraction.

8.13.9 Thermodynamic Properties of Mixtures 



Transient Theory

- 515 -

The Lee-Kesler and Wu & Stiel equations of state are used to calculate the thermodynamic properties of 
liquid and vapor phases for all pure compounds in the database. To calculate the thermodynamic prop-
erties of mixtures, a set of pseudocritical constants are defined for each mixture and the properties are 
calculated in the usual way. 

CHEMPAK uses the original Lee-Kesler rules as follows: 

Zci = 0.2905 - 0.085 wi 

Vci = ZciR0Tci/Pci 

Vcm = Sum(xixj(Vci1/3 + Vcj1/3)3)/8

Tcm = Sum(xixj(Vci1/3 + Vcj1/3)3(TciTcj)1/2) / (8Vcm) 

wm = Sum(xiwi) 

Mm = Sum(xiMi) 

Zcm = 0.2905 - 0.085 wm 

Pcm = R0ZcmTcm/Vcm 

R0 = Gas Constant

The Stiel polarity factor for a polar mixture is computed from the mixture liquid specific volume

8.13a Thermodynamic And Transport Properties Of Mixtures 

8.13.10 Vapor Viscosity 

The pure component equations are used with the following pseudocritical constants defined for each mix-
ture per the formulation of Prausnitz and Gunn: 

Tcm = Sum(xiTci) 

Zcm = Sum(xiZci) 

Vcm = Sum(xiVci) 

Mm = Sum(xiMi) 

Pcm = ZcmR0Tcm/MmVcm

8.13.11 Vapor Conductivity 

The pure component equations are used with the following pseudocritical constants from Yorizane et al 
defined for the mixture: 

Tcm = Sum(xixj(Vci1/3 + Vcj1/3)3(TciTcj)1/2)/(8Vcm) 

Vcm = Sum(xixj(Vci1/3 + Vcj1/3)3) 

wm = Sum(xiwi) 

Zcm = 0.2905 - 0.085 wm 

Pcm = ZcmR0Tcm/MmVcm 

Mm = Sum(xiMi)  

8.13.12 Ideal-Gas Mixture Properties 

Ideal-gas mixture properties are taken as the mole fraction of the pure component properties. The pure 
component properties are defined per mole of substance. 
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8.14 Notation 

C Specific Heat 

e Expansion Coefficient 

h Enthalpy 

log Logarithm to base 10 

ln Natural Logarithm 

m Dipole Moment 

M Molecular Weight 

P Pressure 

R Gas Constant 

r Riedel Parameter 

s Entropy 

T Temperature 

v Viscosity 

V Specific Volume 

w Acentric Factor 

x Mole Fraction 

Y Wu & Stiel Polarity Factor 

Z Compressibility 

 

Subscripts 

b Boiling 

c Critical 

es Equation of State 

f Freezing 

ig Ideal Gas 

L Liquid 

m Mixture 

0 Low Pressure 

p Constant Pressure 

ra Rackett 

ref Reference 

r Reduced 

s Saturated 
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v Vapor 

v Constant Volume 

Superscripts 

(o) Simple Fluid 

(r) Reference Fluid 

(p) Polar Fluid 
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Role of Pressure Junctions - Detailed Discussion (Long)
In modeling a generalized pipe network, it is possible to construct models that do not have a unique solu-
tion. A common occurrence of this is when a model contains one or more sections which are completely 
bounded by known flow rates. A series of examples with accompanying explanation will clarify situations 
where this occurs. The length of this topic is proportional to the frequency with which engineers get con-
fused over the issue. It became apparent that an exhaustive, lengthy discussion was necessary for some 
engineers. Do not dismiss this topic too quickly because of its length.

Before beginning it will be helpful to consider an aspect of the philosophy of computer modeling. At the 
risk of stating the obvious, it must be recognized by the user that a computer model cannot calculate any-
thing that cannot in principle be calculated by hand. All the computer does is accelerate the calculation 
process. Some users expect the model to generate independent information and become frustrated 
when the software requests additional information from them. But if the user was doing the calculation by 
hand that same information would still be required. The difference is that in the case of the hand cal-
culation, the engineer would be forced to think through why the information is needed.

However, when the engineer interacts with AFT xStream, they do not need to think at the same depth as 
in the hand calculation. So when AFT xStream asks for the additional information, it is not as apparent 
why it is required. This disconnect in thinking can cause frustration for the user. Fully understanding the 
concepts in this topic will greatly reduce the frustration for some users, and will improve the quality of 
models for all users.

Examples

The simplest example is the system shown in Figure 1. In AFT xStream terms, the system has two 
assigned flow junctions.
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Figure 1: Model with two assigned flows. This model does not have a unique solution.

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It cannot be 
determined because there is no reference pressure. The reference pressure is that pressure from which 
other pressures in the system are derived. There can be one or more reference pressures, but there 
always has to be at least one.

The model in Figure 1 can be built with AFT xStream and if you try and run this model, AFT xStream will 
inform you that it cannot run it because of the lack of a reference pressure. In AFT xStream there are five 
junctions that can act as a reference pressure: the tank, assigned pressure, control valves with pressure 
setpoints, and valve and relief valve after cracking (with the exit valve option).

There are a couple other things worth noting about Figure 1. First is that the model in Figure 1 has 
redundant boundary conditions. When one flow is specified in a single pipe, the other end must have the 
same flow. Thus the second known flow does not offer any new information. Because the conditions are 
redundant, there is no unique solution to the model in Figure 1. In any AFT xStream model, there is 
always at least one unknown for each junction in the model – either pressure or flow rate. Sometimes 
there are two unknowns such as a compressor/fan. It is possible the user may not know either the flow or 
the pressure at the compressor/fan. In such cases the user is required to specify the relationship 
between flow and pressure. This relationship is called a compressor/fan curve, and by specifying the rela-
tionship between the two, effectively one of the two unknowns can be eliminated. Thus we always end up 
with one unknown for each junction.

Second, if the user was allowed to specify two flows as in Figure 1, they could specify them with different 
flow rates. Clearly they must have the same flow, so an inconsistency occurs. The basic reason the incon-
sistency is possible is because Figure 1 does not have a unique solution. 

Figure 2 a-c shows three other model configuration possibilities. It is not possible to specify inconsistent 
conditions for any of the Figure 2 models, and they always have a unique solution no matter what input is 
specified by the user.
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Figure 2: Top two models with one pressure and one assigned flow, bottom model with two pressures. All of 
these models have a unique solution.

The four models in Figures 1 and 2 a-c contain all logical possibilities. In all four cases there are four 
things we want to know. The pressure and flow at the inlet, and the pressure and flow in the outlet. In 
each case we know two of these four. The problem is that in the Figure 1 model the lack of a reference 
pressure makes it impossible to determine the inlet and outlet pressures, even though we know the flow. 
The three models in Figure 2 a-c all have at least one pressure and thus all four of the desired para-
meters can be determined. Table 1 summarizes this. Also note in Table 1 that in the Figure 2c case the 
flow can be determined, but it is by iteration.

Table 1: Four logical possibilities of boundary conditions for single pipe systems

As we consider multi-pipe systems, there are a host of other possibilities that present themselves. All 
other configuration possibilities which lack a reference pressure ultimately boil down to the same prob-
lem that exists in Figure 1.

The pipe lengths, diameters and friction factors are not included in the remaining models because they 
do not influence the main point of this topic. It is assumed that these parameters can be obtained for each 
pipe and the resulting pressure drop calculated with standard relationships.

Consider the model in Figure 3. With three boundaries having a known flow, this clearly has the same 
problem as the model in Figure 1. No unique pressures at any location can be calculated.

A pressure at any one of the three boundaries in Figure 3 would be sufficient to allow a unique solution of 
the system. It is also possible that there could be two pressures and one flow, or three pressures. As long 
as there is one pressure a unique solution exists.
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Figure 3: Three known flows at boundaries lack a reference pressure, similar to the model in Figure 1. This 
model does not have a unique solution.

Now consider the models in Figure 4. The Figure 4a model does have one reference pressure, but in this 
case there is still a problem. The Flow Control Valve (FCV) is controlling the flow to 10 gpm, and the 
downstream flow is demanding 10 gpm. The section of the system before the FCV can be solved 
(because there is a pressure upstream), but the section after the FCV does not have a unique solution. 
Why? In order to obtain a unique solution, the pressure drop across the FCV must be known. But any 
pressure drop could exist and satisfy the conditions of this model. It is thus not possible to determine the 
pressure at the outlet flow demand because it depends on the FCV pressure drop which is not known. 
The model in 4b does have a pressure downstream of the FCV, and thus there is a unique pressure drop 
across the FCV and a unique solution exists for the model in Figure 4b.

If you input the remaining data for the Figure 4a model and run it in AFT xStream, you will get the mes-
sage shown in Figure 5. AFT xStream identifies the part(s) of the model where a known pressure is 
needed.

Figure 4a-b.: The model at the top does not have a reference pressure after the Flow Control Valve so the 
pressure drop across the FCV cannot be determined. The top model does not have a unique solution. The 

bottom model has a pressure upstream and downstream, and a unique solution exists.
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Figure 5: AFT xStream message when you try to run the model shown in Figure 4a.

Sizing Compressors or Fans with Flow Control Valves

An analogous situation to Figure 4a is when the user is trying to size a compressor using the Com-
pressor/Fan with a fixed flow. The Compressor/Fan with a fixed flow is really just a reverse FCV. It con-
trols the flow by adding pressure, rather than reducing it. Figure 6 shows this case and is another 
example of a model without a unique solution, requiring more than one pressure junction. If the user 
instead entered a compressor or fan curve for this model, it could be solved.

Figure 6: A compressor/fan modeled as a fixed flow behaves identically to the FCV model in Figure 4a, for 
which no unique solution exists

Increasing in model complexity, Figure 7 shows some additional examples of models without a unique 
solution. In particular, Figure 7b has a compressor/fan with a fixed flow that can add as much pressure as 
it wants, and the downstream FCV can then take out as much as it wants. There are an infinite number of 
possible solutions.
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While it would be highly unusual for a system to have two FCV’s in series, it is worth considering the 
model in Figure 7b further. It is common to have an FCV in series with a compressor/fan. How does one 
size the compressor/fan in such a case? There are several ways to do this, one of which is to change the 
compressor/fan from a fixed flow to an actual compressor or fan curve. Trying multiple curves will guide 
you to the best compressor or fan.

But there is a better way. Consider for a moment the pressure drop across the FCV in Figure 7b. In the 
installed system, is any pressure drop acceptable? Usually not. It is typical to have pressure drop limits 
based on the system design and the FCV itself. A common requirement is a minimum pressure drop 
across the FCV. If no minimum pressure drop exists, let’s say we choose a compressor or fan that results 
in the pressure drop across the FCV being 0.01 psid. If the system is built and the compressor or fan 
slightly underperforms its published curve, the FCV will not be able to control to its flow control point. 
Even if the compressor or fan does operate exactly on the published curve, eventually fouling in the pipes 
will result in increased pipe resistance (and pressure drop) and again the FCV will not be able to control 
to its flow control point.

Figure 7: Neither model above has a unique solution. The top model has two flow control valves in series. 
The bottom model has a  compressor/fan modeled as a fixed flow in series with an FCV. In both cases either 

a third pressure junction is needed between the two middle junctions, or one of the junctions must be 
changed from a flow controlling device.

To avoid these kinds of problems in installed systems, a minimum Cv or pressure drop across the FCV is 
typically required. This minimum pressure drop provides the key to sizing the compressor/fan in Figure 
7b. Rather than model the FCV as a flow control valve, instead model it as a pressure drop control valve 
(PDCV) set to the minimum pressure drop requirement. Then a unique solution exists, the model will run 
and the compressor/fan can be sized. Once the compressor/fan is sized and an actual curve exists, the 
curve can be entered and the valve can be switched back to an FCV. Remember that when we use the 
PDCV, we are still getting the flow we want for the true FCV, because the compressor/fan is now provid-
ing the control.

Think for a moment what we just did. We went through a thought process that many engineers have gone 
through during their hand calculations. Specifically, we size the compressor/fan such that the FCV pres-
sure drop is minimized. If the FCV has a larger pressure drop than the minimum, the compressor/fan 
must add more pressure to overcome this excess pressure drop. In short, it must use more energy and is 
thus less efficient. Figure 8 depicts this process.
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Figure 8a-c: The model at the top is the same as Figure 7b and does not have a unique solution. To size the 
compressor/fan, change the model to the second one shown above, which uses a pressure drop control 

valve (PDCV) rather than an FCV. Once the second model is run, the compressor/fan is sized, a curve exists, 
and the model at the bottom can be run using an FCV.

Let’s make a slight addition in complexity to the model in Figure 8. In this case we have two flow control 
valves in parallel (Figure 9). To size this compressor/fan, we apply the process described in Figure 8. We 
choose one of the FCV’s, make it a PDCV, size the compressor/fan, choose a compressor/fan with an 
actual curve, enter the curve into the model, and then return the PDCV to an FCV.

Figure 9: A compressor/fan with a fixed flow in series with two parallel FCV’s. The model in its current form 
does not have a unique solution. To size the compressor/fan, first change the FCV at J7 to a PDCV.

This brings up the question, which FCV should one choose to turn into a PDCV? When FCV’s are put in 
parallel, frequently the pipe design has one of the FCV’s further away from the compressor/fan than the 
others. Because of the additional piping leading to this FCV, it will be the weakest link in the chain of par-
allel FCV’s by virtue of having the lowest pressure drop across it. The most remote FCV should be 
chosen as the PDCV. If the most remote FCV is chosen, when the minimum pressure drop required is 
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applied to the PDCV all other FCV’s in the parallel system will have greater than the minimum pressure 
drop — thus satisfying the pressure drop requirement for those FCV’s as well.

What if you do not know which FCV is the most remote? In this case make your best guess, change it to a 
PDCV at the minimum required pressure drop, run the model, then verify whether all other FCV’s have a 
pressure drop that meets or exceeds the requirement. If not, then the FCV with the smallest pressure 
drop as determined by the first run is in reality the weakest FCV. Choose this FCV, change it to a PDCV, 
and then change the original PDCV back to an FCV since it is not the weak link. If the pipe system lead-
ing to each FCV is truly identical and all FCV’s have identical pressure drops, any of the FCV’s will serve 
as the PDCV.

The preceding process can be extended to cases where there are three or more FCV’s in parallel, and 
also cases with more than one compressor/fan in parallel supplying the FCV’s.

In Figure 9 the most remote valve is J7, the one on the right. If the minimum pressure drop is 5 psid, 
change J7 to a PDCV with a 5 psi drop. This results in the output shown in Figure 10a. Notice how the 
pressure drop across the other FCV at J6 is greater than 5 psid because it is closer to the com-
pressor/fan. Also notice how the flow through J7 is still 1 lbm/s even though it is not controlling flow. Once 
again, the reason for this is that the compressor/fan is controlling the flow to 2 lbm/s, and with the J6 FCV 
controlling to 1 lbm/s, the excess must go through J7. The compressor/fan is thus sized and its pressure 
rise is shown in Figure 10b (59.83 psid).

Figure 10a-b: Results from changing J7 in Figure 9 to pressure drop control valve

AFT xStream results for the model in Figure 9 after J8 has been changed to a PDCV. Top results show 
valve summary and bottom results show compressor/fan size.
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Pressure Control Valves

The problem of non-unique solutions can also occur when a Pressure Reducing Valve (PRV) or Pressure 
Sustaining Valve (PSV) is used. A PRV is used to control pressure downstream of the valve, while a PSV 
controls pressure at the valve inlet. One thing that PRVs and PSVs have in common with FCVs is that the 
pressure drop cannot be known ahead of time. The pressure drop depends on the balance of the pipe 
system.

Consider the simple system shown in Figure 11. With the pressure controlled downstream of the PRV, 
the pressure upstream is not known. Without knowledge of the PRV's pressure drop, the pressure 
upstream of the PRV cannot be determined and thus no unique solution exists.

Figure 11: If a PRV is downstream of a known flow the PRV pressure drop cannot be calculated. This model 
does not have a unique solution.

Figure 12 shows the possible cases with PRVs and PSVs, while Table 2 comments on the six cases. In 
summary, at least one known pressure is always needed on the side of a pressure control valve opposite 
of the controlled side.



Transient Theory

- 527 -

Figure 12a-f.: Six possibilities for PRV and PSV configurations. Cases A and E do not have unique solutions. 
See Table 2 for comments.

Table 2: Summary of six possibilities for PRV and PSV configurations.

If a compressor/fan is being sized in series with a PRV or PSV, modeling the compressor/fan as an 
assigned flow will not permit a unique solution if the compressor/fan is upstream of a PRV or downstream 
of a PSV. The reasons for this are the same as those in the previous section on FCVs.
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In combination with the previous examples, it should be apparent how the non-unique solution problem 
can occur in more complicated systems. In all such cases, the reasoning will boil down to the same prob-
lems already discussed.

Closing Parts of a System

A model may be built which has sufficient information to obtain a unique solution. Then a user closes a 
junction and all of a sudden the problem of no unique solution occurs. This is shown in Figure 13. The top 
model has a unique solution and will run fine. In the bottom model the valve is turned off and the section 
of the system downstream of the valve has only known flows. No reference pressure exists in this section 
because it is isolated from the known pressures in the section on the left.

Figure 13: Top model has reference pressures at J1 and J2. Bottom model has closed valve at J4 which isol-
ates the J5 and J6 assigned flows. There is no reference pressure for J5 and J6 and no unique solution 

exists for the bottom model.

Summary

AFT xStream models always require one reference pressure, and may require more if the engineer uses 
control valves, compressor/fans with assigned flows, or closes pipes or junctions. The actual number of 
reference pressures needed depends on the model, but AFT xStream always checks to be sure sufficient 
reference pressures exist and stops to warn the user when they do not.

This capability is a powerful diagnostic feature that will help guide the user in building meaningful models.
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Related Blogs

Reference Pressure Needed: Where It Comes from and How to Address it

https://www.aft.com/support/product-tips/reference-pressure
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Output Messages & Warnings
Various types of messages may be given in the output when you run a model. These messages are inten-
ded to alert you about problems with the model or solution. There are different message classifications 
depending on the severity, but all message types should be reviewed when they are displayed in the out-
put.

The links below will take you to a message list for the corresponding message type with a brief explan-
ation given for each.

 1. CRITICAL WARNING - Very High Severity - The model is not accurately predicting behavior, and 
the solution may violate the engineering assumptions of the software. These issues must be 
resolved for the model to be trustworthy, and the output should only be used for error resolution or 
troubleshooting purposes and never for engineering decisions.

 2. WARNING - High Severity - A serious issue with the model or results exists. For example, the solu-
tion has exceeded a valid data range, or potentially unrealistic behavior is occurring. A real system 
may encounter operational problems under the conditions.

 3. CAUTION - Moderate/Low Severity - Something may be wrong with the model or of interest for the 
user to double check. Depending on the application, the results may or may not be affected. If res-
ults are affected, it would be to a lower degree compared to a Warning.

 4. INFORMATION - An Information message is intended to make the user aware that an advanced 
feature is being used in the model, or to provide comments or suggestions relating to an advanced 
feature. Following suggestions may achieve higher accuracy results if the right conditions apply, 
but can also cause incorrect results if not applied properly. If the user understands the feature 
then no action is required.

Any message that directly lists a pipe/junction can be double-clicked  to take you directly to the object on 
the Workspace. Whenever a Warning or Critical Warning message type is displayed, the General Res-
ults section will display red text.

Related Topics

Use the Model Data Window 562
Solution Method Panel 117
Simulation Mode/Duration Panel 111

Critical Warnings
The model is not accurately predicting behavior, and the solution may violate the engineering assump-
tions of the software. These issues must be resolved for the model to be trustworthy, and the output 
should only be used for error resolution or troubleshooting purposes and never for engineering 
decisions.

CRITICAL WARNINGS



Output Messages & Warnings

- 531 -

Characteristic speed exceeded maximum determined from...
A Critical Warning message in AFT xStream

Full Message text is:

The characteristic speed exceeded the maximum determined from estimated maximum pipe tem-
perature and Mach number at X seconds, Pipe Y, Section Z.

This critical warning indicates that at some time during the simulation the characteristic speed exceeded 
the maximum characteristic speed, which is equivalent to the MOC grid section length divided by the time 
step. If this happens the solver in xStream will attempt to interpolate properties outside the MOC char-
acteristic grid, which may introduce instability and inaccuracies to the solution.

The Estimated Maximum Pipe Temperature During Transient and/or the Estimated Maximum Pipe Mach 
Number During Transient in the Sectioning panel should be increased to increase the maximum char-
acteristic speed.

For more information about the MOC solution, please refer to the Pipe Sectioning and Method of Char-
acteristics pages. This warning message is generated when points R or L are outside of points 1 or 3 in 
Figure 1 on the Pipe Sectioning page.

Related Topics

Method of Characteristics 473

Global Energy Balance Disabled
A Critical Warning message in AFT xStream

Full Message text is:

Global energy balance disabled by user in Solution Control window

This critical warning message alerts users they have disabled the Global Energy Balance option in the 
Advanced Parameters Panel. Results shown with this critical warning do not represent a valid converged 
solution.

Global Mass Balance Disabled
A Critical Warning message in AFT xStream

Full Message text is:

Global mass balance disabled by user in Solution Control window

This critical warning message alerts users they have disabled the Global Mass Balance option in the 
Advanced Parameters Panel. Results shown with this critical warning do not represent a valid converged 
solution.
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Junction X Had Reverse Flow - Compressor Pressure/Head Could 
Not Be Predicted

A Critical Warning message in AFT xStream

Full Message text is:

The Compressor Junction X had reverse flow during the transient. The head/pressure rise was estimated 
from the zero flow value.

This critical warning message displays for centrifugal compressors when reverse flow occurs at the com-
pressor and the Manufacturer's Curve is being used for calculations. The compressor head rise under 
such conditions is unknown. The zero-flow value is used.

Maximum transient pipe mach number X higher than estimate Y
A Critical Warning message in AFT xStream

Full Message text is:

The maximum transient pipe Mach number (X) was higher than the estimate (Y). Results should not be 
considered accurate until the simulation is re-run with an estimated maximum pipe Mach number higher 
than the actual transient maximum.

The Mach number at some location in the pipes exceeded the Estimated Maximum Pipe Mach Number 
During Transient, which is defined on the Sectioning panel of Analysis Setup. This can cause instability in 
the Solver and significant error in the results. The model should be re-run with the Estimated Maximum 
Pipe Mach Number During Transient set to at least 0.1 greater than the maximum pipe mach number 
encountered during the simulation.

Pipe Mach number exceeded 1 during simulation
A Critical Warning message in AFT xStream

Full Message text is:

Pipe Mach number exceeded 1 during simulation.

AFT xStream is limited to sonic and subsonic flows, and cannot model flows exceeding Mach 1. 
However, the MOC calculations during the MOC Transient simulation can on occasion calculate velo-
cities slightly above 1. This critical warning is shown by default when the Mach number in the pipes 
exceeds 1.0001. Users should examine results with this critical warning carefully, and recognize that res-
ults after Mach 1 is exceeded may be in error.

Required flow to supply the pressure control valve at junction X is 
above sonic flow

A Critical Warning message in AFT xStream

Full Message text is:
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Required flow to supply the pressure control valve at Junction X is above sonic flow and cannot be sup-
plied. Please review results and change your model.

This critical warning message means the user has specified a pressure at a pressure control valve which 
requires a flow which is physically impossible because of sonic choking. The set point should be changed 
to allow physically realistic flows.

Setting relaxation lower than relative pressure/flow tolerance gives 
unreliable results

A Critical Warning message in AFT xStream

Full Message text is:

Setting relaxation lower than relative pressure(flow) tolerance gives unreliable results.

Setting the relaxation to a value close to or lower than relative tolerance can lead to false convergence 
and invalid results. AFT xStream alerts the user to this when inputting data in the AFT Arrow Steady Solu-
tion Control panel, and also alerts the user once the solution has been obtained.

Specified flow through/out of junction X is above sonic flow and can-
not be supplied

A Critical Warning message in AFT xStream

Full Message text is:

Specified flow through (out of) Junction X is above sonic flow and cannot be supplied. Please review your 
results and change your model.

This critical warning message means the user has specified an outflow which is physically impossible 
because of sonic choking. This message can also occur if Assigned Flow junctions, Flow Control Valves, 
or Compressor/Fans modeled as a fixed flowrate are used.

These results do not represent a converged solution
A Critical Warning message in AFT xStream

Full Message text is:

These results do not represent a converged solution. Use only for error resolution purposes.

This message alerts users that results are displayed for an unconverged solution. The displayed results 
should only be used for purposes of determining the reasons for nonconvergence. Under no cir-
cumstances should these results be used for engineering purposes.
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Warnings
A Warning is of High Severity, and should always be reviewed before considering the results to be mean-
ingful for the system.

A serious issue with the model or results exists. For example, the solution has exceeded a valid data 
range, or potentially unrealistic behavior is occurring. A real system may encounter operational problems 
under the conditions.

WARNINGS

Automatic Sectioning Did Not Achieve Steady Conservation
A Warning message in AFT xStream

Full Message text is:

Automatic Sectioning did not achieve the desired Steady Conservation Error

Automatic Sectioning is a tool found in the Sectioning panel of the Analysis Setup window when 
Advanced Options are shown. This tool attempts to add pipe sections until the conservation error 
between the AFT Arrow Steady and MOC Steady Solutions is below the allowable error. This warning is 
shown if the Automatic Sectioning is unable to meet the allowable error. The allowable error may be 
exceeded if the maximum number of sections is reached.

Chempak Temperature/Pressure Outside Valid Range
A Warning message in AFT xStream

Full Message text is:

Chempak temperature and/or pressure is above/below valid range for the following:

The final solution had temperature and/or pressure conditions in the specified pipes obtained with 
Chempak physical property data which were beyond Chempak’s range of applicability. The range value 
is also displayed. This warning indicates the results may not be valid. It also may indicate an input error in 
the model because of the extreme temperature or pressure state.

Control Valve Open Percentage Outside Valid Range
A Warning message in AFT xStream

Full Message text is:

Control Valve open percentage outside valid range of 0-100% at Junction X

This message is a warning that a control valve which includes open percentage data is operating outside 
the range of 0-100%. In many cases, it is likely that the user has not defined open percentages outside of 
the valid range, but instead has entered data that might allow xStream to extrapolate values outside that 
range.
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Energy may not be balanced at Junction X
A Warning message in AFT xStream

Full Message text is:

Energy may not be balanced at Junction X (total = Y)

This warning alerts users that the converged energy balance results may be incorrect for the AFT Arrow 
Steady Solution. Once a converged solution is obtained, AFT xStream checks all junctions to ensure an 
energy balance exists. It compares the imbalance to the mass flow weighted enthalpy tolerance, and 
when the imbalance exceeds the tolerance, this warning is generated.

If the magnitude of the energy imbalance is close to the tolerance  specified, it is generally safe to ignore 
this warning, although it may make sense to reduce tolerances further and rerun the model.

If the magnitude of the energy imbalance is large, the converged solution that may be incorrect. When a 
large imbalance exists, it may be an indicator the model is not realistic.

These warnings should always be reviewed in detail, and the user should perform hand calculations on 
the energy balance at the affected junctions to verify whether an acceptable solution exists.

Note: This warning will usually occur when you assign isothermal boundary conditions to pipes in your 
model. If pipes are forced to flow at the isothermal temperature specified, it is usually not pos-
sible to balance energy at the junctions. The warning can be ignored in such circumstances, 
because the energy imbalance is a natural result of the isothermal assumption.

FCV could not control flow at Junction X
A Warning message in AFT xStream

Full Message text is:

FCV could not control flow at Junction X

The Flow Control Valve was not able to control the flow, and backflow may have occurred.

Flow may not be balanced at Junction X
A Warning message in AFT xStream

Full Message is:

Flow may not be balanced at Junction X (total = Y)

This warning alerts users that the converged mass balance results may be incorrect for the AFT Arrow 
Steady Solution. Once a converged solution is obtained, AFT xStream checks all junctions to ensure a 
mass balance exists. It compares the imbalance to the flow tolerance, and when the imbalance exceeds 
the tolerance, this warning is generated.

If the magnitude of the flow imbalance is close to the tolerance  specified, it may be safe to ignore this 
warning, although it likely make sense to reduce tolerances further and rerun the model.
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If the magnitude of the energy imbalance is large, the converged solution that may be incorrect. When a 
large imbalance exists, it may be an indicator the model is not realistic.

These warnings should always be reviewed in detail, and the user should perform hand calculations on 
the energy balance at the affected junctions to verify whether an acceptable solution exists.

Fluid is no longer in the vapor phase because the fluid tem-
perature/pressure is...

A Warning message in AFT xStream

Full Message Text

There are several variations of this Warning:

 l Fluid is no longer in the vapor phase because the fluid pressure is above the Saturation Pres-
sure for the following:

Pipe X Inlet/Outlet, Actual Pressure = Y, Saturation Pressure = Z
 l Fluid is no longer in the vapor phase because the fluid temperature is below the Saturation 

Temperature for the following:
Pipe X Inlet/Outlet, Actual Temperature = Y, Saturation Temperature = Z

Explanation

The steady-state temperature and pressure conditions at the specified pipes are such that one or more 
gas components has reached saturation conditions. When the fluid property conditions fall below sat-
uration the solution accuracy will be decreased since one of the fundamental Engineering Assumptions 
is that the fluid is single-phase and superheated. The Solver will attempt to extrapolate gas properties 
below the saturation line.

The variations of the Warning depend on which fluid library is used and different programming methods 
are required due to differences in the library sources.

 l Variation for "pressure is above the Saturation Pressure" is only applicable to AFT Standard or 
User Library Fluids.

 l Variation for "temperature is below the Saturation Temperature" is applicable to ASME Steam, 
Chempak, and NIST REFPROP fluids.

Required Action

Adjust the model such that the fluid properties remain superheated, single-phase, and outside the sat-
uration conditions. If this is not possible, then a larger uncertainty in results must be accepted and the res-
ults may not be accurate depending on how far the properties extend into saturation.
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If there is flexibility in adjusting the model, there are various changes that could be made depending on 
the goal of the analysis and what is acceptable:

 l Check for typos or incorrect inputs in the Model Data (including units), especially at the boundary 
condition junctions or any components with significant temperature or pressure changes

 l Increase or decrease the upstream boundary condition temperature (such as the temperature in a 
Tank junction)

 l Adjust the heat transfer in pipes
 l Run a scenario using a different fluid library if the fluid can be found in the other Library sources, 

and compare the results

Inlet and outlet pipes at Junction X do not have the same stagnation 
enthalpy

A Warning message in AFT xStream

Full Message text is:

Inlet and outlet pipes at Junction X do not have the same stagnation enthalpy.

The stagnation enthalpy entering a junction should equal the stagnation enthalpy exiting, assuming no 
flow splits and an adiabatic junction. This warning tells you that the values differ. Results are likely incor-
rect, and may not represent a converged solution.

Junction X Compressor/Fan added negative pressure
A Warning message in AFT xStream

Full Message text is:

Junction X Compressor added negative pressure.

A compressor junction with an assigned flow rate had a pressure loss across the compressor junction 
either in the steady-state or transient system. This warning is meant to alert the user that the compressor 
is not adding pressure as they may be expecting.

Junction X Exceeded End-of-Curve Flow Rate
A Warning message in AFT xStream

Full Message text is:

Junction X Exceeded End-of-Curve Flow Rate

Centrifugal compressor curves typically only extend to a given flow. AFT xStream defines this point as 
the End-of-Curve.  Such data has been defined for this compressor in the Compressor Configuration win-
dow, and the system is operating past the End-of-Curve flow rate. Thus the results may be invalid, 
because the compressor may not actually operate at that point.
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Junction X Had Reverse Flow During Transient
A Warning message in AFT xStream

Full Message text is:

Junction X had reverse flow during the transient. The head/pressure rise was estimated from the zero 
flow value.

A transient event could cause reverse flow at a compressor junction in the model. In this situation, the 
head/pressure rise across the compressor is estimated from the value at zero flow.

Maximum system pressure exceeded enthalpy table's maximum 
pressure of X

A Warning message in AFT xStream

Full Message text is:

Maximum system pressure exceeded enthalpy table's maximum pressure of X. Enthalpy is extrapolated 
for pressures exceeding this value.

This warning indicates that the AFT Standard fluid database is being used with the Table Enthalpy 
model, and that the maximum system pressure exceeded the maximum pressure for the enthalpy data. 
The Table enthalpy model uses interpolation based on the current pressure to calculate the enthalpy at a 
given temperature. If the pressure at a point in the system exceeds the maximum pressure data available 
for the fluid in the AFT Standard fluid database, then the enthalpy must be extrapolated, leading to inac-
curacy in the results. Extrapolation far above the maximum temperature will lead to increased inac-
curacy, and may cause convergence issues. Consider using an alternate fluid database such as NIST 
REFPROP or Chempak with a higher maximum pressure.

Maximum Transient Pipe Temperature Higher Than Estimate
A Warning message in AFT xStream

Full Message text is:

The maximum transient pipe temperature (X) was higher than the estimate (Y). The estimated maximum 
pipe temperature should be set marginally above the maximum.

This warning indicates the maximum temperature in the pipes during the transient simulation is higher 
than the Estimated Maximum Pipe Temperature During Transient value specified by the user in the Sec-
tioning panel. A temperature higher than the estimate may cause the maximum sonic velocity to be 
higher than estimated, and in turn mean the time step for the MOC Transient simulation is too small to 
properly simulate high-velocity flow.

The user should provide a more accurate estimated maximum temperature and re-run the simulation. If 
high Mach numbers are never seen during the simulation, it may be acceptable to set the estimated max-
imum pipe temperature lower than the actual maximum temperature.
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Maximum Transient Pipe Temperature Significantly Lower Than 
Estimate

A Warning message in AFT xStream

Full Message text is:

The maximum transient pipe temperature (X) was significantly lower than the estimate (Y). The estim-
ated maximum pipe temperature should be set marginally above the maximum.

This warning indicates the maximum pipe temperature during the transient simulation is significantly 
lower than the Estimated Maximum Pipe Temperature During Transient value specified by the user in the 
Sectioning panel. The estimated maximum temperature is used to help determine the time step for the 
simulation. In this situation, it's possible that more time steps are used than are necessary to capture the 
system's transient behavior. Lowering the estimate will make each time step longer, reducing run time.

The user should provide a more accurate estimated maximum pipe temperature and re-run the sim-
ulation.

Physical flow area is less than the sonic area at junction X...
A Warning message in AFT xStream

Full Message text is:

Physical flow area is less than the sonic area at junction X. Sonic choking probably exists but was 
ignored in this solution because no CdA was specified.

AFT xStream cannot account for sonic choking at a junction unless the CdA for Sonic Choking is spe-
cified. For several junctions, a physical area is specified by the user. For example, for an orifice the orifice 
area or diameter is specified. However, the real flow area is less than this physical area because of vena 
contracta and wall separation effects. In order to perform a proper sonic choking calculation, AFT 
xStream needs to know the CdA.

When this warning is displayed, AFT xStream has determined that the physical area was less than the 
sonic area at the specified junction, but sonic choking was ignored because no CdA was specified. Thus 
sonic choking may exist even though AFT xStream could not calculate it.

When this warning is displayed it is recommended you obtain the proper CdA for the junction and run the 
model again.

Pipe/Junction X property calculation exceeded maximum local iter-
ation limit

A Warning message in AFT xStream

Full Message text is:

Pipe/Junction X property calculation exceeded maximum local iteration limit.

The final network solution was not within tolerance for a local iteration. The local iteration limit set in the 
AFT Arrow Steady Solution panel was exceeded, but the Solver ignored this and continued on. If a net-
work solution is obtained but this out of tolerance situation exists, AFT xStream attempts the network 
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solution again up to five times in a row. If the out of tolerance situation remains, AFT xStream ceases fur-
ther attempts and displays the convergence notification, then gives this warning in the output. The prop-
erty can be any of several solver parameters and depends on the actual subroutine where the problem 
occurred.

Along with the warning, the Error value and Tolerance are displayed, along with a Code #. For AFT 
xStream to consider this local iteration to be converged, the Error value needs to be less than the dis-
played Tolerance. This Tolerance is not the tolerance the user can specify in the AFT Arrow Steady Solu-
tion panel, but rather an internal “hard-wired” tolerance that has been set by the software developers and 
arrived at through experience.

If the Error value is relatively close to the displayed Tolerance, it is generally safe to ignore this warning. If 
it is much larger, the remainder of the output is probably invalid.

In either case, changing the solution method in the AFT Arrow Steady Solution panel frequently solves 
the problem.

The Code # identifies the subroutine where the problem occurred. This information is not of much assist-
ance to the user, but can be of help to AFT technical support staff when troubleshooting models.

Pipe/Junction X property calculation failed to continue towards con-
vergence

A Warning message in AFT xStream

Full Message text is:

Pipe/Junction X property calculation failed to continue towards convergence.

The final network solution was not within tolerance for a local iteration. This was determined by AFT 
xStream’s Auto-Detect feature. The Solver ignored this and continued on. If a network solution is 
obtained but this out of tolerance situation exists, AFT xStream attempts the network solution again up to 
five times in a row. If the out of tolerance situation remains, AFT xStream ceases further attempts and dis-
plays the convergence notification, then gives this warning in the output. The property can be any of sev-
eral solver parameters and depends on the actual subroutine where the problem occurred.

Along with the warning, the Error value and Tolerance are displayed, along with a Code #. For AFT 
xStream to consider this local iteration to be converged, the Error value needs to be less than the dis-
played Tolerance. This Tolerance is not the tolerance the user can specify in the Tolerance panel of Ana-
lysis Setup, but rather an internal “hard-wired” tolerance that has been set by the software developers 
and arrived at through experience.

If the Error value is relatively close to the displayed Tolerance, it is generally safe to ignore this warning. If 
it is much larger, the remainder of the output is probably invalid.

In either case, changing the solution method in the AFT Arrow Steady Solution panel frequently solves 
the problem.

The Code # identifies the subroutine where the problem occurred. This information is not of  much assist-
ance to the user, but can be of help to AFT technical support staff when troubleshooting models.
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Pipe X temperature is outside temperature limits in AFT Arrow 
Steady Solution

A Warning message in AFT xStream

Full Message text is:

Pipe X temperature is equal to or greater than the maximum temperature limit (equal to or less than the 
minimum temperature limit) of Y set by the user in Solution Control. Results may be incorrect.

The user has specified limits in the Pressure and Temperature Solver Limits panel of the AFT Arrow 
Steady Solution in Analysis Setup. These limits are intended to aid in convergence by restricting the 
search space while solving, and should generally be left as the AFT default values. This warning indic-
ates that the final solution had one or more pipes outside the limit range, and the temperature results 
have been artificially limited by the Solver. The results are therefore not valid. To resolve this either 
remove or change the temperature limit.

Note: These limits should not be used as Design Alerts, or to approximate some physical phe-
nomenon.

PRV could not control pressure at Junction X
A Warning message in AFT xStream

Full Message is:

PRV could not control flow at Junction X

This warning alerts users that the Pressure Reducing Valve at junction X was not able to control the flow, 
and backflow may have occurred.

PSV could not control pressure at Junction X
A Warning message in AFT xStream

Full Message text is:

PSV could not control flow at Junction X

This warning alerts users that the Pressure Sustaining Valve at junction X was not able to control the 
flow, and backflow may have occurred.

Temperature at inlet/exit of pipe X is above/below max/min fluid tem-
perature range

A Warning message in AFT xStream
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Full Message Text

There are several variations of this Warning:

 l Temperature at inlet of pipe X is below min fluid temperature range.
 l Temperature at exit of pipe X is below min fluid temperature range.
 l Temperature at inlet of pipe X is above max fluid temperature range.
 l Temperature at exit of pipe X is above max fluid temperature range.

Explanation

The temperature used to calculate fluid properties is being predicted outside the valid range of data for 
the AFT Standard fluid or User Library Fluid. In order to produce results the software is extrapolating data 
or using a curve fit beyond the defined range of acceptable values. The fluid properties may be incorrect 
and may affect the result accuracy. The max and min temperature for the fluid data can be seen by open-
ing the Library menu, selecting Edit Fluids, selecting the fluid used in the model, and looking at the top of 
the Properties section.

Required Action

Adjust the model such that the temperatures remain within the bounds of fluid data. This could take on 
many forms depending on the goal of the analysis and what is acceptable:

 l Check for typos or incorrect inputs in the Model Data (including units), especially at the boundary 
condition junctions or any components with significant temperature changes

 l Increase or decrease the upstream boundary condition temperature (such as the temperature in a 
Tank junction)

 l Adjust the heat transfer in pipes such that the temperature does not drop below or rise above the 
bounds of data

 l Add more data to the custom fluid that extends the range to cover the temperatures seen in the 
model

 l Run a scenario using a different fluid library if the fluid can be found in the other Library sources, 
and compare the results

The maximum difference between the AFT Arrow Steady solution 
and the MOC Steady Solution for velocity is X%

A Warning message in AFT xStream

Full Message text is:

The maximum difference between the AFT Arrow Steady solution and the MOC Steady Solution for velo-
city is X%
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The MOC Steady Solution is used to transition from the AFT Arrow Steady results to the MOC Transient 
simualtion, and some change in system velocities is expected. This difference is checked prior to the 
MOC Transient simulation. The user can define an allowable change between the two steady solutions 
on the MOC Steady Solution panel, with a default value of 10%.

Pipes with initial velocities less than 10 ft/sec are not included in this check as a small absolute change in 
velocity can be a large relative change in velocity.

The maximum peak-to-peak pressure limit defined in the API 618 
standard has been exceeded at X locations

A Warning message in AFT xStream

Full Message text is:

The maximum peak-to-peak pressure limit defined in the API 618 standard has been exceeded at X loc-
ation(s). See the Pulsation Summary.

This warning appears in AFT xStream when peak-to-peak pressure limits defined by the API 618 stand-
ard have been violated at one or more locations. This warning only appears when the PFA module is act-
ive, when the Frequency Analysis Mode is set to Steady State Pulsation, and the option Evaluate with 
API 618 is active in the Pulse Setup Panel. The Pulsation Summary tab in the Output Window, shown in 
Figure 1 below, provides a summary of each location where this occurred along with the limit at that loc-
ation and the frequency at which the API 618 limit was violated.

Figure 1: The Pulsation Summary tab shows frequency analysis and reciprocating compressor information 
along with information describing locations where API 618 was violated

Related Examples

Frequency Analysis - PFA Example             671

Related Topics
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Defining Pulsation Settings 419
Pulse Setup Panel 100
Pulsation peak-to-peak pressures are within allowable API 618 levels 552

The MOC Steady Solution did not reach a nominally steady state 
before the transient started

A Warning message in AFT xStream

Full Message text is:

The MOC Steady Solution did not reach a nominally steady state before the transient started.

The MOC Steady Solution runs a series of Block Iterations and checks the velocity change across each 
block. The MOC Steady Solution is considered nominally steady when the velocity change between 
blocks is less than the values specified in the MOC Steady Solution panel. If the velocity change across a 
block is never lower than the allowable change, a nominally steady state will not be reached, and this 
warning will be shown. 

The user should increase the allowable change, increase the maximum number of MOC Steady Block 
Iterations, or increase the number of sections used.

Transient choking occured at Junction X
A Warning message in AFT xStream

Full Message text is:

Transient choking exists at junction X. The specified flow or pressure could not be met.

This warning tells the user that choked conditions exist at a junction with a specified pressure or flow rate, 
specifically that those choked conditions existed during the transient simulation. In this situation, xStream 
will limit the flow at the pipe to the choked flow rate regardless of the user-defined conditions.

Transient temperature was above/below fluid maximum/minimum 
temperature

A Warning message in AFT xStream

Full Message Text

There are several variations of this Warning:

 l Transient temperature was below fluid maximum temperature at X seconds. Results after this 
time may not be valid.

 l Transient temperature was above fluid maximum temperature at X seconds. Results after this 
time may not be valid.
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Explanation

The temperature used to calculate fluid properties is being predicted outside the valid range of data for 
the AFT Standard fluid or User Library Fluid. In order to produce results the software is extrapolating data 
or using a curve fit beyond the defined range of acceptable values. The fluid properties may be incorrect 
and may affect the result accuracy. The max and min temperature for the fluid data can be seen by open-
ing the Library menu, selecting Edit Fluids, selecting the fluid used in the model, and looking at the top of 
the Properties section.

xStream will extrapolate below the minimum or above the maximum temperature and assume the fluid 
remains in the superheated gas phase. In some cases the minimum temperature for the library fluid rep-
resents saturation conditions, in which case xStream will be extrapolating below the saturation line.

The reported time step is the first occurrence of this issue during the simulation. There may be additional 
occurrences of the temperature being above the max or below the min throughout the transient sim-
ulation. Results from the MOC Transient after the reported time step should be treated with caution.

Required Action

Adjust the model such that the temperatures remain within the bounds of fluid data. This could take on 
many forms depending on the goal of the analysis and what is acceptable:

 l Check for typos or incorrect inputs in the Model Data (including units), especially at the boundary 
condition junctions or any components with significant temperature changes

 l Increase or decrease the upstream boundary condition temperature (such as the temperature in a 
Tank junction)

 l Adjust the heat transfer in pipes such that the temperature does not drop below or rise above the 
bounds of data

 l Add more data to the custom fluid that extends the range to cover the temperatures seen in the 
model

 l Run a scenario using a different fluid library if the fluid can be found in the other Library sources, 
and compare the results

Transient temperature was below saturation temperature
A Warning message in AFT xStream

Full Message Text

Transient temperature was below saturation temperature at X seconds. Results after this time may not 
be valid.
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Explanation

The transient temperature and pressure conditions at one or more pipes were such that one or more gas 
components reached saturation conditions. When the fluid property conditions fall below saturation the 
solution accuracy will be decreased since one of the fundamental Engineering Assumptions is that the 
fluid is single-phase and superheated. The Solver will attempt to extrapolate gas properties below the sat-
uration line, or optionally, the user can choose to limit properties to Saturated Conditions in the Transient 
Solver Advanced Parameters panel.

The reported time step is the first occurrence of this issue during the simulation. There may be additional 
occurrences of the fluid properties being saturated throughout the transient simulation. Results from the 
MOC Transient after the reported time step should be treated with caution.

Required Action

Adjust the model such that the fluid properties remain superheated, single-phase, and outside the sat-
uration conditions throughout the entire transient simulation. If this is not possible, then results after the 
reported time step should be treated with caution since there is a larger uncertainty and the results may 
not be accurate depending on how far the properties extend into saturation.

To determine the location of the saturated fluid properties, it is recommended to create various Profile 
Graphs using the "Temperature Static" and "Temperature Saturation" graph parameters with the same 
units and axis range. When the static temperature drops below the saturation temperature on the graph, 
use the Show Junction Locations option to determine which pipe has the occurrence and the approx-
imate station. Then, a Transient Pipe Graph can be created for the related stations to show the time step 
that saturation occurs. Knowing the approximate location of saturation can be useful to understand which 
upstream junctions may be impacting the results, and the temperature/pressure drops at these junctions 
should be reviewed.

If there is flexibility in adjusting the model, there are various changes that could be made depending on 
the goal of the analysis and what is acceptable:

 l Check for typos or incorrect inputs in the Model Data (including units), especially at the boundary 
condition junctions or any components with significant temperature or pressure changes

 l Increase or decrease the upstream boundary condition temperature (such as the temperature in a 
Tank junction)

 l Adjust the heat transfer in pipes, or consider adding insulation
 l Run a scenario using a different fluid library if the fluid can be found in the other Library sources, 

and compare the results

Cautions
Something may be wrong with the model or of interest for the user to double check. Depending on the 
application, the results may or may not be affected. If results are affected, it would be to a lower degree 
compared to a Warning. While some Caution messages may be left unresolved without affecting model 
results, they should never be ignored by the user.
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CAUTIONS

All transient junction behavior was disabled
A Caution message in AFT xStream

Full Message text is:

All transient junction behavior was disabled. This is a troubleshooting mode.

This is a cautionary notice that the Disable transient junction behavior for the entire simulation setting is 
enabled on the Transient Solver Initialization Panel under the Advanced Settings, meaning that the 
model was run with no user-defined transients applied. This is different than using the AFT Arrow Steady 
solution method, and is usually only useful for troubleshooting purposes, and identifying artificial tran-
sients.

Assigned Flow at Junction X has a constant flow rate during the 
transient...

A Caution message in AFT xStream

Full message text is:

Assigned Flow at Junction X has a constant flow rate during the transient. During a transient the flow usu-
ally changes. This may not be an appropriate use of the junction.

An Assigned Flow junction fixes the flow at a boundary. When a transient occurs in the system, it is com-
mon to see all flows affected by that transient. This caution is a reminder that an assigned flow may not 
be the appropriate junction to model a transient boundary condition. In general it is better to use 
Assigned Pressure or Tank junctions at boundaries.

Automatic Sectioning is enabled, but flow increases substantially 
during the transient

A Caution message in AFT xStream

Full Message text is:

Automatic Sectioning is enabled, but flow increases substantially during the transient.

This is a cautionary notice that the user enabled Automatic Sectioning to allow xStream to section the 
system to minimize the Steady-State Conservation Error. However, Automatic Sectioning is performed 
based on the steady-state flow, meaning conservation error will increase if the system flow increases. 
When this caution is presented, the user should not assume that conservation error was minimized 
throughout the simulation.
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Check Valve closed at Junction X
A Caution message in AFT xStream

Full Message is:

Check Valve closed at Junction X.

This is a cautionary notice that a check valve closed during the AFT Arrow Steady Solution.

   Flow through Junction X is negative. Loss factors may be in error.
A Caution message in AFT xStream

Full Message text is:

Flow through Junction X is negative. Loss factors may be in error.

This caution alerts users to flow through junctions in the opposite direction from the connecting pipes ref-
erence directions. Any loss information specified for junctions may be in error because it was defined 
assuming flow in the other direction.

Junction X exceeded maximum event messages
A Caution message in AFT xStream

Full Message is:

Junction X exceeded maximum event messages.

Event messages are generated each time a transient event occurs at a junction. A limit is set of how 
many event messages can be shown for a junction to limit how much data is displayed in the output. This 
limit was reached, and some events have happened with no event message displayed. The maximum 
event messages setting can be changed in the Output Control window on the Format & Action tab.

Junction X is downstream of a choking point
A Caution message in AFT xStream

There are two variations of this Caution:

 l Junction X is downstream of a choking point, static properties cannot be calculated at junction
 l Junction X is downstream of a choking point, stagnation properties cannot be calculated at junc-

tion

This caution only occurs at pressure type junctions (e.g., Assigned Pressure or Tank) when the model is 
run in the AFT Arrow Steady mode. When sonic choking occurs at a junction with a fixed pressure, there 
is no way to calculate a velocity downstream of the choke point. This means that it is not possible to 
determine static conditions if you have specified stagnation pressure at the junction, and vice versa.

For the variation stating that static properties cannot be calculated at the junction, all other results for the 
model are valid except for the static pressure, static temperature, and static enthalpy at the junction.
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For the variation stating that stagnation properties cannot be calculated at the junction, all other results 
for the model are valid except for the stagnation pressure and stagnation temperature at the junction. 
Stagnation enthalpy is conserved across the choke point, therefore, it is known at the junction.

Note that xStream does not model the dynamics of how the flow stream exits into the ambient conditions.

Maximum transient pipe Mach number significantly lower than 
estimate

A Caution message in AFT xStream

Full Message text is:

The maximum transient pipe Mach Number X was significantly lower than the estimate Y. Lowering the 
estimated maximum pipe Mach number may increase accuracy. The estimate must be set above the sim-
ulation maximum pipe Mach Number, a value of at least Z is recommended

This is a cautionary notice that the maximum transient Mach number in the pipes remained significantly 
below the Estimated Maximum Pipe Mach Number During Transient, which is defined in the Sectioning 
panel. Decreasing the estimated maximum Mach number may increase the accuracy and improve the 
run time. Note that if the estimated maximum Mach number is less than the maximum Mach number 
encountered during the simulation, the solution will become unstable, so the estimated maximum Mach 
number should not be defined to be less than the recommended value given in the caution.

Maximum transient pipe Mach number at least 0.2 higher than 
steady...

A Caution message in AFT xStream

Full Message text is:

The maximum transient pipe Mach number is at least X higher than the steady pipe mach number at the 
same location. If sectioning was determined from MOC steady results, the accuracy of the transient sim-
ulation may not be sufficient for higher flow periods. 

This is a cautionary notice that there was a large change in Mach number between the steady state and 
transient results. The sectioning for the model is chosen based on the steady state results, and will there-
fore produce the highest accuracy results for cases where the velocity is similar to the steady state velo-
city. The inaccuracy due to sectioning is discussed further in the Transient Result Accuracy topic.

It is recommended to run the model again with more sections to determine what effect the Mach number 
difference has on accuracy.

Pipe X length is shorter than the elevation change (between Junc-
tion Y and Z)

A Caution message in AFT xStream

Full Message text is:

Pipe X length shorter than the elevation change (between Junction Y and Junction Z).
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This caution alerts users to a possible inconsistency in their input. When this caution is shown, a pipe is 
defined with a length that is shorter than the elevation change between its connecting junctions. In this 
situation, pressure loss along the pipe due to friction is calculated using the pipe length the user has 
defined while static head loss is determined using the elevation change the user has defined.

Transient data did not extend to Stop Time at Junction X
A Caution message in AFT xStream

Full Message text is:

Transient data did not extend to Stop Time at Junction X. Final data point was used. 

The transient data at Junction X does not have time data that covers the entire time frame of the sim-
ulation as defined on the Simulation Mode/Duration panel of Analysis Setup. The final data point will be 
used for the remaining time steps of the simulation. You can enter additional time data points at Junction 
X to avoid this message.

Transient temperature was within 10 deg. F of fluid min-
imum/maximum

A Caution message in AFT xStream

Full Message Text

There are two variations of this Caution:

 l Transient temperature was within 10 deg. F of fluid minimum temperature at X seconds.
 l Transient temperature was within 10 deg. F of fluid maximum temperature at X seconds.

Explanation

The temperature at some point in the system approached the minimum/maximum temperature of the 
fluid according to the library data during the transient simulation. For an AFT Standard fluid or User 
Library Fluid, the max and min temperature for the fluid data can be seen by opening the Library menu, 
selecting Edit Fluids, selecting the fluid used in the model, and looking at the top of the Properties sec-
tion.

This Caution does not necessarily mean that fluid properties were calculated outside the valid range and 
that results are incorrect; however, the user should investigate accordingly. Some fluid properties may be 
extrapolated beyond the range of the available data points that were used for the polynomial curve fits or 
interpolated data. Fluid property calculations at these extremes will have higher uncertainty and may res-
ult in model convergence issues. In some cases this Caution may also mean that the saturation con-
ditions were reached, and may be displayed with an accompanying Warning about saturation.
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Required Action

The user should review the results to verify that saturation conditions were never reached. Flow must 
remain superheated at all times in the simulation (no two-phase flow or condensation) as stated in the 
engineering assumptions. A useful method of checking for condensation is to create various Transient 
Pipe graphs at different locations in the system and display the "Temperature Static" and "Temperature 
Saturation" parameters using the same units and axis range. Prime locations to check for saturation 
would be at the pipe inlets/outlets next to junctions like valves that have transient events. One of the 
graph parameters can be added as a secondary y-axis to create a stacked graph which overlays both 
series. Double click the empty box in front of the parameter name, or select the parameter row and click 
the right facing blue arrow above the parameters to indent it and make it a secondary y-axis. Then, verify 
that the Static Temperature does not drop below the Saturation Temperature for any time step.

If saturation conditions are never reached at any location throughout the entire transient simulation, then 
this Caution can be disregarded.

Transient temperature was within 10 deg. F of saturation
A Caution message in AFT xStream

Full Message Text

Transient temperature was within 10 deg. F of saturation temperature at X seconds.

Explanation

The temperature at some point in the system approached saturation conditions during the transient sim-
ulation. It does not necessarily mean that condensation occurred or that the results cannot be trusted; 
however, the user should investigate accordingly. Fluid property calculations close to saturation con-
ditions may result in model convergence issues.

Required Action

The user should review the results to verify that saturation conditions were never reached. Flow must 
remain superheated at all times in the simulation (no two-phase flow or condensation) as stated in the 
engineering assumptions. A useful method of checking for condensation is to create various Transient 
Pipe graphs at different locations in the system and display the "Temperature Static" and "Temperature 
Saturation" parameters using the same units and axis range. Prime locations to check for saturation 
would be at the pipe inlets/outlets next to junctions like valves that have transient events. One of the 
graph parameters can be added as a secondary y-axis to create a stacked graph which overlays both 
series. Double click the empty box in front of the parameter name, or select the parameter row and click 
the right facing blue arrow above the parameters to indent it and make it a secondary y-axis. Then, verify 
that the Static Temperature does not drop below the Saturation Temperature for any time step.
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If saturation conditions are never reached at any location throughout the entire transient simulation, then 
this Caution can be disregarded.

Information
An Information message is intended to make the user aware that an advanced feature is being used in 
the model, or to provide comments or suggestions relating to an advanced feature. Following sug-
gestions may achieve higher accuracy results if the right conditions apply, but can also cause incorrect 
results if not applied properly. If the user understands the feature then no action is required.

INFORMATION

Flow at the Following Junctions is Laminar
An Information message in AFT xStream

The flow at the listed Junctions is in a laminar regime. Further loss corrections may be necessary.

Pulsation peak-to-peak pressures are within allowable API 618 
levels

An Information message in AFT xStream

This informational message appears in AFT xStream when peak-to-peak pulsation pressures fall below 
the maximum allowable limits defined by the API 618 standard at all locations and all evaluated fre-
quencies. This message only appears when the PFA module is active, when the Frequency Analysis 
Mode is set to Steady State Pulsation, and the option Evaluate with API 618 is active in the Pulse Setup 
Panel.

Related Examples

Frequency Analysis - PFA Example             671

Related Topics

Defining Pulsation Settings 419
Pulse Setup Panel 100
The maximum peak-to-peak pressure limit defined in the API 618 standard has been 
exceeded at X locations 543
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Troubleshooting
This section discusses methods of troubleshooting models that are having difficulty converging. Topics 
include discussions of common issues, ideas to simplify overly complex models, and methods for adapt-
ing the solution methodology through either tolerance or flow relaxation.

Contents

Reducing Run Time 554

Transient Solver Errors 559

Diagnostics Window 561

Use the Model Data Window 562

Transfer Results to Initial Guesses 564

Poor Compressor Curve Fits 565

Troubleshooting Resistance Curves 565

Use the Output Window Sort Feature 566

Lower the Flow Rate Relaxation 566

Try Absolute Tolerance 567

Make Initial Flow Rate Guesses for Pipes 567

Change Boundary Conditions 567

Turn Off Parts of the Model 568

Break a Large Model Into Submodels 568

Use an AFT Standard Fluid 568

Run the MOC Steady Solution 568

Simplify Event Transients 569
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Limit Properties to Saturation Conditions 569

Enable Transient Debug Files 570

Identifying and Restoring Corrupted Model Files 570

Related Blogs

Having model convergence problems? Start here!

Reducing Run Time
The below topics discuss several common model configurations that can cause xStream model run times 
to be longer than expected. Select a topic below for information on why each configuration increases the 
run time, and suggestions on how each configuration can be avoided.

If one of the below configurations is detected by xStream and the run time is relatively long, xStream will 
present a message to the user showing which of the below configurations may be applicable.

Note that the configurations listed here as causing long run times may not be inaccurate for the system 
being modeled. However, they are all likely inefficient modeling choices for transient analysis - especially 
for preliminary iterations.

The configurations discussed below are not meant to capture every possible model configuration which 
can cause long model run times in xStream. Many other factors can also cause long run times. Following 
the suggestions listed below may help reduce run time in any model, though it may not be practical to 
implement the listed suggestions for all models.

Related Topics

Minimizing Run Time 40
Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

You Should Combine Your Pipes

The model has both very long and very short pipes
A model with both long and short pipes requires a larger number of pipe sections in order to perform cal-
culations. The more pipe sections in a model, the more computations the solver needs to perform, which 

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
https://www.aft.com/support/product-tips/analyzing-transients-faster-a-hacker-s-guide-to-pipe-sectioning
https://www.aft.com/support/product-tips/you-should-combine-your-pipes
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results in a longer run time.

How are short and long pipe lengths contributing to long run times?

To run a transient simulation, AFT xStream sections pipes to apply the Method of Characteristics. In any 
system there will be a single controlling pipe. The controlling pipe is the pipe with the fewest sections - by 
default, 10. AFT xStream uses the length of a section in the controlling pipe to divide all pipes in the 
model into sections and determine a uniform time step for the transient simulation.   

When a model has both very long and very short pipes, the short pipes determine the controlling pipe 
length, and the long pipes must be divided into many sections to properly apply the Method of Char-
acteristics. The run time is proportional to the square of the number of sections, meaning many sections 
in a model will often cause extremely long run times.

Consider a model that consists of two pipes: a very short pipe, such as 1 meter, and a very long pipe, 
such as 10,000 meters. The 1 meter pipe will be the controlling pipe with 10 sections, and the 10,000 
meter pipe must be broken into 100,000 sections. The model thus requires 100,010 sections in order to 
perform the calculations, which results in a long run time. Increasing the short pipe’s length artificially 
from 1 to 10 meters decreases the number of sections required by a factor of 10, reducing run time by a 
factor of 100. While the length increase may also increase the error in the short pipe, experience shows 
that the error is usually negligible in a liquid transient context.

What can the user do?

Several different approaches are available to reduce run time. These approaches can work in parallel, 
and it is up to the engineer to make appropriate judgments as to which is best for the model.

Consider modeling fittings and losses in pipes and combining multiple short pipes. In the Pipe 
Properties window, use the Fittings & Losses tab to add in fittings to the pipe instead of using junctions on 
the workspace. This is useful to account for pressure losses without modeling large numbers of elbows 
or similar fittings. For example, a user can add valves and bends to a pipe, and the solver will still apply 
the losses directly to the pipe during the calculations. By removing these junctions and combining pipes 
in the workspace, many short pipes between these fittings are eliminated. Reducing and combing short 
pipes reduces the number of sections in the model and the overall run time.

Consider adding artificial length to short pipes. Adding length to short pipes increases the length of 
the controlling pipe, which results in fewer sections for the other pipes in the model. Reducing the overall 
number of sections in the model improves run time. Using pipe lengths that are common multiples, such 
as 5 feet, 10 feet, 15 feet, etc. provides improved sectioning since short pipes can be perfectly divided 
into longer pipes.

Related Topics

Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60
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Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The model has many pipes that can be combined
Users often model losses in AFT xStream  using junctions with no transient behavior, such as a bend, 
static valve, or orifice, between two pipes of identical diameter. While this may help show where these 
losses are occurring in the overall pipe system, it can result in extra pipes which can have a detrimental 
effect on pipe sectioning and run time. Combining pipes and modeling the losses within the pipe itself can 
improve sectioning and run time while maintaining accuracy.

How are pipes that can be combined contributing to long run times?

To run a transient simulation, AFT xStream sections pipes to apply the Method of Characteristics. In any 
system there will be a single controlling pipe. The controlling pipe is the pipe with the fewest sections - by 
default, 10. AFT xStream uses the length of a section in the controlling pipe to divide all pipes in the 
model into sections and determine a uniform time step for the transient simulation.   

Each pipe in a model must be sectioned individually, meaning section count must increase with pipe 
count. The run time is proportional to the square of the number of sections, meaning many sections in a 
model will often cause extremely long run times. Reducing the number of pipes in a model is often an 
effective way to reduce run time.

Consider a model that includes a pipeline that is 100 meters long, and has 9 bends in it. If those 9 bends 
are modeled as unique junctions, the pipeline must be modeled as 10 individual pipes. Each pipe has 10 
sections by default, meaning the pipeline will have 100 sections. If the pipeline is modeled as a single 
pipe, and the 9 bends are modeled as additional pipe friction using  the Fittings & Losses tab in the Pipe 
Properties window, the number of sections in the pipeline could be reduced by a factor of 10, in turn redu-
cing the run time by a factor of 100.

What can the user do?

The Fittings & Losses tab in the Pipe Properties window can be used to add losses directly to pipes to 
replace individual junctions on the workspace. This process can be done manually, or automatically 
using the Join Selected Pipes/Jcts tool in AFT xStream.

Select the pipes to be combined and the junctions between those pipes on the Workspace, and choose 
the Join Pipes/Junctions from the Edit menu. This option will combine the selected pipes into one pipe, 
add the losses from the junctions into the Fittings & Losses tab.

Related Topics

Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60

https://www.aft.com/support/product-tips/analyzing-transients-faster-a-hacker-s-guide-to-pipe-sectioning


Troubleshooting

- 557 -

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

You Should Combine Your Pipes

The model has an unusually short pipe
A model with a very short pipe requires a larger number of pipe sections in order to perform calculations. 
The more pipe sections in a model, the more computations there are that need to be performed, which 
results in a longer run time.

How are pipe lengths contributing to long run times?

To run a transient simulation, AFT xStream sections pipes to apply the Method of Characteristics. In any 
system there will be a single controlling pipe. The controlling pipe is the pipe with the fewest sections - by 
default, 10. AFT xStream uses the length of a section in the controlling pipe to divide all pipes in the 
model into sections and determine a uniform time step for the transient simulation.   

When the controlling pipe is unusually short, the other pipes in the model must be divided into many sec-
tions to apply the Method of Characteristics.  The run time is proportional to the square of the number of 
sections, meaning many sections in a model will often cause extremely long run times.

Consider a model that has one 0.05 ft long pipe and 100 pipes that are each 10 ft long. Each 10 ft pipe 
would require 200 sections, requiring 20,000 sections overall. Modeling the very short pipe as 0.1 ft 
would reduce the number of sections by a factor of 2, which would potentially decrease the run time by a 
factor of 4. Alternatively if the very short pipe is not considered in the sectioning by combining the pipes, 
then the controlling pipe length would become 10 ft. With one section in each pipe this would decrease 
the number of sections from 20,000 to 100, decreasing the run time by a factor of 40,000.

What can the user do?

There are several different approaches to reduce run time. These approaches can work in parallel, and it 
is up to the engineer to make appropriate judgments as to which approach is best for the model. 

Consider modeling fittings and losses in pipes and combining multiple short pipes. In the Pipe 
Properties window, use the Fittings & Losses tab to add in fittings to the pipe instead of using junctions on 
the workspace. This is useful to account for pressure losses without modeling large numbers of elbows 
or similar fittings. For example, a user can add valves and bends to a pipe, and the solver will still apply 
the losses directly to the pipe during the calculations. By removing these junctions and combining pipes 
in the workspace, many short pipes between these fittings are eliminated. Reducing and combing short 
pipes reduces the number of sections in the model and the overall run time.

Consider adding artificial length to short pipes. Adding length to short pipes increases the length of 
the controlling pipe, which results in fewer sections for the other pipes in the model. Reducing the overall 
number of sections in the model improves run time. Using pipe lengths that are common multiples, such 
as 5 feet, 10 feet, 15 feet, etc. provides improved sectioning since short pipes can be perfectly divided 
into longer pipes.

https://www.aft.com/support/product-tips/analyzing-transients-faster-a-hacker-s-guide-to-pipe-sectioning
https://www.aft.com/support/product-tips/you-should-combine-your-pipes
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Related Topics

Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The simulation has a large number of time steps
A model with a large number of time steps will require a large number of calculations. The more cal-
culations that need to be performed, the longer the run time.

How are the time steps contributing to long run times?

xStream sections pipe to apply the Method of Characteristics solution method. The Method of Char-
acteristics requires a uniform time step to be used for all pipes in the model, which is determined during 
the sectioning process using the section length and the sonic velocity in the gas. On average the sonic 
velocity is typically on the magnitude of 103, producing a time step on the magnitude of 10-3.   

A time step of 0.001 seconds means that a transient simulation of 1 minute will have 60,000 total time 
steps. Similarly, a transient simulation of 1 hour will have 3.6 million time steps. Run time is roughly pro-
portional to the number of time steps, and models with large numbers of time steps will generally have 
long run times. In addition, models with higher wave velocity may require shorter time steps, increasing 
the number of time steps required.  

What can the user do?

There are several different approaches to reduce run time when the number of time steps is larger than 
expected.

Consider reducing the simulation duration. The simulation duration is defined on the Simulation Dur-
ation panel. For a simple system, the full effect of the transient response occurs over twice the com-
munication time, where the communication time is the time it takes a pressure wave to travel the length of 
the system and back (length of system / wave velocity). Determining the communication time can 
become more complex for systems with branching paths or major reflection points in the path. However, 
limiting the simulation duration to 2 times the communication time may be a good starting point. If mul-
tiple transient events occur the simulation duration should be extended to end after the transient 
response has completed for the last transient event.

In addition, for a piping network attached to a very long pipe it may not be necessary to include the length 
of the very long pipe in the communication time calculation. Use your engineering judgement on whether 
the reflections from the pipeline will be important to consider.

https://www.aft.com/support/product-tips/analyzing-transients-faster-a-hacker-s-guide-to-pipe-sectioning
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Consider lengthening the controlling pipe. The controlling pipe length is used to determine the time 
step for the simulation, setting the time step equal to the section length divided by twice the sonic velo-
city. Artificially lengthening the controlling pipe means the time step for the simulation can be longer, and 
fewer time steps are required for the simulation. 

Consider decreasing the Minimum Number of Sections per Pipe. The length of the time step is 
determined by the length of the computational stations. If the minimum number of stations per pipe is 
large, then shorter sections and shorter time steps will be required. Note that decreasing the number of 
sections will decrease the accuracy of the solution. A sensitivity analysis is recommended to determine 
the effect of decreasing the number of sections on accuracy, see the Transient Sensitivity Analysis 
Tutorial.

Related Topics

Transient Result Accuracy 58
Transient Sensitivity Analysis Tutorial 60

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

Transient Solver Errors
A transient solver error will be shown during the transient solution if xStream encounters a calculation 
error which would invalidate the calculation results for the rest of the transient. Transient solver errors 
halt the transient solution and must be resolved for the full simulation to be run.

The below topics offer descriptions of the more common solver errors and tips for common resolutions. 
Reach out to AFT Support for further assistance.

TRANSIENT SOLVER ERRORS            

General error occurred during the transient calculations
A Transient Solver Error in AFT xStream

Full Message text is:

Error occurred while running Transient Solver. General error occurred during the transient calculations.

 

This solver error can be caused by any number of discrepancies. It is recommended to generate a Tran-
sient Debug File to get more information on the solution leading up to the iteration error. It may also help 
to increase the minimum number of sections defined on the Sectioning panel.

Contact AFT Support for additional help if needed.

https://www.aft.com/support/product-tips/analyzing-transients-faster-a-hacker-s-guide-to-pipe-sectioning
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Junction iteration problem
A Transient Solver Error in AFT xStream

Full Message text is:

Error occurred while running Transient Solver. [Junction] iteration problem.

 

An iteration error for junctions such as the branch junction can occur if the flow or pressure iterations at 
that point exceed the maximum iterations. It is recommended to generate a Transient Debug File to get 
more information on the solution leading up to the iteration error. It may also help to increase the min-
imum number of sections defined on the Sectioning panel.

Contact AFT Support for additional help if needed.

Possible supersonic flow detected at the connection of Junction X 
and Pipe Y

A Transient Solver Error in AFT xStream

Full Message text is:

Possible supersonic flow detected at the connection of Junction X and Pipe Y. Modeling of supersonic 
conditions is not supported and the solver was halted.

 

xStream assumes that the flow is one dimensional and does not become supersonic during the transient. 
In reality there are situations that could cause supersonic flow to develop behind a shockwave. In addi-
tion there could be multidimensional shocks in a real system which are not captured in a one-dimensional 
solution. xStream will halt the transient if the calculated Mach number exceeds one to prevent inaccurate 
results from being displayed to the user.

If this error message is shown for a system that should not experience supersonic flow it is recom-
mended to verify the model inputs are correct, consider adjusting the junction transient events, and poten-
tially increase the minimum number of sections per pipe. Supersonic flow is more likely to occur when 
there is a high pressure differential across a junction during the steady state, when a transient event 
occurs rapidly, and/or when the section length is relatively large in a pipe.

The configuration which most commonly causes this transient solver error is  a valve with a large pres-
sure differential across it that opens rapidly in the transient.

User Specified AFT Arrow to Resolved allowable mismatch was 
exceeded

A Transient Solver Error in AFT xStream

Full Message text is:

Error occurred while running Transient Solver. A user specified AFT Arrow to Resolved allowable mis-
match was exceeded.
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This solver error indicates that one of the allowable mismatch values defined in the Transient Solver Ini-
tialization panel was exceeded. For an explanation of how the allowable mismatch values are applied 
and the transient solver initialization process please reference the discussion in the Transient Solver Ini-
tialization panel topic.

xStream prints a summary of the comparison between the AFT Arrow Steady and Resolved solutions in 
the Solution Progress window, which can be used to determine what parameters were violated. For 
example, see Figure 1 below which shows a model that met the velocity criteria, but did not meet the 
applied temperature criteria.

Figure 1: The bottom of the Solution Progress window provides additional information on the results of the 
artificial transient resolution period

To resolve a mismatch between the AFT Arrow Steady and Resolved solutions it is recommended to re-
evaluate the initial conditions selected for the model to remove inconsistent inputs.

For instance, in the model used for Figure 1 there was an inlet tank defined at 300 deg. F. Pipe P1 con-
nected to the inlet tank was defined to use convective heat transfer with the atmospheric temperature set 
at 70 deg. F. There was no flow in the pipe initially, so the pipe was fixed at the atmospheric temperature 
(70 deg. F) for the AFT Arrow Steady solution. During the artificial transient resolution process the pipe 
temperature was allowed to vary and increased to about 300 deg. F due to the tank temperature, creating 
a mismatch between the AFT Arrow Steady and Resolved solution temperatures in the pipe.

The error message in the example model was resolved by using the Temperature Override for Zero Flow 
option in the Pipe Properties window to set the pipe's temperature equal to the tank temperature during 
the AFT Arrow Steady solution.

Diagnostics Window
The Model Diagnostics Window is intended to help users check on a number of settings that may have 
been changed during the model-building process and that may affect the model results.             

The Model Diagnostics window can be accessed from the Tools menu.             

When the Model Diagnostics Window is opened all input will be checked, and the results will be dis-
played in a tabular format. Items of note will be highlighted based on the impact each identified item may 
have on the results. It should be noted that not all items identified by this window will have a neg-
ative impact on results. Rather, the identified items are settings that have frequently been incorrectly 
applied by other users. This is not an exhaustive list of troubleshooting items, though the most common 
issues are all included.             
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Data in the Model Diagnostics is organized by the Data Source, which is the window where that set-
ting/input is defined. Any item that may negatively impact the model will be highlighted based on its poten-
tial to affect the model, as shown in the Potential Impact column. For pipe and junction diagnostic items, 
the pipe(s)/junction(s) that were identified will be listed below the diagnostic item. For an example, see 
Figure 1 below. The Diagnostic window indicates that multiple pipes  have unusual pipe dimensions, and 
should be reviewed.             

Figure 1: Example of the Model Diagnostics window. For this example, potential issues have been flagged in 
the pipe dimensions.             

Related Blogs

AFT Responds to 2020 Customer Survey Feedback

Use the Model Data Window
The Model Data window is a powerful tool for reviewing and documenting model inputs, along with find-
ing input errors in a model.             

Look at the model in Figure 1. If an input error in one of the pipes was suspected, the task of looking for 
the error in each individual pipe input window would be tedious.             

Now look at the Model Data window for the pipes in Figure 2. Here it is much easier to scan down 
columns of data looking for input errors. In this case, one of the pipe lengths was accidentally entered in 
miles rather than feet.             

https://www.aft.com/support/product-tips/aft-responds-to-2020-customer-survey-responses
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Figure 1: Workspace layout of a pipe system with an input error in one of the pipes (error not shown).
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Figure 2: Model Data window display for the model in Figure 1. From this perspective it is much easier to see 
that one of the pipes (#2) has length data entered in miles rather than feet. This is not automatically an input 
error, as AFT xStream accepts pipe input with mixed engineering units. However, more frequently than not 

the user intends to use consistent units, so this probably is an error.

Related Blogs

Having model convergence problems? Start here!

Transfer Results to Initial Guesses
AFT xStream’s iterative steady-state solver takes initial guesses (also called initial conditions) and 
applies the principles of mass and momentum balance to improve the guesses. This is called iteration. It 
continues to refine the solutions until agreement with the governing equations is obtained.    

After a converged steady-state answer is obtained, you can choose to take these results and use them 
as the initial guesses for a subsequent run. Using those results as initial guesses can lead to faster con-
vergence in subsequent steady-state runs, as the solver can start at or very close to the actual solution.             

Note: This will not increase the speed of the transient solution progress.             

https://www.aft.com/support/product-tips/common-convergence-tips-tricks


Troubleshooting

- 565 -

This feature is called Transfer Results to Initial Guess, and it is on the Output window, Edit menu and tool-
bar.

Poor Compressor Curve Fits
The Compressor/Fan Properties window allows curve fits of compressor/fan data up to fourth order. 
Depending on the data points entered, compressor/fan curves fits similar to the orange or blue curves in 
Figure 1 below are possible.             

AFT xStream can only work with the data the user inputs, and will use flow rates on the orange curve past 
the inflection point around 80 as acceptable operating points, which can lead to unusual results or non-
convergence. Users should always ensure that their compressor/fan curves cross the flow rate axis as 
shown in the blue curve in Figure 1.             

AFT xStream will attempt to warn the user when a model containing a poor compressor/fan curve fit  is 
run. The user can choose to run the model with this curve fit anyways, but they should take care that the 
compressor/fan is operating in a region of the curve fit that matches physical expectations, such as the 
area to the left of the inflection point on the orange curve.              

Figure 1: A good compressor/fan performance curve fit in blue and a poor compressor/fan performance 
curve fit in orange. All compressor/fan curve fits should include sufficient data such that the curve crosses 

the zero pressure rise axis as shown in the blue curve.             

Troubleshooting Resistance Curves
Common issues with resistance curves include curves where losses do not increase with flow, and 
curves with a non-zero loss at zero flow. Figure 1 below shows examples of curves with potential issues 
compared to a correctly defined curve.
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Figure 1: Example resistance curves showing correct and incorrect curve types

These common issues create two potential problems in a model:

 1. If the system sees a constant pressure drop even at low flowrates, the iterative Solver can 
encounter difficulty converging on a solution since the system flow and pressure drop are no 
longer dependent on each other.

 2. Real equipment in a system will typically cause a higher pressure drop at larger flowrates, and will 
not provide any loss to the system at zero flow. Users should capture a single known pressure 
loss data point by defining a curve which passes through two points: the known pressure drop at 
the tested flowrate, and zero pressure drop at zero flow. The Resistance Curve topic gives more 
information on defining this type of curve.

Related Topics

Resistance Curve Loss Model 223
General Component 272

Use the Output Window Sort Feature
If a model runs but the results look incorrect, use the Sort feature on the toolbar in the Output Window to 
look for extremes in velocity, pressure drop or other parameters. An input error (like incorrect diameter) 
may be easier to see by looking at its effect on the results.    

Lower the Flow Rate Relaxation
The AFT Arrow Steady Solution Panel allows users to change multiple parameters, including the numer-
ical relaxation parameter for both flow rate and pressure. 
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By default, an automatic relaxation is selected, and the relaxation will be enabled when AFT xStream 
detects the AFT Arrow Solution is getting stuck. 

The user can also set this relaxation to a fixed value which is then applied for every iteration. Values of 
0.5 or 1.0 are recommended for pressure relaxation, while values of 0.05 or 0.1 are recommended for 
flow rate relaxation. 

Related Blogs

Having model convergence problems? Start here!

Try Absolute Tolerance
Most models converge reliably with relative tolerances, which is the default in AFT xStream’s AFT Arrow 
Steady Solution panel. However, some models converge better with absolute tolerance. This situation 
usually means there is at least one element of the model that is close to the real answer in absolute terms 
but does not lock in on a relative (percentage) basis, likely due to a small-magnitude value for pressure or 
flow.             

If a model will not converge with relative tolerance, try changing to absolute tolerance. Even better, try 
the option to converge on either absolute or relative, which will offer the most flexibility.    

Related Blogs

Having model convergence problems? Start here!

Make Initial Flow Rate Guesses for Pipes
As an iterative solver, AFT xStream needs initial guesses to start the AFT Arrow Steady Solution pro-
cess. xStream will make default initial guesses automatically. On occasion the AFT xStream guesses are 
far away from reality. For some models providing an  initial guess for all the pipe flow rates in the system 
can help the model converge for the steady state.             

User-defined initial guesses can be as simple as selecting all the pipes and initializing all of them to 1 
lbm/sec, even though some operate at 0.1 lbm/sec and others at 10 lbm/sec. Note that initial guesses 
that are too far from the final solution can also interfere further with convergence.    

Related Topics

Optional Input for Pipes 203

Change Boundary Conditions
Changing the boundary pressures or flow rates can provide insight into what is giving the model trouble. 

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
https://www.aft.com/support/product-tips/common-convergence-tips-tricks
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For example, obtaining convergence only within a certain range of flowrates could indicate an issue with 
curve fit data being unrealistic outside of that range of flowrates.    

Turn Off Parts of the Model
Using the Special Conditions feature, users can turn off elements in your model and in effect shutdown 
entire sections. If the model runs when certain sections are closed, this could indicate a problem with one 
of the components in the closed section.    

Break a Large Model Into Submodels
AFT xStream provides convenient features for deleting parts of your model and merging parts back in. A 
section of your model can be quickly deleted by selecting it on the Workspace and choosing Delete from 
the Edit menu. If the section is instead Cut, it can be Pasted into a new model of its own for testing or hold-
ing. At a later time the removed sections can be added back in to the current model by using the Merge 
feature on the File menu.    

The advantage of breaking your model into sub-models is that you can investigate the convergence char-
acteristics of each part of your model independently. If you can get each sub-model to converge, you 
should be able to get the original model to converge also. If one of your sub-models will not converge, it is 
doubtful your original model will converge either.    

Use an AFT Standard Fluid
AFT xStream offers multiple fluid databases for users to choose from in the Fluids panel of the Analysis 
Setup window. Each database has benefits and drawbacks.     

If the model is defined using the ASME Steam, Chempak, or NIST REFPROP databases and is exper-
iencing convergence problems, the user should simplify the model by choosing a fluid from the AFT 
Standard fluid database. The fluid models used for this database are simplified from those in the other 
databases, and often allow AFT xStream to find a solution more easily.     

Once the user has a model that runs well using an AFT Standard fluid, they can return to the more com-
plex fluid databases. 

It should also be noted that users are strongly encouraged to only use AFT Standard fluids in their AFT 
xStream model. The increased accuracy of other models is almost always outweighed by the increased 
run time associated with the more complex fluids. 

Related Topics

Fluid Panel 84

Run the MOC Steady Solution
AFT xStream has three different Simulation Modes: AFT Arrow Steady, MOC Steady, and MOC Tran-
sient. By default, only the AFT Arrow Steady and MOC Transient solutions are available. The user can 
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access the MOC Steady Simulation Mode by enabling Advanced Options in the Analysis Setup window. 

The MOC Steady Solution is what xStream uses to move between the AFT Arrow Steady solution and 
the start of the MOC Transient Solution. Stopping the simulation after the MOC Steady Solution is 
obtained can help the user understand how the AFT Arrow Steady Solution is adjusted before the tran-
sient simulation starts. Occasionally, issues can arise during this process which need to be addressed 
prior to a successful MOC Transient simulation. 

Related Topics

AFT Arrow Steady Solution Group 117
Transient Solver Initialization Panel 111

Simplify Event Transients
On occasion, the transient events defined for an AFT xStream model can lead to issues in the transient 
simulation. The user can use Special Conditions to ignore individual transients, re-run the simulation, 
and check to see if the issue persists. This troubleshooting tactic can be especially useful when dealing 
with check valves or control valves in the model.    

Limit Properties to Saturation Conditions
AFT xStream is a single-phase tool, operating under the assumption that the fluid is always in the gas/va-
por phase. When saturation is reached, xStream will attempt to extrapolate gas properties past the sat-
uration conditions. In some situations, this approach is successful, and the transient simulation can 
proceed. However, in other situations, the MOC Transient solution will fail as it attempts to extrapolate 
gas properties. In this situation, it can be helpful to limit property calculations to saturation conditions and 
not allow xStream to extrapolate properties.     

The user can limit properties to saturation conditions in the Advanced Transient Parameters panel of the 
Analysis Setup window after checking the Show Advanced Options box in the lower left corner of the win-
dow.     

This setting can also be useful outside of troubleshooting situations. When limited amounts of transient 
condensation is seen, it is unlikely that a full phase change will occur, meaning the temperature and pres-
sure will be constant at the saturation conditions. Thus, in some situations, it may be more accurate to 
limit properties to saturation conditions if the system only briefly reaches saturation during a transient sim-
ulation. 

Related Topics

Transient Solver Advanced Parameters 152
Fluid Panel 84
Engineering Assumptions 18

Related Examples
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Fluid Library Comparison - Steam Turbine Shutdown Example 639

Enable Transient Debug Files
AFT xStream has the ability to write out Debug files containing useful information about events that hap-
pen during a transient simulation. xStream will write out information about the MOC Steady Solution pro-
cess and information about any errors it encounters during a transient simulation. 

The user can enable transient debug files in the Advanced Transient Parameters panel of the Analysis 
Setup window after checking the Show Advanced Options box in the lower left corner of the window. 

Once the user has checked the Create Transient Debug File option, xStream will save a Transient Debug 
file each time a scenario is run in an xStream model. The user can view the information written to invest-
igate the issue themselves, or work with AFT's support team to resolve the issue. In the event that a user 
requests support from AFT but cannot send a model file, the AFT Support team will likely ask the user to 
generate this file.  

Identifying and Restoring Corrupted Model Files
The most common way to tell if a model file is "corrupted" is an error message that says "An error 
occurred reading the file into AFT xStream. Can't find [TOOLBOX PREFERENCES] heading."

You may see multiple of these messages after pressing OK, and the part between the brackets [ ] may 
say something else each time. This is indicating that the software is trying to read different sections of the 
file, and it is finding that there is either no data, or corrupted data. It is then showing you an error for each 
section of the file that the software tries to read when loading the model, similar to Figure 1.

Figure 1: Error message indicating that some portion of the model file cannot be found

Another indicator is if the model's file size has been reduced to 0 or 1 KB. This indicates the data inside 
the file has been lost. This can be seen in the file size in the Windows File Explorer (Figure 2).
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Figure 2: Very low file sizes can be an indication of model file corruption

What are the backup files (.bak extensions)?

AFT software will automatically generate backup versions of your model file each time you save. By 
default, these files will be located in the same directory where you have saved your model. These files 
have a specific naming convention, but generally the file extension will start with "*.bak" and end with 
three numbers. Newer versions of AFT software will have a fourth letter after the .bak, and it signifies 
which application the backup is for.

 l AFT Fathom.bakF-001
 l AFT Arrow.bakA-001
 l AFT Impulse.bakI-001
 l AFT xStream.bakX-001

The numbers signify previous versions of the model, with the 001 extension being the most recent 
backup. Of course, if your current model file is corrupted and you need to restore a backup, the 001 
backup won't contain the most recent updates you made to the model, but it will be better than losing 
everything! The backups named 002 and 003 are the second and third most recent backups, respect-
ively. Generally, you won't need to use these files unless you want to revert to even earlier state of the 
model file, or there is an issue with the 001 backup.

When you save a model file, the application will copy the previous version of the file into .bak001, the pre-
vious .bak001 will be copied into .bak002, and so on, creating a cascading effect. This way .bak001 is 
always the most up to date backup version of the model.

How to Restore a Backup File

 1. Close the AFT application if it is still open.
 2. In the same location as your model file, locate the file with the extension *.bak-001.
 3. Create a copy of *.bak-001. This is useful in case something goes wrong, and you need to try 

again.
 4. Rename the copied file and change the file extension to the appropriate application file extension 

below. Windows will prompt you to confirm the extension change; click Yes.
 l Fathom: *.fth
 l Arrow: *.aro
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 l Impulse: *.imp
 l xStream: *.xtr

 5. Try opening the restored file. If this didn't solve the problem, you can try the same steps with an 
earlier backup file, using .bak-002 or .bak-003 if they exist. However, note that doing so will revert 
even more changes because these are even earlier versions of the model from multiple saves 
prior.

Figure 3: The newest backup file, identifiable by file extension numbering and date modified

Figure 4: Changing file name extension to restore the backup file

Tips to Prevent File Corruption

The best way to prevent file corruption is to open, edit, and save the file locally on your PC. It is not recom-
mended to edit and save files directly to a shared server, network drive, or cloud storage platform like 
Dropbox or OneDrive.

If the connection to the network location is interrupted or cuts out while saving the model file, it could cor-
rupt the file or cause data loss. This can be especially common on VPNs. If you need to have the file in a 
shared location for colleagues to access, it is recommended that you download the file to your local PC, 
edit/save the file locally on your machine, then upload the file afterwards.

Customize Your User Settings Related to Backups

By default, only a maximum of three backups will be kept at a time. If desired, you can change this num-
ber in Number of Backup Files Created, which can be accessed in User Options as shown in Figure 5. 
Here, you can also choose to check the box that will automatically save your model in a specified time 
interval.
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Figure 5: The number of backup files created and options to save automatically can be customized in User 
Options
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Technical Support
This section focuses on the technical support options for AFT Products. Topics include descriptions of 
the various support options, contact information for the AFT Support team, and links to external sites to 
assist with installation issues related to AFT xStream.   
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Related Blogs

Having model convergence problems? Start here!

Technical Support Options

Support, Upgrade, and Maintenance (SUM)

This primary level of support is for assistance with specific features within the software, or resolving 
issues with a model such as difficult to converge models. AFT is limited in the ability to interpret model 
results and cannot recommend specific changes in a system.

One full year of SUM is provided with the purchase of a full license. Leases have SUM coverage during 
the period of the lease. Further support after the first year requires SUM renewal.

For technical support questions falling in this category, contact AFT.

https://www.aft.com/support/product-tips/common-convergence-tips-tricks
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Flow Expert Package (FEP)

The FEP is a higher level of consulting assistance for a particular project. This service will assign a qual-
ified AFT engineer to assist in not only modeling your system, but also with providing operational sug-
gestions and interpretation of results.

The intention of this service is to provide assistance to active users of AFT software and address ques-
tions on the appropriate use of the software for specific system requirements.

Please visit our website at: https://www.aft.com/products/aft-flow-expert-package for more information 
on our FEP services.

Flow Modeling Consulting Services

AFT's sister company, Purple Mountain Technology Group (PMTG), provides comprehensive consulting 
services utilizing experienced consulting engineers and AFT tools. PMTG offers a solution to a wide vari-
ety of system analysis by building and investigating the models and providing direction on system 
changes and appropriate operation. Visit PMTG on the web: https://www.pmtechgroup.com/, or call at 
(719) 687-9145 for more information.

Contacting AFT
 l Telephone - (719) 686-1000                     
 l Fax - (719) 686-1001                     
 l Online - https://www.aft.com/ download the latest maintenance releases, find out what is hap-

pening at AFT, and get all the latest information.      
 l E-mail Support - support@aft.com
 l Mail - 2955 Professional Place (Suite 301), Colorado Springs, CO 80904, USA      

Information on Software Installation
For information on Local and Server installations of AFT software, please visit our website at 
https://www.aft.com/support/installation. 

For answers to frequently asked licensing questions, please visit our eLicense or USB Key FAQ pages.   

Chempak Database Installation
AFT xStream does not include the Chempak Database by default. The Chempak Database is a separate 
product that must be downloaded and installed as an addition to AFT xStream.

https://www.aft.com/products/aft-flow-expert-package
https://www.pmtechgroup.com/
https://www.aft.com/
mailto:support@aft.com
https://www.aft.com/support/installation
https://docs.aft.com/aftdocumentation/eLicenseFAQs.htm
https://docs.aft.com/aftdocumentation/USBKeyFAQs.htm
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Database File Location

The Chempak Database is installed in C:\AFT Products\Chempak Data\ by default. If both AFT 
xStream and Chempak Database are installed to their default locations, no further configuration is neces-
sary. However, if AFT xStream or the Chempak Database are not installed in a default location, AFT 
xStream will need to know where to look for the Chempak Database. This is specified in the control.aft 
file, located in the same folder as xStream.exe. If the files cannot be found the following message is dis-
played:

Figure 1: Error message when Chempak data cannot be found in default location

Control.aft can be edited with a text editor, and by default looks like:

Figure 2: Default control.aft file

If the Chempak Database was installed to a location other than the default, the line "ChempakDataPath = 
" will need to be edited to include the directory it was installed to. For example: "ChempakDataPath = 
C:\My AFT Files\Chempak Data"

Upgrading Chempak Database Version

If you had Chempak installed with other AFT products, you may receive a message that the library is out-
dated.
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Figure 3: Outdated Chempak data

To fix this issue, download the newest version of the Chempak Database from the AFT website. Be sure 
to install to the same location as the existing Chempak Database, and double check the control.aft file if 
necessary.

Output Files
Numerical results and output from the Solver are saved in Output Files (*.out file extension). Output Files 
are stored in the same location as the model file, and a unique file will exist for each scenario that is run, 
differentiated by numbers appended to the file name. The General section of the Output window will list 
which Output File is used for the current scenario.

The Output File will only remain on disk if the model file is saved after it has been run.

Changing various input data parameters for the model will invalidate the previous results, and a prompt 
will appear stating: "This action will clear all results and delete the output file for the current scenario and 
any children. Do you want to continue the action?"

Renaming the model file in the Windows File Explorer will unlink the model file from any existing Output 
Files. Instead, open the model file and choose File > Save As which will rename and copy all Output 
Files. Alternatively, the Save Scenario to File options can be used from the Scenario Manager.

The file size will be heavily dictated by the simulation duration and amount of time steps saved as spe-
cified on the Simulation Duration panel in Analysis Setup. The Sectioning Panel will also have an impact 
and will increase the file size if the Output Pipe Stations are set to All Stations.

Updated Fluids Library
If the data in a shared fluid library is changed outside of the model you are opening, the following inform-
ational message will appear when opening the file:

The following fluid(s) used in the scenario have different property data than what is currently in the lib-
rary:

https://www.aft.com/downloads/current-versions/aft-chempak
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Figure 1: Update Fluids dialog window which appears if the fluid properties for the model have changed 
since it was last opened

This message is shown because the model is defined with a custom fluid in the Fluid Library and the cus-
tom fluid was modified outside of this model. If the fluid was changed in error, then choose the "Keep 
using the fluids defined in the scenario" option or cancel loading the model and change the fluid. If the 
changes were intended then update the fluid data used in the model using the "Change to Base Scenario 
and update..." option.

Special File Control Features

What Is the Control.aft File?

Conrol.aft is read as AFT xStream begins to load and instructs AFT xStream where certain key files and 
copy protection tokens are located. Typically there is little need to change the settings, however this file 
can be used to override the internal defaults and customize your working environment.

Control.aft is typically located in the application folder. However, on networks, it may be necessary to loc-
ate it in the Windows\System folder of each client. If AFT xStream finds the file in the Windows\System 
folder it will use it and ignore any file in the application folder.

Control.aft can be edited using any text-based editor. Notepad, supplied as part of the Windows install-
ation, is a good choice. Be careful to avoid changing any of the headings or key words. If these are 
changed AFT xStream will not find the important data.

Specifying Where Chempak is Located

Before AFT xStream can use the Chempak Fluid Database it needs to know where both the data is loc-
ated. These paths are specified in the control.aft file.
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When Chempak is installed the setup procedure automatically updates any control.aft file specified with 
the path to the data.

You can manually edit the file by opening it in Notepad (or any text editor) and adding the following line to 
the [SEARCH PATHS] section (replace C:\AFT Products\Chempak Data with the path information based 
on your system):

ChempakDataPath = C:\AFT Products\Chempak Data

This will instruct AFT xStream to look in the C:\AFT Products\Chempak Data directory for the data.

Also see Chempak Data Location.    

Converting Models from Earlier Versions
Models from earlier versions of AFT xStream can be used with this version. In most cases, the model file 
can be opened in the newer version and automatically converted to the updated format. It is considered 
good practice to do a complete check on the model to ensure the conversion process was complete and 
accurate. In some cases, especially with older models (two or more versions behind), the automatic con-
version is not successful. If this occurs, please contact our support team with a copy of the original model 
file.

Other files such as libraries (previously called "databases") or preference files can also be converted.

The Workspace Layers Import Assistant can be used for models created in versions prior to the exist-
ence of Workspace Layers. This tool allows views from Visual Report (which is now deprecated) and cus-
tomized Workspace appearance to be preserved.
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Examples

Walk-Through Examples
The AFT xStream Walk-Through Examples are designed to get new users trained to use AFT xStream 
correctly in the shortest amount of time. If you are using AFT xStream for the first time, start with the 
Beginner - Tank Blowdown example because it offers an in-depth explanation of how to use 
AFT xStream. Otherwise, choose an example from the table below that you wish to learn more about.

Completed versions of the example model files are included with the default installation: C:\AFT Product-
s\AFT xStream 3\Examples

Example Fluid Pipes Description

Beginner - Tank Blowdown Nitrogen 2

An in depth discussion of model building in 
AFT xStream and a basic overview of the soft-
ware interface and Primary Windows. Models 

a simple valve opening during a tank blow-
down.

Gas Turbine Fuel System Methane 11

A compressor is passing natural gas through 
a heat exchanger before being used in the 

combustion baskets of a turbine system. This 
example evaluates the effect  the sudden clos-

ure of one of the 3 control valves has on the 
temperature of the system. The effect of the 
Minimum Number of Sections per Pipe para-

meter is also shown.

Fluid Library Comparison - 
Steam Turbine Shutdown Steam 12

Two turbines in a high pressure steam system 
are simultaneously shut off as a bypass line 
valve is opened. This model demonstrates 

factors to know to evaluate which fluid library 
to use in your system, as well as demon-

strating how to construct a model in the iso-
metric drawing mode.

Pipe Forces from Turbine 
Shutdown Steam 14

Two turbines in a high pressure steam system 
are simultaneously shut off. This model 
demonstrates the transient forces of the 

steam within the system as well as the effect 
that the transient duration has on these 

forces. Finally, this example shows how to 
export the force file once the forces are 

obtained.

PFA Add-on Module - Fre-
quency Analysis Methane 5

A frequency analysis is performed on a sys-
tem with a positive displacement compressor 
to determine the acoustical frequencies for 
the existing piping configuration using the 

Pulsation Frequency Analysis (PFA) Module.
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Beginner - Tank Blowdown Example (Metric Units)

Summary

This example will give you the big picture of AFT xStream’s layout and structure. To accomplish this pur-
pose, a simple model will be built to  evaluate the initial design for a tank that undergoes a blowdown. 
Nitrogen flows out of a supply tank into a 2 inch line as a part of the blowdown. The flow is controlled by 
opening and closing a valve in the 2 inch line. This model will simulate opening the valve in 0.1 seconds, 
after which the valve will remain open for the remainder of the simulation.

Topics Covered

 l Model building basics
 l Entering Pipe and Junction data
 l Entering transient data
 l Using the Primary Windows: Workspace, Model Data, Output, & Graph Results
 l Analysis Setup: fluid libraries, sectioning pipes, etc
 l Graph types
 l Workspace Layers

Required Knowledge

This example assumes the user has not used AFT xStream previously. It begins with the most basic ele-
ments of laying out the pipes and junctions and solving the transient system via the Method of Char-
acteristics (MOC).

Model File

This example is intended to be built from scratch to help familiarize yourself with the steps to define a 
complete model in AFT xStream. For reference purposes only, the completed example model file can be 
found in the Examples folder as part of the AFT xStream installation:

C:\AFT Products\AFT xStream 3\Examples

 l Metric - Beginner - Tank Blowdown.xtr
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 Step 1. Start AFT xStream

 ØTo start AFT xStream, open the all applications list in the Windows Start Menu, expand the AFT 
xStream 3 folder, and choose AFT xStream 3. This refers to the standard menu items created by a stand-
ard installation; you may have chosen to specify a different installation location.

As AFT xStream starts, the Startup Window appears, as shown in Figure 1. This window provides you 
with several options before you start building a model.

Figure 1: Startup Window with Modeling Preferences collapsed

Some of the actions available from the Startup window are:

 l Open a previous model, browse to a model, or browse to an example
 l Activate an Add-on Module
 l Select AFT Standard “Air” or a recently used fluid to be the Working Fluid
 l Review or modify Modeling Preferences: select a Unit System, filter units, choose a Grid Style, 

select a Default Pipe Material, and more
 l Access other Resources such as Help Files and Video Tutorials

If this is the first time that you have started AFT xStream, Modeling Preferences will be expanded in the 
middle section of the Startup Window, as shown by Figure 2. If this is not the first time that you have star-
ted AFT xStream, the Startup Window will appear with Modeling Preferences Collapsed, as shown in Fig-
ure 1.
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When collapsed, you can view your current Modeling Preferences at the bottom of the Start a New Model 
section. To further review or adjust your preferences, click the Modify button (Figure 1).

Figure 2: Startup Window with Modeling Preferences expanded

 ØWith Modeling Preference expanded, as in Figure 2, select Both with Metric Defaults under 
Unit System. The Filter section can be used to limit the number of units that are shown in the interface.

The  Common Plus Selected Industries option adds units from the industries you select. You can use the 
Show Sample Units option to see the model units based on your selections. After modifying your Model-
ing Preferences, click Remember My Preferences and Hide.

 ØClick Start Building Model.

The Workspace window is shown initially, as seen in . The tabs in the AFT xStream window represent the 
Primary Windows. Each Primary Window contains its own toolbar that is displayed directly beneath the 
Primary Window tabs.

AFT xStream supports multiple monitor usage. You can click and drag any of the Primary Window tabs 
off of the main xStream window, where you can then  move it anywhere you like on your screen, including 
onto a second monitor in a dual monitor configuration. To add the Primary Window back to the main 
xStream window bar, simply click the "X" button in the upper-right of the primary window.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT xStream settings, unless you are specifically instructed to do otherwise.
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The Workspace window

The Workspace window is the primary interface for building your model. This window has three main 
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools 
on the far left. The Quick Access Panel is displayed on the far right. It is possible to collapse the Quick 
Access Panel by clicking on the thumbtack pin in the upper-right of the Quick Access Panel in order to 
allow for greater Workspace area.

Figure 3: The Workspace Primary Window

You will build your model on the Workspace using the Toolbox. The Pipe Drawing tool on the upper-left is 
used to draw new pipes on the Workspace. The Annotation tool beside it allows you to create annota-
tions and auxiliary graphics.

Below the two drawing tools are the different types of junctions available in AFT xStream. Junctions con-
nect pipes and also influence the pressure or flow behavior of the pipe system. Drag and drop any of the  
junction icons from the Toolbox to add them to the Workspace.

Holding your mouse pointer over a Toolbox icon identifies the tool’s function.

 Step 2. Build the model

To lay out this example model, you will place several junctions on the Workspace. Then, you will connect 
the junctions with pipes.

I. Place the Tank junction

 ØTo start, click and drag a Tank junction from the Toolbox and drop it on the Workspace. Figure 4 
shows the Workspace with one Tank.
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Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the 
Toolbox. AFT xStream uses three types of objects: pipes, junctions, and annotations.

All pipe and junction objects on the Workspace have an associated ID number. Junctions are prefixed 
with the letter J, and pipes are prefixed with the letter P. You can assign a name in the object’s Properties 
window, and the visibility of both the name and ID number can be controlled through the use of Work-
space Layers. You can also drag the ID number/name text to a different location to improve visibility.

The Tank you have created on the Workspace will take on the default ID number of 1. You can change 
this to any desired integer between 1 and 99,999 that is not already assigned.

Editing on the Workspace

You can move junctions on the Workspace to new locations. You can also cut, copy, paste, and duplicate 
junctions from the Edit menu or using keyboard shortcuts. Undo is available for most arrangement 
actions on the Workspace.

Note: The relative location of objects  is not important. Pipe lengths and junction elevations are defined 
through property windows. The relative object locations on the Workspace establish the con-
nectivity of the objects but have no bearing on the actual length or elevation relationships.

Figure 4: Tank  junction placed

II. Place the Valve junction

ØTo add a Valve junction, click and drag a valve from the Toolbox and place it on the Workspace as 
shown in Figure 5. The Valve will be assigned the default number "J2".
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Figure 5: Tank Blowdown model with Valve placed

III. Place an Assigned Pressure junction

ØTo add an Assigned Pressure junction, click and drag an Assigned Pressure junction from the Tool-
box and place it on the Workspace as shown in Figure 6. The Assigned Pressure junction will be 
assigned the default number "J3".

Figure 6: All junctions placed
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 ØBefore continuing, save the work you have done so far by either choosing Save As... from the File 
menu, clicking the Save button on the Common Toolbar, or using the CTRL+S keyboard shortcut. Enter 
a file name (Tank Blowdown, perhaps) and AFT xStream will append the *.xtr extension to the file name.

IV. Draw a pipe between J1 and J2

Now that you have all of the junctions placed, you need to connect them with pipes.

 ØTo create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The pointer will change to a 
crosshair when you move it over the Workspace. Draw a pipe near the junctions by clicking and dragging 
the mouse, similar to that shown in Figure 7.

The pipe object on the Workspace has an ID number (P1) that is shown near the center of the pipe.

Figure 7: First pipe drawn

 ØTo place the pipe between J1 and J2, use the mouse to grab the pipe in the center and drag it so 
that the left endpoint falls within the J1 Tank icon, then drop it there (see Figure 8). Next, grab the right 
endpoint of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J2 Valve 
icon (see Figure 9).
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Figure 8: First pipe partially connected

Figure 9: First pipe fully connected

V. Add the remaining pipe

A faster way to add a pipe is to draw it directly between the desired junctions.

 ØActivate the Pipe Drawing Tool again. Position the cursor on the J2 Valve, then press and hold the 
left mouse button. Stretch the pipe across to the J3 Assigned Pressure junction, then release the mouse 
button. All objects in the model should now be graphically connected as they are in Figure 10. 

Save the model by selecting "Save" in the File menu, by clicking the "Save" icon on the Toolbar, or by 
entering CTRL+S.
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Figure 10: All pipes and junctions placed

Reference positive flow direction

The arrow on each pipe indicates the reference positive flow direction for the pipe. The direction does not 
influence the direction that the flow may go, it influences sign convention only. If the direction of flow cal-
culated by the Solver is the opposite of this reference flow direction, then the output will show the flow 
rate as a negative number.

You can reverse the reference positive flow direction by choosing Reverse Direction from the Arrange 
menu, selecting the Reverse Pipe Direction button on the Toolbar, or pressing F3.

Although the reference positive flow direction does not need to point in the direction of the actual flow, 
when used with compressors, the reference direction determines the suction side and discharge side of 
the compressor.

Note: Examples of other junctions that depend on pipe directions include Control Valves, Check 
Valves, and Area Changes.

Note: Some users find it desirable to lock objects to the Workspace once placed. This prevents acci-
dental movement and disruption of the connections. You can lock all the objects by first select-
ing all objects by using CTRL+A or the Edit menu by clicking Select All. Then use CTRL+L or go 
to the Arrange menu and selecting Lock Object. The lock button on the Workspace Toolbar will 
appear depressed, indicating it is in an enabled state. Alternatively, you can use the grid feature 
and snap to grid. The grid options can be modified through the Arrange menu or User Options 
window.

A. Define the model components

The model must have all pipes and junctions defined in order for it to run. This step encompasses the 
proper input data and connectivity for all pipes and junctions.
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Object status

Each pipe and junction has an object status. The object status tells you whether the object is defined 
according to AFT xStream's requirements. To see the status of the objects in your model, click the light 
bulb icon on the Workspace Toolbar (alternatively, you could choose Show Object Status from the View 
menu). Each time you click the light bulb, Show Object Status is toggled on or off.

When Show Object Status is on, the ID numbers for all undefined pipes and junctions are displayed in 
red on the Workspace. Objects that are completely defined have their ID numbers displayed in black. 
These colors are configurable through User Options from the Tools menu.

Because you have not yet defined the pipes and junctions in this model, all the object ID numbers will 
change to red when you turn on Show Object Status.

Showing undefined objects

Another useful feature is the List Undefined Objects window (Figure 11). This can be opened from the 
View menu by clicking on List Undefined Objects, or by clicking the List Undefined Objects icon on the 

Workspace toolbar . All objects with incomplete information are listed. Click on an undefined pipe or 
junction to display the property data that is missing. Click the close button on the bottom-right to stop 
showing this window.

Figure 11: The List Undefined Objects window lets you see the undefined properties for each object
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I. Enter data for the J1 Tank

 ØTo define the first tank, open the J1 Tank Properties window (Figure 12) by double-clicking on the J1 
junction.

Note: You can also open an object’s Properties window by selecting the object (clicking on it) and then 
either pressing the Enter key or clicking the Open Pipe/Junction Window icon on the Workspace 
Toolbar.

 ØEnter the following properties into the J1 Tank Properties window:
 1. Name = Supply Tank
 2. Elevation = 0 meters
 3. Tank Model = Finite
 4. Pressure = 45 bar
 5. Temperature = 150 deg. C
 6. Fixed Volume = 8.5 meters3
 7. Initial Conditions = Known
 8. Thermodynamic Process = Adiabatic

Note: You can specify default units for many parameters (such as meters for length) in the User 
Options window, accessed from the Tools menu under Preferred Units.

You can give the junction a name, if desired, by entering it in the Name field at the top of the window.  By 
default, the junction's name indicates the junction type, and will be displayed in the Model Data and Out-
put. It can optionally be displayed on the Workspace via the use of Workspace Layers which will be dis-
cussed later.

Most junction types can be entered into a custom Junction Library allowing the junction to be used mul-
tiple times or shared between users. To select a junction from the custom library, choose the desired junc-
tion from the Library List in the junction's Properties window. The current junction will get the properties 
from the library component.

The Copy Data From Jct... list will show all the junctions of the same type in the model. This will copy 
desired parameters from an existing junction in the model to the current junction.
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Figure 12: Properties window for Tank J1

Using the tabs in the Properties windows

The information in the Properties windows is grouped into several categories and placed on separate 
tabs. Click the tab to bring its information forward. Figure 12 is an example of a Tank’s Properties win-
dow.

The Tank Model tab is the tab that appears first when the Tank junction is opened and contains all of the 
inputs required to define the Tank in steady-state. While the Tank Model tab is specific to the Tank junc-
tion, the first tab opened for any junction will contain all inputs required for that junction to be defined.

The Optional tab allows you to set Special Conditions (like closing a valve or turning off a compressor), 
and change the junction icon.

Each junction has a tab for Notes, allowing you to enter text describing the junction or documenting any 
assumptions.

The highlight feature (on by default) displays all the required information in the Properties window in light 
blue. You can toggle the highlight on and off by pressing F2 with the properties window open or by 
double-clicking an empty area above the tabs of the properties window. The highlight feature can also be 
turned on or off by selecting Highlight in Pipe and Jct Windows from the View menu.

The Status tab will state whether all required input data is present for a given junction. If not, it will list all 
inputs that are incomplete.
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 ØClick OK. If Show Object Status is turned on, you should see the J1 ID number turn black again, telling 
you that J1 is now completely defined.

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature. 
Position the cursor on the Tank J1 junction and hold down the right mouse button. An information box 
appears, as shown in Figure 13.

Inspecting is a faster way of examining the input (and output if results are available) than opening the 
Properties window.

Figure 13: Inspect junction properties from the Workspace by clicking and holding the right mouse button

II. Enter data for the J2 Valve

The Valve is the element which will cause the transient in this model. The purpose of the model will be to 
understand how the conditions within the supply tank and discharge pipe change after the valve opens.

 ØDouble-click the J2 junction icon to open the Valve Properties window and enter the following data 
on the Loss Model tab (Figure 14).

 1. Elevation = 0 meters (by default, the elevation will be set to the value specified in the last junction, 
and this behavior can be changed in the User Options > Parameters > Pipes and Junctions sec-
tion)

 2. Loss Source = User Specified
 3. Loss Model = Kv
 4. Kv = 52
 5. xT = 0.7

 ØClick the Optional tab and set the Special Condition to Closed. This will set the initial steady-state 
Kv equal to 0. The Kv value defined above will represent the final steady-state value after the transient 
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valve movement has completed.

Figure 14: Input data for the J2 Valve

 ØClick the Transient tab and enter the following data (Figure 15).
 1. Initiation of Transient = Time (indicates that the valve closure will be initiated at the time you spe-

cify)
 2. Enter the following Kv vs. Time data:

Time (seconds) Kv xT

0 0 0.7

0.1 52 0.7

240 52 0.7

The first data point of the table  must match the steady-state value of the junction; therefore, the values 
are grayed out. In this case, the valve is closed in the initial steady-state due to the Special Condition spe-
cified in the previous step. Therefore, the initial transient data point automatically populates the valve as 
being closed (Kv of zero means the valve is closed). The valve then fully opens over a period of 0.1 
seconds. It remains in this position for the rest of the simulation.
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Figure 15: Transient input data for the J2 Valve

 ØClick the OK button to save and close the Valve Properties window. There should now be a “T” 
symbol next to the Valve junction on the Workspace, indicating that transient data is entered for the junc-
tion. The Valve junction on the Workspace will additionally have a red “X” next to it indicating that the junc-
tion contains a Special Condition.

III. Enter data for the J3 Assigned Pressure

 ØDouble-click the J3 junction icon to open the Assigned Pressure Properties window and enter the 
following data (Figure 16).

 1. Elevation = 0 meters
 2. Boundary Specification = Stagnation
 3. Stagnation Pressure = 1 bar
 4. Temperature = 21.1 deg. C
 5. Click the OK button to save and close the Assigned Pressure Properties window
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Figure 16: Input data for the J3 Assigned Pressure

ØSave the model again before proceeding.

IV. Enter data for Pipe P1

Data for pipes and junctions can be entered in any order. In this example, the junctions were done first. 
The next step is to define all of the pipes.

 ØOpen the Pipe Properties window for Pipe P1. The Pipe Model tab opens by default (Figure 17).

 1. Pipe Material = Steel - ANSI
 2. Size = 2 inch
 3. Type = STD (schedule 40)
 4. Length = 6.1 meters
 5. Friction Model = Standard
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Figure 17: Properties window for Pipe P1

The Pipe Properties window

The Inspect feature can be accessed not only from pipes and junctions located on the Workspace, but 
also from within the Properties window of each pipe (and certain junctions). This is helpful when you want 
to quickly check the properties of objects that connect to a pipe or junction whose Properties window you 
already have open.

To Inspect a junction connected to a given pipe, position the mouse pointer on the connected junction’s 
ID number in that pipe’s Properties window (located at the top right of the Pipe Properties window) and 
hold down the right mouse button. This process can be repeated for any junction that states the upstream 
and downstream pipe in the junction’s Properties window. You can jump to that junction’s Properties win-
dow by double-clicking the connected junction’s ID number, or use the Jump button to jump to any other 
part of the model.

 ØClick OK to save and close the Pipe Properties window for Pipe P1.

V. Enter data for Pipe P2

 ØOpen the Pipe Properties window for Pipe P2 and enter the following data:

 1. Pipe Material = Steel - ANSI
 2. Size = 2 inch
 3. Type = STD (schedule 40)
 4. Length = 457 meters
 5. Friction Model = Standard
 6. Click OK to save and close the Pipe P2 Properties window.
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 ØCheck if all the pipes and junctions are defined by clicking on the List Undefined Objects button. If 
all data is entered, no items should appear in the Undefined Objects window. If items are present, open 
the corresponding Properties windows for the incomplete items from the Workspace. The Status tab on 
each Properties window will indicate what information is missing.

B. Review model data

 ØSave the model. It is also a good idea to review the input using the Model Data window.

Reviewing input in the Model Data window

The Model Data window is shown in Figure 18. To change to this window, you can click on the Model 
Data tab, select it from the Window menu,   or use the CTRL+M keyboard shortcut. The Model Data win-
dow gives you a table-based perspective of your model. Selections can be copied to the clipboard and 
transferred into other Windows programs, saved to a formatted file, printed to a PDF, or printed out for 
review. Figure 19 shows an expanded view of the Transient Data tab from Figure 18. Here, all transient 
input data for the model is shown.

Data is displayed in three general areas. The top is called the General data section, the middle is the 
Pipe data section and the bottom is the Junction data section. Each section is collapsible using the but-
ton at the top-left of the section. Further, each section can be resized.

The Model Data window allows access to all Properties windows by double-clicking on any input para-
meter column in the row of the pipe or junction you want to access.

Figure 18: The Model Data window displays all input in table form
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Figure 19: The Transient data tab in the Model Data window displays transient input data

 Step 3. Specify Analysis Setup

The Analysis Setup window allows the user to define fluid properties, view undefined pipe/junction prop-
erties, section pipes, adjust simulation duration, enable Add-on Modules if purchased and available on 
the current license, and specify other simulation settings from a single central location.

 ØClick Analysis Setup on the Main Toolbar to open the Analysis Setup window (see Figure 20). The 
Analysis Setup window  contains various groups depending on which modules you may be using. Each 
group has one or more items. A fully defined group has every item within it defined with all required 
inputs. Complete every group to run the Solver. A group or item that needs more information will have a 
red exclamation mark to the left of the group or item name. After completing a group, the group icon 
shows a green circle with a checkmark. After defining all groups, thus completing the Analysis Setup, the 
Model Status light in the lower-right corner of the Workspace turns from red to green.

The Analysis Setup window can also be opened by clicking on the Model Status Light on the Status Bar 
at the bottom-right corner of the AFT xStream window (Figure 3).
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Figure 20: The Analysis Setup window tracks the defined and undefined model inputs

A. Modules

Under the Modules group, click on the Modules item to open the Modules panel, shown in Figure 20. 
Here you can enable and disable  the Pulsation Frequency Analysis (PFA) Add-on Module if it is available 
on the license. By default, the model will have all modules disabled. Make no changes to this panel for 
this example.

B. Fluid Properties

 ØSelect the Fluid item to open the Fluid panel (Figure 21).

This panel allows you to specify the fluid used in the model. There are several fluid libraries that are avail-
able:

 l AFT Standard - Common fluids from various industry standard sources have been curve fit to 
optimize calculation speed.

 l User Library Fluid - If the desired working fluid is not available via the other sources, custom fluid 
properties can be entered and saved to the User Library for repeated use in the future. Custom flu-
ids are created by opening the Library Manager from the Library menu or by clicking the Edit Fluid 
List button in the Fluid panel and clicking Add New Fluid.

 l ASME Steam Tables - Properties are calculated via the Equations of State which were used to 
generate the classic steam/water tables in the IAPWS Industrial Formulation (1997).

 l Chempak - Optional add-on for purchase which contains data for several hundred fluids and sup-
ports user-specified fluid mixtures. Chempak is licensed from Madison Technical Software.
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 l NIST REFPROP - The Reference Fluid Thermodynamic and Transport Properties (REFPROP) 
Database is licensed from the National Institute of Standards and Technology (NIST) where prop-
erties for approximately 150 fluids are calculated via Equations of State. REFPROP supports 
user-specified fluid mixtures.

 ØSelect the AFT Standard fluid option, then choose Nitrogen (GN2) from the list and click the Add to 
Model button. Leave the Equation of State as Redlich-Kwong and the Enthalpy Model as Generalized.

Figure 21: Fluid panel of Analysis Setup

C. Pipes and Junctions

The Pipes and Junctions panel is used to show the status of the pipes and junctions on the Workspace. 
This item is incomplete if there are any undefined pipes/junctions on the Workspace, or if there are no 
pipes/junctions on the Workspace. In this example the objects in the Workspace are fully defined, so this 
item is marked as complete.

Running models in steady-state

After fully specifying the Fluid panel and the pipes and junctions, sufficient information exists to run the 
model in steady-state. You can run the model in steady-state by selecting the Simulation Mode/Duration 
panel from the Transient Control group and then choosing AFT Arrow™ Steady for the Time Simulation. 
If you do this, the other inputs on the Simulation Mode/Duration panel and the Pipe Sectioning and Out-
put panel will no longer be required, and the model can be run.

In general, it is a good idea to always run your model in steady-state before running the full transient ana-
lysis to make sure the model is giving reasonable results. However, in this case the model has no flow in 
the steady-state due to the closed valve, and a steady-state run is trivial. Keep the Transient option selec-
ted.
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D. Pipe Sectioning and Output

The next panel is the Pipe Sectioning and Output panel in the corresponding group. The Pipe Sectioning 
and Output panel divides pipes into computation sections in a manner which is consistent with the 
Method of Characteristics (MOC).

To satisfy the MOC, the following equation must be valid:

where Δt is the time step, Δx is the section length, and c is the sonic velocity.

 ØEnter 1 for the Minimum Number of Sections Per Pipe.

The Minimum Number of Sections Per Pipe determines the section length by taking the quotient of the 
shortest pipe's length and the Minimum Number of Sections. Increasing the number of sections in a 
model will always have a positive correlation to the model accuracy as the error inherent to the Method of 
Characteristics decreases when the step size is made smaller. However, the run time of the model 
increases quadratically as well, since each added section to the shortest pipe increases the number of 
calculations for each time step. This increase in run time is exacerbated when there is a large disparity 
between the minimum pipe length and the length of the longest pipe, such as the case in this model.

The Minimum Number of Sections Per Pipe for this example will be set to 1 for expediency, but note that 
it would be wise to use more computational sections if you are running an AFT xStream model for real 
projects. Typically, less sections and faster run time is useful during the initial model development and 
troubleshooting, and more sections can be used for final runs.

 ØDefine the Estimated Maximum Pipe Temperature During Transient as 930 deg. C.

The Estimated Maximum Pipe Temperature During Transient is used to calculate the maximum sonic 
velocity. Since all pipes in the network must be solved together, the time step must be the same for each 
pipe. However, the sonic velocity will not be equivalent for all of the pipes. Therefore, the sonic velocity at 
the specified maximum temperature is used to find a uniform time step for the system. Without a uniform 
time step, the MOC could fail. Choosing a maximum temperature that is much higher or much lower than 
the maximum temperature calculated during the run can result in additional uncertainty in the MOC solu-
tion, as is discussed in the Pipe Sectioning - Introduction to Method of Characteristics help topic. It is gen-
erally recommended to choose a conservatively high temperature for the model initially. The results of 
the initial run can then be used to refine the Estimated Maximum Temperature During Transient for sub-
sequent runs.

The Estimated Maximum Pipe Mach Number During Transient is an additional parameter that  affects res-
ult accuracy. The value of this parameter is set to 1 by default so that the Method of Characteristics grid is  
able to bound the sonic velocity obtained at the Estimated Maximum Pipe Temperature During Transient. 
Setting the Mach number to 1 ensures that the model will not fail assuming  the input values for that vari-
able are correct.

However, because of the computational methodology of the MOC, using the default Mach number can 
introduce error due to the difference between the Estimated Maximum Pipe Mach Number During Tran-
sient and the actual maximum. This error is particularly noticeable when the Mach number during the 
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simulation is near zero. If the maximum Mach number reached during the simulation is near zero, a more 
accurate model can be found by lowering the estimated maximum based on the actual Maximum Mach 
number of the system.

To change the Estimated Maximum Pipe Mach Number During Transient, you must expand the 
Advanced Sectioning Controls dropdown in the Pipe Sectioning and Output panel of Analysis Setup. It is 
highly recommended that you first run the model with the default Mach number in order to ensure that 
choking does not occur in the pipes before altering this number. Additionally, be cognizant of the fact that 
altering sectioning, transient components, or maximum estimated temperatures between runs could 
have an effect on the maximum Mach number reached during the simulation. As such, it is generally 
recommended to only change this number once your model has reached a more finalized state.

Sonic choking will be seen in this model, so no adjustment to Maximum Mach Number will be made.

The Sectioning Summary underneath the inputs will be partially filled in. Certain properties such as the 
Estimated Total Steps and Total Pipe Computations will need the Simulation Mode/Duration panel to be 
completed before values can be displayed.

Figure 22: The Sectioning panel in the Analysis Setup window is used to calculate the time step of the model

E. Transient Control

 ØSelect the Simulation Mode/Duration panel. Enter 0 seconds for the Start Time and 240 seconds for 
the Stop Time (Figure 23).

 ØClick OK to accept the changes in Analysis Setup.
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Figure 23: The Simulation Mode/Duration panel is used to specify the simulation type and the time span for 
the transient

 ØSave the model.

 Step 4. Run the model

 ØChoose Run Model... from the Analysis menu or click the Run Model button on the Common Tool-
bar. During execution, the Solution Progress window is displayed and can be used to pause or cancel the 
Solver's activity (Figure 24).
This simple model will take several minutes to run. A typical xStream model may take hours to solve 
depending on the simulation duration, sectioning, and which fluid library is used.
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Figure 24: The Solution Progress window displays the state of the simulation

The two Solvers

AFT xStream has two Solvers. The first is called the AFT Arrow™ Steady Solver, which as its name sug-
gests, obtains a steady-state solution to the pipe network. The second Solver is called the Transient 
Solver and solves the gas transient equations via the Method of Characteristics (MOC).

The AFT Arrow™ Steady Solver and Transient Solver use different sectioning methods which causes 
small discrepancies between the converged AFT Arrow™ Steady solution and the first time step of the 
transient solution. AFT xStream runs the Transient Solver for a period of time before the transient sim-
ulation begins in order to allow these artificial waves caused by these discrepancies to dampen and die 
out. Once the artificial transients have settled, AFT xStream checks the solution with resolved artificial 
transients against the AFT Arrow™ Steady solution. If the mismatch between the beginning and end of 
the artificial transient resolution process is sufficiently small AFT xStream proceeds with the transient sim-
ulation. See the chart in Figure 25 as a visual representation of the process described above.

Figure 25: Illustration of the Transient Solver Initialization process with artificial transient resolution
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 ØWhen the solution is obtained, click the Output button to display the table-based Output window. 
The information in the Output window can be reviewed visually on the screen, saved to a file, exported to 
a spreadsheet-ready format, copied to the clipboard, or printed.

The output file

When the Solver runs, the output data is written to a file. This file is given the same name as the model 
itself with a number appended to the name, and with an *.out extension appended to the end. For all data 
processing, graphing, etc., the data is extracted from this file. The number is appended because users 
are able to build different scenarios all within this model. Each scenario will have its own output file; thus, 
the files need to be distinguishable from each other.

The output file will only remain on disk if you save the model after it has been run. Once saved, it 
will remain until the user erases it or the model input data is modified.

 ØSave the model file again such that the output file is saved to the disk. This means that if you were to 
close your model right now and then reopen it, you could proceed directly to the Output window for data 
review without rerunning your model.

 Step 5. Review the Output window

The Output window (Figure 26) is similar in structure to the Model Data window. Three areas are shown, 
and you can minimize or enlarge each section by clicking the arrow next to the General, Pipes, and All 
Junctions tabs. The items displayed in the tabs can be customized with the Output Control window, 
which can be opened by clicking the spreadsheet with a pencil icon from the Common Toolbar or from 
the Tools dropdown menu.

The General section will open by default to the Warnings tab if any Warnings or Cautions were 
encountered during the simulation. This model should generate a Caution that the Maximum Transient 
Pipe Mach Number is at least 0.2 higher than the steady pipe Mach number, which occurs since there is 
no flow in the system at steady-state. When this Caution is present, the effect of pipe sectioning on res-
ults can be significant. The impact of pipe sectioning will be addressed in greater detail in a later step.

The Output window allows you to review both the steady-state and transient results. The Pipes tab, All 
Junctions tab, and any specific junction tabs in the Junction section (such as Tank, Valve, etc.) show the 
steady-state results. A summary of the maximum and minimum transient results for each pipe is given on 
the Transient Max/Min tab in the Pipe section and is the active tab displayed in Figure 26. You can review 
the solutions for each time step (i.e., a time history) on the Transient Output tab shown in Figure 27. Note 
that in order to display all pipe stations the model will need to be set to save data for all stations. By 
default, xStream saves all data points. This can be changed in the Pipe Sectioning and Output panel.
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Figure 26: The Output window displays steady-state and transient output in tabular form

Figure 27: The Output window displays transient data from each time step

Figure 28: The Output window displays the values of steady-state parameters in the Pipes tab

 ØClick on the Event Messages By Time tab. This tab allows you to review changes of states at junc-
tions, such as the onset of choking or the initiation of transient events (see Figure 29). There should be 
messages indicating that the J2 Valve experienced a near instantaneous choking that dissipated after 
about 0.06 seconds while the J3 Assigned Pressure experienced choking after 2.3 seconds that lasted 
until approximately 128.9 seconds. Choking is an important phenomenon to pay attention to as it indic-
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ates that the fluid has reached sonic velocity. This has significant implications for the MOC calculation 
method as will be discussed later.

Figure 29: Event Messages by Time tab displays important system behavior

The Output Control window (Figure 30) can be accessed from either the Tools menu or from the Output 
window Toolbar, and it allows you to select the specific output parameters you want to display in the Out-
put window. You can choose the units and reorder the parameters as desired. If you do not change any 
of the Output Control settings, the default Output Control parameters are assigned.

Figure 30: The Output Control window lets you customize the output

Units for each column in the Output window can also be changed by double-clicking the column header. 
This will open a window in which you can select the units you prefer (Figure 31). These changes are 
extended to the Output Control parameter data that is set.
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Figure 31: The Change Units window is opened from the Output window tabs by double-clicking a column 
header

 Step 6. View the Graph Results

For transient analysis, the Graph Results window will usually be more helpful than the Output window 
because of the more voluminous data.

 ØOpen the Graph Results window by clicking the Graph Results tab, choosing it from the Windows 
menu,  or by pressing CTRL+G.

Figure 32 shows the Graph Results window with the Graph Control tab selected on the Quick Access 
Panel.

Figure 32: The Graph Results window and Quick Access Panel Graph Control tab is where various system 
parameters (both steady-state and transient) can be graphed
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A. Create a Transient Pipe graph

AFT xStream gives you the ability to create stacked graphs. These are graphs that are vertically aligned 
such that they use the same same x-axis but have different parameters on the y-axis of each graph. This 
feature is helpful when you want to look at how different parameters vary with time at a given position 
without having to create separate graphs.

 ØAccess the graphing parameters by opening the Graph Control tab on the Quick Access Panel 
(this tab is automatically selected when the Graph Results window is opened). Because we are 
interested in seeing how the pressures and flows in specific pipe sections respond over time, ensure that 
the Transient Pipe tab is selected in the Parameters/Formatting area on the Quick Access Panel. Altern-
atively, you can open the Select Graph Parameters window by clicking on the corresponding icon on the 
Graph Results Toolbar (Figure 32).

 ØAdd the Pipe P2 Outlet to the Graph These Pipes/Stations list by expanding the tree for Pipe P2 
under the Select Pipe Stations list and double-clicking the Outlet station. Pipe P2 Outlet represents the 
pipe computing station at the discharge of the blowdown pipe. Alternatively, you can click on the right 
arrow button after selecting the pipe station you want to graph to add it to the Graph These Pipes/Sta-
tions list.

 ØVerify the Time Units are set to seconds and the Time Frame is set to All Times.
 ØClick the Add button twice, which is the green “+” icon next to Select Parameter. Two new rows will 

appear under the Parameter definition area which will create stacked graphs (Figure 33).
 ØSelect the following parameters from the dropdown lists on each row:

 1. Temperature Static with units of deg. C
 2. Velocity with units of meters/s
 3. Mach Number

Figure 33 shows the input in the Parameters/Formatting area on the Quick Access Panel.
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Figure 33: The Graph Control tab on the Quick Access Panel allows you to specify the graph parameters you 
want to graph in the Parameters/Formatting area

 ØClick the Generate button at the bottom of the Quick Access Panel to create the static tem-
perature, velocity, and Mach number graphs at the pipe discharge over the duration of the simulation.

 ØFormat the legend font size to 20 pt by right-clicking on any legend and using the scroll bar. Drag 
the legend to the top-right corner of the graph.

 ØFormat the y-axis and x-axis font size to 20 pt by right-clicking on each axis parameter and using 
the scroll bar.

Figure 34 shows the stacked graphs detailing the static temperature, velocity, and the Mach number at 
Pipe P2 outlet over the course of 240 seconds. Here you can see that the maximum temperature at the 
discharge is about 800 deg. C. Also note that the maximum temperature in Figure 34 does not approach 
the value indicated in the Transient Max/Min tab. This is because the Transient Pipe graph shows only 
the outlet station (station 75), while the maximum temperature in Pipe P2 is reached at station 66.

Note: The axis titles in the stacked graphs in Figure 34 have been modified for clarity.

The Formatting area on the Graph Control tab can be used to modify the graph colors, fonts, and other 
elements. Options to copy the graph image or x-y data are available on the Graph Results Toolbar or by 
right-clicking the graph. The graph image or x-y data can be saved from the File menu.
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Figure 34: Static temperature, velocity, and Mach number of Pipe P2 outlet

Further review of the graph results in Figure 34 shows that sonic choking occurs after several seconds, 
as was seen on the Event Messages tab in the Output window, and continues for the next 130 seconds. 
Also note that the temperature, velocity, and Mach number all rise sharply shortly after the valve opens, 
with the Mach number rapidly reaching one. After the initial rise, the temperature and velocity both decay 
while the Mach number remains at one. The velocity drops because sonic velocity has a positive cor-
relation with temperature, so as the temperature decays, the velocity required for choked flow also 
decreases. This relationship is important to understand when looking at systems that encounter choking.

B. Create a Transient Junction graph

For the purpose of this analysis, it is also helpful to look at the temperature and pressure of the tank over 
time.

 ØCreate a new graph tab by clicking the New Tab button which is the green plus icon located on the bot-
tom-right, immediately below the graph area (Figure 32).

 ØClick the Transient Jct tab on the Graph Control tab of the Quick Access Panel (Figure 35). Add the 
J1 (Supply Tank) junction.

 ØVerify the Time Units are set to seconds and the Time Frame is set to All Times.
 ØClick the Add button to add a new row under the Parameter definition area.
 ØSelect the following parameters from the dropdown lists on each row:
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 1. Pressure Stagnation with units of bar
 2. Temperature Stagnation with units of deg. C

 ØClick the Generate button. These graphs show the tank pressure and temperature initially decrease 
quickly, then decrease more slowly as time progresses. This change in slope is due to a decreasing pres-
sure gradient between the tank and the atmosphere as the tank is emptied, which slows the mass flow 
rate out of the tank (Figure 36).

Note: AFT xStream assumes all pipes are adiabatic (perfectly insulated). Over a 240 second run time 
this assumption may not be accurate. Consider this when evaluating simulation results over 
longer times.

Figure 35: Graph Parameters window for the Transient Junction graph
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Figure 36: The Transient Junction graph shows how variables within a junction change over time, such as 
with the temperature and pressure of Tank J1

This junction graph could be used to determine when certain conditions within the tank were met. For 
instance, suppose there was a need to know when the tank pressure dropped below 25 bar. The junction 
graph would indicate the tank pressure would reach such a point around 60 seconds after beginning the 
tank blowdown.

C. Create an Animated Profile graph

Lastly, we will animate the profile of the system to show the wave caused by opening the valve.

 ØCreate a new graph tab and select the Profile tab. Under Plot Single Path, select Pipe P1 and P2. 
After ensuring your Length Units are meters, select the option to Animate Using Output and ensure the 
Animation Time Units are set to seconds.
ØAdd new parameters until you have 4 in total, and set them to the following (see Figure 37):

 1. Pressure Static with units of bar
 2. Temperature Static with units of deg. C
 3. Velocity with units of meters/sec
 4. Density Static with units of kg/m3

 ØClick the Generate button. This will show the max and min envelopes of the parameters throughout 
the selected time frame. The animation can started by clicking Play in the top-left playback controls (Fig-
ure 38).
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Figure 37: Profile Graph Parameters window

Figure 38: The Profile Graph show the Maximum and Minimum values of all parameters shown in the Graph 
over the specified time Frame, and can also animate the values

Take note of the pressure wave that is created at the valve just after animation is started. This wave 
travels to the Assigned Pressure junction before reflecting back towards the valve. The amount of time it 
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takes this wave to travel to the reflection point and back is called the communication time. It should be 
noted when creating your transient that any event which occurs over a shorter length of time than the 
communication time of the system is considered to happen instantaneously.

 Step 7. View the Workspace Layers

Workspace Layers can display input and output values superimposed over the model, and color pipes 
automatically based on output values.

The Workspace Layers can also animate the transient pipe results in a color animation overlaid on the 
model.

 ØNavigate to the Workspace window by clicking on the Workspace tab or pressing CTRL+W. Select 
the Workspace Layers tab in the bottom-right of the Quick Access Panel. The Workspace Layers panel 
contains two sections named Layer Presets and Layers.
Within the Layers section, there are two expandable or collapsible groups which contain the two layer 
types named Color Maps and Standard layers. We will integrate the model results with the graphical lay-
out of the pipe network by using the All Objects Layer located under the Standard group. The All Objects 
Layer is the bottommost layer for all models and shows  all pipes, junctions, and annotations when the 
layer is visible. Layer visibility can be toggled on/off using the eye icon next to the layer. The combination 
of layers and toggling visibility allows for a wide range of visual customization, and the All Objects Layer 
will always provide a safety net to keep track of all objects in the model.

 ØOpen the Layer Settings window for the All Objects Layer by double-clicking the All Objects 
Layer, clicking the gear icon to the right of the layer name, or selecting the layer and clicking the single 
gear icon on the Layers Toolbar. The Layer Settings window is shown in Figure 39.

The Layer Settings window provides flexible options for customizing the appearance of the model. The 
Pipes & Junctions group allows you to show or hide junctions, and change display properties like color, 
size, and thickness. Note that you cannot hide individual objects on the All Objects Layer, but you can 
hide objects on new layers, and then hide the entire All Objects Layer below. The Label Control group 
allows you to display input and output parameters next to objects on the Workspace. The Annotations 
group allows you to customize annotations.
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Figure 39: The Layer Settings window specifies content to be superimposed on the Workspace

 ØSelect the Pipe Parameters item under the Label Control group. The left pane lists input and out-
put parameters available for display, and the right pane lists the parameters currently being displayed by 
the layer on the Workspace.

 ØIn the left pane, expand the Pipe Max/Min Parameters list. Then, select Max Temperature Static  in 
the list with units of deg. C. Add it to the right pane by either double-clicking the parameter, or selecting 
the parameter and clicking the arrow between the panes. Repeat the process to add the Min Tem-
perature Static parameter with the same units.

 ØAdd additional clarity by repositioning the labels and adding a legend. It is common for the text 
on the Workspace Layers to overlap with objects when first generated. Labels can be dragged to a new 
area or a smaller font can be selected using the Font Decrease icon on the Workspace Toolbar or from 
within the Global Layer Settings. Parameter units can be consolidated in a legend which can be added 
via the Global Layer Settings. In the Layers Toolbar, click the double gear icon to open the Global Layer 
Settings. Then, enable the checkbox for Show Units in Legend. The result of these adjustments is shown 
in Figure 40.

Figure 40: Results are superimposed on the model layout via Workspace Layers
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 Step 8. Examine the effect of heat transfer

By default AFT xStream models all pipes as adiabatic at the internal surface, meaning no heat is trans-
ferred from the fluid to the pipe walls or surroundings. Modeling the pipes as adiabatic is reasonable 
when the pipes are well insulated and the temperature difference between the fluid and the atmosphere 
is relatively low. However, for cases such as the tank blowdown modeled in this example, heat transfer 
from the fluid to the pipe walls and environment has a large impact on results.

 ØCreate a child scenario named Convective Heat Transfer.
 ØOpen the Pipe Properties window for each pipe and enter the following on the Heat Transfer 

tab:
 1. Heat Transfer Model = Convective Heat Transfer
 2. External Convection Coefficient Correlation = Free-Horizontal (Churchill-Chu)
 3. Ambient Temperature = 21.1 deg. C

After updating each of the pipes open the Analysis Setup window and go to the Pipe Sectioning and Out-
put panel. Change the Estimated Maximum Pipe Fluid Temperature During Transient to 175 deg. C and 
click OK to accept the changes.

 ØRun the model and go to the Output window.

Note that a new caution is shown for heat transfer results in the steady-state. AFT xStream can’t solve for 
convective heat transfer when there is no flow in a pipe in the steady-state, so xStream treats all stagnant 
pipes as isothermal at the temperature of the connected boundary junctions. The Temperature Override 
feature on the Optional tab of the Pipe Properties window can be used to specify a different temperature 
for the pipe if needed.

In the Transient Max/Min tab shown in Figure 41 it can be seen that the maximum temperature in Pipe P2 
is only 112 deg. C as opposed to 919 deg. C which was calculated with adiabatic heat transfer.

Go to the Graph Results window and recreate the Pipe P2 outlet graph from Figure 34 as is shown below 
in Figure 42.

Figure 41: Transient Max/Min temperature output with convective heat transfer modeled
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Figure 42: Temperature, velocity, and Mach number for the discharge of Pipe P2 with convective heat trans-
fer

 Step 9. Examine the effect of sectioning

In AFT xStream, sectioning plays an important role in model accuracy. Due to how the MOC operates, 
accuracy increases with the number of sections you have in the model. To illustrate this,  the model was 
re-run with a Minimum Number of Sections Per Pipe of 6 instead of 1. Comparing Figure 36 to Figure 45, 
values such as the temperature and pressure for Tank J1 remain similar with the increase in the number 
of sections. However, values such as the maximum temperature reached in Pipe P2 (Figure 26 and Fig-
ure 43), changed substantially. This value increased from 919 deg. C to 1203 deg. C. This change in the 
maximum temperature indicates that the difference in sectioning has significant implications if your 
interest is in the conditions in the blowdown pipe. It should be noted that changing the Minimum Number 
of Sections Per Pipe from 1 to 6 caused the computation time of the model to increase from a couple 
minutes to about 1.75 hours. Therefore, it is of critical importance to balance accuracy and computation 
time when using AFT xStream. This idea is discussed in more detail on the Pipe Sectioning - Introduction 
to the Method of Characteristics help topic.

Due to the long run time, it was not sensible to ask you to run the 6 section scenario as a part of this 
example. If you are interested, you may want to run this scenario overnight.
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Figure 43: Transient Min/Max tab of the Output for a modified sectioning scenario

Figure 44: Temperature, velocity, and Mach number for the discharge of Pipe P2 with 6 sections minimum per 
pipe
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Figure 45: Temperature and pressure stagnation for Tank J1 with 6 sections minimum per pipe
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Figure 46: Profile Graph for Tank Blowdown system with 6 Sections Minimum Per Pipe

Conclusion

You have now used the Primary Windows in AFT xStream to build and analyze a simple gas transient 
model. Pipes and junctions were placed on the Workspace and defined by entering data into their Prop-
erties windows. Analysis Setup was used to select a fluid, section the pipes, and enter a duration for the 
transient simulation. The model was run and results were viewed in the Output window. Different types of 
graphs were created to analyze the system behavior, and the effect of sectioning was discussed.
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Gas Turbine Fuel System Example 

Summary

The combustion baskets in a natural gas fuel system are fed by a positive displacement compressor. The 
natural gas is preheated by a heat exchanger before passing through the three control valves, with each 
feeding a separate combustion basket. One of the control valves experiences a nearly instantaneous 
closure. The objective is to determine the maximum fluid temperature reached during the transient, both 
in the entire system, and at the inlets of the combustion baskets. The effect of this transient event on the 
temperature, pressure, and velocity of the system should be observed.

As the design engineer, you are also responsible for evaluating the sensitivity of the results to the Min-
imum Number of Sections Per Pipe parameter.

Topics Covered

 l Modeling a valve closure as a transient event
 l Modeling a heat exchanger
 l Using the Scenario Manager
 l Importance of the Estimated Maximum Temperature During Transient setting
 l Finding the max and min values for transient parameters
 l Creating animated profile graphs

Required Knowledge

This example assumes that the user has some familiarity with AFT xStream such as placing junctions, 
connecting pipes, and entering pipe and junction properties. Refer to the Beginner - Tank Blowdown 
example for more information on these topics.

Model File

A completed version of the model file can be referenced from the Examples folder as part of the AFT 
xStream installation:

C:\AFT Products\AFT xStream 3\Examples

 l Metric - Gas Turbine Fuel System.xtr
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 Step 1. Build the model

A. Place the pipes and junctions

 ØIn the Workspace window, assemble the model as shown in Figure 1.

Figure 1: Layout of the system on the Workspace

B. Enter the pipe and junction data

The system is in place but now the input data for the pipes and junctions needs to be entered. Enter the 
following data in each Pipe and Junction Properties window.

All Pipes are Stainless Steel - ANSI, Schedule 10S, and have standard roughness. The rest of the pipe 
information is as follows:

Pipe # Size (inches) Length (meters)

1 8 23

2 8 7.5

3 8 1.5

4 5 1.5

5 5 1.5

6 8 1.5
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Pipe # Size (inches) Length (meters)

7 5 1.5

8 5 1.5

9 8 1.5

10 5 1.5

11 5 1.5

Because several of the pipes are the same, you can use the Global Pipe Edit tool to speed up the pro-
cess of entering the data. The Global Pipe Edit tool allows you to apply changes to multiple pipes at the 
same time.

 ØSelect Global Pipe Edit either from the Edit menu, or by selecting the Global Edit dropdown on the 
toolbar (blue globe symbol) and selecting the Global Pipe Edit option. This will open the Global Pipe Edit 
window.

 ØSelect Pipes P4, P5, P7, P8, P10, and P11 from the list of pipes as shown in Figure 2.

Figure 2: Global Pipe Edit window

 ØClick the Select Pipe Data button. This will open a template Pipe Properties window for entering the 
data to be applied to all of the selected pipes.
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 ØFill out the data for the selected pipes. When you have entered all of the data for the pipes, close 
the Pipe Properties window by selecting OK. The Global Pipe Edit window will now display a list of all of 
the parameters that may be applied to the selected pipes. The parameters are categorized as they are 
displayed on the tabs in the Pipe Properties window.

 ØSelect the All button above the Parameters to Change list, since for this example, you want all of 
the parameters for all of the selected pipes to be updated to the specified values. The Global Pipe Edit 
window should now appear as shown in Figure 3.

Figure 3: Global Pipe Edit window with all pipe parameters selected for updating

 ØApply the changes to the selected pipes by clicking the Apply Selections button. AFT xStream 
will notify you that the changes have been completed with a message in the bottom-left of the Global Pipe 
Edit window. At this point, all of the changes have been applied but not saved. If you wish to cancel all of 
the changes you just implemented, you may do so by clicking Cancel on the Global Pipe Edit window.

 ØSave the applied changes by clicking OK.

Note: The Guide button in the Global Edit windows may be used as a reminder of the required steps 
for the global edit process if needed.

 1. Assigned Flow J1
 a. Name = PD Compressor
 b. Elevation = 0 meters
 c. Mass Flow Rate = 41400 kg/hr
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Note: Be advised that the unit for mass flow is not the default, it is kg/hr as opposed to 
kg/s.

 d. Temperature = 21 deg. C
 2. Heat Exchanger J2

 a. Name = Natural Gas Heater
 b. Elevation =0 meters
 c. K = 6.6
 d. Steady Heat Rate =1035 kW

 3. Valve J3
 a. Elevation = 0 meters
 b. Kv = 8650
 c. xT = 0.3

 4. Valve J5
 a. Name = Diffusion Gas FCV
 b. Elevation = 0 meters
 c. Kv = 80
 d. xT = 0.7

 5. Valve J8
 a. Name = Premix Gas FCV #1
 b. Elevation = 0 meters
 c. Kv = 170
 d. xT = 0.7

 6. Valve J11
 a. Name = Premix Gas FCV #2
 b. Elevation = 0 meters
 c. Kv = 170
 d. xT = 0.7
 e. Click on the Transient Tab and enter the following data:

Time (seconds) Kv xT

0 170 0.7

0.01 0 0.7

2 0 0.7

 7. Assigned Pressures J6, J9, J12
 a. J6 Name = Combustion Basket #1
 b. J9 Name = Combustion Basket #2
 c. J12 Name = Combustion Basket #3
 d. Elevation = 0 meters
 e. Stagnation Pressure = 15.7 bar
 f. Temperature = 60 deg. C.
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 8. Junctions J4, J7, J10
 a. Elevation = 0 meters

C. Check if the pipe and junction data is complete

 ØOpen the List Undefined Objects window from the View menu or the Workspace Toolbar to verify if 
all pipes and junctions are specified. If not, the incomplete pipes or junctions will be listed. If undefined 
objects are present, go back to the incomplete pipes or junctions and enter the missing data.

 Step 2. Specify Analysis Setup

A. Specify the Fluid panel

 ØOpen the Analysis Setup window by clicking Analysis Setup on the Common Toolbar.
 ØSelect Methane from the AFT Standard fluid library, and click the Add to Model button.

Note: Methane is used to approximate natural gas in order to minimize the run time. This is typically a 
fair assumption for preliminary runs. If you need to model a real natural gas mixture, such as for 
a final run, then the NIST REFPROP library or the optional Chempak add-on can be used. Be 
aware that mixtures with multiple components may drastically increase the runtime. Limiting the 
mixture to 3 or 4 components is advised.

B. Specify the Pipe Sectioning and Output panel

 ØOpen the Pipe Sectioning and Output panel and specify the following:
 1. Minimum Number of Sections Per Pipe = 8
 2. Estimated Maximum Pipe Temperature During Transient = 60 deg. C

Note: If following along in the completed model file, the Estimated Maximum Pipe Temperature Dur-
ing Transient will have a different value. This will be discussed in later steps.
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Figure 4: Sectioning panel

C. Specify the Simulation Mode/Duration panel

 ØEnter a Stop Time of 2 seconds on the Simulation Mode/Duration panel from the Transient Con-
trol group. Verify the Time Simulation is set to Transient. Click the OK button.

 Step 3. Create scenarios to model different sectioning setups

A. Create scenarios

In this model, the following three types of Sectioning cases for the system are to be evaluated:

 1. 8 Sections Minimum per Pipe
 2. 4 Sections Minimum per Pipe
 3. 2 Sections Minimum per Pipe

To evaluate the three cases, we will utilize the Scenario Manager to create three scenarios for the three 
cases.

Open the Scenario Manager on the Quick Access Panel. Create a child scenario by either right-clicking 
on the Base Scenario and then selecting Create Child, or by first selecting the Base Scenario on the 

Scenario Manager on the Quick Access Panel and then selecting the Create Child icon  . Enter the 
name 8 Sections Minimum Per Pipe in the Create Child Scenario window, and select the OK button. The 
new 8 Sections Minimum Per Pipe scenario should now appear in the Scenario Manager on the Quick 
Access Panel below the Base Scenario. Select the Base Scenario and create another child named 4 Sec-
tions Minimum Per Pipe. Finally, create one more child and call it 2 Sections Minimum Per Pipe. The 
Child Scenarios should now be displayed as shown in Figure 5.
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Figure 5: Create model variants and keep them organized using the Scenario Manager on the Quick Access 
Panel

B. Set up scenarios

Child scenarios inherit data from their ancestor scenarios. As long as the data has not been modified in a 
child scenario, data parameters in the child scenario will have the same value as their parent. Scenarios 
can be loaded onto the Workspace by double-clicking their name in the Scenario Manager. The currently 
loaded scenario is indicated in the scenario tree with a green circle with a checkmark (Figure 5). Since 
the Base Scenario already has been set up with 8 Minimum Sections Per Pipe, the 8 Sections Minimum 
Per Pipe child does not need to be modified.
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 ØLoad the 4 Sections Minimum Per Pipe scenario by double-clicking the name in the Scenario Man-
ager. Open the Analysis Setup window from the Common Toolbar. Open the Pipe Sectioning and Output 
panel and  then click OK. 

 ØChange the Minimum Number of Sections Per Pipe to 4 from the Pipe Sectioning and Output 
panel in Analysis Setup, then click OK. The required input for this scenario is now complete.

 ØRepeat the steps above for the 2 Sections Minimum Per Pipe scenario, and change the value 
to 2.

 Step 4. Run the first scenario

 ØDouble-click the 8 Sections Minimum Per Pipe scenario in the Scenario Manager.
 ØClick the Run Model button on the Common Toolbar or select the option from the Analysis menu. 

AFT xStream will prompt you to save the model if you have not done so already, then will open the Solu-
tion Progress window.

 Step 5. Review the results

 ØClick the Output button. This will take you to the Output window, which will display any warnings if 
they exist. There should be a warning indicating that the maximum transient pipe temperature was higher 
than the estimate as well as a caution that the maximum transient pipe mach number was significantly 
lower than the estimate (see Figure 6). The Estimated Maximum Pipe Temperature During Transient is 
critical to the calculation of transient conditions due to its necessity in the Method of Characteristics. A 
review on how the MOC handles sectioning and tabulation can be found here.
The Estimated Maximum Pipe Temperature During Transient is used to calculate the sonic velocity of the 
fluid, which is then used to create the upper boundary of the characteristic grid. If the maximum tem-
perature during the transient exceeds the specified Estimated Maximum Pipe Temperature During Tran-
sient and the flow is sonic, the Method of Characteristics may have to extrapolate data, which can lead to 
instability and will stop the transient solver. In this model, sonic velocity was not reached when the tem-
perature was higher than the estimated maximum. However, to ensure that this model can handle sonic 
flow, we will re-run the model with a higher Estimated Maximum Pipe Temperature During Transient.
The Maximum Transient Pipe Mach Number warning indicates that error could be introduced through 
having a Mach Number substantially lower than the Maximum Transient Pipe Mach Number used for the 
calculation (in this case, the xStream default value of one). This caution will be ignored in this example for 
simplicity.

Figure 6: The maximum transient pipe temperature exceeds estimated maximum temperature warning indic-
ates that the model is at risk of instability if changes are made
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 Step 6. Adjust the Pipe Sectioning panel

 ØDouble-click the Base Scenario in the Scenario Manager. Open the Analysis Setup window from the 
Common Toolbar and select  Change the  Click OK.

 ØChange the Estimated Maximum Pipe Temperature During Transient  to 80 deg. C from the Pipe 
Sectioning and Output panel.

Important: Making this change in the Base Scenario will save time since it will propagate the change 
to all scenarios automatically.

 Step 7. Re-run the model and review results

A. Review Output window

 ØRe-run the 8 Sections Minimum Per Pipe scenario, then proceed to the Output window. There 
should be a caution indicating that the maximum transient pipe mach number was significantly lower than 
the estimate. Disregard this caution as discussed previously.
ØSelect the Transient Max/Min tab as shown in Figure 7. Here we can see the maximum static tem-
peratures in the pipes (scroll to the right in the Pipes section of the Output). Note that the values here are 
accounting for the entire length of the pipe, and the corresponding Station at which the max/min values 
occurred is reported.

The max static temperature for the entire system occurs at the inlet of Pipe P2 (Station 0), with a 
value of about 77.6 deg. C. This is intuitive because the Pipe P2 inlet is equivalent to the J2 Heat 
Exchanger outlet, which adds heat to the system. Furthermore, if we observe the pipes that feed the com-
bustion baskets (Pipes P5, P8, and P11) we can see that max static temperatures occur at the inlets (Sta-
tion 0). Therefore, to find the max temperatures for the pipe outlets, which correspond to the combustion 
basket inlets, we will need to create transient graphs.

Figure 7: Transient Max/Min tab in the Output window
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B. Graph the results

Go to the Graph Results window by clicking on the Graph Results tab  or pressing CTRL+G on the key-
board.

 ØCreate a graph that shows the temperature over time at the entrance to Combustion Basket #1 
using the following steps (Figure 8):

 1. From the Graph Control tab on the Quick Access Panel, select the Transient Pipe tab
 2. Select Pipe P5 and add the outlet station
 3. Verify that the time units are set to seconds
 4. In the Parameters definition area, select Temperature Static with units of deg. C
 5. Click the Generate button

Figure 8: Graph Parameters for Combustion Basket #1 Inlet

 ØRight-click on the resulting graph and select Show Cross Hair, or enable it via the icon on the 
Graph Toolbar. Moving your mouse cursor over the graph will display the numerical values of the graph 
data points. This can be used to find the max value, or you can right-click on the graph and select Copy 
X-Y Data, which can be pasted into Excel or other software utilities for further inspection.

The max temperature at the inlet of Combustion Basket #1 is about 72.3 deg. C. Note that this tem-
perature is lower than the temperature shown on the Transient Max/Min tab because this graph is show-
ing the outlet of Pipe P5, while the maximum temperature in Pipe P5 occurs at the inlet of the pipe. The 
maximum temperature for the outlet of Pipe P5 occurs at about 0.55 seconds before trending back 
towards the previous steady-state temperature of 60 deg. C as the flow normalizes.

Note: The Assigned Pressure junctions in this model were defined with Stagnation Temperature. 
Therefore, the Static Temperature will be lower than the Stagnation value, as is seen in Figure 
9. In the case of Pipe P11 where the flow is zero after the valve closure, the Static and Stag-
nation Temperatures will be equal.
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Figure 9: Temperature Static vs Time for the inlet to Combustion Basket #1

To easily recreate this graph in the other scenarios or in the future, it can be added into the Graph List 
Manager on the Quick Access Panel.

 ØRight-click the graph and select Add Graph to List from the context menu, or use the icon from the 

Graph Results Toolbar . Give the graph a name, such as “Combustion Basket #1 Temperature vs 
Time”, then click OK. The graph will be added to the currently selected folder in the Graph List Manager. 
Note that graphs added to the Graph List Manager are not permanently saved until the model is saved 
again. Also be aware that only the graph settings are saved as opposed to the graph data.

 ØCreate the same graph above for Combustion Basket #2 and #3, and save them as Graph List 
Items. Combustion Basket #2 corresponds to the Pipe P8 Outlet station, and Combustion Basket #3 cor-
responds to the Pipe P11 Outlet station. Combustion Basket #2 will have a similar graph with a slightly 
lower maximum. Combustion Basket #3 will have a flat graph due to the valve closure, and the tem-
perature settles out to the boundary condition of the J12 Assigned Pressure since Pipe P11 is adiabatic 
with no heat transfer.

Table 1: Summary of the Combustion Basket max static temperatures for the 8 Sections scenario

Combustion Basket Max Transient Temperature (deg. C)

#1 (Pipe P5 Outlet) 72.3

#2 (Pipe P8 Outlet) 71.9

#3 (Pipe P11 Outlet) 60.0
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C. Animate the results

AFT xStream can animate output along pipeline paths in your model in the Graph Results window. This 
feature can help you understand how your system will respond when a transient event occurs. You can 
also animate multiple graphs at the same time.

Here, you will animate the temperature static, pressure static, and velocity along the flow path between 
the positive displacement compressor and Combustion Basket #1 in order to gain an understanding of 
how these parameters respond as the control valve closes.

 ØSpecify the following graph settings (Figure 10):

 1. Create a new graph tab by clicking the New Tab button located in the bottom-right (green “+” 
icon).

 2. Select the Profile tab under the Graph Control tab in the Quick Access Panel.
 3. Select Pipes P1 through P5.
 4. Ensure the Length Units are meters for the Profile graph.
 5. Select the option to Animate Using Output. To use this feature, data from all pipe stations must be 

saved (which is the default on the Pipe Sectioning and Output panel), otherwise the option will be 
grayed out.

 6. Ensure that the Animation Time Units are set to seconds.
 7. Add two additional parameters using the Add button, and specify the three parameters:

 a. Temperature Static with units of deg. C
 b. Pressure Static with units of bar
 c. Velocity with units of meters/sec

 8. Check the Mx and Mn boxes next to the graph parameters to plot the maximum and minimum val-
ues on the graph.

 9. Click the Generate button.
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Figure 10: Graph parameters for Combustion Basket #1 animated profile

Note: Figure 11 have been modified to increase clarity.

Figure 11: Flow to Combustion Basket #1 profile animation

Additional animation control features appear at the top of the Graph Results window (Figure 11). Press 
the Play button and watch the temperature, pressure, and velocity responses move between the max-
imum and minimum values. This animation can also be recorded to a file.

 ØAdd the graph to the Graph list manager by either right clicking on the graph or using the Add 
Graph to List icon. Give it a name, such as "Combustion Basket #1 Animated Profile".

Playing the animation reveals that the highest temperature in the system is observed at the J2 heat 
exchanger. It should also be noted that the rise to this maximum temperature occurs when the pressure 
wave from the valve closing passes through this junction. However, this heightened temperature is not 
immediately seen by the combustion baskets downstream because the gas velocity throughout the sys-
tem drops immediately following the valve closure. Instead, the heightened temperature moves slowly 
downstream until the gas wave is reflected at the positive displacement compressor and passes through 
the heat exchanger going the opposite direction. This causes the local gas velocity to rise and causes the 
temperature wave to move downstream towards the combustion baskets more quickly. This wave even-
tually reaches Combustion Basket #1 at around Time = 0.55 seconds, at which point the inlet to the com-
bustion basket reaches its maximum temperature.
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 Step 8. Run the other scenarios and graph the results

 ØLoad and run the other two scenarios using the Scenario Manager.
 ØObserve the Transient Max/Min tab for each scenario, and note the overall system max static 

temperature. The max temperature and pressure during both the steady-state and the transient sim-
ulation can also be found at the bottom of the General tab in the Output. A summary of the system max 
temperature for each scenario is shown below in Table 2.

Table 2: Overall system max static temperatures for the three sectioning counts

Scenario System Max Transient Temperature (deg. C)

8 Sections 77.6

4 Sections 76.0

2 Sections 75.2

 ØCreate the same graphs from the previous steps for each of the scenarios by double-clicking on 
the saved Graph List Items in the Graph List Manager.

Table 3: Combustion Basket max static temperatures for the three sectioning counts

Scenario

Combustion 
Basket #1 Max 
Transient Tem-
perature (deg. 

C)

Combustion 
Basket #2 Max 
Transient Tem-
perature (deg. 

C)

Combustion 
Basket #3 Max 
Transient Tem-
perature (deg. 

C)

8 Sections 72.3 71.9 60.0

4 Sections 70.7 70.3 60.0

2 Sections 69.6 69.2 60.0

Conclusion

Use of transient conditions within a valve junction allowed us to model the effects of an unexpected valve 
closure in a system. The Scenario Manager was used to easily create variations of the model that ana-
lyzed the effect of different pipe sectioning. While this example was focused on temperature, it also 
showed that values such as pressure and velocity can be tracked by AFT xStream. The overall maximum 
temperature for the system was found in the Transient Max/Min tab of the Output, and also at the bottom 
of the General tab for each scenario (Table 2). Different pipe sectioning resulted in different max tem-
peratures (Table 3).

Additionally, this example identified the Estimated Maximum Temperature During Transient as a critical 
variable in the tabulation of the transient results. This value sets the boundary for the characteristic grid 
used by the Method of Characteristics. If sonic choking occurs at a temperature higher than the 
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estimated maximum, the model may not converge. As such, this value should be conservatively high on 
early runs of a model and then refined once the temperature that the transient approaches is known.
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Fluid Library Comparison - Steam Turbine Shutdown Example 

Summary

Two turbines in a high pressure steam system are simultaneously shut down while a bypass line is 
opened. Evaluate the maximum pressure at the turbine inlets. Additionally, quantify the mass flow rate 
through the bypass valve throughout the transient and perform an analysis on whether condensation or 
two-phase flow occurs in the bypass line. Lastly, conduct a sensitivity analysis based on the selection of 
different fluid library data.

Topics Covered

 l Using the isometric grid to create a model
 l Modeling a transient turbine shutdown
 l Creating transient graphs
 l Animating profile graphs
 l Evaluating the selection of a fluid library

Required Knowledge

This example assumes that the user has some familiarity with AFT xStream such as placing junctions, 
connecting pipes, and entering pipe and junction properties. Refer to the Beginner - Tank Blowdown 
example for more information on these topics.

Model File

A completed version of the model file can be referenced from the Examples folder as part of the AFT 
xStream installation:

C:\AFT Products\AFT xStream 3\Examples

 l Metric - Fluid Library Comparison - Steam Turbine Shutdown.xtr
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 Step 1. Build the model

A. Place the pipes and junctions

Isometric Drawing Mode

The previous example models were drawn using the default Pipe Drawing Mode, 2D Freeform.  
AFT xStream has two additional available drawing modes, 2D Orthogonal and Isometric. In this model, 
the isometric mode is used to visually interpret the pipe layout and provide a better understanding of the 
system.

 1. From the Arrange menu, select the option to Show Grid.
 2. Open the Arrange menu again, go to Pipe Drawing Mode, and select Isometric.
 3. Place the junctions as shown in Figure 1.
 4. Click the Pipe Drawing Tool and draw the pipes in the model as shown. When drawing segmented 

pipes such as P5, a red dashed preview line will show how the pipe will be drawn on the isometric 
grid. As you are drawing a pipe, you can change the preview line by clicking any arrow key on your 
keyboard or scrolling the scroll wheel on your mouse.

 5. Use the Rotate Icons buttons on the Workspace Toolbar, or right-click on the junction and select 
the Auto-rotate option to automatically align the junction with the connected pipes. Alternatively, 
Customize Icon can be selected from the right-click menu to manually choose an icon/orientation.

 6. The grid can be shown or turned off in the Arrange menu, as shown in Figure 2.

Note: You can hold the "Alt" key while adjusting a pipe by the endpoint to add an additional segment. 
This can be used with the arrow key or mouse scroll wheel to change between different preview 
line options.
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Figure 1: Isometric layout with the grid shown

Figure 2: Isometric layout with the grid turned off

B. Enter the pipe and junction data

The system is in place but now the  input data for the pipes and junctions needs to be entered. Double-
click each pipe or junction and enter the following data in the Pipe or Junction Properties window.

All pipe materials are User Specified in this model (see Figure 3). Use the Absolute Roughness of Steel 
(0.004572 cm) as the Friction Model, along with the following data:
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Note: The pipes below are user defined as they utilize non-standard pipe sizes.

Pipe # Inner Diameter (cm) Length (meters)

1 34 30.5

2 30.5 20

3 30.5 15

4 30.5 4.5

5 30.5 4.5

6 15.5 2

7 10 2

8 15.5 3

9 15.5 1.5

10 15.5 6

11 49 6

12 49 1.5

Figure 3: User Specified Pipe Properties window
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 1. Assigned Pressure J1
 a. Name = High Pressure Steam Inlet
 b. Elevation = 0 meters         
 c. Static Pressure = 170 bar         
 d. Temperature = 570 deg. C         

 2. Area Change J2
 a. Type = Conical Transition
 b. Angle = 45 degrees

 3. Branches J3, J4, and J7
 a. Elevation = 0 meters         

 4. Assigned Flows J5 and J6
 a. J5 Name = Turbine 1
 b. J6 Name = Turbine 2
 c. Elevation = 0 meters         
 d. Mass Flowrate = 228600 kg/hr

Note: Be advised that the unit for mass flow is not the default, it is kg/hr as opposed to 
kg/s.

 e. Temperature =570 deg. C         
 5. Dead End J8

 a. Elevation = 0 meters         
 6. Bend J9

 a. Elevation = 0 meters         
 b. Type = Standard Elbow (knee, threaded)

 7. Bend J10, J12
 a. Elevation = 1.5 meters         
 b. Type = Standard Elbow (knee, threaded)

 8. Valve J11
 a. Kv = 2600
 b. xT = 0.7
 c. Elevation = 1.5 meters
 d. On the Optional tab, set the Special Condition to Closed
 e. Click on the Transient Tab and enter the following data:

Time (seconds) Kv xT

0 0 0.7

2 2600 0.7

5 2600 0.7
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 9. Assigned Pressure J13
 a. Name = Steam Bypass Outlet
 b. Elevation = 0 meters
 c. Static Pressure = 30 bar
 d. Static Temperature = 350 deg. C

C. Check if the pipes and junctions are defined

 ØClick the        List Undefined Objects button to see if the model is fully defined. If it is not, the undefined 
pipes and junctions window will       show a list of incomplete items. If undefined objects are present, go back 
to the incomplete pipes or      junctions and enter the missing data.

 Step 2. Specify Analysis Setup

A. Specify the Fluid panel

 ØOpen the Analysis Setup window from the Common      Toolbar and open the       Fluid panel.
 ØSelect Steam from the AFT Standard fluid library, and click the Add to Model button.

B. Specify the Pipe Sectioning and Output panel

 ØOpen the Pipe Sectioning and Output panel and specify the following:
 1. Minimum Number of Sections Per Pipe = 1
 2. Estimated Maximum Pipe Temperature During Transient = 600 deg. C

Figure 4: Pipe Sectioning and Output panel
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C. Specify the Simulation Mode/Duration panel

 ØEnter a Stop Time of 5 seconds on the Simulation Mode/Duration panel from the Transient Con-
trol group. Verify the Time Simulation is set to Transient. Click the OK button.

 Step 3. Run the model

 ØClick the Run Model button on the Common Toolbar or select the option from the Analysis menu. 
AFT xStream will prompt you to save the model if you have not done so already, then will open the Solu-
tion Progress window.

 Step 4. Graph the results

A. Graph the transient pressures at the turbines

 ØGo to the Graph Results window. The first graph we will make will show the Static Pressure at the 
entrance to the steam turbines.

 1. From the Graph Control tab on the Quick Access Panel, select the Transient Pipe tab
 2. Select the Pipe P5 outlet station
 3. Ensure that the Time Units are set to seconds
 4. Select Pressure Static with units of bar in the Parameters definition area
 5. Click Generate

This will generate the graph shown in Figure 6. The pressure variation is difficult to see using the default 
y-axis scale so we will adjust the scale using the following steps:

 1. Right-click the y-axis
 2. Un-check the Auto Scale box
 3. Set the Minimum to 150 bar, the Maximum to 190 bar, and the Major Val to 10 (see Figure 7)

The graph should now match Figure 8. When the model contains multiple transient events, transient pipe 
graphs allow the user to see the cumulative impact of the events on system pressure. Note that the first 
peak contains an oscillation, which is attributable to the opening of the bypass valve.



Fluid Library Comparison - Steam Turbine Shutdown Example

- 646 -

Figure 5: Graph Parameters for the inlet pressure to the turbines



Fluid Library Comparison - Steam Turbine Shutdown Example

- 647 -

Figure 6: Static pressure at steam turbine 2 entrance

Figure 7: Axis Modification Window opened by right-clicking the y-axis
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Figure 8: Static pressure at steam turbine 2 entrance with modified y-axis

B. Animate the bypass line temperature and pressure

We will also animate the profile of the bypass line temperature and pressure in order to determine 
whether condensation occurs.

 1. Create a new graph tab by clicking the New Tab button located in the bottom-right (green “+” 
icon).

 2. Select the Profile tab under the Graph Control tab in the Quick Access Panel.
 3. Select pipes 6, 8, 9, and 10.
 4. Verify the Length Units are set to meters.
 5. Select the option to Animate Using Output. To use this feature, data from all pipe stations must be 

saved (which is the default on the Pipe Sectioning and Output panel), otherwise the option will be 
grayed out.

 6. Ensure that the Animation Time Units are set to seconds.
 7. Add two additional parameter using the Add button, and specify the three parameters:

 a. Pressure Static with units of bar
 b. Temperature Static with units of deg. C
 c. Temperature Saturation with units of deg. C

 8. Make Temperature Saturation a secondary axis parameter by double-clicking in the empty box to 
the left of the name. Alternatively, select the parameter and click the right facing blue arrow above 
the list of parameters. If done successfully, the Temperature Saturation parameter should appear 
indented under Temperature Static.

 9. Uncheck the Mx and Mn boxes only for the Temperature Saturation parameter.
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 10. Click the Generate button.

 11. Adjust the y-axis scaling for both Temperature Static and Temperature Saturation as follows:

 a. Right-click on the temperature y-axis and uncheck the Auto Scale box
 b. Set the Minimum to 300, Maximum to 600, and Major Val to 50.

Important: Ensure both the primary (left) and secondary (right) y-axes have the same max and 
min limits when both parameters have the same unit. This allows for easy visual com-
parison of the parameters.

 12. Click the Play button to review the animation. The animation speed can be increased by using the 
Speed Slider at the right side of the playback controls.

Figure 9: Graph Parameters for the bypass line animated profile

Figure 10 is useful to determine whether or not condensation occurs in the system. Condensation can 
occur by a rise in pressure, a decrease in temperature, or a combination of both. Each fluid library con-
tains saturation line data and warning messages will be given in the Output if the fluid properties drop into 
the two-phase region. In this model the temperatures stay well above the saturation line at all times, 
showing that the steam is not close to condensing.

Reminder: AFT xStream assumes all gases are superheated and does not model two-phase flow. 
Saturation data is only used for predicting the presence of saturation conditions, and the fun-
damental equations in the Solver assume the gas is single phase.
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Figure 10: Bypass line animation profile

C. Graph the mass flow rate    and pressure drop through the bypass valve

Lastly, we shall create a graph to show the mass flow rate and the pressure drop through the    bypass 
valve to gain insight into how the flow develops in the bypass line.

 1. Create a new graph tab.
 2. From the Graph Control tab on the Quick Access Panel, select the Transient Jct tab.
 3. In the Select Junctions section, select J11 and click the “>” arrow.
 4. Add a second parameter in the Select Parameters section, and specify the two parameters:

 a. Mass Flow Rate Inlet with units of kg/hr
 b. Pressure Drop Stagnation Total with units of bar

 5. Click the Generate button.

As shown in Figure 12, the flow rate increases and the pressure drop decreases as the valve opens over 
time. While the observed trends for mass flow rate and pressure drop are typical for a valve that is open-
ing, it is still worthwhile to make Transient Jct graphs when multiple transient events occur in order to fully 
understand the interactions between them.
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Note:Figure 12 has modified axes titles and its legend removed for clarity.

Figure 11: Graph Parameters for the Bypass Valve mass flow and pressure drop

Figure 12: Bypass valve mass flow rate and pressure drop transient
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 Step 5. Evaluate the effects of changing fluid libraries

A. Review the results of other libraries

In addition to the AFT Standard fluid library, the model built in this example was run using Steam from the 
Chempak, NIST REFPROP, and ASME Steam libraries. Similar results to the AFT Standard fluid run 
were obtained for both the bypass valve and the turbine pressure vs time graph, so these results are not 
shown below. Nevertheless, it is sensible to run your system using different fluid libraries as they have 
been known to impact results. The temperature profile for the bypass line showed more significant dif-
ferences, as is shown below comparing the results using NIST REFPROP vs AFT Standard (Figure 13). 
ASME Steam and Chempak gave nearly identical results to NIST, and therefore are not shown.

Note that the minimum temperature reached at J11 is about 32 degrees  higher in the AFT Standard fluid 
library run compared to the NIST REFPROP run. The results for each fluid library showed that no con-
densation was found, and no warnings were given in the Output.

Figure 13: Bypass line profile using the NIST REFPROP fluid library

B. Advice for preliminary runs

Obtaining final results from AFT xStream will require multiple iterations. To effectively work through those 
iterations, we recommend the iterative process begins with the following steps:
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Step 1: Run the steady-state model with multiple fluid libraries

It is recommended that the first runs are completed using a simplified version of your model in the AFT 
Arrow™ Steady-State Solver with each fluid property model before considering transient conditions. This 
will allow for larger issues in the model to be caught before having to commit to Transient runs, which are 
more time consuming. This also can inform the types of variables that need to be considered during 
refined runs (i.e. if the AFT Arrow™ steady-state runs are close to the saturation temperature, con-
densation is a phenomenon that should be monitored in subsequent runs).

Step 2: Complete a transient run using an AFT Standard fluid with minimal sectioning

You should then run your simplified model in the Transient Solver using an AFT Standard fluid with min-
imal sectioning (i.e. a lower value for the Minimum Number of Sections Per Pipe setting on the Pipe Sec-
tioning and Output panel in Analysis Setup). This is not always possible, such as when mixtures are 
present, but this step should always be attempted if allowable. This will allow for larger issues to be 
caught before committing to extended run times. Only after you are satisfied with the model should you 
attempt increasing the number of sections.

C. Selection of fluid property model for final runs

A number of factors must be taken into consideration while selecting the fluid library for an AFT xStream 
model. If there are no mixtures, and the compound is present in the AFT Standard library, it is recom-
mended that the AFT Standard library be the first library used. AFT Standard has the shortest run times 
of the different libraries and is an excellent choice for early runs focused on troubleshooting the model. 
However, if there is a need to model mixtures, and simplifying the system is not possible, initial runs 
should be conducted with NIST REFPROP or Chempak.

NIST REFPROP and Chempak both have greater accuracy than AFT Standard and can model mixtures. 
However, both have slower run times than AFT Standard. Chempak typically runs faster than NIST 
REFPROP with comparable accuracy. However, Chempak is an optional add-on for purchase while the 
NIST REFPROP library comes standard with AFT xStream.

Lastly, ASME Steam provides a well-established, trustworthy source of steam data. ASME Steam typ-
ically has the longest run times, and it is recommended that a high processing power computer paired 
with ample time be used to run your analysis if this library is selected. If either of those elements are 
unavailable, it is recommended that one of the other libraries be used, with the added note that NIST 
REFPROP is the most similar in accuracy to ASME Steam.

Table 1 summarizes the run times for this example with the different fluid libraries. The run times will be 
affected by the specifications of your computer as well as the memory available. Table 1 shows data for 
runs conducted on the laptops at AFT as of publication.

Additionally, Table 2 provides a library compatibility chart to assist with fluid property model selection.

It should be noted that if a tremendous amount of accuracy is needed, appropriate library selection will 
not be sufficient to give a high accuracy model. The single parameter that will have the greatest effect on 
accuracy is the Minimum Number of Sections per Pipe in the Sectioning panel. Ultimately, appropriate 
sectioning remains the single most important factor in creating a high accuracy model and should be 
weighed just as heavily as the fluid library when setting the parameters your transient gas system uses.
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Table 1: Comparison of run times with various fluid libraries

Steam Turbine Shutdown Approx Run Times

Fluid Property Model Run        Time

AFT        Standard - 1 Section 2 - 3        minutes

Chempak - 1 Section 4 - 10        minutes

NIST        REFPROP - 1 Section 0.9 -        1.4 hours

AFT        Standard - 10 Sections 1 -        2 hours

ASME        Steam - 1 Section 3 -        4 hours

Table 2: Compatibility chart for fluid library selection for final runs

Fluid Library
Model Requirements

Mixtures Condensation 
Data

System 
Troubleshooting Final Runs Complex 

Systems*

AFT Standard   P P**   P

NIST 
REFPROP P P   P P

Chempak P P   P P

ASME Steam   P   P  

* Evaluating the complexity of a system is most easily done in early runs of the model. It is suggested that 
all early runs should be run with a version of AFT Standard if they can, and the run time recorded. This 
run time should inform your decision on which fluid library is needed to run the more thorough runs when 
high accuracy results are needed. As seen from Table 1, the run times can vary wildly between the 4 lib-
raries, so make sure you evaluate your time constraints and accuracy needs when weighing this 
decision. Factors that can impact the run time include the ratio in the length of the smallest pipe to the 
largest pipe, presence of mixtures, usage of Junctions containing resistance curves, and the presence of 
sonic choking. See the Reducing Run Time section for more information.

** It is strongly recommended that all runs used to troubleshoot the design of the system are run using 
AFT Standard.

Conclusion

Graphs were created showing the turbine inlet pressure over time, and animating the pressure and tem-
perature in the bypass line. It was determined that no condensation occurs, regardless of which fluid lib-
rary was used.
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A standard procedure for initial and final runs was discussed:

 l Step 1: Run the steady-state model with multiple fluid libraries
 l Step 2: Complete a transient run using an AFT Standard fluid with minimal sectioning

Lastly, a comparison of the different fluid libraries was discussed. AFT Standard should be used for initial 
runs and troubleshooting (runs faster). NIST REFPROP, Chempak, and ASME Steam libraries should be 
used for final runs where higher accuracy is required; however, the trade off is that the model will have 
significantly longer run times.
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Pipe Forces from Turbine Shutdown Example 

Summary

Two turbines in a high pressure steam system have their valves simultaneously shut off, which causes 
the system to experience transient forces. This example describes how to determine the transient force 
data for the piping system during the steam flow transient. It also evaluates the effect of varying the time 
to close the valves on force magnitude. Lastly, this example shows how to export the force results to a 
force file to  use in piping stress software.

Topics Covered

 l Calculating the forces associated with a transient event
 l Using the Scenario Comparison Tool to compare scenarios
 l Exporting force sets to CAESAR II®

Required Knowledge

This example assumes that the user has some familiarity with AFT xStream such as placing junctions, 
connecting pipes, and entering pipe and junction properties. Refer to the Beginner - Tank Blowdown 
example for more information on these topics.

Model File

A partially completed model file will be utilized as the starting point for this example. A completed version 
of the model file can be referenced if desired. Both the initial and final model files can be found in the 
Examples folder as part of the AFT xStream installation:

C:\AFT Products\AFT xStream 3\Examples

 l Metric - Pipe Forces from Turbine Shutdown - Initial.xtr
 l Metric - Pipe Forces from Turbine Shutdown - Final.xtr

 Step 1. Open the model file

For this example, we will be starting from a pre-built model file which has been partially set up for your 
convenience. From either the Startup window or the File menu, browse to the model file with the name 
shown above, using the variant with “- Initial” appended to the file name. The Workspace should appear 
as shown in Figure 1.
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Figure 1: Model layout

 Step 2. Specify the Pipe Sectioning and Output panel

 ØOpen the Pipe Sectioning and Output panel in the Analysis Setup window. Define the Minimum 
Number of Sections Per Pipe as 1 section and the Estimated Maximum Pipe Temperature During Tran-
sient as 600 degrees C.

Figure 2: Pipe Sectioning and Output panel
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 Step 3. Specify the Simulation Mode/Duration panel

 ØOpen the Simulation Mode/Duration panel from the Transient Control group. Enter the Stop 
Time as 1 second. Click OK to save and close the Analysis Setup window.

 Step 4. Specify Force Sets

 ØOpen the Force Definitions panel from the Forces group.

We will first add one Force Set from the Workspace.

A. Force Types

The Difference force type is intended to model the specific case where all of the following criteria is true:

 1. The force is between a pair of 90 degree elbows
 2. The force is an axial pipe force
 3. All pipes, fittings, and components between the elbow pair are in-line

The force equations in the Solver are specific to this geometry. The pipes and components between the 
elbow pair can be horizontal, vertical, or sloped, but the axial component of the fluid weight is not accoun-
ted for in the forces. AFT xStream only accounts for hydraulic forces, or those acting on the pipe from the 
fluid. Elevation and hydrostatic pressure are accounted for in the pressure and flow solution.

Figure 3: Schematic of the Difference force type

The Point force type would be used for calculating the force at  a Dead End junction. It is calculated using 
the difference in fluid pressure and ambient pressure, multiplied by the pipe area.

The Difference Exit force type would be used between a single 90 degree elbow and a location where the 
fluid is leaving the system, such as an exit valve, exit orifice, or nozzle.

The force sets in this example will use the Difference force type to calculate the axial forces between 90 
degree elbow pairs.
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B. Defining Force Sets

Force sets can be defined from the Workspace, or from within Analysis Setup. We will first add one Force 
Set from the Workspace. Generally it is best to represent each elbow with a unique junction on the Work-
space (either an Elbow or Branch). This example assumes that the static pressure loss in the elbows is 
negligible, and therefore, they are modeled as Branch junctions which are lossless.

 ØOn the Workspace, right-click on Pipe P2 and from the right-click menu select Create a Force Set 
with Selected Pipe. Select the Use Pipe Information radio button and un-check the Include Appended 
Text option (Figure 4). Click Create. This will open the Force Definitions panel of the Analysis Setup win-
dow. The Force Definitions panel should appear as shown in Figure 5.

AFT xStream can only determine axial forces down a pipe in the direction defined as forward by the force 
set definition. As such, AFT xStream has no knowledge of the three-dimensional orientation of a given 
force set. For example, a vertical pipe and a horizontal pipe that both have the same force magnitude 
would be indistinguishable in AFT xStream. The force set definition informs the sign of the force, with a 
positive value indicating a force pushing from the start location to the end location, and a negative value 
indicating the converse.

If a more robust view of the 3D orientation of the pipes is required, directional information can be entered 
using the optional Force Unit Vector columns. The Force Unit Vectors do not impact AFT xStream's cal-
culations, but may be useful to export the output to  piping stress analysis software as discussed in Step 
10

Note: Only single pipes can be added as a Difference force set type from the Workspace.

Figure 4: Adding a force set from the Workspace  using the right-click menu
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Figure 5: First Force Set added to the Force Definitions panel in the Analysis Setup window

The remaining force sets will be defined inside the Force Definitions panel.

 ØDefine a force set by clicking New, selecting the Force Type (in this example, we will be using Dif-
ference because all force sets are between 90 degree elbow pairs), entering a name, and defining the 
starting and ending locations of the force set. Set up the force sets as shown in Figure 6. Click OK to save 
and close the Analysis Setup window.

 1. P2, Difference, P2 Inlet to P2 Outlet (previously created from the Workspace)
 2. P3, Difference, P3 Inlet to P3 Outlet
 3. P4, Difference, P4 Inlet to P4 Outlet

 ØDouble-Check Force Set Assumptions: It is important to consider if the force sets adhere to the 
assumptions mentioned previously which apply to the Difference force type. All of the force sets are loc-
ated between pairs of 90 degree elbows (represented as lossless Branch junctions). Furthermore, each 
force set spans a single pipe and there are no branching paths in the middle of the force sets. Therefore, 
the defined Difference force sets are valid and compatible with the equations programmed into AFT 
xStream.

Note: A Difference force set that spans Pipes P5-P6 would be between a pair of 90 degree elbows, 
and would be horizontally in-line; however, it would not be valid since there is a branching flow 
path in the middle. Even if the flow path from Pipe P12 to the closed bypass valve starts as stag-
nant in the steady-state, it can be affected by the transient, and could potentially serve as an 
anchoring support for Pipes P5 and P6. The same applies to Pipe P7, where the Difference 
force set would not be valid due to the branching flow at the endpoint.
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Figure 6: Completed Force Definitions panel in the Analysis Setup window

 Step 5. Create child scenarios using the Scenario Manager

A. Create scenarios

In this model, we will evaluate three different valve closure durations for the system:

 1. 0.1 Second Valve Closure
 2. 0.25 Second Valve Closure
 3. 0.5 Second Valve Closure

We will create three child scenarios to model the three cases.

 ØGo to the Scenario Manager on the Quick Access Panel. Create a child scenario by either right-
clicking on the Base Scenario and then selecting Create Child, or by first selecting the Base Scenario 

and then selecting the Create Child icon . Enter the name "0.1 Second Valve Closure" in the Create 
Child Scenario window, and click OK. The new  scenario should now appear in the Scenario Manager on 
the Quick Access Panel below the Base Scenario.

 ØRight-click the Base Scenario in the Quick Access Panel. Create another child and call it "0.25 
Second Valve Closure". Finally, create one more child and call it "0.5 Second Valve Closure". The child 
scenarios should now be displayed as shown in Figure 7.
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Figure 7: Scenario Tree with additional child scenarios created

B. Define the child scenarios

Since the "0.1 Second Valve Closure" scenario uses the same transient definitions as the base scenario, 
we do not need to modify it. Having a duplicate of the parent scenario is useful for organizing Multi-Scen-
ario graph selections and keeping your scenario tree intuitive. We will set up the remaining scenarios 
using the following steps:

 1. Load the "0.25 Second Valve Closure" scenario by double-clicking the name in the Scenario Man-
ager.

 2. Open the Assigned Flow Properties window for Assigned Flow J10 and open the Transient tab. 
Enter the following data:

Time (seconds) Mass Flow(kg/sec) Static Temperature (deg. C)

0 62.75 570

0.25 0 570

1 0 570

 3. Enter the same Transient Data for Assigned Flow J12.
 4. Open the Child Scenario "0.5 Second Valve Closure" from the Scenario Manager.
 5. Open the Assigned Flow Properties window for Assigned Flow J10 and open the Transient tab. 

Enter the following data:

Time (seconds) Mass Flow(kg/sec) Static Temperature (deg. C)

0 62.75 570

0.5 0 570

1 0 570

 6. Enter the same Transient Data for Assigned Flow J12.

 Step 6. Compare child scenarios using the Scenario Comparison Tool

The three scenarios created should be identical except for the different transient data. To confirm the 
scenarios are otherwise identical, we will use the Scenario Comparison Tool.
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 1. Load the "0.1 Second Valve Closure" scenario from the Scenario Manager.
 2. In the Tools menu, select the Scenario Comparison Tool.
 3. In the Scenario Comparison - Selection window (Figure 8), select the Siblings option.
 4. Click Show Comparison.
 5. In the Scenario Comparison Grid, set the Item and Parameter sliders to show Differences. Also 

set the Highlight Unique Values slider to Yes.

The Scenario Comparison Tool will run a comparison of all Pipe and Junction Properties as well as the 
General Properties used in each scenario and highlight any differences in the Scenario Comparison 
Grid. In this model, the only highlighted differences should be for the First Transient Data parameter for 
junctions J10 and J12 (Figure 9). Note that each column in the Scenario Comparison Grid is highlighted 
in a different color. This indicates that each scenario possesses a unique value for the given parameters. 
Click close to exit the Scenario Comparison Tool.

Figure 8: Scenario Comparison Tool - Selection window

Figure 9: Scenario Comparison Grid of the sibling scenarios



Pipe Forces from Turbine Shutdown Example

- 664 -

 Step 7. Run the first scenario

 ØDouble-click the "0.1 Second Valve Closure" child scenario in the Scenario Manager. Select 
Run Model from the Analysis menu. This will open the Solution Progress window. Once finished, click 
Output on the Solution Progress window.

 Step 8. View the results

A. Open the Forces tab

 ØIn the Output window, click on the Forces tab. This will show the maximum force observed in the 
defined force sets, as well as provide information about how the force segments were defined.

Figure 10: Forces tab in the Output window for the "0.1 Second Valve Closure" scenario

B. Graph the force results

 ØOpen the Graph Results window. We will create a graph that shows the transient forces over time for 
the force sets. To do so, perform the following steps:

 1. Select the Forces tab on the Graph Control tab on the Quick Access Panel, as shown in Figure 11.
 2. Click the All button such that all force sets are selected from the list to be graphed.
 3. Verify the Force Units Primary Y is set to N.
 4. Verify that  Time Units is set to seconds.
 5. Verify that the Time Frame is set to All Times.
 6. Click Generate.

This should generate the graph shown in Figure 12.

Add the graph to the Graph List Manager by right-clicking the graph results window and selecting "Add 
Graph To List...", or by using the icon on the toolbar. Name the graph "Force Sets" and click OK.
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Figure 11: Graph parameters for force sets

Figure 12: Force vs Time graph for the "0.1 Second Valve Closure" scenario

Note that at Time = 0 seconds, there are no forces for any of the force sets. This is expected since the 
sum of forces across a piping run between two elbows equals zero in a steady-state system. If a Point or 
Exit type force set were used instead of a Difference type force set, then a non-zero force may be 
encountered during the steady-state.

Additionally, some traditional methods of analyzing force sets will not yield the same results as AFT 
xStream since they may not include friction or momentum effects in their force balances. Traditional 
methods can yield significantly different results and indicate incorrect, non-zero forces during steady-
state conditions.

There are two important points to be observed here:

 1. AFT xStream calculates transient fluid forces. This does not include weight from piping, com-
ponents, or the fluid itself, or any other forces external to the piping.  A comprehensive analysis of 
pipe loading must separately include these items.
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 2. Ignoring friction and momentum force balance components will result in force imbalances that do 
not exist in reality.

 Step 9. Run the other child scenarios

 ØRun the other two child scenarios and load the Force Sets graph list item for each. The results 
are shown in the figures below.

Figure 13: Forces tab in the Output window for the "0.25 Second Valve Closure" scenario

Figure 14: Force vs Time graph for the "0.25 Second Valve Closure" scenario

Figure 15: Forces tab in the Output window for the "0.5 Second Valve Closure" scenario
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Figure 16: Force vs Time graph for the "0.5 Second Valve Closure" scenario

These figures show that the maximum force magnitude increases as the valve closes faster. Typically, 
the more rapidly a change occurs, the more severe the resulting forces are. Therefore, a utility of AFT 
xStream would be to evaluate the correlation between transient event duration (e.g., valve closing time) 
and the resultant force magnitudes.

Factors affecting the timing and magnitude of forces

The pipe sectioning, fluid property model, and specification of the Maximum Pipe Mach Number During 
Transient setting can have a significant effect on the accuracy of the forces calculated by AFT xStream. 
These effects are not significant for the system built within this example. However, the results for altering 
each of these three parameters are shown in the figures below so that you may see the impact of chan-
ging these three parameters. Note that in Figure 18, Steam from the ASME Steam, Chempak, and NIST 
REFPROP fluid libraries are superimposed on each other, indicating no meaningful difference for this 
case.

If you wish to learn more about the effect of altering these 3 factors with regards to force, see the Tran-
sient Sensitivity Analysis Tutorial.
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Figure 17: Effect of sectioning when all scenarios use the AFT Standard fluid library and a Maximum Pipe 
Mach Number During Transient of 1

Figure 18: Effect of the fluid property model when all scenarios use a Minimum Number of Sections Per Pipe 
of 1 and an Estimated Maximum Pipe Mach Number During Transient of 1
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Figure 19: Effect of Maximum Pipe Mach Number During Transient when all scenarios use the AFT Standard  
fluid library

 Step 10. Export to a CAESAR II Force File

 ØOpen the Output window, and click on the File menu. Select Export Force File... and choose 
CAESAR II® Force File. This will open the export file window shown in Figure 20.
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Figure 20: Export CAESAR II® Force File window

The force sets to include in the force file may be individually selected, along with how frequently data 
points are saved. The number of data points that will be in the file is also displayed for the given settings. 
This number should not exceed the maximum number of data points allowed for the relevant piping 
stress software, which in the case of CAESAR II® is 2500.

If unit vector information has been entered in the Force Definitions panel, the Export Unit Vector option 
can be used to include this information in the exported file. Similar methods to those described above can 
be used to export force files to ROHR2®, TRIFLEX®, and AutoPIPE®.

Conclusion

Force sets were defined to calculate the transient forces between pairs of 90 degree elbows (rep-
resented by lossless Branch junctions) as a result of two simultaneous Turbine Safety Valve closures in a 
steam system. Several child scenarios were created to evaluate the effect of the closure time where we 
noted that a faster valve closure produced higher magnitudes of forces. Several important assumptions 
and takeaways were discussed:

 1. The Difference force type is intended to model the specific case where all of the following criteria 
is true:

 a. The force is between a pair of 90 degree elbows
 b. The force is an axial pipe force
 c. All pipes, fittings, and components between the elbow pair are in-line

 2. AFT xStream calculates transient fluid forces. This does not include weight from piping, com-
ponents, or the fluid itself, or any other forces external to the piping.  A comprehensive analysis of 
pipe loading must separately include these items.

 3. Ignoring friction and momentum force balance components will result in force imbalances that do 
not exist in reality.

Finally, we discussed how to export these forces into a force file to be used in pipe stress analysis soft-
ware.
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Frequency Analysis - PFA Example             

Summary

The preliminary design for a system uses a positive displacement reciprocating compressor that is 
single-acting and has two heads (cylinders) with a 180 degree phase offset. It is suspected that the 
design may have pulsation resonance issues  and needs to be checked for compliance with the API 618 
standard.  Perform a frequency analysis by placing a forcing function on the PD compressor and 
observing the frequency response of the system. Determine the worst acoustic natural frequency of the 
system, run the compressor at the worst-case RPM, and determine if the API 618 limits are violated.

Topics Covered

 l Using the PFA Module to identify natural acoustic frequencies
 l Defining valid sectioning and simulation duration settings for pulsation analysis
 l Identifying problematic compressor speeds based on pulsation frequency and cylinder arrange-

ment
 l Using periodic flow to represent a reciprocating compressor
 l Checking API 618 compliance

Required Knowledge

This example assumes that the user has some familiarity with AFT xStream such as placing junctions, 
connecting pipes, and entering pipe and junction properties. Refer to the Beginner - Tank Blowdown 
example for more information on these topics.

Model File

A completed version of the model file can be referenced from the Examples folder as part of the AFT 
xStream installation:

C:\AFT Products\AFT xStream 3\Examples

 l Metric - Frequency Analysis - PFA.xtr

 Step 1. Activate the PFA module

Open the Analysis Setup window and go the Modules panel under the Modules group. Then, select the 
option to Activate PFA.
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 Step 2. Build the model

A. Place the pipes and junctions

The next step is to define the pipes and junctions. In the Workspace window, assemble the model as 
shown in Figure 1.

Figure 1: Layout of frequency analysis model

B. Enter the pipe and junction data

The system is in place but now we need to enter the input data for the pipes and junctions. Enter the fol-
lowing data:

All Pipes are  Steel - ANSI, STD (schedule 40), and have standard roughness. The rest of the pipe inform-
ation is as follows:

Pipe # Length (meters) Size (inches)

1 8 10

2 8 10

3 8 10

4 80 16

5 3 6
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 1. Assigned Flow J1
 a. Elevation = 3.5 meters
 b. Name = PD Compressor
 c. Mass Flow Rate =2 kg/sec

Note: This is the average bulk flow produced by the compressor.

 d. Temperature = 38 deg. C
 2. Valve J2

 a. Elevation = 3.5 meters
 b. Loss Source = User Specified
 c. Loss Model = Kv
 d. Kv = 385
 e. xT = 0.8

 3. Branch J3
 a. Elevation = 3.5 meters

 4. Valve J4
 a. Elevation = 0 meters
 b. Loss Source = User Specified
 c. Loss Model = Kv
 d. Kv = 1380
 e. xT = 0.6

 5. Assigned Pressure J5
 a. Elevation = 0 meters
 b. Stagnation Pressure = 0 barG
 c. Temperature = 38 deg. C

 6. Dead End J6
 a. Elevation = 3.5 meters
 b. Name = Closed Valve

C. Check if the pipe and junction data is complete

 ØTurn on List Undefined Objects from the Main Toolbar to verify if all data is entered. If it is not, the 
undefined pipes and junctions window will show a list of incomplete items. If there are undefined objects, 
go back to the incomplete pipes or junctions and enter the missing data.

 Step 3. Specify Analysis Setup

A. Fluid panel

 ØOpen the Analysis Setup window and select the Fluid panel under the Fluid Properties group.
 ØSelect Methane from the AFT Standard fluid library, and click the Add to Model button.
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B. Pipe Sectioning and Output panel

 ØOpen the Pipe Sectioning and Output panel and define the following settings: in 
 1. Minimum Number of Sections Per Pipe = 8 sections
 2. Estimated Maximum Pipe Fluid Temperature During Transient = 65 deg. C

C. Simulation Mode/Duration panel

 ØEnter a Stop Time of 2 seconds on the Simulation Mode/Duration panel in the Transient Control 
group.

D. Pulse Setup panel

 ØOpen the Pulse Setup panel from the Pulsation Setup group. The Pulse Setup panel is used to spe-
cify the location and magnitude of the pulse applied to the system, as well as the parameters required to 
generate the forcing function for frequency analysis.

 ØDefine the Pulsation inputs as follows (Figure 2):

 1. Select Natural Frequency Evaluation for the Frequency Analysis Mode.
 2. Select junction J1 as the location for the pulse to be applied at.
 3. For Magnitude, ensure that Automatic (Twice Steady-State Flow) is selected.
 4. Under Frequency Analysis, define the Cutoff Frequency as 200 Hz and verify that the Minimum 

Number of Frequency Samples is set to the default value of 1000.
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Figure 2: Pulse Setup panel in the Analysis Setup window with all pulsation settings defined

Now that all of the pulsation inputs are defined, look at the Pulsation Summary at the bottom of the win-
dow. The defined Cutoff Frequency and the Minimum Number of Frequency Samples will affect the num-
ber of sections and the simulation duration that are required to run the analysis. If the number of sections 
is insufficient, then the time step will be too large to capture the specified Cutoff Frequency. Similarly, if 
the simulation duration is too small, then the number of time steps will not accommodate the Minimum 
Number of Frequency Samples.

Checking the Pulsation Summary for this example, the Minimum Sections Required for Cutoff are 2, and 
the Minimum Simulation Duration Required for Min. Samples is 0.79 seconds. Both of these require-
ments are satisfied by the current model settings. The Update For Me button can be used to auto-
matically change the minimum number of sections and/or the minimum simulation duration if they are 
insufficient. Click OK to save and close the Analysis Setup window.

 Step 4. Run the model

 ØSelect Run Model from the Common Toolbar. This will open the Solution Progress window. This 
model has an estimated run time of 5 minutes, but the run time is dependent on the speed of your PC.

 Step 5. Ensure the pressure response stabilizes

 ØOpen the Graph Results window. The first step will be to generate a plot of the pressure in each of 
the pipes to ensure that the simulation duration was long enough for the response to stabilize.

 ØCreate the pressure graph as follows:
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 1. Select the Transient Pipe tab from the Graph Control tab of the Quick Access Panel
 2. Add the Inlet and Outlet station for each of the pipes
 3. Choose Pressure Static as the Parameter in units of bar
 4. Click Generate

The pressure graph should appear as shown in Figure 3. Note that there is a small perturbation in the 
pressure when the pulse is applied to the system, though the pressure results completely stabilize by the 
end of the run. If the pressure results were still changing at the end of the run, the model should be re-run 
with a longer simulation duration.

Figure 3: Static Pressure vs Time in each pipe shows that the Simulation Duration is sufficient

 Step 6. Graph the frequency response

 ØNext, graph the acoustic frequency response as follows:

 1. Click the New Tab button (green “+” icon in the bottom-right)
 2. Select the Frequency tab in the Graph Parameter section of the Quick Access Panel (Figure 4)
 3. Add the Inlet and Outlet station for each of the pipes
 4. Verify that the pressure units are set to bar
 5. Click the Generate button
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Figure 4: Graph Parameters section for the frequency analysis

Identify excitation frequencies to study

From the graph in Figure 5, there are several frequencies that produce a large pressure response. Points 
on the plot with a large response magnitude are easily identified by finding local maxima on the graph. 
The frequency and amplitude associated with these maxima can be highlighted on the graph by clicking 
and dragging the cursor from left to right highlighting the location of the local maximum. These maxima 
are the acoustic natural frequencies that are potentially the most damaging when excited by a positive 
displacement compressor. These frequencies can also be caused by equipment that contributes large 
pressure drops, such as control valves.

Two natural frequencies are identified for the system based on the peaks in the graph at roughly 28 Hz 
and 56 Hz. Note that the number of sections used for the analysis may affect the location of the peaks, so 
it is prudent to run the analysis with more sections to reduce uncertainty in the results. It is also recom-
mended to analyze frequencies near identified peaks (for example, analyzing 55 and 56 Hz for the peak 
at 56 Hz) to account for potential shifting of the frequency peaks that can result from the assumptions 
made for the frequency analysis in AFT xStream.
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Figure 5: Acoustical frequency graph for the positive displacement compressor system

 Step 7. Simulate the worst-case scenario

A. Determine the worst-case RPM

The 28 Hz excitation frequency resulted in the highest magnitude pressure response for the system; 
therefore, it will be the focus for the remainder of this example. In order to run a worst-case scenario, we 
need to translate the excitation frequency to a compressor speed in RPM. The equation below relates 
compressor RPM and the number of heads (N) to the fundamental frequency, also called the base pulsa-
tion frequency (fb), and only applies when the number of heads is even and equally offset.

In this case 28 Hz pulsation frequency corresponds to 840 RPM. We will use this RPM in the next step. A 
real analysis might also include lower speeds that have a harmonic multiple falling on an excitation fre-
quency of the system, such as 420 RPM, if these speeds are near the desired operating speed of the 
compressor.

B. Create a scenario with Steady State Pulsation

 ØCreate a child scenario and switch to Steady State Pulsation analysis mode:
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 1. In the Scenario Manager, right-click on the Base Scenario and choose Create Child. Name the 
child scenario “840 RPM”.

 2. Open the Analysis Setup window and go to the Pulse Setup panel.
 3. Switch the Frequency Analysis Mode to the Steady State Pulsation option.
 4. Under the Pulsation Source section, select the Reciprocating Compressor option. The Com-

pressor dropdown menu will show User Defined since this example is using an Assigned Flow 
junction to represent the discharge of the compressor.

 5. Enter the Speed as 840 RPM and the Number of Heads as 2.
 6. Ensure the checkbox for Evaluate with API 618 is enabled. Click OK to save and close Analysis 

Setup.

C. Approximate the compressor flow

Since the PD compressor is single-acting and has 2 compression cylinders with a 180 degree phase off-
set, we can take advantage of the Periodic Flow option in the Assigned Flow junction to create a modified 
sine wave that approximates the mass flow leaving the compressor. In this case, having 2 heads with a 
180 degree offset results in an easy, symmetrical chopped sine wave with two peaks per period.

The Periodic Flow with Chopped Sine Wave option will require a frequency and amplitude. For the 
Chopped Sine Wave sub-option, the frequency represents two peaks. It is equivalent to taking the abso-
lute value of a full period of a normal sine wave. Assuming that the minimum flow that occurs between the 
peaks is zero, the flow amplitude must scale the steady-state flow rate by π/2 to achieve an equivalent 
bulk flow rate. This is shown in Figure 6 for one crankshaft rotation, and the areas under the steady-state 
and periodic mass flow curves are equal to the other. This scaling results in a flow amplitude of 3.14 
kg/sec. Because the compressor flow has two peaks per crankshaft revolution, the frequency of the 
sinusoid is equal to the frequency of the crankshaft, which at 840 RPM is 14 1/s (Hz).

Figure 6: Illustration of transient and steady mass flow rates with identical areas under the curves, resulting 
in equivalent bulk flow rates
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 ØModify the Assigned Flow junction to represent steady-state pulsation:

 1. Open the Assigned Flow Properties window for junction J1.
 2. In the Flow Model tab, set Mass Flow Rate to 0.01 kg/s. This is chosen to be near zero since the 

Assigned Flow junction does not accept an input steady-state flow of zero.
 3. In the Transient tab, clear the pulse transient data by clicking Edit Table under the transient table 

and choosing Clear All Data.
 4. Check the boxes next to Periodic Flow and Chopped Sine Wave.
 5. Set the Frequency to 14 1/s.
 6. Set the Flow Amplitude to 3.14 kg/sec (Figure 7).
 7. Click OK to save and close the Assigned Flow Properties window.

Figure 7: Assigned Flow Properties window with Periodic Flow transient applied

The model is now updated to represent the pulsation at the positive displacement compressor that will 
excite the system.
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 Step 8. Check for compliance with API 618

A. Check the Output for warnings

 ØRun the model, then navigate to the Output window.

A warning will be shown stating that the maximum pressure limit for API 618 was exceeded as is shown 
in Figure 8. The caution message stating that lowering the estimated maximum pipe Mach number may 
increase accuracy is useful for improving sectioning, but iterating on this value is not necessary for the 
purpose of this example. The caution message about the maximum transient pipe Mach number exceed-
ing the steady pipe Mach number can be ignored, since this is to be expected based on the flow amp-
litude.

When the API 618 evaluation is performed, the Pulsation Summary tab is shown in the Output window 
with additional information on where pressure limit violations occurred, and what inputs were used to cal-
culate the API 618 pressure limits for the scenario (Figure 9).

Figure 8: Warning showing that the API 618 pressure limits have been exceeded at multiple locations

Figure 9: Pulsation Summary tab listing the pipes with the largest API 618 pressure violations
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B. Examine the pulsation at the compressor

The pulsation behavior at the outlet of the compressor can be illustrated by graphing the flow at the inlet 
of Pipe P1.

 1. Select the Transient Pipe tab in the Graph Parameter section of the Quick Access Panel
 2. Add the Outlet station from Pipe P1
 3. Select Mass Flowrate as the graphing parameter with units of kg/sec
 4. Ensure that Time Units are set to seconds
 5. Click the Generate button
 6. Right-click on the x-axis and uncheck the Auto Scale option
 7. Set the Maximum to 0.286, which corresponds to 4 crankshaft rotations
 8. Set the Major Val to 0.0714, which is the period of a single crankshaft rotation (60/840)

The resulting graph is shown in Figure 10. There should be 8 pulses each with a maximum flow near 3.14 
kg/sec and a minimum flow near zero. The period of each pulse (a single peak on the graph) is equal to 
0.0357 seconds, which translates to a pulsation frequency of 28 Hz. Being equal to the first major natural 
frequency of the system, this should result in maximum excitation of the pressure amplitude in the sys-
tem at this frequency and its associated harmonic integer multiples.

Figure 10: Periodic mass flowrate supplied by the compressor over 4 crankshaft revolutions
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C. Graph the API 618 limits

There were many locations within the model where the API 618 limits were exceeded. Since this 
example focused on the closed valve at the J6 Dead End, we will graph the API 618 limits for this loc-
ation. The same procedure could be applied for any location in the model.

 1. Select the Frequency tab in the Graph Parameter section of the Quick Access Panel
 2. Add the Pipe P5 Outlet station
 3. Ensure the Pressure Units are set to bar
 4. Click the Generate button

Figure 11 shows the resulting graph in which AFT xStream has overlaid the calculated API 618 limits. A 
noticeable spike is seen at 28 Hz which exceeds the API 618 limit for the outlet station. Keen observers 
will notice very small spikes at the harmonic multiples of the compressor frequency (56 Hz).

Figure 11: Frequency graph showing the API 618 limits

Because the peak-to-peak pulsation level recommended by API 618 is exceeded, the system design 
may need to be changed in order to minimize vibration and maximize system longevity. This could be 
achieved by changing the compressor selection such as one with more cylinders or replacing the com-
pressor with several smaller capacity compressors. Other approaches may include changing pipe geo-
metry or adding pulsation suppression devices such as acoustic filters, pulsation bottles, finite volume 
surge tanks, or choking tubes.

Conclusion

The PFA Add-on Module for AFT xStream can be used to apply a pressure pulse to the system in order 
to identify acoustic frequencies which may result in damage. These frequencies can be used in further 
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pulsation analysis to determine if pulsation mitigation is required. The Steady State Pulsation analysis 
mode and Assigned Flow junction with a periodic chopped sine wave allowed us to simulate the PD com-
pressor running at a specified RPM.

The piping layout and geometry of the system was found to have an excitation frequency of 28 Hz (the 
first harmonic). With a single-acting, 2 head, 180 degree phase offset compressor, the fundamental fre-
quency or base pulsation frequency of 28 Hz corresponded to a compressor speed of 840 RPM. The 
compressor outlet flowrate was approximated with a chopped sine wave where the frequency was 14 Hz. 
The two peaks per period represented the flow from each compression cylinder during one full rotation of 
the crankshaft.

The peak-to-peak pressure oscillations were found to violate the API 618 standard. Future modifications 
would need to be made to the system such as changing the compressor, altering the piping layout, or util-
izing pulsation suppression devices.
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Verification

AFT xStream Verification Overview
There are a number of aspects to the verification process employed by Applied Flow Technology to 
ensure that AFT xStream provides accurate solutions to gas transient and steamhammer problems in 
pipe flow systems. These are discussed in Verification Methodology. A listing of all of the verified models 
is given in Summary of Verification Models. The verification models are taken from numerous Refer-
ences.

Verification References

 1. Sod, Gary. A Survey of Several Finite Difference Methods for Systems of Nonlinear Hyperbolic 
Conservation Laws. Journal of Computational Physics, Elsevier, 1978, 27 (1). ff10.1016/0021- 
9991(78)90023-2. hal-01635155 (https://hal.archives-ouvertes.fr/hal-01635155/document)

 2. Moody, Frederick J., Introduction to Unsteady Thermofluid Mechanics, John Wiley & Sons, Inc., 
New York, NY, 1990.

https://hal.archives-ouvertes.fr/hal-01635155/document
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Verification Methodology
The AFT xStream software is a gas transient and steamhammer analysis product intended for use by 
trained engineers. As a technical software package, issues of quality and reliability of the technical data 
generated by the software are important. The following description summarizes the steps taken by 
Applied Flow Technology to ensure the high quality of the technical data.

1. Comparison with open literature examples

There are not many published examples for gas transient systems available for comparison with AFT 
xStream. However, AFT xStream has been compared to several published systems with known ana-
lytical solutions, including Sod's shock tube example and a pipe rupture case from Moody.

2. Transient solver checks for artificial transient to ensure true steady initial 
conditions

Before running the transient solution, AFT xStream always runs the MOC Steady solution with no tran-
sient boundary conditions in effect. It then compares the initial conditions to the MOC Steady calculation 
to see if significant differences exist. If so, a warning is generated.

3. Steady-state and transient solution at time zero are self checking

AFT xStream has two Solvers – one for the steady-state and one for the transient. They use two entirely 
different solution algorithms. First the AFT Arrow Steady Solver is run, and then the results are used to ini-
tialize the MOC Transient Solver. Before the transient solver is actually run, the MOC Steady solution is 
run. If the Arrow Steady and MOC Steady solutions disagree, a warning is generated. Thus  if there were 
fundamental calculation errors in either method then an artificial transient would be generated and the 
user warned. This does not ensure all transient calculations afterward are correct, but does ensure that 
the fundamental transient equations are being properly represented.

Summary of Verification Models
Comparison of AFT xStream predictions to the published calculation results is included herein for two 
cases from two sources.

Below is a summary of the cases.

Case Fluid Reference

Case 1 Air Sod

Case 2 Air Moody
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Verification Case 1
Problem Statement

PRODUCT: AFT xStream

TITLE: XtrVerify1.xtr

REFERENCE: Gary Sod. A Survey of Several Finite Difference Methods for Systems of Nonlinear Hyper-
bolic Conservation Laws. Journal of Computational Physics, Elsevier, 1978, 27 (1), pp.1-31, Fig. 4. 
ff10.1016/0021- 9991(78)90023-2. hal-01635155 (https://hal.archives-ouvertes.fr/hal-01635155/doc-
ument)

FLUID: Air

ASSUMPTIONS: Calorically perfect gas, ideal gas

RESULTS:

https://hal.archives-ouvertes.fr/hal-01635155/document
https://hal.archives-ouvertes.fr/hal-01635155/document
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DISCUSSION:

The shock tube apparatus studied for this problem involves a high pressure and low pressure region ini-
tially separated by a diaphragm. The high pressure region (x = 0 to x = 5) is initially fully enclosed with a 
dead end at x = 0. The low pressure region has an open end at x = 10. Both regions are initially at rest. At 
the beginning of the transient the diaphragm is broken, resulting in a compression wave forming at the 
broken diaphragm and propagating out from that point. In xStream the initial conditions at the dead end 
for the high pressure region are modeled using an assigned pressure junction. Since the simulation ends 
before the wave reflects this is reasonable, but would not be an accurate way to model the dead end for a 
longer simulation. The diaphragm is represented by a valve which is closed at time 0, then opens instant-
aneously once the transient begins to represent the diaphragm bursting open.

An analytical solution to this problem can be found by making several simplifying assumptions, including 
that the pipes are adiabatic and frictionless, and that the gas is calorically perfect and ideal. This means 
that the fundamental compressible flow equations can be solved assuming flow is isentropic, except at 
the shock wave. The analytical solution was calculated using the basic equations as are described on 
page 3, along with the fundamental compressible flow equations.

The initial values for pressure  and temperature were chosen in order to satisfy the pressure and density 
ratios specified by the reference for the steady state.

It can be seen that the relative magnitudes of the pressure, density, and velocity are reasonably close to 
the analytical solution, though the shock wave front is shifted slightly to the left. There is a more notice-
able difference in the maximum temperature results for xStream and the analytical solution, though the 
margin of error is still relatively small. The lower temperature predicted by xStream will also cause a 
lower sonic velocity for the fluid, which explains the shift in the shock wave front. 
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Verification Case 1 Problem Statement
Verification Case 1

Gary Sod. A Survey of Several Finite Difference Methods for Systems of Nonlinear Hyperbolic Con-
servation Laws. Journal of Computational Physics, Elsevier, 1978, 27 (1), pp.1-31, Fig. 4.
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Verification Case 2
Problem Statement

PRODUCT: AFT xStream

TITLE: XtrVerify2.xtr

REFERENCE: Moody, Frederick J., Introduction to Unsteady Thermofluid Mechanics, John Wiley & 
Sons, Inc., New York, NY, 1990, Page 452-453, Example 8.5, Figures 8.16 & 8.17

FLUID: Air

ASSUMPTIONS: Calorically perfect gas, friction is negligible

RESULTS:
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DISCUSSION:

To find an analytical solution for this example Moody assumes the process is adiabatic, the pipes are fric-
tionless, and that the fluid is ideal and calorically perfect. The assumptions made by Moody allow an isen-
tropic solution to be found for the expansion wave.
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The tube rupture is modeled as an instantaneous drop in static pressure based on the dimensionless 
static pressure drop ratio in Moody Figure 8.16, P/Po.

Though Moody assumes that the pipes are frictionless, the pipes in xStream are instead defined as 
hydraulically smooth. This is done to prevent supersonic flow in the xStream model.

The difference in friction models and the fact that the fluid in xStream is not modeled as calorically perfect 
can account for the minor differences between the xStream results and the analytical solution.
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Verification Case 2 Problem Statement
Verification Case 2

Moody, Frederick J., Introduction to Unsteady Thermofluid Mechanics, John Wiley & Sons, Inc., New 
York, NY, 1990, Page 452-453, Example 8.5, Figures 8.16 & 8.17
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Bend  240
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Branch  243
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Change Units window  609

Check Valve  245

Checklist  302

Chempak Fluid  84

Chempak library  See Fluid libraries, Chempak library

Clear Initial Guesses  291

Color Map  320

Colors and Fonts  372
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Dead End  271

Defining force sets  See Forces, Force sets, Definition

Defining objects

List Undefined Objects window  590, 628, 644, 673

Design Alerts  293

Design Factors  203

Disable Pipes Snapping to Isometric Grid  296

Duplicate Special  291

E

eLicense Information  293

Estimated Maximum Temperature During Transient  See Pipe Sectioning panel, Estimated 
Maximum Temperature During Transient

Exit Valves  285

Export force files  See Forces, Exporting force files

Export Model Data  289

F
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File Locations  374
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Fittings and Losses  183

Flip Vertex  295

Fluid libraries

AFT Standard library  600, 628, 644, 653, 673

ASME Steam Tables library  600, 653
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Chempak library  600, 653

Effect of  652, 667

NIST REFPROP library  601, 653

Selection  653-654

Fluid Library  294

Fluid panel  600, 628, 644, 673

Fluid Property Viewers  293

Forces

Exporting force files  669

Force sets  658

Definition  659-660

Direction  659

Force Unit Vectors  659

Methodology  665

Forces panel  670

G

General Component  272

Graph Animations  See Animation, Graph

Graph Control tab

Forces  664

Profile tab  635, 648

Transient Jct tab  612, 650

Transient Pipe tab  610, 633, 645

Graph List Manager  634, 637, 664

Graph Results  301
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Graph Results window  609

Modifying axes of graphs  645

Grid  370

H

Heat Exchanger  273

Highlight feature  592

I

ID numbers  585, 590

Import Graph Data  289

Information Messages  530

Initial Flow Guess  203

Inspection  176

Inspection feature  593, 597

Insulation  187

Insulation Library  294

Integration Query  293

Interpolated X-Y Data  76

Isometric  See Pipe Drawing Mode, Isometric

J

Junction library  294, 591

Junctions  584
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Assigned Flow Properties Window  236

Assigned Pressure Properties Window  238

Bend Properties Window  240
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Branch Properties Window  243

Check Valve Properties Window  245

Compressor/Fan Properties Window  247

Control Valve Properties Window  268

Dead End Properties Window  271
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Heat Exchanger Properties Window  273
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Relief Valve Properties Window  277
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Tank  584
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Valve  593
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Labels  318, 371
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Libraries  428, 441

List Undefined Objects window  See Defining objects, List Undefined Objects window

Load Background Picture  290

Lock Object  296, 589
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Merge  289

Method of Characteristics  602, 631

Minimizing the Quick Access Panel  310

Minimum Number of Frequency Samples  105, 423

Minimum Number of Sections Per Pipe  See Pipe Sectioning panel, Minimum Number of 
Sections Per Pipe

Mixtures  600, 653

Model building process  652
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Model Data Control  293

Model Data Print Content  293
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Model Status Light  309, 599
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N
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O
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Open Percentage Data  285
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Open Pipe/Jct Window  591

Orifice  274

Output  301

Output Control  293

Output Control window  606, 608

Output file  606

Output File  577

Output Language  293

Output Messages  530

Output Print Content  293

Output window  606, 631
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P
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Pipe Drawing Mode  295
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Isometric  640
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Estimated Maximum Temperature During Transient  602, 628, 644, 657, 674
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Properties Tab  304

Properties windows

Notes tab  592

Optional tab  592-593

Status tab  592, 598

Transient tab

Specification  594, 662, 680

Pulsation Frequency Analysis  292

Pulsation panel  674

Cutoff Frequency  674

Minimum Number of Frequency Samples  674
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Pulsation Summary  675
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Quick Access Panel  314, 584

Graph List Manager  634

Quick Graph Formatting  293, 611

R

Recovery File  375

Relief Valve  277

Reset Label Locations  296

Reverse Direction  296, 589

Reverse flow  589

Rotate Icon  295

Rotate Selection  295

Rotating Icons  640

Run Model  292, 604, 631, 645, 664, 675, 681

S

Satisfying Connectivity Requirements  175

Scale/Flip Workspace  295

Scenario Comparison Tool  293, 662-663

Scenario Manager  293, 303, 632, 637, 661, 679

Screen  278

Select Flow Path  291

Select Graph Parameters  293, 610

Select Special  291

Selecting a fluid library  See Fluid libraries, Selection
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Set Pipe and Junction Locations to Parent  296

Show Grid  295, 640

Show Object Status  175, 590, 593

Simulation Mode/Duration panel  601, 603, 629, 645, 658, 674

Snap to Grid  295

Sonic choking  603, 612, 637

Sonic Choking  285

Sort Table By  295

Special Conditions  212

Stacked Graphs  610

Startup window  582

Modeling Preferences  582

Status Bar  599

T

Tank  280

Tank junction  See Junctions, Tank

Tee/Wye  283

Time Simulation  292

Toolbars  599

Toolbox  584

Annotation tool  584

Pipe Drawing Tool  584, 587-588

Tooltips  584

Transfer Results to Initial Guesses  291

Transient Control group  603

Transient event specification  See Properties windows, Transient tab, Specification
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Transient Jct tab  See Graph Control tab, Transient Jct tab

Transient Pipe tab  See Graph Control tab, Transient Pipe tab

Transient Solver  605, 653

Troubleshooting Models  565

U

Undefined objects list  See Defining objects, List Undefined Objects window

Undefined Objects Window  175

Unique solution  70

Use Status Feature  175

User Library Fluid  84

User Options  293, 370, 374, 590

V

Valve  284

Valve junction  See Junctions, Valve

Venturi  286

W

Warnings  530

Workspace  300, 314

Workspace Icon  212

Workspace Layers  314

Active Layer  316

Animation Settings  55, 320

From Workspace Selections  315

Workspace Layers Tab  307

Workspace Symbols  322, 372
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